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1. Product overview

1.1 Features and benefits
The Fujitsu KVM series4-0812/1622/3242 switches combine analog and digital
technology to provide flexible, centralized control of data center servers, and
virtual media, and to facilitate the operations, activation, and maintenance of
remote branch offices where trained operators may be unavailable. IP-based
KVM s4 switches give you flexible target device management control and secure
remote access from anywhere at anytime.

The KVM s4 switch provides enterprise customers with the following features and
options:

• significant reduction of cable volume

• keyboard, video, and mouse (KVM) capabilites, configurable for analog
(local) or digital (remote) connectivity

• true serial capability through Secure Shell (SSH) and Telnet

• enhanced video resolution support, up to 1600 x 1200 or 1680 x 1050
(widescreen) native from target to remote

• virtual media capability accessed through USB ports

• dual independent local port video paths (dedicated to ACI)

• dual stack IPv4 (DHCP) and IPv6 (DHCPv6 and stateless auto-configuration)
for simultaneous access

• supports CCID compliant smart card readers

• accessibility to target devices across 10/100 or 1000BaseT LAN port(s)

• a MODEM port that supports V.34, V.90 or V.92-compatible modems that
may be used to access the switch when an Ethernet connection is not
available

Reduce cable bulk

With server densities continually increasing, cable bulk remains a major concern
for network administrators. The KVM s4 switch significantly reduces KVM cable
volume in the rack by utilizing the innovative virtual media conversion option
cables and single, industry-standard Unshielded Twisted Pair (UTP) cabling. This
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1. Product overview

allows a higher server density while providing greater airflow and cooling
capacity.

KVM switching capabilities

The KVM s4 switch supports adapter cables that are powered directly from the
target device and provide Keep Alive functionality when the switch is not
powered. The following adapter cables are supported: KVM s4 Adapter USB20-
VGA and KVM s4 Adapter Serial cables.

True serial capabilities

The KVM s4 switch supports KVMs4 Adapter Serial cables that provide true serial
capabilities through Secure Shell (SSH) or Telnet. You can launch an SSH
 session or launch a serial viewer from the on-board web interface (OBWI) to
connect the targets that are connected to the KVM s4 switches with a KVMs4
Adapter Serial cable.

Local and remote user interfaces

You can use the local user interface (local UI) by connecting directly to the local
port to manage the KVM s4. You can also use the remote OBWI to manage your
switch. The OBWI is web browser based and is launched directly from the switch,
and any devices connected to the KVM s4 are automatically detected. The two
user interfaces share a similar look and feel for an optimal user experience.

Control of virtual media and smart card-capable switches

The KVM s4 switch allows you to view, move, or copy data located on virtual
media to and from any target device. You can manage remote systems more
efficiently by allowing operating system installation, operating system recovery,
hard drive recovery or duplication, BIOS updating, and target device backup.

The KVM s4 switch allows you to use smart cards in conjunction with your switch
system. Smart cards are pocket-sized cards that store and process information.
Smart cards such as the Common Access Card (CAC) can be used to store
identification and authentication to enable access to computers, networks, and
secure rooms or buildings.

Virtual media and smart card readers can be connected directly to the switch
using USB ports located on the switch. In addition, virtual media and smart card
readers may be connected to any remote workstation that is running the remote
OBWI or Avocent® DSView® 3 Management Software and is connected to the
switch using an Ethernet connection.
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1.1 Features and benefits

To open a virtualmedia session with a target device, youmust first connect the target
device to a switch using the adapter cable. For a smart card, youmust first connect the
target device to a switch using the smart card-capable adapter cable.

Access the switch via a standard TCP/IP network

The switch provides agentless remote control and access. No special software or
drivers are required on the attached servers or client.

The client connects to the switch using an Internet browser.

You can access the switch and all attached systems via Ethernet or using a V.34,
V.90, or V.92 modem from a client. The clients can be located anywhere a valid
network connection exists.

DSView 3 Management Software plug-in

The DSView 3 software may be used with the switch to allow IT administrators to
remotely access, monitor, and control target devices on multiple platforms
through a single, web based user interface. For more information, see the
DSView 3 Software Plug-In for KVM s4 Switches Technical Bulletin.
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1. Product overview

1.2 Sample configuration

Figure 1.1. Example switch configuration

Table 1.1. Descriptions for Figure 1.1

Number Description Number Description

1 CAT 5
connection 7 Telephone network

2
KVM
connection to
the switch

8 Ethernet

3 Remote IP
connection 9 DSView 3 software server

4 Rackof servers 10 Analog user (localUI)
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1.2 Sample configuration

Number Description Number Description

5 KVM s4 switch 11 Digital user (computer with Internet
browser, remote OBWI)

6 Modem
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2. Installation

2.1 KVM s4 Switch Connectivity
The KVM s4 switch transmits KVM and serial information between operators and
target devices attached to the switch over a network using either an Ethernet or
modem connection.

The KVM s4 switch uses TCP/IP for communication over Ethernet. For the best
system performance, use a dedicated, switched 100BaseT or 1000BaseT
network. You can also use 10BaseT Ethernet.

The KVM s4 switch uses the Point-to-Point Protocol (PPP) for communication
over a V.34, V.90, or V.92 modem. You can perform KVM and serial switching
tasks by using the OBWI or the DSView 3 software. For more information on the
DSView 3 software, visit http://www.avocent.com/fujitsu.

Figure 2.1 illustrates an example basic configuration for the switch. Descriptions
follow in Table 2.1.
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2. Installation

Figure 2.1. Basic switch configuration using the KVM s4-3242 switch

Table 2.1. Descriptions for Figure 2.1

Number Description Number Description

1 Digital user 8 Power cord

2 Telephone
network 9 Ports 1-32

3 Network 10 LocalUSB connections
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2.1 KVM s4 Switch Connectivity

Number Description Number Description

4 Modem 11 Power control device

5 Analog user 12 Target devices1-32

6 External virtual
media 13 Adapter cables

7 KVM s4-3242
switch

Getting started

Before installing your switch, refer to the following lists to ensure you have all
items that shipped with the switch, as well as other items necessary for proper
installation.

Supplied with the switch

• Rack mount bracket kit

• Rack Mounting Bracket Quick Installation Guide

• KVM s4 Quick Installation Guide

• Safety and Regulatory Statements Guide

• Cables and adapters for the MODEM and SETUP ports

• AC power cord(s)

Additional items needed

• One adapter cable per target device

• One serial adapter cable per serial device

• One UTP patch cable per adapter cable (4-pair UTP, up to 45 meters)

• UTP patch cable(s) for network connectivity (4-pair UTP, up to 45 meters)

• One virtual media-capable adapter cable per target device for virtual media
sessions

• One smart card-capable adapter cable per target device for smart card
control
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Setting up your network

The switch uses IP addresses to uniquely identify the switch and the target
devices. The KVM s4 switch supports both Dynamic Host Configuration Protocol
(DHCP) and static IP addressing. Make sure that an IP address is reserved for
each switch and that each IP address remains static while the switch is
connected to the network.

2.2 Rack Mounting a KVM s4 Switch
A rack mounting kit is supplied with each switch. You may either place the switch
on the rack shelf or mount the switch directly into an Electronic Industries Alliance
(EIA) standard rack.

The switch may be rack-mounted in a 1U or 0U configuration.

Rack mounting safety considerations

• Rack Loading: Overloading or uneven loading of racks may result in shelf or
rack failure, causing damage to equipment and possible personal injury.
Stabilize racks in a permanent location before loading begins. Mount
components beginning at the bottom of the rack, then work to the top. Do not
exceed your rack load rating.

• Power considerations: Connect only to the power source specified on the
unit. When multiple electrical components are installed in a rack, ensure that
the total component power ratings do not exceed circuit capabilities.
Overloaded power sources and extension cords present fire and shock
hazards.

• Elevated ambient temperature: If installed in a closed rack assembly, the
operating temperature of the rack environment may be greater than room
ambient. Use care not to exceed the rated maximum ambient temperature of
the switch.

• Reduced air flow: Install the equipment in the rack so that the amount of
airflow required for safe operation of the equipment is not compromised.

• Reliable earthing: Maintain reliable earthing of rack-mounted equipment.
Pay particular attention to supply connections other than direct connections
to the branch circuit (for example, use of power strips).

• Product should not be mounted with the rear panel facing in the downward
position.
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2.3 Connecting the switch hardware

For complete instructions on installing the rack mounting bracket, please refer to
your KVM s4 Quick Installation Guide.

2.3 Connecting the switch hardware
To connect and turn on your switch:

To avoid potential video and/or keyboard problems when using Fujitsu
products: If the building has3-phase AC power, ensure that the computer and
monitor are on the same phase. For best results, they should be on the same circuit.

WARNING: To reduce the risk of electric shock or damage to your
equipment:
- Do not disable the power grounding plug. The grounding plug is an important safety
feature.
- Connect the power cord into a grounded (earthed) outlet that is easily accessible at all
times.
- Disconnect the power from the product byunplugging the power cord from either the
electrical outlet or the product.
- The AC inlet is themain disconnect for removing power to this product. For products
that havemore than one AC inlet, to remove power completely, all AC line cordsmust
be disconnected.
- This product hasno user serviceable parts inside the product enclosure. Do not open
or remove product cover.

1. Connect your VGA monitor and USB keyboard and mouse cables into the
appropriately labeled ports.

2. Choose an available port on the switch. Connect one end of a UTP cable (4-
pair, up to 150 ft/45 m) into a numbered port. Connect the other end into an
RJ-45 connector of an adapter cable.

3. Connect the adapter cable into the appropriate ports on the back of a target
device. Repeat this procedure for all target devices you want to connect.

When connecting to a SunMicrosystems target device, youmust use amulti-sync
monitor in the local port to accommodate Sun computers that support both VGAand
sync-on-green or composite sync.

4. Connect both LAN ports to independent Ethernet switches to provide
redundancy.

5. Turn on each target device, then locate the power cord(s) that came with the
switch. Connect one end into the power socket on the rear of the switch.
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Connect the other end into an appropriate AC wall outlet. Use your second
power cord to connect to the second power socket on the rear of the switch.
Connect the other end into an appropriate wall outlet.

Plug the redundant power supplies into separate branch circuits to provide additional
redundancy in the event one externalAC power source should go away.

To connect local virtual media or a smart card reader:

Connect the virtual media or smart card reader to an available USB port on the
switch.

For all virtualmedia sessionsand smart card readers, youmust use a KVM s4 Adapter
USB20-VGA adapter cable.

For information on connecting virtual media remotely, see "Virtual Media" on
page 60. For information on connecting a smart card reader remotely, see "Smart
cards" on page 64.

To connect a serial adapter cable to a serial device using a UTP connector:

1. Attach the serial adapter cable UTP connector to the serial device.

-or-

Attach the serial adapter cable to an RJ-45 to 9-pin female adapter.
Attach the adapter to the serial port of the serial device.

2. Connect one end of a UTP cable (4-pair, up to 150 ft/45 m) into an available
numbered port on the rear of the switch. Connect the other end into the RJ-
45 connector of the serial adapter cable.

3. Attach a USB-to-barrel power cord to the power connector on your serial
adapter cable. Connect the USB connector on the USB-to-barrel power cord
into any available USB port on the serial target device.

2.4 Cascading KVM s4 Switches
You can cascade up to two levels of KVM s4 switches, enabling users to connect
to up to 1024 servers. In a cascaded system, each target port on the main switch
will connect to the Analog Console Interface (ACI) port on each cascaded switch.
Each cascaded switch can then be connected to a device with an adapter cable.
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2.4 Cascading KVM s4 Switches

Figure 2.2. KVM s4 Switch Cascaded Configuration

Number Description

1 Master KVM s4 switch

2 Cascaded KVM s4 switch

3 Target port on themaster switch

4 ACI port on the cascaded switch

5 Target devices connected to the switches

Table 2.2: Descriptions for Figure 2.2
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To cascade multiple switches:

1. Attach one end of a CAT 5 cable to a target port on the KVM s4 switch.

2. Connect the other end of the CAT 5 cable to the ACI port (chain link icon) on
the back of your cascaded KVM s4 switch.

3. Connect the devices to your cascaded KVM s4 switch.

4. Repeat these steps for all the cascaded KVM s4 switches you wish to attach
to your system.

The systemwill automatically “merge” the two switches. All devices connected to the
cascaded switcheswill display on themain switch device list in the localUI.

The switch supports one cascaded switch per target port of themain switch. You cannot
attachmore switches to the cascaded switch.

Local port cascading is not supported on KVM s4.

2.5 Configuring KVM s4 Switches
Once all physical connections have been made, you will need to configure the
switch for use in the overall switch system. This can be accomplished in two
ways.

To configure the switch using DSView 3 software:

See the DSView 3 Installer/User Guide for detailed instructions.

To configure the switch using the local UI:

See "Network Settings" on page 29 for detailed instructions on using the local UI
to configure initial network setup.

Setting up the built-in web server

You can access the switch via an embedded web server that handles most day-
to-day switch tasks. Before using the web server to access the switch, first specify
an IP address through the local port on the back panel of the switch or local UI.

Connecting to the OBWI through a firewall

For switch installations that use the OBWI for access, the following ports must be
opened in a firewall if outside access is desired.

590-1058-640A14



2.5 Configuring KVM s4 Switches

TCPPort
Number Function

22 Used for SSH for serial sessions to a serial adapter cable

23 Used for Telnet (when Telnet is enabled)

80 Used for the initial downloading of the Video Viewer

443 Used by the web browser interface for managing the switch and
launching KVM sessions

2068 Transmission of KVM session data (mouse & keyboard) or transmission
of video on switches

Table 2.3: TCP ports and functions for the switch OBWI

In a typical configuration, as shown in Figure 2.3, the user’s computer is located
outside of the firewall, and the switch resides inside the firewall.

Figure 2.3. Typical switch firewall configuration

Table 2.4. Descriptions for Figure 2.3

Number Description

1 KVM s4 switch
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Number Description

2 Firewall

3 User’s computer

4 Firewall forwardsHTTP requests and KVM traffic to the switch

5 User browses to firewall’s external IP address

To configure the firewall:

To access the switch from outside a firewall, configure your firewall to forward
ports 22, 23 (if Telnet is enabled), 80, 443 and 2068 from its external interface to
the KVM switch through the firewall’s internal interface. Consult the manual for
your firewall for specific port forwarding instructions.

For information on launching the OBWI, see "OBWI" on page 20.

2.6 Verifying The Connections

Rear panel Ethernet connection LEDs

On a KVM s4 switch, the rear panel features two LEDs indicating the Ethernet
LAN1 connection status and two LEDs indicating the Ethernet LAN2 connection
status.

• The green LEDs illuminate when a valid connection to the network is
established and blink when there is activity on the port.

• The bi-color LEDs may illuminate either green or amber.

• They illuminate green when the communication speed is 1000M.

• They illuminate amber when the communication speed is 100M.

• They are not illuminated when the communication speed is 10M.

Rear panel power status LEDs

The rear panel of each appliance has two power status LEDs, one for each
power supply. The LED(s) illuminate green when the switch is turned on and
operating normally.

• The LED is off if the power supply does not have power or has failed.

• The LED illuminates when the unit is ready.

• The LED blinks when the switch is booting or an upgrade is in progress.
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2.7 Adjusting mouse settings on target devices

• The LED blinks "SOS" if a fault condition occurs, such as power supply
failure, elevated ambient temperature, or fan failure. The LED will continue to
blink "SOS" as long as the failure persists.

The switch prevents a serial break from the attached device if the module loses
power. However, a user can generate a serial break with the attached device by
pressing Serial Break on the serial session viewer.

2.7 Adjusting mouse settings on target devices
Before a computer connected to the switch can be used for remote user control,
you must set the target mouse speed and turn off acceleration. For machines
running Microsoft®Windows® (Windows XP, Windows Vista, Windows 2003,
Windows 2008 and Windows 7), use the default PS/2 mouse driver.

To ensure that the local mouse movement and remote cursor display remain in
sync, mouse acceleration must be set to “none” for all user accounts accessing a
remote system through a KVM switch. Mouse acceleration must also be set to
“none” on every remote system. Special cursors should not be used and cursor
visibility options, such as pointer trails, Ctrl key cursor location animations, cursor
shadowing, and cursor hiding, should also be turned off.

If you are not able to disablemouse acceleration fromwithin aWindowsoperating
system, or if you do not wish to adjust the settingsof all your target devices, youmayuse
the Tools >Single Cursor Mode command available in the Video Viewer window. This
command places the Video Viewer window into an “invisible mouse” mode, which
allowsyou tomanually toggle control between themouse pointer on the target system
being viewed and themouse pointer on the client computer.
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3. Local and Remote Configuration

3.1 User interfaces
The KVM s4 switch comes equipped with two “point-and-click” interfaces: a local
user interface (local UI) and a remote on-board web interface (OBWI). Using the
configuration options provided by these interfaces, you can tailor the switch to
your specific application, control any attached devices, and handle all basic KVM
or serial switch needs.

The localUI and remote OBWI are almost identical. Unless specified, all information in
this chapter applies to both interfaces.

From either interface, you can launch two different kinds of sessions:

• The Video Viewer window allows you to control the keyboard, monitor, and
mouse functions of individual target devices connected to the switch in real
time. You may also use predefined global macros to perform actions within
the Video Viewer window. For instructions on how to use the Video Viewer,
see Chapter 4.

• The serial viewer window allows you to manage individual target devices
either by using commands or scripts.

Local UI

The switch includes a local port on the back. This port enables you to connect a
keyboard, monitor and mouse directly to the switch and use the local UI.

You can choose any of the following keystrokes to be configured to open the
local UI or to switch between the local UI and an active session: Print Screen,
Ctrl + Ctrl, Shift + Shift, and Alt + Alt.

To launch the local UI:

1. Connect your monitor, keyboard and mouse cables to the switch. For more
information, see "Connecting the switch hardware" on page 11.

2. Press any of the enabled keystrokes to launch the local UI.

3. If local UI authentication has been enabled, enter your username and
password.
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3. Local and Remote Configuration

If the switch hasbeen added to a DSView 3 server, then the DSView 3 server will be
accessed to authenticate the user. If the switch hasnot been added to a DSView 3
server, or if the DSView 3 server cannot be reached, then the switch local user
database will be accessed to authenticate the user. The default local username is
Admin, and there is no password. Usernames in the local user database are case-
sensitive.

OBWI

The switch OBWI is a remote, web browser based user interface. For details on
setting up your system, see "Connecting the switch hardware" on page 11. The
following table lists the operating systems and browsers that are supported by the
OBWI. Make sure that you are using the latest version of your Web browser.

Table 3.1. OBWI supported operating systems and browsers

Operating System

Browser

Microsoft®

Internet Explorer
version 6.0 SP1
and later

Firefox version 3.0 and later

MicrosoftWindows
Server® 2003
Standard, Enterprise, or
Web Edition

Yes Yes

MicrosoftWindows
Server® 2008
Standard, Enterprise, or
Web Edition

Yes Yes

WindowsXP
Professionalwith
Service Pack3

Yes Yes

WindowsVista®

Businesswith Service
Pack1

Yes Yes

Windows7 Yes Yes
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3.1 User interfaces

Operating System

Browser

Microsoft®

Internet Explorer
version 6.0 SP1
and later

Firefox version 3.0 and later

Red Hat Enterprise
Linux® 4 and 5
Standard, Enterprise or
Web Edition

No Yes

Sun Solaris 10 and 11 No Yes

Solaris 10 x86 No Yes

Ubuntu 8Workstation No Yes

To log in to the switch OBWI:

1. Launch a web browser.

2. In the address field of the browser, enter the IP address or host name
assigned to the switch you wish to access. Use https://xxx.xx.xx.xx or
https://hostname as the format.

If using IPv6mode, youmust include square brackets around the IP address. Use
https://[<ipaddress>] as the format.

3. When the browser makes contact with the switch, enter your username and
password, then click Login. The switch OBWI will appear.

The default username isadmin with the password admin.

To log in to the switch OBWI from outside a firewall, repeat the above procedure,
entering the external IP address of the firewall instead.

Using the user interfaces

After you have been authenticated, the user interface appears. You may view,
access, and manage your switch, as well as specify system settings and change
profile settings. Figure 3.1 shows the user interface window areas for the switch
and descriptions are provided in the following table.
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Figure 3.1. User interface window

Number Description

1

Top option bar: Use the top option bar to bookmarkan interface
window, refresh the displayof an interface window, print a web page,
log out of an OBWI session, or access the online help page. The name
of the logged-in user appears on the left side of the top option bar.

2

Side navigation bar: Use the side navigation bar to select and display
the system information in the content area. The side navigation bar
also contains icons in the top left corner that, when clicked, expand or
collapse all nodes.

3 Content area: Use the content area to displayor make changes to the
switch OBWI system.

Table 3.2: User interface descriptions

Using the side navigation bar

You can use the side navigation bar to display windows in which you can specify
settings or perform operations. Clicking on a link that does not contain an arrow
will display its corresponding window.
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Using the top option bar

If authentication is disabled, only the Refresh button will appear in the localUI. If
authentication is enabled, only the Refresh and LogOut buttonswill appear in the local
UI. All of the buttonswill appear in the remote OBWI.

Bookmarking a window (Microsoft Internet Explorer only)

The user interface contains a bookmark icon and text in the top option bar. You
can bookmark a window to add a link to the window in the Favorites drop-down
menu. You may select the link at any time to quickly access the bookmarked
window.

If you bookmark a window and information related to the window changes, this
new information will appear in the window when you next display the
bookmarked window.

If you click BOOKMARK or the bookmark icon after the switch OBWI session has
timed out, the User Login window will open and you must log in again.

To bookmark a window:

1. In the top option bar, click BOOKMARK or the bookmark icon. The Add
Favorite dialog box will appear.

2. If you wish, type a name for the window. You may also click the Create in
button to create or specify a folder in which to place the window.

3. Click OK to close the Add Favorite dialog box.

Printing a window

All switch OBWI windows contain a print icon in the top option bar.

To print the switch OBWI window:

1. In the top option bar, click PRINT or the print icon. The Print dialog box will
appear.

2. Specify the options you wish to use for printing the switch OBWI window.

3. Click Print to print the switch OBWI window and close the Print dialog box.

Refreshing a window

The switch user interface may be refreshed at any time by clicking REFRESH or
the refresh icon in the top option bar.

Logging out

To log out at any time, click the logout icon in the top option bar.
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3. Local and Remote Configuration

3.2 Viewing system information
You can view various appliance and target device information from several
different screens in the user interface.

Table 3.3. System information

Category Select This: To View This:

Switch
Unit View >
Appliance >
Overview

Switch name and type and appliance tools

Unit View >
Appliance >
Properties>
Identity

Current firmware revision for application and boot

Unit View >
Appliance >
Properties>
Location

Site, department, or location

Unit View >
Appliance >
Appliance Settings
>Versions

Current firmware revision for application, boot,
and Video FPGA

Unit View >
Connections

List of the attached devices

Target Device
Unit View >Target
Devices

List of connected target devices, aswell as the
following information about each device: Name,
Type, Status, and Action

Click on one of the target devices to view the
following additional information: Name, Type, eID,
available session option, and the connection path

You will also be alerted if any of the following fault conditions occur: power
supply failure, elevated ambient temperature, or fan failure. A yellow triangle with
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an exclamation point and the name of the failure will appear in the header of
each screen. This notification will appear or disappear only after you refresh the
page. You can click on the notification to get more information.

3.3 KVM s4 Switch Sessions
From the Active Sessions screen, you can view a list of active sessions and the
following information about each session: Target Device, Owner, Remote Host,
Duration, and Type.

Launching a session
Java 1.6.0_11 or later is required to launch a session.

To launch a session:

1. From the side navigation bar, select Unit View > Target Devices. A list of
available devices will appear.

2. Click the KVM Session or Serial Session link to the right of the desired target
device to launch the session.

If the target device is currently in use, users attempting to gain access will be
given an opportunity to force a connection to the device if their preemption level
is equal to or higher than the current user’s.

To switch to the active session from the local UI (local users only):

1. From the side navigation bar, select Local Session.

2. Select the Resume Active Session check box. The Video Viewer window will
appear.

-or-

Press Esc.

Configuring sessions

To configure general session settings:

1. From the side navigation bar, select Unit View > Appliance > Appliance
Settings > Sessions > General. The Appliance General Session Settings
screen appears.

2. Select or deselect the Enable Inactivity Timeout check box.

3. In the Inactivity Timeout field, enter the amount of inactive time you want to
pass before the session closes (from 1 to 90 minutes).
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4. In the Login Timeout field, enter the amount of inactive time you want to pass
before you must log in again (from 21 to 120 seconds).

5. Select or deselect the Enable Preemption Timeout check box.

6. In the Preemption Timeout field, enter the amount of time (from 1 to 120
seconds) that a prompt will be displayed to inform you that your session is
going to be preempted.

7. Click Save.

To configure KVM session settings:

1. From the side navigation bar, select Unit View > Appliance > Appliance
Settings > Sessions > KVM. The Appliance KVM Session Settings screen
appears.

2. Select an encryption level for keyboard and mouse signals (128-bit SSL,
DES, 3DES, or AES) and for video signals (128-bit SSL, DES, 3DES, AES, or
None).

3. Select a language from the Keyboard drop-down menu.

4. Click Save.

To configure serial session settings:

1. From the side navigation bar, select Unit View > Appliance > Appliance
Settings > Settings > Serial. The Appliance Serial Session Settings screen
appears.

2. Either enable or disable the Telnet Access Enabled check box.

3. Click Save.

Closing a session

To close a session:

1. From the side navigation bar, select Active Sessions to display the Appliance
Sessions screen.

2. Click the check box next to the desired target device(s).

3. Click Disconnect.

If there is an associated locked virtualmedia session, it will be disconnected.

To close a session (local users only):

1. From the side navigation bar, select Local Session.
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2. Select the Disconnect Active Session check box.

3.4 KVM s4 Switch Tools
From the Unit Overview screen, you can view the appliance name and type. You
can also perform basic appliance tasks.

Rebooting the switch

To reboot the switch:

1. From the side navigation bar, select Unit View > Appliance > Overview to
open the Unit Overview screen.

2. Click Reboot.

3. A dialog box appears, warning you that all active sessions will be
disconnected. Click OK.

If you are using the localUI, the screen will be blankwhile the switch reboots. If you are
using the remote OBWI, amessage will appear to let you know that the interface is
waiting on the appliance to complete the reboot.

Upgrading the switch firmware

You can update your switch with the latest firmware available.

After the Flash memory is reprogrammed with the upgrade, the switch performs a
soft reset, which terminates all adapter cable sessions. A target device
experiencing an adapter cable firmware update may not display, or may display
as disconnected. The target device will appear normally when the Flash update
is completed.

WARNING: Disconnecting an adapter cable during a firmware update or cycling power
to the target device will render themodule inoperable and require the adapter cable to
be returned to the factory for repair.

To upgrade the switch firmware:

1. From the side navigation bar, select Unit View > Appliance > Overview to
open the Unit Overview window.

2. Click Upgrade Firmware to open the Upgrade Appliance Firmware.

3. Select one of the following options from which to load the firmware file: File
System, TFTP, FTP, or HTTP.

The File System option is only available on the remote OBWI.
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4. If you selected File System, select Browse to specify the location of the
firmware upgrade file.

-or-

If you selected TFTP, enter the Server IP Address and Firmware File you
wish to load.

-or-

If you selected FTP or HTTP, enter the Server IP Address and Firmware
File you wish to load, as well as the User Name and User Password.

5. Click Upgrade.

Saving and restoring switch configurations and user databases

You may save the switch configuration to a file. The configuration file will contain
information about the managed appliance. You may also save the local user
database on the switch. After saving either file, you may also restore a previously
saved configuration file or local user database file to the switch.

To save a managed appliance configuration or user database of a managed
appliance:

1. From the side navigation bar, select Unit View > Appliance > Overview to
open the Unit Overview window.

2. Click Save Appliance Configuration or Save Appliance User Database. The
File Download dialog box will open.

3. Click Save. The Save As dialog box will open.

4. Navigate to the desired location and enter a name for the file. Click Save.

5. Click Close.

To restore a managed appliance configuration or user database of a
managed appliance:

1. From the side navigation bar, select Unit View > Appliance > Overview to
open the Unit Overview window.

2. Click Restore Appliance Configuration or Restore Appliance User Database.
The Restore Appliance Configuration Window or Restore Appliance User
Database Window will appear.

3. Click Browse. Navigate to the desired location and select the file name. Click
Upload.
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4. After the success screen appears, click Close. Reboot the managed
appliance to enable the restored configuration. See "KVM s4 Switch Tools"
on page 27.

3.5 Network Settings
Only switch administrators canmake changes to the network dialog box settings. Other
userswill have view only access.

To configure general network settings:

1. From the side navigation bar, select Unit View > Appliance > Appliance
Settings > Network > General. The Appliance General Network Settings
screen appears.

2. Select one of the following options from the LAN Speed drop-down menu:
Auto-Detect, 10 Mbps Half Duplex, 10 Mbps Full Duplex, 100 Mbps Half
Duplex, 100 Mbps Full Duplex, or 1 Gbps Full Duplex.

Youmust reboot if you change the Ethernet mode.

3. Select either Enabled or Disabled in the ICMP Ping Reply drop-down menu.

4. Click Save.

To configure IPv4 network settings:

1. From the side navigation bar, select Unit View > Appliance > Appliance
Settings > Network > IPv4. The switch IPv4 Settings screen appears.

2. Select or deselect the Enable IPv4 check box to enable or disable IPv4
mode.

3. Enter the desired information in the Address, Subnet, and Gateway fields.

4. Select either Enabled or Disabled in the DHCP drop-down menu.

If you enable DHCP, any information that you enter in the Address, Subnet, and
Gateway fieldswill be ignored.

5. Click Save.

To configure IPv6 network settings:

1. From the side navigation bar, select Unit View > Appliance > Appliance
Settings > Network > IPv6. The switch IPv6 Settings screen appears.

590-1058-640A 29



3. Local and Remote Configuration

2. Select or deselect the Enable IPv6 Stateful Configuration check box to
enable or disable.

3. Enter the desired information in the Address, Gateway, and Prefix Length
fields.

4. Select either Enabled or Disabled in the DHCPv6 drop-down menu.

If you enable DHCPv6, any information that you enter in the Address, Gateway, and
Prefix length fieldswill be ignored.

5. Click Save.

3.6 DNS Settings
You can choose to either manually assign the DNS server or to use the
addresses obtained using DHCP or DHCPv6.

Tomanually configure DNS settings:

1. From the side navigation bar, select Unit View > Appliance > Appliance
Settings > DNS. The Appliance DNS Settings screen appears.

2. SelectManual, DHCP (if IPv4 is enabled) or DHCPv6 (if IPv6 is enabled).

3. If you selected Manual, enter the DNS Server numbers in the Primary,
Secondary and Tertiary fields.

4. Click Save.

3.7 Local UI Settings
To change how the local UI is invoked:

1. From the side navigation bar, select Unit View > Appliance > Appliance
Settings > Ports > Local Port UI to open the Local Port UI Settings screen.

2. Under the Invoke Local Port UI heading, select the check box next to one or
more of the listed methods.

3. Click OK.

Local port user settings

You can turn on or turn off local port user interface authentication and choose a
user access level. If you turn on local port user interface authentication, you will
be required to log in to use the interface.
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You can also select the keyboard language for the local port, scan mode time,
enable/disable the setup port password and select a user preemption level. The
preemption level of users determines whether they may disconnect another
user’s serial or KVM session with a target device. Preemption levels range from 1
- 4, with 4 being the highest level. For example, a user with a preemption level of
4 may preempt other level 4 users, as well as those with a level 1, 2, or 3 setting.

To change the default preemption level (administrator only):

1. From the side navigation bar, select Unit View > Appliance > Appliance
Settings > Ports > Local Port UI to open the Local Port UI Settings screen.

2. Select or deselect the Disable Local Port User Authentication check box.

3. Select one of the following options from the User Access Level drop-down
menu: User, User Administrator, or Appliance Administrator.

4. Select a number 1 - 4 from the User Preemption Level drop-down menu.

5. Click Save.

3.8 Virtual media
You can determine the behavior of the switch during a virtual media session
using the options provided in the Appliance Virtual Media Session Settings
screen. outlines the options that can be set for virtual media sessions. For
information about using virtual media in a KVM session, see "Virtual Media" on
page 60.

Setting Description

Session Settings:
VirtualMedia
locked to KVM
session

The locking option specifieswhether a virtualmedia session is
locked to the KVM session on the target device.When locking is
enabled (default) and the KVM session is closed, the virtualmedia
session will also be closed.When locking is disabled and the KVM
session is closed, the virtualmedia session will remain active.

Session Settings:
 Allow Reserved
Sessions

Ensures that a virtualmedia connection can only be accessed with
your username and that no other user can create a KVM connection
to that target device.When the associated KVM session is
disconnected, the virtualmedia sessionmaybe disconnected
according to the Locked setting in the VirtualMedia dialog box.

Table 3.4: Virtual Media Session Settings
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Setting Description

DriveMappings:
VirtualMedia
AccessMode

Youmayset the accessmode for mapped drives to read-only or
read-write.When the accessmode is read-only, the user will not be
able to write data to themapped drive on the client server.When the
accessmode is read-write, the user will be able to read and write
data from/to themapped drive. If themapped drive is read-only by
design (for example, a CD-ROMdrive, DVD-ROMdrive or ISO
images), the configured read-write accessmodewill be ignored.
Setting the read-onlymode can be helpfulwhen a read-write drive
such asamass storage device or a USB removablemedia is
mapped, and you wish to prevent the user fromwriting data to it.

You can have one DVD drive and onemass storage devicemapped
concurrently. ACD drive, DVD drive, or ISOdisk image file is
mapped asa virtualCD/DVD drive.

Encryption Level
Youmayconfigure encryption levels for virtualmedia sessions. The
choicesare: None (default), 128-bit SSL (ARCFOUR), DES,
3DES, and AES.

VirtualMedia
Accessper adapter
cable:Enable
VM/Disable VM

The VirtualMedia Accessper the adapter cable section lists all KVM
s4 Adapter USB20-VGA cables. The list includesdetails about each
cable, including the option to enable or disable virtualmedia for each
cable.

To set virtual media options:

1. From the side navigation bar, select Unit Views > Appliance > Appliance
Settings > Sessions > Virtual Media to open the Appliance Virtual Media
Session Settings screen.

2. Either enable or disable the Virtual Media locked to KVM Sessions check
box.

3. Either enable or disable the Allow Reserved Sessions check box.

4. Select one of the following options from the Virtual Media Access Mode from
the drop-down menu: Read-Only or Read-Write.

5. Select one of the Encryption Levels that you wish to be supported.

6. Select the check box next to each KVM s4 Adapter USB20-VGA cable for
which you want to enable virtual media and click Enable VM.

-or-
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Select the check box next to each KVM s4 Adapter USB20-VGA cable
for which you want to disable virtual media and click Disable VM.

7. Click Save.

Local virtual media settings

Local users can also determine the behavior of virtual media from the Local
Session screen. In addition to connecting and disconnecting a virtual media
session, you can configure the settings in the following table.

Table 3.5. Local Virtual Media Session Settings

Setting Description

CD ROM/

DVD ROM

Allowsvirtualmedia sessions to the first detected CD-ROMor DVD-
ROM (read-only) drives. Enable this checkbox to establish a virtual
media CD-ROMor DVD-ROM connection to a target device. Disable
to end a virtualmedia CD-ROMor DVD-ROM connection to a target
device.

MassStorage

Allowsvirtualmedia sessions to the first detectedmass storage drive.
Enable this checkbox to establish a virtualmediamass storage
connection to a target device. Disable to end a virtualmediamass
storage connection to a target device.

Reserved
Ensures that a virtualmedia connection can only be accessed with your
username and that no other user can create a KVM connection to that
target device.

To configure local virtual media settings:

1. From the side navigation bar, select Local Session.

2. Select to enable or deselect to disable any of the Virtual Media Session
options.

3.9 Modem settings
From the Appliance Modem Settings screen, you can configure several modem
settings, as well as view the following modem settings: Local Address, Remote
Address, Subnet Mask, and Gateway.

For information on connecting your switch to a modem, see "Connecting the
switch hardware" on page 11.
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To configure modem settings:

1. From the side navigation bar, select Unit View > Appliance > Appliance
Settings > Ports > Modem to open the Appliance Modem Settings screen.

2. Either enable or disable the Modem sessions can preempt digital sessions
check box.

3. Select an Authentication Timeout time from 30 to 300 seconds, and an
Inactivity Timeout time from 1 to 60 minutes.

4. Select Save.

3.10 Scan mode
In Scan mode, the switch automatically scans from port to port (target device to
target device). You can scan multiple target devices, specifying which devices to
scan. The scanning order is determined by placement of the target device in the
list. You can also configure the amount of time before the scan moves to the next
target device in the sequence.

The Scan button is disabled if you are connected viamodem.

To add target devices to the Scan list:

1. From the side navigation bar, select Unit View > Target Devices to open the
Target Devices screen.

2. Select the check boxes next to the names of the target devices you wish to
scan.

3. Click Scan.

To configure Scan Time:

1. From the side navigation bar, select Unit View > Appliance > Appliance
Settings > Ports > Local Port UI to open the Local Port UI Settings screen.

2. Under the Scan Mode heading, enter an amount of time in seconds (from 3-
255) in the Scan Time field.

3. Click Save.

3.11 DSView 3 device IP addresses
You can contact and register an unmanaged switch with a DSView 3 server by
specifying the IP addresses of up to four DSView 3 servers.
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To configure the DSView 3 server IP address:

1. On the side navigation bar, select Unit View > Appliance > Appliance
Settings > User Accounts > DSView 3. The DSView 3 Settings screen is
displayed.

2. Enter up to four DSView 3 software server IP addresses that you want to
contact in the Server 1 - 4 fields.

3. Click Save.

3.12 User Accounts

Managing local accounts

The switch OBWI provides local and login security through administrator-defined
user accounts. By selecting Local Accounts on the side navigation bar,
administrators may add and delete users, define user preemption, and access
levels and change passwords.

Access levels

When a user account is added, the user may be assigned to any of the following
access levels: Appliance administrators, User administrators, and Users.

AccessLevel

Operation Appliance
Administrator

User
Administrator Users

Configure
interface
system-level
settings

Yes No No

Configure
access rights

Yes Yes No

Add, change
and delete user
accounts

Yes, for all
access levels

Yes, for users
and user
administrators
only

No

Table 3.6: Allowed Operations by Access Level
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AccessLevel

Operation Appliance
Administrator

User
Administrator Users

Change your
own password

Yes Yes Yes

Access target
device

Yes, all target
devices

Yes, all target
devices

Yes, if allowed

To add a new user account (administrator only):

1. On the side navigation bar, select Unit View > Appliance > Appliance
Settings > User Accounts > Local Accounts to open the Appliance Local User
Accounts screen.

2. Click the Add button.

3. Enter the name and password of the new user in the blanks provided.

4. Select the preemption and access levels for the new user.

5. Select any of the available target devices that you wish to assign to the user
account and click Add.

User administrators and appliance administrators can accessall target devices.

6. Click Save.

To delete a user account (administrator only):

1. On the side navigation bar, select Unit View > Appliance > Appliance
Settings > User Accounts > Local Accounts to open the Appliance Local User
Accounts screen.

2. Click the check box to the left of each account that you wish to delete, then
click Delete.

To edit a user account (administrator or active user only):

1. On the side navigation bar, select Unit View > Appliance > Appliance
Settings > User Accounts > Local Accounts. The Appliance Local User
Accounts screen is displayed.

2. Click the name of the user you wish to edit. The user profile will appear.

3. Fill out the user information on the screen, then click Save.
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3.13 SNMP settings
SNMP is a protocol used to communicate management information between
network management applications and the switch. Other SNMP managers can
communicate with your switch by accessing MIB-II and the public portion of the
enterprise MIB. When you open the SNMP screen, the OBWI will retrieve the
SNMP parameters from the unit.

From the SNMP screen, you can enter system information and community strings.
You may also designate which stations can manage the switch as well as receive
SNMP traps from the switch. If you select Enable SNMP, the unit will respond to
SNMP requests over UDP port 161.

To configure general SNMP settings:

1. Select Unit View > Appliance > Appliance Settings > SNMP > SNMP Settings
to open the SNMP screen.

2. Click to enable the Enable SNMP check box to allow the switch to respond to
SNMP requests over UDP port 161.

3. Enter the system’s fully qualified domain name in the Name field, as well as
a node contact person in the Contact field.

4. Enter the Read, Write, and Trap community names. These specify the
community strings that must be used in SNMP actions. The Read and Write
strings only apply to SNMP over UDP port 161 and act as passwords that
protect access to the switch. The values can be up to 64 characters in length.
These fields may not be left blank.

5. Type the address of up to four management workstations that are allowed to
manage this switch in the Allowable Managers fields. Alternatively, you may
leave these fields blank to allow any station to manage the switch.

6. Click Save.

3.14 Event settings
An event is a notification sent by the switch to a management station indicating
that something has occurred that may require further attention.

To enable individual events:

1. Select Unit View > Appliance > Appliance Settings > Auditing > Events to
open the Events screen.
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2. Specify the events that will generate notifications by clicking the appropriate
check boxes in the list.

-or-

Select or clear the check box next to Event Name to select or deselect
the entire list.

3. Click Save.

3.15 Setting event destinations
You can configure audit events to be sent to SNMP trap destinations and Syslog
servers. The events enabled on the Events screen are sent to all the servers
listed on the Event Destination screen.

1. Select Unit View > Appliance > Appliance Settings > Auditing > Destinations
to open the Event Destinations screen.

2. Type the address of up to four management workstations to which this switch
will send events in the SNMP Trap Destination fields, as well as up to four
Syslog servers.

3. Click Save.

3.16 Configuring Adapter Cables
From the switch, you can display a list of the attached adapter cables, as well as
the following information about each cable: eID (electronic ID), Port, Status,
Application, Interface Type, and USB Speed. You can click on one of the cables
to view the following additional information: Switch Type, Boot Version, Hardware
Version, FPGA Version, Version Available, and Upgrade Status.

You can also perform the following tasks: delete offline adapter cables, upgrade
the cable firmware, set the USB speed, or decommission the cables.

To delete offline adapter cables:

1. From the side navigation bar, click Unit View > Appliance > Appliance
Settings > Ports > Adapter cables to open the Appliance adapter cable
screen.

2. Click Delete Offline.

To set the USB Speed (for KVM s4 Adapter USB20-VGA cables only):

1. From the side navigation bar, click Unit View > Appliance > Appliance
Settings > Ports > USB20-VGA to open the Appliance USB20-VGA screen.

2. Select the check box(es) next to the cable(s) that you wish to modify.
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3. Click either Set USB 1.1 Speed or Set USB 2.0 Speed.

Upgrading adapter cables

The adapter cable Flash upgrade feature allows appliance administrators to
update the adapter cable with the latest firmware available. This update can be
performed using the switch user interface or DSView 3 software.

After the Flash memory is reprogrammed with the upgrade, the switch performs a
soft reset, which terminates all adapter cable sessions. A target device
experiencing an adapter cable firmware update may or may not display as
disconnected. The target device will appear normally when the Flash update is
completed.

If the appliance is configured to Auto-Upgrade adapter cables, the adapter cables
will automatically update when the switch is updated. To update your switch
firmware, see "KVM s4 Switch Tools" on page 27 or the DSView 3 Software
Online Help. If issues occur during the normal upgrade process, adapter cables
may also be force-upgraded when needed.

Checkhttp://www.ts.fujitsu.com for firmware upgrade files.

To upgrade the adapter cable firmware:

1. From the side navigation bar, click Unit View > Appliance > Appliance
Settings > Ports > Adapter cables to open the Appliance adapter cables
screen.

2. Select the check box(es) next to the adapter cable(s) that you wish to
upgrade and click Upgrade.

WARNING: Disconnecting an adapter cable during a firmware update or cycling power
to the target device will render themodule inoperable and require the adapter cable to
be returned to the factory for repair.

3.17 Power device settings
Youmust have administrator privileges to change power control device settings.

From the Appliance Power Devices screen, you can view a list of connected
power devices, as well as the following information about each power device:
Name, Port, Status, Version, Model, Buzzer, Alarm, and Temperature. You can
also select a power device, then select Settings to view the following details
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about that power device: Name, Description, Status, Version, Sockets, Vendor
Name, Model, and Input Feeds.

If a target device is connected to a power control device outlet, you can turn on,
turn off or cycle (turn off, then turn on) the target device.

To turn on, turn off or power cycle a target device:

1. From the side navigation bar, select Unit View > Appliance > Appliance
Settings > Ports > Power Devices to open the Appliance Power Devices
screen.

2. Click the name of the unit you wish to configure and select Sockets.

3. Select the check box to the left of the socket(s) that you wish to configure.

4. Click On,Off, or Cycle, as desired.

To delete offline power devices:

1. From the side navigation bar, select Unit View > Appliance > Appliance
Settings > Ports > Power Devices to open the Appliance Power Devices
screen.

2. Click Delete Offline.

To change the minimum on time, off time or wake up state:

1. From the side navigation bar, select Unit View > Appliance > Appliance
Settings > Ports > Power Devices to open the Appliance Power Devices
screen.

2. Click the name of the unit you wish to configure and select Sockets.

3. Click the socket name that you wish to modify.

4. Use the drop-down windows to alter the desired settings and click Save.

Associated target servers and power outlets

By naming one or more power outlets with the same name as a target server, the
outlets are linked or associated with the target server for easier control. In the
OBWI Target Devices page, power control actions are selectable for a target with
linked outlets. On the Target Overview page, a Wall Outlet Power table shows the
outlets linked with a target device.

In the following figure, the target device named Server2 has linked power outlets.
Clicking on the drop-down menu arrow in the Action column shows the additional
power actions available.
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Figure 3.2. Target devices

In the following figure, the target Unit Overview page for Server2 shows the Wall
Power, where outlet 1 and outlet 9 from PDU 1 are linked to Server2.

Figure 3.3. Target overview Server2

Grouping power outlets

Multiple power outlets may be given the same name to link them into one group,
which is listed as one target device. Power actions performed on the Target
Devices page are applied to all applicable outlets. Power control actions for
specific power outlets of a target may be performed on the Unit Overview page. In
the following figure, the target named Group2 is composed of power outlets 4 and
5 from PDU 1.
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Figure 3.4. Target overview for Group2

Default outlet names

On the Power Devices page, the check box “Assign Default Names to Outlets”
controls whether or not power outlets are given default names for a power device,
as shown in the following figure. Only power outlets with names are listed on the
Target page. Default assigned power outlet names may be removed by clearing
the "Assign Default Names to Outlets" check box and saving. Power outlets
without names are assigned default names by turning on “Assign Default Names
to Outlets” and saving.

Figure 3.5. Appliance power devices page

Assigning an outlet name

On the Power Device Outlet Settings page, three options are available for
assigning the name of a outlet as shown in the following figure. The options are
Manual Name assignment, Link to Target Device and Do Not Display as Target
Device.
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Figure 3.6. Power device outlet settings page

• The Manual Name assignment gives a unique name to a outlet. The name
must be unique for all the adapter cables and power outlet names. An
attempt to specify a manual name which is not unique will result in an error
and the name will not be saved.

• The Link to Target Device assignment links the outlet to another target name
(either an outlet or adapter cable) for power control of the named target.
When an outlet is linked to an adapter cable target name, typically the outlet
physically provides power to the server attached to the adapter cable.

• The Do Not Display as Target Device option gives the outlet a blank name,
which prevents it from being displayed on the Target Devices page. This
option may be used for spare outlets to remove them from the Target Devices
page.

Access control inheritance

When a power outlet name is changed by linking it to a target, the outlet inherits
the access control already configured for that target name. When an adapter
cable is added, if the name retrieved from the adapter cable matches the name of
an existing target, the new adapter cable inherits the access control from that
target. When a target device is renamed, all the adapter cables and outlets of that
target are renamed, and they carry forward the access control previously
configured for the old target name.

Renaming of a target device

On the Target Overview page, the name for that target may be changed to any
unique target name. The name must be unique for the set of all targets, including
adapter cables and power outlets. When a target is renamed, all outlets linked to
that target are also given the new target name.
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Prioritized status of target devices

On the Target Devices page, a target with linked power outlets controls multiple
devices. The Status value displayed for a target is chosen as the highest priority
of all the status values of the devices. The following table shows the possible
status values in priority order (highest to lowest) and the applicable target device
types.

StatusValue Applicable for: StatusDescription

Adapter
Cable

Power
Outlet

In Use x N/A A session is active

Path Blocked x N/A Path to Target is in use byanother session

Upgrading x N/A The adapter cable is being upgraded

Powering On N/A x One or more outlets are powering on

Powering Off N/A x One or more outlets are powering off

No Power x N/A No power detected on the adapter cable

Partial Power N/A x Target hasoutlets in both on and off states

Locked-Off N/A x One or more outlets are locked on

PoweredOff N/A x One or more outlets are powered off

Locked-On N/A x One or more outlets are locked off

Idle x N/A No session active; the adapter cable has
power

PoweredOn N/A x Outlets are powered on

Table 3.7: Target Status Values

When a target device has multiple power outlets linked by name and they do not
have a common power state, the appliance may consider the Locked-Off outlet
status as Off, and the Locked-On outlet status as On. The following table lists the
resulting Status values for combinations of two outlet status values.
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Outlet 1 Status Outlet 2 Status Resulting Status

Off Off Off

Off On Partial Power

On On PoweredOn

Locked-On On PoweredOn

Locked-On Locked-On Locked-On

Locked-On Off Partial Power

Locked-Off On Partial Power

Locked-Off Locked-Off Locked-Off

Locked-Off Off PoweredOff

Locked-On Locked-Off Partial Power

Table 3.8: Multiple outlet status values and displayed status

Local Session page on the local port

On the local port's Local Session page, when the target of the active session has
power outlets linked, three power controls are displayed on the page under the
Active session. The following figure illustrates the power controls displayed for an
active local port session for a target named Server2.

Figure 3.7. Local Session page with power controls
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4.1 The Video Viewer window
The Video Viewer is used to conduct a KVM session with the target devices
attached to an switch using the OBWI. When you connect to a device using the
Video Viewer, the target device desktop appears in a separate window
containing both the local and the target device cursors.

The switch OBWI software uses a Java-based program to display the Video
Viewer window. The switch OBWI automatically downloads and installs the Video
Viewer the first time it is opened.

Java 1.6.0_11 or later is required to launch a session.

The switch OBWI doesnot install the Java Runtime Environment (JRE). The JRE is
available asa free download from http://www.sun.com.

The switch OBWI uses systemmemory to store and display imageswithin Video Viewer
windows. Each opened Video Viewer window requiresadditional systemmemory. An
8-bit color setting on the client server requires1.4MBofmemoryper Video Viewer
window, a 16-bit color setting requires2.4MBand a 32-bit color setting requires6.8
MB. If you attempt to openmore Video Viewer windows than your systemmemory
allows (usually four), you will receive an out-of-memoryerror and the requested Video
Viewer window will not open.

If the device you are attempting to access is currently being viewed by another
user, you will be prompted to preempt the other user if your preemption level is
equal to or greater than the other user's preemption level. An appliance
administrator can also disconnect an active user via the Active Session page. For
more information, see "KVM s4 Switch Sessions" on page 25.
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Figure 4.1. Video Viewer window (normal window mode)

Table 4.1. Descriptions for Figure 4.1

Number Description

1
Title Bar: Displays the name of the target device being viewed.When in
Full Screenmode, the title bar disappears and the target device name
appears between themenu and toolbar.

2
Thumbtack icon: Locks the displayof themenu and toolbar so that it is
visible at all times.

3

Menu and toolbar: Enables you to accessmanyof the features in the
Video Viewer window. Themenu and toolbar is in a show/hide state if
the thumbtackhasnot been used. Place your cursor over the toolbar to
display themenu and toolbar. Up to ten commandsand/or macro group
buttons can be displayed on the toolbar. Bydefault, the Single Cursor
Mode, Refresh, AutomaticVideo Adjust, and Align LocalCursor buttons
appear on the toolbar. For more information, see "Changing the
toolbar" on page 49 and "Macros" on page 66.
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Number Description

4
Macro buttons: Commonly used keyboard sequences that can be sent to
the target device.

5 Minimize button: Minimizes the displayof the Video Viewer window into
the taskbar at the bottom of the local computer.

6

Maximize button: Changes the window to Full Screenmode that
expands the accessed device desktop to fill the entire screen. Expanding
the window causes the following to occur:

The title bar disappears.

The target device name appears between themenu and toolbar.

TheMaximize button changes to a NormalWindowMode button and
appears on the toolbar. Clicking the button toggles the Video Viewer
window to NormalWindowmode.

The Close button appears on the toolbar.

7
Close button: Closes the Video Viewer window.

NOTE: TheClose buttonmaynot be present for all operating systems.

8
Accessed device desktop: Interactswith your device through this
window.

9 Frame: Resizes the Video Viewer window byclicking and holding on the
frame.

Changing the toolbar

You can choose the amount of elapsed time before the toolbar hides in the Video
Viewer window when it is in show/hide state (that is, not locked in place by the
thumbtack).

To specify a toolbar hide time:

1. Select Tools > Session Options from the Video Viewer window menu.

-or-

Click the Session Options button.

The Session Options dialog box appears.

2. Click the Toolbar tab.
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3. Use the arrow keys to specify the number of elapsed seconds prior to hiding
the toolbar.

4. Click OK to save your changes and close the dialog box.

4.2 Launching a Session
When using a non-proxied connection, video performance over a slower network
connectionmaybe less than optimal. Since certain color settings (such asGrayscale)
use lessnetwork bandwidth than others (such asBest Color), changing the color
settings can increase video performance. For optimal video performance over a slower
network connection, use a color setting such asGrayscale/Best Compression or Low
Color/High Compression. See "Adjusting the View" on page 51 for more information.

If a user connects to a target device with a higher screen resolution than the local
computer, the Video Viewer window will display a portion of the target device screen,
with scroll bars for viewing the remainder of the screen. The user mayview the entire
screen byadjusting the resolution on the target device, the local computer or both.

To launch a KVM session from the switch Explorer window:

1. Click on a device listed on the Target Devices screen to open the unit
overview window.

2. Click the KVM Session link to open the Video Viewer in a new window.

Session time-out

A remote session can time-out when no activity occurs in a Session window for a
specified time. The session time-out value can be configured in the Appliance
KVM Session Settings window. The specified time-out value will be used the next
time the switch OBWI is accessed.

To enable, disable or configure the session time-out:

1. In the side menu, select Unit View > Appliance > Appliance Settings >
Sessions > General.

2. Select the desired setting for the Enable Inactivity Timeout box.

3. If necessary, select the time limit for the inactivity time-out.

4. Click Save.
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4.3 Window Size
The View >Scaling command is not available if the Video Viewer window is in Full
Screenmode or to non-primary users of a shared session.

When the switch OBWI is used for the first time, any open Video Viewer windows
display at a resolution of 1024 x 768 until the user changes the value. Each
Video Viewer window can be set to a different resolution.

The switch OBWI automatically adjusts the display if the window size changes
during a session as long as autoscaling is enabled. If the target device resolution
changes any time during a session, the display adjusts automatically.

To change the Video Viewer window resolution:

1. Select the View > Scaling command.

2. Select the desired resolution.

4.4 Adjusting the View
Using menus or task buttons in the Video Viewer window, you can do the
following:

• Align the mouse cursors.

• Refresh the screen.

• Enable or disable Full Screen mode. When Full Screen mode is enabled, the
image adjusts to fit the desktop up to a size of 1600 x 1200 or 1680 x 1050
(widescreen). If the desktop has a higher resolution, the following occurs:

• The full-screen image is centered in the desktop, and the areas
surrounding the Video Viewer window are black.

• The menu and toolbar are locked so that they are visible at all times.

• Enable automatic, full or manual scaling of the session image:

• With full scaling, the desktop window remains fixed and the device
image scales to fit the window.

• With automatic scaling, the desktop window is sized to match the
resolution of the target device being viewed.

• With manual scaling, a drop-down menu of supported image scaling
resolutions is displayed.

• Change the color depth of the session image.
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To align the mouse cursors:

Click the Align Local Cursor button in the Video Viewer window toolbar. The local
cursor should align with the cursor on the remote device.

If cursors drift out of alignment, turn off mouse acceleration in the attached device.

To refresh the screen, click the Refresh Image button in the Video Viewer
window, or select View > Refresh from the Video Viewer window menu. The
digitized video image is completely regenerated.

To enable Full Screen mode, click the Maximize button, or select View > Full
Screen from the Video Viewer window menu. The desktop window disappears
and only the accessed device desktop is visible. The screen resizes up to a
maximum of 1600 x 1200 or 1680 x 1050 (widescreen). If the desktop has a
higher resolution, then a black background surrounds the full screen image. The
floating toolbar appears.

To disable Full Screen mode, click the Full Screen Mode button on the floating
toolbar to return to the desktop window.

To enable full scaling, select View > Scaling from the Video Viewer window
menu. The device image scales automatically to the resolution of the target
device being viewed.

To enable manual scaling, select View > Scaling from the Video Viewer window
menu. Choose the dimension to scale the window. The available manual scaling
sizes will vary according to your system.

4.5 Refreshing the Image
Clicking the Refresh Image button in the Manual Video Adjust dialog box
completely regenerates the digitized video image.

You can also selectView >Refresh from the Video Viewer windowmenu to refresh the
image.

4.6 Video Settings

Additional video adjustment

Generally, the Video Viewer window automatic adjustment features optimize the
video for the best possible view. However, users can fine-tune the video with the
help of Fujitsu Technical Support by selecting the Tools > Manual Video Adjust
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command in the Video Viewer window menu or clicking the Manual Video Adjust
button. This displays the Manual Video Adjust dialog box. Video adjustment is a
per target setting.

Users can also verify the level of packets per second required to support a static
screen by observing the packet rate located in the lower left-hand corner of the
dialog box.

Tomanually adjust the video quality of the window:

The following video adjustments should bemade onlywith the help of Fujitsu Technical
Support.

1. Select Tools > Manual Video Adjust from the Video Viewer window menu.

-or-

Click the Manual Video Adjust button.

The Manual Video Adjust dialog box appears.

Figure 4.2. Manual Video Adjust dialog box
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Number Description Number Description

1
Image Capture
Width

8 PixelNoise Threshold

2
Pixel
Sampling/Fine
Adjust

9 AutomaticVideo Adjustment

3
Image Capture
Horizontal
Position

10 Refresh Image

4
Image Capture
VerticalPosition

11 Adjustment bar

5 Contrast 12 Video Test Pattern

6 Brightness 13 PerformanceMonitor

7
BlockNoise
Threshold

14 Close button

Table 4.2: Descriptions for Figure 4.2

2. Click the icon corresponding to the feature you wish to adjust.

3. Move the Contrast slider bar and then fine-tune the setting by clicking the
Min (-) or Max (+) buttons to adjust the parameter for each icon pressed. The
adjustments display immediately in the Video Viewer window.

4. When finished, click Close to exit the Manual Video Adjust dialog box.

Target video settings

The Image Capture Width, Pixel Sampling/Fine Adjust, Image Capture Horizontal
Position and Image Capture Vertical Position adjustments affect how the target
video is captured and digitized. They are seldom changed.

The image capture parameters are automatically changed by the Automatic
Adjustment function. A special image is required on the target in order to make
accurate adjustments independently.
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Automatic video adjustment

In most cases, you do not need to alter the Video Settings from the default
settings. The system automatically adjusts and uses the optimal video
parameters. The switch OBWI performs best when the video parameters are set
such that no (0) video packets are transmitted for a static screen.

You can easily adjust your video parameters to ideal settings by clicking on the
Auto Adjust Video button in the Manual Video Adjust dialog box.

You can also select Tools >AutomaticVideo Adjust from the Video Viewer window
menu or click theAutomaticVideo Adjust toolbar icon to automatically adjust the video.

Video Test Pattern

Clicking the Video Test Pattern button in the Manual Video Adjust dialog box
toggles a display of a video test pattern. Click the Video Test Pattern button again
to toggle back to a normal video image.

Vendor-specific video settings

Video settings vary significantly among manufacturers.

4.7 Color Settings

Adjusting color depth

The Dambrackas Video Compression (DVC) algorithm enables users to adjust
the number of viewable colors in a remote session window. You can choose to
display more colors for the best fidelity or fewer colors to reduce the volume of
data transferred on the network.

Video Viewer windows can be viewed using the Best Color Available (slower
updates), Best Compression (fastest updates), a combination of Best Color and
Best Compression or in Grayscale.

You can specify the color depths of individual ports and channels by selecting the
View Color command in a remote session window. These settings are saved
individually per channel.

Contrast and brightness

If the image in the Video Viewer window is too dark or too light, select Tools >
Automatic Video Adjust or click the Automatic Video Adjust button. This command
is also available in the Video Adjustments dialog box. In most cases, this corrects
video issues.
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When clicking Auto Adjust several times does not set the contrast and brightness
as desired, adjusting the contrast and brightness manually can help. Increase the
brightness. Do not go more than 10 increments before moving the contrast.
Generally, the contrast should be moved very little.

4.8 Noise Settings

Detection thresholds

In some cases, noise in the video transmission keeps the packets/sec count up,
which is indicated by small dots changing in the area of the cursor when it is
moved. Varying the threshold values may result in “quieter” screens and can
improve cursor tracking.

You can modify Noise Threshold and Priority Threshold values if you are using
standard video compression. You can also modify Block Noise Threshold and
Pixel Noise Threshold values. You can restore default threshold values by
clicking Auto Adjust Video.

Block Noise Threshold and Pixel Noise Threshold

The Block Noise Threshold and Pixel Noise Threshold values set the minimum
color levels in terms of changed video blocks and pixels per thousand that are
allowed.

• The Block Noise Threshold sets the minimum color change that occurs in a
single video block. Increasing the value reduces the network bandwidth.
Decreasing the value makes the size of these artifacts smaller.

• The Pixel Noise Threshold sets the minimum color change in a single pixel.
Decreasing the value reduces the number of low-contrast artifacts, but
increases network bandwidth.

See "Adjusting the View" on page 51 for information about changing the color
depth.

4.9 Mouse Settings

Adjusting mouse options

The Video Viewer window mouse options affect cursor type, Cursor mode,
scaling, alignment and resetting. Mouse settings are device-specific; that is, they
may be set differently for each device.
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If the device doesnot support the ability to disconnect and reconnect themouse (almost
all newer PCsdo), then themouse will become disabled and the device will have to be
rebooted.

Cursor type

The Video Viewer window offers five appearance choices for the local mouse
cursor. You can also choose no cursor or the default cursor.

In Single Cursor mode, the display of the local (second) cursor in the Video
Viewer window turns off and only the target device mouse pointer is visible. The
only mouse movements that appear are those of the target device remote cursor.
Use Single Cursor mode when there is no need for a local cursor.

Figure 4.3. Video Viewer window with local and remote cursors displayed

Number Description

1 Remote Cursor

2 LocalCursor

Table 4.3: Descriptions for Figure 4.3

590-1058-640A 57



4. The Video Viewer

The Cursor mode status of the Video Viewer window displays in the title bar,
including the keystroke that will exit Single Cursor mode. You can define the
keystroke that will exit Single Cursor mode in the Session Options dialog box.

When using a device that captures keystrokesbefore they reach the client server, you
should avoid using those keys to restore themouse pointer.

To enter Single Cursor mode, select Tools > Single Cursor Mode from the Video
Viewer window menu, or click the Single Cursor Mode button. The local cursor
does not appear and all movements are relative to the target device.

To select a key for exiting Single Cursor mode:

1. Select Tools > Session Options from the Video Viewer window menu.

-or-

Click the Session Options button.

The Session Options dialog box appears.

2. Click the Mouse tab.

3. Select a terminating keystroke from the drop-down menu in the Single
Cursor mode area.

4. Click Save to save settings.

When you enable Single Cursor mode, you can press the specified key to return
to Regular Desktop mode.

To exit Single Cursor mode, press the key on the keyboard that is identified in the
title bar.

To change the mouse cursor setting:

1. Select Tools > Session Options from the Video Viewer window menu.

-or-

Click the Session Options button.

The Session Options dialog box appears.

2. Click the Mouse tab.

3. Select a mouse cursor type in the Local Cursor panel.

4. Click OK to save settings.
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Mouse scaling

Some earlier versions of Linux did not support adjustable mouse accelerations.
For installations that must support these earlier versions, you can choose among
three pre-configured mouse scaling options or set your own custom scaling. The
pre-configured settings are Default (1:1), High (2:1) or Low (1:2):

• In a 1:1 scaling ratio, every mouse movement on the desktop window sends
an equivalent mouse movement to the target device.

• In a 2:1 scaling ratio, the same mouse movement sends a 2X mouse
movement.

• In a 1:2 scaling ratio, the value is 1/2X.

To set mouse scaling:

1. Select Tools > Session Options from the Video Viewer window menu.

-or-

Click the Session Options button.

The Session Options dialog box appears.

2. Click the Mouse tab.

3. To use one of the pre-configured settings, check the appropriate radio
button.

-or-

To set custom scaling:

a. Click the Custom radio button to enable the X and Y fields.

b. Type a scaling value in the X and Y fields. For every mouse input, the
mouse movements are multiplied by the respective X and Y scaling
factors. Valid input range is 0.25-3.00.

Mouse alignment and synchronization

Because the switch OBWI cannot get constant feedback from the mouse, there
are times when the mouse on the switch may lose sync with the mouse on the
host system. If your mouse or keyboard no longer responds properly, you can
align the mouse to reestablish proper tracking.

Alignment causes the local cursor to align with the remote target device’s cursor.
Resetting causes a simulation of a mouse and keyboard reconnect as if you had
disconnected and reconnected them.
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To realign the mouse, click the Align Local Cursor button in the Video Viewer
window toolbar.

4.10 Virtual Media
The virtual media feature allows the user on the client server to map a physical
drive on that machine as a virtual drive on a target device. The client server may
also add and map an ISO or floppy image file as a virtual drive on the target
device. You may have one CD drive and one mass storage device mapped
concurrently.

• A CD/DVD drive, disk image file (such as an ISO or floppy image file) is
mapped as a virtual CD/DVD-ROM drive.

• A floppy drive, USB memory device or other media type is mapped as a
virtual mass storage device.

For information on configuring virtual media settings using the OBWI, see "Virtual
media" on page 31.

Requirements

The target device must support virtual media and be connected to the KVM switch
with a KVM s4 Adapter USB20-VGA adapter cable.

The target device must be intrinsically able to use the types of USB2-compatible
media that you virtually map. In other words, if the target device does not support
a portable USB memory device, you cannot map that on the client server as a
virtual media drive on the target device.

The user (or user group to which the user belongs) must have permission to
establish virtual media sessions and/or reserved virtual media sessions to the
target device. See "User Accounts" on page 35.

Only one virtual media session may be active to a target device at one time.

Sharing and preemption considerations

The KVM and virtual media sessions are separate; therefore, there are many
options for sharing, reserving or preempting sessions. The DSView 3 software
has the flexibility to accommodate the system needs.

For example, the KVM and virtual media sessions may be locked together. In this
mode, when a KVM session is disconnected, so is the associated virtual media
session. If the sessions are not locked together, the KVM session can be closed
but the virtual media session will remain active. This could be desirable if a user
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is performing a time-intensive task using the virtual media session (such as an
operating system load), and wants to establish a KVM session with a different
target device to perform other functions while the operating system load
progresses.

Once a target device has an active virtual media session without an associated
active KVM session, two situations can occur > the original user (User A) can
reconnect or a different user (User B) can connect to that channel. You may set
an option in the Virtual Media dialog box (Reserved) that allows only the User A
to access that channel with a KVM session.

If User B is allowed to access that session (the Reserved option is not enabled),
User B could control the media that is being used in the virtual media session. By
using the Reserved option in a tiered environment, only User A could access the
lower switch and the KVM channel between the upper switch and lower switch
would be reserved for User A.

Virtual Media dialog box

The Virtual Media dialog box allows you to manage the mapping and unmapping
of virtual media. The dialog box displays all the physical drives on the client
server that can be mapped as virtual drives. You may also add ISO and floppy
image files and then map them using the Virtual Media dialog box.

After a device is mapped, the Virtual Media dialog box Details View displays
information about the amount of data transferred and the time elapsed since the
device was mapped.

You may specify that the virtual media session is reserved. When a session is
reserved, and the associated KVM session is closed, another user cannot launch
a KVM session to that target device. If a session is not reserved, another KVM
session may be launched.

You may also reset the USB2 adapter cable from the Virtual Media dialog box.
This action will reset every form of USB media on the target device. It should be
used with caution and only when the target device is not responding.

Opening a virtual media session

To launch a virtual media session:

Select Tools - Virtual Media from the Video Viewer menu. The Virtual Media
dialog box will appear. To make this a reserved session, click Details, then select
the Reserved check box.
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Figure 4.4. Video Viewer Virtual Media Dialog Box

Tomap a virtual media drive:

1. Open a virtual media session from the Video Viewer menu by selecting Tools
> Virtual Media.

2. To map a physical drive as a virtual media drive:

a. In the Virtual Media dialog box, click the Mapped check box next to the
drive(s) you wish to map.

b. If you wish to limit the mapped drive to read-only access, click the Read
Only check box next to the drive. If the virtual media session settings
were previously configured so that all mapped drives must be read only,
this check box will already be enabled and cannot be changed.

You might wish to enable the Read Only check box if the
session settings enabled read and write access, but you
wished to limit a particular drive’s access to read only.

3. To add and map an ISO or floppy image as a virtual media drive:

a. In the Virtual Media dialog box, click Add Image.

b. The common file dialog box will appear, with the directory containing
disk image files (that is, those ending in .iso or .img) displayed. Select
the desired ISO or floppy image file and click Open.
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-or-

If the client server’s operating system supports drag-and-drop,
select the desired ISO or floppy image file from the common file
dialog box, and drag it onto the Virtual Media dialog box.

c. The file’s header is checked to ensure it is correct. If it is, the common file
dialog box will close and the chosen image file will appear in the Virtual
Media dialog box, where it can be mapped by clicking the Mapped
check box.

d. Repeat steps a through c for any additional ISO or floppy images you
wish to add. You may add any number of image files (up to the limits
imposed by memory), but you may only have one virtual CD or DVD or
virtual mass storage mapped concurrently.

If you attempt to map too many drives (one CD or DVD and one mass storage
device) or too many drives of a particular type (more than one CD or DVD or
mass storage device), a message will be displayed. If you still wish to map a new
drive, you must first unmap an existing mapped drive, then map the new drive.

After a physical drive or image is mapped, it may be used on the target device.

To unmap a virtual media drive:

1. In the Virtual Media dialog box, uncheck the Mapped check box next to the
drive you wish to unmap.

2. You will be prompted to confirm. Confirm or cancel the unmapping.

3. Repeat for any additional virtual media drives you wish to unmap.

To display virtual media drive details:

In the Virtual Media dialog box, click Details. The dialog box expands to display
the Details table. Each row indicates:

• Target Drive - Name used for the mapped drive, such as Virtual CD 1 or
Virtual CD 2.

• Mapped to - Identical to Drive information that appears in the Client View
Drive column.

• Read Bytes and Write Bytes - Amount of data transferred since the mapping.

• Duration - Elapsed time since the drive was mapped.

To close the Details view, click Details again.
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To reset all USB devices on the target device:

TheUSB reset feature resets everyUSBdevice on the target device, including the
mouse and keyboard. It should only be used when the target device is not responding.

1. In the Virtual Media dialog box, click Details.

2. The Details View will appear. Click USB Reset.

3. A warning message will appear, indicating the possible effects of the reset.
Confirm or cancel the reset.

4. To close the Details view, click Details again.

Closing a virtual media session

To close the Virtual Media dialog box:

1. Click Exit.

2. If you have any mapped drives, a message is displayed, indicating that the
drives will be unmapped. Confirm or cancel the operation.

If a user attempts to disconnect a virtual media session or an active KVM session
that has an associated locked virtual media session, a confirmation message is
displayed, indicating that any virtual media mappings will be lost.

4.11 Smart cards
You can connect a smart card reader to an available USB port on the client
server and access attached target devices on the switch system. You can then
launch a KVM session to open the Video Viewer and map a smart card.

For all smart card readers, youmust use a KVM s4 Adapter USB20-VGA cable.

The smart card status is indicated by the smart card icon at the far right of the
Video Viewer toolbar. The following table describes the smart card status icons.

Table 4.4. Smart Card Icons

Icon Description

A smart card is not in the smart card reader, or a smart card reader is not
attached.

A smart card is in the smart card reader but hasnot beenmapped yet.

A smart card ismapped.
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Tomap a smart card:

1. Open a KVM session to display the Video Viewer window menu.

2. Insert a smart card into the smart card reader attached to your client server.

3. Click Tools > Map Smart Card on the Video Viewer window menu.

4. If no smart card is mapped to the target device, the No Card Mapped option
will have a dot beside it. Select your smart card, listed below this option, to
map the smart card.

To unmap a smart card, close out the KVM session by clicking X in the Video
Viewer window menu, selecting Tools > No Card Mapped, removing the smart
card from the smart card reader or disconnecting the smart card reader from the
client server.

4.12 Keyboard pass-through
Keystrokes that a user enters when using a Video Viewer window may be
interpreted in two ways, depending on the Screen mode of the Video Viewer
window.

• If a Video Viewer window is in Full Screen mode, all keystrokes and
keyboard combinations except Ctrl-Alt-Del are sent to the remote target
device being viewed.

• If a Video Viewer window is in Regular Desktop mode, Keyboard Pass-
through mode can be used to control whether the remote target device or
local computer recognizes certain keystrokes or keystroke combinations.

Keyboard pass-through must be specified using the Session Options dialog box.
When enabled, keyboard pass-through sends all keystrokes and keystroke
combinations except Ctrl-Alt-Del to the remote target device being viewed when
the Video Viewer window is active. When the local desktop is active, keystrokes
and keystroke combinations entered by the user affect the local computer.

TheCtrl-Alt-Del keyboard combination can be sent only to a remote target device by
using amacro.

The Japanese keyboard ALT-Han/Zen keystroke combination is always sent to a
remote target device regardlessof the Screenmode or keyboard pass-through setting.

To specify keyboard pass-through:

1. Select Tools-Session Options from the Video Viewer window menu.

-or-
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Click the Session Options button.

The Session Options dialog box appears.

2. Click the General tab.

3. Select Pass-through all keystrokes in regular window mode.

4. Click OK to save setting.

4.13 Macros
The switch OBWI comes pre-configured with macros for the Windows, Linux, and
Sun platforms.

To send a macro, selectMacros-<desired macro> from the Video Viewer window
menu, or select the desired macro from the buttons available on the Video Viewer
menu.

4.14 Saving the view
You can save the display of a Video Viewer either to a file or to the clipboard for
pasting into a word processor or other program.

To capture the Video Viewer window to a file:

1. Select File-Capture to File from the Video Viewer window menu.

-or-

Click the Capture to File button.

The Save As dialog box appears.

2. Enter a filename and choose a location to save the file.

3. Click Save to save the display to a file.

To capture the Video Viewer window to your clipboard, select File-Capture to
Clipboard from the Video Viewer window menu, or click the Capture to Clipboard
button. The image data is saved to the clipboard.

4.15 Closing a session
To close a Video Viewer window session:

Select File-Exit from the Video Viewer window.
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LDAP is a vendor-independent protocol standard used for accessing, querying
and updating a directory using TCP/IP. Based on the X.500 Directory Services
model, LDAP is a global directory structure that supports strong security features
including authentication, privacy and integrity.

If individual user accounts are stored on an LDAP-enabled directory service such
as Active Directory, you can use the directory service to authenticate users. The
default values given for the LDAP search and query parameters are defined for
use with Active Directory.

The settings made in the OBWI let you configure your authentication
configuration parameters. The software sends the username, password and other
information to the appliance, which then determines whether the user has
permission to view or change configuration parameters for the appliance in the
OBWI.

Unlessotherwise specified, the LDAPdefault values should be used unlessActive
Directory hasbeen reconfigured. Modifying the default valuesmaycause LDAP
authentication server communication errors.

5.1 Configuring LDAP in the user interface
On the LDAP Overview page in the OBWI, you can configure the LDAP
authentication priority and the parameters that define LDAP server connection
information.

LDAP overview parameters

LDAP authentication priority

In the LDAP Priority section of the OBWI, you can disable LDAP, or you can set
the authentication priority by choosing whether local authentication or LDAP
authentication should happen first.

To configure LDAP authentication priority parameters:

1. Select Appliance - Appliance Settings - User Accounts - LDAP Accounts-
Overview.

2. Select either LDAP Disabled, LDAP before Local or LDAP after Local for the
LDAP Priority.

3. Click Save.
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LDAP servers

The Address fields specify the host names or IP addresses of the primary and
secondary LDAP servers. The secondary LDAP server is optional.

The Port fields specify the User Datagram Protocol (UDP) port numbers that
communicate with the LDAP servers. The default value is 389 for non-secure
LDAP and 636 for secure LDAP (LDAPS). The default Port ID is automatically
entered by the software when an access type is specified.

The Access Type radio buttons specify how a query is sent to each LDAP target
device. When using LDAP, all usernames, passwords and other information sent
between an appliance and LDAP server are sent as non-secure clear text. Use
LDAPS for secure encrypted communication between an appliance and LDAP
server.

To configure LDAP server parameters:

1. Select Appliance - Appliance Settings - User Accounts - LDAP Accounts >
Overview.

2. Identify the primary and secondary server address, port and access type in
the appropriate fields or radio buttons.

3. Click Save.

LDAP Search parameters

On the LDAP Search page, you can configure the parameters used when
searching for LDAP directory service users. Use the Search DN field to define an
administrator-level user that the appliance uses to log into the directory service.
Once the appliance is authenticated, the directory service grants it access to the
directory to perform the user authentication queries specified on the LDAP Query
page. The default values are cn=Administrator, cn=Users, dc=yourDomainName
and dc=com and may be modified. For example, to define an administrator
Distinguished Name (DN) for test.view.com, type cn=Administrator, cn=Users,
dc=test, dc=view, and dc=com. Each Search DN value must be separated by a
comma. The Search Password field is used to authenticate the administrator or
user specified in the Search DN field. Use the Search Base field to define a
starting point from which LDAP searches begin. The modifiable default values
are dc=yourDomainName and dc=com. For example, to define a search base for
test.com, type dc=test, dc=com. Each Search Base value must be separated by
a comma. The UID Mask field specifies the search criteria for User ID searches of
LDAP target devices. The format should be in the form <name>=<%1>. The
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default value is sAMAccountName=%1, which is correct for use with Active
Directory. This field is required for LDAP searches.

To configure LDAP search parameters:

1. Select Appliance - Appliance Settings - User Accounts - LDAP Accounts >
Search.

2. Enter the appropriate information in the Search DN, Search Password,
Search Base and UID Mask fields.

3. Click Save.

These options cannot be changed if the LDAPPriority is set to LDAPDisabled on the
Overview screen.

LDAP Query parameters

On the LDAP Query page, you can configure the parameters used when
performing user authentication queries.

The appliance performs two different types of queries. Query Mode (Appliance) is
used to authenticate administrators and users attempting to access the appliance
itself. Query Mode (Target Device) is used to authenticate users that are
attempting to access attached target devices. Additionally, each type of query has
three modes that utilize certain types of information to determine whether or not
an LDAP user has access to an appliance or connected target devices. See
"Appliance and target device query modes" on page 71 detailed information on
each mode.

You can configure the following settings on the LDAP Query Page:

• The Query Mode (Appliance) parameters determine whether or not a user
has access to the appliance.

• The Query Mode (Target Device) parameters determine whether or not a
user has user access to target devices connected to an appliance. The user
does not have access to the appliance, unless granted by Query Mode
(Appliance).

• The Group Container, Group Container Mask, and Target Mask fields are
only used for group query modes and are required when performing an
appliance or device query.

• The Group Container field specifies the organizational unit (ou) created in
Active Directory by the administrator as the location for group objects.
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• Group objects are Active Directory objects that can contain users,
computers, contacts and other groups. Group Container is used when
Query Mode is set to Group Attribute. Each group object, in turn, is
assigned members to associate with a particular access level for
member objects (people, appliances, and target devices). The access
level associated with a group is configured by setting the value of an
attribute in the group object.

• For example, if the Notes property in the group objects list is used to
implement the access control attribute, the Access Control Attribute field
on the LDAP Query Page should be set to info. Setting the Notes
property to KVM User Admin causes the members of that group to have
user administration access to the appliances and target devices that are
also members of that same group.

• The Notes property is used to implement the access control attribute. The
value of the Notes property, available in group and user objects shown in
Active Directory Users and Computers (ADUC), is stored internally in the
directory, in the value of the info attribute. ADUC is a Microsoft Management
Console snap-in for configuring Active Directory. It is started by selecting
Start > Programs > Administrative Tools > Active Directory Users and
Computers. This tool is used to create, configure and delete objects such as
users, computers and groups. See "Appliance and target device query
modes" on page 71 for more information.

• The Group Container Mask field defines the object type of the Group
Container, which is normally an organizational unit. The default value is
“ou=%1”.

• The Target Mask field defines a search filter for the target device. The default
value is “cn=%1”.

• The Access Control Attribute field specifies the name of the attribute that is
used when the query modes are set to User Attribute or Group Attribute. The
default value is info.

 To configure LDAP query parameters:

1. Select Appliance - Appliance Settings - User Accounts - LDAP Accounts -
Query.

2. Select either Basic, User Attribute or Group Attribute for the Appliance Query
Mode and the Target Device Query Mode.
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3. Enter the appropriate information in the Group Container, Group Container
Mask, Target Mask, and Access Control Attribute fields.

4. Click Save.

These options cannot be changed if the LDAPPriority is set to LDAPDisabled on the
Overview screen.

5.2 Appliance and target device query modes
One of three modes can each be used for Query Mode (Appliance) and Query
Mode (Target Device):

• Basic – A username and password query for the user is made to the directory
service. If they are verified, the user is given appliance administrator access
to the appliance and any attached target devices for Query Mode
(Appliance), or to any selected target device for Query Mode (Target Device).

• User Attribute – A username, password and Access Control Attribute query
for the appliance user is made to the directory service. The Access Control
Attribute is read from the user object (the user account) in Active Directory.

If the KVM Appliance Admin value is found, the user is given appliance
administrator access to the appliance and any attached target devices
for Query Mode (Appliance), or to any selected target device for Query
Mode (Target Device).

If the KVM User Admin value is found, the user is given user
administrator access to the appliance and attached target devices for
Query Mode (Appliance), or to any selected target device for Query
Mode (Target Device).

If the KVM User value is found, the user is given user access to the
appliance for Query Mode (Appliance), or to any selected target device
for Query Mode (Target Device).

If none of the three valuesare found, the user is given no access to the appliance and
target devices for QueryMode (Appliance) or to any selected target device for Query
Mode (Target Device), unless the user hasUser Admin or Appliance Admin privileges
to the appliance.

You can access the ADUC by selecting Start - Programs - Administrative Tools -
Active Directory Users and Computers.

• Group Attribute – A username, password and group query is made to the
directory service for an appliance and attached target devices when using
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Query Mode (Appliance), or for a selected target device when using Query
Mode (Target Device). If a group is found containing the user and the
appliance name, the user is given access to the appliance or attached target
devices, depending on the group contents, when using Query Mode
(Appliance). If a group is found containing the user and target device IDs, the
user is given access to the selected target device connected to the appliance
when using Query Mode (Target Device).

Groups can be nested to a maximum of 16 levels in depth. Use nesting
to create groups within other groups. For example, you may have a top-
level group named Computers that contains a member named R&D,
which is a group. The R&D group may contain a member named
Domestic, which is a group, and so on.

5.3 Setting up Active Directory for performing
queries
Before you can use any of the querying modes for units, you must first make
changes to Active Directory so that the selected querying mode can assign the
applicable authorization level for the user.

To set up group queries:

1. Log into Windows with administrator privileges.

2. Open Active Directory software.

3. Create an organizational unit to be used as a group container.

4. Create a computer object in Active Directory with a name identical to the
switching system name for querying appliances (specified in the Appliance
Overview screen of the OBWI), or identical to the attached target devices for
querying target devices. The name must match exactly, including case.

5. The appliance names and target device names used for group queries are
stored in the appliance. The appliance name specified in the Appliance
Overview screen of the OBWI and target device names must identically
match the object names in Active Directory. Each appliance name and target
device name may be comprised of any combination of upper-case and
lower-case letters (a-z, A-Z), digits (0-9), and hyphens (-). You cannot use
spaces and periods (.) or create a name that consists entirely of digits. These
are Active Directory constraints.
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The factory default name in earlier versions contains a space that must be removed by
editing the switching system name in the ApplianceOverview screen of the OBWI.

6. Create one or more groups under the group container organizational unit.

7. Add the usernames and the target device/appliance objects to the groups
you created in step 5.

8. Specify the value of any attribute being used to implement the access control
attribute. For example, if you are using info as the attribute in the Access
Control Attribute field and using the Notes property in the group object to
implement the access control attribute, the value of the Notes attribute in
Active Directory may be set to one of the three available access levels (KVM
User, KVM User Admin, or KVM Appliance Admin) for the group object. The
members of the group may then access the appliances and target devices at
the specified access level.

If none of the three valuesare found, the user is granted user level access to any
appliance or target device listed in a group with the username.
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Each switch may be configured at the appliance level through the

Console menu interface accessed through the SETUP port. All

terminal commands are accessed through a terminal or PC running

terminal emulation software.

NOTE: The preferredmethod is to make all configuration settings in the localUI.

To connect a terminal to the switch:

1. Using the supplied RJ-45 to DB-9 (female) adapter and UTP

cable, connect a terminal or a PC that is running terminal

emulation software (such as HyperTerminal) to the SETUP port on

the back panel of the switch. The terminal settings are 9600 bits

per second (bps), 8 bits, 1 stop bit, no parity and no flow control.

2. Turn on each target device and then turn on the switch. When the

switch completes initialization, the Console menu will display the

following message: Press any key to continue.

Console boot menu options
While the switch is turning on, you can press a key to view the boot

menu. From this menu, you can choose one of four options.

• Boot Normal

• Boot Alternate Firmware

• Reset Factory Defaults

• Full-Factory Reset

Console main menu options
Once turned on, the main menu displays the product name and

version. From this menu, you can choose one of four options.

• Network configuration: This menu option allows you to configure

the network setting of the appliance.

• Debug messages: This menu option turns on console status

messages. Because this can significantly reduce performance, you

should only enable debug messages when instructed to do so by

Fujitsu Technical Support. When you are finished viewing the

messages, press any key to exit this mode.
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• Reset Appliance: This menu option allows you to execute a soft

reset of the switch.

• Exit: This menu selection will return you to the ready prompt. If

the Console menu interface password is enabled, you must exit

the Console main menu so that the next user will be prompted

with the Username and Password login screen.
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Appendix B: Using KVMs4 Adapter Serial cables
Using KVMs4 Adapter Serial Cables

An administrator can choose between the ACS console server and

Cisco pinouts for each serial adapter cable port via the local user

interface or the remote OBWI. ACS is the default.

To change the pinout to Cisco mode:

1. Select Unit View - Appliance - Appliance Settings - Ports >

Adapter Cable.

2. Click on the desired serial adapter cable(s).

3. Select Settings > Pinout.

NOTE: If the DB-9 adapter is used, select the ACS console server pinouts.

ACS console server port pinouts

The following table lists the ACS console server serial port pinouts for

the serial adapter cable.

Pin No. SignalName Input/Output

1 RTS - Request to Send OUT

2 DTR - Data Terminal
Ready OUT

3 TXD - Transmit Data OUT

4 GND - SignalGround N/A

5 CTS - Clear to Send IN

6 RXD - Receive Data IN

7 DCD/DSR - Data Set
Ready IN

8 N/C - Not Connected N/A

Table B.1: ACS Console Server Serial Port Pinouts
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Cisco port pinouts

The following table lists the Cisco serial port pinouts for the serial

adapter cable.

Pin No. SignalName Input/Output

1 CTS - Clear to Send IN

2 DCD/DSR - Data Set
Ready IN

3 RXD - Receive Data IN

4 GND - SignalGround N/A

5 N/C - Not Connected N/A

6 TXD - Transmit Data OUT

7 DTR - Data Terminal
Ready OUT

8 RTS - Request to Send OUT

Table B.2: Cisco Serial Port Pinouts
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Appendix C: UTP cabling
This appendix discusses various aspects of connection media. The

KVM s4 switching system utilizes UTP cabling. The performance of

an switch system depends on high quality connections. Poor quality

or poorly installed or maintained cabling can diminish switch system

performance.

NOTE: This appendix is for information purposesonly. Please consult with your local
code officials and/or cabling consultants prior to any installation.

UTP copper cabling
The following are basic definitions for the three types of UTP cabling

that the KVM s4 switch supports:

• CAT5 (4-pair) high performance cable consists of twisted pair

conductors, used primarily for data transmission. The twisting of

the pairs gives this cable some immunity from the infiltration of

unwanted interference. CAT5 cable is generally used for networks

running at 10 or 100 Mbps.

• CAT5E (enhanced) cable has the same characteristics as CAT5,

but is manufactured to somewhat more stringent standards.

• CAT6 cable is manufactured to tighter requirements than CAT5E

cable. CAT6 has higher measured frequency ranges and

significantly better performance requirements than CAT5E cable

at the same frequencies.

Wiring standards
There are two supported wiring standards for 8-conductor (4-pair) RJ-

45 terminated UTP cable: EIA/TIA 568A and B. These standards

apply to installations utilizing CAT5, CAT5E, and CAT6 cable

specifications. The KVM s4 switching system supports either of these

wiring standards. The following table describes the standards for each

pin.

Pin EIA/TIA 568A EIA/TIA 568B

1 white/green white/orange

Table C.1: UTP wiring standards
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Pin EIA/TIA 568A EIA/TIA 568B

2 green orange

3 white/orange white/green

4 blue blue

5 white/blue white/blue

6 orange green

7 white/brown white/brown

8 brown brown

Cabling installation, maintenance, and safety tips
The following is a list of important safety considerations that should

be reviewed prior to installing or maintaining your cables:

• Keep all UTP runs to a maximum of 30 feet each.

• Maintain the twists of the pairs all the way to the point of

termination, or no more than one-half inch untwisted. Do not skin

off more than one inch of the jacket while terminating.

• If bending the cable is necessary, make it gradual with no bend

sharper than a one inch radius. Allowing the cable to be sharply

bent or kinked can permanently damage the cable’s interior.

• Dress the cables neatly with cable ties, using low to moderate

pressure. Do not over tighten the ties.

• Cross-connect cables where necessary, using rated punch blocks,

patch panels, and components. Do not splice or bridge the cable

at any point.

• Keep the UTP cable as far away as possible from potential sources

of EMI, such as electrical cables, transformers, and light fixtures.

Do not tie the cables to electrical conduits or lay the cables on

electrical fixtures.

• Always test every installed segment with a cable tester. “Toning”

alone is not an acceptable test.
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• Always install jacks so as to prevent dust and other contaminants

from settling on the contacts. The contacts of the jack should face

up on the flush mounted plates, or left/right/down on surface

mount boxes.

• Always leave extra slack on the cables, neatly coiled in the

ceiling or nearest concealed location. Leave at least five feet at

the work outlet side and 15 feet at the patch panel side.

• Choose either 568A or 568B wiring standard before beginning.

Wire all jacks and patch panels for the same wiring scheme. Do

not mix 568A and 568B wiring in the same installation.

• Always obey all local and national fire and building codes. Be

sure to firestop all the cables that penetrate a firewall. Use

plenum-rated cable where it is required.
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Appendix D: Cable pinout information
NOTE: All switcheshave the 8-pin modular jack for themodem and console/setup
ports.

Figure D.1: Modem jack

Pin Description Pin Description

1
Request to
Send (RTS)

5 Transmit Data (TXD)

2
Data Set
Ready (DSR)

6 SignalGround (SG)

3
Data Carrier
Detect (DCD)

7 Data TerminalReady (DTR)

4
Receive Data
(RXD)

8 Clear to Send (CTS)

Table D.1: Descriptions for Figure D.1

Figure D.2: Console/setup jack
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Pin Description Pin Description

1
NoConnection
(N/C)

5 Transmit Data (TXD)

2
NoConnection
(N/C)

6 SignalGround (SG)

3
NoConnection
(N/C)

7 NoConnection (N/C)

4
Receive Data
(RXD)

8 NoConnection (N/C)

Table D.2: Descriptions for Figure D.2
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Server ports

Number

KVM s4-0812: 8

KVM s4-1622: 16

KVM s4-3242: 32

Type PS/2, USB, and Serial

Connectors 8-pin modular

Sync types Separate horizontal and vertical

Input video
resolution

Standard

640 x480@ 60Hz

800 x600@ 75Hz

960 x700@ 75Hz

1024 x768@ 75Hz

1280 x1024@ 75Hz

1600 x1200@ 60Hz

Widescreen

800 x500@ 60Hz

1024 x640@ 60Hz

1280 x800@ 60Hz

1440 x900@ 60Hz

1680 x1050@ 60Hz

Supported cabling 4-pair UTP or CAT 6, 45metersmaximum length

Dimensions

Form factor 1 U-rack, mountable

Table E.1: Technical specifications
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Server ports

Dimensions
1.72 x17.00 x9.20 in (Height xWidth xDepth)

(4.37 x43.18 x23.4 cm)

Weight (without
cables)

KVM s4-0812: 6.5 lb (3.0 kg)

KVM s4-1622: 7.0 lb (3.2 kg)

KVM s4-3242: 7.6 lb (3.4 kg)

SETUP port

Number 1

Type RS-232 serial

Connector 8-pin modular

Local port

Number/Type 1 VGA/4 USB

Network connection

Number 2

Type 10/100/1000 Ethernet

Connector 8-pin modular

USB device port

Number 4

Type USB2.0

MODEM port

Number 1

Type RS-232 serial

Connectors 8-pin modular

PDU port
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Server ports

Number 2

Type RS-232 serial

Connector 8-pin modular

Power specifications

Connectors 2

Type Internal

Power

KVM s4-0812: 13W

KVM s4-1622: 18W

KVM s4-3242: 24W

Heat dissipation

KVM s4-0812: 43 BTU/hr

KVM s4-1622: 45 BTU/hr

KVM s4-3242: 47 BTU/hr

AC input range 100 - 240 VAC

AC frequency 50/60 Hzauto-sensing

AC input current
rating

1.25 A

AC input power
(maximum)

40W

Ambient atmospheric condition ratings

Temperature

32 to 122 degreesFahrenheit (0 to 50 degreesCelsius)
operating;

-4 to 158 degreesFahrenheit (-20 to 70 degrees
Celsius) non-operating
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Server ports

Humidity

Operating: 20%to 80%relative humidity (non-
condensing)

Non-operating: 5%to 95%relative humidity, 38.7
degreesCmaximumwet bulb temperature

Safety and EMC
Standards
approvals and
markings

UL, FCC, cUL, ICES-003, CE, VCCI, KCC, C-Tick,
GOST

Safety certificationsand EMC certifications for this
product are obtained under one or more of the following
designations: CMN (CertificationModelNumber), MPN
(Manufacturer’sPart Number), or SalesLevelModel
designation. The designation that is referenced in the
EMC and/or safety reports and certificatesare printed
on the label applied to this product.

590-1058-640A88



Appendix F: Sun advanced key emulation

Appendix F: Sun advanced key emulation
Certain keys on a standard Type 5 (US) Sun keyboard can be

emulated by key press sequences on the local port USB keyboard. To

enable Sun Advanced Key Emulation mode and use these keys, press

and hold Ctrl+Shift+Alt and then press the Scroll Lock key. The Scroll
Lock LED blinks. Use the indicated keys in the following table as you

would use the advanced keys on a Sun keyboard. For example: For

Stop + A, press and hold Ctrl+Shift+Alt and press Scroll Lock, then F1
+ A.

These key combinations will work with the KVM s4 Adapter USB20-

VGA cables. With the exception of F12, these key combinations are

not recognized by Microsoft Windows. Using F12 performs a

Windows key press.

When finished, press and hold Ctrl+Shift+Alt and then press the Scroll

Lock key to toggle Sun Advanced Key Emulation mode off.

Sun key (US) Key to enable Sun keyemulation

Compose Application(1)

Compose keypad

Power F11

Open F7

Help Num Lock

Props F3

Front F5

Stop F1

Again F2

Undo F4

Cut F10

Copy F6

Table F.1: Sun key emulation
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Sun key (US) Key to enable Sun keyemulation

Paste F8

Find F9

Mute keypad /

Vol.+ keypad +

Vol.- keypad -

Command (left)(2) F12

Command (left)(2) Win (GUI) left(1)

Command (right)(2) Win (GUI) right (1)

ENDNOTES:

(1)Windows95 104-key keyboard.

(2)The Command key is the SunMeta (diamond) key.
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Appendix G: Getting help and technical
assistance

If you need help, service, or technical assistance or just want more

information about Fujitsu products, you will find a wide variety of

sources available from Fujitsu to assist you. This section contains

information about where to go for additional information about

Fujitsu and Fujitsu products, what to do if you experience a problem

with your system, and whom to call for service, if it is necessary.

Before you call
Before you call, make sure that you have taken these steps to try to

solve the problem yourself:

• Check all cables to make sure that they are connected.

• Check the power switches to make sure that the system and any

devices are turned on.

• Use the troubleshooting information in your system

documentation, and use the diagnostic tools that come with your

system. Information about diagnostic tools is in the Problem

Determination and Service Guide on the Fujitsu Documentation

CD that comes with your system.

• Go to the Fujitsu support Web site at

http://www.ts.fujitsu.com/support/ to check for technical

information, hints, tips, and new device drivers or to submit a

request for information.

You can solve many problems without outside assistance by

following the troubleshooting procedures that Fujitsu provides in the

online help or in the documentation that is provided with your Fujitsu

product. The documentation that comes with Fujitsu systems also

describes the diagnostic tests that you can perform. Most systems,

operating systems, and programs come with documentation that

contains troubleshooting procedures and explanations of error

messages and error codes. If you suspect a software problem, see the

documentation for the operating system or program.
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1. Produktüberblick

1.1 Funktionen und Vorteile
Die KVM series4-0812/1622/3242-Switches von Fujitsu verbinden analoge und
digitale Technologie für eine flexible, zentralisierte Steuerung von Servern im
Datencenter und stellt Betrieb, Aktivierung und Wartung von Remote-
Zweigstellen, für die keine ausgebildeten Bediener zur Verfügung stehen, bereit.
Die IP-basierten KVM s4-Switches ermöglichen Ihnen flexible Zielgeräte-
Steuerung und sicheren Remote-Zugriff jederzeit und von jedem Standort aus.

Der KVM s4-Switch bietet Unternehmenskunden die folgenden Merkmale und
Optionen:

• erhebliche Reduzierung des Kabelvolumens

• Tastatur-, Video- und Maus-Funktionalität (KVM), konfigurierbar für analoge
(lokale) und digitale (Remote) Konnektivität

• echte serielle Funktionalität über Secure Shell (SSH) und Telnet

• erweiterte Unterstützung für Bildschirmauflösungen bis zu 1600 x 1200 oder
1680 x 1050 (Breitbild), nativ von Ziel zu Remote

• Virtual Media-Fähigkeit über USB-Ports

• duale, unabhängige Videopfade am lokalen Port (dediziert auf ACI)

• Dual-Stack-IPv4 (DHCP) und IPv6 (DHCPv6 und statusfreie Auto-
Konfiguration) für simultanen Zugriff

• Unterstützung von CCID-kompatiblen Smartcard-Lesegeräten

• Zugriffsmöglichkeit auf Zielgeräte über 10/100 oder 1000BaseT LAN-Port(s),

• ein Modem-Port, der V.34-, V.90- oder V.92-kompatible Modems unterstützt,
die verwendet werden können, wenn eine Ethernet-Verbindung nicht
verfügbar ist

Weniger Verkabelungsaufwand

Mit stetig wachsenden Serverdichten stellt das Kabelvolumen immer noch eines
der Hauptprobleme für Netzwerkadministratoren dar. Der KVM s4-Switch
verringert den KVM-Kabelaufwand im Rack deutlich, indem er innovative Virtual
Media-Konvertierungsoptionskabel und einfache UTP-Kabel auf
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1. Produktüberblick

Industriestandard verwendet. Dies erlaubt eine höhere Serverdichte und bietet
dennoch erhöhten Luftdurchfluss und eine bessere Kühlkapazität.

KVM-Switching-Funktionalität

Der KVM s4-Switch unterstützt Adapterkabel, die direkt vom Zielgerät mit Strom
versorgt werden und eine Keep Alive-Funktionalität bieten, wenn der Switch nicht
mit Strom versorgt wird. Die folgenden Adapterkabel werden unterstützt: KVM s4-
Adapter-USB20-VGA- und serielle KVM s4 Adapterkabel.

Echte serielle Funktionalität

Der KVM s4-Switch unterstützt serielle KVMs4-Adapterkabel, die die echte
serielle Funktionalität über Secure Shell (SSH) oder Telnet bieten. Sie können
eine SSH-Sitzung oder eine serielle Viewer-Sitzung über die integrierte
Weboberfläche (OBWI) aufrufen, um eine Verbindung zu den Zielgeräten
herzustellen, die über ein serielles KVM s4-Adapterkabel an die KVM s4-
Switches angeschlossen sind.

Lokale und Remote-Benutzeroberflächen

Sie können über die lokale Benutzeroberfläche eine direkte Verbindung mit dem
lokalen Port herstellen, um die KVM s4 zu verwalten. Sie können auch die
integrierte Weboberfläche remote verwenden, um Ihren Switch zu verwalten. Die
integrierte Weboberfläche ist browserbasiert und wird direkt vom Switch aus
aufgerufen. Alle Geräte, die an die KVM s4 angeschlossen sind, werden
automatisch erkannt. Die beiden Benutzeroberflächen sind ähnlich gestaltet,
damit der Benutzer sich schnell zurechtfindet.

Steuerung von Virtual Media- und Smartcard-fähigen Switches

Der KVM s4-Switch ermöglicht das Anzeigen von auf virtuellen Speichergeräten
gespeicherten Daten auf einem beliebigen Zielgerät. Außerdem können die
Daten von den Speichergeräten auf das Zielgerät verschoben oder kopiert
werden und umgekehrt. Remote-Systeme lassen sich effizienter verwalten,
indem die Installation und Wiederherstellung von Betriebssystemen, die
Wiederherstellung oder Duplizierung von Festplatten sowie BIOS-
Aktualisierungen und Backups von Zielgeräten über Remote-Zugriff ermöglicht
werden.

Der KVM s4-Switch ermöglichen die Verwendung von Smartcards in Verbindung
mit Ihrem Switch-System. Smartcards sind Karten im Taschenformat, die Daten
speichern und verarbeiten. Smartcards, wie z. B. Common Access Cards (CAC),
können für die Speicherung von Identifizierungs- und
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1.1 Funktionen und Vorteile

Authentifizierungsinformationen verwendet werden, um Zugriff bzw. Zugang zu
Computern, Netzwerken und gesicherten Räumen und Gebäuden zu erhalten.

Virtual Media- und Smartcard-Lesegeräte können direkt über die USB-Ports an
den Switch angeschlossen werden. Darüber hinaus können Virtual Media- und
Smartcard-Lesegeräte an alle Remote-Workstations angeschlossen werden, auf
denen die Remote-OBWI oder Avocent® DSView® 3-Managementsoftware
ausgeführt wird und die über eine Ethernet-Verbindung an den Switch
angeschlossen sind.

Umeine VirtualMedia-Sitzungmit einem Zielgerät zu öffnen, mussdasZielgerät zuerst
mit einemAdapterkabel an den Switch angeschlossen werden.Wenn es sich um eine
Smartcard handelt, muss zuerst dasZielgerät an einen Switchmit einemSmartcard-
fähigen Adapterkabel angeschlossen werden.

Zugriff auf den Switch über ein standardmäßiges TCP/IP-Netzwerk

Der Switch bietet agentenlosen Remote-Zugriff und Remote-Steuerung. Für
angeschlossene Server oder Clients werden keine speziellen
Softwareprogramme oder Treiber benötigt.

Der Client stellt über einen Internetbrowser eine Verbindungmit demSwitch her.

Sie können über Ethernet oder über ein V.34, V.90 oder V.92-Modem von einem
Client-Computer aus auf den Switch und alle angeschlossenen Systeme
zugreifen. Die Client-Computer können überall dort aufgestellt sein, wo sich eine
gültige Netzwerkverbindung befindet.

DSView 3 Management-Software-Plug-In

Die DSView 3-Software kann mit dem Switch verwendet werden, um es IT-
Administratoren zu ermöglichen, mit Remote-Zugriff über eine einzige,
webbasierte Benutzeroberfläche auf Zielgeräte auf mehreren Plattformen
zuzugreifen und diese zu Überwachen und zu steuern. Weitere Informationen
finden Sie im DSView 3-Software Plug-In for KVM s4 Switches Technical Bulletin.
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1.2 Beispielkonfiguration

Abbildung 1.1. Beispielkonfiguration eines Switches

Tabelle 1.1. Beschreibungen für Abbildung 1.1

Anzahl Beschreibung Anzahl Beschreibung

1 CAT 5-
Verbindung 7 Telefonnetz

2 KVM-Verbindung
mit demSwitch 8 Ethernet

3 Remote-IP-
Verbindung 9 DSView 3 Software-Server

4 Server-Rack 10 Analoger Benutzer (lokale
Benutzeroberfläche)
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1.2 Beispielkonfiguration

Anzahl Beschreibung Anzahl Beschreibung

5 KVM s4-Switch 11 Digitaler Benutzer (Computer mit
Internetbrowser, Remote-OBWI)

6 Modem
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2. Installation

2.1 Konnektivität des KVM s4-Switches
Der KVM s4-Switch übermittelt KVM-Informationen zwischen Bedienern und an
den Switch angeschlossenen Zielgeräten über eine Ethernet- oder eine lokale
Verbindung.

Der KVM s4-Switch verwendet TCP/IP für die Kommunikation über Ethernet. Die
beste Leistung wird durch die Verwendung eines dedizierten, geswitchten
100BaseT- oder 1000BaseT-Netzwerk erzielt. Sie können auch 10BaseT-
Ethernet verwenden.

Der KVM s4-Switch verwendet das Point-to-Point-Protokoll (PPP) zur
Kommunikation über ein V.34, V.90 oder V.92-Modem. Mithilfe von OBWI oder
der DSView 3-Software können KVM- und serielle Switching-Aufgaben
ausgeführt werden. Weitere Informationen zur DSView 3-Software erhalten Sie
unter http://www.avocent.com/fujitsu.

Abbildung 2.1 zeigt ein Beispiel einer Basiskonfiguration für Switches.
Beschreibungen folgen in Tabelle 2.1.
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Abbildung 2.1. Switch-Basiskonfiguration mit dem KVM s4-3242-Switch

Tabelle 2.1. Beschreibungen für Abbildung 2.1

Anzahl Beschreibung Anzahl Beschreibung

1 Digitaler
Benutzer 8 Netzkabel

2 Telefonnetz 9 Ports 1 - 32

3 Netzwerk 10 Lokale USB-Verbindungen
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2.1 Konnektivität des KVM s4-Switches

Anzahl Beschreibung Anzahl Beschreibung

4 Modem 11 Stromüberwachungsgerät

5 Analoger
Benutzer 12 Zielgeräte 1 - 32

6 Externe Virtual
Media 13 Adapterkabel

7 KVM s4-3242
Switch

Vor der Installation

Überprüfen Sie vor der Installation des Switches anhand der folgenden Liste, ob
sowohl alle Teile, die mit dem Switch versandt wurden, als auch etwaige
Zusatzteile, die für die Installation benötigt werden, vorhanden sind.

Lieferumfang des Switches

• Rackbefestigungshalterungskit

• Rack-Befestigungshalterungskit – Schnellinstallationsanleitung

• KVM s4-Schnellinstallationsanleitung

• Leitfaden zu Sicherheits- und behördlichen Bestimmungen

• Kabel und adapters für MODEM- und SETUP-Ports

• Wechselstrom-Netzkabel

Zusätzlich benötigte Teile

• Ein Adapterkabel pro Zielgerät

• Ein serielles Adapterkabel pro seriellem Zielgerät

• Ein UTP-Patchkabel für jedes Adapterkabel (4-adriges UTP-Kabel, bis zu 45
m)

• UTP-Patchkabel für Netzwerkkonnektivität (4-adriges UTP-Kabel, bis zu 45
m)

• Ein Virtual Media-fähiges Adapterkabel pro Zielgerät für Virtual Media-
Sitzungen

• Ein Smart Card-fähiges Adapterkabel pro Zielgerät für Smart Card-
Steuerung
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Einrichten des Netzwerks

Der Switch verwendet IP-Adressen, um den Switch und die Zielgeräte eindeutig
zu identifizieren. Der KVM s4-Switch unterstützt DHCP (Dynamic Host
Configuration Protocol) und statische IP-Adressenvergabe. Stellen Sie sicher,
dass für jeden Switch eine IP-Adresse reserviert ist und dass die IP-Adressen
statisch bleiben, wenn der Switch an das Netzwerk angeschlossen ist.

2.2 Einen KVM s4-Switch im Rack montieren
Mit jedem Switch wird ein Rack-Befestigungskit geliefert. Sie können Ihren
Switch entweder in einem Rack unterbringen oder den Switch direkt in ein EIA-
Standardrack (Electronic Industries Alliance) einbauen.

Der Switch beansprucht eine 1-HE- bzw. 0-HE-Einbauhöhe im Rack.

Sicherheitsvorkehrungen bei Rackbefestigung

• Rackbelastung: Überladung oder ungleichmäßige Rackbestückung kann zur
Beschädigung von Regalen oder des Racks führen und mögliche
Personenschäden nach sich ziehen. Vor dem Bestücken müssen die Racks
an ihren vorgesehenen Standorten stabilisiert werden. Das Rack muss von
unten nach oben mit Komponenten bestückt werden. Die Rack-
Belastungswerte dürfen nicht überschritten werden.

• Überlegungen zur Stromversorgung: Schließen Sie das Gerät nur an eine
auf der Einheit angegebene Stromversorgung an. Achten Sie bei der
Installation von mehreren elektrischen Komponenten in einem Rack darauf,
dass die Gesamtstromaufnahme die Stromkreiskapazität nicht übersteigt.
Überlastete Stromversorgungen und Verlängerungskabel stellen eine
erhöhte Brand- und Stromschlaggefahr dar.

• Erhöhte Umgebungstemperaturen: Beim Einbau in geschlossenen Rack-
Gruppen kann es vorkommen, dass die Betriebstemperatur in der Rack-
Umgebung höher als die Raumtemperatur ist. Achten Sie darauf, dass die
auf dem Gerät angegebene maximale Umgebungstemperatur nicht
überschritten wird.

• Unzureichende Belüftung: Der Einbau von Geräten im Rack muss so
vorgenommen werden, dass die für den sicheren Betrieb der Geräte
benötigte Luftzufuhr sichergestellt ist.

• Zuverlässige Geräteerdung: Stellen Sie sicher, dass rackmontierte Geräte
stets zuverlässig geerdet sind. Achten Sie vor allem auf
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2.3 Anschluss der Switch-Hardware

Versorgungsanschlüsse, die nicht direkt an den Verzweigungsschaltkreis
angeschlossen sind (z. B. Verwendung von Mehrfachsteckdosen).

• Das Gerät sollte nicht so installiert werden, dass die hintere Gehäuseplatte
nach unten zeigt.

Vollständige Anweisungen zur Installation der Rackbefestigungshalterung finden
Sie in der KVM s4-Schnellinstallationsanleitung.

2.3 Anschluss der Switch-Hardware
So schließen Sie den Switch an und schalten ihn ein:

Beachten Sie Folgendes, um Störungen von Monitor und/oder Tastatur bei
der Verwendung von Fujitsu-Produkten zu vermeiden:Wenn imGebäude
dreiphasiger Wechselstrom verwendet wird, stellen Sie sicher, dassRechner und
Monitor phasengleich sind. Die besten Ergebnisse werden erzielt, wenn die Geräte am
selben Stromkreis angeschlossen sind.

WARNUNG: Vermeidung von Elektroschock oder Schäden an Ihrem Gerät:
– DasNetzkabelmuss immer ordnungsgemäß geerdet sein. Der Masseanschluss ist
ein wichtigesSicherheitsmerkmal.
– Stecken Sie dasNetzkabel in eine geerdete Schukosteckdose, die jederzeit leicht
zugänglich seinmuss.
– Um die Stromversorgung zu unterbrechen, ziehen Sie dasNetzkabel entweder aus
der Netzsteckdose oder ausdemGerät.
– Der Wechselstromeingang ist die Haupt-Stromtrennung, um die Stromversorgung
desGeräts zu unterbrechen. Für Produktemit mehr als einemWechselstromeingang
müssen alleWechselstromkabel getrennt werden, um den Strom vollständig
abzutrennen.
– DiesesProdukt verfügt über keine Teile, die vomBenutzer gewartet werden können.
DasGerät nicht öffnen und die Abdeckung nicht abnehmen.

1. Schließen Sie einen VGA-Monitor und USB-Tastatur- und Mauskabel an die
entsprechenden Ports an.

2. Wählen Sie einen verfügbaren Port am Switch. Schließen Sie ein Ende
eines UTP-Kabels (4-paarig, bis zu 45 m) an einen nummerierten Port an.
Schließen Sie das andere Ende an einen RJ-45-Anschluss eines
Adapterkabels an.

3. Schließen Sie das Adapterkabel an die entsprechenden Ports an der
Rückseite des Zielgeräts an. Wiederholen Sie diesen Vorgang für alle
Zielgeräte, die Sie anschließen möchten.
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Beim AnschlusseinesZielgeräts von SunMicrosystemsmusseinMultisync-Monitor
verwendet werden, der sowohlSun Rechner mit VGA- als auch Sync-on-Green oder
Composite-Syncunterstützt.

4. Schließen Sie beide LAN-Ports an voneinander unabhängige Ethernet-
Switches an, um bestmögliche Redundanz zu gewährleisten.

5. Schalten Sie alle Zielgeräte ein und legen Sie das/die Stromkabel bereit,
das/die im Lieferumfang des Switches enthalten ist/sind. Stecken Sie das
eine Kabelende in den Stromanschluss des Switches auf der
Geräterückseite. Stecken Sie das andere Ende in eine geeignete
Netzsteckdose. Schließen Sie das zweite Stromkabel an den zweiten
Stromanschluss auf der Rückseite des Switches an. Stecken Sie das andere
Ende in eine geeignete Netzsteckdose.

Schließen Sie die Redundanz-Stromversorgungen an voneinander unabhängige
Abzweigleitungen an, um zusätzliche Redundanz im Falle einer fehlerhaften
Wechselstromquelle sicherzustellen.

So schließen Sie lokale Virtual Media oder ein Smartcard-Lesegerät an:

Schließen Sie die Virtual Media oder das Smartcard-Lesegerät an einen
verfügbaren USB-Port am Switch an.

Für alle VirtualMedia-Sitzungen und Smartcard-Lesegerätemüssen Sie ein KVM s4-
Adapter-USB20-VGA-Adapterkabel verwenden.

Informationen zum Remote-Anschluss von Virtual Media finden Sie unter „Virtual
Media“ auf Seite 67. Informationen zum Remote-Anschluss eines Smartcard-
Lesegeräts finden Sie unter „Smartcards“ auf Seite 72.

So schließen Sie ein serielles Adapterkabel mit einem UTP-Stecker an ein
serielles Gerät an:

1. Schließen Sie den UTP-Stecker des serielles Adapterkabel an das serielle
Gerät an.

– oder –

Schließen Sie das serielles Adapterkabel an die Buchse eines RJ-45-
auf-9-Pin-Adapters an. Schließen Sie den Adapter an den seriellen Port
des seriellen Geräts an.
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2. Schließen Sie ein Ende eines UTP-Kabels (4-paarig, bis zu 45 m) an einen
nummerierten Port auf der Rückseite des Switches an. Schließen Sie das
andere Ende an einen RJ-45-Anschluss des serielles Adapterkabels an.

3. Schließen Sie das USB-zu-Stromkabel an den Stromstecker am serielles
Adapterkabel an. Schließen Sie den USB-Anschluss am USB-zu-Stromkabel
an einen verfügbaren USB-Port am seriellen Zielgerät an.

2.4 Kaskadieren von KVM s4-Switches
Sie können bis zu zwei Ebenen von KVM s4-Switches kaskadieren und es
Benutzern so ermöglichen, Verbindungen mit bis zu 1024 Servern herzustellen.
In einem kaskadierten System wird jeder ARI-Port des Hauptswitches mit dem
ACI-Port (Analog Console Interface) jedes kaskadierten Switches verbunden.
Jeder kaskadierte Switch kann dann mit einem Adapterkabel an ein Zielgerät
angeschlossen werden.
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Abbildung 2.2. KVM s4 Switch kaskadierte Konfiguration

Anzahl Beschreibung

1 KVM s4-Hauptswitch

2 Kaskadierter KVM s4-Switch

3 Zielport amHauptswitch

4 ACI-Port am kaskadierten Switch

5 Zielgeräte, die an die Switchesangeschlossen sind

Tabelle 2.2: Beschreibungen für Abbildung 2.2
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2.5 Konfigurieren des KVM s4-Switches

Mehrere Switches kaskadieren:

1. Schließen Sie ein Ende eines CAT 5-Kabels an den Zielport eines KVM s4-
Switches an.

2. Schließen Sie das andere Ende des CAT 5-Kabels an den ACI-Port
(Kettengliedsymbol) auf der Rückseite des kaskadierten KVM s4-Switches
an.

3. Schließen Sie die Zielgeräte an den kaskadierten KVM s4-Switch an.

4. Wiederholen Sie diese Schritte für alle kaskadierte KVM s4-Switches, die Sie
an Ihr System anschließen möchten.

Die beiden Switcheswerden automatisch „zusammengelegt“. Alle Geräte, die an die
kaskadierten Switchesangeschlossen sind, werden in der Hauptswitch-Geräteliste in
der lokalen Benutzeroberfläche angezeigt.

Der Switch unterstützt einen kaskadierten Switch pro Zielgeräte-Port amHauptswitch.
Sie können nicht mehr Switchesan den kaskadierten Switch anschließen.

Eine Kaskadierung des lokalen Portswird vomKVM s4 nicht unterstützt.

2.5 Konfigurieren des KVM s4-Switches
Nachdem alle physischen Verbindungen hergestellt sind, müssen Sie den
Switch für die Verwendung im Switch-System konfigurieren. Dies kann auf
zweierlei Arten durchgeführt werden:

So konfigurieren Sie den Switch mit der DSView 3-Software:

Detaillierte Anweisungen finden Sie in der DSView 3-Installations- und
Bedienungsanleitung.

So konfigurieren Sie den Switch über die lokale Benutzeroberfläche:

Detaillierte Anweisungen zur Verwendung der lokalen Benutzeroberfläche für
die erstmalige Netzwerkeinrichtung finden Sie unter „Netzwerkeinstellungen“ auf
Seite 32.

Einrichten des integrierten Webservers

Sie können über einen integrierten Webserver auf den Switch zugreifen, der den
Großteil der normalen Aufgaben des Switches verwaltet. Bevor Sie über den
Webserver auf den Switch zugreifen, müssen Sie zuerst über den lokalen Port
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auf der Rückseite des Switches oder über die lokale Benutzeroberfläche eine IP-
Adresse festlegen.

Zugriff auf die OBWI über eine Firewall

Für Switch-Installationen, die über die OBWI auf den Switch zugreifen, müssen
die folgenden Ports in der Firewall geöffnet werden, wenn Zugriff von außen
gewünscht ist.

TCP-Portnummer Funktion

22 Wird für SSH für serielle Sitzungenmit einem seriellesAdapterkabel
verwendet

23 Wird für Telnet (wenn aktiviert) verwendet

80 Wird für den anfänglichen Download desVideo Viewers verwendet

443 Wird von der Webbrowseroberfläche zur Verwaltung desSwitches
und zumStarten von KVM-Sitzungen verwendet.

2068 Übertragung von KVM-Sitzungsdaten (Maus+Tastatur) oder
Videoübertragung an Switches.

Tabelle 2.3: TCP-Ports und Funktionen für die OBWI des Switches

In einer typischen Konfiguration, wie in Abbildung 2.3 gezeigt, befindet sich der
Computer des Benutzers außerhalb der Firewall und der Switch innerhalb der
Firewall.
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2.6 Überprüfen der Verbindungen

Abbildung 2.3. Typische Switch-Firewall-Konfiguration

Tabelle 2.4. Beschreibungen für Abbildung 2.3

Anzahl Beschreibung

1 KVM s4-Switch

2 Firewall

3 Computer desBenutzers

4 Firewall leitet HTTP-Anfragen und KVM-Daten an den Switch

5 Benutzer sucht nach der externen IP-Adresse der Firewall

So konfigurieren Sie die Firewall:

Um von außerhalb einer Firewall auf den Switch zuzugreifen, konfigurieren Sie
Ihre Firewall so, dass die Ports 22, 23 (wenn Telnet aktiviert ist), 80, 443 und
2068 von der externen Oberfläche zum KVM-Switch über die interne Oberfläche
der Firewall weitergeleitet werden. Weitere Informationen zur Portweiterleitung
finden Sie in der Bedienungsanleitung Ihrer Firewall.

Informationen zum Aufrufen der OBWI finden Sie unter „OBWI“ auf Seite 22.

2.6 Überprüfen der Verbindungen

Ethernet-Verbindungs-LEDs auf der Geräterückseite

Der KVM s4-Switch verfügt auf der Geräterückseite über zwei LEDs, die den
Verbindungsstatus der Ethernet-LAN1-Verbindung anzeigen und zwei LEDs, die
den Verbindungsstatus der Ethernet-LAN2-Verbindung anzeigen.

• Die grünen LEDs leuchten, wenn eine gültige Netzwerkverbindung
hergestellt ist, und blinken, um Aktivität am Port anzuzeigen.

• Die zweifarbigen LEDs leuchten entweder grün oder gelb.

• Bei einer Übertragungsgeschwindigkeit von 1000 M/Bit leuchten sie
grün.

• Bei einer Übertragungsgeschwindigkeit von 100 M/Bit leuchten sie gelb.

• Liegt die Übertragungsgeschwindigkeit bei 10 M/Bit leuchten sie nicht.
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Netzstromstatus-LEDs auf der Geräterückseite

Auf der Rückseite jedes Geräts befinden sich zwei Netzstromstatus-LEDs, eine
für jede Stromversorgung. Die LEDs leuchten grün auf, wenn der Switch
eingeschaltet ist und normal in Betrieb ist.

• Die LED leuchtet nicht, wenn die Stromversorgung nicht eingeschaltet ist
oder ein Fehler vorliegt.

• Die LED leuchtet, wenn die Einheit betriebsbereit ist.

• Die LED blinkt, wenn der Switch hochgefahren wird oder eine Aktualisierung
durchgeführt wird.

• Die LED blinkt „SOS“, wenn ein Fehlerzustand vorliegt, wie z. B. ein Ausfall
der Stromversorgung, eine zu hohe Umgebungstemperatur oder ein
Gebläsefehler. Die LED blinkt kontinuierlich „SOS“, so lange der Fehler
vorliegt.

Der Switch verhindert eine serielle Unterbrechung der angeschlossenen Geräte,
sollte die Stromversorgung des Moduls unterbrochen werden. Der Benutzer kann
jedoch eine serielle Unterbrechung durch Drücken der Taste Serial Break im
Serial Session Viewer erzeugen.

2.7 Einstellen der Mauseinstellungen an Zielgeräten
Bevor ein an den Switch angeschlossener Computer zur Remote-
Benutzersteuerung verwendet werden kann, müssen Sie die
Mausgeschwindigkeit des Zielgeräts einstellen und die Mausbeschleunigung
ausschalten. Verwenden Sie für Computer mit den Betriebssystemen Microsoft®

Windows® (Windows XP, Windows Vista, Windows 2003, Windows 2008 und
Windows 7) den standardmäßigen PS/2-Maustreiber.

Damit die lokalen Mausbewegungen und die Anzeige des Remote-Cursors
synchron bleiben, muss die Mausbeschleunigung für alle Benutzerkonten, die
auf eine Remote-System über einen KVM-Switch zugreifen, auf „Keine“
eingestellt sein. Die Mausbeschleunigung muss auch auf jedem Remote-System
auf „Keine“ eingestellt sein. Stellen Sie sicher, dass keine speziellen Cursor
verwendet werden und Anzeigeoptionen, wie Mausspur,
Cursorpositionsanimationen mit der Strg-Taste, Mausschatten und Ausblenden
des Cursors deaktiviert sind.
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Wenn Sie dieMausbeschleunigung nicht über einWindows-Betriebssystem
deaktivieren können oder wenn Sie nicht die Einstellungen aller Ihrer Zielgeräte
einstellenmöchten, können Sie den BefehlExtras>Einzelcursor-Modus im Video
Viewer-Fenster verwenden. Dieser Befehl schaltet dasVideo Viewer-Fenster in einen
Modusmit „unsichtbaremMauszeiger“, in demSiemanuell festlegen können, ob der
Cursor am Zielgerät oder amClient-Computer angezeigt wird.
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3.1 Benutzeroberflächen
Der KVM s4-Switch ist mit zwei „Point-and-Click“-Oberflächen ausgestattet: einer
lokalen Benutzeroberfläche und einer integrierten Remote-Weboberfläche
(OBWI). Mit den Konfigurationsoptionen, die Ihnen diese Benutzeroberflächen
bieten, können Sie den Switch auf Ihre Anwendung zuschneiden,
angeschlossene Geräte steuern und alle grundlegenden KVM- oder seriellen
Switch-Anforderungen verwalten.

Die lokale Benutzeroberfläche und die Remote-OBWI sind fast identisch.Wenn nicht
ausdrücklich angegeben, beziehen sich alle Informationen in diesemKapitel auf beide
Benutzeroberflächen.

Aus beiden Benutzeroberflächen heraus können Sie zwei verschiedene
Sitzungsarten starten:

• Mit dem Video Viewer-Fenster können Sie in Echtzeit die Tastatur-,
Bildschirm- und Mausfunktionen eines einzelnen Zielgeräts übernehmen,
das an den Switch angeschlossen ist. Es können auch vordefinierte globale
Makros verwendet werden, um Aktionen innerhalb des Video Viewer-
Fenster auszuführen. Informationen zur Verwendung des Video Viewers
finden Sie in Kapitel 4.

• Mit dem seriellen Viewer-Fenster können Sie einzelne Zielgeräte entweder
mit Befehlen oder mit Skripten verwalten.

Lokale Benutzeroberfläche

Auf der Rückseite des Switches befindet sich ein lokaler Port. Über diesen Port
können Sie eine Tastatur, einen Bildschirm und eine Maus direkt an den Switch
anschließen und die lokale Benutzeroberfläche verwenden.

Sie können eine der folgenden Tastenfolgen zum Aufrufen der lokalen
Benutzeroberfläche oder zum Umschalten zwischen der lokalen
Benutzeroberfläche und einer aktiven Sitzung verwenden: Druck, Strg +Strg,
Umschalt +Umschalt und Alt +Alt.

So starten Sie die lokale Benutzeroberfläche:

1. Schließen Sie die Kabel von Bildschirm, Tastatur und Maus an den Switch
an. Weitere Informationen finden Sie unter „Anschluss der Switch-Hardware“
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auf Seite 11.

2. Verwenden Sie eine der aktivierten Tastenfolgen, um die lokale
Benutzeroberfläche zu starten.

3. Sofern die Authentifizierung der lokalen Benutzeroberfläche aktiviert wurde,
geben Sie Ihren Benutzernamen und Kennwort ein.

Wenn der Switch einemDSView 3-Server zugeordnet wurde, wird auf diesen DSView
3-Server zugegriffen, um den Benutzer zu authentifizieren.Wenn der Switch keinem
DSView 3-Server zugeordnet wurde, oder auf den DSView 3-Server nicht zugegriffen
werden kann, dann wird die lokale BenutzerdatenbankdesSwitches verwendet, um
den Benutzer zu authentifizieren. Der Standard-Benutzername ist Admin und es ist
kein Kennwort erforderlich. BeiBenutzernamen in der lokalen Datenbankwird nach
Groß- und Kleinschreibung unterschieden.

OBWI

Die OBWI des Switches ist eine remote, webbrowserbasierte
Benutzeroberfläche. Weitere Informationen zur Einrichtung Ihres Systems finden
Sie unter „Anschluss der Switch-Hardware“ auf Seite 11. In der nachfolgend
aufgeführten Tabelle sind die Betriebssysteme und Browser aufgeführt, die von
der OBWI unterstützt werden. Vergewissern Sie sich, dass Sie über die neueste
Version des Webbrowsers verfügen.

Tabelle 3.1. Von OBWI unterstützte Betriebssysteme und Browser

Betriebssystem

Browser

Microsoft®

Internet Explorer
ab Version 6.0
SP1

Firefoxab Version 3.0

MicrosoftWindows
Server® 2003 Standard,
Enterprise oder Web
Edition

Ja Ja

MicrosoftWindows
Server® 2008 Standard,
Enterprise oder Web
Edition

Ja Ja

590-1058-640A22



3.1 Benutzeroberflächen

Betriebssystem

Browser

Microsoft®

Internet Explorer
ab Version 6.0
SP1

Firefoxab Version 3.0

WindowsXPProfessional
mit Service Pack3

Ja Ja

WindowsVista® Business
mit Service Pack1

Ja Ja

Windows7 Ja Ja

RedHat Enterprise
Linux® 4 und 5 Standard,
Enterprise oder Web
Edition

Nein Ja

Sun Solaris 10 und 11 Nein Ja

Solaris 10 x86 Nein Ja

Ubuntu 8Workstation Nein Ja

Somelden Sie sich an der Switch-OBWI an:

1. Starten Sie einen Webbrowser.

2. Geben Sie im Adressfeld des Browsers die IP-Adresse oder den Host-
Namen ein, die/der dem Switch, auf den Sie zugreifen möchten, zugewiesen
ist. Verwenden Sie hierbei das Format https://xxx.xx.xx.xx oder
https://hostname.

Wenn Sie den IPv6-Modus verwenden, müssen Sie die IP-Adresse in eckige Klammern
einschließen. Verwenden Sie hierbei dasFormat https://[<IP-Adresse>].

3. Wenn der Browser die Verbindung mit dem Switch hergestellt hat, geben Sie
Ihren Benutzernamen und Ihr Kennwort ein und klicken Sie dann auf
Anmelden. Die integrierte Weboberfläche des Switches wird angezeigt.

Der Standard-Benutzername ist admin; dasKennwort ist admin.
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Wiederholen Sie den obigen Vorgang, um sich von außerhalb einer Firewall an
der Switch-OBWI anzumelden, und geben Sie dabei die externe IP-Adresse der
Firewall ein.

Verwenden der Benutzeroberflächen

Nach der Authentifizierung wird die Benutzeroberfläche angezeigt. Sie können
Ihren Switch anzeigen, darauf zugreifen und ihn verwalten, sowie
Systemeinstellungen festlegen und Profileinstellungen ändern. Abbildung 3.1
zeigt die Anzeige der Benutzeroberfläche für den Switch. Beschreibungen sind in
der folgenden Tabelle zu finden.

Abbildung 3.1. Fenster der Benutzeroberfläche

Anzahl Beschreibung

1

ObereOptionsleiste: Verwenden Sie die obere Optionsleiste, um ein
Benutzeroberflächenfenster als Lesezeichen zumarkieren, die Anzeige
einesBenutzeroberflächenfensters zu aktualisieren, eineWebseite zu
drucken, sich von einer OBWI-Sitzung abzumelden oder auf die Online-
Hilfeseite zuzugreifen. Der Name desangemeldeten Benutzerswird auf
der linken Seite der oberenOptionsleiste angezeigt.

Tabelle 3.2: Beschreibungen der Benutzeroberfläche
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Anzahl Beschreibung

2

Seitliche Navigationsleiste: Verwenden Sie die seitliche Navigationsleiste,
um Systeminformationen im Inhaltsbereich anzuzeigen. Die seitliche
Navigationsleiste enthält außerdem in der linken oberen Ecke Symbole,
die beim Anklicken Nodesein- bzw. ausblenden.

3 Inhaltsbereich: Verwenden Sie den Inhaltsbereich, um dasOBWI-System
desSwitchesanzuzeigen oder Änderungen vorzunehmen.

Verwenden der seitlichen Navigationsleiste

Verwenden Sie die seitliche Navigationsleiste zum Anzeigen von Fenstern, in
denen Einstellungen geändert oder Aktionen ausgeführt werden. Durch Klicken
eines Links, der keinen Pfeil enthält, wird das entsprechende Fenster angezeigt.

Verwenden der oberen Navigationsleiste

Wenn die Authentifizierung deaktiviert ist, wird nur die Aktualisieren-Schaltfläche auf
der lokalen Benutzeroberfläche angezeigt.Wenn die Authentifizierung aktiviert ist,
werden nur die Aktualisieren- und Abmelden-Schaltflächen auf der lokalen
Benutzeroberfläche angezeigt. Alle Schaltflächen werden auf der Remote-OBWI
angezeigt.

Einem Fenster ein Lesezeichen hinzufügen (nur Microsoft Internet Explorer)

Die Benutzeroberfläche enthält ein Lesezeichensymbol und Text in der oberen
Optionsleiste. Sie können ein Fenster als Lesezeichen markieren, um einen Link
zum Fenster im Dropdownmenü „Favoriten“ hinzuzufügen. Diesen Link können
Sie jederzeit auswählen, um schnell auf das als Lesezeichen markierte Fenster
zuzugreifen.

Wenn Sie ein Fenster als Lesezeichen markiert haben und die zugehörigen
Fenster-Informationen ändern sich, werden die neuen Informationen im Fenster
angezeigt, sobald das als Lesezeichen markierte Fenster das nächste Mal
aufgerufen wird.

Wenn Sie auf LESEZEICHEN oder auf das Lesezeichen-Symbol klicken,
nachdem das Inaktivitäts-Timeout der Switch-OBWI-Sitzung abgelaufen ist, wird
das Anmelde-Fenster angezeigt und Sie müssen sich erneut anmelden.

Somarkieren Sie ein Fenster als Lesezeichen:

1. Klicken Sie in der oberen Optionsleiste auf LESEZEICHEN oder das
Lesezeichensymbol. Das Dialogfeld „Favorit hinzufügen“ wird angezeigt.
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2. Optional können Sie dem Fenster einen Namen geben. Sie können auch auf
die Schaltfläche Erstellen in klicken, um ein Verzeichnis zu erstellen oder
festzulegen, in dem das Fenster platziert werden soll.

3. Klicken Sie aufOK , um das Dialogfeld „Favorit hinzufügen“ zu schließen.

Ein Fenster drucken

Alle Switch-OBWI-Fenster enthalten ein Drucken-Symbol in der oberen
Optionsleiste.

So drucken Sie das Switch-OBWI-Fenster:

1. Klicken Sie in der oberen Optionsleiste auf DRUCKEN oder auf das
Drucksymbol. Das Dialogfeld „Drucken“ wird angezeigt.

2. Legen Sie die Optionen fest, die Sie zum Drucken des Switch-OBWI-
Fensters verwenden möchten.

3. Klicken Sie auf Drucken, um das Switch-OBWI-Fenster zu drucken und das
Dialogfeld „Drucken“ zu schließen.

Ein Fenster aktualisieren

Sie können die Switch-Benutzeroberfläche durch Klicken auf AKTUALISIEREN
oder das Aktualisieren-Symbol in der oberen Optionsleiste jederzeit
aktualisieren.

Abmelden

Sie können sich jederzeit abmelden, indem Sie auf das Abmelden-Symbol in der
oberen Optionsleiste klicken.

3.2 Anzeigen von Systeminformationen
Auf der Benutzeroberfläche können Sie sich verschiedene Einheiten- und
Zielgeräteinformationen auf unterschiedlichen Bildschirmen anzeigen lassen.

Tabelle 3.3. Systeminformationen

Kategorie Wählen Sie
Folgendesaus: Um diesanzuzeigen:

Switch
Einheiten-Anzeige >
Einheit >Überblick

Switch-Name und -Typ und Einheiten-
Werkzeuge
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Kategorie Wählen Sie
Folgendesaus: Um diesanzuzeigen:

Einheiten-Anzeige >
Einheit >
Eigenschaften >
Identität

Aktuelle Firmware-Version für Anwendung und
Bootvorgang

Einheiten-Anzeige >
Einheit >
Eigenschaften >
Standort

Standort, Abteilung oder Standort

Einheiten-Anzeige >
Einheit >Einheit-
Einstellungen >
Versionen

Aktuelle Firmware-Version für Anwendung,
Bootvorgang und Video-FPGA

Einheiten-Ansicht >
Verbindungen

Liste der angeschlossenenGeräte

Zielgerät
Einheiten-Anzeige >
Zielgeräte

Liste der angeschlossenen Zielgeräte sowie die
folgenden Informationen zu jedemGerät: Name,
Typ, Statusund Aktion

Klicken Sie auf ein Zielgerät, um die folgenden
zusätzlichen Informationen anzuzeigen: Name,
Typ, eID, verfügbare Sitzungsoption und
Verbindungspfad

Sie werden benachrichtigt, wenn einer der folgenden Fehlerzustände vorliegt:
ein Ausfall der Stromversorgung, eine zu hohe Umgebungstemperatur oder ein
Gebläsefehler. Dies wird durch ein gelbes Dreieck mit Ausrufezeichen und dem
Fehlernamen im oberen Teil jedes Bildschirms angezeigt. Diese
Benachrichtigung wird nur nach einer Aktualisierung der Seite angezeigt bzw.
nicht angezeigt. Klicken Sie auf die Benachrichtigung, um weitere Informationen
zu erhalten.
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3.3 KVM s4-Sitzungen
Auf dem Bildschirm „Aktive Sitzungen“ wird eine Liste aktiver Sitzungen und die
folgenden zu jeder Sitzung gehörenden Informationen angezeigt: Zielgerät,
Besitzer, Remote-Host, Dauer und Typ.

Starten einer Sitzung
Java 1.6.0_11 oder höher wird benötigt, um eine Sitzung zu starten.

So starten Sie eine Sitzung:

1. Wählen Sie in der seitlichen Navigationsleiste Einheiten-Ansicht > Zielgeräte
aus. Es wird eine Liste der verfügbaren Geräte angezeigt.

2. Klicken Sie auf den Link KVM-Sitzung oder Serielle Sitzung rechts neben
dem gewünschten Zielgerät, um die Sitzung zu starten.

Wenn das Zielgerät momentan verwendet wird, besteht für Benutzer mit einer
Unterbrechnungsebene, die gleich oder höher als die des aktuellen Benutzers
ist, die Möglichkeit, eine Verbindung zu diesem Gerät zu erzwingen.

So schalten Sie über die lokalen Benutzeroberfläche auf die aktive Sitzung
um (nur lokale Benutzer):

1. Klicken Sie in der seitlichen Navigationsleiste auf Lokale Sitzung.

2. Aktivieren Sie das Kontrollkästchen Aktive Sitzung fortsetzen. Das Video
Viewer-Fenster wird angezeigt.

– oder –

Drücken Sie die Esc-Taste.

Konfigurieren von Sitzungen

So konfigurieren Sie allgemeine Sitzungseinstellungen:

1. Wählen Sie in der seitlichen Navigationsleiste Einheiten-Ansicht > Einheit >
Einheit-Einstellungen > Sitzungen > Allgemein aus. Der Bildschirm
„Allgemeine Sitzungseinstellungen der Einheit“ wird angezeigt.

2. Aktivieren oder deaktivieren Sie das Kontrollkästchen Inaktivitäts-Timeout
aktivieren.

3. Geben Sie im Feld „Inaktivitäts-Timeout“ die Inaktivitätszeit ein, die vergehen
soll, bis die Sitzung geschlossen wird (von 1 bis 90 Minuten).
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4. Geben Sie im Feld „Anmeldungs-Timeout“ die Inaktivitätszeit ein, die
vergehen soll, bis eine erneute Anmeldung erforderlich ist (von 21 bis 120
Sekunden).

5. Aktivieren oder deaktivieren Sie das Kontrollkästchen Timeout für Trennung
aktivieren.

6. Geben Sie im Feld „Timeout für Trennung“ die Zeit (von 1 bis 120 Sekunden)
ein, in der ein Hinweis angezeigt wird und Ihnen mitteilt, dass Ihre Sitzung
getrennt wird.

7. Klicken Sie auf Speichern.

So konfigurieren Sie KVM-Sitzungseinstellungen:

1. Wählen Sie in der seitlichen Navigationsleiste Einheiten-Ansicht > Einheit >
Einheit-Einstellungen > Sitzungen > KVM aus. Der Bildschirm „KVM-
Sitzungseinstellungen der Einheit“ wird angezeigt.

2. Wählen Sie eine Verschlüsselungsstufe für Tastatur- und Maussignale aus
(128-Bit-SSL, DES, 3DES, oder AES) und bei Videosignalen (128-Bit-SSL,
DES, 3DES, AES oder Keine).

3. Wählen Sie eine Sprache im Dropdown-Menü „Tastatur“ aus.

4. Klicken Sie auf Speichern.

So konfigurieren Sie serielle Sitzungseinstellungen:

1. Wählen Sie in der seitlichen Navigationsleiste Einheiten-Ansicht > Einheit >
Einheit-Einstellungen > Sitzungen > Seriell aus. Der Bildschirm „Allgemeine
Einstellungen der seriellen Sitzung“ wird angezeigt.

2. Aktivieren oder deaktivieren Sie das Kontrollkästchen Telnet-Zugriff aktiviert.

3. Klicken Sie auf Speichern.

Schließen einer Sitzung

So schließen Sie eine Sitzung:

1. Klicken Sie in der seitlichen Navigationsleiste auf Aktive Sitzungen, den
Bildschirm „Einheit-Sitzungen“ anzuzeigen.

2. Aktivieren Sie die Kontrollkästchen neben den gewünschten Zielgeräten.

3. Klicken Sie auf Trennen.

Gibt eseine zugehörige gesperrte VirtualMedia-Sitzung, so wird diese getrennt.
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So schließen Sie eine Sitzung (nur lokale Benutzer):

1. Klicken Sie in der seitlichen Navigationsleiste auf Lokale Sitzung.

2. Aktivieren Sie das Kontrollkästchen Aktive Sitzung trennen.

3.4 KVM s4-Switch Werkzeuge
Der Einheiten-Name und -Typ wird auf dem Bildschirm „Einheiten-Überblick“
angezeigt. Zusätzlich können grundlegende Einheiten-Aufgaben ausgeführt
werden.

Neustarten des Switches

So starten Sie den Switch neu:

1. Klicken Sie in der seitlichen Navigationsleiste auf Einheiten-Ansicht >
Einheit > Einheit-Überblick, um den Bildschirm „Einheiten-Überblick“
aufzurufen.

2. Klicken Sie auf Neustart.

3. Ein Dialogfeld weist Sie darauf hin, dass alle aktiven Sitzungen getrennt
werden. Klicken Sie aufOK.

Wenn Sie die lokale Benutzeroberfläche verwenden, werden während desNeustarts
auf demBildschirm keine Informationen angezeigt.Wenn Sie die Remote-OBWI
verwenden, wird eine Nachricht angezeigt, dassdie Benutzeroberfläche wartet, bis der
Neustart der abgeschlossen ist.

Aktualisierung der Switch-Firmware

Sie können den Switch mit der aktuellsten Firmware aktualisieren.

Nachdem der Flash-Speicher mit der Aktualisierung neu programmiert wurde,
führt der Switch einen Warmstart durch, bei dem alle Adapterkabel-Sitzungen
getrennt werden. Ein Zielgerät, bei dem die Adapterkabel-Firmware aktualisiert
wird, wird möglicherweise nicht oder als nicht verbunden angezeigt. Das
Zielgerät wird wie gewohnt angezeigt, sobald die Flash-Aktualisierung beendet
ist.

WARNUNG: Wenn ein Adapterkabelwährend desAktualisierungsvorgangsoder
während einesNeustarts desZielgeräts getrennt wird, wird dasModul beschädigt und
dasAdapterkabelmuss zur Reparatur ansWerkeingeschickt werden.
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So aktualisieren Sie die Firmware des Switches:

1. Klicken Sie in der seitlichen Navigationsleiste auf Einheiten-Ansicht >
Einheit > Einheit-Überblick, um den Bildschirm „Einheiten-Überblick“
aufzurufen.

2. Klicken Sie auf Firmware aktualisieren, um den Bildschirm „Einheiten-
Firmware aktualisieren“ aufzurufen.

3. Wählen Sie eine der folgenden Optionen, um die Firmware-Datei
herunterzuladen:Dateisystem, TFTP, FTP oder HTTP.

DieOption „Dateisystem“ ist nur über die Remote-OBWI verfügbar.

4. Wenn die Option „Dateisystem“ ausgewählt wurde, wählen Sie
Durchsuchen, um den Speicherort der Firmware-Aktualisierungsdatei
festzulegen.

– oder –

Sofern TFTP ausgewählt wurde, geben Sie die Server-IP-Adresse und
die Firmware-Datei ein, die Sie laden möchten.

– oder –

Sofern FTP oder HTTP ausgewählt wurde, geben Sie die Server-IP-
Adresse und die Firmware-Datei ein, die Sie laden möchten, sowie den
Benutzernamen und das Benutzerkennwort.

5. Klicken Sie auf Aktual..

Speichern und Wiederherstellen von Switch-Konfigurationen und -
Benutzerdatenbanken

Sie können die Switch-Konfiguration in einer Datei speichern. Die
Konfigurationsdatei enthält Informationen über die verwaltete Einheit. Sie können
außerdem die lokale Benutzerdatenbank auf dem Switch speichern. Nach dem
Speichern der Dateien können Sie eine zuvor gespeicherte Konfigurationsdatei
oder lokale Benutzerdatenbank-Datei auf den Switch hochladen.

So speichern Sie eine Konfiguration oder eine Benutzerdatenbank einer
verwalteten Einheit:

1. Klicken Sie in der seitlichen Navigationsleiste auf Einheiten-Ansicht >
Einheit > Einheit-Überblick, um den Bildschirm „Einheiten-Überblick“
aufzurufen.
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2. Klicken Sie auf Einheiten-Konfiguration speichern oder Einheiten-
Benutzerdatenbank speichern. Das Dialogfeld „Datei herunterladen“ wird
geöffnet.

3. Klicken Sie auf Speichern. Das Dialogfeld „Speichern unter“ wird geöffnet.

4. Navigieren Sie zum gewünschten Speicherort und geben Sie einen
Dateinamen ein. Klicken Sie auf Speichern.

5. Klicken Sie auf Schließen.

So stellen Sie eine Konfiguration oder eine Benutzerdatenbank einer
verwalteten Einheit wieder her:

1. Klicken Sie in der seitlichen Navigationsleiste auf Einheiten-Ansicht >
Einheit > Einheit-Überblick, um den Bildschirm „Einheiten-Überblick“
aufzurufen.

2. Klicken Sie auf Einheiten-Konfiguration wiederherstellen oder Einheiten-
Benutzerdatenbank wiederherstellen. Der Bildschirm „Einheiten-
Konfiguration wiederherstellen“ oder „Einheiten-Benutzerdatenbank
wiederherstellen“ wird angezeigt.

3. Klicken Sie auf Durchsuchen. Navigieren Sie zum gewünschten Speicherort
und wählen Sie einen Dateinamen aus. Klicken Sie auf Hochladen.

4. Klicken Sie nach der Anzeige des Bestätigungsbildschirms auf Schließen.
Starten Sie die verwaltete Einheit neu, um die wiederhergestellte
Konfiguration zu aktivieren. Siehe „KVM s4-Switch Werkzeuge“ auf Seite 30.

3.5 Netzwerkeinstellungen
Nur Switch-Administratoren könne Änderungen imDialogfeld für die
Netzwerkeinstellungen vornehmen. Andere Benutzer können sich diese Einstellungen
lediglich anzeigen lassen.

So konfigurieren Sie die allgemeinen Netzwerkeinstellungen:

1. Wählen Sie in der seitlichen Navigationsleiste Einheiten-Ansicht > Einheit >
Einheit-Einstellungen > Netzwerk > Allgemein aus. Der Bildschirm
„Allgemeine Einheit-Netzwerkeinstellungen“ wird angezeigt.

2. Wählen Sie eine der folgenden Optionen aus dem Dropdownmenü für die
LAN-Geschwindigkeit: Automatische Erkennung, 10 MBit/s Halbduplex, 10
MBit/s Vollduplex, 100 MBit/s Halbduplex, 100 MBit/s Vollduplex oder 1
GBit/s Vollduplex.
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Siemüssen einen Neustart ausführen, wenn der Ethernet-Modusgeändert wurde.

3. Wählen Sie entweder Aktiviert oder Deaktiviert im Dropdownmenü „ICMP-
Ping-Antwort“.

4. Klicken Sie auf Speichern.

So konfigurieren Sie IPv4-Netzwerkeinstellungen:

1. Wählen Sie in der seitlichen Navigationsleiste Einheiten-Ansicht > Einheit >
Einheit-Einstellungen > Netzwerk > IPv4 aus. Der Bildschirm „IPv4-
Einstellungen“ des Switches wird angezeigt.

2. Aktivieren oder deaktivieren Sie das Kontrollkästchen IPv4 aktivieren, um
den IPv4-Modus zu aktivieren oder deaktivieren.

3. Geben Sie die gewünschten Informationen in die Adress-, Subnetz- und
Gateway-Felder ein.

4. Wählen Sie entweder Aktiviert oder Deaktiviert im Dropdownmenü „DHCP“
aus.

Wenn Sie DHCPaktivieren, werden alle Informationen, die Sie in die Adress-, Subnetz-
undGateway-Felder eingeben, nicht beachtet.

5. Klicken Sie auf Speichern.

So konfigurieren Sie IPv6-Netzwerkeinstellungen:

1. Wählen Sie in der seitlichen Navigationsleiste Einheiten-Ansicht > Einheit >
Einheit-Einstellungen > Netzwerk > IPv6 aus. Der Bildschirm „IPv4-
Einstellungen“ des Switches wird angezeigt.

2. Aktivieren oder deaktivieren Sie das Kontrollkästchen Zustandsbehaftete
IPv6-Konfiguration aktivieren, um den IPv6-Modus zu aktivieren oder
deaktivieren.

3. Geben Sie die gewünschten Informationen in die Adress-, Gateway- und
Präfix-Länge-Felder ein.

4. Wählen Sie entweder Aktiviert oder Deaktiviert im Dropdownmenü
„DHCPv6“ aus.

Wenn Sie DHCPv6 aktivieren, werden alle Informationen, die Sie in die Adress-,
Gateway- und Präfix-Länge-Felder eingeben, nicht beachtet.

5. Klicken Sie auf Speichern.

590-1058-640A 33



3. Lokale und Remote-Konfiguration

3.6 DNS-Einstellungen
Sie können den DNS-Server entweder manuell zuweisen oder die über DHCP
oder DHCPv6 erhaltenen Adressen verwenden.

So konfigurieren Sie DNS-Einstellungen manuell:

1. Wählen Sie in der seitlichen Navigationsleiste Einheiten-Ansicht > Einheit >
Einheit-Einstellungen > DNS aus. Der Bildschirm mit den DNS-Einstellungen
der Einheit wird angezeigt.

2. Wählen Sie Manuell, DHCP (bei aktiviertem IPv4) oder DHCPv6 (bei
aktiviertem IPv6) aus.

3. Geben Sie bei der Auswahl von Manuell die DNS-Servernummern in die
Felder für primär, sekundär und tertiär ein.

4. Klicken Sie auf Speichern.

3.7 Einstellungen der lokalen Benutzeroberfläche
So ändern Sie, wie die lokale Benutzeroberfläche aufgerufen wird:

1. Klicken Sie in der seitlichen Navigationsleiste auf Einheiten-Ansicht >
Einheit > Einheit-Einstellungen > Ports > Benutzeroberfläche des lokalen
Ports, um den Einstellungsbildschirm für die Benutzeroberfläche des lokalen
Ports aufzurufen.

2. Aktivieren Sie unter der Überschrift „Benutzeroberfläche des lokalen Ports“
ein Kontrollkästchen neben mindestens einer der aufgeführten Methoden.

3. Klicken Sie aufOK.

Benutzereinstellungen des lokalen Ports

Die Authentifizierung der Benutzeroberfläche des lokalen Ports kann ein- oder
ausgeschaltet und eine Benutzer-Zugriffsstufe ausgewählt werden. Wenn die
Authentifizierung der Benutzeroberfläche des lokalen Ports eingeschaltet wird, ist
eine Anmeldung erforderlich, bevor die Oberfläche verwendet werden kann.

Des Weiteren kann die Tastatursprache des lokalen Ports und die Scan-
Moduszeit eingestellt sowie das Kennwort des Setup-Ports aktiviert bzw.
deaktiviert und eine Benutzerunterbrechungsebene ausgewählt werden. Die
Benutzerunterbrechungsebene bestimmt, ob Benutzer eine andere serielle oder
KVM-Sitzung mit einem Zielgerät trennen können. Es gibt die
Benutzerunterbrechungsebenen 1 bis 4, wobei 4 die höchste Ebene darstellt.
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Beispiel: Ein Benutzer mit einer Benutzerunterbrechungsebene von 4 kann
andere Benutzer mit Ebene 4 sowie der Ebenen 1, 2 und 3 unterbrechen.

So ändern Sie die Standardunterbrechungsebene (nur Administratoren):

1. Klicken Sie in der seitlichen Navigationsleiste auf Einheiten-Ansicht >
Einheit > Einheit-Einstellungen > Ports > Benutzeroberfläche des lokalen
Ports, um den Einstellungsbildschirm für die Benutzeroberfläche des lokalen
Ports aufzurufen.

2. Aktivieren oder deaktivieren Sie das Kontrollkästchen
Benutzerauthentifizierung am lokalen Port deaktivieren.

3. Wählen Sie eine der folgenden Optionen aus dem Dropdown-Menü der
Benutzer-Zugriffsstufe aus:Benutzer, Benutzeradministratoroder
Einheitenadministrator.

4. Wählen Sie eine Zahl zwischen 1 und 4 aus dem Dropdown-Menü der
Benutzerunterbrechungsebene aus.

5. Klicken Sie auf Speichern.

3.8 Virtual Media
Sie können das Verhalten des Switches während einer Virtual Media-Sitzung
mithilfe der Optionen im Bildschirm „Virtual Media-Sitzungseinstellungen der
Einheit“ festlegen. In der unten stehenden Tabelle sind die Optionen dargestellt,
die für Virtual Media-Sitzungen eingerichtet werden können. Weitere
Informationen zur Verwendung von Virtual Media in einer KVM-Sitzung finden
Sie unter „Virtual Media“ auf Seite 67.

Einstellung Beschreibung

Sitzungseinstellungen: Virtual
Media gesperrt für KVM-
Sitzungen

Die Option „Gesperrt“ gibt an, ob eine VirtualMedia-
Sitzung für die KVM-Sitzung auf dem Zielgerät gesperrt
wurde.Wenn die Option „Gesperrt“ aktiviert ist
(Standardeinstellung) und die KVM-Sitzung geschlossen
wird, wird auch die VirtualMedia-Sitzung geschlossen.
Wenn „Gesperrt“ deaktiviert ist und die KVM-Sitzung
geschlossen wird, bleibt die VirtualMedia-Sitzung
weiterhin aktiv.

Tabelle 3.4: Virtual Media-Sitzungseinstellungen
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Einstellung Beschreibung

Sitzungseinstellungen:
 Reservierte Sitzungen
erlauben

Stellt sicher, dassder Zugriff auf eine VirtualMedia-
Verbindung nur mit IhremBenutzernamenmöglich ist
und kein anderer Benutzer eine KVM-Verbindung zu
diesem Zielgerät herstellen kann.Wenn die zugehörige
KVM-Sitzung getrennt wird, wird die VirtualMedia-
Sitzung je nachdem, ob die Einstellung „Gesperrt“ im
Dialogfeld „VirtualMedia“ aktiviert ist oder nicht, ebenfalls
getrennt.

Laufwerkzuordnungen:
VirtualMedia-Zugriffsmodus

Sie können den Zugriffsmodus für zugeordnete
Laufwerke auf „Nur Lesezugriff“ bzw. „Lese- und
Schreibzugriff“ einstellen. Im schreibgeschützten
Zugriffsmoduskönnen keine Daten auf das zugeordnete
Laufwerk desClient-Servers geschrieben werden.Wenn
der ZugriffsmodusLese- und Schreibzugriff ist, können
Sie Daten auf das zugeordnete Laufwerk schreiben bzw.
von diesem lesen.Wenn das zugeordnete Laufwerk
typenbedingt schreibgeschützt ist (beispielsweise
bestimmte CD-ROM, DVD-ROModer ISO-Images),
wird der konfigurierte Schreib-Lese-Zugriff ignoriert. Das
Festlegen des schreibgeschützten Zugriffsmodus ist
nützlich, wenn ein Laufwerkmit Schreib-Lese-Zugriff,
wie z. B. ein Massenspeichergerät oder ein USB-
Wechselmedium, zugeordnet wird und Sie verhindern
möchten, dassder Benutzer Daten darauf schreibt.

Sie können ein DVD-Laufwerk und ein
Massenspeichergerät gleichzeitig zuweisen. Ein CD-
ROM-, DVD-Laufwerk oder eine ISO-Image-Dateiwird
als virtuellesCD-/DVD-Laufwerk zugewiesen.

Verschlüsselungsstufe

Sie können Verschlüsselungsstufen für VirtualMedia-
Sitzungen konfigurieren. Die folgenden
Verschlüsselungsstufen stehen zur Verfügung: Keine
(Standardeinstellung), 128-Bit-SSL (ARCFOUR), DES,
3DESund AES.
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Einstellung Beschreibung

VirtualMedia-Zugriff über
Adapterkabel: VM
aktivieren/VM deaktivieren

Im Abschnitt VirtualMedia-Zugriff über Adapterkabel
werden alle KVM s4-Adapter-USB20-VGA-Kabel
aufgeführt. Diese Auflistung enthält Einzelheiten über
jedesKabel, einschließlich der Option, VirtualMedia für
jedesKabel zu aktivieren bzw. zu deaktivieren.

So legen Sie Virtual Media-Optionen fest:

1. Klicken Sie in der seitlichen Navigationsleiste auf Einheiten-Ansicht >
Einheit > Einheit-Einstellungen > Sitzungen > Virtual Media, um den
Bildschirm „Virtual Media-Einstellungen der Einheit“ aufzurufen.

2. Aktivieren oder deaktivieren Sie das Kontrollkästchen Virtual Media gesperrt
für KVM-Sitzungen.

3. Aktivieren oder deaktivieren Sie das Kontrollkästchen Reservierte Sitzungen
zulassen.

4. Wählen Sie eine der folgenden Optionen aus dem Dropdownmenü für den
Virtual Media-Zugriffsmodus: Schreibgeschützt oder Lese-/Schreibzugriff.

5. Wählen Sie eine der Verschlüsselungsstufen, die verwendet werden soll.

6. Aktivieren Sie das Kontrollkästchen neben jedem KVM s4-Adapter-USB20-
VGA-Kabel, für den Sie Virtual Media aktivieren möchten, und klicken Sie auf
VM aktivieren.

– oder –

Aktivieren Sie das Kontrollkästchen neben jedem KVM s4-Adapter-
USB20-VGA-Kabel, für den Sie Virtual Media deaktivieren möchten, und
klicken Sie auf VM deaktivieren.

7. Klicken Sie auf Speichern.

Lokale Virtual Media-Einstellungen

Lokale Benutzer können außerdem vom lokalen Sitzungsbildschirm das
Verhalten von Virtual Media bestimmen. Zusätzlich zum Aktivieren und
Deaktivieren einer Virtual Media-Sitzung können Sie die Einstellungen aus
folgender Tabelle konfigurieren.

Tabelle 3.5. Lokale Virtual Media-Sitzungseinstellungen
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Einstellung Beschreibung

CD-ROM/

DVD-ROM

Ermöglicht VirtualMedia-Sitzungenmit dem ersten erkannten
CD-ROM- oder DVD-ROM-Laufwerk (schreibgeschützt).
Aktivieren Sie diesesKontrollkästchen, um eine VirtualMedia
CD-ROM- oder DVD-ROM-Verbindungmit einem Zielgerät
herzustellen. Deaktivieren Sie diesesKontrollkästchen, um eine
VirtualMedia CD-ROM- oder DVD-ROM-Verbindungmit einem
Zielgerät zu beenden.

Massenspeicher

Ermöglicht VirtualMedia-Sitzungenmit dem ersten erkannten
Massenspeichergerät. Aktivieren Sie diesesKontrollkästchen,
um eine VirtualMedia-Massenspeicher-Verbindungmit einem
Zielgerät herzustellen. Deaktivieren Sie dasKontrollkästchen,
um eine VirtualMedia-Verbindung zwischen einem
Massenspeichergerät und einem Zielgerät zu beenden.

Reserviert

Stellt sicher, dassder Zugriff auf eine VirtualMedia-Verbindung
nur mit IhremBenutzernamenmöglich ist und kein anderer
Benutzer eine KVM-Verbindung zu diesem Zielgerät herstellen
kann.

So konfigurieren Sie lokale Virtual Media-Einstellungen:

1. Klicken Sie in der seitlichen Navigationsleiste auf Lokale Sitzung.

2. Aktivieren oder deaktivieren Sie die jeweiligen Virtual Media-
Sitzungsoptionen.

3.9 Modemeinstellungen
Vom Bildschirm „Einheit-Modemeinstellungen“ aus können Sie verschiedene
Modemeinstellungen vornehmen sowie die folgenden Modemeinstellungen
ansehen: lokale Adresse, Remote-Adresse, Subnetzmaske und Gateway.

Weitere Informationen zum Anschließen des Switches an ein Modem finden Sie
unter „Anschluss der Switch-Hardware“ auf Seite 11.

So konfigurieren Sie die Modemeinstellungen:

1. Klicken Sie in der seitlichen Navigationsleiste auf Einheiten-Ansicht >
Einheit > Einheit-Einstellungen > Ports > Modem, um den Bildschirm
„Modemeinstellungen“ aufzurufen.

2. Aktivieren oder deaktivieren Sie das Kontrollkästchen Modemsitzungen
können digitale Sitzungen unterbrechen.
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3. Wählen Sie ein Authentifizierungs-Timeout von 30 bis 300 Sekunden und
ein Inaktivitäts-Timeout von 1 bis 60 Sekunden.

4. Klicken Sie auf Speichern.

3.10 Scan-Modus
Im Scan-Modus scannt der Switch automatisch von Port zu Port (Zielgerät zu
Zielgerät). Sie können mehrere Zielgeräte scannen und bestimmen, welche
Geräte gescannt werden sollen. Die Scan-Reihenfolge wird von der Position des
Zielgeräts in der Liste bestimmt. Sie können außerdem die Zeitspanne
definieren, die verstreicht, bis das nächstfolgende Zielgerät gescannt wird.

Die Schaltfläche „Scannen“ ist deaktiviert, wenn eine Verbindung zu einemModem
besteht.

So fügen Sie Zielgeräte zur Scan-Liste hinzu:

1. Klicken Sie in der seitlichen Navigationsleiste auf Einheiten-Ansicht >
Zielgeräte, um den Bildschirm „Zielgeräte“ aufzurufen.

2. Aktivieren Sie das Kontrollkästchen neben den Zielgeräten, die gescannt
werden sollen.

3. Klicken Sie auf Scannen.

So konfigurieren Sie die Scandauer:

1. Klicken Sie in der seitlichen Navigationsleiste auf Einheiten-Ansicht >
Einheit > Einheit-Einstellungen > Ports > Benutzeroberfläche des lokalen
Ports, um den Einstellungsbildschirm für die Benutzeroberfläche des lokalen
Ports aufzurufen.

2. Geben Sie unter der Scan-Modus-Überschrift in das Scandauer-Feld die
Dauer in Sekunden (von 3 - 255) ein.

3. Klicken Sie auf Speichern.

3.11 DSView 3 Server-IP-Adressen
Sie können einen Switch, der nicht verwaltet ist, über einen DSView 3-Server
kontaktieren und registrieren, indem Sie die IP-Adressen von bis zu vier DSView
3-Servern festlegen.
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So konfigurieren Sie die DSView 3-IP-Adresse eines Servers:

1. Wählen Sie in der seitlichen Navigationsleiste Einheiten-Ansicht > Einheit >
Einheit-Einstellungen > Benutzerkonten > DSView 3 aus. Der Bildschirm mit
den DSView 3-Einstellungen wird angezeigt.

2. Geben Sie bis zu vier IP-Adressen des DSView 3-Software-Servers in den
Server-Feldern 1 - 4 ein, mit denen Sie eine Verbindung herstellen möchten.

3. Klicken Sie auf Speichern.

3.12 Benutzerkonten

Verwalten lokaler Benutzerkonten

Die Switch-OBWI bietet lokale und Anmeldungssicherheit durch vom
Administrator definierte Benutzerkonten. Durch Auswahl von Lokale
Benutzerkonten in der seitlichen Navigationsleiste können Administratoren
Benutzer hinzufügen und löschen, Benutzerunterbrechungen und Zugriffsstufen
festlegen und Kennwörter ändern.

Zugriffsstufen

Sobald ein Benutzerkonto hinzugefügt wird, kann der Benutzer zu den folgenden
Zugriffsstufen zugewiesen werden: Einheitenadministrator,
Benutzeradministrator und Benutzer.

Zugriffsstufe

Vorgang Einheitenadministrator Benutzeradministrator Benutzer

Einstellungen der
Benutzeroberflächen-
Zugriffsstufe
konfigurieren

Ja Nein Nein

Zugriffsrechte
konfigurieren

Ja Ja Nein

Benutzerkonten
hinzufügen, ändern und
löschen

Ja, für alle
Zugriffsstufen

Ja, jedoch nur für
Benutzer und
Benutzeradministratoren

Nein

Tabelle 3.6: Zulässige Aktionen nach jeweiliger Zugriffsstufe
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Zugriffsstufe

Vorgang Einheitenadministrator Benutzeradministrator Benutzer

EigenesKennwort
ändern

Ja Ja Ja

Auf Zielgerät zugreifen Ja, alle Zielgeräte Ja, alle Zielgeräte Ja, falls zulässig

So fügen Sie ein neues Benutzerkonto hinzu (nur Administratoren):

1. Klicken Sie in der seitlichen Navigationsleiste auf Einheiten-Ansicht >
Einheit > Einheit-Einstellungen > Benutzerkonten > Lokale Benutzerkonten,
um den Bildschirm „Lokale Benutzerkonten der Einheit“ aufzurufen.

2. Klicken Sie auf die Schaltfläche Hinzufügen.

3. Geben Sie den Namen und das Kennwort des neuen Benutzers in die dafür
vorgesehenen Felder ein.

4. Wählen Sie die Unterbrechungs- und Zugriffsstufen für den neuen Benutzer
aus.

5. Wählen Sie die jeweiligen verfügbaren Zielgeräte aus, die dem
Benutzerkonto zugewiesen werden sollen, und klicken Sie auf Hinzufügen.

Benutzer- und Einheitenadministratoren können auf alle Zielgeräte zugreifen.

6. Klicken Sie auf Speichern.

So löschen Sie ein Benutzerkonto (nur Administratoren):

1. Klicken Sie in der seitlichen Navigationsleiste auf Einheiten-Ansicht >
Einheit > Einheit-Einstellungen > Benutzerkonten > Lokale Benutzerkonten,
um den Bildschirm „Lokale Benutzerkonten der Einheit“ aufzurufen.

2. Aktivieren Sie das Kontrollkästchen links neben jedem Konto, das Sie
löschen möchten, und klicken Sie auf Löschen.

So bearbeiten Sie ein Benutzerkonto (nur Administratoren oder aktive
Benutzer):

1. Wählen Sie in der seitlichen Navigationsleiste Einheiten-Ansicht > Einheit >
Einheit-Einstellungen > Benutzerkonten > Lokale Benutzerkonten aus. Der
Bildschirm „Lokale Benutzerkonten der Einheit“ wird angezeigt.
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2. Klicken Sie auf den Namen des Benutzers, dessen Konto bearbeitet werden
soll. Das Benutzerprofil wird angezeigt.

3. Geben Sie die Benutzerinformationen auf dem Bildschirm ein und klicken
Sie auf Speichern.

3.13 SNMP-Einstellungen
SNMP ist ein Protokoll, das verwendet wird, um Verwaltungsinformationen
zwischen Netzwerk-Managementanwendungen und dem Switch zu
kommunizieren. Andere SNMP-Manager können mit dem Switch kommunizieren,
indem Sie auf MIB-II und den öffentlichen Teil von Enterprise-MIB zugreifen.
Wenn Sie den SNMP-Bildschirm öffnen, ruft OBWI die SNMP- Parameter aus der
Einheit ab.

Im Bildschirm „SNMP“ können Sie die Systeminformationen und Community-
Zeichenketten eingeben. Außerdem können Sie festlegen, welche Konsolen den
Switch verwalten und SNMP-Traps vom Switch empfangen können. Wenn Sie
SNMP aktivieren auswählen, antwortet die Einheit auf SNMP- Anfragen über
UDP-Port 161.

So konfigurieren Sie allgemeine SNMP-Einstellungen:

1. Wählen Sie Einheiten-Ansicht > Einheit > Einheit-Einstellungen > SNMP>
SNMP-Einstellungen aus, um den SNMP-Bildschirm aufzurufen.

2. Aktivieren Sie das Kontrollkästchen SNMP aktivieren, um es dem Switch zu
erlauben, auf SNMP-Anfragen über UDP-Port 161 zu antworten.

3. Geben Sie den vollständigen System-Domainnamen in das Namensfeld ein,
sowie eine Node-Kontaktperson im Kontaktfeld.

4. Geben Sie die Lese-, Schreib- und Trap-Community-Namen ein. Damit
werden die Community-Zeichenketten festgelegt, die für SNMP-Aktionen
verwendet werden müssen. Die Zeichenketten für Lesen und Schreiben
gelten nur für SNMP über den UPD-Port 161 und fungieren als Kennwörter,
die den Zugriff auf den Switch schützen. Die Eingaben können eine
maximale Länge von 64 Zeichen haben. Diese Felder dürfen nicht leer
bleiben.

5. Geben Sie die Adressen von bis zu vier Management-Workstations in die
Felder „Zugelassene Manager“ ein, die diesen Switch verwalten sollen. Sie
können diese Felder auch leer lassen, so dass der Switch von allen
Konsolen verwaltet werden kann.

6. Klicken Sie auf Speichern.
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3.14 Ereigniseinstellungen
Ein Ereignis ist eine Benachrichtigung, die vom Switch zu einer
Managementkonsole gesendet wird, und die angibt, dass ein Ereignis
aufgetreten ist, das ggf. Ihre Aufmerksamkeit erfordert.

So aktivieren Sie einzelne Ereignisse:

1. Wählen Sie Einheiten-Ansicht > Einheit > Einheit-Einstellungen > Audit >
Ereignisse aus, um den Ereignis-Bildschirm aufzurufen.

2. Geben Sie durch Aktivieren der entsprechenden Kontrollkästchen in der
Liste die Ereignisse an, die Benachrichtigungen auslösen sollen.

– oder –

Aktivieren oder deaktivieren Sie das Kontrollkästchen neben
„Ereignisname“, um die gesamte Liste auszuwählen bzw. die gesamte
Auswahl aufzuheben.

3. Klicken Sie auf Speichern.

3.15 Einstellen von Ereignis-Zielen
Sie können Audit-Ereignisse so konfigurieren, dass sie an SNMP-Trap-Ziele und
Syslog-Server gesendet werden. Die Ereignisse, die auf dem Ereignis-Bildschirm
aktiviert sind, werden an alle auf dem Bildschirm „Ereignis-Ziele“ aufgeführten
Server gesendet.

1. Wählen Sie Einheiten-Ansicht > Einheit > Einheit-Einstellungen > Audit >
Ziele aus, um den Ereignis-Ziel-Bildschirm aufzurufen.

2. Geben Sie die Adressen von bis zu vier Management-Workstations ein, an
die dieser Switch Ereignisse in den SNMP-Trap-Adress-Feldern sowie an
bis zu vier Syslog-Server sendet.

3. Klicken Sie auf Speichern.

3.16 Konfiguration der Adapterkabel
Sie können vom Switch aus eine Liste der angeschlossenen Adapterkabel sowie
die folgenden Informationen über jedes Kabel anzeigen: eID (elektronische
Kennung), Port, Status, Anwendung, Schnittstellentyp und USB-Geschwindigkeit.
Klicken Sie auf ein Kabel, um die folgenden zusätzlichen Informationen
anzuzeigen: Switch-Typ, Boot-Version, Hardware-Version, FPGA-Version,
verfügbare Version und Aktualisierungsstatus.
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Zusätzlich können Sie die folgende Aufgaben ausführen: Offline-Adapterkabel
löschen, Kabel-Firmware aktualisieren, USB-Geschwindigkeit einstellen oder
Kabel außer Betrieb nehmen.

So löschen Sie Offline-Adapterkabel:

1. Klicken Sie in der seitlichen Navigationsleiste auf Einheiten-Ansicht >
Einheit > Einheit-Einstellungen > Ports > Adapterkabel, um den Bildschirm
„Einheiten-Adapterkabel“ aufzurufen.

2. Klicken Sie aufOffline löschen.

So legen Sie die USB-Geschwindigkeit fest (nur für KVM s4-Adapter-USB20-
VGA-Kabel):

1. Klicken Sie in der seitlichen Navigationsleiste auf Einheiten-Ansicht >
Einheit > Einheit-Einstellungen > Ports > USB20-VGA, um den Bildschirm
„USB20-VGA“ aufzurufen.

2. Aktivieren Sie das/die Kontrollkästchen neben dem/den Kabel(n), die Sie
ändern möchten.

3. Klicken Sie entweder auf USB 1.1-Geschwindigkeit festlegen oder USB 2.0-
Geschwindigkeit festlegen.

Adapterkabel aktualisieren

Die Adapterkabel erhalten mit einer Flash-Aktualisierung die neueste Firmware.
Diese Aktualisierung kann über die Switch-Benutzeroberfläche oder die DSView
3-Managementsoftware durchgeführt werden.

Nachdem der Flash-Speicher mit der Aktualisierung neu programmiert wurde,
führt der Switch einen Warmstart durch, bei dem alle Adapterkabel-Sitzungen
getrennt werden. Ein Zielgerät, bei dem die Adapterkabel-Firmware aktualisiert
wird, wird möglicherweise nicht oder als nicht verbunden angezeigt. Das
Zielgerät wird wie gewohnt angezeigt, sobald die Flash-Aktualisierung beendet
ist.

Wenn die Einheit so konfiguriert ist, dass Adapterkabel automatisch aktualisiert
werden, werden Adapterkabel automatisch aktualisiert, wenn der Switch
aktualisiert wird. Informationen zum Aktualisieren der Switch-Firmware finden Sie
unter „KVM s4-Switch Werkzeuge“ auf Seite 30 oder in der Online-Hilfe der
DSView 3 Software-Managementsoftware. Wenn während des normalen
Aktualisierungsvorgangs Probleme auftreten, können Sie Adapterkabel auch bei
Bedarf manuell aktualisieren.

Firmware-Aktualisierungsdateien sind auf http://www.ts.fujitsu.com zu finden.
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So aktualisieren Sie Adapterkabel:

1. Klicken Sie in der seitlichen Navigationsleiste auf Einheiten-Ansicht >
Einheit > Einheit-Einstellungen > Ports > Adapterkabel, um den Bildschirm
„Einheiten-Adapterkabel“ aufzurufen.

2. Aktivieren Sie die Kontrollkästchen neben den Adapterkabeln, die Sie
aktualisieren möchten, und klicken Sie auf Aktual..

WARNUNG: Wenn ein Adapterkabelwährend desAktualisierungsvorgangsoder
während einesNeustarts desZielgeräts getrennt wird, wird dasModul beschädigt und
dasAdapterkabelmuss zur Reparatur ansWerkeingeschickt werden.

3.17 Stromverwaltungsgeräte-Einstellungen
Siemüssen über Administrator-Berechtigungen verfügen, um die
Stromverwaltungsgeräte-Einstellungen zu ändern.

Auf dem Bildschirm „Einheiten-Stromverwaltungsgeräte“ wird eine Liste der
angeschlossenen Stromverwaltungsgeräte und die folgenden zu jedem
Stromverwaltungsgerät gehörenden Informationen angezeigt: Name, Port,
Status, Version, Modell, Tonsignal, Alarm und Temperatur. Sie können auch erst
ein Stromverwaltungsgerät und dann Einstellungen auswählen, um die
folgenden detaillierten Informationen über das Stromverwaltungsgerät
anzuzeigen: Name, Beschreibung, Status, Version, Ausgänge, Herstellername,
Model und Eingangs-Feeds.

Wenn ein Zielgerät an einen Stromverwaltungsgeräte-Ausgang angeschlossen
ist, können Sie das Zielgerät ein-, aus- bzw. aus- und wieder einschalten.

So schalten Sie den Strom für ein Gerät ein, aus oder aus und wieder ein:

1. Klicken Sie in der seitlichen Navigationsleiste auf Einheiten-Ansicht >
Einheit > Einheit-Einstellungen > Ports > Stromverwaltungsgeräte, um den
Bildschirm „Einheit-Stromverwaltungsgeräte“ aufzurufen.

2. Klicken Sie auf den Namen der Einheit, die Sie konfigurieren möchten, und
wählen Sie Ausgänge aus.

3. Aktivieren Sie die Kontrollkästchen links neben den Ausgängen, die Sie
konfigurieren möchten.

4. Klicken Sie auf Ein, Aus oder auf Aus- und einschalten.
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So löschen Sie Stromverwaltungsgeräte, die offline sind:

1. Klicken Sie in der seitlichen Navigationsleiste auf Einheiten-Ansicht >
Einheit > Einheit-Einstellungen > Ports > Stromverwaltungsgeräte, um den
Bildschirm „Einheit-Stromverwaltungsgeräte“ aufzurufen.

2. Klicken Sie aufOffline löschen.

So ändern Sie die Minimum-Ein-Zeit, Aus-Zeit oder denWachzustand:

1. Klicken Sie in der seitlichen Navigationsleiste auf Einheiten-Ansicht >
Einheit > Einheit-Einstellungen > Ports > Stromverwaltungsgeräte, um den
Bildschirm „Einheit-Stromverwaltungsgeräte“ aufzurufen.

2. Klicken Sie auf den Namen der Einheit, die Sie konfigurieren möchten, und
wählen Sie Ausgänge aus.

3. Klicken Sie auf den Ausgangsnamen, den Sie ändern möchten.

4. Verwenden Sie die Dropdown-Fenster, um die gewünschten Einstellungen
vorzunehmen, und klicken Sie auf Speichern.

Zugehörige Zielserver und Stromausgänge

Durch das Benennen von mindestens einem Stromausgang mit dem Namen des
Zielgeräts werden die Ausgänge mit dem Zielserver für eine einfachere
Steuerung verbunden bzw. verknüpft. Auf der OBWI-Zielgeräte-Seite können
Stromverwaltungsmaßnahmen für ein Ziel mit verknüpften Ausgängen
ausgewählt werden. Auf der Ziel-Übersichtsseite sind die mit Zielgeräten
verknüpften Ausgänge in einer Tabelle dargestellt.

Das mit Server2 in der folgenden Abbildung bezeichnete Zielgerät verfügt über
verknüpfte Ausgänge. Durch Klicken auf den Pfeil des Dropdown-Menüs in der
Spalte „Aktion“ werden die verfügbaren Aktionen für Netzanschlüsse angezeigt.

Abbildung 3.2. Zielgeräte
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In der folgenden Abbildung werden auf der Zieleinheiten-Überblickseite für
Server2 die Netzanschlüsse angezeigt, wobei Ausgang 1 und Ausgang 9 von
PDU 1 mit Server2 verknüpft sind.

Abbildung 3.3. Zielübersicht Server2

Zusammenfassen von Stromausgängen zu Gruppen

Mehreren Stromausgängen kann derselbe Name zugewiesen werden, um sie zu
einer Gruppe zusammenzufassen, die dann wiederum als ein Zielgerät
angezeigt wird. Stromverwaltungsaktionen, die auf der Zielgeräte-Seite
durchgeführt werden, werden auf die jeweiligen Ausgänge angewandt.
Stromverwaltungsaktionen für bestimmte Stromausgänge eines Zielgeräts
können auf der Einheiten-Überblick-Seite durchgeführt werden. In der folgenden
Abbildung besteht das mit Gruppe2 bezeichnete Zielgerät aus den
Stromausgängen 4 und 5 der PDU 1.

Abbildung 3.4. Zielübersicht für Gruppe2

Standardausgangsnamen

Auf der Seite „Stromverwaltungsgeräte“ kann mit dem Kontrollkästchen
„Ausgängen Standardnamen zuweisen“ festgelegt werden, ob den Ausgängen
von Stromverwaltungsgeräten Standardnamen zugeteilt werden (siehe folgende
Abbildung). Nur Stromausgänge mit Namen werden auf der Zielseite aufgeführt.
Standardmäßig zugewiesene Namen von Stromausgängen können durch
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Deaktivieren des Kontrollkästchens „Ausgängen Standardnamen zuweisen“
gelöscht werden. Stromausgängen ohne Namen können durch Aktivieren des
Kontrollkästchens „Ausgängen Standardnamen zuweisen“ und Speichern der
Einstellung Standardnamen zugewiesen werden.

Abbildung 3.5. Seite „Einheiten-Stromverwaltungsgeräte“

Zuweisen eines Ausgangsnamens

Auf der Seite „Einstellungen für Stromverwaltungsgeräte-Ausgang“ sind drei
Optionen verfügbar, um einem Ausgang einen Namen zuzuweisen (siehe
folgende Abbildung). Die Optionen sind „Manuelle Namenszuweisung“,
„Verbindung mit Zielgerät“ und „Nicht als Zielgerät anzeigen“

Abbildung 3.6. Seite „Einstellungen für Stromverwaltungsgeräte-Ausgang“

• Mit der Option „Manuelle Namenszuweisung“ wird dem Ausgang ein
eindeutiger Name zugewiesen. Der Name für alle Adapterkabel und
Ausgänge muss eindeutig sein. Wenn ein Name manuell vergeben wird und
dieser nicht eindeutig ist, tritt ein Fehler auf und der Name wird nicht
gespeichert.

• Mit der Zuweisung von „Verbindung mit Zielgerät“ wird der Ausgang mit
einem anderen Zielnamen für die Stromverwaltung des benannten Ziels
verknüpft (entweder ein Ausgang oder ein Adapterkabel). Wenn ein
Ausgang mit einem Adapterkabel-Zielnamen verknüpft wird, versorgt der
Ausgang normalerweise den an das Adapterkabel angeschlossenen Server
physisch mit Strom.
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• Mit der Option „Nicht als Zielgerät anzeigen“ erhält der Ausgang keinen
Namen und wird somit auch nicht auf der Zielgeräteseite angezeigt. Diese
Option kann für unbelegte Ausgänge verwendet werden, um diese von der
Zielgeräteseite zu entfernen.

Zugriffssteuerungsübernahme

Wenn ein Stromverwaltungsgeräte-Ausgang durch das Verknüpfen mit einem
Ziel geändert wird, so übernimmt der Ausgang die bereits konfigurierte
Zugriffssteuerung für diesen Zielnamen. Wenn ein Adapterkabel hinzugefügt wird
und der vom Adapterkabel erhaltene Name mit einem Namen eines
bestehenden Ziels übereinstimmt, erbt das neue Adapterkabel die
Zugriffssteuerung von diesem Ziel. Wenn ein Zielgerät unbenannt wird, werden
alle Adapterkabel und Ausgänge dieses Ziels umbenannt, und vererben die
zuvor konfigurierte Zugriffssteuerung des alten Zielnamens.

Umbenennen eines Zielgeräts

Auf der Ziel-Übersichtsseite kann der Name dieses Ziels in einen eindeutigen
Zielnamen umbenannt werden. Der Name muss für alle Ziele eindeutig sein,
einschließlich Adapterkabel und Stromverwaltungsgeräte-Ausgänge. Wenn ein
Ziel umbenannt wird, erhalten alle Ausgänge, die mit diesem Ziel verknüpft sind,
den neuen Zielnamen.

Priorisierter Status von Zielgeräten

Auf der Zielgeräteseite steuert ein Ziel mit verknüpften Stromverwaltungsgeräte-
Ausgängen mehrere Geräte. Der Statuswert, der für ein Ziel angezeigt wird, wird
als höchste Priorität aller Statuswerte der Geräte ausgewählt. In der folgenden
Tabelle werden die möglichen Statuswerte in Prioritätsfolge (absteigend) und die
jeweiligen Zielgerätetypen angezeigt.

Statuswert Zutreffend für: Status-Beschreibung

Adapterkabel Stromausgang

In Verwendung x – Eine Sitzung ist aktiv

Pfad blockiert x – Pfad zum Zielwird von einer
anderen Sitzung verwendet

Aktualisierung läuft x – DasAdapterkabelwird
aktualisiert

Tabelle 3.7: Zielstatuswerte
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Statuswert Zutreffend für: Status-Beschreibung

Adapterkabel Stromausgang

Wird eingeschaltet – x Mindestensein Ausgang wird
eingeschaltet

Wird ausgeschaltet – x Mindestensein Ausgang wird
ausgeschaltet

Kein Strom x – Adapterkabelwird nicht mit
Strom versorgt

Teilweise
Stromversorgung – x Ziel hat ein- und

ausgeschaltete Ausgänge

Gesperrt aus – x Mindestensein Ausgang ist
gesperrt (ein)

Ausgeschaltet – x Mindestensein Ausgang ist
ausgeschaltet

Gesperrt ein – x Mindestensein Ausgang ist
gesperrt (aus)

Inaktiv x –
Keine Sitzung aktiv;
Adapterkabelwirdmit Strom
versorgt

Eingeschaltet – x Ausgänge sind eingeschaltet

Wenn ein Zielgerät über mehrere Stromausgänge verfügt, die per Namen
verknüpft sind, und diese nicht über einen gemeinsamen Stromzustand verfügen,
so kann die Einheit den Ausgangsstatus „Gesperrt aus“ als „aus“ und den
Ausgangsstatus „Gesperrt ein“ als „ein“ erkennen. Die folgende Tabelle zeigt die
resultierenden Statuswerte aus der Kombination von zwei
Ausgangsstatuswerten.

StatusAusgang 1 StatusAusgang 2 Resultierender Status

Aus Aus Aus

Aus Ein Teilweise Stromversorgung

Ein Ein Eingeschaltet

Tabelle 3.8: Mehrfache Ausgangsstatuswerte und angezeigter Status
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StatusAusgang 1 StatusAusgang 2 Resultierender Status

Gesperrt ein Ein Eingeschaltet

Gesperrt ein Gesperrt ein Gesperrt ein

Gesperrt ein Aus Teilweise Stromversorgung

Gesperrt aus Ein Teilweise Stromversorgung

Gesperrt aus Gesperrt aus Gesperrt aus

Gesperrt aus Aus Ausgeschaltet

Gesperrt ein Gesperrt aus Teilweise Stromversorgung

Lokale Sitzungsseite am lokalen Port

Auf der lokalen Sitzungsseite des lokalen Ports werden drei
Stromverwaltungsgeräte unter der aktiven Sitzung angezeigt, wenn das Ziel der
aktiven Sitzung verknüpfte Stromausgänge besitzt. Die folgende Abbildung zeigt
die angezeigten Stromverwaltungsgeräte, die für eine aktive lokale Port-Sitzung
für ein Ziel namens „Server2“ angezeigt werden.

Abbildung 3.7. Lokale Sitzungsseite mit Stromverwaltungsgeräten
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4.1 Das Video Viewer-Fenster
Über den Video Viewer werden KVM-Sitzungen mit den Zielgeräten
durchgeführt, die an einen Switch angeschlossen sind und über die OBWI
verwaltet werden. Wenn Sie mithilfe des Video Viewers eine Verbindung mit
einem Gerät herstellen, wird der Desktop des Zielgeräts in einem separaten
Video Viewer-Fenster angezeigt und enthält den lokalen als auch den Cursor
des Zielgeräts.

Die Switch-OBWI-Software verwendet ein Java-basiertes Programm zum
Anzeigen des Video Viewer-Fensters. Die Switch-OBWI lädt den Video Viewer
automatisch herunter und installiert ihn, wenn der Video Viewer das erste Mal
geöffnet wird.

Java 1.6.0_11 oder höher wird benötigt, um eine Sitzung zu starten.

Die Switch-OBWI installiert nicht das Java Runtime Environment (JRE). Die JREwird
als kostenloser Download unter http://www.sun.com zur Verfügung gestellt.

Die Switch-OBWI verwendet den Systemspeicher, um Bildanzeigen in Video Viewer-
Fenstern zu speichern und anzuzeigen. Jedes separat geöffnete Video Viewer-
Fenster erfordert zusätzlichen Systemspeicher. Eine 8-Bit-Farbeinstellung auf dem
Server erfordert 1,4MB, eine 16-Bit-Farbeinstellung erfordert 2,4MBund eine 32-Bit-
Farbeinstellung erfordert 6,8MBSpeicher pro Video Viewer-Fenster.Wenn Siemehr
Video Viewer-Fenster öffnen, als Ihr System zulässt (gewöhnlich sind es vier), erhalten
Sie die Nachricht „Nicht genügend Arbeitsspeicher“ und dasangeforderte Video
Viewer-Fenster wird nicht geöffnet.

Wenn das Gerät, auf das Sie versuchen zuzugreifen, momentan von einem
anderen Benutzer verwendet wird, werden Sie dazu aufgefordert, die Sitzung
des anderen Benutzers zu unterbrechen, sofern Ihre
Benutzerunterbrechungsstufe gleich oder höher als die des anderen Benutzers
ist. Ein Einheitenadministrator kann auch einen aktiven Benutzer über die Seite
„Aktive Sitzung“ unterbrechen. Weitere Informationen finden Sie unter „KVM s4-
Sitzungen“ auf Seite 28.
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Abbildung 4.1. Video Viewer-Fenster (normaler Fenstermodus)

Tabelle 4.1. Beschreibungen für Abbildung 4.1

Anzahl Beschreibung

1
Titelleiste: Zeigt den Namen desangezeigten Zielgeräts an. Im
Vollbildmoduswird die Titelleiste ausgeblendet und der Zielgerätename
zwischenMenü und Symbolleiste angezeigt.

2
Pin-Symbol: Verankert die Menü- und Symbolleisten, sodass sie ständig
sichtbar sind.

3

Menü- und Symbolleiste: Ermöglicht den Zugriff auf viele Funktionen im
Video Viewer-Fenster. DieMenü- und Symbolleisten können ein- und
ausgeblendet werden, wenn der Pin nicht verwendet wird. Platzieren Sie
den Cursor auf der Symbolleiste, um dieMenü- und Symbolleisten
anzuzeigen. Bis zu zehn Befehle und/oder Makrogruppen-Schaltflächen
können auf der Symbolleiste angezeigt werden. Standardmäßig werden
die Schaltflächen für Einzelcursor-Modus, Aktualisieren, Automatische
Monitoranpassung und Lokalen Cursor ausrichten auf der Symbolleiste
angezeigt.Weitere Informatonen finden Sie unter „Ändern der
Symbolleiste“ auf Seite 55 und „Makros“ auf Seite 74.
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Anzahl Beschreibung

4
Makro-Schaltflächen: Häufig verwendete Tastenfolgen, die zum Zielgerät
gesendet werden können.

5 Schaltfläche „Minimieren“: Minimiert die Anzeige desVideo Viewer-
Fensters in die Taskleiste am unteren Bildschirmrand.

6

Schaltfläche „Maximieren“: Ändert die Größe desFensters in den
Vollbildmodus, sodassder Desktop des verbundenenGeräts den
gesamten Bildschirm ausfüllt. EineMaximierung desFensters führt zu
Folgendem:

Die Titelleiste wird ausgeblendet.

Der Zielgerätenamewird zwischenMenü- und Symbolleiste angezeigt.

DieMaximieren-Schaltfläche wird zur Verkleinern-Schaltfläche und wird
auf der Symbolleiste angezeigt. Durch Klicken auf diese Schaltfläche
wechselt dasVideo Viewer-Fenster in den Normalfenster-Modus.

Die Schließen-Schaltfläche wird auf der Symbolleiste angezeigt.

7

Schaltfläche „Schließen“: Schließt dasVideo Viewer-Fenster.

HINWEIS: Die Schaltfläche „Schließen“ ist möglicherweise nicht bei allen
Betriebssystemen vorhanden.

8
Desktop des verbundenenGeräts: Interagiert mit IhremGerät in diesem
Fenster.

9 Rahmen: Ändert durch Klicken und Halten desRahmensdie Größe des
Video Viewer-Fensters.

Ändern der Symbolleiste

Sie können eine Zeitspanne bestimmen, die verstreicht, bevor die Symbolleiste
im Video Viewer-Fenster ausgeblendet wird, sofern diese frei beweglich ist, d. h.
nicht mit einem Pin fixiert ist.

So legen Sie die Zeitspanne, die verstreicht, bis die Symbolleiste
ausgeblendet wird:

1. Wählen Sie im Video Viewer-Menü Extras > Sitzungsoptionen aus.

– oder –

Klicken Sie auf die Schaltfläche Sitzungsoptionen.
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Das Dialogfeld „Sitzungsoptionen“ wird angezeigt.

2. Klicken Sie auf das Register Symbolleiste.

3. Verwenden Sie die Pfeiltasten, um die Anzahl der Sekunden festzulegen,
die verstreichen sollen, bis die Symbolleiste ausgeblendet wird.

4. Klicken Sie aufOK, um die Änderungen zu speichern und schließen Sie das
Dialogfeld.

4.2 Starten einer Sitzung
Bei einer langsameren Netzwerkverbindung ohne Proxy-Server kann die Bildqualität
ungenügend sein. Da bestimmte Farbeinstellungen (wie z. B. Grauskala) weniger
Netzwerkbandbreite als andere (wie z. B. optimale Farbe) benötigen, kann dasÄndern
der Farbeinstellungen die Bildqualität verbessern. Die beste Bildqualität bei langsamen
Netzwerkverbindungen erzielen Siemit Einstellungen wie Grauskala/optimale
Kompression oder Geringe Farbe/Hohe Kompression. Siehe „Anpassen der Ansicht“
auf Seite 57 für weitere Informationen.

Wenn ein Benutzer eine Verbindung zu einem Zielgerät mit einer höheren Auflösung
aufbaut als auf dem lokalen Computer, zeigt dasVideo Viewer-Fenster einen Teil des
Zielgerätebildschirmsmit Bildlaufleisten zur Anzeige der verdeckten Teile des
Bildschirmsan. Der Benutzer kann sich den gesamten Bildschirm anzeigen lassen,
indem die Auflösung desZielgeräts, des lokalen Computers oder beider Geräte
angepasst wird.

So starten Sie eine KVM-Sitzung über das Switch-Explorer-Fenster:

1. Klicken Sie auf ein auf dem Bildschirm „Zielgeräte“ aufgeführtes Gerät, um
das Fenster „Einheiten-Überblick“ aufzurufen.

2. Klicken Sie auf den Link KVM-Sitzung, um den Video Viewer in einem neuen
Fenster zu öffnen.

Timeout der Sitzung

Bei einer Remote-Sitzung kann ein Timeout erfolgen, wenn im Sitzungsfenster in
einer bestimmten Zeit keine Aktivität erkannt wird. Das Sitzungs-Timeout kann im
Fenster „KVM-Sitzungseinstellungen der Einheit“ konfiguriert werden. Dieser
festgelegte Timeout-Wert wird dann beim nächsten Zugriff auf die OBWI des
Switches verwendet.

So aktivieren, deaktivieren oder konfigurieren Sie das Sitzungstimeout:

1. Wählen Sie in der seitlichen Navigationsleiste Einheiten-Ansicht > Einheit >
Einheit-Einstellungen > Sitzungen > Allgemein aus.
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2. Wählen Sie gewünschte Einstellung für das Feld Inaktivitäts-Timeout
aktivieren.

3. Legen Sie, falls erforderlich, die Zeitbegrenzung für das Inaktivitäts-Timeout
fest.

4. Klicken Sie auf Speichern.

4.3 Fenstergröße
Der BefehlAnsicht >Skalierung steht nicht zur Verfügung, wenn dasVideo Viewer-
Fenster im Vollbildmodusangezeigt wird. Benutzer, die nicht primäre Benutzer einer
geteilten Sitzung sind, haben ebenfalls keinen Zugriff auf diesen Befehl.

Wenn Sie die Switch-OWBI zum ersten Mal verwenden, werden alle geöffneten
Video Viewer-Fenster mit einer Auflösung von 1024 x 768 angezeigt, bis der
Benutzer diesen Wert ändert. Jedes einzelne Video Viewer-Fenster kann auf
eine andere Auflösung eingestellt werden.

Die Switch-OBWI passt die Anzeige automatisch an, wenn die Fenstergröße
während einer Sitzung geändert wird und die automatische Skalierung aktiviert
ist. Wenn sich die Auflösung des Zielgeräts während einer Sitzung verändert,
wird die Anzeige automatisch angepasst.

So ändern Sie die Auflösung des Video Viewer-Fensters:

1. Wählen Sie den Befehl Ansicht > Skalierung aus.

2. Wählen Sie die gewünschte Auflösung aus.

4.4 Anpassen der Ansicht
Mithilfe der Menüs und Schaltflächen im Video Viewer-Fenster können Sie
folgende Aktionen ausführen:

• Die Mauscursor ausrichten.

• Den Bildschirm aktualisieren.

• Den Vollbildmodus aktivieren oder deaktivieren. Bei aktiviertem
Vollbildmodus passt sich das Bild an den Desktop mit einer Größe von 1600
x 1200 oder 1680 x 1050 (Breitbild) an. Wenn der Desktop auf eine höhere
Auflösung eingestellt ist, geschieht Folgendes:

• Das Vollbild wird in der Mitte des Bildschirms zentriert dargestellt. Die
nicht ausgefüllten Bereiche bleiben schwarz.
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• Die Menü- und Symbolleisten sind verankert, sodass sie immer sichtbar
sind.

• Die automatische, vollständige oder manuelle Skalierung der
Sitzungsanzeige aktivieren:

• Wenn die vollständige Skalierung ausgewählt wird, behält das Desktop-
Fenster seine Größe bei und die Zielgeräte-Anzeige wird so angepasst,
dass sie das Fenster ausfüllt.

• Bei der automatischen Skalierung wird das Desktop-Fenster an die
Auflösung des angezeigten Zielgeräts angepasst.

• Wenn die manuelle Skalierung ausgewählt wird, wird ein
Dropdownmenü der unterstützten Auflösungen der Bildschirmskalierung
angezeigt.

• Ändern Sie die Farbtiefe der Sitzungsanzeige.

So richten Sie die Mauszeiger aufeinander aus:

Klicken Sie in der Video Viewer-Symbolleiste auf die Schaltfläche Lokalen
Cursor ausrichten. Der lokale Cursor sollte auf den Cursor des Remote-Gerätes
ausgerichtet werden.

Deaktivieren Sie dieMausbeschleunigung desangeschlossenenGeräts, wenn der
Cursor nicht einwandfrei ausgerichtet ist.

Klicken Sie auf die Schaltfläche Anzeige aktualisieren im Video Viewer-Fenster
oder wählen Sie Ansicht > Aktualisieren aus dem Video Viewer-Menü aus. Die
digitalisierte Darstellung wird vollständig regeneriert.

Klicken Sie auf die Schaltfläche Maximieren oder wählen Sie Ansicht > Vollbild
aus dem Video Viewer-Menü aus. Das Desktop-Fenster wird ausgeblendet und
nur der aufgerufene Desktop des Zielgeräts wird angezeigt. Der Bildschirm
ändert sich auf eine maximale Auflösung von 1600 x 1200 oder 1680 x 1050
(Breitbild). Wenn der Desktop eine höhere Auflösung besitzt, wird ein schwarzer
Rahmen um das Vollbild angezeigt. Die unverankerte Symbolleiste wird
angezeigt.

Klicken Sie auf der unverankerten Symbolleiste auf die Schaltfläche
Vollbildmodus, um den Vollbildmodus zu deaktivieren und zum Desktop-Fenster
zurückzukehren.
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Zum Aktivieren der automatischen Skalierung wählen Sie im Video Viewer-Menü
die Option Ansicht > Skalierung . Die Geräteanzeige skaliert sich automatisch auf
die Auflösung des angezeigten Zielgeräts.

Zum Aktivieren der manuellen Skalierung wählen Sie im Video Viewer-Menü die
Option Ansicht > Skalierung . Wählen Sie die Fenstergröße aus, auf die skaliert
werden soll. Die verfügbaren Größen für die manuelle Skalierung variieren je
nach System.

4.5 Bildschirm aktualisieren
Klicken Sie im Dialogfeld „Manuelle Monitoranpassung“ auf die Schaltfläche
Bildschirm aktualisieren, um die digitalisierte Bildschirmdarstellung vollständig
neu zu generieren.

Sie können außerdemAnsicht >Aktualisieren im Video Viewer-Menü auswählen, um
den Bildschirm zu aktualisieren.

4.6 Videoeinstellungen

Zusätzliche Videoanpassung

Generell dienen die automatischen Anpassungsfunktionen des Video Viewer-
Fensters dazu, das Bild für die bestmögliche Darstellung zu optimieren. Benutzer
können die Bildanzeige jedoch mithilfe des technischen Supports von Fujitsu
feineinstellen, indem Sie im Video Viewer-Menü auf Extras > Manuelle
Monitoranpassung oder auf die Schaltfläche Manuelle Monitoranpassung im
Video Viewer-Fenster klicken. Das Dialogfeld „Manuelle Monitoranpassung“ wird
angezeigt. Die Videoeinstellung richtet sich immer nach dem Zielgerät.

Benutzer können auch die Pakete pro Sekunde überprüfen, die für die
Unterstützung eines statischen Bildschirms erforderlich sind, indem sie die
Paketdurchsatzrate in der unteren linken Ecke des Dialogfelds beobachten.

So passen Sie die Videoqualität des Fensters manuell an:

Die folgenden Einstellungen der Videoqualität sollten nur mit Unterstützung des
technischen Supports von Fujitsu vorgenommenwerden.

1. Wählen Sie im Video Viewer-Menü die Option Extras > Manuelle
Monitoranpassung.

– oder –

Klicken Sie auf die Schaltfläche Manual Video Adjust.
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Das Dialogfeld „Manuelle Monitoranpassung“ wird angezeigt.

Abbildung 4.2. Dialogfeld „Manuelle Monitoranpassung“

Anzahl Beschreibung Anzahl Beschreibung

1 Bild-Aufnahmebreite 8 Pixel-Rauschschwelle

2
Pixel-
Sampling/Feineinstellung

9 Automatische Videoanpassung

3 Horizontale Bildaufnahme 10 Bildschirm aktualisieren

4 Vertikale Bild-Aufnahme 11 Schieberegler

5 Kontrast 12 Testbild

6 Helligkeit 13 Systemmonitor

7 BlockNoise Threshold 14 Schaltfläche „Schließen“

Tabelle 4.2: Beschreibungen für Abbildung 4.2

2. Klicken Sie auf das Symbol für die anzupassende Funktion.

3. Bewegen Sie den Schieberegler und führen Sie dann eine Feinabstimmung
durch Klicken auf die Schaltflächen Min (-) oder Max (+) durch, um die
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Parameter für das jeweils angeklickte Symbol anzupassen. Die
Einstellungen werden sofort im Video Viewer-Fenster sichtbar.

4. Wenn Sie den Vorgang beendet haben, klicken Sie auf Schließen, um das
Dialogfeld „Manuelle Monitoranpassung“ zu verlassen.

Monitoreinstellungen am Zielgerät

Die Einstellungen Bild-Aufnahmebreite, Feineinstellung für Pixel-Sampling,
Horizontale Bild-Aufnahme und Vertikale Bild-Aufnahme beeinflussen die
Aufnahme und Digitalisierung des Zielbildschirms und werden selten geändert.

Die Parameter für die Bild-Aufnahme werden automatisch von der automatischen
Anpassungsfunktion geändert. Für das Zielbild sind spezielle Einstellungen
nötig, damit genaue Anpassungen unabhängig durchgeführt werden können.

Automatische Monitoranpassung

In den meisten Fällen müssen die Standardeinstellungen für die Videoparameter
nicht verändert werden. Das System stellt sich automatisch ein und verwendet
die optimalen Videoparameter. Die Switch-OBWI arbeitet am Besten, wenn die
Videoparameter so eingestellt sind, dass keine (0) Videopakete für einen
Statikbildschirm übertragen werden.

Die Videoparameter können auf einfache Weise auf die bestmöglichen
Einstellungen durch Klicken im Dialogfeld „Manuelle Monitoranpassung“ auf die
Schaltfläche Automatische Monitoranpassung eingestellt werden.

Sie können auch ausdemVideo Viewer-MenüExtras>Automatische
Monitoranpassung auswählen oder auf dasSymbol für Automatische
Monitoranpassung in der Toolbar klicken, um dieMonitoreinstellungen anzupassen.

Testbild

Durch Klicken auf die Schaltfläche Testbild im Dialogfeld „Manuelle
Monitoranpassung“ wird auf ein Testbild umgeschaltet. Klicken Sie erneut auf die
Schaltfläche Testbild, um zur normalen Videoanzeige zurückzuschalten.

Anbieterspezifische Videoeinstellungen

Die Videoeinstellungen sind von Hersteller zu Hersteller unterschiedlich.
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4.7 Farbeinstellungen

Anpassen der Farbtiefe

Der Dambrackas Videokomprimierungsalgorithmus (DVC) ermöglicht es
Benutzern, die Anzahl der sichtbaren Farben eines Remote-Sitzungsfensters
anzupassen. Sie können auswählen, ob viele Farben für eine möglichst getreue
Darstellung angezeigt werden, oder weniger Farben, um das über das Netzwerk
übertragene Datenvolumen zu reduzieren.

Für die Anzeige des Video Viewer-Fensters sind folgende Optionen möglich:
Optimale verfügbare Farbe (langsamere Aktualisierung), optimale Kompression
(schnellste Aktualisierung), eine Kombination aus optimaler Farbe und optimaler
Kompression oder Grauskala.

Die Farbtiefen von einzelnen Ports und Kanälen können durch Auswahl des
Befehls Farbe anzeigen in einem Remote-Sitzungsfenster festgelegt werden.
Diese Einstellungen werden individuell für jeden Kanal gespeichert.

Kontrast und Helligkeit

Falls das Bild im Video Viewer-Fenster zu dunkel oder zu hell ist, wählen Sie
Extras > Automatische Monitoranpassung aus und klicken Sie auf die
Schaltfläche Automatische Monitoranpassung. Dieser Befehl ist auch im
Dialogfeld „Monitoranpassung“ verfügbar. Dies korrigiert in den meisten Fällen
Störungen bei der Bilddarstellung.

Wenn durch mehrmaliges Klicken auf Automatische Anpassung der Kontrast und
die Helligkeit nicht wie gewünscht eingestellt werden, kann eventuell eine
manuelle Anpassung hilfreich sein. Erhöhen Sie die Helligkeit. Erhöhen Sie die
Helligkeit nicht um mehr als 10 Stufen, bevor Sie mit dem Kontrast fortfahren.
Generell sollte der Kontrast nur gering geändert werden.

4.8 Rauschschwellen-Einstellungen

Schwellenwerte für die Bilderkennung

In einigen Fällen kann es vorkommen, dass das Rauschen bei der
Bildübertragung die Übertragungsrate der Pakete hochhält, was durch kleine
sich verändernde Punkte im Bereich des sich bewegenden Cursors zu erkennen
ist. Das Ändern der Schwellenwerte kann dazu führen, dass die Bildschirme
rauschfreier sind und das Mauszeiger-Tracking verbessert wird.
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Sie können die Werte für Rausch- und Prioritätsschwelle verändern, wenn Sie
die standardmäßige Videokomprimierung verwenden. Sie können auch die
Werte für „Rauschschwelle blockieren“ und „Pixel-Rauschschwelle“ ändern. Die
Schwellenwerte können durch Klicken auf Automatische Monitoranpassung
wiederhergestellt werden.

Rauschschwelle blockieren und Pixel-Rauschschwelle

Die Werte für „Rauschschwelle blockieren“ und „Pixel-Rauschschwelle“
bestimmen die Mindestfarbabstufungen bei den zulässigen veränderten
Videoblöcken und Pixel pro Tausend.

• Die Einstellung für „Rauschschwelle blockieren“ stellt die minimale
Farbänderung in einem einzelnen Videoblock ein. Das Erhöhen dieses
Werts verringert die Netzwerkbandbreite. Die Verringerung des Werts
reduziert die Bildfehler.

• Die Einstellung „Pixel-Rauschschwelle“ stellt die minimale Farbänderung in
einem einzelnen Pixel ein. Eine Verringerung des Werts führt zu einer
Reduzierung der Anzahl von kontrastarmen Bildfehlern, jedoch wird dadurch
die Netzwerkbandbreite erhöht.

Siehe „Anpassen der Ansicht“ auf Seite 57 für weitere Informationen zum Ändern
der Farbtiefe.

4.9 Mauseinstellungen

Die Mauseinstellungen anpassen

Die Mausoptionen des Video Viewer-Fensters beeinflussen den Cursortyp, den
Cursor-Modus, die Skalierung, die Ausrichtung und das Zurücksetzen. Die
Mauseinstellungen sind gerätespezifisch und können für jedes Gerät
unterschiedlich festgelegt werden.

Wenn dasGerät dasTrennen und den erneuten Anschlussder Mausnicht unterstützt
(fast alle neueren Computer unterstützen dies), wird die Mausdeaktiviert und das
Gerät mussneu gestartet werden.

Cursortyp

Das Video Viewer-Fenster bietet fünf Anzeigemöglichkeiten für den lokalen
Mauszeiger. Sie können auch den Standard-Cursor auswählen oder festlegen,
dass kein Cursor angezeigt werden soll.
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Im Einzelcursor-Modus wird der lokale (zweite) Cursor im Video Viewer-Fenster
nicht angezeigt und nur der Cursor des Zielgeräts wird angezeigt. Die einzigen
Mausbewegungen, die angezeigt werden, sind die des Remote-Cursors auf dem
Zielgerät. Verwenden Sie den Einzelcursor-Modus, wenn der Einsatz eines
lokalen Cursors nicht erforderlich ist.

Abbildung 4.3. Video Viewer-Fenster mit angezeigtem lokalem und Remote-Cursor

Anzahl Beschreibung

1 Remote-Cursor

2 Lokaler Cursor

Tabelle 4.3: Beschreibungen für Abbildung 4.3

Der Status des Cursormodus des Video Viewer-Fensters einschließlich des
Tastenanschlags, der den Einzelcursormodus beendet, wird in der Titelleiste
angezeigt. Sie können den Tastenanschlag, mit dem der Einzelcursormodus
beendet wird, im Dialogfeld „Sitzungsoptionen“ festlegen.

Wenn Sie ein Gerät verwenden, dassTastenanschläge aufzeichnet, bevor diese den
Client-Server erreichen, sollten Siemöglichst nicht diese Tastenanschläge verwenden,
um denMauszeiger wiederherzustellen.
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Wählen Sie zum Aufrufen des Einzelcursormodus Extras > Einzelcursormodus
aus dem Video Viewer-Menü aus, oder klicken Sie auf die Schaltfläche
Einzelcursormodus. Der lokale Cursor wird nicht angezeigt und alle
Bewegungen sind relativ zum Zielgerät.

So legen Sie eine Taste für das Beenden des Einzelcursormodus fest:

1. Wählen Sie im Video Viewer-Menü Extras > Sitzungsoptionen aus.

– oder –

Klicken Sie auf die Schaltfläche Sitzungsoptionen.

Das Dialogfeld „Sitzungsoptionen“ wird angezeigt.

2. Klicken Sie auf das Register Maus.

3. Wählen Sie im Bereich Einzelcursormodus den gewünschten
Tastenanschlag zum Beenden des Modus aus dem Dropdownmenü aus.

4. Klicken Sie auf Speichern, um die Einstellungen zu speichern.

Wenn der Einzelcursormodus aktiviert ist, können Sie die festgelegte Taste
drücken, um zum normalen Desktop-Modus zurückzukehren.

Drücken Sie die Taste, die in der Titelleiste angezeigt wird, um den
Einzelcursormodus zu beenden.

So ändern Sie die Mauszeigereinstellung:

1. Wählen Sie im Video Viewer-Menü Extras > Sitzungsoptionen aus.

– oder –

Klicken Sie auf die Schaltfläche Sitzungsoptionen.

Das Dialogfeld „Sitzungsoptionen“ wird angezeigt.

2. Klicken Sie auf das Register Maus.

3. Wählen Sie im Bereich „Lokaler Cursor“ einen Mauszeigertyp aus.

4. Klicken Sie aufOK, um die Einstellungen zu speichern.

Mausskalierung

Einige ältere Linux Versionen unterstützten keine anpassbaren
Mausbeschleunigungen. Bei Installationen, die diese älteren Versionen
unterstützen müssen, können Sie zwischen drei vorkonfigurierten
Mausskalierungsoptionen wählen oder Ihre eigene benutzerdefinierte
Skalierung einstellen. Die vorkonfigurierten Einstellungen sind Standard (1:1),
Hoch (2:1) oder Niedrig (1:2):

590-1058-640A 65



4. Video Viewer

• Bei einem Skalierungsverhältnis von 1:1 sendet jede Mausbewegung auf
dem Desktop-Fenster die gleiche Mausbewegung an das Zielgerät.

• Bei einem Skalierungsverhältnis von 2:1 sendet die gleiche Mausbewegung
eine doppelte Mausbewegung.

• Ein Skalierungsverhältnis von 1:2 bewirkt eine Halbierung des Wertes.

So stellen Sie die Mausskalierung ein:

1. Wählen Sie im Video Viewer-Menü Extras > Sitzungsoptionen aus.

– oder –

Klicken Sie auf die Schaltfläche Sitzungsoptionen.

Das Dialogfeld „Sitzungsoptionen“ wird angezeigt.

2. Klicken Sie auf das Register Maus.

3. Wählen Sie die entsprechende Optionsschaltfläche aus, um eine der
vorkonfigurierten Einstellungen zu verwenden.

– oder –

So stellen Sie eine benutzerdefinierte Skalierung ein:

a. Klicken Sie auf die Optionsschaltfläche Benutzerdefiniert, um die X- und
Y-Felder zu aktivieren.

b. Geben Sie die Skalierungswerte in die X- und Y-Felder ein. Jede
Mausbewegung wird mit den entsprechenden X- und Y-
Skalierungsfaktoren multipliziert. Der zulässige Eingabebereich liegt
zwischen 0,25 und 3,00.

Mausausrichtung und Synchronisierung

Die OBWI des Switches kann nicht kontinuierlich Rückmeldungen von der Maus
erhalten. Das kann dazu führen, dass die Maus am Switch nicht mehr mit der
Maus am Host-System synchronisiert ist. Wenn Maus oder Tastatur nicht mehr
ordnungsgemäß reagieren, kann die Maus neu ausgerichtet werden, um eine
ordnungsgemäße Synchronisation wiederherzustellen.

Eine Ausrichtung bewirkt die Ausrichtung des lokalen Cursors auf den Cursor
des Remote-Zielgeräts. Ein Zurücksetzen bewirkt eine Simulation eines erneuten
Verbindungsaufbaus von Maus und Tastatur, genau wie bei einer
hardwaremäßigen Trennung und darauffolgendem Neuanschluss.

Zum Ausrichten des Mauszeigers klicken Sie in der Video Viewer-Symbolleiste
auf die Schaltfläche Lokalen Cursor ausrichten.
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4.10 Virtual Media
Mithilfe der Virtual Media-Funktion können Sie ein physikalisches Laufwerk des
Client-Computers als virtuelles Laufwerk auf dem Zielgerät zuweisen. Sie
können auch eine ISO- oder Disk-Image-Datei des lokalen Clients als virtuelles
Laufwerk auf dem Zielgerät hinzufügen und zuweisen. Sie können ein CD-ROM-
Laufwerk und ein Massenspeichergerät gleichzeitig zuweisen.

• Ein CD-ROM-/DVD-Laufwerk oder eine Disk-Image-Datei (wie eine ISO-
oder Disketten-Image-Datei) wird als virtuelles CD-/DVD-ROM-Laufwerk
zugewiesen.

• Diskettenlaufwerke, USB-Speichergeräte oder andere Speichermedien
werden als virtuelle Massenspeichergeräte zugewiesen.

Weitere Informationen zur Konfiguration der Virtual Media-Einstellungen über die
OBWI finden Sie unter „Virtual Media“ auf Seite 35.

Anforderungen

Das Zielgerät muss Virtual Media unterstützen und mit einem KVM s4-Adapter-
USB20-VGA-Adapterkabel an den KVM-Switch angeschlossen sein.

Das Zielgerät muss auf jeden Fall die Typen USB2-kompatibler Speichermedien
unterstützen, die Sie virtuell zuweisen. Anders gesagt, wenn das Zielgerät
tragbare USB-Speichergeräte nicht unterstützt, können Sie dieses Gerät nicht als
Virtual Media-Laufwerk auf dem Zielgerät zuweisen.

Sie (oder die Benutzergruppe, zu der Sie gehören) müssen über die
Berechtigung verfügen, Virtual Media-Sitzungen und/oder reservierte Virtual
Media-Sitzungen auf dem Zielgerät öffnen zu können. Siehe „Benutzerkonten“
auf Seite 40.

Es kann immer jeweils nur eine Virtual Media-Sitzung zu einem Zielgerät aktiv
sein.

Überlegungen zum Teilen und Trennen von Sitzungen

Die KVM- und Virtual Media-Sitzungen werden unabhängig voneinander
ausgeführt. Daher stehen viele Möglichkeiten zum Teilen, Reservieren oder
Trennen von Sitzungen zur Verfügung. Die DSView 3-Software bietet die
Flexibilität, diese Systemanforderungen zu erfüllen.

Zum Beispiel können die KVM- und Virtual Media-Sitzungen zusammen gesperrt
werden. Wenn in diesem Modus eine KVM-Sitzung getrennt wird, wird auch die
zugehörige Virtual Media-Sitzung getrennt. Wenn die Sitzungen nicht zusammen
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gesperrt wurden, kann die KVM-Sitzung geschlossen werden, während die
Virtual Media-Sitzung aktiv bleibt. Dies kann vorteilhaft sein, wenn ein Benutzer
eine zeitintensive Aufgabe unter Verwendung der Virtual Media-Sitzung (wie z.
B. das Laden eines Betriebssystems) ausführt und gleichzeitig eine KVM-Sitzung
zu einem anderen Zielgerät aufbauen möchte, um andere Funktionen
auszuführen, bis das Laden des Betriebssystems abgeschlossen ist.

Wenn auf dem Zielgerät eine aktive Virtual Media-Sitzung ohne eine zugehörige
aktive KVM-Sitzung ausgeführt wird, kann entweder der erste Benutzer (Benutzer
A) oder ein anderer Benutzer (Benutzer B) mit diesem Kanal eine Verbindung
herstellen. Sie können eine Option (Reserviert) im Dialogfeld „Virtual Media“
festlegen, sodass nur Benutzer A auf das entsprechende Zielgerät mit
ausgeführter KVM-Sitzung zugreifen kann.

Wenn Benutzer B auf diese Sitzung zugreifen darf (die Option „Reserviert“ ist
deaktiviert), kann er das Speichermedium steuern, das bei der Virtual Media-
Sitzung verwendet wird. Durch Verwenden der Option „Reserviert“ in einer
kaskadierten Umgebung kann nur Benutzer A auf den unteren Switch zugreifen.
Der KVM-Kanal zwischen dem oberen und unteren Switch ist für Benutzer A
reserviert.

Dialogfeld „Virtual Media“

Verwenden Sie das Dialogfeld „Virtual Media“, um das Zuweisen von Virtual
Media bzw. das Aufheben der Zuweisung zu verwalten. Das Dialogfeld zeigt alle
physischen Laufwerke des Client-Servers, die als Virtual Media zugewiesen
werden können. Sie können auch ISO- und Disk-Image-Dateien hinzufügen und
sie dann mithilfe des Dialogfelds „Virtual Media“ zuweisen.

Nach der Zuweisung eines Geräts werden in der Detailansicht im Dialogfeld
„Virtual Media“ die Menge der übertragenen Daten und die seit der Zuweisung
des Geräts verstrichene Zeit angezeigt.

Sie können angeben, ob die Virtual Media-Sitzung reserviert werden soll. Wenn
eine Sitzung reserviert wurde und die zugehörige KVM-Sitzung geschlossen
wird, kann kein anderer Benutzer eine KVM-Sitzung auf diesem Zielgerät öffnen.
Wenn eine Sitzung nicht reserviert wurde, kann eine andere KVM-Sitzung
geöffnet werden.

Darüber hinaus können Sie das USB2-Adapterkabel über das Dialogfeld „Virtual
Media“ zurücksetzen. Dieser Vorgang setzt alle Arten von USB-Medien am
Zielgerät zurück. Er sollte daher nur verwendet werden, wenn das Zielgerät nicht
reagiert.
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Öffnen von Virtual Media-Sitzungen

So starten Sie eine Virtual Media-Sitzung:

Wählen Sie Extras – Virtual Media im Video Viewer-Menü aus. Das Dialogfeld
„Virtual Media“ wird angezeigt. Wenn diese Sitzung als reservierte Sitzung
festgelegt werden soll, klicken Sie auf Details und aktivieren Sie dann das
Kontrollkästchen Reserviert.

Abbildung 4.4. Video Viewer-Dialogfeld „Virtual Media“

So weisen Sie ein Virtual Media-Laufwerk zu:

1. Öffnen Sie eine Virtual Media-Sitzung, indem Sie in der Video Viewer-
Symbolleiste Extras > Virtual Media auswählen.

2. So weisen Sie ein physisches Laufwerk als Virtual Media-Laufwerk zu:

a. Aktivieren Sie im Dialogfeld „Virtual Media“ das Kontrollkästchen
Zugeordnet neben den Laufwerken, die Sie zuweisen möchten.

b. Wenn für das zugewiesene Laufwerk ein schreibgeschützter Zugriff
festgelegt werden soll, aktivieren Sie neben dem Laufwerk das
Kontrollkästchen Schreibgeschützt. Wenn die Einstellungen der Virtual
Media-Sitzung so vorkonfiguriert wurden, dass alle zugewiesenen
Laufwerke schreibgeschützt sein müssen, ist dieses Kontrollkästchen
bereits aktiviert und kann nicht geändert werden.
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Sie können das Kontrollkästchen Schreibgeschützt aktivieren,
wenn in den Sitzungseinstellungen Schreib-/Lesezugriff
festgelegt wurde, Sie jedoch den Zugriff eines bestimmten
Laufwerks auf schreibgeschützt einschränken möchten.

3. So fügen und weisen Sie ein ISO- oder Disk-Image als Virtual Media-
Laufwerk hinzu:

a. Klicken Sie im Dialogfeld „Virtual Media“ auf Image hinzufügen.

b. Das Dialogfeld zum Auswählen der allgemeinen Datei wird geöffnet,
wobei das Verzeichnis mit den Disk-Image-Dateien (Erweiterung .iso
oder .img) angezeigt wird. Wählen Sie eine ISO- oder Disk-Image-Datei
aus und klicken Sie aufÖffnen.

– oder –

Wenn das Betriebssystem des Client-Servers Drag & Drop
unterstützt, wählen Sie die gewünschte ISO- oder Disk-Image-
Datei im Dialogfeld für allgemeine Dateien aus und ziehen Sie
diese in das Dialogfeld „Virtual Media“.

c. Der Datei-Header wird überprüft, um sicherzustellen, dass er korrekt ist.
Wenn der Datei-Header korrekt ist, wird das Dialogfeld zum Auswählen
der allgemeinen Datei geschlossen und die ausgewählte Image-Datei
im Dialogfeld „Virtual Media“ geöffnet, in dem sie durch Aktivieren des
Kontrollkästchens Zugeordnet zugewiesen werden kann.

d. Wiederholen Sie Schritte a bis c für alle weiteren ISO- oder Disk-Images,
die Sie hinzufügen möchten. Sie können eine beliebige Anzahl von
Image-Dateien hinzufügen (bis zu der vom Speicher vorgegebenen
Beschränkung), Sie können jedoch nur ein virtuelles CD- oder DVD-
Laufwerk oder ein virtuelles Massenspeichergerät gleichzeitig
zuweisen.

Wenn Sie zu viele Laufwerke (ein CD- oder DVD-Laufwerk und ein
Massenspeichergerät) oder zu viele Laufwerke eines bestimmten Typs (mehrere
CD-/DVD-Laufwerke oder Massenspeichergeräte) zuweisen, wird eine Nachricht
angezeigt. Wenn Sie trotzdem ein neues Laufwerk zuweisen möchten, müssen
Sie zuerst die Zuweisung eines vorhandenen Laufwerks aufheben. Danach
können Sie dann das neue Laufwerk zuweisen.

Nach der Zuweisung eines physikalischen Laufwerks oder Images kann es auf
dem Zielgerät verwendet werden.
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So heben Sie die Zuweisung eines Virtual Media-Laufwerks auf:

1. Deaktivieren Sie im Dialogfeld „Virtual Media“ das Kontrollkästchen
Zugeordnet neben den Laufwerken, deren Zuweisung Sie aufheben
möchten.

2. Eine Bestätigung ist erforderlich. Bestätigen Sie das Aufheben der
Zuweisungen oder brechen Sie den Vorgang ab.

3. Wiederholen Sie diesen Vorgang für zusätzliche Virtual Media-Laufwerke,
deren Zuweisung Sie aufheben möchten.

So zeigen Sie Details zu Virtual Media-Laufwerken an:

Klicken Sie im Dialogfeld „Virtual Media“ auf Details. Das Dialogfeld wird
erweitert und die Details-Tabelle wird eingeblendet. Die Zeilen bedeuten
Folgendes:

• Ziellaufwerk – Name für das zugewiesene Laufwerk, wie z. B. Virtual CD 1
oder Virtual CD 2.

• Zugeordnet zu – Identisch zu den Laufwerksinformationen, die in der Spalte
„Client-Ansicht des Laufwerks“ angezeigt werden.

• Bytes lesen und Bytes schreiben – Datenmenge, die seit der Zuweisung
übertragen wurde.

• Dauer – Zeit, die seit der Zuweisung des Laufwerks verstrichen ist.

Klicken Sie zum Schließen der Detailansicht erneut auf Details.

So setzen Sie alle USB-Geräte auf dem Zielgerät zurück:

Mit dieser Funktion werden alle USB-Geräte auf dem Zielgerät einschließlich Tastatur
undMauszurückgesetzt. Sie sollte daher nur verwendet werden, wenn dasZielgerät
nicht reagiert.

1. Klicken Sie im Dialogfeld „Virtual Media“ auf Details.

2. Die Detailansicht wird angezeigt. Klicken Sie auf USB zurücksetzen.

3. Eine Warnmeldung weist auf die möglichen Auswirkungen des
Zurücksetzens hin. Bestätigen Sie den Vorgang oder brechen Sie ihn ab.

4. Klicken Sie zum Schließen der Detailansicht erneut auf Details.

Schließen von Virtual Media-Sitzungen

So schließen Sie das Dialogfeld „Virtual Media“:

1. Klicken Sie auf Beenden.
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2. Wenn Laufwerke zugewiesen wurden, wird eine Nachricht angezeigt, dass
die Zuweisung aufgehoben wird. Bestätigen Sie den Vorgang oder brechen
Sie ihn ab.

Wenn Sie versuchen, eine Virtual-Media-Sitzung oder eine aktive KVM-Sitzung
zu trennen, die über eine zugehörige gesperrte Virtual Media-Sitzung verfügt,
werden Sie in einer Bestätigungsnachricht darauf hingewiesen, dass alle Virtual
Media-Zuweisungen verloren gehen.

4.11 Smartcards
Sie können ein Smartcard-Lesegerät an einen verfügbaren USB-Port am Client-
Server anschließen und auf angeschlossene Zielgeräte im Switch-System
zugreifen. Starten Sie dann eine KVM-Sitzung, um den Video Viewer zu öffnen,
und weisen Sie eine Smartcard zu.

Für alle VirtualMedia-Sitzungen und Smartcard-Lesegerätemüssen Sie ein KVM s4-
Adapter-USB20-VGA-Kabel verwenden.

Der Smartcard-Status wird durch ein Smartcard-Symbol auf der äußerst rechten
Seite der Video Viewer-Symbolleiste angezeigt. Die folgende Tabelle beschreibt
die Smartcard-Statussymbole.

Tabelle 4.4. Smartcard-Symbole

Symbol Beschreibung

Esbefindet sich keine Smartcard im Lesegerät oder es ist kein
Smartcard-Lesegerät angeschlossen.

Esbefindet sich eine Smartcard im Lesegerät, diese wurde jedoch noch
nicht zugewiesen.

Es ist eine Smartcard zugewiesen.

So weisen Sie eine Smartcard zu:

1. Öffnen Sie eine KVM-Sitzung, um das Video Viewer-Menü anzuzeigen.

2. Setzen Sie eine Smartcard in das an Ihren Client-Server angeschlossene
Smartcard-Lesegerät ein.

3. Wählen Sie im Video Viewer-Menü Extras > Smartcard zuweisen aus.
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4. Wenn keine Smartcard zum Zielgerät zugewiesen ist, wird dies durch einen
Punkt neben der Option „Keine Karte zugewiesen“ angezeigt. Wählen Sie
Ihre Smartcard aus, die unter dieser Option angezeigt wird, um die
Smartcard zuzuweisen.

Um die Zuweisung einer Smartcard aufzuheben, schließen Sie die KVM-Sitzung,
indem Sie im Video Viewer-Fenster auf X klicken, auf Extras > Keine Karte
zugewiesen klicken, die Smartcard aus dem Smartcard-Lesegerät entfernen oder
das Smartcard-Lesegerät vom Client-Server trennen.

4.12 Tastaturanschlag-Weitergabe
Tastenanschläge, die von einem Benutzer eingegeben werden, wenn dieser ein
Video Viewer-Fenster verwendet, können je nach eingestelltem
Bildschirmmodus des Video Viewers auf zwei verschiedene Arten interpretiert
werden.

• Mit dem Video Viewer im Vollbildmodus werden alle Tastenanschläge und
Tastenfolgen mit der Ausnahme von Strg-Alt-Entf zum angezeigten Remote-
Zielgerät gesendet.

• Wenn sich das Video Viewer-Fenster im normalen Desktop-Modus befindet,
kann die Tastenanschlag-Weitergabe dazu verwendet werden, zu steuern,
ob das Remote-Zielgerät oder der lokale Computer bestimmte
Tastenanschläge oder Tastenfolgen erkennt.

Die Tastenanschlag-Weitergabe muss im Dialogfeld „Sitzungsoptionen“
festgelegt werden. Wenn diese Option aktiviert ist, werden alle Tastenanschläge
und Tastenfolgen mit der Ausnahme von Strg-Alt-Entf bei aktiviertem Video
Viewer-Fenster zum angezeigten Remote-Zielgerät gesendet. Wenn der lokale
Desktop aktiv ist, beziehen sich alle Tastenanschläge und Tastenfolgen, die
durch den Benutzer eingegeben werden, auf den lokalen Computer.

Die Tastenfolge Strg-Alt-Entf kann nur mittelsMakro an dasRemote-Zielgerät
übertragen werden.

Die japanische Tastenfolge ALT-Han/Zen wird immer an dasRemote-Zielgerät
übertragen, unabhängig vomBildschirmmodusoder den Einstellungen der
Tastenanschlag-Weitergabe.

So legen Sie die Tastenanschlag-Weitergabe fest:

1. Wählen Sie im Video Viewer-Menü Extras – Sitzungsoptionen aus.

– oder –
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Klicken Sie auf die Schaltfläche Sitzungsoptionen.

Das Dialogfeld „Sitzungsoptionen“ wird angezeigt.

2. Klicken Sie auf das Register Allgemein.

3. Wählen Sie Alle Tastenanschläge im normalen Fenster-Modus weitergeben.

4. Klicken Sie aufOK, um die Einstellung zu speichern.

4.13 Makros
Die Switch-OBWI ist mit vorkonfigurierten Makros für Windows, Linux und Sun
ausgestattet.

Wählen Sie Makros – <gewünschtes Makro> aus dem Video Viewer-Menü aus
oder wählen Sie das gewünschte Makro über die Schaltflächen im Video Viewer-
Menü aus.

4.14 Speichern einer Ansicht
Der Bildschirm des Video Viewers kann entweder in eine Datei gespeichert oder
in die Zwischenablage kopiert werden und von dort in ein Textverarbeitungs-
oder anderes Programm eingefügt werden.

So speichern Sie das Video Viewer-Fenster in einer Datei:

1. Wählen Sie im Video Viewer-Menü Datei – In Datei speichern.

– oder –

Klicken Sie auf die Schaltfläche In Datei speichern.

Das Dialogfeld „Speichern unter“ wird geöffnet.

2. Geben Sie einen Dateinamen ein und legen Sie einen Speicherort für die
Datei fest.

3. Klicken Sie auf Speichern, um den Bildschirm in einer Datei zu speichern.

Um das Video Viewer-Fenster in der Zwischenablage zu speichern, wählen Sie
Datei – In Zwischenablage speichern aus dem Video Viewer-Menü aus oder
klicken Sie auf die Schaltfläche In Zwischenablage speichern. Die Bilddatei wird
in die Zwischenablage kopiert.

4.15 Schließen einer Sitzung
So beenden Sie eine Video Viewer-Sitzung:

Wählen Sie im Video Viewer-Menü Datei – Beenden.
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LDAP ist ein händlerunabhängiger Protokollstandard für den Zugriff, die Abfrage
und die Aktualisierung von Verzeichnissen über TCP/IP. LDAP ist eine globale
Verzeichnisstruktur, die auf dem X.500-Verzeichnis-Servicemodell basiert und
Authentifizierung, Datenschutz und Integrität zu ihren stärksten
Sicherheitsmerkmalen zählt.

Wenn individuelle Benutzerkonten in einem LDAP-fähigen Verzeichnisdienst wie
Active Directory gespeichert werden, können Sie den Verzeichnisdienst zur
Authentifizierung von Benutzern verwenden Die Standardwerte für die LDAP-
Such- und Abfrageparameter sind für die Verwendung mit Active Directory
bestimmt.

Mit den in der OBWI vorgenommenen Einstellungen können Sie Ihre
Authentifizierungskonfigurationsparameter konfigurieren. Die Software sendet
Benutzernamen, Kennwort und andere Informationen an die Einheit, die
daraufhin festlegt, ob der Benutzer über die Zugriffsrechte verfügt, um die
Konfigurationsparameter der Einheit in der OBWI anzuzeigen oder zu ändern.

Soweit nicht anders angegeben, sollten die Standardwerte für LDAP verwendet
werden, wenn Active Directory nicht rekonfiguriert wurde. Die Änderung der
Standardwerte kann zu Kommunikationsfehlern desLDAP-Authentifizierungsservers
führen.

5.1 Konfigurieren von LDAP in der
Benutzeroberfläche
Auf der LDAP-Übersichtsseite in der OBWI können Sie die LDAP-
Authentifizierungspriorität und die Parameter festlegen, die die LDAP-
Serververbindungsinformationen definieren.

LDAP-Übersicht-Parameter

LDAP-Authentifizierungspriorität

Im Bereich „LDAP-Priorität“ der OBWI können Sie LDAP deaktivieren oder Sie
können die Authentifizierungspriorität einstellen, indem Sie festlegen, ob zuerst
eine lokale oder eine LDAP-Authentifizierung ausgeführt werden soll.
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So konfigurieren Sie die Parameter der LDAP-Authentifizierungspriorität:

1. Wählen Sie Einheit – Einheit-Einstellungen – Benuterzkonten – LDAP-
Konten – Übersicht aus.

2. Wählen Sie entweder LDAP deaktiviert, LDAP vor lokal oder LDAP nach
lokal als LDAP-Priorität aus.

3. Klicken Sie auf Speichern.

LDAP-Server

In den Adressfeldern werden die Hostnamen oder IP-Adressen des primären und
sekundären LDAP-Servers eingegeben. Der sekundäre LDAP-Server ist
optional.

Die Port-Felder geben die UDP (User Datagram Protocol)-Portnummern an, die
mit den LDAP-Servern kommunizieren. Der Standardwert lautet 389 für
ungesichertes LDAP und 636 für gesichertes LDAP (LDAPS). Die Standard-Port-
ID wird automatisch von der Software eingegeben, wenn ein Zugriffstyp
festgelegt wird.

Die Zugriffstyp-Optionsschaltflächen geben an, wie eine Abfrage an jedes LDAP-
Zielgerät gesendet wird. Wenn Sie LDAP verwenden, werden alle
Benutzernamen, Kennwörter usw. zwischen einer Einheit und dem LDAP-Server
als ungesicherter, unverschlüsselter Text versendet. Verwenden Sie LDAPS für
eine sichere, verschlüsselte Kommunikation zwischen Einheit und LDAP-Server.

So konfigurieren Sie LDAP-Serverparameter:

1. Wählen Sie Einheit – Einheit-Einstellungen – Benuterzkonten – LDAP-
Konten – Übersicht aus.

2. Geben Sie die primäre und sekundäre Server-Adresse, den Port und den
Zugriffstyp in den entsprechenden Feldern an bzw. verwenden Sie die
Optionsschaltflächen.

3. Klicken Sie auf Speichern.

LDAP-Suchparameter

Auf der LDAP-Suchseite können Sie die für die Suche nach Benutzern im LDAP-
Verzeichnis verwendeten Parameter konfigurieren, Über das Feld „Such-DN“
können Sie einen Benutzer auf Administratorebene festlegen, unter dem sich die
Einheit beim Verzeichnisdienst anmeldet. Nachdem die Einheit authentifiziert
wurde, gewährt ihr der Verzeichnisdienst Zugriff auf das Verzeichnis, um die auf
der LDAP-Abfrageseite angegebenen Abfragen zur Benutzerauthentifizierung
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durchzuführen. Die Standardwerte sind cn=Administrator, cn=Users,
dc=yourDomainName und dc=com. Diese können geändert werden. Um zum
Beispiel einen Administrator „Distinguished Name (DN)“ für test.view.com
einzurichten, geben Sie cn=Administrator, cn=Users, dc=test, dc=view und
dc=com ein. Die Werte im Feld „Such-DN“ müssen durch Kommata voneinander
getrennt werden. Das Feld „Suchkennwort“ dient zur Authentifizierung des
Administrators oder Benutzers, der im Feld „Such-DN“ angegeben ist. Im Feld
„Suchbasis“ wird ein Anfangspunkt für die LDAP-Suche angegeben. Die
veränderbaren Standardwerte sind dc=yourDomainName und dc=com. Um zum
Beispiel eine Suchbasis für test.com festzulegen, geben Sie dc=test, dc=com
ein. Die Werte im Feld „Suchbasis“ müssen durch Kommata voneinander
getrennt werden. Das Feld „UID-Maske“ gibt die Suchkriterien für die Benutzer-
ID-Suche auf LDAP-Zielgeräten an. Es sollte im Format name=%1 eingegeben
werden. Der Standardwert ist sAMAccountName=%1 für die Verwendung mit
Active Directory. Das Feld wird für LDAP-Suchen benötigt.

So konfigurieren Sie LDAP-Suchparameter:

1. Wählen Sie Einheit – Einheit-Einstellungen – Benuterzkonten – LDAP-
Konten – Suche aus.

2. Geben Sie die entsprechenden Informationen in die Felder Such-DN,
Suchkennwort, Suchbasis und UID-Maske ein.

3. Klicken Sie auf Speichern.

DieseOptionen können nicht geändert werden, wenn die LDAP-Priorität im
Übersichtsbildschirm auf LDAPdeaktiviert eingestellt ist.

LDAP-Abfrageparameter

Auf der LDAP-Abfrageseite können Sie die Parameter für die Durchführung von
Benutzerauthentifizierungsabfragen konfigurieren.

Die Einheit kann zwei Abfragearten durchführen. Abfragemodus (Einheit) wird
zur Authentifizierung von Administratoren und Benutzern verwendet, die auf die
Einheit selbst zugreifen. Abfragemodus (Zielgerät) wird zur Authentifizierung von
Benutzern verwendet, die auf angeschlossene Zielgeräte zugreifen. Außerdem
verfügt jede Abfrageart über drei Modi, die bestimmte Informationen verwenden,
um zu bestimmen, ob ein LDAP-Benutzer Zugriff auf eine Einheit oder
angeschlossene Zielgeräte hat. Detaillierte Informationen zu jedem Modus
finden Sie unter „Abfragemodi für Einheit und Zielgerät“ auf Seite 79.
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Auf der LDAP-Abfrageseite können Sie die folgenden Einstellungen
konfigurieren:

• Mit den Parametern des Abfragemodus (Einheit) legen Sie fest, ob einem
Benutzer Zugriff auf die Einheit gewährt wird.

• Mit den Parametern des Abfragemodus (Zielgerät) legen Sie fest, ob ein
Benutzer Zugriffsrechte auf Zielgeräte hat, die mit einer Einheit verbunden
sind. Der Benutzer hat keinen Zugriff auf die Einheit, es sei denn, der Zugriff
wurde durch den Abfragemodus (Einheit) gewährt.

• Die Felder Gruppencontainer, Gruppencontainermaske und Zielgerätmaske
werden nur für den Gruppen-Abfragemodus verwendet und werden benötigt,
wenn eine Einheiten- oder Gerätegruppen-Abfrage durchgeführt werden
soll.

• Das Feld Gruppencontainer gibt die Organisationseinheit (ou) an, die vom
Administrator als Speicherort für Gruppenobjekte im Active Directory erstellt
wurde.

• Bei Gruppenobjekten handelt es sich um Active Directory-Objekte, die
Benutzer, Computer, Kontakte und andere Gruppen enthalten können.
Der Gruppencontainer wird verwendet, wenn der Abfragemodus auf das
Gruppenattribut eingestellt wurde. Jedem Gruppenobjekt werden dann
Mitglieder zugeordnet, die für bestimmte Zugriffsebenen für
Mitgliedsobjekte (Benutzer, Einheiten und Zielgeräte) stehen. Die
Zugriffsebene für eine Gruppe wird durch Einstellung des Attributwerts
eines Gruppenobjekts konfiguriert.

• Wenn zum Beispiel die Eigenschaft Notizen des Gruppenobjekts für die
Implementierung des Attributs für Zugriffskontrolle verwendet wird, dann
muss das Feld Attribut für Zugriffskontrolle auf der LDAP-Abfrageseite
auf Info eingestellt sein. Wenn Sie dann das Feld Notizen auf KVM-
Benutzeradministrator einstellen, werden den Mitgliedern dieser Gruppe
die Zugriffsrechte eines Benutzeradministrators auf die Einheiten und
die Zielgeräte gewährt, die auch Mitglieder der gleichen Gruppe sind.

• Die Eigenschaft Notizen wird zum Implementieren der
Zugriffssteuerungsattribute verwendet. Der Wert der Eigenschaft Notizen, der
in den in ADUC (Active Directory Users and Computers) angezeigten
Gruppen- und Benutzerobjekten verfügbar ist, wird im Verzeichnis im Wert
des Attributs Info intern gespeichert. Bei ADUC handelt es sich um ein Snap-
In der Microsoft Management Console zum Konfigurieren von Active
Directory. Diese Anwendung wird gestartet, indem Sie Start > Programme >
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Verwaltung > Active Directory-Benutzer und -Computer wählen. Mit diesem
Programm können Sie Objekte wie Benutzer, Computer und Gruppen
erstellen, konfigurieren und löschen. Weitere Informationen finden Sie unter
„Abfragemodi für Einheit und Zielgerät“ auf Seite 79.

• Die Gruppencontainermaske definiert den Objekttyp des Gruppencontainers,
der normalerweise eine Verwaltungseinheit ist. Der Standardwert ist
„ou=%1“.

• Im Feld Zielmaske können Sie einen Suchfilter für das Zielgerät festlegen.
Der Standardwert ist „cn=%1“.

• Im Feld Attribut für Zugriffskontrolle wird der Name des Attributs festgelegt,
das verwendet wird, wenn die Abfragemodi auf „Benutzerattribut“ oder
„Gruppenattribut“ eingestellt wurden. Der Standardwert ist „info“.

So konfigurieren Sie LDAP-Abfrageparameter:

1. Wählen Sie Einheit – Einheit-Einstellungen – Benuterzkonten – LDAP-
Konten – Abfrage aus.

2. Wählen Sie für den Einheiten- und den Zielgeräte-Abfragemodus entweder
Einfach, Benutzerattribut oder Gruppenattribut.

3. Geben Sie die entsprechenden Informationen in die Felder
Gruppencontainer, Gruppencontainermaske, Zielgerätemaske und Attribut
für Zugriffskontrolle ein.

4. Klicken Sie auf Speichern.

DieseOptionen können nicht geändert werden, wenn die LDAP-Priorität im
Übersichtsbildschirm auf LDAPdeaktiviert eingestellt ist.

5.2 Abfragemodi für Einheit und Zielgerät
Einer von drei Modi kann für den Abfragemodus (Einheit) und den Abfragemodus
(Zielgerät) verwendet werden:

• Einfach – Der Verzeichnisdienst wird auf Benutzername und -kennwort des
Benutzers abgefragt. Wenn diese bestätigt wurden, wird dem Benutzer im
Abfragemodus (Einheit) der Administratorzugriff auf die Einheit und alle
verbundenen Zielgeräte bzw. im Abfragemodus (Gerät) der
Administratorzugriff auf alle ausgewählten Zielgeräte gewährt.

• Benutzerattribut – Der Verzeichnisdienst wird auf Benutzername, Kennwort
und Attribut für Zugriffskontrolle des Benutzers abgefragt. Das Attribut für
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Zugriffskontrolle wird aus dem Benutzerobjekt (dem Benutzerkonto) im
Active Directory gelesen.

Wenn der Wert „KVM-Einheitenadministrator“ gefunden wurde, werden
dem Benutzer im Abfragemodus (Einheit) die Zugriffsrechte des
Einheitenadministrators auf die Einheit und alle verbundenen Zielgeräte
gewährt und im Abfragemodus (Gerät) auf das ausgewählte Zielgerät.

Wenn der Wert „KVM-Benutzeradministrator“ gefunden wurde, werden
dem Benutzer im Abfragemodus (Einheit) die Zugriffsrechte des
Benutzeradministrators auf die Einheit und alle verbundenen Zielgeräte
gewährt und im Abfragemodus (Gerät) auf das ausgewählte Zielgerät.

Wenn der Wert „KVM-Benutzer“ gefunden wurde, werden dem Benutzer
im Abfragemodus (Einheit) die Zugriffsrechte des Benutzers auf die
Einheit und alle verbundenen Zielgeräte gewährt und im Abfragemodus
(Gerät) auf das ausgewählte Zielgerät.

Wenn keiner dieser dreiWerte gefunden wurde, werden demBenutzer im
Abfragemodus (Einheit) keine Zugriffsrechte auf Einheiten und Zielgeräte oder im
Abfragemodus (Gerät) auf ausgewählte Zielgeräte gewährt, es sei denn, der Benutzer
verfügt über benutzer- oder einheitenadministrative Zugriffsrechte für die Einheit.

Sie können auf die ADUC zugreifen, indem Sie Start – Programme – Verwaltung
– Active Directory-Benutzer und -Computer wählen.

• Gruppenattribut – Im Abfragemodus (Einheit) wird eine Abfrage des
Benutzernamens, Kennworts und der Gruppe für eine Einheit und die
verbundenen Zielgeräte beim Verzeichnisdienst durchgeführt. Im
Abfragemodus (Gerät) wird diese Abfrage für das ausgewählte Zielgerät
durchgeführt. Wenn eine Gruppe gefunden wird, welche die Namen des
Benutzers und der Einheit enthält, wird dem Benutzer im Abfragemodus
(Einheit) in Abhängigkeit von den Gruppeninhalten, der Zugriff auf die
Einheit oder die verbundenen Zielgeräte gewährt. Wenn eine Gruppe
gefunden wird, welche die IDs des Benutzers und des Zielgeräts enthält,
wird dem Benutzer im Abfragemodus (Gerät) der Zugriff auf das ausgewählte
Zielgerät gewährt, das mit der Einheit verbunden ist.

Gruppen können maximal über 16 Ebenen verschachtelt werden.
Mithilfe dieser Verschachtelung können Sie Gruppen innerhalb anderer
Gruppen erstellen. Es ist möglich, eine Obergruppe Computer
anzulegen, unter welcher sich die Gruppe „Forschung und Entwicklung“
befindet. Die Gruppe „Forschung und Entwicklung“ könnte ein Mitglied
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mit dem Namen „National“ enthalten, welches wiederum eine Gruppe
darstellt, und so weiter.

5.3 Einrichten von Active Directory für das
Durchführen von Abfragen
Bevor Sie die Abfragemodi für Einheiten verwenden können, müssen Sie
zunächst Änderungen am Active Directory vornehmen, damit der ausgewählte
Abfragemodus die entsprechende Autorisierungsebene für den Benutzer
zuordnen kann.

So stellen Sie Gruppenabfragen ein:

1. Melden Sie sich unter Windows als Administrator an.

2. Öffnen Sie die Active Directory-Software.

3. Erstellen Sie eine Organisationseinheit, die als Gruppencontainer verwendet
werden soll.

4. Zum Abfragen von Einheiten erstellen Sie ein Objekt in Active Directory,
dessen Name mit dem Switching-System identisch ist (dieser wurde im
Übersichtsbildschirm der OBWI definiert) oder dessen Name mit den
verbundenen Zielgeräten identisch ist. Die Namen müssen genau
übereinstimmen; die Groß- und Kleinschreibung ist zu beachten.

5. Die Einheiten- und Zielgerätenamen für die Gruppenabfragen sind in der
Einheit gespeichert. Die im Einheiten-Übersichtsbildschirm der OBWI
definierten Einheiten- und Zielgerätenamen müssen genau mit den
Objektnamen in Active Directory übereinstimmen. Jeder Einheiten- und
Zielgerätename kann aus einer Kombination von Groß- und
Kleinbuchstaben (a–z, A–Z), Zahlen (0–9) und Bindestrichen (-) bestehen.
Sie dürfen keine Leerzeichen und Punkte (.) verwenden und keinen Namen
erstellen, der ausschließlich aus Zahlen besteht. Diese Beschränkungen
bestehen im Active Directory.

Der voreingestellte Standardname in früheren Versionen enthält ein Leerzeichen.
Diesesmussentfernt werden, indem der Name desSwitching-Systems im Einheiten-
Übersichtsbildschirm der OBWI geändert wird.

6. Es können mehrere Gruppen unter einer Gruppencontainer-
Organisationseinheit erstellt werden.
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7. Fügen Sie den in Schritt 5 erstellten Gruppen die Benutzernamen sowie die
Zielgeräte- und Einheitenobjekte hinzu.

8. Geben Sie den Wert eines Attributs an, welches als Attribut für
Zugriffskontrolle verwendet wird. Wenn Sie zum Beispiel „Info“ als Attribut im
Feld Attribut für Zugriffskontrolle verwenden, und die Notizeneigenschaften
als Gruppenobjekt für die Implementierung des Attributs für Zugriffskontrolle
angegeben haben, dann kann der Wert des Notizen-Attributs für das
Gruppenobjekt im Active Directory auf eine der drei Zugriffsebenen
eingestellt sein (KVM-Benutzer, KVM-Benutzeradministrator oder KVM-
Einheitenadministrator). Die Mitglieder dieser Gruppe können dann auf der
festgelegten Zugriffsebene auf die Einheiten und Zielgeräte zugreifen.

Wenn keiner der dreiWerte gefunden wird, wird demBenutzer Benutzerzugriff auf
Einheiten oder Zielgeräte gewährt, die in einer Gruppemit demBenutzernamen
aufgeführt sind.
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Jeder Switch kann über das Konsolenmenü konfiguriert werden, auf

das über den SETUP-Port zugegriffen werden kann. Auf alle

Terminalbefehle kann über ein Terminal oder einen PC, auf dem die

Terminal-Emulationssoftware ausgeführt wird, zugegriffen werden.

HINWEIS: Die bevorzugteMethode ist dasEinstellen sämtlicher
Konfigurationseinstellungenmit der lokalen Benutzeroberfläche.

Anschließen eines Terminals an einen Switch:

1. Schließen Sie mit dem im Lieferumfang enthaltenen RJ-45-auf-

DB-9-Adapter (Buchse) und einem UTP-Kabel ein Terminal oder

einen PC, auf dem Terminal-Emulationssoftware (z. B.

HyperTerminal) läuft, an den SETUP-Port auf der

Gehäuserückseite des Switches an. Das Terminal muss wie folgt

eingestellt sein: 9600 bps, 8 bits, 1 stop bit, no parity und no

flow control.

2. Schalten Sie alle Zielgeräte und danach den Switch ein. Wenn der

Switch die Initialisierung abgeschlossen hat, wird auf dem

Konsolenmenü folgende Nachricht angezeigt: Press any key to

continue.

Menüoptionen im Boot-Menü der Konsole
Während der Switch hochgefahren wird, können Sie durch

Tastendruck das Boot-Menü aufrufen. In diesem Menü können Sie

eine der vier Optionen auswählen.

• Boot Normal

• Boot Alternate Firmware

• Reset Factory Defaults

• Full-Factory Reset

Hauptmenüoptionen der Konsole
Sobald das Gerät eingeschaltet ist, wird im Hauptmenü der

Produktname und die Version angezeigt. In diesem Menü können Sie

eine der vier Optionen auswählen.

• Network configuration: Mit dieser Menüoption können Sie die

Netzwerkeinstellungen der Einheit konfigurieren.
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• Debug messages: Diese Menüoption aktiviert die

Statusmeldungen der Konsole. Sie sollten Debug-Meldungen nur

aktivieren, wenn Sie vom technischen Kundendienst von Fujitsu

dazu angewiesen wurden, da diese Funktion die Leistung deutlich

mindern kann. Dieser Modus kann durch Betätigen einer

beliebigen Taste beendet werden, wenn Sie sich die Meldungen

durchgelesen haben.

• Reset Appliance: Mit dieser Menüoption können Sie einen

Warmstart des Switches ausführen.

• Exit: Mit dieser Menüauswahl kehren Sie wieder zur

Eingabeaufforderung zurück. Wenn das Konsolenmenü durch ein

Kennwort geschützt ist, müssen Sie das Hauptmenü der Konsole

verlassen, sodass der nächste Benutzer wieder zur Eingabe von

Benutzernamen und Kennwort aufgefordert wird.
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Anhang B: Verwendung von seriellen KVM s4-
Adapterkabeln
Verwendung von seriellen KVM s4-Adapterkabeln

Ein Administrator kann für jeden serielles Adapterkabel-Port über die

lokale Benutzeroberfläche oder das Remote-OBWI zwischen den

Stiftbelegungen für den ACS Konsolenserver und für Cisco wählen.

ACS ist der Standardwert.

So ändern Sie die Pinbelegung auf den Cisco Modus:

1. Wählen Sie Einheiten-Ansicht – Einheit – Einheit-Einstellungen –

Ports – Adapterkabel aus.

2. Klicken Sie auf das/die gewünschten seriellen Adapterkabel.

3. Wählen Sie Einstellungen > Pinbelegung.

HINWEIS: Wenn ein DB-9-Adapter verwendet wird, wählen Sie die ACS
Konsolenserver-Pinbelegung aus.

ACS-Konsolenserverport-Pinbelegungen

Die folgende Tabelle listet die Pinbelegungen des seriellen Ports des

ACS Konsolenservers für das serielles Adapterkabel auf.

Pin-Nr. Signalname Eingang/Ausgang

1 RTS–Request to
Send AUSGANG

2 DTR –Data Terminal
Ready AUSGANG

3 TXD – Transmit Data AUSGANG

4 GND –SignalGround –

5 CTS–Clear to Send EINGANG

6 RXD –Receive Data EINGANG

7 DCD/DSR –Data Set
Ready EINGANG

8 N/C –Not Connected –

Tabelle B.1: Pinbelegung des seriellen Ports des ACS-Konsolenservers
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Cisco-Port Pinbelegung

Die folgende Tabelle listet die Cisco-Pinbelegungen des seriellen

Ports für das serielles Adapterkabel auf.

Pin-Nr. Signalname Eingang/Ausgang

1 CTS–Clear to Send EINGANG

2 DCD/DSR –Data Set
Ready EINGANG

3 RXD –Receive Data EINGANG

4 GND –SignalGround –

5 N/C –Not Connected –

6 TXD – Transmit Data AUSGANG

7 DTR –Data Terminal
Ready AUSGANG

8 RTS–Request to
Send AUSGANG

Tabelle B.2: Cisco-Port Pinbelegung

590-1058-640A86



Anhang C: UTP-Verkabelung

Anhang C: UTP-Verkabelung
In diesem Anhang werden die unterschiedlichen

Anschlussmöglichkeiten beschrieben. Das KVM s4-Switching-System

verwendet UTP-Kabel. Die Leistungsfähigkeit Ihres Switch-Systems

hängt von der Qualität der Verkabelungen ab. Schlechte Kabelqualität

oder schlecht verlegte bzw. gewartete Kabel können die

Systemleistung des Switches verringern.

HINWEIS: Dieser Anhang ist nur für Informationszwecke gedacht. Sprechen Sie vor
der Installationmit IhremElektriker und/oder Kabelfachmann vor Ort.

UTP-Kupferkabel
Im Folgenden werden die drei UTP-Arten, die vom KVM s4Switch

unterstützt werden, allgemein beschrieben:

• Cat 5-Hochleistungskabel (4-paarig) bestehen aus verdrillten

Leiterpaaren. Diese Kabelart wird in erster Linie für die

Datenübermittlung verwendet. Durch das Verdrillen von

Leitungspaaren wird das Kabel widerstandsfähiger gegen das

Eindringen von Störungen. Das Cat 5-Kabel wird allgemein für

Netzwerke mit 10 oder 100 MBit/s verwendet.

• Das CAT 5E-Kabel (verbessert) verfügt über die gleichen

Merkmale wie das CAT 5-Kabel, wird jedoch unter strengeren

Vorschriften hergestellt.

• CAT 6-Kabel werden unter höheren Anforderungen als CAT 5E-

Kabel hergestellt. CAT 6-Kabel verfügen über höhere messbare

Frequenzbereiche und bessere Leistungsansprüche als CAT 5E-

Kabel bei gleichen Frequenzen.

Kabelnormen
Es bestehen zwei unterstützte Kabelnormen für UTP-Kabel mit 8

Leitern (4-paarig) und RJ-45-Stecker: EIA/TIA 568A und B. Diese

Normen werden für Installation mit CAT 5, CAT 5E und CAT 6

angewendet. Das KVM s4-Switching-System unterstützt beide

Kabelnormen. In der folgenden Tabelle wird die Pinbelegung

beschrieben.
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Pin EIA/TIA 568A EIA/TIA 568B

1 weiß/grün weiß/orange

2 grün orange

3 weiß/orange weiß/grün

4 blau blau

5 weiß/blau weiß/blau

6 orange grün

7 weiß/braun weiß/braun

8 braun braun

Tabelle C.1: UTP-Kabelnormen

Kabelverlegung, Kabelwartung und Sicherheitshinweise
Im Folgenden werden wichtige Sicherheitshinweise aufgelistet, die vor

der Installation oder Wartung von Kabeln beachtet werden müssen:

• Verlegen Sie UTP-Kabel mit einer maximalen Länge von 10

Metern.

• Behalten Sie die Verdrillung der Paare bis zum endgültigen

Anschluss bei oder lösen Sie die Verdrillung um höchstens 1,25

cm. Entfernen Sie am Kabelende nicht mehr als 2,54 cm der

Ummantelung.

• Wenn das Kabel gebogen werden muss, sollte eine leichte

Biegung mit nicht mehr als 2,54 cm Radius verlegt werden. Durch

harte Biegungen oder Knicke des Kabels kann das Kabelinnere

permanent beschädigt werden.

• Fassen Sie die Kabel unter geringem oder mittlerem Druck mit

Kabelbindern zusammen. Binden Sie die Kabelbinder nicht zu

fest.

• Kabel ggf. mithilfe von Kontaktblöcken, Patch-Panels und

Komponenten querverbinden. Kabel dürfen nicht überbrückt oder

gespleißt werden.
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• UTP-Kabel so weit wie möglich von potenziellen

elektromagnetischen Störquellen (zum Beispiel Stromkabel,

Transformatoren oder Lampenfassungen) entfernt verlegen.

Befestigen Sie die Kabel nicht an elektrischen Leitungsführungen

und verlegen Sie die Kabel nicht auf elektrischen Vorrichtungen.

• Überprüfen Sie jedes installierte Segment mit einem Kabelprüfer.

„Toning“ ist keine akzeptable Prüfung.

• Installieren Sie die Anschlussbuchsen stets so, dass kein Staub

oder andere Verschmutzungen auf die Kontakte gelangen können.

Die Kontakte der Anschlussbuchse sollten nach oben auf die

Einbauplatten zeigen oder sich links/rechts/unterhalb der

Aufputzdosen befinden.

• Lassen Sie immer etwas zusätzlichen Durchhang für die Kabel,

rollen Sie diese sauber in die Decke oder in eine unauffällige

Stelle auf. Lassen Sie eine Extra-Kabellänge von mindestens 1,5

m am Arbeitsende und 5 m am Patch-Panel.

• Entscheiden Sie sich vor Arbeitsbeginn für die Kabelnorm 568A

oder 568B. Verkabeln Sie alle Anschlussbuchsen und Patch-

Panels nach dem gleichen Verkabelungsschema. Kombinieren Sie

568A- und 568B-Verkabelung nicht in derselben Installation.

• Befolgen Sie stets die örtlichen und gesetzlichen Feuer- und

Gebäudevorschriften. Stellen Sie sicher, dass alle Kabel, die durch

eine Brandschutzmauer verlegt werden, die

Feuerschutzbedingungen erfüllen. Verwenden Sie ggf.

Plenumkabel.
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Anhang D: Pinbelegung der Kabel
HINWEIS: Alle Switches verfügen über eine 8-poligeModularsteckerbuchse und
Konsolen-/Setup-Ports.

Abbildung D.1: Modembuchse

Pin Beschreibung Pin Beschreibung

1
Request to Send
(RTS)

5 Transmit Data (TXD)

2
Data Set Ready
(DSR)

6 SignalGround (SG)

3
Data Carrier
Detect (DCD)

7 Data TerminalReady (DTR)

4
Receive Data
(RXD)

8 Clear to Send (CTS)

Tabelle D.1: Beschreibungen für Abbildung D.1

Abbildung D.2: Konsolen-/Setup-Buchse
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Pin Beschreibung Pin Beschreibung

1
Nicht belegt
(N/C)

5 Transmit Data (TXD)

2
Nicht belegt
(N/C)

6 SignalGround (SG)

3
Nicht belegt
(N/C)

7 Nicht belegt (N/C)

4
Receive Data
(RXD)

8 Nicht belegt (N/C)

Tabelle D.2: Beschreibungen für Abbildung D.2
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Anhang E: Technische Daten

Serverports

Anzahl

KVM s4-0812: 8

KVM s4-1622: 16

KVM s4-3242: 32

Typ PS/2, USBund seriell

Anschlüsse 8-polig, modular

Sync-Arten Unabhängig horizontal und vertikal

Eingangsvideoauflösung

Standard

640 x480 bei 60 Hz

800 x600 bei 75 Hz

960 x700 bei 75 Hz

1024 x768 bei 75 Hz

1280 x1024 bei 75 Hz

1600 x1200 bei 60 Hz

Breitbild

800 x500 bei 60 Hz

1024 x640 bei 60 Hz

1280 x800 bei 60 Hz

1440 x900 bei 60 Hz

1680 x1050 bei 60 Hz

Unterstützte Verkabelung
Cat 5- oder Cat 6-UTP-Kabelmit 4 Paaren,
45Meter Maximallänge

Abmessungen

Tabelle E.1: Technische Daten
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Serverports

Formfaktor 1 HE, rackmontierbar

Abmessungen 1,72 x17,00 x9,20 (Höhe xBreite xTiefe)

Gewicht (ohne Kabel)

KVM s4-0812: 3,0 kg

KVM s4-1622: 3,2 kg

KVM s4-3242: 3,4 kg

SETUP-Port

Anzahl 1

Typ RS-232 seriell

Stecker 8-polig, modular

Lokaler Port

Anzahl/Typ 1 VGA/4 USB

Netzwerkverbindung

Anzahl 2

Typ 10/100/1000 Ethernet

Stecker 8-polig, modular

USB-Geräte-Port

Anzahl 4

Typ USB2.0

MODEM-Port

Anzahl 1

Typ RS-232 seriell
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Serverports

Anschlüsse 8-polig, modular

PDU-Port

Anzahl 2

Typ RS-232 seriell

Stecker 8-polig, modular

Leistungsdaten

Anschlüsse 2

Typ Intern

Strom

KVM s4-0812: 13 W

KVM s4-1622: 18 W

KVM s4-3242: 24 W

Wärmeabstrahlung

KVM s4-0812: 43 BTU/Std.

KVM s4-1622: 45 BTU/Std.

KVM s4-3242: 47 BTU/Std.

Wechselstrom-
Eingangsleistungsbereich

100–240 VWechselstrom

Wechselstromfrequenz 50/60 HzAutosensing

Wechselstrom-
Eingangsspannungswert

1,25 A

Wechselstrom-
Eingangsleistung (max.)

40 W

Umgebungsbedingungen

Temperatur
0 ºC bis 50 ºC in Betrieb;

-20 ºC bis 70 ºC, nicht in Betrieb
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Serverports

Luftfeuchtigkeit

Betrieb: 20%bis 80%relative Luftfeuchtigkeit
(nicht-kondensierend)

Nicht in Betrieb: Relative Luftfeuchtigkeit: 5%
bis 95%, Feuchttemperatur: 38,7 ºC (max.)

Sicherheits- und EMV-
Zulassungen und -
Kennzeichnungen

UL, FCC, cUL, ICES-003, CE, VCCI, KCC,
C-Tick, GOST

Die Sicherheits- und EMV-Zulassungen für
diesesProdukt werden unter einer oder
mehreren der folgenden Bezeichnungen
angegeben: Zertifizierungs-Modellnummer
(CMN), Hersteller-Teilnummer (MPN) oder
Bezeichnung desVertriebsstufenmodells
(SalesLevelModel). Die Bezeichnung, wie sie
in den EMV- und/oder Sicherheitsberichten
aufgeführt wird, befindet sich auf dem
Geräteaufkleber.
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Anhang F: Erweiterte Tastenemulation für Sun-
Zusatztasten

Bestimmte Tasten auf einer standardmäßigen Sun-Tastatur Typ 5 (US)

können durch Tastenfolgen auf einer am lokalen Port angeschlossenen

USB-Tastatur emuliert werden. Um die Tastenemulation für Sun

Zusatztasten zu aktivieren und diese zu verwenden, halten Sie die

Tasten Strg+Umschalt+Alt gedrückt und drücken Sie die Rollen-Taste.
Die Rollen-Tasten-LED blinkt. Verwenden Sie die entsprechenden

Tasten in der folgenden Tabelle so, als würden Sie die Zusatztasten

einer Sun Tastatur bedienen. Beispiel: Für Stop + A drücken Sie und

halten Sie die Tasten Strg+Umschalt+Alt gedrückt und drücken Sie

die Rollen-Taste. Betätigen Sie danach F1 + A.

Diese Tastenkombination funktioniert mit den KVM s4-Adapter-

USB20-VGA-Kabeln. Diese Tastenkombinationen werden mit

Ausnahme von F12 von Microsoft Windows nicht erkannt. Wird F12

verwendet, dann wird ein Windows Tastendruck ausgeführt.

Um die Tastenemulation für Sun Zusatztasten zu deaktivieren, drücken

und halten Sie Strg+Umschalt+Alt gedrückt und drücken Sie die

Rollen-Taste.

Sun Taste (US) Taste zumAktivieren der Sun Tastenemulation

Compose Anwendung(1)

Compose Zehnertastatur

Strom F11

Open F7

Help Num-Taste

Props F3

Front F5

Stop F1

Again F2

Tabelle F.1: Sun Tastenemulation
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Sun Taste (US) Taste zumAktivieren der Sun Tastenemulation

Undo F4

Cut F10

Copy F6

Paste F8

Find F9

Mute Zehnertastatur/

Vol.+ Zehnertastatur +

Vol.- Zehnertastatur -

Command (links)(2) F12

Command (links)(2) Win (GUI) links(1)

Command (rechts)
(2) Win (GUI) rechts(1)

WEITEREHINWEISE:

(1)Tastatur mit 104 Tasten für Windows95.

(2)Die Command-Taste ist die SunMeta (Diamant)-Taste.
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Anhang G: Hilfe und technischer Support
Wenn Sie Hilfe, Service oder technischen Support benötigen oder

einfach nur weitere Informationen zu Fujitsu-Produkten wünschen,

stehen Ihnen eine Vielzahl von Fujitsu-Quellen zur Verfügung. In

diesem Abschnitt finden Sie Angaben dazu, wo Sie zusätzliche

Informationen zu Fujitsu und Fujitsu-Produkten erhalten, wie Sie

vorgehen müssen, wenn mit Ihrem System Probleme auftreten, und an

wen Sie sich gegebenenfalls für Service wenden können.

Vor dem Anruf
Stellen Sie vor dem Anruf sicher, dass Sie folgende Schritte

durchgeführt haben, um das Problem zu beheben:

• Überprüfen Sie alle Kabel, um sicherzustellen, dass sie

ordnungsgemäß angeschlossen sind.

• Überprüfen Sie die Netzschalter, um sicherzustellen, dass das

System und alle Geräte eingeschaltet sind.

• Verwenden Sie die Angaben zur Fehlerbehebung in Ihrer

Systemdokumentation sowie die Diagnosehilfen des Systems.

Informationen zu den Diagnoseprogrammen finden Sie in der

Anleitung zu Problembehebung und Service auf der Fujitsu-

Dokumentations-CD, die im Lieferumfang Ihres Systems enthalten

ist.

• Besuchen Sie die Support-Webseite von Fujitsu unter der Adresse

http://www.ts.fujitsu.com/support/, um technische Angaben,

Hinweise und Tipps abzurufen, neue Gerätetreiber

herunterzuladen oder um eine Informationsanforderung zu senden.

Sie können die meisten Probleme ohne Hilfe selbst beheben, indem

Sie den Fehlerbehebungsanweisungen folgen, die Fujitsu in der

Online-Hilfe oder der Dokumentation beschreibt (Bestandteil des

Fujitsu-Produkts). In der Dokumentation der Fujitsu-Systeme werden

auch die Diagnosetests erläutert, die Sie selbst durchführen können.

Nahezu alle Systeme, Betriebssysteme und Programme verfügen über

Dokumentationen, die Anweisungen zur Fehlerbehebung und

Erläuterungen zu Fehlermeldungen und -codes enthalten. Wenn Sie

ein Softwareproblem vermuten, ziehen Sie die Dokumentation des

Betriebssystems oder Programms zurate.
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1. Présentation du produit

1.1 Caractéristiques et avantages
Les commutateurs KVM series4-0812/1622/3242 de Fujitsu allient les
technologies numérique et analogique afin de permettre un contrôle flexible et
centralisé des serveurs de datacenters ainsi que des équipements Virtual Media,
et de faciliter le fonctionnement, l’activation et la maintenance des sites distants
ne disposant pas d’opérateurs formés. Les commutateurs KVM s4 IP offrent une
gestion flexible des équipements cibles ainsi qu’un accès à distance sécurisé en
tout lieu et à tout moment.

Le commutateur KVM s4 offre ainsi les fonctionnalités et les options suivantes
aux entreprises :

• Réduction significative du volume des câbles

• Capacités KVM (clavier, écran et souris) et connectivité analogique (locale)
ou numérique (distante)

• Véritables capacités série via Secure Shell (SSH) et Telnet

• Prise en charge améliorée des résolutions vidéo, jusqu’à 1600 x 1200 ou
1680 x 1050 (écran large) en résolution native cible distante

• Fonctionnalité Virtual Media par le biais des voies USB

• Deux voies vidéo locales indépendantes (dédiées ACI)

• Accès simultané via IPv4 (DHCP) et IPv6 (DHCPv6 et configuration
automatique sans état) double pile

• Prise en charge des lecteurs de carte à puce conforme CCID

• Accès aux équipements cibles par les voies LAN 10/100 ou 1000BaseT

• Voie MODEM prenant en charge les modems compatibles V.34, V.90 ou
V.92, pour accéder au commutateur lorsqu’aucune connexion Ethernet n’est
disponible

Réduction du volume des câbles

La densité des serveurs augmente sans cesse et l’encombrement des câbles
reste l’un des principaux problèmes des administrateurs réseau. Le commutateur
KVM s4 réduit considérablement le volume des câbles KVM dans le rack, grâce
aux câbles d’option de conversion innovants et aux câbles UTP (à paires
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torsadées non blindées) uniques de norme industrielle. On obtient ainsi une
densité de serveurs plus élevée tout en bénéficiant d’une meilleure circulation de
l’air et d’une capacité de refroidissement supérieure.

Capacités de commutation KVM

Le commutateur KVM s4 prend en charge des câbles adaptateurs alimentés
directement par l’équipement cible et qui offrent la fonction Keep Alive lorsque le
commutateur n’est pas sous tension. Les câbles adaptateurs suivants sont pris
en charge : câbles adaptateurs série USB20-VGA KVM s4 et câbles adaptateurs
série KVM s4.

Véritables capacités série

Le commutateur KVM s4 prend en charge les câbles adaptateurs série KVM s4
qui offrent de véritables capacités série via Secure Shell (SSH) ou Telnet. Vous
pouvez ainsi lancer une session SSH ou un visualiseur série à partir de
l’interface Web intégrée pour la connexion des équipements cibles reliés aux
commutateurs KVM s4 au moyen d’un câble adaptateur série KVM s4.

Interfaces utilisateur locale et distante

Vous pouvez utiliser l’interface utilisateur locale par le biais de la voie locale
pour administrer le commutateur KVM s4. Vous pouvez également utiliser
l’interface Web intégrée distante. Elle s’ouvre dans un navigateur Web et se
lance directement à partir du commutateur. Elle détecte automatiquement tous
les équipements reliés au commutateur KVM s4. Les deux interfaces utilisateur
partagent la même apparence, pour plus de convivialité.

Commutateurs Virtual Media et compatibles avec les lecteurs de carte
à puce

Le commutateur KVM s4 vous permet de visualiser, de déplacer ou de copier des
données entre l’équipement Virtual Media et n’importe quel équipement cible.
Vous êtes ainsi en mesure de gérer de façon plus efficace les systèmes distants
avec des possibilités d’installation et de récupération du système d’exploitation,
de récupération ou de duplication du disque dur, de mise à jour du BIOS et de
sauvegarde de l’équipement cible.

Le commutateur KVM s4 vous permet également d’utiliser des cartes à puce en
association avec votre système de commutation. Les cartes à puce sont des
cartes de stockage au format compact. Certains modèles, tels que la Common
Access Card (CAC), peuvent servir au stockage de données d’identification et
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d’authentification, permettant ainsi l’accès à des ordinateurs, réseaux, salles
sécurisées ou bâtiments spécifiques.

Les équipements Virtual Media et lecteurs de cartes peuvent être connectés
directement aux voies USB du commutateur. Ils prennent également en charge la
connexion aux stations de travail distantes exécutant l’interface Web intégrée
distante ou la plate-forme d’administration logicielle DSView® 3 d’Avocent® et
reliées au commutateur à l’aide d’une connexion Ethernet.

Pour ouvrir une session VirtualMedia à partir d’un équipement cible, connectezd’abord
ce dernier au commutateur à l’aide d’un câble adaptateur. Pour utiliser une carte à
puce, connectez tout d’abord l’équipement cible à un commutateur à l’aide d’un câble
adaptateur compatible.

Accès au commutateur via un réseau TCP/IP standard

Le commutateur offre des capacités de contrôle à distance et d’accès sans agent.
Aucun logiciel ou pilote particulier n’est nécessaire sur les serveurs ou clients
reliés.

Le client se connecte au commutateur à l’aide d’un navigateur Internet.

Vous pouvez accéder au commutateur et à tous les systèmes reliés via Ethernet
ou par le biais d’un modem V.34, V.90 ou V.92 à partir d’un client. L’ordinateur
client peut être situé n’importe où, tant qu’il est connecté au réseau.

Module externe de plate-forme d’administration logicielle DSView 3

Le logiciel DSView 3 peut être utilisé avec le commutateur pour permettre aux
administrateurs informatiques d’accéder à, de surveiller et de contrôler à
distance les équipements cibles de différentes plates-formes via une seule
interface Web utilisateur. Pour en savoir plus, reportez-vous à la fiche technique
du module externe de logiciel DSView 3 pour les commutateurs KVM s4.
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1.2 Exemple de configuration

Figure 1.1. Exemple de configuration de commutateur

Tableau 1.1. Description de la Figure 1.1

Numéro Description Numéro Description

1 Connexion CAT 5 7 Réseau téléphonique

2 Connexion KVM
au commutateur 8 Ethernet

3 Connexion IP
distante 9 Serveur exécutant le logicielDSView 3

4 Rackde serveurs 10 Utilisateur analogique (interface
utilisateur locale)
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Numéro Description Numéro Description

5 Commutateur
KVM s4 11

Utilisateur numérique (ordinateur
équipé d’un navigateur Internet,
interfaceWeb intégrée)

6 Modem

590-1058-640A 5



1. Présentation du produit

590-1058-640A6



2. Installation

2.1 Connectivité du commutateur KVM s4
Le commutateur KVM s4 transmet des informations KVM et série entre les
opérateurs et les équipements cibles reliés au commutateur par l’intermédiaire
d’une connexion Ethernet ou modem.

Le commutateur KVM s4 utilise le protocole TCP/IP via une connexion Ethernet.
Pour des performances optimales, utilisez un réseau 100BaseT ou 1000BaseT
commuté dédié. Les réseaux Ethernet 10BaseT sont également pris en charge.

Le commutateur KVM s4 utilise le protocole PPP (point à point) pour les
communications par modem V.34, V.90 ou V.92. Les tâches de commutation
KVM et série s’effectuent par le biais de l’interface Web intégrée ou du logiciel
DSView 3. Pour en savoir plus sur le logiciel DSView 3, consultez la page
http://www.avocent.com/fujitsu.

La Figure 2.1 illustre une configuration de base de commutateur. La description
se trouve dans le Tableau 2.1.
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Figure 2.1. Configuration de base avec le commutateur KVM s4-3242

Tableau 2.1. Description de la Figure 2.1

Numéro Description Numéro Description

1 Utilisateur
numérique 8 Cordon d’alimentation

2 Réseau
téléphonique 9 Voies 1 à 32
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2.1 Connectivité du commutateur KVM s4

Numéro Description Numéro Description

3 Réseau 10 ConnexionsUSB locales

4 Modem 11 PDU

5 Utilisateur
analogique 12 Équipements cibles 1-32

6 VirtualMedia
externe 13 Câblesadaptateurs

7 Commutateur
KVM s4-3242

Démarrage

Avant d’installer le commutateur, consultez la liste ci-dessous afin de vous
assurer que vous disposez de tous les éléments livrés avec le commutateur ainsi
que des autres éléments nécessaires à l’installation.

Fournis avec le commutateur

• Kit de montage en rack

• Guide d’installation rapide des supports de montage en rack

• Guide d’installation rapide du commutateur KVM s4

• Guide de sécurité et conformité

• Câbles et adaptateurs pour les voies MODEM et SETUP

• Cordon(s) d’alimentation secteur

Autres éléments nécessaires

• Un câble adaptateur par équipement cible

• Un câble adaptateur série par équipement série

• Un câble de raccordement UTP par câble adaptateur (câble à 4 paires
torsadées non blindées d’une longueur maximale de 45 m)

• Un ou plusieurs câbles de raccordement UTP pour la connexion au réseau
(câbles à 4 paires torsadées non blindées d’une longueur maximale de 45
 m)

• Un câble adaptateur compatible Virtual Media par équipement cible pour les
sessions Virtual Media
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• Un câble adaptateur prenant en charge les lecteurs de cartes à puce par
équipement cible pour le contrôle des cartes à puce

Configuration du réseau

Le commutateur utilise des adresses IP pour identifier de manière unique le
commutateur et les équipements cibles. Il prend en charge le protocole DHCP
(Dynamic Host Configuration Protocol) ainsi que l’adressage IP statique.
Assurez-vous qu’une adresse IP est réservée pour chaque commutateur et que
chaque adresse IP reste statique lorsque le commutateur est connecté au
réseau.

2.2 Montage en rack d’un commutateur KVM s4
Le commutateur est livré avec un kit de montage en rack. Vous pouvez choisir
d’installer le commutateur sur l’une des étagères du rack ou de le monter
directement dans un rack conforme à la norme EIA (Electronic Industries
Alliance).

Le commutateur peut être monté en rack dans une configuration 1 U ou 0 U.

Consignes de sécurité relatives au montage en rack

• Chargement du rack : une mauvaise répartition de la charge ou une
surcharge risque d’affaiblir le rack et de faire plier les étagères, entraînant
d’éventuels dommages matériels et corporels. Stabilisez les racks à leur
emplacement définitif avant de les charger. Montez les équipements dans le
rack de bas en haut. Ne dépassez pas la charge autorisée.

• Remarques relatives à l’alimentation : n’utilisez aucune source
d’alimentation autre que celle indiquée sur l’unité. Si le rack contient
plusieurs éléments électriques, vérifiez que la charge nominale totale ne
dépasse pas la capacité du circuit. La sollicitation excessive des sources
d’alimentation et l’utilisation de rallonges favorisent les risques d’incendie et
d’électrocution.

• Température ambiante élevée : si l’équipement est installé dans un rack
fermé, il se peut que la température à l’intérieur du rack soit supérieure à la
température ambiante de la pièce. Veillez à ce que cette température
n’excède pas la température maximale de fonctionnement du commutateur.

• Circulation d’air réduite : l’équipement doit être monté dans le rack de sorte
à maintenir une circulation d’air suffisante pour garantir un fonctionnement
en toute sécurité.
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• Mise à la terre : assurez-vous que la mise à la terre de l’équipement monté
en rack est fiable. Vérifiez en particulier les branchements qui ne sont pas
reliés directement au circuit de dérivation (lors de l’utilisation de barrettes de
connexion, par exemple).

• Ne montez pas le commutateur panneau arrière dirigé vers le bas.

Reportez-vous au Guide d’installation rapide des supports de montage en rack
pour obtenir des instructions détaillées.

2.3 Connexion du commutateur
Pour connecter et activer le commutateur :

Afin d’éviter tout problème de vidéo et/ou clavier lors de l’utilisation des
produits Fujitsu, respectez les consignes suivantes : Si le bâtiment est alimenté
en courant alternatif triphasé, assurez-vousque l’ordinateur et l’écran sont sur la même
phase. Pour des résultats optimaux, ils doivent être reliés aumême circuit.

AVERTISSEMENT : Pour éviter d’endommager le matériel et écarter tout
risque d’électrocution, respectez les consignes suivantes :
- Ne retirez pas la prise de terre, elle constitue un élément de sécurité essentiel.
- Branchez le cordon d’alimentation sur une prise reliée à la terre et facilement
accessible à tout moment.
- Coupez l’alimentation de l’unité en débranchant le cordon d’alimentation au niveau de
la prise secteur ou de l’unité.
- Lameilleure façon demettre l’équipement hors tension est de le débrancher de la
prise de courant. Pour les produits possédant plusieurs prisesde courant, tous les
cordonsd’alimentation doivent être débranchésavant que l’alimentation soit
complètement coupée.
- Aucune pièce située dans le boîtier du produit ne peut être réparée par l’utilisateur. Le
couvercle ne doit par conséquent être ni ouvert, ni retiré.

1. Connectez l’écran VGA, le clavier USB et la souris sur les voies
correspondantes.

2. Choisissez une voie disponible du commutateur. Branchez l’extrémité d’un
câble UTP (4 paires, jusqu’à 45 m) sur une voie numérotée. Branchez l’autre
extrémité au connecteur RJ-45 d’un câble adaptateur.

3. Connectez un câble adaptateur aux voies correspondantes à l’arrière de
l’équipement cible. Répétez la procédure pour tous les équipements cibles à
connecter.
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Lors de la connexion d’un équipement cible SunMicrosystems, utilisezun écran à
synchronisationmultiple sur la voie locale pour prendre en charge les ordinateursSun
compatibles avec la norme VGAou les synchronisations composites.

4. Connectez les deux voies LAN à des commutateurs Ethernet indépendants
pour plus de redondance.

5. Mettez sous tension tous les équipements cibles, puis munissez-vous du ou
des cordons d’alimentation fournis avec le commutateur. Branchez l’une des
extrémités dans la prise d’alimentation située à l’arrière du commutateur.
Branchez l’autre extrémité sur une prise secteur appropriée. Branchez le
deuxième cordon d’alimentation à la seconde prise d’alimentation située à
l’arrière du commutateur. Branchez l’autre extrémité sur une prise secteur
appropriée.

Branchez les alimentations redondantesà des circuits de dérivation séparéspour plus
de redondance en casde panne de la source d’alimentation c.a. externe.

Connexion d’un équipement Virtual Media ou d’un lecteur de cartes :

Connectez l’équipement Virtual Media ou le lecteur de cartes à l’une des voies
USB disponibles du commutateur DSR.

Vousdevezutiliser un câble adaptateur USB20-VGAKVM s4 pour toutes les sessions
VirtualMedia et tous les lecteurs de cartes.

Pour en savoir plus sur la connexion à distance d’équipements Virtual Media,
reportez-vous à la section « Virtual Media » à la page 65. Pour en savoir plus sur
la connexion à distance d’un lecteur de cartes, reportez-vous à la section «
Cartes à puce » à la page 70.

Connexion d’un câble adaptateur série à un équipement série à l’aide d’un
connecteur UTP :

1. Reliez le connecteur UTP du câble adaptateur série à l’équipement série.

-ou-

Reliez le câble adaptateur série à un adaptateur femelle RJ-45/9
broches. Reliez l’adaptateur à la voie série de l’équipement série.

2. Branchez une extrémité d’un câble UTP (4 paires, longueur maximale de 45
 m) sur une voie numérotée disponible à l’arrière du commutateur. Branchez
l’autre extrémité au connecteur RJ-45 du câble adaptateur série.
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3. Reliez un cordon d’alimentation USB-connecteur cylindrique au connecteur
d’alimentation du câble adaptateur série. Branchez le connecteur USB du
cordon USB-connecteur cylindrique sur l’une des voies USB disponibles de
l’équipement série cible.

2.4 Mise en cascade de commutateurs KVM s4
Vous pouvez monter en cascade jusqu’à deux niveaux de commutateurs KVM
 s4, pour permettre aux utilisateurs de connecter un maximum de 1 024 serveurs.
Dans un système en cascade, chaque voie cible du commutateur principal peut
être reliée à la voie ACI (Analog Console Interface) de chaque commutateur
monté en cascade. Chacun des commutateurs montés en cascade peut ensuite
être relié à un équipement à l’aide d’un câble adaptateur.
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Figure 2.2. Configuration en cascade de commutateurs KVM s4

Numéro Description

1 Commutateur KVM s4 principal

2 Commutateur KVM s4 en cascade

3 Voie cible du commutateur principal

4 Voie ACI du commutateur en cascade

5 Équipements cibles reliés aux commutateurs

Tableau 2.2 : Description de la Figure 2.2
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Mise en cascade de plusieurs commutateurs :

1. Reliez l’extrémité d’un câble CAT 5 à une voie cible du commutateur KVM
 s4.

2. Reliez l’autre extrémité du câble CAT 5 à la voie ACI (icône en forme de
maillon de chaîne) située à l’arrière du commutateur KVM s4 en cascade.

3. Reliez les équipements à votre commutateur KVM s4 en cascade.

4. Répétez ces étapes pour tous les commutateurs KVM s4 montés en cascade
à relier au système.

Le système reconnaît automatiquement les deux commutateursmontésen cascade
comme un seul ensemble. Tous les équipements connectésaux commutateursmontés
en cascade s’affichent dans la liste d’équipements du commutateur principal de
l’interface utilisateur locale.

Le commutateur prend en charge un commutateur monté en cascade par voie cible du
commutateur principal. Vousne pouvezpas relier de commutateur au commutateur
monté en cascade.

Lemontage en cascade à partir de la voie locale n’est paspris en charge par les
commutateursKVM s4.

2.5 Configuration des commutateurs KVM s4
Une fois toutes les connexions physiques établies, vous devez configurer le
commutateur que vous comptez utiliser dans le système de commutation global.
Deux possibilités s’offrent à vous.

Configuration du commutateur via le logiciel DSView 3 :

Reportez-vous au guide d’installation et d’utilisation du logiciel DSView3 pour
obtenir des instructions détaillées.

Configuration du commutateur à l’aide de l’interface utilisateur locale :

Reportez-vous à la section « Paramètres de réseau » à la page 32 pour obtenir
des instructions détaillées sur l’utilisation de l’interface utilisateur locale dans le
cadre de la configuration initiale du réseau.

Configuration du serveur Web intégré

Vous pouvez accéder au commutateur par l’intermédiaire d’un serveur Web
intégré capable de gérer la plupart des tâches de commutation de routine. Avant
d’accéder au commutateur via le serveur Web, spécifiez une adresse IP à l’aide
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de la voie locale située sur le panneau arrière du commutateur ou de l’interface
utilisateur locale.

Connexion à l’interface Web intégrée derrière un pare-feu

Pour les installations de commutateur qui gèrent les accès via l’interface Web
intégrée, vous devez ouvrir les voies suivantes dans le pare-feu pour permettre
l’accès de l’extérieur.

Numéro de
voie TCP Fonction

22 Utilisée pour SSH dans le cadre de sessions série vers un câble
adaptateur série

23 Utilisée pour Telnet (lorsque cette fonction est activée)

80 Utilisée pour le téléchargement initial du visualiseur vidéo

443 Utilisée par l’interface du navigateur Web pour gérer le commutateur et
lancer des sessionsKVM

2068 Transmission desdonnéesde sessionsKVM (souris et clavier) ou
transmission vidéo entre les commutateurs.

Tableau 2.3 : Voies TCP et fonctions de l’interface Web intégrée du commutateur

Dans une configuration standard, comme illustrée à la Figure 2.3, l’ordinateur de
l’utilisateur est situé à l’extérieur du pare-feu tandis que le commutateur se trouve
à l’intérieur de celui-ci.
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Figure 2.3. Configuration typique du commutateur avec pare-feu

Tableau 2.4. Description de la Figure 2.3

Numéro Description

1 Commutateur KVM s4

2 Pare-feu

3 Ordinateur de l’utilisateur

4
Le pare-feu transmet les requêtesHTTPet le traficKVM au
commutateur

5 L’utilisateur accède à une adresse IP extérieure au pare-feu

Configuration du pare-feu :

Pour accéder au commutateur depuis l’extérieur d’un pare-feu, configurez ce
dernier afin de rediriger les voies 22, 23 (si Telnet est activé), 80, 443 et 2068 de
l’interface externe au commutateur KVM via l’interface interne du pare-feu.
Consultez le manuel du pare-feu pour obtenir des instructions spécifiques
concernant la redirection des voies.

Pour plus d’informations sur le lancement de l’interface Web intégrée, reportez-
vous à la section « Interface Web intégrée » à la page 22.

2.6 Vérification des connexions

Voyants de connexion Ethernet du panneau arrière

Le panneau arrière du KVM s4 comporte deux voyants indiquant l’état de la
connexion Ethernet LAN1 et deux voyants indiquant l’état de la connexion
Ethernet LAN2.

• Les voyants verts s’allument lorsque la connexion au réseau est
correctement établie et clignotent lorsque la voie correspondante est active.

• Les voyants bicolores émettent une couleur verte ou orange.

• Ils sont verts lorsque la vitesse de communication est de 1000M.

• Ils sont orange lorsque la vitesse de communication est de 100M.

• Ils restent éteints lorsque la vitesse de communication est de 10M.

590-1058-640A 17



2. Installation

Voyants d’état de l’alimentation du panneau arrière

Le panneau arrière de chaque unité comporte deux voyants d’état de
l’alimentation, soit un pour chaque entrée d’alimentation. Les voyants verts
s’allument lorsque le commutateur est sous tension et fonctionne normalement.

• Les voyants sont éteints lorsque l’entrée d’alimentation correspondante est
hors tension ou défectueuse.

• Les voyants sont allumés lorsque l’unité est prête.

• Le voyant clignote lorsque le commutateur est en cours de démarrage ou
lorsqu’une mise à jour est en cours.

• Les voyants émettent le signal « SOS » en cas de problème (coupure de
l’alimentation, température ambiante élevée, dysfonctionnement du
ventilateur). Ils clignotent tant que le problème persiste.

Le commutateur empêche les interruptions série de l’équipement relié
provoquées par une coupure d’alimentation du module. Il est toutefois possible
de générer une interruption série à partir de l’équipement relié en sélectionnant
Serial Break dans le visualiseur série.

2.7 Réglage des paramètres de la souris sur les
équipements cibles
Avant de pouvoir utiliser à distance un ordinateur connecté au commutateur,
vous devez régler la vitesse de la souris et désactiver l’accélération. Sur les
ordinateurs exécutant Microsoft®Windows® (Windows XP, Windows Vista,
Windows 2003, Windows 2008 and Windows 7), utilisez le pilote de souris PS/2
par défaut.

Pour garantir la synchronisation constante des mouvements de la souris locale
avec ceux du curseur distant, définissez l’accélération de la souris sur « Aucun »
pour tous les comptes utilisateurs accédant au système distant par le biais du
commutateur KVM. L’accélération de la souris doit également être définie sur «
 Aucun » sur chacun des systèmes distants. N’utilisez pas de curseur spécial.
Les options de visibilité du curseur (telles que les traînées du pointeur, les
animations d’emplacement du curseur à l’aide de la touche Ctrl, l’ombre du
curseur et le curseur masqué) doivent également être désactivées.
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Si vousne savezpas comment désactiver l’accélération de la souris sousWindowsou si
vousne souhaitez pas régler les paramètresde tous voséquipements cibles, utilisez la
commandeOutils >Mode curseur simple dans la fenêtre du visualiseur vidéo. Grâce à
cette commande, la fenêtre du visualiseur vidéo semet enmode « souris invisible », ce
qui vouspermet de basculer entre le pointeur de la souris du système cible en cours de
visualisation et le pointeur de la souris de l’ordinateur client.
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3. Configuration locale et distante

3.1 Interfaces utilisateur
Le commutateur KVM s4 est fourni avec deux interfaces de type « contrôle en un
clic » : une interface utilisateur locale et une interface Web intégrée distante. Les
options de configuration proposées par ces interfaces vous permettent de
personnaliser le commutateur en fonction de votre application précise, de
contrôler les équipements reliés et de traiter tous les besoins du commutateur
série ou KVM de base.

Lesdeux interfaces sont quasiment identiques. Sauf indication contraire, toutes les
informations contenuesdans ce chapitre s’appliquent auxdeux interfaces.

Toutes deux permettent d’ouvrir deux types de sessions différents :

• La fenêtre du visualiseur vidéo permet de contrôler en temps réel les
fonctions du clavier, de l’écran et de la souris des équipements cibles
individuels reliés au commutateur. Vous avez également la possibilité
d’utiliser des macros prédéfinies pour réaliser des actions dans la fenêtre du
visualiseur. Les instructions d’utilisation du visualiseur vidéo sont décrites au
chapitre 4.

• La fenêtre du visualiseur série vous permet de gérer des équipements cibles
individuels par le biais de commandes ou de scripts.

Interface utilisateur locale

Le commutateur est équipé d’une voie locale située sur le panneau arrière. Cette
voie vous permet de relier un clavier, un écran et une souris directement au
commutateur et d’utiliser l’interface utilisateur locale.

Vous avez le choix entre les combinaisons de touches suivantes pour
commander l’ouverture de l’interface utilisateur locale ou commuter entre
l’interface utilisateur locale et une session active : Impr écran, Ctrl + Ctrl, Maj +
Maj et Alt + Alt.

Lancement de l’interface utilisateur locale :

1. Connectez les câbles de l’écran, du clavier et de la souris au commutateur.
Pour en savoir plus, reportez-vous à la section « Connexion du commutateur
» à la page 11.
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2. Pour lancer l’interface utilisateur locale, appuyez sur l’une des combinaisons
de touches activées.

3. Si l’authentification a été activée, saisissez vos nom d’utilisateur et mot de
passe.

Si le commutateur a été ajouté au serveur DSView 3, l’authentification de l’utilisateur se
fait via ce serveur. Si le commutateur n’a pasété ajouté au serveur DSView 3 ou si
aucune communication ne peut être établie avec ce serveur, l’authentification de
l’utilisateur se fait par l’intermédiaire de la base de données locale du commutateur. Le
nom d’utilisateur local par défaut est Admin et aucunmot de passe n’est défini. Les
nomsd’utilisateur de la base de données sont sensibles à la casse.

Interface Web intégrée

L’interface Web intégrée du commutateur est une interface utilisateur distante
basée sur navigateur. Pour en savoir plus sur la configuration de votre système,
reportez-vous à la section « Connexion du commutateur » à la page 11. Le
tableau suivant dresse la liste des systèmes d’exploitation et navigateurs pris en
charge par l’interface Web intégrée. Assurez-vous d’utiliser la dernière version
disponible de votre navigateur web.

Tableau 3.1. Systèmes d’exploitation et navigateurs pris en charge par l’interface
Web intégrée

Système d’exploitation

Navigateur

Microsoft® Internet
Explorer 6.0 SP1
ou version
ultérieure

Firefox3.0 ou version ultérieure

MicrosoftWindows
Server® 2003
Standard, Enterprise
ouWeb Edition

Oui Oui

MicrosoftWindows
Server® 2008
Standard, Enterprise
ouWeb Edition

Oui Oui
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Système d’exploitation

Navigateur

Microsoft® Internet
Explorer 6.0 SP1
ou version
ultérieure

Firefox3.0 ou version ultérieure

Windows XP
Professionnel avec
Service Pack 3

Oui Oui

WindowsVista®

Professionnel avec
Service Pack 1

Oui Oui

Windows 7 Oui Oui

Red Hat Enterprise
Linux® 4 et 5 Standard,
Enterprise ouWeb
Edition

Non Oui

Sun Solaris 10 et 11 Non Oui

Solaris 10 x86 Non Oui

Ubuntu 8Workstation Non Oui

Pour se connecter à l’interface Web intégrée du commutateur :

1. Lancez un navigateur Web.

2. Saisissez l’adresse IP ou le nom d’hôte attribué au commutateur auquel
vous souhaitez accéder dans la barre d’adresse du navigateur. Utilisez le
format https://xxx.xx.xx.xx ou https://nomhôte.

Si vousutilisez le mode IPv6, saisissez l’adresse IP entre crochets. Utilisez le format
https://[<adresseip>].

3. Lorsque la communication entre le navigateur et le commutateur est établie,
saisissez vos nom d’utilisateur et mot de passe, puis cliquez sur Connexion.
L’interface Web intégrée du commutateur s’affiche.

Par défaut, le nom d’utilisateur et le mot de passe sont admin.

590-1058-640A 23



3. Configuration locale et distante

Pour vous connecter à l’interface Web intégrée du commutateur en dehors du
pare-feu, répétez la procédure ci-dessus en remplaçant l’adresse IP du
commutateur par l’adresse IP externe du pare-feu.

Utilisation des interfaces utilisateur

L’interface utilisateur s’affiche après l’authentification. Vous pouvez afficher,
accéder à et administrer votre commutateur, ainsi que spécifier des paramètres
système et modifier les paramètres de profil. La Figure 3.1 présente les zones de
la fenêtre de l’interface utilisateur. La description est donnée dans le tableau qui
suit.

Figure 3.1. Fenêtre de l’interface utilisateur

Numéro Description

1

Barre d’options supérieure : utilisez la barre d’options supérieure pour
mettre en signet de fenêtresd’interface, actualiser l’affichage des
fenêtres, imprimer despagesWeb, vousdéconnecter de la session de
l’interfaceWeb intégrée ou accéder à l’aide en ligne. Le nom de
l’utilisateur connecté apparaît dans la partie gauche de la barre d’options
supérieure.

Tableau 3.2 : Description de l’interface utilisateur
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Numéro Description

2

Barre de navigation latérale : utilisez la barre de navigation latérale pour
sélectionner et afficher les informations système dans la zone de
contenu. Cette barre contient également des icônes, dans le coin
supérieur gauche, permettant de développer ou de réduire
l’arborescence.

3 Zone de contenu : utilisez la zone de contenu pour afficher oumodifier le
système de l’interfaceWeb intégrée du commutateur.

Utilisation de la barre de navigation latérale

Vous pouvez utiliser la barre de navigation latérale pour afficher des fenêtres
dans lesquelles vous spécifierez des paramètres ou effectuerez des opérations.
Cliquez sur un lien non précédé d’une flèche pour afficher la fenêtre
correspondante.

Utilisation de la barre d’options supérieure

Si l’authentification est désactivée, seul le bouton Actualiser s’affiche dans l’interface
utilisateur locale. Si l’authentification est activée, seuls les bouton Actualiser et
Déconnexion s’affichent dans l’interface utilisateur locale. Tous les autresboutons
s’affichent dans l’interfaceWeb intégrée.

Mise en signet d’une fenêtre (avec Microsoft Internet Explorer uniquement)

La barre d’options supérieure de l’interface utilisateur comporte une icône de
mise en signet. La mise en signet d’une fenêtre ajoute un lien vers cette fenêtre
dans le menu Favoris. Sélectionnez ce lien à tout moment pour accéder
rapidement à la fenêtre.

Si vous mettez en signet une fenêtre et que les informations qu’elle contient sont
modifiées, les informations mises à jour apparaissent lors du prochain affichage
de la fenêtre.

Si vous cliquez sur SIGNET ou sur l’icône correspondante après expiration de la
session de l’interface Web du commutateur, la fenêtre Connexion utilisateur
s’ouvre, vous invitant à vous connecter à nouveau.

Mise en signet d’une fenêtre :

1. Dans la barre d’options supérieure, cliquez sur SIGNET ou sur l’icône
correspondante. La boîte de dialogue Ajouter aux favoris s’affiche.
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2. Si vous le souhaitez, nommez la fenêtre. Vous pouvez également cliquer sur
le bouton Créer dans pour créer ou indiquer un dossier dans lequel placer le
lien.

3. Cliquez sur OK pour fermer la boîte de dialogue Ajouter aux favoris.

Impression d’une fenêtre

Toutes les fenêtres de l’interface Web intégrée comportent une icône
d’impression dans la barre d’options supérieure.

Pour imprimer la fenêtre de l’interface Web intégrée du commutateur :

1. Dans la barre d’options supérieure, cliquez sur IMPRIMER ou sur l’icône
correspondante. La boîte de dialogue d’impression s’affiche.

2. Définissez les options d’impression de votre choix.

3. Cliquez sur Imprimer pour imprimer le contenu de la fenêtre et fermer la
boîte de dialogue d’impression.

Actualisation d’une fenêtre

Vous pouvez, à tout moment, cliquer sur ACTUALISER ou sur l’icône
correspondante de la barre d’options supérieure pour actualiser l’interface
utilisateur du commutateur.

Déconnexion

Pour vous déconnecter à tout moment, cliquez sur l’icône Déconnexion de la
barre d’options supérieure.

3.2 Affichage des informations relatives au système
Plusieurs écrans de l’interface utilisateur permettent d’afficher diverses
informations relatives au matériel et aux équipements cibles reliés.

Tableau 3.3. Informations système

Catégorie Chemin d’accès Informationsaffichées

Commutateur
VueUnités>
Matériel >
Présentation

Nom et type du commutateur et outils
matériels
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Catégorie Chemin d’accès Informationsaffichées

VueUnités>
Matériel >
Propriétés>
Identité

Version actuelle du firmware de l’application et
du programme de démarrage

VueUnités>
Matériel >
Propriétés>
Emplacement

Site, service ou emplacement

VueUnités>
Matériel >
Paramètresdu
matériel >Versions

Version actuelle du firmware de l’application,
du programme de démarrage et de la version
FPGA

VueUnités>
Connexions

Liste deséquipements reliés

Équipement cible
VueUnités>
Équipements
cibles

Liste deséquipements cibles reliés et
informations suivantes relativesà chacun
d’entre eux : nom, type, état et action

Cliquez sur l’un deséquipements cibles pour
afficher les informations supplémentaires
suivantes : nom, type, numéro eID, option de
session disponible et chemin de connexion

Vous serez également averti si l’un des problèmes suivants se produit : coupure
d’alimentation, température ambiante élevée ou dysfonctionnement du
ventilateur. Un triangle jaune avec point d’exclamation et la description du
problème rencontré s’affichent dans l’en-tête de chaque écran. Cette notification
apparaît ou disparaît uniquement après actualisation de la page. Cliquez sur la
notification pour en savoir plus.

3.3 Sessions du commutateur KVM s4
L’écran Sessions actives vous permet d’afficher la liste des sessions actives ainsi
que les informations suivantes relatives à chacune d’entre elles : équipement
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cible, propriétaire, hôte distant, durée et type.

Ouverture d’une session
Java version 1.6.0_11 ou ultérieure est requis pour lancer une session.

Ouverture d’une session :

1. Dans la barre de navigation latérale, sélectionnez Vue Unités >
Équipements cibles. La liste des équipements disponibles s’affiche.

2. Cliquez sur le lien Session KVM ou Session série à côté de l’équipement
cible souhaité pour lancer la session.

Si l’équipement cible est en cours d’utilisation, tout utilisateur tentant d’y accéder
a la possibilité de forcer la connexion à condition de disposer d’un privilège de
préemption supérieur ou égal à celui de l’utilisateur connecté.

Commutation vers la session active à partir de l’interface utilisateur locale
(utilisateurs locaux uniquement) :

1. Dans la barre de navigation latérale, sélectionnez Session locale.

2. Cochez la case Reprendre la session active. La fenêtre du visualiseur vidéo
s’ouvre.

-ou-

Appuyez sur Echap.

Configuration des sessions

Configuration des paramètres de session générale :

1. Dans la barre de navigation latérale, sélectionnez Vue Unités > Matériel >
Paramètres du matériel > Sessions > Général. L’écran Paramètres généraux
de session du matériel s’affiche.

2. Cochez ou décochez la case Activer le délai d’inactivité.

3. Dans le champ Délai d’inactivité, indiquez la durée d’inactivité souhaitée
avant que la session ne se ferme (entre 1 et 90 minutes).

4. Dans le champ Expiration de la connexion, indiquez la durée d’inactivité
souhaitée avant qu’une nouvelle connexion ne soit requise (entre 21 et 120
 secondes).

5. Cochez ou décochez la case Activer le délai avant préemption.
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6. Dans le champ Délai avant préemption, indiquez la durée souhaitée (entre 1
et 120 secondes) avant qu’une invite ne s’affiche pour vous informer de la
préemption de la session.

7. Cliquez sur Enregistrer.

Configuration des paramètres de session KVM :

1. Dans la barre de navigation latérale, sélectionnez Vue Unités > Matériel >
Paramètres du matériel > Sessions > KVM. L’écran Paramètres de session
KVM du matériel s’affiche.

2. Sélectionnez un niveau de cryptage pour les signaux du clavier et de la
souris (SSL 128 bits, DES, 3DES ou AES) ainsi que pour les signaux vidéo
(SSL 128 bits, DES, 3DES, AES ou Aucun).

3. Dans le menu déroulant Clavier, sélectionnez une langue.

4. Cliquez sur Enregistrer.

Configuration des paramètres de session série :

1. Dans la barre de navigation latérale, sélectionnez Vue Unités > Matériel >
Paramètres du matériel > Paramètres > Série. L’écran Paramètres de
session série du matériel s’affiche.

2. Cochez ou décochez la case Accès Telnet activé.

3. Cliquez sur Enregistrer.

Fermeture d’une session

Fermeture de session :

1. Dans la barre de navigation latérale, sélectionnez Sessions actives pour
afficher l’écran correspondant.

2. Cochez la case à côté des équipements cibles concernés.

3. Cliquez sur Déconnecter.

Si une session VirtualMedia verrouillée associée est active, elle est alors désactivée.

Fermeture d’une session (utilisateurs locaux uniquement) :

1. Dans la barre de navigation latérale, sélectionnez Session locale.

2. Cochez la case Déconnecter la session active.
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3.4 Outils du commutateur KVM s4
L’écran Présentation de l’unité vous permet d’afficher le nom et le type de
matériel. Vous pouvez également y effectuer des tâches de base.

Redémarrage du commutateur

Pour redémarrer le commutateur :

1. Dans la barre de navigation latérale, sélectionnez Vue Unités > Matériel >
Présentation pour afficher l’écran correspondant.

2. Cliquez sur Redémarrage.

3. Une boîte de dialogue s’affiche, vous avertissant de la déconnexion de
toutes les sessions actives. Cliquez sur OK.

Si vousutilisez l’interface utilisateur locale, l’écran reste vierge pendant le redémarrage
du commutateur. Si vousutilisez l’interfaceWeb intégrée distante, unmessage
s’affiche, vous indiquant que l’interface attend la fin du redémarrage de l’équipement.

Mise à jour du firmware du commutateur

Vous pouvez mettre à jour votre commutateur à l’aide du dernier firmware
disponible.

Une fois la mémoire Flash à jour, le commutateur redémarre à chaud, ce qui
interrompt toutes les sessions des câbles adaptateurs. Il se peut que les
équipements cibles sur lesquels le firmware du câble adaptateur est en cours de
mise à jour ne s’affichent pas ou soient signalés comme déconnectés. Ils sont à
nouveau visibles normalement dès que la mise à jour Flash est terminée.

AVERTISSEMENT : La déconnexion d’un câble adaptateur ou lamise hors tension
puis sous tension de l’équipement cible pendant unemise à jour du firmware rend le
câble adaptateur inopérationnel et vousoblige à le retourner à l’usine pour réparation.

Mise à jour du firmware du commutateur :

1. Dans la barre de navigation latérale, sélectionnez Vue Unités > Matériel >
Présentation pour afficher l’écran correspondant.

2. Cliquez sur Mettre à jour le firmware pour affiche l’écran Mise à jour du
firmware du matériel.

3. Sélectionnez l’une des options de chargement du fichier de mise à jour du
firmware : Système de fichiers, TFTP, FTP ou HTTP.
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L’option Système de fichiers est uniquement accessible à partir de l’interfaceWeb
intégrée distante.

4. Si vous avez sélectionné Système de fichiers, cliquez ensuite sur Parcourir
pour spécifier l’emplacement du fichier de mise à jour du firmware.

-ou-

Si vous avez sélectionné TFTP, indiquez l’adresse IP du serveur et le
fichier de firmware à charger.

-ou-

Si vous avez sélectionné FTP ou HTTP, indiquez l’adresse IP du serveur
et le fichier de firmware à charger, ainsi que vos nom d’utilisateur et mot
de passe.

5. Cliquez sur Mettre à jour.

Enregistrement et restauration des configurations de commutateur et
des bases de données utilisateur

Vous pouvez enregistrer la configuration du commutateur dans un fichier. Le
fichier de configuration contient alors ainsi des informations sur le matériel géré.
Vous pouvez également enregistrer la base de données utilisateur locale sur le
commutateur. Dans les deux cas, vous avez la possibilité de restaurer un fichier
de configuration précédemment enregistré ou un fichier de base de données
utilisateur locale sauvegardé sur le commutateur.

Enregistrement de la configuration du matériel géré ou de la base de données
utilisateur correspondante :

1. Dans la barre de navigation latérale, sélectionnez Vue Unités > Matériel >
Présentation pour afficher l’écran correspondant.

2. Cliquez sur Enregistrer la configuration du matériel ou sur Enregistrer la
base de données utilisateur du matériel. La boîte de dialogue de
téléchargement de fichier s’affiche.

3. Cliquez sur Enregistrer. La boîte de dialogue Enregistrer sous s’affiche.

4. Naviguez jusqu’à l’emplacement de votre choix et saisissez un nom de
fichier. Cliquez sur Enregistrer.

5. Cliquez sur Fermer.
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Restauration de la configuration du matériel géré ou de la base de données
utilisateur correspondante :

1. Dans la barre de navigation latérale, sélectionnez Vue Unités > Matériel >
Présentation pour afficher l’écran correspondant.

2. Cliquez sur Restaurer la configuration du matériel ou sur Restaurer la base
de données utilisateur du matériel. La fenêtre Restaurer la configuration du
matériel ou Restaurer la base de données utilisateur du matériel s’affiche.

3. Cliquez sur Parcourir. Naviguez jusqu’à l’emplacement correspondant et
sélectionnez le fichier. Cliquez sur Télécharger.

4. Une fois l’écran de confirmation affiché, cliquez sur Fermer. Redémarrez le
matériel géré afin d’activer la configuration restaurée. Reportez-vous à la
section « Outils du commutateur KVM s4 » à la page 30.

3.5 Paramètres de réseau
Seuls les administrateurs de commutateurs peuvent modifier les paramètresde la boîte
de dialogue réseau. Lesautresutilisateurs bénéficient d’un accèsen lecture seule
uniquement.

Configuration des paramètres de réseau généraux :

1. Dans la barre de navigation latérale, sélectionnez Vue Unités > Matériel >
Paramètres du matériel > Réseau > Général. L’écran Paramètres réseau
généraux du matériel s’affiche.

2. Sélectionnez une ou plusieurs options dans le menu déroulant Vitesse du
LAN : Auto-détection, Half-duplex 10 Mbit/s, Full-duplex 10 Mbit/s, Half-
duplex 100 Mbit/s, Full-duplex 100 Mbit/s ou Full-duplex 1 Gbit/s.

Si vousmodifiez le mode Ethernet, vousdevez redémarrer.

3. Sélectionnez Activé ou Désactivé dans le menu déroulant Réponse Ping
ICMP.

4. Cliquez sur Enregistrer.

Configuration des paramètres réseau IPv4 :

1. Dans la barre de navigation latérale, sélectionnez Vue Unités > Matériel >
Paramètres du matériel > Réseau > IPv4. L’écran Paramètres IPv4 du
matériel s’affiche.
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2. Cochez ou décochez la case Activer IPv4 pour activer ou désactiver le mode
IPv4.

3. Saisissez les informations requises dans les champs Adresse, Sous-réseau
et Passerelle.

4. Sélectionnez Activé ou Désactivé dans le menu déroulant DHCP.

Si vousactivez le modeDHCP, toutes les informations renseignéesdans les champs
Adresse, Sous-réseau et Passerelle seront ignorées.

5. Cliquez sur Enregistrer.

Configuration des paramètres réseau IPv6 :

1. Dans la barre de navigation latérale, sélectionnez Vue Unités > Matériel >
Paramètres du matériel > Réseau > IPv6. L’écran Paramètres IPv6 du
matériel s’affiche.

2. Cochez ou décochez la case Activer la configuration IPv6 avec état pour
activer ou désactiver l’option correspondante.

3. Saisissez les informations requises dans les champs Adresse, Passerelle et
Longueur du préfixe.

4. Sélectionnez Activé ou Désactivé dans le menu déroulant DHCPv6.

Si vousactivez le modeDHCPv6, toutes les informations renseignéesdans les champs
Adresse, Passerelle et Longueur du préfixe seront ignorées.

5. Cliquez sur Enregistrer.

3.6 Paramètres DNS
Vous pouvez choisir d’attribuer manuellement un serveur DNS ou d’utiliser les
adresses obtenues à l’aide de DHCP ou de DHCPv6.

Configuration manuelle des paramètres DNS :

1. Dans la barre de navigation latérale, sélectionnez Vue Unités > Matériel >
Paramètres du matériel > DNS. L’écran Paramètres DNS du matériel
s’affiche.

2. Sélectionnez Manuel, DHCP (si IPv4 activé) ou DHCPv6 (si IPv6 activé).

3. Si vous avez sélectionné Manuel, renseignez l’adresse du serveur DNS
dans les champs Primaire, Secondaire et Tertiaire.

4. Cliquez sur Enregistrer.

590-1058-640A 33



3. Configuration locale et distante

3.7 Paramètres de l’interface utilisateur locale
Modification du chemin d’accès à l’interface utilisateur locale :

1. Dans la barre de navigation latérale, cliquez sur Vue Unités > Matériel >
Paramètres du matériel > Voies > Interface utilisateur locale pour afficher
l’écran Paramètres de l’interface utilisateur de la voie locale.

2. Sous l’intitulé Appeler l’interface utilisateur de la voie locale, cochez la case
située à côté d’une ou de plusieurs méthodes.

3. Cliquez sur OK.

Paramètres utilisateur de la voie locale

Vous pouvez activer ou désactiver l’authentification pour l’interface utilisateur de
la voie locale et sélectionner un niveau d’accès utilisateur. Si vous activez
l’authentification pour l’interface utilisateur de la voie locale, vous devez fournir
vos informations de connexion à chaque utilisation de l’interface.

Vous pouvez également sélectionner la langue du clavier relié à la voie locale, la
temporisation du mode de balayage, l’activation ou la désactivation du mot de
passe de la voie de configuration et un niveau de préemption utilisateur. Le
niveau de préemption des utilisateurs détermine leur capacité ou non à
déconnecter la session série ou KVM d’un autre utilisateur sur un équipement
cible. Les niveaux de préemption vont de 1 à 4, 4 étant le niveau le plus élevé.
Par exemple, un utilisateur bénéficiant d’un niveau de préemption 4 peut
préempter la session d’autres utilisateurs de niveau 4 ainsi que ceux de niveau
 1, 2 ou 3.

Modification du niveau de préemption par défaut (administrateur uniquement)
 :

1. Dans la barre de navigation latérale, cliquez sur Vue Unités > Matériel >
Paramètres du matériel > Voies > Interface utilisateur locale pour afficher
l’écran Paramètres de l’interface utilisateur de la voie locale.

2. Cochez ou décochez la case Désactiver l’authentification de l’utilisateur de
la voie locale.

3. Dans le menu déroulant Niveau d’accès utilisateur, sélectionnez l’une des
options suivantes : Utilisateur, Administrateur d’utilisateurs ou Administrateur
de matériel.

4. Sélectionnez un niveau compris entre 1 et 4 dans le menu déroulant Niveau
de préemption de l’utilisateur.
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5. Cliquez sur Enregistrer.

3.8 Virtual Media
Vous pouvez définir le comportement du matériel au cours d’une session Virtual
Media à l’aide des options de l’écran Paramètres de session Virtual Media du
matériel. Le tableau suivant indique les différentes options de configuration des
sessions Virtual Media. Pour en savoir plus sur l’utilisation de Virtual Media dans
une session KVM, reportez-vous à la section « Virtual Media » à la page 65.

Paramètre Description

Paramètresde session :
SessionsVirtualMedia
verrouilléesdansdes
sessionsKVM

Cette option permet de verrouiller une session VirtualMedia
au niveau de la session KVM sur l’équipement cible. Si le
verrouillage est activé (paramètre par défaut), la session
VirtualMedia se ferme automatiquement lorsque l’utilisateur
quitte la session KVM. Si le verrouillage est désactivé, la
session VirtualMedia reste active lorsque l’utilisateur quitte
la session KVM.

Paramètresde session :
Autoriser les sessions
réservées

Restreint l’accèsd’une connexion VirtualMedia à un nom
d’utilisateur spécifique. Aucun autre utilisateur ne peut
établir de connexion KVM avec cet équipement cible. Selon
la configuration du paramètre Verrouillage dans la boîte de
dialogue VirtualMedia, la désactivation de la session KVM
associée sera suivie ou non de la déconnexion de la session
VirtualMedia.

Tableau 3.4 : Paramètres de session Virtual Media
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Paramètre Description

Mappage de lecteurs :
Mode d’accèsVirtualMedia

Vouspouvezdéfinir le mode d’accèsaux lecteursmappés
sur lecture seule ou sur lecture/écriture. Enmode lecture
seule, l’utilisateur ne peut pasécrire de données sur le
lecteur mappé du serveur client. Enmode lecture/écriture,
l’utilisateur peut lire desdonnéesà partir du lecteur mappé
et en écrire dessus. Si le lecteur mappé est conçu pour le
mode lecture seule uniquement (certains lecteursCD-ROM,
DVD-ROMou certaines images ISO, par exemple), le mode
d’accèsen lecture/écriture est ignoré. Il peut s’avérer
pratique de définir le mode lecture seule dans le cadre du
mappage d’un lecteur enmode lecture/écriture (tel qu’un
dispositif de stockage demasse ou un support USB
amovible) afin d’éviter qu’un utilisateur n’y écrive des
données.

Vouspouvezmapper simultanément un lecteur DVD et un
dispositif de stockage demasse. Les lecteursCD ouDVD ou
les fichiers image de disque ISOsont mappésen tant que
lecteursCD/DVD virtuels.

Niveau de cryptage

Vousavez la possibilité de configurer différents niveauxde
cryptage pour les sessionsVirtualMedia. Vouspouvez
choisir entre : Aucun (par défaut), SSL 128 bits
(ARCFOUR), DES, 3DESet AES.

Accèsà VirtualMedia par
câble adaptateur : Activer
VM/Désactiver VM

La section Accèsà VirtualMedia par câble adaptateur
dresse la liste de tous les câblesadaptateursUSB20-VGA
KVM s4. Cette liste inclut des informationsdétaillées sur
chaque câble, notamment la possibilité d’activer ou non la
fonction VirtualMedia.

Paramétrage des options Virtual Media :

1. Dans la barre de navigation latérale, cliquez sur Vue Unités > Matériel >
Paramètres du matériel > Sessions > Virtual Media pour afficher l’écran
Paramètres de session Virtual Media du matériel.

2. Cochez ou décochez la case Sessions Virtual Media verrouillées dans des
sessions KVM.

3. Cochez ou décochez la case Autoriser les sessions réservées.
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4. Dans le menu déroulant Mode d’accès Virtual Media, sélectionnez l’une des
options suivantes : Lecture seule ou Lecture/Écriture.

5. Sélectionnez le niveau de cryptage à prendre en charge.

6. Cochez la case correspondant à chaque câble adaptateur USB20-VGA KVM
 s4 pour lequel vous souhaitez activer Virtual Media, puis cliquez sur Activer
VM.

-ou-

Cochez la case correspondant à chaque câble adaptateur USB20-VGA
KVM s4 pour lequel vous souhaitez désactiver Virtual Media, puis
cliquez sur Désactiver VM.

7. Cliquez sur Enregistrer.

Paramètres Virtual Media locaux

Les utilisateurs locaux peuvent également déterminer le comportement de la
fonction Virtual Media à partir de l’écran Session locale. En plus de la connexion
et de la déconnexion d’une session Virtual Media, vous pouvez configurer les
paramètres du tableau suivant.

Tableau 3.5. Paramètres de session Virtual Media locale

Paramètre Description

CD-ROM/

DVD-ROM

Autorise des sessionsVirtualMedia au niveau du premier lecteur CD-
ROMouDVD-ROM (en lecture seule) détecté. Cochez cette case
pour établir une connexion CD-ROMouDVD-ROMVirtualMedia
vers un équipement cible. Décochez-la pour interrompre la connexion
CD-ROMouDVD-ROMVirtualMedia d’un équipement cible.

Stockage de
masse

Autorise des sessionsVirtualMedia au niveau du premier lecteur de
stockage demasse détecté. Cochez cette case pour établir une
connexion de stockage de grande capacité VirtualMedia vers un
équipement cible. Désactivez-la pour interrompre la connexion de
stockage de grande capacité VirtualMedia d’un équipement cible.

Réservée
Restreint l’accèsd’une connexion VirtualMedia à un nom d’utilisateur
spécifique. Aucun autre utilisateur ne peut établir de connexion KVM
avec cet équipement cible.

Configuration des paramètres Virtual Media locaux :

1. Dans la barre de navigation latérale, sélectionnez Session locale.
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2. Cochez la case pour activer ou décochez-la pour désactiver les options
Virtual Media.

3.9 Paramètres de modem
L’écran Paramètres de modem du matériel vous permet de configurer et
d’afficher les paramètres de modem suivants : Adresse locale, Adresse distante,
Masque de sous-réseau et Passerelle.

Pour en savoir plus sur la connexion de votre commutateur à un modem,
consultez la section « Connexion du commutateur » à la page 11.

Configuration des paramètres de modem :

1. Dans la barre de navigation latérale, cliquez sur Vue Unités > Matériel >
Paramètres du matériel > Voies > Modem pour afficher l’écran Paramètres
de modem du matériel.

2. Cochez ou décochez la case Les sessions modem peuvent préempter les
sessions numériques.

3. Dans le champ Délai d’authentification, saisissez une valeur comprise entre
30 et 300 secondes et dans le champ Délai d’inactivité, une valeur comprise
entre 1 et 60 minutes.

4. Cliquez sur Enregistrer.

3.10 Mode de balayage
En mode de balayage, le commutateur examine automatiquement les différentes
voies une à une (équipement cible par équipement cible). Vous pouvez balayer
plusieurs équipements cibles, en spécifiant les équipements de votre choix.
L’ordre de balayage est déterminé par la position des équipements cibles dans
la liste. Vous pouvez également configurer la durée écoulée avant que le
balayage ne passe à l’équipement suivant dans la séquence.

Le bouton Balayage est désactivé en casde connexion par modem.

Pour ajouter des équipements cibles à la liste de balayage :

1. Dans la barre de navigation latérale, sélectionnez Vue Unités - Équipements
cibles pour afficher l’écran correspondant.

2. Cochez les cases situées en regard des noms des équipements cibles à
balayer.

3. Cliquez sur Balayage.
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Configuration de la durée de balayage :

1. Dans la barre de navigation latérale, cliquez sur Vue Unités > Matériel >
Paramètres du matériel > Voies > Interface utilisateur locale pour afficher
l’écran Paramètres de l’interface utilisateur de la voie locale.

2. Sous l’intitulé Mode Balayage, indiquez la durée souhaitée en secondes
(comprise entre 3 et 255) dans le champ Durée du balayage (secondes).

3. Cliquez sur Enregistrer.

3.11 Adresses IP des serveurs DSView 3
Vous pouvez contacter et enregistrer un commutateur non administré à l’aide
d’un serveur DSView 3 en indiquant l’adresse IP de quatre serveurs DSView 3
maximum.

Configuration de l’adresse IP du serveur DSView 3 :

1. Dans la barre de navigation latérale, sélectionnez Vue Unités > Matériel >
Paramètres du matériel > Comptes utilisateurs > DSView 3. L’écran
Paramètres DSView 3 s’affiche.

2. Renseignez jusqu’à quatre adresses IP de serveurs logiciels DSView 3 à
contacter dans les champs Serveur 1 à 4.

3. Cliquez sur Enregistrer.

3.12 Comptes utilisateurs

Gestion des comptes locaux

L’interface Web intégrée du commutateur utilise des comptes utilisateurs définis
par l’administrateur pour plus de sécurité au niveau des connexions locales. La
fonction Local de la barre de navigation latérale permet aux administrateurs
d’ajouter ou de supprimer des utilisateurs, de définir les niveaux de préemption
et d’accès, et de modifier les mots de passe.

Niveaux d’accès

Lorsqu’un compte utilisateur est ajouté, l’utilisateur se voit attribuer l’un des
niveaux d’accès suivants : Administrateur de matériel, Administrateur
d’utilisateurs ou Utilisateur.
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Niveau d’accès

Opération Administrateur
dematériel

Administrateur
d’utilisateurs Utilisateurs

Configuration des
paramètres
système de
l’interface

Oui Non Non

Configuration des
droits d’accès

Oui Oui Non

Ajout, modification
et suppression des
comptes
utilisateurs

Oui, pour tous
les niveaux
d’accès

Oui, uniquement
pour les
utilisateurs et les
administrateurs
d’utilisateurs

Non

Modification du
mot de passe de
l’utilisateur

Oui Oui Oui

Accèsà
l’équipement cible

Oui, à tous les
équipements
cibles

Oui, à tous les
équipements
cibles

Oui, s’il est autorisé

Tableau 3.6 : Opérations autorisées par niveau d’accès

Ajout d’un nouveau compte utilisateur (administrateur uniquement) :

1. Dans la barre de navigation latérale, cliquez sur Vue Unités > Matériel >
Paramètres du matériel > Comptes utilisateurs > Local pour afficher l’écran
Comptes utilisateurs locaux du matériel.

2. Cliquez sur le bouton Ajouter.

3. Saisissez le nom et le mot de passe du nouvel utilisateur dans les espaces
prévus à cet effet.

4. Sélectionnez les niveaux de préemption et d’accès.

5. Sélectionnez les équipements cibles disponibles à affecter au compte
utilisateur et cliquez sur Ajouter.
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Lesadministrateurs d’utilisateurs et les administrateurs dematériel ont accèsà tous les
équipements cibles.

6. Cliquez sur Enregistrer.

Suppression d’un compte utilisateur (administrateur uniquement) :

1. Dans la barre de navigation latérale, cliquez sur Vue Unités > Matériel >
Paramètres du matériel > Comptes utilisateurs > Local pour afficher l’écran
Comptes utilisateurs locaux du matériel.

2. Cochez la case en regard de chacun des comptes à supprimer, puis cliquez
sur le bouton Supprimer.

Modification d’un compte utilisateur (administrateur ou utilisateur actif
uniquement) :

1. Dans la barre de navigation latérale, sélectionnez Vue Unités > Matériel >
Paramètres du matériel > Comptes utilisateurs > Local. L’écran Comptes
utilisateurs locaux du matériel s’affiche.

2. Cliquez sur le nom de l’utilisateur dont vous souhaitez modifier le compte.
Son profil s’affiche.

3. Saisissez les informations relatives à l’utilisateur, puis cliquez sur
Enregistrer.

3.13 Paramètres SNMP
SNMP est un protocole utilisé pour la communication des informations
d’administration entre les applications d’administration réseau et le commutateur.
D’autres gestionnaires SNMP peuvent communiquer avec votre commutateur en
accédant à la base de données MIB-II et à la partie publique de la base de
données MIB de l’entreprise. Lorsque vous accédez à l’écran SNMP, l’interface
Web intégrée récupère les paramètres SNMP de l’unité.

L’écran SNMP vous permet de saisir les informations relatives au système et les
chaînes de communauté. Vous pouvez également désigner quelles stations
peuvent administrer le commutateur et recevoir des interruptions SNMP du
commutateur. Si vous sélectionnez Activer SNMP, l’unité répond aux requêtes
SNMP par le biais de la voie UDP 161.

Configuration des paramètres SNMP généraux :

1. Sélectionnez Vue Unités > Matériel > Paramètres du matériel > SNMP >
Paramètres SNMP afin d’afficher l’écran SNMP.
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2. Cochez la case Activer SNMP pour permettre au commutateur de répondre
aux demandes SNMP par la voie UDP 161.

3. Saisissez le nom de domaine complet du système dans le champ Nom de
même que les coordonnées de la personne à contacter dans le champ
Contact.

4. Sous Communauté, renseignez les champs Lecture, Écriture et Interruption.
Ces champs précisent les chaînes de communauté devant être utilisées
dans les actions SNMP. Les chaînes Lecture et Écriture s’appliquent
uniquement au protocole SNMP via la voie UDP 161 et servent de mots de
passe destinés à protéger l’accès au commutateur. Elles peuvent comporter
jusqu’à 64 caractères. Ces champs sont obligatoires.

5. Saisissez l’adresse de quatre stations de gestion maximum, qui seront
autorisées à administrer le commutateur dans les champs Gestionnaires
autorisés. Vous pouvez également laisser ces champs vides pour permettre
à toutes les stations d’administrer le commutateur.

6. Cliquez sur Enregistrer.

3.14 Paramètres des événements
Un événement est un avis envoyé par le commutateur à une station de gestion,
indiquant qu’un événement inhabituel s’est produit et peut nécessiter votre
attention.

Activation des événements individuels :

1. Sélectionnez Vue Unités > Matériel > Paramètres du matériel > Audit >
Événements afin d’afficher l’écran Événements.

2. Spécifiez les événements générant des notifications en cochant les cases
correspondantes dans la liste.

-ou-

Cochez ou décochez la case située à côté de l’intitulé Nom de
l’événement afin de sélectionner ou de désélectionner toute la liste.

3. Cliquez sur Enregistrer.

3.15 Configuration des destinations d’événements
Vous pouvez configurer les événements d’audit à envoyer à des destinations
d’interruptions SNMP et à des serveurs Syslog. Les événements activés sur
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l’écran Événements sont transmis à tous les serveurs figurant sur l’écran
Destinations des événements.

1. Sélectionnez Vue Unités > Matériel > Paramètres du matériel > Audit >
Destinations afin d’afficher l’écran Destinations des événements.

2. Dans les champs Destinations des interruptions SNMP, saisissez l’adresse
de quatre stations de gestion maximum, auxquelles ce commutateur peut
envoyer des interruptions, ainsi que quatre serveurs Syslog maximum.

3. Cliquez sur Enregistrer.

3.16 Configuration des câbles adaptateurs
Le commutateur vous permet d’afficher la liste des câbles adaptateurs reliés,
ainsi que les informations suivantes relatives à chaque câble : numéro eID
(identifiant électronique), voie, état, application, type d’interface et vitesse USB.
Cliquez sur le câble de votre choix pour afficher les informations
complémentaires suivantes : type de commutateur, version de démarrage,
version du matériel, version FPGA, version disponible et état de la mise à jour.

Vous pouvez également effectuer les tâches suivantes : supprimer les câbles
adaptateurs hors ligne, mettre à jour le firmware du câble, définir la vitesse USB
ou mettre les câbles hors service.

Suppression des câbles adaptateurs hors ligne :

1. Dans la barre de navigation latérale, cliquez sur Vue Unités > Matériel >
Paramètres du matériel > Voies > Câbles adaptateurs pour afficher l’écran
Câbles adaptateurs du matériel.

2. Cliquez sur Supprimer les équipements hors ligne.

Définition de la vitesse USB (câbles adaptateurs USB20-VGA KVM s4
uniquement) :

1. Dans la barre de navigation latérale, cliquez sur Vue Unités > Matériel >
Paramètres du matériel > Voies > USB20-VGA pour afficher l’écran USB20-
VGA du matériel.

2. Cochez les cases à côté des câbles à modifier.

3. Sélectionnez ensuite l’option Configurer à la vitesse de transfert USB 1.1 ou
Configurer à la vitesse de transfert USB 2.0.
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Mise à jour des câbles adaptateurs

L’option de mise à jour Flash des câbles adaptateurs permet aux administrateurs
de mettre à jour les câbles adaptateurs à l’aide du dernier firmware disponible.
Cette mise à jour peut être effectuée à l’aide de l’interface utilisateur du
commutateur ou du logiciel DSView 3.

Une fois la mémoire Flash à jour, le commutateur redémarre à chaud, ce qui
interrompt toutes les sessions des câbles adaptateurs. Il se peut que les
équipements cibles sur lesquels le firmware du câble adaptateur est en cours de
mise à jour ne s’affichent pas ou soient signalés comme déconnectés. Ils sont à
nouveau visibles normalement dès que la mise à jour Flash est terminée.

Si le matériel est configuré pour la mise à jour automatique des câbles
adaptateurs, ceux-ci sont automatiquement mis à jour en même temps que le
commutateur. Pour mettre à jour le firmware de votre commutateur, reportez-vous
à la section « Outils du commutateur KVM s4 » à la page 30 ou à l’aide en ligne
du logiciel DSView 3. En cas de problème durant le processus de mise à jour
normal, les câbles adaptateurs peuvent faire l’objet d’une mise à jour forcée.

Lesdernières versionsdes firmwares sont disponibles sur le site
http://www.ts.fujitsu.com.

Mise à jour du firmware des câbles adaptateurs :

1. Dans la barre de navigation latérale, cliquez sur Vue Unités > Matériel >
Paramètres du matériel > Voies > Câbles adaptateurs pour afficher l’écran
Câbles adaptateurs du matériel.

2. Cochez les cases situées à côté des câbles adaptateurs à mettre à jour et
cliquez sur Mettre à jour.

AVERTISSEMENT : La déconnexion d’un câble adaptateur ou lamise hors tension
puis sous tension de l’équipement cible pendant unemise à jour du firmware rend le
câble adaptateur inopérationnel et vousoblige à le retourner à l’usine pour réparation.

3.17 Paramètres de la PDU
Seul un administrateur peut modifier les paramètresdesPDU.

L’écran PDU du matériel affiche la liste des PDU reliées, ainsi que les
informations suivantes relatives à chacune d’entre elles : Nom, Voie, État,
Version, Modèle, Alarme sonore, Alarme et Température. Vous pouvez
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également sélectionner une PDU, puis cliquer sur Paramètres pour afficher les
informations suivantes : Nom, Description, État, Version, Prises, Nom du
fournisseur, Modèle et Entrées.

Lorsqu’un équipement cible est connecté à une prise de PDU, vous pouvez le
mettre sous tension, hors tension ou le redémarrer.

Pour mettre sous tension, hors tension ou redémarrer un équipement cible :

1. Dans la barre de navigation latérale, cliquez sur Vue Unités > Matériel >
Paramètres du matériel > Voies > PDU pour afficher l’écran PDU du
matériel.

2. Cliquez sur le nom de l’unité à configurer, puis sélectionnez Prises.

3. Cochez la case en regard des prises à configurer.

4. Cliquez sur Marche, Arrêt ou Redémarrer selon l’action souhaitée.

Suppression des PDU hors ligne :

1. Dans la barre de navigation latérale, cliquez sur Vue Unités > Matériel >
Paramètres du matériel > Voies > PDU pour afficher l’écran PDU du
matériel.

2. Cliquez sur Supprimer les équipements hors ligne.

Modification des valeurs minimales de mise sous tension, de mise hors
tension ou d’éveil :

1. Dans la barre de navigation latérale, cliquez sur Vue Unités > Matériel >
Paramètres du matériel > Voies > PDU pour afficher l’écran PDU du
matériel.

2. Cliquez sur le nom de l’unité à configurer, puis sélectionnez Prises.

3. Cliquez sur le nom de la prise à modifier.

4. Modifiez les paramètres de votre choix à l’aide des listes déroulantes, puis
cliquez sur Enregistrer.

Serveurs cibles et prises associés

L’affectation d’un même nom de serveur cible à plusieurs prises électriques
permet d’associer ces prises au serveur en question pour un contrôle plus aisé.
La page Équipements cibles de l’interface Web intégrée permet de sélectionner
plusieurs options de contrôle de l’alimentation pour chaque équipement cible
associé à des prises. Le tableau Alimentation secteur de la page Présentation de
l’unité indique les prises associées à un équipement cible.
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Dans la figure suivante, l’équipement cible Server2 est associé à des prises.
Cliquez sur la flèche du menu déroulant de la colonne Action pour afficher les
options d’alimentation supplémentaires disponibles.

Figure 3.2. Équipements cibles

Dans la figure suivante, la page Présentation de l’unité relative au serveur intitulé
Server2 indique que la prise 1 et la prise 9 de la PDU 1 sont associées à Server2
dans la section Alimentation secteur.

Figure 3.3. Aperçu des équipements cibles pour Server2

Groupement de prises

Vous pouvez attribuer un même nom à plusieurs prises afin de les regrouper au
sein d’un même groupe listé comme un seul équipement cible. Les actions
d’alimentation effectuées sur la page Équipements cibles s’appliquent alors à
toutes les prises concernées. Les options de contrôle de l’alimentation relatives à
des prises d’alimentation spécifiques peuvent être configurées sur la page
Présentation de l’unité. Dans la figure suivante, la cible Group2 se compose des
prises d’alimentation 4 et 5 de la PDU 1.
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Figure 3.4. Aperçu des équipements cibles de Group2

Noms des prises par défaut

Sur la page PDU, la case Attribuer des noms par défaut aux prises permet
d’activer l’attribution de noms par défaut aux prises d’une PDU, comme illustré à
la figure suivante. Seules les prises auxquelles un nom a été attribué
apparaissent sur la page de l’équipement cible. Pour supprimer les noms de
prises attribués par défaut, décochez la case Attribuer des noms par défaut aux
prises. Pour attribuer des noms par défaut aux prises sans nom, cochez la case
Attribuer des noms par défaut aux prises et sauvegardez.

Figure 3.5. Page PDU du matériel

Attribution d’un nom à une prise

La page Paramètres de la prise de la PDU propose trois options d’attribution de
nom aux prises, illustrées dans la figure suivante. Sous Affectation du nom, trois
options sont disponibles : Manuelle, Associer à l’équipement cible et Ne pas
afficher en tant qu’équipement cible.
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Figure 3.6. Page Paramètres de la prise de la PDU

• L’option Manuelle permet d’attribuer un nom unique à la prise. Ce nom doit
être unique pour tous les câbles adaptateurs et prises. La tentative
d’attribution manuelle d’un nom qui ne soit pas unique génère une erreur et
il est alors impossible d’enregistrer le nom.

• L’option Associer à l’équipement cible associe la prise à un autre nom de
cible (une prise ou un câble adaptateur) pour le contrôle de l’alimentation de
l’équipement en question. Lorsqu’une prise est associée à un nom de câble
adaptateur cible, elle fournit généralement l’alimentation du serveur relié à
ce câble.

• L’option Ne pas afficher en tant qu’équipement cible attribue un nom vierge
à la prise, l’empêchant ainsi d’apparaître sur la page Équipements cibles.
Cette option peut être utile pour supprimer les prises de réserve de la page
Équipements cibles.

Héritage du contrôle d’accès

Lorsque le nom d’une prise est associé à un équipement cible, la prise hérite des
paramètres de contrôle d’accès configurés pour la cible en question. Ainsi, lors
de l’ajout d’un câble adaptateur, si le nom récupéré du câble correspond au nom
d’un équipement cible existant, le nouveau câble hérite des paramètres de
contrôle d’accès de cet équipement cible. La modification du nom d’un
équipement cible entraîne la modification de tous les noms des câbles
adaptateurs et prises associés à cet équipement, tandis que les paramètres de
contrôle d’accès configurés pour l’ancien nom restent valables.

Modification du nom d’un équipement cible

Le nom d’un équipement cible peut être modifié en un nom unique sur la page
Présentation de l’unité. Le nom doit alors être unique pour l’ensemble des cibles,
y compris les câbles adaptateurs et prises d’alimentation. La modification du nom
d’un équipement cible entraîne la modification du nom de toutes les prises
associées, qui héritent simplement du nouveau nom de l’équipement cible.

Niveaux de priorité des équipements cibles

Sur la page Équipements cibles, un équipement cible associé à des prises
d’alimentation contrôle plusieurs équipements. La valeur affichée dans le champ
État d’un équipement cible donné correspond à la valeur d’état de plus haute
priorité parmi tous les équipements reliés. Le tableau suivant répertorie les
valeurs d’état possibles par ordre de priorité décroissant et les types
d’équipements cibles applicables.
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Valeur d’état Applicable à : Description de l’état

Câble
adaptateur Prise

Utilisé x S.O. Une session est active

Chemin bloqué x S.O. Le chemin d’accèsà la cible est utilisé par
une autre session

Mise à jour x S.O. Câble adaptateur en cours demise à
jour

Mise sous
tension S.O. x Une ou plusieurs prisesen cours demise

sous tension

Mise hors
tension S.O. x Une ou plusieurs prisesen cours demise

hors tension

Aucune
alimentation x S.O. Aucune alimentation détectée sur le

câble adaptateur

Partiellement
sous tension S.O. x L’équipement cible présente desprises

sous tension et despriseshors tension

Verrouillage
désactivé S.O. x Une ou plusieurs prises sont verrouillées

sous tension

Hors tension S.O. x Une ou plusieurs prises sont hors
tension

Verrouillage
activé S.O. x Une ou plusieurs prises sont verrouillées

hors tension

Inactif x S.O. Aucune session active, câble adaptateur
alimenté

Sous tension S.O. x Lesprises sont sous tension

Tableau 3.7 : Valeurs d’état des équipements cibles

Lorsqu’un équipement cible compte plusieurs prises d’alimentation présentant le
même nom mais des états d’alimentation différents, le matériel peut considérer
l’état Verrouillé hors tension comme l’état Hors tension et l’état Verrouillé sous
tension comme l’état Sous tension. Le tableau suivant répertorie les valeurs
d’état résultant de la combinaison de deux valeurs d’état.
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État de la prise 1 État de la prise 2 État résultant

Hors tension Hors tension Hors tension

Hors tension Sous tension Partiellement sous tension

Sous tension Sous tension Sous tension

Verrouillage activé Sous tension Sous tension

Verrouillage activé Verrouillage activé Verrouillage activé

Verrouillage activé Hors tension Partiellement sous tension

Verrouillage
désactivé Sous tension Partiellement sous tension

Verrouillage
désactivé

Verrouillage
désactivé Verrouillage désactivé

Verrouillage
désactivé Hors tension Hors tension

Verrouillage activé Verrouillage
désactivé Partiellement sous tension

Tableau 3.8 : Valeurs d’état multiples et état affiché

Page Session locale de la voie locale

La page Session locale de la voie locale affiche trois options de contrôle de
l’alimentation pour la session active lorsque l’équipement cible de la session
active est associé à des prises d’alimentation. La figure suivante illustre les
options de contrôle de l’alimentation affichées pour la session active de la voie
locale de l’équipement cible Server2.

Figure 3.7. Page Session locale avec options de contrôle de l’alimentation
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4.1 Fenêtre du visualiseur vidéo
Le visualiseur vidéo permet d’ouvrir une session KVM sur les équipements cibles
reliés à un commutateur via l’interface Web intégrée. Lors de la connexion à un
équipement à l’aide du visualiseur vidéo, le bureau de l’équipement s’affiche
dans une nouvelle fenêtre sur laquelle apparaissent le curseur local et le curseur
de l’équipement cible.

Le logiciel de l’interface Web intégrée du commutateur exécute un programme
Java pour afficher la fenêtre du visualiseur vidéo. L’interface Web intégrée du
commutateur télécharge et installe automatiquement le visualiseur vidéo lors de
sa première ouverture.

Java version 1.6.0_11 ou ultérieure est requis pour lancer une session.

L’interfaceWeb intégrée du commutateur n’installe pas JRE (Java Runtime
Environment). Il peut être téléchargé gratuitement à l’adresse http://www.sun.com.

L’interfaceWeb intégrée du commutateur utilise la mémoire système pour stocker et
afficher des imagesdans les fenêtresdu visualiseur vidéo. Pour chaque fenêtre
supplémentaire du visualiseur vidéo, de lamémoire supplémentaire est requise. Un
réglage couleur 8 bits sur le serveur client requiert 1,4 Mo demémoire par fenêtre du
visualiseur ; un réglage 16 bits, 2,4 Mo ; et un réglage 32 bits 6,8 Mo. Si vousessayez
d’ouvrir plus de fenêtresque le nombre pris en charge par la mémoire système
(habituellement quatre), unmessage d’erreur indiquant un espacemémoire insuffisant
s’affiche et la fenêtre ne s’ouvre pas.

Si un autre utilisateur est en train de visualiser l’équipement cible auquel vous
essayez d’accéder, vous pouvez préempter l’autre utilisateur en question si vous
bénéficiez d’un niveau de préemption supérieur ou égal au sien. Les
administrateurs de matériel peuvent également déconnecter un utilisateur actif
via la page Session active. Pour en savoir plus, reportez-vous à la section «
Sessions du commutateur KVM s4 » à la page 27.
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Figure 4.1. Fenêtre du visualiseur vidéo (mode d’affichage normal)

Tableau 4.1. Description de la Figure 4.1

Numéro Description

1
Barre de titre : affiche le nom de l’équipement cible en cours de
visualisation. Enmode plein écran, la barre de titre disparaît et le nom de
l’équipement cible s’affiche entre le menu et la barre d’outils.

2
Punaise : verrouille l’affichage dumenu et de la barre d’outils de sorte
qu’ils soient toujours visibles.

3

Menu et barre d’outils : permettent d’accéder à de nombreuses
fonctionsdu visualiseur vidéo. Si la punaise n’est pasactivée, le menu et
la barre d’outils sont enmodemasquage automatique. Placez le curseur
au niveau de la barre d’outils pour afficher le menu et la barre d’outils. La
barre d’outils peut afficher jusqu’à dix boutonsde commande et/ou de
groupe demacros. LesboutonsMode curseur simple, Actualiser,
Réglage vidéo automatique et Aligner curseur local s’affichent par
défaut sur la barre d’outils. Pour en savoir plus, reportez-vousaux
sections«Modification de la barre d’outils » à la page 53 et «Macros» à
la page 72.
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Numéro Description

4
Boutonsdemacros : combinaisonsde touches régulièrement utilisées
pouvant être envoyéesà l’équipement cible.

5 Bouton Réduire : réduit l’affichage de la fenêtre du visualiseur vidéo à un
bouton de la barre des tâches, en basde l’écran de l’ordinateur local.

6

Bouton Agrandir : fait passer la taille de la fenêtre aumode plein écran
de sorte que le bureau de l’équipement visualisé s’affiche en plein écran.
L’agrandissement de la fenêtre a les conséquences suivantes :

La barre de titre disparaît.

Le nom de l’équipement cible s’affiche entre le menu et la barre d’outils.

Le bouton Agrandir se transforme en boutonMode d’affichage normal
qui apparaît dans la barre d’outils. Cliquezdessuspour faire basculer la
fenêtre du visualiseur enmode d’affichage normal.

Le bouton de fermeture s’affiche dans la barre d’outils.

7

Bouton de fermeture : ferme la fenêtre du visualiseur vidéo.

NOTA : Le bouton de fermeture ne s’affiche pas sur tous les systèmes
d’exploitation.

8
Bureau de l’équipement auquel vousaccédez : communique avec
l’équipement grâce à cette fenêtre.

9 Cadre : redimensionne la fenêtre du visualiseur vidéo lorsque vous
cliquezet maintenez le bouton de la souris enfoncé sur le cadre.

Modification de la barre d’outils

Vous pouvez définir le délai au bout duquel la barre d’outils disparaît lorsqu’elle
se trouve en mode masquage automatique (c’est-à-dire, non verrouillée à l’aide
de la punaise).

Pour définir la durée de masquage de la barre d’outils :

1. Sélectionnez Outils > Options de session dans le menu du visualiseur vidéo.

-ou-

Cliquez sur le bouton Options de session.

La boîte de dialogue Options de session s’affiche.

2. Cliquez sur l’onglet Barre d’outils.
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3. À l’aide des touches fléchées, indiquez le délai en secondes avant le
masquage de la barre d’outils.

4. Cliquez sur OK pour enregistrer les modifications et fermer la boîte de
dialogue.

4.2 Lancement d’une session
En casd’utilisation d’une connexion sansproxy, les performances vidéo par une
connexion réseau plus lente risquent de ne pasêtre optimales. Certains paramètresde
couleur (tels que Niveauxde gris) utilisent moinsde bande passante réseau que
d’autres (tels que Couleur optimale). Par conséquent, la modification desparamètres
de couleur peut améliorer les performances vidéo. Pour desperformances vidéo
optimales sur une connexion réseau lente, utilisez les paramètresde couleur Niveaux
de gris/Compression optimale ou Couleur basse/Haute compression. Pour en savoir
plus, reportez-vousà la section « Réglage de l’affichage » à la page 55.

Si un utilisateur se connecte à un équipement cible avecune résolution supérieure à
celle de l’ordinateur local, la fenêtre du visualiseur vidéo contient uniquement une partie
de l’écran de l’équipement cible et desbarresde défilement pour afficher le reste de cet
écran. L’utilisateur peut afficher l’écran en entier en réglant la résolution de
l’équipement cible, de l’ordinateur local ou desdeux.

Pour lancer une session KVM à partir de la fenêtre de l’explorateur du
commutateur :

1. Cliquez sur un équipement de la liste figurant sur l’écran Équipements cibles
pour ouvrir la fenêtre Présentation de l’unité.

2. Cliquez sur Session KVM pour ouvrir le visualiseur vidéo dans une nouvelle
fenêtre.

Délai d’expiration de la session

La session à distance peut expirer en cas d’inactivité de la fenêtre de session
pendant une durée spécifiée. Le délai d’inactivité est configuré dans la fenêtre
Paramètres de session KVM du matériel. La valeur configurée pour le délai
d’inactivité est utilisée à la prochaine utilisation de l’interface Web intégrée du
commutateur.

Pour activer, désactiver ou configurer le délai d’expiration de la session :

1. Dans la barre de navigation latérale, sélectionnez Vue Unités > Matériel >
Paramètres du matériel > Sessions > Général.
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2. Sélectionnez le paramètre de votre choix dans le champ Activer le délai
d’inactivité.

3. Si nécessaire, sélectionnez une limite de temps d’inactivité.

4. Cliquez sur Enregistrer.

4.3 Taille de la fenêtre
La commande Affichage >Mise à l’échelle n’est pasdisponible enmode plein écran ou
auxutilisateurs secondairesd’une session partagée.

Lors de la première utilisation de l’interface Web intégrée du commutateur, les
fenêtres du visualiseur vidéo s’affichent par défaut avec une résolution de 1024 x
 768. Cette résolution est conservée tant que vous ne la modifiez pas. Toutes les
fenêtres du visualiseur peuvent avoir une résolution différente.

L’interface Web intégrée du commutateur règle automatiquement l’affichage si la
taille de la fenêtre est modifiée au cours d’une session et à condition que la mise
à l’échelle automatique soit activée. Si la résolution de l’équipement cible est
modifiée en cours de session, l’affichage est automatiquement ajusté.

Pour modifier la résolution de la fenêtre du visualiseur vidéo :

1. Sélectionnez la commande Affichage > Mise à l’échelle.

2. Sélectionnez la résolution de votre choix.

4.4 Réglage de l’affichage
Les menus et les boutons de la barre des tâches de la fenêtre du visualiseur
permettent de réaliser les tâches suivantes :

• Aligner les curseurs de souris.

• Actualiser l’écran.

• Activer ou désactiver le mode plein écran. En mode plein écran, l’image est
réglée pour que la résolution maximale du bureau soit de 1600 x 1200 ou
1680 x 1050 (écran large). Si la résolution du bureau est supérieure :

• L’image en plein écran est centrée sur le bureau et les zones entourant
la fenêtre du visualiseur s’affichent en noir.

• Les barres de menus et d’outils sont verrouillées de manière à être
visibles à tout moment.
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• Activer la mise à l’échelle automatique, totale ou manuelle de l’image de la
session :

• En mise à l’échelle totale, la fenêtre du bureau est fixe et l’image de
l’équipement est redimensionnée à la taille de la fenêtre.

• En mise à l’échelle automatique, la fenêtre du bureau est
redimensionnée de manière à correspondre à la résolution de
l’équipement cible visualisé.

• En mise à l’échelle manuelle, un menu déroulant des résolutions prises
en charge s’affiche.

• Modifier la profondeur d’échantillonnage de l’image d’une session.

Pour aligner les curseurs de souris :

Cliquez sur le bouton Aligner curseur local dans la barre d’outils du visualiseur
vidéo. Le curseur local s’aligne alors sur celui de l’équipement distant.

Si les curseurs présentent desproblèmesd’alignement, désactivez le paramètre
d’accélération de la souris au niveau de l’équipement cible.

Pour actualiser l’affichage, cliquez sur le bouton Actualiser image de la fenêtre
du visualiseur vidéo ou sélectionnez Affichage > Actualiser dans le menu du
visualiseur vidéo. L’image vidéo numérisée est alors entièrement régénérée.

Pour activer le mode plein écran, cliquez sur le bouton Agrandir ou sélectionnez
Affichage > Plein écran dans le menu du visualiseur vidéo. La fenêtre du bureau
disparaît et seul le bureau de l’équipement visualisé s’affiche. L’écran est
redimensionné jusqu’à une résolution maximale de 1600 x 1200 ou 1680 x 1050
(écran large). Si la résolution du bureau est supérieure, un fond noir entoure
l’image en plein écran. La barre d’outils flottante s’affiche.

Pour désactiver le mode plein écran et revenir à la fenêtre du bureau, cliquez sur
le bouton Mode plein écran dans la barre d’outils flottante.

Pour activer la mise à l’échelle totale, sélectionnez Affichage > Mise à l’échelle
dans le menu du visualiseur vidéo. L’image de l’équipement est
automatiquement redimensionnée à la résolution de l’équipement cible
visualisé.

Pour activer la mise à l’échelle manuelle, sélectionnez Affichage > Mise à
l’échelle dans le menu du visualiseur vidéo. Sélectionnez les dimensions de la
fenêtre. Les valeurs de mise à l’échelle disponibles varient en fonction du
système.
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4.5 Actualisation de l’image
Cliquez sur le bouton Actualiser image de la boîte de dialogue Réglage vidéo
manuel pour régénérer entièrement l’image vidéo numérisée.

Pour actualiser l’image, vouspouvezégalement sélectionner Affichage >Actualiser
dans lemenu du visualiseur vidéo.

4.6 Paramètres vidéo

Réglage vidéo supplémentaire

En général, les fonctions de réglage automatique du visualiseur offrent un
affichage vidéo optimal. Vous avez cependant la possibilité d’ajuster le réglage
de cet affichage avec l’aide d’un représentant de l’assistance technique Fujitsu
en sélectionnantOutils > Réglage vidéo manuel de la barre de menus du
visualiseur vidéo ou en cliquant sur le bouton Réglage vidéo manuel. La boîte de
dialogue Réglage vidéo manuel s’affiche. Le réglage de la vidéo s’effectue
équipement par équipement.

Vous pouvez vérifier le niveau de paquets par seconde nécessaire pour un
écran statique en observant la vitesse affichée dans le coin inférieur gauche de
la boîte de dialogue.

Pour régler manuellement la qualité vidéo de la fenêtre :

Les réglages vidéo suivants doivent être configurésuniquement avec l’aide d’un
représentant de l’assistance technique Fujitsu.

1. Sélectionnez Outils > Réglage vidéo manuel dans le menu du visualiseur
vidéo.

-ou-

Cliquez sur le bouton Réglage vidéo manuel.

La boîte de dialogue Réglage vidéo manuel s’affiche.
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Figure 4.2. Boîte de dialogue Réglage vidéo manuel

Numéro Description Numéro Description

1
Largeur de capture
d’image

8 Niveau sonore despixels

2
Réglage fin de
l’échantillonnage de
pixels

9 Réglage vidéo automatique

3
Position horizontale
de la capture
d’image

10 Actualiser image

4
Position verticale de
la capture d’image

11 Barre de réglage

5 Contraste 12 Modèle d’essai vidéo

6 Luminosité 13 Indicateur de performance

7
Bloquer le niveau
de bruit

14 Bouton Fermer

Tableau 4.2 : Description de la Figure 4.2
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2. Cliquez sur l’icône correspondant à la fonction que vous souhaitez régler.

3. Déplacez le curseur de contraste, puis affinez le réglage en cliquant sur le
bouton Min (-) ou Max (+) pour chaque paramètre sélectionné. Les réglages
sont immédiatement appliqués dans la fenêtre du visualiseur vidéo.

4. Lorsque vous avez terminé, cliquez sur Fermer pour quitter la boîte de
dialogue Réglage vidéo manuel.

Paramètres vidéo cibles

Les commandes de réglage Largeur de capture d’image, Réglage fin de
l’échantillonnage de pixels, Position horizontale de la capture d’image et
Position verticale de la capture d’image agissent sur la capture et la numérisation
de l’image de l’équipement cible. Elles sont rarement modifiées.

Les paramètres de capture d’image sont modifiés automatiquement par la
fonction de réglage automatique. La cible doit avoir une image particulière afin
d’effectuer des réglages indépendants précis.

Réglage vidéo automatique

Dans la plupart des cas, vous n’avez pas besoin de modifier les paramètres
d’affichage vidéo par défaut. Le système ajuste et optimise automatiquement les
paramètres d’affichage. L’interface Web intégrée du commutateur offre des
performances optimales lorsque les paramètres d’affichage sont réglés de sorte
qu’aucun (0) paquet de données vidéo ne soit transmis pour un écran statique.

Pour régler les paramètres vidéo sur les valeurs optimales, cliquez sur le bouton
Réglage vidéo automatique de la boîte de dialogue Réglage vidéo manuel.

Vouspouvezégalement régler automatiquement les paramètres vidéo en
sélectionnantOutils >Réglage vidéo automatique dans lemenu du visualiseur vidéo ou
en cliquant sur l’icône de barre d’outilsRéglage vidéo automatique.

Modèle d’essai vidéo

Pour basculer vers l’affichage d’un modèle d’essai vidéo, cliquez sur le bouton
Modèle d’essai vidéo de la boîte de dialogue Réglage vidéo manuel. Cliquez à
nouveau sur ce bouton pour revenir à l’affichage normal.

Paramètres vidéo spécifiques aux fournisseurs

Les paramètres vidéo varient considérablement selon les fabricants.
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4.7 Paramètres de couleur

Réglage de la profondeur d’échantillonnage

L’algorithme DVC permet aux utilisateurs de spécifier le nombre de couleurs
affichables dans une fenêtre de session distante. Vous pouvez choisir
d’augmenter le nombre de couleurs pour une meilleure fidélité de reproduction
ou de le diminuer afin de réduire le volume des données transmises sur le
réseau.

Les paramètres d’affichage des fenêtres du visualiseur vidéo sont : Couleur
optimale disponible (actualisations plus lentes), Compression optimale
(actualisations plus rapides), une combinaison des deux ou le mode Échelle de
gris.

Pour définir la profondeur d’échantillonnage des voies et des canaux individuels,
sélectionnez la commande Affichage > Couleur dans la fenêtre de la session à
distance. Ces paramètres sont enregistrés séparément pour chaque canal.

Contraste et luminosité

Si l’image du visualiseur vidéo est trop sombre ou trop claire, sélectionnez Outils
> Réglage vidéo automatique ou cliquez sur le bouton Réglage vidéo
automatique. Cette commande est également disponible dans la boîte de
dialogue correspondante. Dans la plupart des cas, cette opération permet de
corriger le problème.

Au cas où l’activation répétée de la commande Réglage vidéo automatique n’est
pas suffisante pour corriger le contraste et la luminosité, vous pouvez les régler
manuellement. Augmentez la luminosité. Ne l’augmentez pas de plus de 10
 incréments avant de passer au réglage du contraste. En général, il suffit de
modifier légèrement le contraste.

4.8 Paramètres de bruit

Seuils de détection

Dans certains cas, le bruit de la transmission vidéo maintient le nombre de
paquets par seconde à une valeur élevée, indiquée par l’apparition de petits
points autour du curseur lorsqu’il se déplace. La modification des valeurs de
seuil permet d’améliorer l’affichage à l’écran et le tracé du curseur.

Si vous utilisez une compression vidéo standard, vous pouvez modifier les
valeurs Niveau de bruit et Seuil de priorité. Vous pouvez également modifier les
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valeurs Bloquer le niveau de bruit et Niveau sonore des pixels. Pour restaurer les
valeurs de seuil par défaut, cliquez sur Réglage vidéo automatique.

Bloquer le niveau de bruit et Niveau sonore des pixels

Les valeurs Bloquer le niveau de bruit et Niveau sonore des pixels définissent
les niveaux minimaux de couleur en termes de nombre autorisé de blocs vidéo et
de pixels modifiés pour mille.

• Le paramètre Bloquer le niveau de bruit détermine la modification minimale
de couleur dans un même bloc vidéo. L’augmentation de ce seuil réduit la
bande passante du réseau. Sa diminution entraîne la réduction de la taille
de ces artéfacts.

• Le paramètre Niveau sonore des pixels détermine la modification minimale
de couleur dans un même pixel. La diminution de ce seuil réduit le nombre
d’artéfacts de faible contraste mais augmente la bande passante du réseau.

Pour en savoir plus sur la modification de la profondeur d’échantillonnage,
reportez-vous à la section « Réglage de l’affichage » à la page 55.

4.9 Paramètres de la souris

Réglage des options de la souris

Les options de la souris du visualiseur concernent le type de curseur, le mode de
curseur, la mise à l’échelle, l’alignement et la réinitialisation. Les paramètres de
la souris s’appliquent à un équipement particulier. Ils peuvent varier d’un
équipement à un autre.

Si l’équipement ne permet pasde débrancher et de rebrancher la souris
(contrairement auxpossibilités offertes par la plupart desPC récents), la souris est
alors désactivée et l’équipement doit être redémarré.

Type de curseur

Le visualiseur vidéo offre cinq options de curseur local. Vous avez également la
possibilité de n’utiliser aucun curseur ou de garder le curseur par défaut.

En mode curseur simple, l’affichage du curseur local (secondaire) dans le
visualiseur est désactivé et seul le pointeur de la souris de l’équipement cible est
visible. Seuls les mouvements de la souris de l’équipement cible apparaissent à
l’écran. Utilisez le mode curseur simple lorsqu’aucun curseur local n’est
nécessaire.
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Figure 4.3. Curseurs local et distant affichés dans la fenêtre du visualiseur vidéo

Numéro Description

1 Curseur distant

2 Curseur local

Tableau 4.3 : Description de la Figure 4.3

Le mode de curseur actif dans le visualiseur s’affiche dans la barre de titre,
accompagné du raccourci clavier permettant de quitter le mode curseur simple.
Vous pouvez définir ce raccourci clavier dans la boîte de dialogue Options de
session.

En casd’utilisation d’un équipement capturant les frappesau clavier avant qu’elles
n’atteignent le client, il est recommandé d’éviter d’utiliser ces frappespour restaurer le
pointeur de la souris.

Pour activer le mode Curseur simple, sélectionnez Outils > Mode curseur simple
dans le menu du visualiseur vidéo ou cliquez sur le bouton Mode curseur simple.
Le curseur local ne s’affiche pas. Tous les mouvements observés sont ceux de
l’équipement cible.
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Pour sélectionner une touche afin de quitter le mode curseur simple :

1. Sélectionnez Outils > Options de session dans le menu du visualiseur vidéo.

-ou-

Cliquez sur le bouton Options de session.

La boîte de dialogue Options de session s’affiche.

2. Cliquez sur l’onglet Souris.

3. Sélectionnez le raccourci clavier de fin de votre choix dans le menu
déroulant de la zone Mode curseur simple.

4. Cliquez sur Enregistrer pour enregistrer les paramètres.

Lorsque le mode curseur simple est activé, utilisez le raccourci clavier défini pour
revenir au mode de bureau normal.

Appuyez sur la touche indiquée dans la barre de titre pour quitter le mode
curseur simple.

Pour modifier le paramètre de curseur :

1. Sélectionnez Outils > Options de session dans le menu du visualiseur vidéo.

-ou-

Cliquez sur le bouton Options de session.

La boîte de dialogue Options de session s’affiche.

2. Cliquez sur l’onglet Souris.

3. Sélectionnez un type de curseur dans le volet Curseur local.

4. Cliquez sur OK pour enregistrer les paramètres.

Mise à l’échelle de la souris

Certaines versions antérieures de Linux ne prenaient pas en charge les
accélérations de souris réglables. Pour les installations nécessitant une prise en
charge de ces versions antérieures, vous pouvez choisir parmi trois options
préconfigurées de mise à l’échelle de la souris ou définir vos propres
paramètres. Les paramètres préconfigurés sont : Défaut (1:1), Élevé (2:1) et
Faible (1:2).

• Avec un rapport de mise à l’échelle de 1:1, tout mouvement de la souris
dans la fenêtre du bureau envoie un mouvement de souris équivalent vers
l’équipement cible.
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• Avec un rapport de 2:1, le même mouvement de souris envoie un
mouvement de souris multiplié par 2.

• Avec un rapport de 1:2, le facteur de multiplication est de 1/2.

Pour régler la mise à l’échelle de la souris :

1. Sélectionnez Outils > Options de session dans le menu du visualiseur vidéo.

-ou-

Cliquez sur le bouton Options de session.

La boîte de dialogue Options de session s’affiche.

2. Cliquez sur l’onglet Souris.

3. Activez le bouton radio correspondant au paramètre préconfiguré de votre
choix.

-ou-

Mise à l’échelle personnalisée :

a. Cliquez sur le bouton radio Personnalisée pour activer les champs X et
Y.

b. Saisissez une valeur de mise à l’échelle de la souris dans les champs X
et Y. Pour toute entrée de la souris, les mouvements sont multipliés par
les facteurs de mise à l’échelle X et Y correspondants. Les paramètres
saisis doivent être compris entre 0,25 et 3,00.

Alignement et synchronisation de la souris

L’interface Web intégrée du commutateur ne pouvant recevoir de retour
d’information de la souris en permanence, il peut arriver que la souris du
commutateur et la souris de l’hôte ne soient plus synchrones. Si la souris ou le
clavier ne répondent plus correctement, il est parfois nécessaire d’aligner la
souris ou de rétablir le repérage.

L’alignement permet d’aligner le curseur local sur le curseur de l’équipement
cible distant. La réinitialisation entraîne une simulation de reconnexion de la
souris et du clavier, comme si vous les aviez déconnectés puis reconnectés.

Pour aligner les curseurs, cliquez sur le bouton Aligner curseur local dans la
barre d’outils du visualiseur vidéo.
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4.10 Virtual Media
La fonction Virtual Media permet à l’utilisateur du serveur client de mapper un
lecteur physique de cette machine en tant que lecteur virtuel sur un équipement
cible. Le serveur client peut en outre ajouter et mapper un fichier image de
disquette ou ISO en tant que lecteur virtuel sur l’équipement cible. Vous pouvez
mapper simultanément un lecteur DVD-ROM et un dispositif de stockage de
masse.

• Les lecteurs de CD/DVD, les fichiers image disque (tels qu’un fichier image
de disquette ou ISO) sont mappés en tant que lecteurs CD/DVD-ROM
virtuels.

• Les lecteurs de disquette, les périphériques de mémoire USB ou tout autre
type de périphériques sont mappés en tant que dispositifs de stockage de
masse virtuels.

Pour en savoir plus sur la configuration des paramètres Virtual Media à l’aide de
l’interface Web intégrée, reportez-vous à la section « Virtual Media » à la page
35.

Configuration requise

L’équipement cible doit prendre en charge Virtual Media et être connecté au
commutateur KVM à l’aide d’un câble adaptateur USB20-VGA KVM s4.

L’équipement cible doit prendre en charge les types de supports compatibles
USB2 que vous désirez mapper de manière virtuelle. Autrement dit, si
l’équipement cible n’est pas compatible avec les périphériques de mémoire USB
portables, il est impossible de mapper le serveur client en tant que lecteur virtuel
sur l’équipement cible.

Vous devez être autorisé à établir des sessions Virtual Media ou des sessions
Virtual Media réservées sur l’équipement cible (ceci s’applique également au
groupe d’utilisateurs dont vous faites partie). Reportez-vous à la section «
Comptes utilisateurs » à la page 39.

Les sessions Virtual Media pour un même équipement cible peuvent uniquement
être activées une par une.

Remarques relatives au partage et à la préemption

Les sessions KVM et Virtual Media fonctionnent séparément, il existe par
conséquent de nombreuses options quant au partage, à la réservation et à la
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préemption des sessions. Le logiciel DSView 3 permet de répondre aux
différents besoins des systèmes.

Par exemple, il est possible de verrouiller des sessions KVM avec des sessions
Virtual Media. Ainsi, lorsqu’une session KVM est déconnectée, la session Virtual
Media qui lui est associée l’est également. Par contre, si les sessions ne sont pas
verrouillées, vous pouvez fermer la session KVM mais la session Virtual Media
reste ouverte. Cette opération peut s’avérer particulièrement utile lorsqu’un
utilisateur réalise une tâche très longue via une session Virtual Media (le
chargement d’un système d’exploitation, par exemple) et souhaite établir une
session KVM avec un autre équipement cible pour exécuter d’autres fonctions
pendant ce chargement.

Lorsque seule une session Virtual Media est active au niveau de l’équipement
cible, l’utilisateur de départ (Utilisateur A) peut se reconnecter ou un utilisateur
différent (Utilisateur B) peut se connecter à cette voie. Vous pouvez définir
l’option Réserver dans la boîte de dialogue Virtual Media afin de permettre
uniquement à l’utilisateur A d’accéder à la voie au cours d’une session KVM.

Si l’utilisateur B a accès à cette session KVM (l’option Réserver n’est pas
activée), il a la possibilité de contrôler le support utilisé au cours de cette session.
Lors de l’utilisation de l’option Réserver dans un environnement en cascade,
seul l’utilisateur A peut accéder au commutateur situé au niveau inférieur et la
voie KVM située entre le commutateur du niveau supérieur et celui du niveau
inférieur lui est réservée.

Boîte de dialogue Virtual Media

La boîte de dialogue Virtual Media permet de gérer le mappage et le démappage
des supports virtuels. Elle affiche tous les lecteurs physiques du serveur client
qui peuvent être mappés comme lecteurs virtuels. Il est également possible
d’ajouter des fichiers image disquette et ISO, puis de les mapper à l’aide de la
boîte de dialogue Virtual Media.

Une fois l’équipement cible mappé, la zone Détails de la boîte de dialogue
Virtual Media indique la quantité de données transférée et la durée écoulée
depuis le mappage de l’équipement.

Vous pouvez spécifier que la session Virtual Media est réservée. Si la session
est réservée, et la session KVM associée fermée, aucun autre utilisateur ne peut
ouvrir une session KVM pour cet équipement cible. Une autre session KVM peut
cependant être ouverte si la session n’est pas réservée.
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Vous pouvez également réinitialiser les câbles adaptateurs USB2 à partir de la
boîte de dialogue Virtual Media. Veuillez cependant noter que ceci réinitialise
tous les périphériques USB de l’équipement cible et doit par conséquent être
utilisé avec précautions, et ce, uniquement lorsque l’équipement cible ne répond
pas.

Ouverture d’une session Virtual Media

Lancement d’une session Virtual Media :

Sélectionnez Outils > Virtual Media dans le menu du visualiseur vidéo. La boîte
de dialogue Virtual Media s’affiche. Pour que la session soit réservée, cliquez sur
Détails, puis cochez la case Réserver.

Figure 4.4. Boîte de dialogue Virtual Media du visualiseur vidéo

Mappage d’un lecteur Virtual Media :

1. Ouvrez une session Virtual Media à partir du menu du visualiseur vidéo en
sélectionnantOutils > Virtual Media.

2. Mappage d’un lecteur physique en tant que lecteur Virtual Media :

a. Dans la boîte de dialogue Virtual Media, cochez la case Mappé en
regard du ou des lecteurs à mapper.

b. Cochez la case Lecture seule pour limiter l’accès au lecteur en lecture
seule si nécessaire. Cette case est déjà cochée si les paramètres de
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session Virtual Media étaient définis de sorte que tous les lecteurs
mappés soient en lecture seule. Ceci ne peut alors pas être modifié.

Lorsque les paramètres de session autorisent l’accès en
lecture/écriture, vous pouvez cocher la case Lecture seule si
vous souhaitez appliquer le mode lecture seule à un lecteur
donné.

3. Ajout et mappage d’une image de disquette ou ISO en tant que lecteur
Virtual Media :

a. Dans la boîte de dialogue Virtual Media, cliquez sur Ajouter image.

b. La boîte de dialogue de sélection de fichiers s’ouvre, avec le répertoire
contenant les fichiers image de disque (dotés d’une extension .iso ou
.img) visibles. Sélectionnez le fichier image de disquette ou ISO et
cliquez sur Ouvrir.

-ou-

Si la fonction glisser-déplacer est prise en charge par le
système d’exploitation du serveur client, sélectionnez le fichier
image de disquette ou ISO et faites-le glisser dans la boîte de
dialogue Virtual Media.

c. Le nom du fichier est vérifié afin d’éviter toute erreur. Si le fichier est
correct, la boîte de dialogue de sélection de fichiers se ferme et le fichier
image sélectionné apparaît dans la fenêtre Virtual Media. Vous pouvez
alors le mapper en cochant la case Mappé.

d. Répétez les étapes a à c pour chaque fichier image de disquette ou ISO
que vous désirez ajouter. Vous pouvez en ajouter autant que vous le
souhaitez, dans la limite imposée par la taille de la mémoire.
Cependant, les DVD-ROM virtuels et les dispositifs de stockage de
masse virtuels peuvent uniquement être mappés un par un.

Un message d’erreur s’affiche si vous tentez de mapper trop de lecteurs (un DVD
et un dispositif de stockage de masse) ou trop de lecteurs d’un certain type (plus
d’un DVD ou dispositif de stockage de masse). Pour mapper un nouveau lecteur,
vous devez tout d’abord démapper un lecteur déjà mappé.

Une fois l’image ou le lecteur physique mappé, vous pouvez l’utiliser sur
l’équipement cible.
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Démappage d’un lecteur Virtual Media :

1. Dans la boîte de dialogue Virtual Media, décochez la case Mappé en regard
du ou des lecteurs à démapper.

2. Vous êtes alors invité à confirmer l’opération. Confirmez ou non le
démappage.

3. Répétez cette opération pour les autres lecteurs Virtual Media à démapper.

Affichage des détails du lecteur Virtual Media :

Dans la boîte de dialogue Virtual Media, cliquez sur Détails. Le tableau Détails
s’affiche dans la boîte de dialogue développée. Chaque ligne indique :

• Lecteur cible : nom utilisé pour le lecteur mappé, par exemple CD virtuel 1
ou CD virtuel 2.

• Mappé par : identique aux informations du lecteur figurant dans la liste de la
colonne Lecteur Affichage client.

• Octets en lecture et Octets en écriture : quantité de données transférées
depuis le mappage.

• Durée : temps écoulé depuis le mappage du lecteur.

Pour fermer la fenêtre Détails, cliquez à nouveau sur Détails.

Pour réinitialiser tous les périphériques USB de l’équipement cible :

La fonction de réinitialisation USB s’applique à tous les périphériquesUSBde
l’équipement cible, y compris la souris et le clavier. Par conséquent, elle doit être utilisée
uniquement lorsque l’équipement cible ne répond pas.

1. Dans la boîte de dialogue Virtual Media, cliquez sur Détails.

2. La vue Détails s’affiche. Cliquez sur Réinitialiser USB.

3. Un message vous avertit des conséquences possibles de la réinitialisation.
Confirmez ou annulez la réinitialisation.

4. Pour fermer la fenêtre Détails, cliquez à nouveau sur Détails.

Fermeture d’une session Virtual Media

Fermeture de la boîte de dialogue Virtual Media :

1. Cliquez sur Quitter.

2. Un message indique que les lecteurs mappés vont être démappés.
Confirmez ou annulez l’opération.
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Si vous tentez de déconnecter une session KVM active associée à une session
Virtual Media verrouillée, un message de confirmation s’affiche indiquant que
tous les mappages Virtual Media vont être perdus.

4.11 Cartes à puce
Vous pouvez connecter un lecteur de cartes à puce à l’une des voies USB
disponibles du serveur client, puis accéder aux équipements cibles reliés au
système de commutation. Vous avez alors la possibilité de lancer une session
KVM afin d’ouvrir le visualiseur vidéo et de mapper une carte à puce.

Un câble adaptateursUSB20-VGAKVM s4 est requis pour tous les lecteurs de carte à
puce.

L’icône de la carte à puce, située à l’extrémité droite de la barre d’outils du
visualiseur vidéo, indique l’état de la carte. Le tableau suivant décrit les
différentes icônes d’état affichées.

Tableau 4.4. Icônes d’état de la carte à puce

Icône Description

Aucune carte à puce insérée dans le lecteur ou lecteur de cartesnon relié.

Une carte à puce est présente dans le lecteur, mais n’a pasencore été
mappée.

Une carte à puce a étémappée.

Mappage d’une carte à puce :

1. Ouvrez une session KVM afin d’afficher la fenêtre du visualiseur vidéo.

2. Insérez une carte à puce dans le lecteur de cartes relié au serveur client.

3. Cliquez sur Outils > Mapper Smart Card dans le menu du visualiseur vidéo.

4. Si aucune carte à puce n’est mappée à l’équipement cible, un point apparaît
en regard de l’option Aucune carte mappée. Sélectionnez l’une des cartes à
mapper dans la liste figurant sous cette option.

Pour annuler le mappage d’une carte à puce, fermez la session KVM en cliquant
sur le symbole X du menu du visualiseur vidéo, en sélectionnantOutils > Aucune
carte mappée, en retirant la carte à puce du lecteur ou en déconnectant le lecteur
du serveur client.

590-1058-640A70



4.12 Transfert direct des touches du clavier

4.12 Transfert direct des touches du clavier
Lorsque le visualiseur vidéo est lancé, les frappes au clavier peuvent être
interprétées de deux manières selon le mode d’affichage de la fenêtre du
visualiseur vidéo.

• En mode plein écran, toutes les frappes au clavier et les combinaisons de
touches à l’exception de Ctrl+Alt+Suppr sont transmises à l’équipement cible
en cours de visualisation.

• En mode d’affichage normal du bureau, la transmission des frappes au
clavier permet de contrôler la reconnaissance par l’équipement cible distant
ou l’ordinateur local de certaines frappes ou combinaisons de touches.

La transmission des frappes au clavier est définie dans la boîte de dialogue
Options de session. Lorsque l’option Communication clavier est activée et que la
fenêtre du visualiseur vidéo est active, toutes les frappes au clavier et les
combinaisons de touches à l’exception de Ctrl+Alt+Suppr sont transmises à
l’équipement cible distant en cours de visualisation. Lorsque le bureau local est
actif, les frappes au clavier et les combinaisons de touches agissent sur
l’ordinateur local.

La combinaison de touchesCtrl+Alt+Suppr peut être transmise à l’équipement cible
distant uniquement à l’aide d’unemacro.

Sur les claviers japonais, la combinaison ALT+Han/Zen est toujours envoyée à
l’équipement cible distant, quel que soit le mode d’affichage ou le paramètre de
transfert direct des touchesdu clavier.

Pour activer le transfert direct des touches du clavier :

1. Sélectionnez Outils - Options de session dans le menu du visualiseur vidéo.

-ou-

Cliquez sur le bouton Options de session.

La boîte de dialogue Options de session s’affiche.

2. Cliquez sur l’ongletGénéralités.

3. Sélectionnez Comm. de toutes les combin. de touches en mode fenêtre
normal.

4. Cliquez sur OK pour enregistrer le paramètre.
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4.13 Macros
L’interface Web intégrée du commutateur est préconfigurée avec des macros
pour les plates-formes Windows, Linux et Sun.

Pour envoyer une macro, sélectionnez Macros - <macro souhaitée> dans le
menu du visualiseur vidéo ou sélectionnez directement la macro souhaitée à
l’aide des boutons de cette fenêtre.

4.14 Enregistrement de l’affichage
Vous pouvez enregistrer l’image de la fenêtre du visualiseur dans un fichier ou
dans le presse-papiers puis le coller dans un programme de traitement de texte
ou autre.

Pour copier une image de la fenêtre du visualiseur vidéo dans un fichier :

1. Sélectionnez Fichier > Capturer dans le fichier dans le menu du visualiseur
vidéo.

-ou-

Cliquez sur le bouton Copier dans le fichier.

La boîte de dialogue Enregistrer sous s’affiche.

2. Saisissez le nom et la destination du fichier.

3. Cliquez sur Enregistrer pour enregistrer l’image dans un fichier.

Pour enregistrer la fenêtre du visualiseur vidéo dans le presse-papiers,
sélectionnez Fichier > Copier dans le presse-papiers dans le menu du
visualiseur vidéo ou cliquez sur le bouton Copier dans le presse-papiers.
L’image est enregistrée dans le presse-papiers.

4.15 Fermeture d’une session
Pour fermer une session du visualiseur vidéo :

Sélectionnez Fichier - Quitter dans la fenêtre du visualiseur vidéo.
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Le protocole LDAP est un protocole standard utilisé pour accéder à un annuaire,
lui transmettre des requêtes et le mettre à jour à l’aide du protocole TCP/IP.
Conçu sur le modèle des services d’annuaire X500, LDAP présente une
structure d’annuaire global bénéficiant de fonctionnalités de sécurité renforcées
parmi lesquelles l’authentification, la confidentialité et l’intégrité.

Si des comptes utilisateurs individuels sont stockés sur un service d’annuaires
activé par le protocole LDAP, par exemple Active Directory, vous pouvez l’utiliser
pour authentifier les utilisateurs. Les valeurs par défaut attribuées aux
paramètres de recherche et de requête LDAP sont définies pour une utilisation
avec Active Directory.

Vous pouvez configurer vos paramètres d’authentification via l’interface Web
intégrée. Le logiciel envoie le nom d’utilisateur, le mot de passe et d’autres
informations au matériel, qui détermine alors si l’utilisateur est autorisé ou non à
afficher ou modifier les paramètres de configuration via l’interface Web intégrée.

Sauf indication contraire, les valeurs par défaut du LDAPdoivent être utilisées, àmoins
qu’Active Directory n’ait été reconfiguré. Lamodification des valeurs par défaut risque
d’entraîner deserreurs de communication avec le serveur d’authentification LDAP.

5.1 Configuration de LDAP dans l’interface
utilisateur
La page Présentation LDAP du matériel de l’interface Web intégrée permet de
configurer la priorité d’authentification LDAP et les paramètres de connexion au
serveur LDAP.

Paramètres de la page Vue d’ensemble LDAP

Priorité de l’authentification LDAP

Dans la section Priorité de l’interface Web intégrée, vous pouvez désactiver le
protocole LDAP ou choisir d’effectuer une authentification locale avant LDAP ou
l’inverse.

Pour configurer les paramètres de priorité de l’authentification LDAP :

1. Sélectionnez Matériel - Paramètres du matériel - Comptes utilisateurs -
Comptes LDAP - Présentation.
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2. Dans la section Priorité LDAP, sélectionnez LDAP désactivé, LDAP avant
local ou LDAP après local.

3. Cliquez sur Enregistrer.

Serveurs LDAP

Les champs d’adresse indiquent les noms d’hôte ou les adresses IP des
serveurs LDAP primaire et secondaire. Le serveur LDAP secondaire est facultatif.

Les champs Voie indiquent les numéros des voies UDP (User Datagram
Protocol) utilisées pour communiquer avec les serveurs LDAP. La valeur par
défaut est 389 pour le protocole LDAP non sécurisé et 636 pour le protocole
LDAP sécurisé (LDAPS). Le champ ID de la voie est renseigné automatiquement
par le logiciel lorsqu’un type d’accès est spécifié.

Les boutons radio Type d’accès permettent de sélectionner le mode de
transmission des requêtes à chaque équipement cible LDAP. Si vous
sélectionnez LDAP, tous les noms d’utilisateur, mots de passe, etc., échangés
entre le matériel et le serveur LDAP sont envoyés sous forme de texte en clair,
non sécurisé. Sélectionnez LDAPS pour une communication sécurisée, cryptée,
entre le matériel et le serveur LDAP.

Pour configurer les paramètres du serveur LDAP :

1. Sélectionnez Matériel - Paramètres du matériel - Comptes utilisateurs -
Comptes LDAP - Présentation.

2. Indiquez l’adresse des serveurs primaire et secondaire, ainsi que la voie et
le type d’accès dans les champs ou à l’aide des boutons radio prévus à cet
effet.

3. Cliquez sur Enregistrer.

Paramètres de la page de recherche LDAP

Vous pouvez configurer, sur la page de recherche LDPA, les paramètres de
recherche des utilisateurs du service d’annuaire LDAP. Le champ DN de
recherche permet de définir un utilisateur de type administrateur dont les
références de connexion sont utilisées pour la connexion au service d’annuaire.
Une fois le matériel authentifié, le service lui donne accès à l’annuaire afin qu’il
envoie les requêtes d’authentification de l’utilisateur spécifiées dans la page
Requête LDAP portant sur le matériel. Les valeurs par défaut sont :
cn=Administrator, cn=Users, dc=yourDomainName et dc=com. Elles peuvent être
modifiées. Par exemple, pour définir le DN (Distinguished Name) d’un
administrateur pour test.view.com, saisissez cn=Administrator, cn=Users,
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dc=test, dc=view et dc=com. Les valeurs du champ DN de recherche doivent
être séparées par des virgules. Le champ Mot de passe de recherche sert à
identifier l’administrateur ou l’utilisateur spécifié dans le champ DN de recherche.
Le champ Base de recherche sert à définir le point de départ de la recherche
LDAP. Les valeurs par défaut sont dc=yourDomainName et dc=com. Elles
peuvent être modifiées. Par exemple, pour définir le point de départ de la
recherche sur test.com, saisissez dc=test, dc=com. Les valeurs du champ Base
de recherche doivent être séparées par des virgules. Le champ Masque UID sert
à définir les critères de recherche des identifiants utilisateurs sur les
équipements cibles LDAP. Le format suivant doit être utilisé : <nom>=<%1>. La
valeur par défaut est sAMAccountName=%1 et est compatible avec Active
Directory. Cette valeur est obligatoire pour les recherches LDAP.

Pour configurer les paramètres de recherche LDAP :

1. Sélectionnez Matériel - Paramètres du matériel - Comptes utilisateurs -
Comptes LDAP - Recherche.

2. Saisissez les informations dans les champs DN de recherche, Mot de passe
de recherche, Base de recherche et Masque UID.

3. Cliquez sur Enregistrer.

Vousne pouvezpasmodifier cesoptions si la case LDAPdésactivé est cochée dans la
section Priorité LDAPde la page de présentation.

Paramètres de la page Requête LDAP

Vous pouvez configurer, sur la page Requête LDAP, les paramètres utilisés pour
lancer des requêtes d’authentification de l’utilisateur.

Le matériel émet deux types de requêtes. La fonction Mode Requête (Matériel)
sert à identifier les administrateurs et utilisateurs essayant de se connecter
directement au matériel. La fonction Mode Requête (Équipement cible) sert à
authentifier les utilisateurs tentant de se connecter aux serveurs reliés. De plus,
chaque type de requête peut être transmis selon trois modes basés sur certains
types d’informations permettant de déterminer si un utilisateur LDAP est autorisé
ou non à accéder au matériel ou aux équipements cibles reliés. Reportez-vous à
la section « Modes de requête du matériel et de l’équipement cible » à la page
77 pour obtenir des informations détaillées sur chaque mode.

Vous pouvez configurer les paramètres suivants sur la page Requête LDAP :

• Les paramètres de Mode Requête (Matériel) déterminent si l’utilisateur
dispose ou non de droits d’accès au matériel.
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• Les paramètres Mode Requête (Équipement cible) déterminent si
l’utilisateur dispose ou non de droits d’accès de type utilisateur aux
équipements cibles reliés au matériel. L’utilisateur n’a pas accès au
matériel, sauf s’il bénéficie du mode Requête (Matériel).

• Les champs Conteneur de groupe, Masque du conteneur de groupe et
Masque cible sont utilisés uniquement avec les modes de requête de type
Groupe. Ces informations sont obligatoires lors d’une requête portant sur un
matériel ou un équipement.

• Le champ Conteneur de groupe indique l’unité organisationnelle créée dans
Active Directory par l’administrateur, définissant l’emplacement des objets
du groupe.

• Les objets du groupe sont des objets Active Directory pouvant contenir
des utilisateurs, des ordinateurs, des contacts et d’autres groupes. Le
conteneur de groupe est utilisé avec l’option Mode Requête définie sur
Attribut de groupe. Chaque objet du groupe est affecté à des membres
(personnes, matériels et équipements cibles) disposant d’un certain
niveau d’accès. Le niveau d’accès associé à un groupe est configuré en
définissant la valeur d’un attribut de l’objet du groupe.

• Par exemple, si la propriété Notes des objets du groupe sert à définir
l’attribut de contrôle d’accès, le champ Attribut de contrôle d’accès de la
page de requête LDAP doit être défini sur la valeur info. Si la propriété
Notes est définie sur la valeur Administrateur d’utilisateurs KVM, les
membres de ce groupe disposent de droits d’accès de type
administrateur d’utilisateurs pour se connecter aux matériels et aux
équipements cibles membres du même groupe.

• La propriété Notes sert à définir l’attribut de contrôle d’accès. La valeur de la
propriété Notes, disponible dans les objets groupe et utilisateur indiqués
sous Utilisateurs et Ordinateurs d’Active Directory, est enregistrée en interne
dans l’annuaire, sous la valeur de l’attribut info. Utilisateurs et Ordinateurs
d’Active Director est un composant logiciel enfichable de Microsoft
Management Console utilisé pour la configuration d’Active Directory. Pour le
lancer, sélectionnez Démarrer > Programmes > Outils d’administration >
Utilisateurs et Ordinateurs d’Active Directory. Cet outil permet de créer, de
configurer et de supprimer des objets tels que des utilisateurs, des
ordinateurs et des groupes. Reportez-vous à la section « Modes de requête
du matériel et de l’équipement cible » à la page 77 pour en savoir plus.

590-1058-640A76



5.2 Modes de requête du matériel et de l’équipement cible

• Le champ Masque du conteneur de groupe permet de définir le type d’objet
sous Conteneur de groupe, généralement une unité organisationnelle. La
valeur par défaut est « ou=%1 ».

• Le champ Masque cible permet de définir un filtre de recherche pour
l’équipement cible. La valeur par défaut est « cn=%1 ».

• Le champ Attribut de contrôle d’accès indique le nom de l’attribut utilisé avec
les modes de requête Attribut de l’utilisateur et Attribut de groupe. La valeur
par défaut est info.

Pour configurer les paramètres de requête LDAP :

1. Sélectionnez Matériel - Paramètres du matériel - Comptes utilisateurs -
Comptes LDAP - Requête.

2. Sélectionnez ensuite Basique, Attribut de l’utilisateur ou Attribut de groupe
sous Mode Requête pour le matériel et l’équipement cible.

3. Renseignez les champs Conteneur de groupe, Masque du conteneur de
groupe, Masque cible et Attribut de contrôle d’accès.

4. Cliquez sur Enregistrer.

Vousne pouvezpasmodifier cesoptions si la case LDAPdésactivé est cochée dans la
section Priorité LDAPde la page de présentation.

5.2 Modes de requête du matériel et de l’équipement
cible
Trois modes différents peuvent être utilisés pour les fonctions Mode Requête
(Matériel) et Mode Requête (Équipement cible) :

• Basique : une requête portant sur le nom et le mot de passe de l’utilisateur
est transmise au service d’annuaire. Si les données sont vérifiées,
l’utilisateur dispose alors de droits d’accès de type administrateur de
matériel pour le matériel et les équipements cibles reliés en mode Requête
(Matériel), ou à tout équipement cible sélectionné en mode Requête
(Équipement cible).

• Attribut de l’utilisateur : une requête portant sur le nom d’utilisateur, le mot de
passe et un attribut de contrôle d’accès pour l’utilisateur du matériel est
transmise au service d’annuaire. L’attribut de contrôle d’accès est lu à partir
de l’objet utilisateur (le compte utilisateur) d’Active Directory.
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Si la valeur Admininistrateur de matériel KVM est trouvée, l’utilisateur
dispose de droits d’accès de type administrateur de matériel pour le
matériel et les équipements cibles reliés en mode Requête (Matériel),
ou à tout équipement cible sélectionné en mode Requête (Équipement
cible).

Si la valeur Admininistrateur d’utilisateurs KVM est trouvée, l’utilisateur
dispose de droits d’accès de type administrateur d’utilisateurs pour le
matériel et les équipements cibles reliés en mode Requête (Matériel),
ou à tout équipement cible sélectionné en mode Requête (Équipement
cible).

Si la valeur Utilisateur KVM est trouvée, l’utilisateur dispose de droits
d’accès de type utilisateur pour le matériel en mode Requête (Matériel)
ou à tout équipement cible sélectionné en mode Requête (Équipement
cible).

Si aucune des trois valeurs n’est trouvée, l’utilisateur n’a pasaccèsaumatériel ni aux
équipements cibles enmodeRequête (Matériel), ni auxéquipements cibles
sélectionnésenmodeRequête (Équipement cible), sauf s’il dispose de privilèges
d’accèsaumatériel de type Administrateur d’utilisateurs ou Administrateur dematériel.

Pour accéder à ADUC, sélectionnez Démarrer - Programmes - Outils
d’administration - Utilisateurs et Ordinateurs d’Active Directory.

• Attribut de groupe : une requête portant sur le nom d’utilisateur, le mot de
passe et le groupe est transmise au service d’annuaire pour un matériel et
ses équipements cibles reliés en mode Requête (Matériel), ou pour un
équipement cible sélectionné en mode Requête (Équipement cible). Si un
groupe contenant le nom d’utilisateur et le nom du matériel est trouvé,
l’utilisateur dispose de droits d’accès au matériel ou aux équipements cibles
reliés, selon le contenu du groupe, en mode Requête (Matériel). Si un
groupe contenant l’ID d’utilisateur et l’ID de l’équipement cible est trouvé,
l’utilisateur dispose de droits d’accès aux équipements cibles sélectionnés
reliés au matériel lorsque le mode Requête (Équipement cible) est utilisé.

La structure des groupes peut comporter jusqu’à 16 niveaux. Vous
pouvez créer des groupes au sein de groupes existants. Vous pouvez
par exemple disposer d’un groupe de niveau supérieur appelé
Ordinateurs,dont un des membres porte le nom R&D et constitue
également un groupe. Le groupe R&D peut contenir à son tour un
membre appelé Domestique, lequel est également un groupe, etc.
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5.3 Configuration d’Active Directory pour la
transmission de requêtes
Avant de pouvoir utiliser l’un des modes de requêtes pour les unités, vous devez
modifier les paramètres d’Active Directory afin que le mode de requête
sélectionné puisse attribuer les droits d’accès correspondant à l’utilisateur.

Définition de requêtes de groupe :

1. Connectez-vous sous Windows en tant qu’administrateur.

2. Ouvrez le logiciel Active Directory.

3. Créez une unité organisationnelle représentant un conteneur de groupe.

4. Créez un objet d’ordinateur dans Active Directory portant un nom identique à
celui de la solution de commutation en mode de requête matériel (indiqué
sur l’écran Présentation du matériel de l’interface Web intégrée) ou
identique aux équipements cibles reliés en mode Requête pour les
équipements cibles. Les noms doivent être exactement les mêmes, y
compris la casse.

5. Les noms des matériels et des équipements cibles utilisés pour les requêtes
de groupe sont enregistrés dans le matériel. Le nom du matériel indiqué sur
l’écran Présentation du matériel de l’interface Web intégrée et les noms des
équipements cibles doivent correspondre exactement aux noms des objets
dans Active Directory. Chaque nom peut être constitué de toute combinaison
de lettres en majuscules ou en minuscules (a à z, A à Z), de chiffres (0 à 9) et
de traits d’union (-). Les espaces et les points (.) ne sont pas autorisés, de
même que les noms exclusivement composés de chiffres. Ces contraintes
sont liées à Active Directory.

Dans lespremières versions, le nom par défaut dumatériel défini en usine comporte un
espace qu’il est nécessaire de supprimer dans la fenêtre de présentation dumatériel de
l’interfaceWeb intégrée.

6. Créez un ou plusieurs groupes dans l’unité organisationnelle du conteneur
de groupe.

7. Ajoutez les noms d’utilisateurs et les objets du matériel et de l’équipement
cible aux groupes que vous avez créés à l’étape 5.

8. Spécifiez la valeur de tout attribut utilisé pour implémenter l’attribut de
contrôle d’accès. Par exemple, si vous utilisez les informations comme
attribut dans le champ Attribut de contrôle d’accès et la propriété Notes de
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5. Protocole LDAP

l’objet de groupe pour implémenter l’attribut de contrôle d’accès, la valeur de
l’attribut Notes dans Active Directory peut être définie selon l’un des trois
niveaux d’accès disponibles (Utilisateur KVM, Administrateur d’utilisateurs
KVM ou Administrateur de matériel KVM) pour l’objet de groupe. Les
membres du groupe peuvent alors accéder au matériel et aux équipements
cibles au niveau d’accès spécifié.

Si aucune des trois valeurs n’est trouvée, l’utilisateur bénéficie de l’accèsutilisateur pour
tout matériel ou équipement cible figurant dansun groupe avec son nom d’utilisateur.
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Chaque commutateur peut également être configuré au niveau du

matériel via le menu de la console accessible par la voie SETUP.

Toutes les commandes du terminal sont accessibles à partir d’un

terminal ou d’un PC exécutant un logiciel d’émulation de terminal.

NOTA : Il est préférable d’effectuer tous les paramétragesde configuration via
l’interface utilisateur locale.

Pour connecter un terminal au commutateur :

1. À l’aide de l’adaptateur RJ-45/DB-9 (femelle) et du câble UTP

fournis, connectez un terminal ou un ordinateur exécutant un

logiciel d’émulation de terminal (tel que HyperTerminal) sur la

voie SETUP située sur le panneau arrière du commutateur. Les

paramètres du terminal sont les suivants : 9 600 bit/s, 8 bit, 1 bit

d’arrêt, pas de parité ni de contrôle de flux.

2. Mettez chaque équipement cible sous tension, puis le

commutateur. Une fois l’initialisation du commutateur terminée, le

menu de la console affiche le message suivant : Press any key to

continue (appuyez sur n’importe quelle touche pour continuer).

Options du menu de démarrage de la console
Pendant le démarrage du commutateur, appuyez sur n’importe quelle

touche pour afficher le menu de démarrage. Vous avez alors le choix

entre quatre options.

• Boot Normal

• Boot Alternate Firmware

• Reset Factory Defaults

• Full-Factory Reset

Options du menu principal de la console
Une fois le commutateur allumé, le menu principal affiche le nom et la

version du produit. Vous avez alors le choix entre quatre options.

• Network configuration : cette option vous permet de configurer

les paramètres de réseau de l’équipement.
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• Debug messages : cette option active l’émission de messages

d’état de la console. Étant donné qu’elle peut réduire les

performances de manière significative, il est déconseillé d’utiliser

cette commande sans y avoir été invité par l’assistance technique

de Fujitsu. Lorsque vous avez terminé de lire les messages,

appuyez sur une touche du clavier pour quitter ce mode.

• Reset Appliance : cette option permet d’exécuter un redémarrage

à chaud du commutateur.

• Exit : cette option vous ramène au message signalant que le

système est prêt. Lorsque le mot de passe de l’interface du menu

de la console est activé, vous devez quitter le menu principal de

la console de sorte que l’utilisateur suivant soit invité à saisir son

nom d’utilisateur et son mot de passe pour se connecter.
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Annexe B : Utilisation de câbles adaptateurs
série KVM s4
Utilisation de câbles adaptateurs série KVM s4

Un administrateur peut choisir entre les brochages d’un serveur

console ACS ou Cisco pour chaque voie câble adaptateur série via

l’interface utilisateur locale ou l’interface Web intégrée distante. Le

brochage par défaut est le brochage ACS.

Pour modifier le brochage en mode Cisco :

1. Sélectionnez Vue Unités - Matériel - Paramètres du matériels -

Voies > Câbles adaptateurs.

2. Cliquez sur le ou les câbles adaptateurs série de votre choix.

3. Sélectionnez Paramètres > Disposition des broches.

NOTA : Si l’adaptateur DB-9 est utilisé, sélectionnez les brochagesdu serveur
console ACS.

Brochage des voies du serveur console ACS

Le tableau suivant définit le brochage des voies série du serveur

console ACS pour le câble adaptateur série.

N°de
broche Nom du signal Entrée/sortie

1 RTS - Requête de
transmission SORTIE

2 DTR - Terminal de
donnéesprêt SORTIE

3 TXD - Transmission de
données SORTIE

4 GND - Terre de
signalisation S.O.

5 CTS - Prêt à
transmettre ENTRÉE

Tableau B.1 : Brochage des voies série du serveur de console ACS
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N°de
broche Nom du signal Entrée/sortie

6 RXD - Réception de
données ENTRÉE

7 DCD/DSR - Poste de
donnéesprêt ENTRÉE

8 N/C - Non connecté S.O.

Brochage des voies Cisco

Le tableau suivant définit le brochage des voies série Cisco pour le

câble adaptateur série.

N°de
broche Nom du signal Entrée/sortie

1 CTS - Prêt à
transmettre ENTRÉE

2 DCD/DSR - Poste de
donnéesprêt ENTRÉE

3 RXD - Réception de
données ENTRÉE

4 GND - Terre de
signalisation S.O.

5 N/C - Non connecté S.O.

6 TXD - Transmission de
données SORTIE

7 DTR - Terminal de
donnéesprêt SORTIE

8 RTS - Requête de
transmission SORTIE

Tableau B.2 : Brochage des voies série Cisco
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Annexe C : Câblage UTP
Cette annexe explique différents aspects des supports de connexion.

La solution de commutation KVM s4 utilise le câblage UTP. La

qualité des connexions influence les performances de la solution de

commutation. En effet, un câblage de mauvaise qualité, mal installé ou

mal entretenu peut réduire les performances du commutateur.

NOTA : Les informations contenuesdans cette annexe sont donnéesà titre de
référence uniquement. Avant toute installation, veuillez vous renseigner auprèsdes
autorités compétentesenmatière de câblage dans votre paysou de consultants
spécialisésdans le domaine.

Câblage en cuivre UTP
Les définitions qui suivent décrivent les trois types de câblage UTP

compatibles avec le commutateur KVM s4 :

• Les câbles CAT 5 hautes performances à 4 paires se composent de

paires de fils torsadées et sont utilisés principalement pour la

transmission de données. Les paires torsadées protègent les câbles

des interférences indésirables. Les câbles CAT 5 sont

généralement utilisés dans les réseaux fonctionnant à 10 ou 100

 Mbit/s.

• Les câbles CAT 5E (amélioré) présentent les mêmes

caractéristiques que les câbles CAT 5, mais répond à des normes

de fabrication plus strictes.

• Les câbles CAT 6 sont fabriqués selon des spécifications plus

strictes que les câbles CAT 5E. Les câbles CAT 6 possèdent une

bande de fréquence mesurée supérieure et démontrent des

performances nettement meilleures que les câbles CAT 5E aux

mêmes fréquences.

Normes de câblage
Le câble UTP de type RJ-45 à 4 paires et 8 fils est compatible avec

deux normes de câblage : EIA/TIA 568A et B. Ces normes

s’appliquent aux installations faisant appel aux spécifications de

câblage CAT 5, CAT 5E et CAT 6. La solution de commutation KVM

 s4 est compatible avec ces deux normes de câblage. Le tableau

suivant décrit les normes de câblage correspondant à chaque broche.
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Broche EIA/TIA 568A EIA/TIA 568B

1 blanc/vert blanc/orange

2 vert orange

3 blanc/orange blanc/vert

4 bleu bleu

5 blanc/bleu blanc/bleu

6 orange vert

7 blanc/marron blanc/marron

8 marron marron

Tableau C.1 : Normes de câblage UTP

Installation, maintenance et conseils de sécurité relatifs
au câblage

La liste suivante détaille des points de sécurité importants à prendre

en compte avant toute installation ou maintenance de câbles :

• N’utilisez pas de câbles UTP de plus de 9 m de long.

• Assurez-vous que les paires sont torsadées tout le long du câble

jusqu’au point de terminaison ou qu’en cas de présence d’une

portion de câble non torsadée, celle-ci n’excède pas 1,27 cm.

Veillez à ne pas dénuder le câble sur plus de 2,54 cm à son

extrémité.

• Si vous êtes obligé de plier le câble, courbez-le graduellement en

n’imprimant pas d’angle supérieur à 2,54 cm de rayon. Si vous

tordez ou courbez brutalement le câble, vous risquez d’en

endommager l’intérieur de manière irréversible.

• Fixez soigneusement les câbles à l’aide de colliers de serrage, en

exerçant une pression faible à modérée. Ne serrez pas trop les

colliers.

• Interconnectez les câbles lorsque cela s’avère nécessaire. Pour ce

faire, utilisez des blocs de perforation, des tableaux de connexions

et des composants conformes aux spécifications des câbles.
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N’épissez pas et ne connectez les câbles par pontage en aucun

point.

• Éloignez autant que possible les câbles UTP des sources de

perturbations électromagnétiques potentielles (EMI), telles que les

câbles électriques, les transformateurs et les luminaires. Ne fixez

pas les câbles à des conduites électriques ou à des câbles faisant

partie d’autres installations électriques.

• Testez systématiquement chaque segment installé à l’aide d’un

testeur de câblage. Le « test de la tonalité » seul est insuffisant.

• Pensez à toujours installer des prises femelles de sorte à éviter tout

dépôt de poussière et autres parasites sur les contacts. Les contacts

de la prise femelle doivent être positionnés face vers le haut sur

les plaques encastrées ou vers la gauche, la droite ou le bas sur les

boîtiers extérieurs.

• Prévoyez toujours du jeu pour les câbles, en veillant à les enrouler

soigneusement dans le plafond ou à les dissimuler à proximité.

Prévoyez au moins 1,5 m du côté de la sortie et 4,5 m au niveau

du tableau de raccordement.

• Choisissez la norme de câblage 568A ou 568B avant de

commencer. Câblez toutes les prises et tous les tableaux de

raccordement selon le même schéma électrique. Ne mélangez pas

les câblages 568A et 568B au sein d’une installation.

• Respectez les réglementations locales et nationales en matière de

prévention d’incendie et de construction. Assurez-vous de mettre

en place un dispositif coupe-feu pour tous les câbles pénétrant

dans un pare-feu. Utilisez des câbles ignifuges lorsque cela s’avère

nécessaire.
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Annexe D : Informations relatives au brochage
des câbles

NOTA : Tous les commutateurs sont équipésde prises femellesmodulaires à 8
 brochesau niveau des voiesmodem et Console/Setup.

Figure D.1 : Prise femelle modem

Broche Description Broche Description

1
Requête de
transmission
(RTS)

5 Transmission de données (TXD)

2
Poste de
donnéesprêt
(DSR)

6 Terre de signalisation (SG)

3
Détection de
porteuse
(DCD)

7 Terminal de donnéesprêt (DTR)

4
Réception de
données
(RXD)

8 Prêt à transmettre (CTS)

Tableau D.1 : Description de la Figure D.1
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Figure D.2 : Prise femelle console/configuration

Broche Description Broche Description

1
Aucune
connexion
(N/C)

5 Transmission de données (TXD)

2
Aucune
connexion
(N/C)

6 Terre de signalisation (SG)

3
Aucune
connexion
(N/C)

7 Aucune connexion (N/C)

4
Réception de
données
(RXD)

8 Aucune connexion (N/C)

Tableau D.2 : Description de la Figure D.2
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Annexe E : Spécifications techniques

Voiesdu serveur

Nombre

Commutateur KVM s4-0812 : 8

Commutateur KVM s4-1622 : 16

Commutateur KVM s4-3242 : 32

Type PS/2, USBet série

Connecteurs Modulaire à 8 broches

Typesde
synchronisation

Horizontale et verticale séparées

Résolution d’entrée
vidéo

Standard

640 x480 à 60 Hz

800 x600 à 75 Hz

960 x700 à 75 Hz

1024 x768 à 75 Hz

1280 x1024 à 75 Hz

1600 x1200 à 60 Hz

Écran large

800 x500 à 60 Hz

1024 x640 à 60 Hz

1280 x800 à 60 Hz

1440 x900 à 60 Hz

1680 x1050 à 60 Hz

Câblage compatible
Câble UTPouCAT 6, 4 paires, longueur maximale de
45 m

Dimensions

Tableau E.1 : Spécifications techniques
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Voiesdu serveur

Facteur de forme Montable en rack1 U

Dimensions 1,72 x17,00 x9,20 (hauteur x largeur x profondeur)

Poids (sans les
câbles)

Commutateur KVM s4-0812 : 3,0 kg

Commutateur KVM s4-1622 : 3,2 kg

Commutateur KVM s4-3242 : 3,4 kg

Voie SETUP

Nombre 1

Type Série RS-232

Connecteur Modulaire à 8 broches

Voie locale

Nombre/type 1 VGA/4 USB

Connexion réseau

Nombre 2

Type Ethernet 10/100/1000

Connecteur Modulaire à 8 broches

Voie pour équipement USB

Nombre 4

Type USB 2.0

Voie MODEM

Nombre 1

Type Série RS-232
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Voiesdu serveur

Connecteurs Modulaire à 8 broches

Voie PDU

Nombre 2

Type Série RS-232

Connecteur Modulaire à 8 broches

Consommation

Connecteurs 2

Type Interne

Puissance

Commutateur KVM s4-0812 : 13 W

Commutateur KVM s4-1622 : 18 W

Commutateur KVM s4-3242 : 24 W

Dissipation calorifique

Commutateur KVM s4-0812 : 45,37 kJ/h

Commutateur KVM s4-1622 : 47,48 kJ/h

Commutateur KVM s4-3242 : 49,59 kJ/h

Tension
d’alimentation (c.a.)

100 - 240 V c.a.

Fréquence
d’alimentation (c.a.)

50 à 60 Hz, autodétection

Intensité nominale
d’alimentation (c.a.)

1,25 A

Puissance
d’alimentation (c.a.)
(maximum)

40 W

Conditions ambiantes
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Voiesdu serveur

Température
0 à 50 °C, en fonctionnement

-20 à 70 °C, hors fonctionnement

Humidité

En fonctionnement : 20 %à 80 %d’humidité relative
(sans condensation)

Hors fonctionnement : 5 %à 95 %d’humidité relative,
température de point de roséemaximale de 38,7 °C

Certifications et
labels des normes
EMC et de sécurité

UL, FCC, cUL, ICES-003, CE, VCCI, KCC, C-Tick,
GOST

Les certificationsde sécurité et EMC de ce produit
portent différents noms : CMN (CertificationModel
Number ou Numéro demodèle de conformité), MPN
(Manufacturer’sPart Number ou Numéro de
référence du fabricant) ou SalesLevelModel (Modèle
de niveau de vente). Le nom utilisé dans les rapports et
certificatsEMC et/ou de sécurité est imprimé sur
l’étiquette du produit.
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Annexe F : Émulation des touches avancées du
clavier Sun

Il est possible d’émuler certaines touches d’un clavier Sun (US) de

type 5 standard en utilisant des combinaisons de touches sur un

clavier USB connecté à la voie locale. Pour activer le mode

d’émulation de touches avancées du clavier Sun et utiliser ces

raccourcis clavier, maintenez les touches Ctrl+Maj+Alt enfoncées,

puis appuyez sur la touche Arrêt défil. Le voyant Arrêt défil clignote.
Utilisez les touches indiquées dans le tableau suivant comme si vous

utilisiez les touches avancées d’un clavier Sun. Par exemple : Pour

Stop + A, maintenez les touches Ctrl+Maj+Alt enfoncées et appuyez

sur Arrêt défil, puis sur F1 + A.

Ces combinaisons de touches fonctionnent avec les câbles USB20-

VGA adaptateurs des commutateurs KVM s4. À l’exception de la

touche F12, ces raccourcis clavier ne sont pas reconnus sous Microsoft

Windows. La touche F12 exécute l’activation d’une touche Windows.

Une fois l’opération terminée, maintenez les touches Ctrl+Maj+Alt

enfoncées, puis appuyez sur la touche Arrêt défil pour désactiver

l’émulation des touches avancées du clavier Sun.

Touche Sun (US) Touche activant l’émulation des touchesSun

Compose Application(1)

Compose Pavé numérique

Power F11

Open F7

Help Verr num

Props F3

Front F5

Stop F1

Again F2

Tableau F.1 : Émulation des touches du clavier Sun
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Touche Sun (US) Touche activant l’émulation des touchesSun

Undo F4

Cut F10

Copy F6

Paste F8

Find F9

Mute Touche « / » du pavé numérique

Vol + Touche « +» du pavé numérique

Vol - Touche « – » du pavé numérique

Command (gauche) (2) F12

Command (gauche) (2) ToucheWin gauche (1)

Command (droite) (2) ToucheWin droite (1)

NOTES :

(1) Clavier à 104 touchesWindows 95

(2) La touche Commande est la touche SunMeta (en forme de losange).
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Annexe G : Assistance technique
Si vous avez besoin d’aide, d’un entretien ou d’une assistance

technique ou désirez obtenir plus d’informations concernant les

produits Fujitsu , vous trouverez une large gamme de ressources auprès

de Fujitsu. La présente section vous indique comment vous procurer

des informations concernant la société et les produits Fujitsu, comment

procéder en cas de problème avec votre système et qui contacter pour

obtenir une assistance technique, si nécessaire.

Avant de nous contacter
Avant de nous contacter, suivez les étapes ci-dessous afin d’essayer de

résoudre les problèmes rencontrés par vous-même.

• Vérifiez que tous les câbles sont connectés.

• Vérifiez les interrupteurs d’alimentation afin de vous assurer que

le système et les équipements sont sous tension.

• Reportez-vous à la section Dépannage de votre documentation

système et utilisez les outils de diagnostic fournis avec votre

système. Vous trouverez de plus amples informations sur les outils

de diagnostic dans le Guide de dépannage et d’entretien (Problem

Determination and Service Guide) sur le CD Documentation

Fujitsu fourni avec le système.

• Consultez le site Web d’assistance technique, à l’adresse

http://www.ts.fujitsu.com/support/, pour obtenir des informations

techniques, des astuces et des conseils, les pilotes de nouveaux

matériels ou pour soumettre une demande d’informations.

Vous pouvez résoudre de nombreux problèmes sans avoir recours à

une assistance externe en suivant les procédures de dépannage de

Fujitsu disponibles dans l’aide en ligne ou dans la documentation

fournie avec votre produit Fujitsu. La documentation accompagnant

les systèmes Fujitsu offre également une description des tests de

diagnostic que vous pouvez effectuer. La plupart des systèmes,

systèmes d’exploitation et programmes sont livrés avec une

documentation proposant des procédures de dépannage et des

explications relatives aux messages et aux codes d’erreur. Si vous

suspectez un problème logiciel, reportez-vous à la documentation du

système d’exploitation ou du programme.
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1. Información general del producto

1.1 Características y beneficios
Los conmutadores KVM serie 4-0812/1622/3242 de Fujitsu combinan la
tecnología analógica y digital para proporcionar un control centralizado y flexible
de los servidores del centro de proceso de datos y de medios virtuales, y facilitan
las operaciones, la activación y el mantenimiento de las sucursales remotas
donde no haya operadores cualificados disponibles. Los conmutadores KVM s4
basados en IP le ofrecen un control flexible de la administración de los
dispositivos de destino y un acceso remoto seguro desde cualquier lugar y en
cualquier momento.

El conmutador KVM s4 ofrece a los clientes de empresa las siguientes funciones
y opciones:

• reducción considerable del volumen de cables

• funciones de teclado, vídeo y ratón (KVM) que se puede configurar para
obtener una conectividad analógica (local) o digital (remota)

• capacidad serie real a través de Secure Shell (SSH) y Telnet

• compatibilidad con resolución de vídeo mejorada, nativa de 1600 x 1200 o
1680 x 1050 (panorámica) de dispositivo de destino a remoto

• función de medio virtual accesible a través de puertos USB

• rutas de vídeo del puerto local independientes dobles (dedicadas a ACI)

• IPv4 (DHCP) e IPv6 (DHCPv6 y configuración automática sin estado) de pila
dual para acceso simultáneo

• compatible con lectores de tarjeta inteligente que cumplen con la norma
CCID

• accesibilidad a los dispositivos de destino a través de puerto(s) LAN 10/100
o 1000BaseT

• un puerto MODEM que admite módems compatibles V.34, V.90 o V.92 que
pueden usarse para acceder al conmutador cuando no se dispone de
conexión Ethernet
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1. Información general del producto

Reducción del volumen del cableado

Debido al constante aumento de las densidades de servidores, el volumen de
los cables sigue siendo uno de los principales problemas para los
administradores de redes. El conmutador KVM s4 reduce considerablemente el
volumen de los cables KVM presentes en el rack, mediante la utilización de la
innovadora opción de conversión de medio virtual y de un solo cable estándar
de mercado de par trenzado sin protección (UTP). De este modo, es posible
aumentar la densidad de los servidores, con mayor circulación del aire y mejor
capacidad de refrigeración.

Funciones de la conmutación KVM

El conmutador KVM s4 es compatible con los cables adaptadores que se
encienden directamente desde el dispositivo de destino y proporcionan la
función Keep Alive incluso si el equipo no está encendido. Los siguientes cables
adaptadores son compatibles: Cables serie adaptadores KVM s4 y USB20-VGA
adaptadores KVM s4.

Funciones serie reales

El conmutador KVM s4 es compatible con cables serie adaptadores KVMs4 que
proporcionan funciones serie reales a través de Secure Shell (SSH) o Telnet.
Puede iniciar una sesión SSHo un visor serie desde la interfaz Web incorporada
(OBWI) para conectar los dispositivos de destino que están acoplados a los
conmutadores KVM s4 con un cable serie adaptador KVMs4.

Interfaces de usuario local y remota

Puede usar la interfaz de usuario local conectándose directamente al puerto
local para administrar el KVM s4. También puede utilizar la OBWI remota para
administrar el conmutador. La OBWI, basada en navegador Web, se inicia
directamente desde el conmutador y permite detectar automáticamente cualquier
dispositivo conectado al KVM s4. Las dos interfaces de usuario comparten un
aspecto similar para facilitar al máximo su uso por parte del usuario.

Control del medio virtual y de los conmutadores compatibles con la
tarjeta inteligente

Gracias al conmutador KVM s4 puede ver, mover o copiar datos ubicados en los
medios virtuales desde y a cualquier dispositivo de destino. Puede administrar
los sistemas remotos con mayor eficacia permitiendo la instalación del sistema
operativo, la recuperación del sistema operativo, la recuperación o reproducción
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1.1 Características y beneficios

del disco duro, la actualización de la BIOS y la realización de una copia de
seguridad del dispositivo de destino.

El conmutador KVM s4 le permite utilizar tarjetas inteligentes junto con el sistema
del conmutador. Las tarjetas inteligentes son tarjetas muy pequeñas que
almacenan y procesan información. Las tarjetas inteligentes, como por ejemplo
la Common Access Card (CAC) pueden utilizarse para el almacenamiento de los
datos de identificación y autenticación necesarios para acceder a ordenadores,
redes y salas y edificios protegidos.

Los medios virtuales y los lectores de tarjetas inteligentes pueden conectarse
directamente al conmutador a través de los puertos USB ubicados en el mismo.
Además, los medios virtuales y los lectores de tarjetas inteligentes pueden
conectarse a cualquier estación de trabajo remota que esté utilizando la OBWI
remota o el software de administración Avocent® DSView® 3 y que esté
conectada al conmutador mediante una conexión Ethernet.

Para abrir una sesión demedio virtual con un dispositivo de destino, éste debe
conectarse previamente a un conmutador con un cable adaptador. En el caso de una
tarjeta inteligente, el dispositivo de destino debe conectarse a un conmutador mediante
un cable adaptador compatible con tarjetas inteligentes.

Acceso al conmutador a través de una red TCP/IP estándar

El conmutador ofrece control y acceso remoto "sin agente". No se requiere
ningún software ni controlador especial en los servidores acoplados, o cliente.

El cliente se conecta al conmutador a travésde un navegador de Internet.

Puede acceder al conmutador y a todos los sistemas conectados a través de
Ethernet o mediante un módem V.34, V.90 o V.92 desde un cliente. Los clientes
pueden ubicarse en cualquier lugar donde exista una conexión de red válida.

Complemento del software de administración DSView 3

El software DSView 3 puede utilizarse con el conmutador para permitir que los
administradores de sistemas informáticos puedan supervisar, controlar y acceder
de forma remota a dispositivos de destino en múltiples plataformas a través de
una única interfaz de usuario basada en Web. Para obtener más información
consulte el boletín técnico del complemento del software DSView 3 para los
Conmutadores KVM s4.
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1. Información general del producto

1.2 Ejemplo de configuración

Figura 1.1. Ejemplo de configuración del conmutador

Tabla 1.1. Descripciones para la Figura 1.1

Número Descripción Número Descripción

1 Conexión CAT 5 7 Red telefónica

2 Conexión KVM
al conmutador 8 Ethernet

3 Conexión IP
remota 9 Servidor del software DSView 3

4 Rackde
servidores 10 Usuario analógico (interfaz de usuario

local)
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1.2 Ejemplo de configuración

Número Descripción Número Descripción

5 Conmutador
KVM s4 11 Usuario digital (ordenador con

navegador de Internet, OBWI remota)

6 Módem
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2. Instalación

2.1 Conectividad del conmutador KVM s4
El conmutador KVM s4 transmite información KVM y serie entre los operadores y
los dispositivos de destino acoplados al conmutador a través de una red
mediante una conexión Ethernet o una conexión de módem.

El conmutador KVM s4 utiliza los protocolos TCP/IP para comunicarse a través
de Ethernet. Para obtener el mejor rendimiento del sistema, utilice una red
100BaseT o 1000BaseT conmutada y dedicada. También puede usar una red
Ethernet 10BaseT.

El conmutador KVM s4 utiliza el Protocolo punto a punto (PPP) para las
comunicaciones a través de un módem V.34, V.90, o V.92. Puede efectuar tareas
de conmutación KVM y serie mediante la OBWI o el software DSView 3. Para
obtener más información sobre el software DSView 3, visite
http://www.avocent.com/fujitsu.

La Figura 2.1 ilustra un ejemplo de configuración básica para el conmutador. Las
descripciones se incluyen en la Tabla 2.1.
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2. Instalación

Figura 2.1. Configuración básica del conmutador mediante el conmutador KVM s4-
3242

Tabla 2.1. Descripciones para la Figura 2.1

Número Descripción Número Descripción

1 Usuario digital 8 Cable de alimentación

2 Red telefónica 9 Puertos1-32

3 Red 10 ConexionesUSB locales
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2.1 Conectividad del conmutador KVM s4

Número Descripción Número Descripción

4 Módem 11 Dispositivo de control de alimentación

5 Usuario
analógico 12 Dispositivosde destino 1-32

6 Medios virtuales
externos 13 Cablesadaptadores

7 KVM s4-3242
conmutador

Introducción

Antes de instalar el conmutador, consulte la lista siguiente para asegurarse de
que tiene todos los componentes enviados con el conmutador, así como todos
los elementos necesarios para una instalación adecuada.

Suministrado con el conmutador

• Kit de soporte de montaje en rack

• Guía de instalación rápida del soporte de montaje en rack

• Guía de instalación rápida del KVM s4

• Guía de declaraciones de reglamentación y seguridad

• Cables y adaptadores para los puertos MODEM y SETUP

• Cable(s) de alimentación de CA

Elementos adicionales necesarios

• Un cable adaptador por dispositivo de destino

• Un cable adaptador serie por dispositivo serie

• Un cable de interconexión UTP por cable adaptador (UTP de 4 pares, de
hasta 45 metros)

• Cable(s) de interconexión UTP para conectividad de red (UTP de 4 pares,
de hasta 45 metros)

• Un cable adaptador compatible con medios virtuales por dispositivo de
destino para sesiones de medio virtual

• Un cable adaptador compatible con tarjeta inteligente por dispositivo de
destino para control de la tarjeta inteligente
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2. Instalación

Configuración de la red

El conmutador usa direcciones IP para identificar el conmutador y los
dispositivos de destino de forma exclusiva. El conmutador KVM s4 es compatible
tanto con el protocolo de configuración dinámica de host (DHCP) y con el
direccionamiento IP estático. Asegúrese de que se reserven direcciones IP para
cada conmutador y que permanezcan estáticas cuando el conmutador esté
conectado a la red.

2.2 Montaje en rack de un conmutador KVM s4
Con cada conmutador se suministra un juego de montaje en rack. Puede colocar
el conmutador en la estantería del rack o montarlo directamente en un rack
estándar EIA (Asociación de Industrias Electrónicas).

El conmutador puede montarse en rack en una configuración 1U o 0 U.

Consideraciones de seguridad para el montaje en rack

• Carga del rack: La sobrecarga o carga desigual de racks pueden ocasionar
un fallo del rack o estantería, causando daños al equipo y posibles lesiones
personales. Estabilice los racks en una ubicación permanente antes de
iniciar la carga. Proceda con el montaje de los componentes empezando
por la parte inferior del rack y, a continuación, siga hacia la parte superior.
No supere la capacidad de carga del rack.

• Consideraciones sobre la alimentación: Realice conexiones solamente a la
fuente de alimentación especificada en la unidad. Cuando en un rack se
instalen varios componentes eléctricos, asegúrese de que los índices totales
de alimentación de los componentes no superen las capacidades del
circuito. Los cables alargadores y las fuentes de alimentación
sobrecargados representan un riesgo de descarga eléctrica e incendio.

• Temperatura ambiente elevada: Si se instala en un montaje en rack cerrado,
la temperatura de funcionamiento del entorno del rack puede ser superior a
la temperatura de la sala. Tenga cuidado de que no se supere la
temperatura ambiente máxima establecida para el conmutador.

• Flujo de aire reducido: Instale el equipo en el rack de tal forma que exista la
cantidad de flujo de aire necesaria para que el equipo funcione de manera
segura.

• Toma de tierra fiable: Asegúrese de que los equipos montados en rack
estén conectados a una toma de tierra fiable. Preste especial atención a las
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2.3 Conexión del hardware del conmutador

conexiones de alimentación que no sean conexiones directas al circuito
derivado (por ejemplo, uso de enchufes múltiples).

• El producto no debería montarse con el panel posterior orientado hacia
abajo.

Para obtener instrucciones completas sobre cómo instalar el soporte de montaje
en rack, consulte la Guía de instalación rápida del KVM s4.

2.3 Conexión del hardware del conmutador
Para conectar y encender el conmutador:

Para evitar posibles problemas de vídeo o teclado cuando se utilicen
productos de Fujitsu: Si el edificio dispone de alimentación de CA trifásica,
asegúrese de que el ordenador y la pantalla estén en lamisma fase. Para conseguir
mejores resultados, los dosdeben estar en elmismo circuito.

ADVERTENCIA: Para reducir los riesgos de descarga eléctrica o daños en el
equipo:
- No desactive el enchufe de toma de tierra de alimentación. El enchufe de toma de
tierra esuna característica de seguridad importante.
- Conecte el cable de alimentación a un enchufe con toma de tierra al que se pueda
acceder fácilmente en todomomento.
- Desconecte la alimentación del producto desenchufando el cable de alimentación del
enchufe eléctrico o del producto.
- La entrada de CAeselmodo principal de desconectar la alimentación a este
producto. Para productosque tienenmásde una entrada de CA, a fin de interrumpir la
alimentación completamente esnecesario desconectar todos los cablesde
alimentación de CA.
- Este producto no cuenta con piezasa las que se pueda realizar elmantenimiento
dentro de la carcasa del producto. No abre o retire la cubierta del producto .

1. Conecte un cable VGA para el monitor y los cables del teclado y el ratón
USB en los puertos etiquetados correspondientes.

2. Seleccione un puerto disponible en el conmutador. Conecte un extremo de
un cable UTP (4 pares, hasta 45 m) en un puerto numerado. Enchufe el otro
extremo en un conector RJ-45 de un cable adaptador.

3. Conecte el cable adaptador en los puertos correspondientes de la parte
posterior del dispositivo de destino. Repita este procedimiento en todos los
dispositivos de destino que desee conectar.
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2. Instalación

Cuando conecte un dispositivo de destinoMicrosystemsSun, debe usar unmonitor de
sincronizaciónmúltiple en el puerto local para que sea posible utilizar ordenadoresSun
compatibles con VGA ycon sincronización en verde o sincronización compuesta.

4. Conecte ambos puertos LAN a conmutadores Ethernet independientes para
proporcionar redundancia.

5. Encienda cada uno de los dispositivos de destino y, a continuación, localice
el (los) cable(s) de alimentación suministrado(s) con el conmutador.
Conecte un extremo a la toma de alimentación situada en la parte posterior
del conmutador. Conecte el otro extremo en la toma de pared de CA
adecuada. Utilice el segundo cable de alimentación para conectar la
segunda toma de alimentación situada en la parte posterior del conmutador.
Conecte el otro extremo en una toma de pared adecuada.

Enchufe las fuentesde alimentación redundantesen circuitos derivados
independientespara proporcionar redundancia adicional en el caso de que se
interrumpa alguna fuente de alimentación de CAexterna.

Para conectar los medios virtuales locales o un lector de tarjeta inteligente:

Conecte los medios virtuales o un lector de tarjeta inteligente a un puerto USB
disponible en el conmutador.

Para todas las sesionesdemedio virtual o lectoresde tarjeta inteligente, debe usar un
cable adaptador USB20-VGAadaptador KVM s4.

Para obtener más información sobre cómo conectar los medios virtuales de
forma remota, consulte "Medio Virtual" en la página 67. Para obtener más
información sobre cómo conectar una tarjeta inteligente, consulte "Tarjetas
inteligentes" en la página 73.

Para conectar un cable adaptador serie a un dispositivo serie mediante un
conector UTP:

1. Conecte el conector UTP del cable adaptador serie al dispositivo serie.

-o bien-

Conecte el cable adaptador serie a un adaptador hembra RJ-45 a 9
clavijas. Conecte el adaptador al puerto serie del dispositivo serie.

2. Conecte un extremo de un cable UTP (4 pares, hasta 45 m) en un puerto
numerado disponible en la parte posterior del conmutador. Conecte el otro
extremo en el conector RJ-45 del cable adaptador serie.
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2.4 Conexión en cascada de conmutadores KVM s4

3. Conecte un cable de alimentación USB-to-barrel en el conector de
alimentación del cable adaptador serie. Conecte el conector USB en el
cable de alimentación USB-to-barrel en cualquier puerto USB disponible en
el dispositivo de destino serie.

2.4 Conexión en cascada de conmutadores KVM s4
Puede conectar en cascada hasta dos niveles de conmutadores KVM s4, de este
modo los usuarios pueden conectar hasta 1.024 servidores. En un sistema de
conexión en cascada, cada puerto de destino del conmutador principal se
conecta al puerto de interfaz analógica de consola (ACI) en cada conmutador
conectado en cascada. A continuación, cada conmutador conectado en cascada
podrá conectarse a un dispositivo con un cable adaptador.
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2. Instalación

Figura 2.2. Configuración en cascada del conmutador KVM s4

Número Descripción

1 Conmutador KVM s4 principal

2 Conmutador KVM s4 conectado en cascada

3 Puerto de destino en el conmutador principal

4 Puerto ACI en el conmutador conectado en cascada

5 Dispositivosde destino conectadosa los conmutadores

Tabla 2.2: Descripciones para la Figura 2.2

590-1058-640A14



2.5 Configuración de conmutadores KVM s4

Para conectar en cascada varios conmutadores:

1. Conecte un extremo del cable CAT 5 a un puerto de destino del conmutador
KVM s4.

2. Conecte el otro extremo del cable CAT 5 al puerto ACI (icono de eslabón de
cadena) situado en la parte posterior del conmutador KVM s4 conectado en
cascada.

3. Conecte los dispositivos al conmutador KVM s4 conectado en cascada.

4. Repita estos pasos para todos los conmutadores KVM s4 conectados en
cascada que desee acoplar a su sistema.

El sistema "unirá" de forma automática los dos conmutadores. Todos los dispositivos
conectadosa los conmutadoresen cascada aparecerán en la lista de dispositivosdel
conmutador principal en la interfaz de usuario local.

El conmutador admite un conmutador conectado en cascada por cada puerto de
destino en el conmutador principal. No esposible acoplar másconmutadoresal
conmutador conectado en cascada.

La conexión en cascada del puerto local no es compatible en elKVM s4.

2.5 Configuración de conmutadores KVM s4
Una vez realizadas todas las conexiones físicas, deberá configurar el
conmutador para poder usarlo en todo el sistema del conmutador. Esto puede
hacerse de dos modos.

Para configurar el conmutador mediante el software DSView 3:

Consulte la Guía de uso e instalación de DSView 3 para obtener más
información.

Para configurar el conmutador mediante la interfaz de usuario local:

Consulte "Configuración de red" en la página 32 para obtener más información
sobre cómo utilizar la interfaz de usuario local para configurar los parámetros
iniciales de la red.

Configuración del servidor de Web incorporado

Puede acceder al conmutador a través de un servidor de Web integrado que se
ocupa de la mayor parte de las tareas rutinarias. Antes de utilizar el servidor de
Web para acceder al conmutador, debe especificar en primer lugar una dirección
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2. Instalación

IP a través del puerto local en la parte posterior del conmutador o de la interfaz
de usuario local.

Conexión a la OBWI a través de un firewall

Para las instalaciones del conmutador que usen la OBWI para obtener acceso, si
se desea conseguir acceso externo será necesario que los siguientes puertos
estén abiertos en un firewall.

Número de
puerto TCP Función

22 Se utiliza para SSH para sesiones series a un cable adaptador serie

23 Se utiliza para Telnet (cuando Telnet está activado)

80 Se utiliza para la descarga inicial delVisor de vídeo

443 Lo utiliza la interfaz del navegador Web para administrar el conmutador
e iniciar sesionesKVM

2068 Transmisión de losdatosde la sesión KVM (ratón y teclado) o
transmisión de vídeo en los conmutadores

Tabla 2.3: Puertos TCP y funciones para la OBWI del conmutador

En una configuración normal, como se muestra en la Figura 2.3, el ordenador del
usuario está ubicado fuera del firewall y el conmutador reside dentro del firewall.

Figura 2.3. Configuración normal del firewall del conmutador
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2.6 Verificación de las conexiones

Tabla 2.4. Descripciones para la Figura 2.3

Número Descripción

1 Conmutador KVM s4

2 Firewall

3 Ordenador del usuario

4 ElFirewall envía las solicitudesHTTP yel tráfico KVM al conmutador

5 El usuario selecciona la dirección IP externa del firewall

Configuración del firewall:

Para acceder al conmutador desde el exterior de un firewall, configure el firewall
para transferir los puertos 22, 23 (si Telnet está activado), 80, 443 y 2068 desde
la interfaz externa al conmutador KVM a través de la interfaz interna del firewall.
Consulte en el manual del firewall las instrucciones para reenviar puertos
específicos.

Para obtener información sobre cómo iniciar la OBWI, consulte "OBWI" en la
página 22.

2.6 Verificación de las conexiones

Indicadores LED de la conexión Ethernet del panel posterior

En un conmutador KVM s4, el panel posterior incluye dos LED que indican el
estado de la conexión Ethernet LAN1 y dos que indican el estado de la conexión
Ethernet LAN2.

• Los LED verdes se encenderán cuando se establezca una conexión válida
a la red y parpadearán cuando haya actividad en el puerto.

• Los LED de dos colores pueden encenderse en color verde o ámbar.

• Se encenderán en color verde cuando la velocidad de comunicación se
corresponda a 1000 M.

• Se encenderán en color ámbar cuando la velocidad de comunicación
se corresponda a 100 M.

• No se encenderán cuando la velocidad de comunicación sea de 10 M.
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2. Instalación

Indicadores LED de estado de la alimentación del panel posterior

El panel posterior de cada equipo incluye dos LED de estado de alimentación,
uno para cada fuente de alimentación. El color del (de los) LED es verde cuando
el conmutador está encendido y funciona con normalidad.

• El LED está apagado si la fuente de alimentación no recibe alimentación o
ha fallado.

• El LED se enciende cuando la unidad está lista.

• El LED parpadea cuando el conmutador se está iniciando o se está
efectuando una actualización.

• El LED parpadea indicando "SOS" si se produce una condición de error,
como por ejemplo un fallo en la fuente de alimentación, existe una
temperatura ambiente elevada, o falla el ventilador. El LED continuará
indicando "SOS" mientras persista el fallo.

El conmutador impide que se produzca una interrupción serie del dispositivo
acoplado en caso de que el módulo sufra un corte de alimentación. No obstante,
un usuario puede provocar una interrupción serie con el dispositivo acoplado
pulsando Serial Break en el visor de sesión serie.

2.7 Ajuste de la configuración del ratón en los
dispositivos de destino
Antes de que un usuario remoto pueda llevar a cabo operaciones de control
desde un ordenador conectado al conmutador, debe definir la velocidad del
ratón de destino y desactivar la aceleración. En el caso de ordenadores con
Microsoft®Windows® (Windows XP, Windows Vista, Windows 2003, Windows
2008 y Windows 7), utilice el controlador de ratón PS/2 predeterminado.

Para asegurarse de que el movimiento del ratón local y la visualización del
cursor remoto estén sincronizados, es necesario definir la aceleración del ratón
a cero en todas las cuentas de usuario que accedan al sistema remoto a través
de un conmutador KVM. La aceleración del ratón también debe configurarse a
cero en cada sistema remoto. No deben utilizarse los cursores especiales y las
opciones de visibilidad del cursor, como por ejemplo los rastros del puntero, las
animaciones de ubicación del cursor de activación con la tecla Ctrl, las sombras
del cursor y la ocultación del cursor también deben estar desactivadas.
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Si no puede desactivar la aceleración del ratón desde un sistema operativoWindowso
si no desea ajustar la configuración de todos los dispositivosde destino, puede utilizar el
comandoHerramientas>Modo de cursor simple que encontrará en la ventana Visor
de vídeo. Este comando sitúa la ventana delVisor de vídeo en unmodo de "ratón
invisible" que le permite alternar de formamanual el control entre el puntero del ratón
en el sistema de destino que se está visualizando yel puntero del ratón en el ordenador
cliente.
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3.1 Interfaces de usuario
El conmutador KVM s4 viene equipado con dos interfaces interactivas: una
interfaz de usuario local y una interfaz Web incorporada remota (OBWI). Gracias
a las opciones de configuración que facilitan estas interfaces, puede
personalizar el conmutador según su aplicación específica, controlar cualquier
dispositivo acoplado y responder a todas las necesidades del conmutador serie
o KVM básicas.

La interfaz de usuario local y la OBWI remota son prácticamente idénticas. Salvo que se
especifique lo contrario, toda la información recogida en este capítulo se refiere a
ambas interfaces.

Desde estas dos interfaces puede iniciar dos tipos de sesiones diferentes:

• La ventana Visor de vídeo le permite controlar las funciones del teclado, el
monitor y el ratón de los distintos dispositivos de destino individuales
conectados al conmutador en tiempo real. También puede utilizar macros
globales predefinidas para realizar operaciones dentro de la ventana Visor
de vídeo. Para obtener instrucciones sobre cómo utilizar el Visor de vídeo,
consulte el Capítulo 4.

• La ventana del visor serie le permite administrar dispositivos de destino
individuales utilizando comandos o secuencias de comandos.

Interfaz de usuario local

El conmutador incluye un puerto local en la parte posterior. Este puerto le
permite conectar un teclado, un monitor y un ratón directamente al conmutador y
utilizar la interfaz de usuario local.

Entre las pulsaciones de teclas siguientes podrá elegir la que quiera que se
configure para abrir la interfaz de usuario local o alternar entre la interfaz de
usuario local y la sesión activa: Impr Pant, Ctrl +Ctrl, Mayús +Mayús, y Alt +Alt.

Para iniciar la interfaz de usuario local:

1. Conecte los cables del teclado, monitor y ratón al conmutador. Para obtener
más información, consulte "Conexión del hardware del conmutador" en la
página 11.
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2. Pulse cualquiera de las pulsaciones de tecla activadas para iniciar la
interfaz de usuario local.

3. Si la autenticación de la interfaz de usuario local se ha activado, introduzca
el nombre de usuario y la contraseña.

Si el conmutador se ha añadido a un servidor DSView 3, se accederá a este con el fin
de llevar a cabo la autenticación del usuario. Si el conmutador no se ha añadido a un
servidor DSView 3, o si no esposible conectar con el servidor DSView 3, entonces se
accederá a la base de datosdel usuario local para realizar la autenticación del usuario.
El nombre de usuario local predeterminado esAdmin yno existe contraseña. Los
nombresde usuario en la base de datosdel usuario local distinguen entremayúsculas y
minúsculas.

OBWI

La OBWI del conmutador es una interfaz de usuario remota basada en
explorador de Web. Para obtener más información sobre cómo configurar el
sistema, consulte "Conexión del hardware del conmutador" en la página 11. En
la siguiente se enumeran los sistemas operativos y los exploradores compatibles
con la OBWI. Asegúrese de estar utilizando la versión más reciente del
explorador de Web.

Tabla 3.1. Navegadores y sistemas operativos compatibles con la OBWI

Sistema operativo

Navegador

Microsoft® Internet
Explorer versión
6.0 SP1 ysuperior

Firefox versión 3.0 y superior.

MicrosoftWindows
Server® 2003
Standard, Enterprise o
Web Edition

Sí Sí

MicrosoftWindows
Server® 2008
Standard, Enterprise o
Web Edition

Sí Sí

WindowsXP
Professional con
Service Pack3

Sí Sí
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Sistema operativo

Navegador

Microsoft® Internet
Explorer versión
6.0 SP1 ysuperior

Firefox versión 3.0 y superior.

WindowsVista®

Business con Service
Pack1

Sí Sí

Windows7 Sí Sí

Red Hat Enterprise
Linux® 4 y5 Standard,
Enterprise oWeb
Edition

No Sí

Sun Solaris 10 y11 No Sí

Solaris 10 x86 No Sí

Estación de trabajo
Ubuntu 8

No Sí

Para iniciar sesión en la OBWI del conmutador:

1. Inicie un navegador Web.

2. En el campo de dirección del navegador, introduzca la dirección IP o el
nombre host asignado al conmutador al que desee acceder. Use
https://xxx.xx.xx.xx o https://hostname como formato.

Si usa elmodo IPv6, la dirección IP debe figurar entre corchetes. Use https://[<dirección
ip>] como formato.

3. Cuando el navegador establezca contacto con el conmutador, introduzca el
nombre de usuario y la contraseña, y, a continuación, haga clic en Iniciar
sesión. Aparecerá la OBWI del conmutador.

El nombre de usuario predeterminado esadmin con contraseña admin.
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Para iniciar sesión en la OBWI del conmutador desde el exterior de un firewall,
repita todo el procedimiento anterior e introduzca la dirección IP externa del
firewall en su lugar.

Uso de las interfaces de usuario

Tras realizarse la autenticación, aparece la interfaz de usuario. Puede ver,
acceder y administrar el conmutador, así como especificar la configuración del
sistema y cambiar los parámetros del perfil. La Figura 3.1 muestra las zonas de
la ventana de la interfaz de usuario para el conmutador y las descripciones se
suministran en la tabla siguiente.

Figura 3.1. Ventana de la interfaz de usuario

Número Descripción

1

Barra de opciones superior: Use la barra de opciones superior para
marcar una ventana de la interfaz, actualizar la visualización de una
ventana de la interfaz, imprimir una páginaWeb, cerrar una sesión OBWI
o acceder a la página de ayuda en pantalla. El nombre del usuario que ha
iniciado sesión aparece en el lado izquierdo de la barra de opciones
superior.

Tabla 3.2: Descripciones de la interfaz de usuario
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Número Descripción

2

Barra de exploración lateral: Use la barra de exploración lateral para
seleccionar y visualizar la información del sistema en la zona de
contenido. La barra de exploración lateral también contiene iconosen la
esquina superior izquierda que, al hacer clic sobre ellos, amplían o
contraen todos los nodos.

3 Zona de contenido: Use la zona de contenido para visualizar o realizar
cambiosen el sistema de la OBWI del conmutador.

Uso de la barra de exploración lateral

Puede usar la barra de exploración lateral para mostrar las ventanas en las que
se pueden especificar parámetros o realizar operaciones. Si se hace clic en un
enlace que no contiene una flecha se mostrará su ventana correspondiente.

Uso de la barra de opciones superior

Si la autenticación está desactivada, en la interfaz de usuario local solo aparece el botón
Actualizar. Si la autenticación está activada, en la interfaz de usuario local solo aparece
el botón Actualizar y el botón Cerrar sesión. En la OBWI remota aparecen todos los
botones.

Marcado de una ventana (Microsoft Internet Explorer sólo)

La barra de opciones superior de la interfaz de usuario contiene texto y un icono
de marcado. Puede marcar una ventana para agregar un enlace a la ventana en
el menú desplegable Favoritos. Puede seleccionar el enlace en cualquier
momento para acceder con rapidez a la ventana marcada.

Si marca una ventana y la información relacionada con la ventana cambia, esta
nueva información aparecerá en la ventana cuando visualice la próxima vez
dicha ventana marcada.

Al hacer clic en MARCADOR o en el icono del marcador tras haber finalizado la
sesión OBWI del conmutador, se abrirá la ventana Inicio de sesión de usuario y
deberá iniciar la sesión de nuevo.

Para marcar una ventana:

1. En la barra de opciones superior, haga clic en MARCADOR o en el icono de
marcado. Aparece el cuadro de diálogo Agregar favoritos.

2. Si lo desea, escriba un nombre para la ventana. También puede hacer clic
en el botón Crear en para crear o especificar una carpeta en la que colocar
la ventana.
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3. Haga clic en Aceptar para cerrar el cuadro de diálogo Agregar favoritos.

Impresión de una ventana

Todas las ventanas OBWI del conmutador contienen un icono de impresión en la
barra de opciones superior.

Para imprimir la ventana de la OBWI del conmutador:

1. En la barra de opciones superior, haga clic en IMPRIMIR o en el icono de
impresión. Aparece el cuadro de diálogo Imprimir.

2. Especifique las opciones que desea utilizar para imprimir la ventana de la
OBWI del conmutador.

3. Haga clic en Imprimir para imprimir la ventana de la OBWI del conmutador y
cerrar el cuadro de diálogo Imprimir.

Actualización de una ventana

La interfaz de usuario del conmutador puede actualizarse en cualquier momento
haciendo clic en ACTUALIZAR o en el icono de actualización en la barra de
opciones superior.

Cerrando sesión

Para cerrar sesión en cualquier momento, haga clic en el icono de cierre de
sesión en la barra de opciones superior.

3.2 Visualización de información del sistema
Puede ver información sobre varios equipos y dispositivos de destino desde
diferentes pantallas en la interfaz de usuario.

Tabla 3.3. Información del sistema

Categoría Seleccionar esto: Para ver esto:

Conmutador

Vista de unidades>
Equipo >
Información
general

Nombre y tipo del conmutador y herramientas
del equipo
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Categoría Seleccionar esto: Para ver esto:

Vista de unidades>
Equipo >
Propiedades>
Identidad

Revisión del firmware actual para la aplicación
yboot

Vista de unidades>
Equipo >
Propiedades>
Ubicación

Sitio, departamento o ubicación

Vista de unidades>
Equipo >
Configuración del
equipo >Versiones

Revisión del firmware actual para la aplicación,
boot y vídeo FPGA

Vista de unidades>
Conexiones

Lista de los dispositivosacoplados

Dispositivo de
destino

Vista de unidades>
Dispositivosde
destino

Lista de los dispositivosde destino conectados,
así como la información siguiente acerca de
cada dispositivo: Nombre, tipo, estado yacción

Haga clic en uno de losdispositivosde destino
para ver la siguiente información adicional:
Nombre, tipo, eID, opción de sesión disponible
y ruta de conexión

También se le avisará si se produce alguna de las situaciones de fallo
siguientes: Fallo de la fuente de alimentación, temperatura ambiente elevada o
fallo del ventilador. Aparece un triángulo amarillo con un signo de exclamación y
el nombre del fallo en el encabezado de cada pantalla. Esta notificación
aparecerá o desaparecerá solo tras actualizar la página. Puede hacer clic sobre
la notificación para obtener más información.

3.3 Sesiones del conmutador KVM s4
En la pantalla Sesiones activas, puede ver una lista de las sesiones activas
además de la información siguiente sobre cada sesión: Dispositivo de destino,

590-1058-640A 27



3. Configuración local y remota

propietario, host remoto, duración y tipo.

Inicio de una sesión
Espreciso disponer de Java 1.6.0_11 o superior para iniciar una sesión.

Para iniciar una sesión:

1. En la barra de exploración lateral, seleccione Vista de unidades >
Dispositivos de destino. Aparece una lista de los dispositivos disponibles.

2. Haga clic en el enlace Sesión KVM o Sesión serie a la derecha del
dispositivo de destino deseado para iniciar la sesión.

Si el dispositivo de destino se está usando en ese momento, los usuarios que
estén intentando acceder tendrán la oportunidad de forzar la conexión al
dispositivo si su nivel de preferencia es igual o superior al del usuario actual.

Para conmutar a la sesión activa desde la interfaz de usuario local (solo
usuarios locales):

1. En la barra de exploración lateral, seleccione Sesión local.

2. Seleccione la casilla de verificación Reanudar sesión activa. Aparece la
ventana Visor de vídeo.

-o bien-

Pulse Esc.

Configuración de sesiones

Para configurar los parámetros generales de la sesión:

1. En la barra de exploración lateral, seleccione Vista de unidades > Equipo >
Configuración del equipo > Sesiones > General. Aparece la pantalla
Configuración general de sesión del equipo.

2. Seleccione o cancele la selección de la casilla de verificación Activar tiempo
de espera de inactividad.

3. En el campo Tiempo de espera de inactividad, introduzca el tiempo de
inactividad que quiere que transcurra antes de que se cierre la sesión (de 1
a 90 minutos).

4. En el campo Tiempo de espera de inicio de sesión, introduzca el tiempo de
inactividad que quiere que transcurra antes de que deba iniciar la sesión
nuevamente (de 1 a 120 segundos).
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5. Seleccione o cancele la selección de la casilla de verificación Activar tiempo
de espera de preferencia.

6. En el campo Tiempo de espera de preferencia introduzca el tiempo (de 1 a
120 segundos) durante el que se visualizará un mensaje informándole de
que se va a dar preferencia a su sesión.

7. Haga clic en Guardar.

Para configurar los parámetros de la sesión KVM:

1. En la barra de exploración lateral, seleccione Vista de unidades > Equipo >
Configuración del equipo > Sesiones > KVM. Aparece la pantalla
Configuración de sesión KVM del equipo.

2. Seleccione un nivel de cifrado para las señales de teclado y ratón (SSL de
128 bits, DES, 3DES, o AES) y para las señales de vídeo (SSL de 128 bits,
DES, 3DES, AES, o Ninguno).

3. Seleccione un idioma en el menú desplegable Teclado.

4. Haga clic en Guardar.

Para configurar los parámetros de la sesión serie:

1. En la barra de exploración lateral, seleccione Vista de unidades > Equipo >
Configuración del equipo > Configuración > Serie. Aparece la pantalla
Configuración de sesión serie del equipo.

2. Active o desactive la casilla de verificación Acceso Telnet activado.

3. Haga clic en Guardar.

Cierre de una sesión

Para cerrar una sesión:

1. En la barra de exploración lateral, seleccione Sesiones activas para
visualizar la pantalla Sesiones del equipo.

2. Haga clic en la casilla de verificación junto al (a los) dispositivo(s) de destino
deseado(s).

3. Haga clic en Desconectar.

Si existe una sesión demedio virtual vinculada asociada se desconectará.

Para cerrar una sesión (usuarios locales solo):

1. En la barra de exploración lateral, seleccione Sesión local.
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2. Seleccione la casilla de verificación Desconectar sesión activa.

3.4 Herramientas del conmutador KVM s4
En la pantalla Información general de la unidad puede ver el nombre y el tipo del
equipo. También puede realizar tareas del equipo básicas:

Reinicio del conmutador

Para reiniciar el conmutador:

1. En la barra de exploración lateral, seleccione Vista de unidades > Equipo >
Información general para abrir la pantalla Información general de la unidad.

2. Haga clic en Reiniciar.

3. Aparece un cuadro de diálogo avisándole de que todas las sesiones activas
se desconectarán. Haga clic en Aceptar.

Si está utilizando la interfaz de usuario local, la pantalla se quedará en blancomientras
el conmutador se reinicia. Si está utilizando la OBWI remota, aparecerá unmensaje
indicándole que la interfaz está esperando a que el equipo complete el reinicio.

Actualización del firmware del equipo

Puede actualizar el conmutador con el firmware más reciente disponible.

Una vez que la memoria Flash se haya reprogramado con la actualización, el
conmutador llevará a cabo un reinicio mediante software que finalizará todas las
sesiones del cable adaptador. Es posible que el dispositivo de destino para el
que se está actualizando el firmware del cable adaptador no se muestre o que
se muestre como un dispositivo desconectado. El dispositivo de destino
aparecerá en su estado normal una vez que se haya finalizado la actualización
de la memoria Flash.

ADVERTENCIA: Si se desconecta un cable adaptador durante una actualización del
firmware o se interrumpe la alimentación al dispositivo de destino, se inutilizará el
módulo y será necesario devolver el cable adaptador a la fábrica para su reparación.

Para actualizar el firmware del conmutador:

1. En la barra de exploración lateral, seleccione Vista de unidades > Equipo >
Información general para abrir la pantalla Información general de la unidad.

2. Haga clic en Actualizar el firmware para abrir Actualizar el firmware del
equipo.
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3. Seleccione una de las opciones siguientes para cargar el archivo de
firmware:Sistema de archivos, TFTP, FTP, o HTTP.

La opción Sistema de archivos solo está disponible en la OBWI remota.

4. Si ha elegido Sistema de archivos, seleccione Examinar para especificar la
ubicación del archivo de actualización del firmware.

-o bien-

Si ha seleccionado TFTP, introduzca la dirección IP del servidor y el
archivo de firmware que desea cargar.

-o bien-

Si ha seleccionado FTP o HTTP, introduzca la dirección IP del servidor y
el archivo de firmware que desea cargar, así como el nombre de
usuario y la contraseña de usuario.

5. Haga clic en Actualizar..

Guardar y restaurar las configuraciones del equipo y las bases de
datos del usuario

Puede guardar la configuración del conmutador en un archivo. El archivo de
configuración contendrá información sobre el equipo administrado. También
puede guardar la base de datos del usuario local en el conmutador. Tras
guardar cualquier archivo, puede también restaurar un archivo de configuración
o un archivo de la base de datos del usuario local previamente guardados en el
conmutador.

Para guardar una configuración de un equipo administrado o la base de datos
de usuario de un equipo administrado:

1. En la barra de exploración lateral, seleccione Vista de unidades > Equipo >
Información general para abrir la pantalla Información general de la unidad.

2. Haga clic en Guardar la configuración del equipo o Guardar la base de
datos de usuario del equipo. El cuadro de diálogo Descarga del archivo se
abrirá.

3. Haga clic en Guardar. El cuadro de diálogo Guardar como se abrirá.

4. Vaya a la ubicación deseada e introduzca un nombre para el archivo. Haga
clic en Guardar.

5. Haga clic en Cerrar.
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Para restaurar una configuración de un equipo administrado o la base de
datos de usuario de un equipo administrado:

1. En la barra de exploración lateral, seleccione Vista de unidades > Equipo >
Información general para abrir la pantalla Información general de la unidad.

2. Haga clic en Restaurar la configuración del equipo o Restaurar la base de
datos de usuario del equipo. Aparecerá la ventana Restaurar la
configuración del equipo o la ventana Restaurar la base de datos de usuario
del equipo.

3. Haga clic en Examinar. Vaya a la ubicación deseada y seleccione el nombre
del archivo. Haga clic en Cargar.

4. Cuando aparezca la ventana correcta, haga clic en Cerrar. Reinicie el
equipo administrado para activar la configuración restaurada. Consulte
"Herramientas del conmutador KVM s4" en la página 30.

3.5 Configuración de red
Sólo los administradoresdel conmutador pueden aplicar cambiosen la configuración
del cuadro de diálogo Red. Losdemásusuarios tendrán acceso de solo lectura.

Para configurar los parámetros generales de red:

1. En la barra de exploración lateral, seleccione Vista de unidades > Equipo >
Configuración del equipo > Red > General. Aparece la pantalla
Configuración de red general del equipo.

2. Seleccione una de las opciones siguientes en el menú desplegable
Velocidad de la LAN: Detección automática, 10 Mbps de dúplex medio, 10
Mbps de dúplex completo, 100 Mbps de dúplex medio, 100 Mbps de dúplex
completo o 1 Gbps de dúplex completo.

Debe reiniciar si cambia almodo Ethernet.

3. Seleccione Activado o Desactivado en el menú desplegable Respuesta de
ping de ICMP.

4. Haga clic en Guardar.

Para configurar los parámetros de red IPv4:

1. En la barra de exploración lateral, seleccione Vista de unidades > Equipo >
Configuración del equipo > Red > IPv4. Aparece la pantalla Configuración
IPv4 del conmutador.
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2. Seleccione o cancele la selección de la casilla de verificación Activar IPv4
para activar o desactivar el modo IPv4.

3. Introduzca la información deseada en los campos Dirección, Subred y
Puerta de enlace.

4. Seleccione Activado o Desactivado en el menú desplegable DHCP.

Si activa DHCP se ignorará cualquier información que haya introducido en los campos
Dirección, Subred yPuerta de enlace.

5. Haga clic en Guardar.

Para configurar los parámetros de red IPv6:

1. En la barra de exploración lateral, seleccione Vista de unidades > Equipo >
Configuración del equipo > Red > IPv6. Aparece la pantalla Configuración
IPv6 del conmutador.

2. Seleccione o cancele la selección de la casilla de verificación Activar
configuración con estado de IPv6 para activar o desactivar.

3. Introduzca la información deseada en los campos Dirección, Puerta de
enlace y Longitud del prefijo.

4. Seleccione Activado o Desactivado en el menú desplegable DHCPv6.

Si activa DHCPv6 se ignorará cualquier información que haya introducido en los
camposDirección, Puerta de enlace yLongitud del prefijo.

5. Haga clic en Guardar.

3.6 Configuración del DNS
Puede optar entre asignar manualmente el servidorDNS o utilizar las direcciones
obtenidas utilizando DHCP o DHCPv6.

Para configurar manualmente los parámetros del DNS:

1. En la barra de exploración lateral, seleccione Vista de unidades > Equipo >
Configuración del equipo > DNS. Aparece la pantalla Configuración DNS
del equipo.

2. Seleccione Manual, DHCP (si IPv4 se ha activado) o DHCPv6 (si IPv6 se ha
activado).

590-1058-640A 33



3. Configuración local y remota

3. Si ha seleccionado Manual, introduzca los números del servidor DNS en los
campos Primario, Secundario y Terciario.

4. Haga clic en Guardar.

3.7 Configuración de la interfaz de usuario local
Para cambiar el modo en que se inicia la interfaz de usuario local:

1. En la barra de exploración lateral, seleccione Vista de unidades > Equipo >
Configuración del equipo > Puertos > Interfaz de usuario del puerto local
para abrir la pantalla Configuración de la interfaz de usuario del puerto
local.

2. Bajo el encabezado Iniciar IU del puerto local, seleccione la casilla de
verificación junto a uno o varios de los métodos enumerados.

3. Haga clic en Aceptar.

Configuración del usuario del puerto local

Puede activar o desactivar la autenticación de la interfaz de usuario del puerto
local y seleccionar un nivel de acceso de usuario. Si activa la autenticación de la
interfaz de usuario del puerto local, se le pedirá que inicie sesión para poder
usar la interfaz.

También puede seleccionar el idioma del teclado del puerto local, tiempo del
modo de escaneo, activar/desactivar la contraseña del puerto de configuración y
seleccionar un nivel de preferencia del usuario. El nivel de preferencia de los
usuarios determina si estos pueden desconectar una sesión KVM o serie de otro
usuario con un dispositivo de destino. Los niveles de preferencia van del 1 al 4,
siendo el 4 el nivel más alto. Por ejemplo, un usuario con un nivel de preferencia
del 4 puede tener preferencia sobre otros usuarios de nivel 4, y también sobre
aquellos con un nivel 1, 2, o 3.

Para cambiar el nivel de preferencia determinado (administrador solo):

1. En la barra de exploración lateral, seleccione Vista de unidades > Equipo >
Configuración del equipo > Puertos > Interfaz de usuario del puerto local
para abrir la pantalla Configuración de la interfaz de usuario del puerto
local.

2. Seleccione o anule la selección de la casilla de verificación Desactivar
autenticación del usuario de puerto local.
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3. Seleccione una de las siguientes opciones del menú desplegable Nivel de
acceso del usuario: Usuario, Administrador usuario o Administrador del
equipo.

4. Seleccione un número del 1 al 4 del menú desplegable Nivel de preferencia
del usuario.

5. Haga clic en Guardar.

3.8 Medio Virtual
Puede determinar el comportamiento de un conmutador durante una sesión de
medio virtual mediante las opciones incluidas en la pantalla Configuración de la
sesión de Medio Virtual del equipo. En la tabla siguiente se indican las opciones
disponibles para las sesiones de Medio Virtual. Para obtener información sobre
el uso de la función de medio virtual en una sesión KVM, consulte "Medio Virtual"
en la página 67.

Valor de
configuración Descripción

Configuración de la
sesión: Medio virtual
vinculado a sesiones
KVM

La opción de vinculación especifica si la sesión demedio virtual
está o no vinculada a la sesión KVM en el dispositivo de destino.
Cuando la vinculación esté activada (opción predeterminada) y la
sesión KVM se cierre, la sesión demedio virtual también se
cerrará. Por el contrario, cuando la vinculación esté desactivada y
la sesión KVM se cierre, la sesión demedio virtual permanecerá
activa.

Configuración de la
sesión: Permitir
sesiones reservadas

Mediante esta opción se garantiza que la conexión demedio
virtual sólo sea accesible con su nombre de usuario y que ningún
otro usuario pueda establecer una conexión KVM con ese
dispositivo de destino. Cuando la sesión KVM asociada se
desconecta, la sesión demedio virtual puede desconectarse
mediante la opción Bloqueado del cuadro de diálogoMedio
Virtual.

Tabla 3.4: Configuración de la sesión de Medio Virtual
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Valor de
configuración Descripción

Asignacionesde
unidades: Modo de
acceso deMedio
Virtual

Puede configurar elmodo de acceso a lasunidadesasignadas
como de sólo lectura o sólo escritura. Cuando elmodo de acceso
sea de sólo lectura, el usuario no podrá escribir datosen la unidad
asignada del servidor cliente. Cuando elmodo de acceso sea de
lectura yescritura, el usuario podrá leer y escribir datosdesde/a la
unidad asignada. Si debido a su diseño, la unidad asignada esde
sólo lectura (como por ejemplo una unidad de CD-ROM, una
unidad de DVD-ROMo imágenes ISO), elmodo de acceso
lectura yescritura configurado se omite. La activación delmodo
de sólo lectura puede resultar útil en el caso de que se asignen
unidadesde lectura yescritura, como por ejemplo dispositivosde
almacenamientomasivo omediosextraíblesUSB, y desee
impedir que el usuario pueda escribir datosen ese dispositivo.

Esposible asignar una unidad de DVD yun dispositivo de
almacenamientomasivo de forma simultánea. Puede asignar una
unidad de CD, una unidad de DVD o un archivo de imagen de
disco ISOcomo unidad de CD/DVD virtual.

Nivel de cifrado

Puede definir nivelesde cifrado para las sesionesdemedio virtual.
Lasopciones son las siguientes. Ninguno (opción
predeterminada), SSL de 128 bits (ARCFOUR), DES, 3DES, y
AES.

Acceso deMedio
Virtual por cable
adaptador: Activar
MV/Desactivar MV

La sección Acceso deMedio Virtual por cable adaptador enumera
todos los cablesUSB20-VGAadaptadoresKVM s4. Esta lista
incluye datos sobre cada cable, incluida la opción para activar o
desactivar elmedio virtual para cada cable.

Para configurar las opciones de medio virtual:

1. En la barra de exploración lateral, seleccione Vista de unidades > Equipo >
Configuración del equipo > Sesiones > Medio Virtual para abrir la pantalla
Configuración de la sesión de Medio Virtual del equipo.

2. Active o desactive la casilla de verificación Medio Virtual vinculado a
sesiones KVM.

3. Active o desactive la casilla de verificación Permitir sesiones reservadas.
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4. Seleccione una de las siguientes opciones del modo de acceso de medio
virtual en el menú desplegable: Sólo lectura o Sólo escritura.

5. Seleccione uno de los niveles de cifrado que desee que sea compatible.

6. Seleccione la casilla de verificación que esté situada junto a cada cable
USB20-VGA adaptador KVM s4 para el que desee activar el medio virtual y
haga clic en Activar MV.

-o bien-

Seleccione la casilla de verificación que esté situada junto a cada cable
USB20-VGA adaptador KVM s4 para el que desee desactivar el medio
virtual y haga clic en Desactivar MV.

7. Haga clic en Guardar.

Configuración del medio virtual local

Los usuarios locales pueden determinar el comportamiento del medio virtual
desde la pantalla Sesión local. Además de poder conectar y desconectar una
sesión de medio virtual, puede definir la configuración en la tabla siguiente:

Tabla 3.5. Configuración de la sesión de medio virtual local

Valor de configuración Descripción

CD ROM/

DVD ROM

Permite la sesionesdemedio virtual con las primerasunidades
CD-ROMoDVD-ROM (sólo lectura) detectadas. Active esta
casilla de verificación para establecer una conexión con un
dispositivo de destino desde unmedio virtual de CD-ROMo
DVD-ROM. Desactive esta casilla para finalizar una conexión
con un dispositivo de destino desde unmedio virtual de CD-
ROMoDVD-ROM.

Almacenamiento
masivo

Permite sesionesdemedio virtual con la primera unidad de
almacenamientomasivo detectada. Active esta casilla de
verificación para establecer una conexión con un dispositivo de
destino desde unmedio virtual de almacenamientomasivo.
Desactive esta casilla para finalizar una conexión con un
dispositivo de destino desde unmedio virtual de
almacenamientomasivo.

Reservado

Mediante esta opción se garantiza que la conexión demedio
virtual sólo sea accesible con su nombre de usuario y que
ningún otro usuario pueda establecer una conexión KVM con
ese dispositivo de destino.
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Para definir la configuración de medio virtual local:

1. En la barra de exploración lateral, seleccione Sesión local.

2. Seleccione para activar o anule la selección para desactivar cualquiera de
las opciones de la sesión de medio virtual.

3.9 Configuración del módem
En la pantalla Configuración del módem del equipo puede configurar varios
parámetros del módem, además de ver los siguientes parámetros del módem:
dirección local, dirección remota, máscara de subred y puerta de enlace.

Para obtener información sobre la conexión del conmutador a un módem,
consulte "Conexión del hardware del conmutador" en la página 11.

Para configurar los parámetros del módem:

1. En la barra de exploración lateral, seleccione Vista de unidades > Equipo >
Configuración del equipo > Puertos > Módem para abrir la pantalla
Configuración del módem del equipo.

2. Active o desactive la casilla de verificación Las sesiones de módem pueden
tener preferencia sobre las sesiones digitales.

3. Seleccione un tiempo de espera de autenticación de 30 a 300 segundos y
un tiempo de espera de inactividad de 1 a 60 minutos.

4. Seleccione Guardar.

3.10 Modo de escaneo
En el modo de escaneo, el conmutador escanea automáticamente de puerto en
puerto (de dispositivo de destino en dispositivo de destino). Puede escanear
diversos dispositivos de destino y especificar qué dispositivo escanear. El orden
de escaneo se determina mediante la introducción del dispositivo de destino en
la lista. También puede configurar el intervalo de tiempo antes de que el
escaneo pase al siguiente dispositivo de destino de la secuencia.

El botón Escaneo está desactivado si se ha conectado a travésde unmódem.

Para agregar dispositivos de destino a la lista de escaneo:

1. En la barra de exploración lateral, seleccione Vista de unidades >
Dispositivos de destino para abrir la pantalla Dispositivos de destino.
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2. Seleccione las casillas de verificación junto a los nombres de los
dispositivos de destino que desea escanear.

3. Haga clic en Escaneo.

Para configurar el tiempo de escaneo:

1. En la barra de exploración lateral, seleccione Vista de unidades > Equipo >
Configuración del equipo > Puertos > Interfaz de usuario del puerto local
para abrir la pantalla Configuración de la interfaz de usuario del puerto
local.

2. Bajo el encabezado Modo de escaneo, introduza el intervalo de tiempo en
segundos (de 3-255) en el campo Tiempo de escaneo.

3. Haga clic en Guardar.

3.11 Direcciones IP del dispositivo DSView 3
Puede contactar y registrar un conmutador sin administrar con un servidor
DSView 3 si especifica las direcciones IP para un máximo de cuatro servidores
DSView 3.

Para configurar la dirección IP del servidor DSView 3:

1. En la barra de exploración lateral, seleccione Vista de unidades > Equipo >
Configuración del equipo > Cuentas de usuario > DSView 3. Aparece la
pantalla Configuración de DSView 3.

2. Introduzca hasta cuatro direcciones IP del servidor del software DSView 3
con las que quiere establecer contacto en los campos Servidor 1 - 4.

3. Haga clic en Guardar.

3.12 Cuentas de usuario

Administración de las cuentas locales

La OBWI del conmutador proporciona seguridad de inicio de sesión y local a
través de las cuentas de usuario definidas por el administrador. Al seleccionar
Cuentas locales en la barra de exploración lateral, los administradores pueden
agregar y eliminar usuarios, definir la preferencia del usuario y los niveles de
acceso, y cambiar las contraseñas.

Niveles de acceso

Tras agregar una cuenta de usuario, al usuario se le puede asignar uno de los
siguientes niveles de acceso: Administradores del equipo, Administradores
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usuarios y Usuarios.

Nivel de acceso

Función Administrador
del equipo

Administrador
usuario Usuarios

Configurar los
parámetrosa
nivel del sistema
de la interfaz

Sí No No

Configurar
derechosde
acceso

Sí Sí No

Agregar,
cambiar y
eliminar cuentas
de usuario

Sí, para todos
los nivelesde
acceso

Sí, para los
usuarios y los
administradores
usuarios
únicamente

No

Cambiar la
propia
contraseña

Sí Sí Sí

Acceder al
dispositivo de
destino

Sí, todos los
dispositivosde
destino

Sí, todos los
dispositivosde
destino

Sí, si está permitido

Tabla 3.6: Acciones permitidas en función del nivel de acceso

Para agregar una cuenta de usuario nueva (administrador solo):

1. En la barra de exploración lateral, seleccione Vista de unidades > Equipo >
Configuración del equipo > Cuentas de usuario > Cuentas locales para abrir
la pantalla Cuentas de usuario local del equipo.

2. Haga clic en el botón Agregar.

3. Introduzca el nombre y la contraseña del nuevo usuario en los espacios
provistos.

4. Seleccione los niveles de preferencia y de acceso para el nuevo usuario.
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5. Seleccione cualquiera de los dispositivos de destino que desee asignar a la
cuenta de usuario y haga clic en Agregar.

Losadministradoresusuarios y los administradoresdel equipo pueden acceder a todos
los dispositivosde destino.

6. Haga clic en Guardar.

Para eliminar una cuenta de usuario (administrador solo):

1. En la barra de exploración lateral, seleccione Vista de unidades > Equipo >
Configuración del equipo > Cuentas de usuario > Cuentas locales para abrir
la pantalla Cuentas de usuario local del equipo.

2. Haga clic en la casilla de verificación a la izquierda de cada cuenta que
desee eliminar, haga clic en Eliminar.

Para editar una cuenta de usuario (administrador o usuario activo solo):

1. En la barra de exploración lateral, seleccione Vista de unidades > Equipo >
Configuración del equipo > Cuentas de usuario > Cuentas locales. La
pantalla Cuentas de usuario local del equipo aparece.

2. Haga clic en el nombre del usuario que desee editar. El perfil del usuario
aparecerá.

3. Rellene la información del usuario en la pantalla y, a continuación, haga clic
en Guardar.

3.13 Configuración del SNMP
El SNMP es un protocolo utilizado para comunicar información de administración
entre las aplicaciones de administración de red y el conmutador. Otros
administradores SNMP pueden comunicarse con el conmutador mediante el
acceso a MIB-II (Management Information Base) y a la parte pública de la MIB
empresarial. Cuando abra la pantalla SNMP, la OBWI recuperará los parámetros
del SNMP de la unidad.

En la pantalla SNMP, puede introducir información del sistema y cadenas de
comunidad. También puede designar las estaciones capacitadas para
administrar el conmutador y para recibir interrupciones del SNMP procedentes
del conmutador. Si selecciona Activar SNMP, la unidad responderá a las
solicitudes SNMP por el puerto UDP 161.
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Para configurar los parámetros generales del SNMP:

1. Seleccione Vista de unidades > Equipo > Configuración del equipo > SNMP
> Configuración SNMP para abrir la pantalla SNMP.

2. Haga clic en la casilla de verificación Activar SNMP para que el conmutador
responda a las solicitudes de SNMP a través del puerto UDP 161.

3. Introduzca el nombre de dominio completo del sistema en el campo
Nombre, así como una persona de contacto para el nodo en el campo
Contacto.

4. Introduzca los nombres de comunidad: Leer, Escribir e Interrupción. Estos
datos especifican las cadenas de comunidad que deben utilizarse en las
operaciones de SNMP. Las cadenas Leer y Escribir solo se aplican al SNMP
por el puerto UDP 161 y actúan a modo de contraseñas que protegen el
acceso al conmutador. Los valores pueden tener una longitud máxima de 64
caracteres. Estos campos no pueden quedar en blanco.

5. Escriba la dirección de hasta cuatro estaciones de trabajo de administración
que puedan administrar este conmutador en los campos Administradores
permitidos. Alternativamente, puede dejar estos campos en blanco para
permitir que cualquier estación administre el conmutador.

6. Haga clic en Guardar.

3.14 Configuración de sucesos
Un suceso es una notificación enviada por el conmutador a una estación de
administración, para indicar que se ha producido un hecho que puede precisar
más atención.

Para activar sucesos individuales:

1. Seleccione Vista de unidades > Equipo > Configuración del equipo >
Auditoría > Sucesos para abrir la pantalla Sucesos.

2. Especifique los sucesos susceptibles de generar notificaciones; para ello,
haga clic en las casillas de verificación correspondientes en la lista.

-o bien-

Seleccione o anule la selección de la casilla de verificación junto a
Nombre del suceso para seleccionar o anular la selección de toda la
lista.

3. Haga clic en Guardar.
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3.15 Configuración de los destinos de sucesos
Puede configurar los sucesos de auditoría que se van a enviar a los destinos de
interrupción SNMP y a los servidores Syslog. Los sucesos activados en la
pantalla Sucesos se envían a todos los servidores enumerados en la pantalla
Destinos de sucesos.

1. Seleccione Vista de unidades > Equipo > Configuración del equipo >
Auditoría > Destinos para abrir la pantalla Destinos de sucesos.

2. Escriba la dirección de hasta cuatro estaciones de trabajo de administración
a las que el conmutador enviará sucesos en los campos Destinos de
interrupción, así como hasta cuatro servidores Syslog.

3. Haga clic en Guardar.

3.16 Configuración de los cables adaptadores
Desde el conmutador puede visualizar una lista de los cables adaptadores
acoplados, así como la siguiente información sobre cada cable: eID (ID
electrónico), Puerto, Estado, Aplicación, Tipo de interfaz y Velocidad USB. Puede
hacer clic en uno de los cables para ver la siguiente información adicional: Tipo
de conmutador, Versión de Boot, Versión de hardware, Versión FPGA, Versión
disponible y Estado de la actualización.

También puede realizar las siguientes tareas: eliminar cables adaptadores fuera
de línea, actualizar el firmware del cable, configurar la velocidad USB o
restablecer los cables.

Para eliminar cables adaptadores fuera de línea:

1. En la barra de exploración lateral, haga clic en Vista de unidades > Equipo >
Configuración del equipo > Puertos > Cables adaptadores para abrir la
pantalla Cable adaptador del equipo.

2. Haga clic en Eliminar elementos desconectados.

Para configurar la velocidad USB (sólo para cables USB20-VGA adaptadores
KVM s4):

1. En la barra de exploración lateral, haga clic en Vista de unidades > Equipo >
Configuración del equipo > Puertos > USB20-VGA para abrir la pantalla
USB20-VGA del equipo.

2. Seleccione la(s) casilla(s) de verificación junto a lo(s) cable(s) que desea
modificar.
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3. Haga clic en Establecer velocidad USB 1.1 o bien en Establecer velocidad
USB 2.0.

Actualización de los cables adaptadores

La función de actualización Flash del cable adaptador permite a los
administradores del equipo actualizar el cable adaptador con el firmware más
reciente disponible. Esta actualización puede llevarse a cabo ya sea mediante la
interfaz de usuario del conmutador o el software DSView 3.

Una vez que la memoria Flash se haya reprogramado con la actualización, el
conmutador llevará a cabo un reinicio mediante software que finalizará todas las
sesiones del cable adaptador. Es posible que el dispositivo de destino para el
que se está actualizando el firmware del cable adaptador no se muestre o que
se muestre como un dispositivo desconectado. El dispositivo de destino
aparecerá en su estado normal una vez que se haya finalizado la actualización
de la memoria Flash.

Si el equipo se configura para actualizar automáticamente los cables
adaptadores, los cables adaptadores se actualizarán automáticamente cuando
se actualice el conmutador. Para actualizar el firmware del conmutador, consulte
"Herramientas del conmutador KVM s4" en la página 30 o la Ayuda en línea del
software DSView 3. Si se produce algún problema durante el proceso de
actualización normal, la actualización de los cables adaptadores también puede
forzarse cuando sea necesario.

Visite http://www.ts.fujitsu.com para obtener los archivosde actualización del firmware.

Para actualizar el firmware del cable adaptador:

1. En la barra de exploración lateral, haga clic en Vista de unidades > Equipo >
Configuración del equipo > Puertos > Cables adaptadores para abrir la
pantalla Cable adaptador del equipo.

2. Seleccione la(s) casilla(s) de verificación junto a lo(s) cable(s) adaptadores
que desea modificar y haga clic en Actualizar.

ADVERTENCIA: Si se desconecta un cable adaptador durante una actualización del
firmware o se interrumpe la alimentación al dispositivo de destino, se inutilizará el
módulo y será necesario devolver el cable adaptador a la fábrica para su reparación.
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3.17 Configuración del dispositivo de alimentación
Debe contar con privilegios de administrador para cambiar la configuración del
dispositivo de control de alimentación.

En la pantalla Dispositivos de alimentación del equipo puede ver una lista de los
dispositivos de alimentación conectados, además de la siguiente información
sobre cada dispositivo de alimentación: Nombre, puerto, estado, versión,
modelo, zumbador, alarma y temperatura. También puede seleccionar un
dispositivo de alimentación y, a continuación, seleccionar Configuración para ver
los datos siguientes del dispositivo de alimentación: Nombre, descripción,
estado, versión, sockets, nombre del proveedor, modelo y alimentadores de
entrada.

Si un dispositivo de destino está conectado a una toma del dispositivo de control
de alimentación, puede encender, apagar o reactivar (apagar y después
encender) el dispositivo de destino.

Para encender, apagar o reactivar un dispositivo de destino:

1. En la barra de exploración lateral, seleccione Vista de unidades > Equipo >
Configuración del equipo > Puertos > Dispositivos de alimentación para
abrir la pantalla Dispositivos de alimentación del equipo.

2. Haga clic en el nombre de la unidad que desea configurar y seleccione
Sockets.

3. Seleccione la casilla de verificación a la izquierda del (de los) socket(s) que
desea configurar.

4. Haga clic en Activar, Desactivar o Reactivar, según desee.

Para eliminar dispositivos de alimentación desconectados:

1. En la barra de exploración lateral, seleccione Vista de unidades > Equipo >
Configuración del equipo > Puertos > Dispositivos de alimentación para
abrir la pantalla Dispositivos de alimentación del equipo.

2. Haga clic en Eliminar elementos desconectados.

Para cambiar el tiempo de actividad mínimo, el tiempo de inactividad o el
estado de reactivación:

1. En la barra de exploración lateral, seleccione Vista de unidades > Equipo >
Configuración del equipo > Puertos > Dispositivos de alimentación para
abrir la pantalla Dispositivos de alimentación del equipo.
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2. Haga clic en el nombre de la unidad que desea configurar y seleccione
Sockets.

3. Haga clic en el nombre del socket que desea modificar.

4. Utilice las ventanas desplegables para modificar la configuración deseada y
haga clic en Guardar.

Tomas de alimentación y servidores de destino asociados

Es posible vincular o asociar las tomas de alimentación al servidor de destino y
de este modo facilitar el control; para ello se debe dar el mismo nombre del
servidor de destino a una o varias tomas de alimentación. En la página
Dispositivos de destino de la OBWI es posible seleccionar las operaciones de
control de un dispositivo de destino asociado a las tomas. En la página de
información general del dispositivo, en la tabla Alimentación de la toma de pared
se muestran las tomas vinculadas a un dispositivo de destino.

En la siguiente figura puede verse que el dispositivo de destino de nombre
Server2 tiene tomas de alimentación vinculadas. Si se hace clic en la flecha del
menú desplegable en la columna Acción se muestran las acciones de
alimentación adicionales disponibles.

Figura 3.2. Dispositivos de destino

En la siguiente figura, la página Información general de la unidad de destino
para el Server2, en Alimentación de la toma de pared se muestra que la toma 1 y
la toma 9 de la PDU 1 están vinculadas al Server2.
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Figura 3.3. Información general del dispositivo de destino Server2

Agrupación de tomas de alimentación

Es posible dar el mismo nombre a varias tomas de alimentación con el fin de
vincularlas dentro de un mismo grupo, el cual se enumera como un único
dispositivo de destino. Las acciones de alimentación realizadas en la página
Dispositivos de destino conciernen a todas las tomas aplicables. Las acciones
de control de alimentación para tomas de alimentación específicas pueden
realizarse en la página Información general de la unidad. En la siguiente figura,
el dispositivo de destino de nombre Group2 está compuesto por las tomas de
alimentación 4 y 5 de la PDU 1.

Figura 3.4. Información general del dispositivo de destino para el Group2

Nombres de toma predeterminados

Como puede verse en la figura siguiente, mediante la casilla de verificación
“Asigne nombres predeterminados a tomas” en la página Dispositivos de
alimentación es posible asignar nombres predeterminados a un dispositivo de
alimentación. Sólo las tomas de alimentación que han recibido un nombre
aparecen enumeradas en la página del dispositivo de destino. Es posible
eliminar los nombres de toma de alimentación predeterminados; para ello, es
necesario cancelar la selección de la casilla de verificación “Asigne nombres
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predeterminados a tomas” y grabar dicha acción. A las tomas de alimentación
sin nombre se les asignan nombres predeterminados; para ello es necesario
seleccionar “Asigne nombres predeterminados a las tomas” y seguidamente
guardar.

Figura 3.5. Página Dispositivos de alimentación del equipo

Asignación de un nombre de toma

Como puede verse en la siguiente figura, en la página Configuración de la toma
del dispositivo de alimentación existen tres opciones disponibles para asignar el
nombre a una toma. Las opciones son: Asignación del nombre manual, Vínculo
al dispositivo de destino y No mostrar como dispositivo de destino.

Figura 3.6. Página de configuración de la toma del dispositivo de alimentación

• Mediante la opción Asignación de nombre manual se asigna un nombre
exclusivo a una toma. El nombre debe ser exclusivo para todos los nombres
de cables adaptadores y tomas de alimentación. Si se intenta especificar un
nombre manual que no sea exclusivo se generará un error y el nombre no
se grabará.

• La asignación Vínculo al dispositivo de destino vincula la toma al nombre de
otro dispositivo de destino (ya sea una toma o un cable adaptador) para
obtener el control de alimentación del dispositivo de destino del que se ha
tomado el nombre. Cuando una toma se vincula al nombre de un dispositivo
de destino del cable adaptador, por lo general la toma suministra
físicamente alimentación al servidor acoplado al cable adaptador.
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• La opción No mostrar como dispositivo de destino asigna un nombre vacío a
la toma, lo que evita que aparezca en la página Dispositivos de destino.
Esta opción puede utilizarse para las tomas adicionales, a fin de eliminarlas
de la página Dispositivos de destino.

Herencia del control de acceso

Cuando el nombre de una toma de alimentación cambia al vincularse a un
dispositivo de destino, la toma hereda el control de acceso previamente
configurado para el nombre de ese dispositivo de destino. Cuando se agrega un
cable adaptador, si el nombre recuperado para el cable adaptador coincide con
el nombre de un dispositivo de destino existente, el nuevo cable adaptador
hereda el control de acceso del dispositivo de destino. Cuando se cambia el
nombre de un dispositivo de destino, también se cambia el nombre de todos los
cables adaptadores y tomas de ese dispositivo de destino y estos continúan
manteniendo el control de acceso que se había configurado previamente para el
nombre antiguo del dispositivo de destino.

Cambio del nombre de un dispositivo de destino

En la página Información general del dispositivo de destino es posible cambiar
el nombre del dispositivo de destino por un nombre de dispositivo de destino
exclusivo. El nombre debe ser exclusivo para el conjunto de todos los
dispositivos de destino, incluidos los cables adaptadores y las tomas de
alimentación. Cuando se cambia el nombre de un dispositivo de destino, todas
las tomas vinculadas a ese dispositivo de destino reciben el mismo nombre.

Estado priorizado de los dispositivos de destino

En la página Dispositivos de destino, un dispositivo de destino con tomas de
alimentación vinculadas controla varios dispositivos. El valor de estado mostrado
para un dispositivo de destino se elige como la prioridad más alta de todos los
valores de estado de los dispositivos. En la siguiente tabla se muestras los
valores de estado posibles en orden de prioridad (del más alto al más bajo) y los
tipos de dispositivo de destino aplicables.

Valor de estado Aplicable para: Descripción del estado

Cable
adaptador

Toma de
alimentación

En uso x N/D Una sesión está activa

Tabla 3.7: Valores de estado del dispositivo de destino
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Valor de estado Aplicable para: Descripción del estado

Cable
adaptador

Toma de
alimentación

Ruta bloqueada x N/D La ruta al dispositivo de destino está
siendo utilizada por otra sesión

Actualizando x N/D El cable adaptador se está
actualizando

Activando N/D x Una omás tomasse están activando

Desactivando N/D x Una omás tomasse están
desactivando

No hay
alimentación x N/D No se ha detectado alimentación en

el cable adaptador

Alimentación
parcial N/D x El dispositivo de destino tiene tomas

activadas ydesactivadas

Bloqueado
desactivado N/D x Una omás tomasestán bloqueadas

Desactivado N/D x Una omás tomasestán
desactivadas

Bloqueado
activado N/D x Una omás tomasestán

desbloqueadas

Inactivo x N/D No hayninguna sesión activa; el
cable adaptador tiene alimentación

Activado N/D x Las tomasestán activadas

Cuando un dispositivo de destino cuenta con varias tomas de alimentación
vinculadas por nombre que no tienen un estado de alimentación común, es
recomendable que el estado Bloqueado desactivado de la toma esté
desactivado y el estado Bloqueado activado esté activado. En la tabla siguiente
se enumeran los valores de estado resultantes para combinaciones de dos
valores de estado de la toma.
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3.17 Configuración del dispositivo de alimentación

Estado 1 de la toma Estado 2 de la toma Estados resultantes

Desactivado Desactivado Desactivado

Desactivado Activado Alimentación parcial

Activado Activado Activado

Bloqueado
activado Activado Activado

Bloqueado
activado

Bloqueado
activado Bloqueado activado

Bloqueado
activado Desactivado Alimentación parcial

Bloqueado
desactivado Activado Alimentación parcial

Bloqueado
desactivado

Bloqueado
desactivado Bloqueado desactivado

Bloqueado
desactivado Desactivado Desactivado

Bloqueado
activado

Bloqueado
desactivado Alimentación parcial

Tabla 3.8: Varios valores de estado de la toma y estados visualizados

Página de sesión local en el puerto local

En la página de sesión local del puerto local, cuando el dispositivo de destino de
la sesión activa tiene tomas de alimentación vinculadas, se muestran tres
controles de alimentación en la página bajo sesión activa. La siguiente figura
ilustra los controles de alimentación visualizados para una sesión de puerto
local activa para un servidor de destino con el nombre Server2.
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Figura 3.7. Página Sesión local con controles de alimentación
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4. El Visor de vídeo

4.1 La ventana Visor de vídeo
El Visor de vídeo se utiliza para ejecutar una sesión KVM con los dispositivos de
destino acoplados a un conmutador mediante la OBWI. Cuando se conecta a un
dispositivo a través del Visor de vídeo, el escritorio del dispositivo de destino
aparece en una ventana independiente que contiene el cursor local y el del
dispositivo de destino.

El software OBWI del conmutador usa un programa basado en Java para mostrar
la ventana Visor de vídeo. La OBWI del conmutador descarga e instala
automáticamente el Visor de vídeo la primera vez que se abre.

Espreciso disponer de Java 1.6.0_11 o superior para iniciar una sesión.

La OBWI del conmutador no instala el entorno de ejecución Java (JRE). Este puede
descargarse demodo gratuito desde http://www.sun.com.

LaOBWI del conmutador usa lamemoria del sistema para almacenar ymostrar
imágenesdentro de las ventanasVisor de vídeo. Cada ventana Visor de vídeo precisa
de unamemoria de sistema adicional. Un ajuste de color de 8 bits en el servidor cliente
exige 1,4MBdememoria por ventana Visor de vídeo, un ajuste de color de 16 bits
precisa 2,4MB yuno de 32 bits 6,8MB. Si intenta abrir más ventanasVisor de vídeo de
laspermitidaspor la memoria del sistema (normalmente cuatro) recibirá un error de
memoria insuficiente y la ventana Visor de vídeo solicitada no se abrirá.

Si el dispositivo al que está intentando acceder está siendo vizualizado por otro
usuario, se le pedirá que tome preferencia sobre el otro usuario si su nivel de
preferencia es igual o superior al nivel del otro usuario. Un administrador del
equipo también podrá desconectar al usuario activo a través de la página de
sesión activa. Para obtener más información consulte "Sesiones del conmutador
KVM s4" en la página 27.
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4. El Visor de vídeo

Figura 4.1. Ventana Visor de vídeo (modo de ventana normal)

Tabla 4.1. Descripciones para la Figura 4.1

Número Descripción

1

Barra de título: Muestra el nombre del dispositivo de destino que está
siendo visualizado. En elmodo de pantalla completa, la barra de título
desaparece yel nombre del dispositivo de destino aparece entre el
menú y la barra de herramientas.

2
Icono de chincheta: Bloquea la visualización delmenú yde la barra de
herramientas, para que sean visibles en todomomento.
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Número Descripción

3

Menú ybarra de herramientas: Le permiten acceder a la mayoría de las
funcionesde la ventana Visor de vídeo. Si la función de chincheta no se
ha usado, elmenú y la barra de herramientaspermanecen en el estado
Mostrar/ocultar. Coloque el cursor sobre la barra de herramientaspara
que elmenú y la barra de herramientas se visualicen. Esposible mostrar
hasta diez comandos y/o botonesde grupo demacrosen la barra de
herramientas. Demanera predeterminada, en la barra de herramientas
aparecen losbotonesModo de cursor simple, Actualizar, Ajuste
automático del vídeo yAlinear el cursor local. Para obtener más
información, consulte "Cambio de la barra de herramientas" en la
página 56 y "Macros" en la página 75.

4
Botonesdemacro: Secuenciasde teclado comúnmente utilizadasque
pueden enviarse al dispositivo de destino.

5 BotónMinimizar: Minimiza la ventana Visor de vídeo en la barra de
tareasen la parte inferior del ordenador local.

6

BotónMaximizar: Cambia la ventana almodo de pantalla completa que
amplía el escritorio del dispositivo al que se ha accedido hasta ocupar la
pantalla completa. Al ampliar la ventana puede ocurrir lo siguiente:

La barra de título desaparece.

El nombre del dispositivo de destino aparece entre elmenú y la barra de
herramientas.

El botónMaximizar cambia al botónModo de ventana normal y aparece
en la barra de herramientas. Al hacer clic en el botón se alterna entra la
ventana Visor de vídeo yelModo de ventana normal.

El botón Cerrar aparece en la barra de herramientas.

7

Botón Cerrar: Cierra la ventana Visor de vídeo.

NOTA: Esposible que el botón Cerrar no esté presente en todos los
sistemasoperativos.

8
Escritorio del dispositivo al que se accede: Esta ventana le permite
interactuar con dispositivo.

9 Marco: Permite cambiar el tamaño de la ventana Visor de vídeo
haciendo clic ymanteniendo presionado elmarco.
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Cambio de la barra de herramientas

Puede elegir el intervalo de tiempo que debe transcurrir antes de la que la barra
de herramientas se oculte en la ventana Visor de vídeo cuando está en el estado
Mostrar/ocultar (es decir, cuando no ha sido bloqueada en posición por la
función de chincheta).

Para especificar el tiempo que la barra de herramientas va a permanecer
oculta:

1. Seleccione Herramientas > Opciones de sesión en el menú de la ventana
Visor de vídeo.

-o bien-

Haga clic en el botón Opciones de sesión.

Aparece el cuadro de diálogo Opciones de sesión.

2. Haga clic en la ficha Barra de herramientas.

3. Use las teclas de flecha para especificar el número de segundos que han de
transcurrir antes de que se oculte la barra de herramientas.

4. Haga clic en Aceptar para guardar los cambios y cerrar el cuadro de
diálogo.

4.2 Inicio de una sesión
Cuando se use una conexión sin proxy, el rendimiento del vídeo a travésde una
conexión lenta puede dejar bastante que desear. Dado que ciertas configuracionesde
colores (como la escala de grises) utilizanmenosancho de banda que otros (como el
mejor color), al cambiar la configuración del color puede aumentar el rendimiento del
vídeo. Para obtener un rendimiento del vídeo óptimo a travésde una conexión de red
más lenta, use una configuración de colores como escala de grises/mejor compresión o
color bajo/compresión alta. Consulte "Ajuste de la vista" en la página 58 para obtener
más información.

Si un usuario se conecta a un dispositivo de destino con una resolución de pantalla más
alta que la del ordenador local, la ventana Visor de vídeomostrará una sección de la
pantalla del dispositivo de destino con barrasde desplazamiento para ver el resto de la
pantalla. El usuario puede ver toda la pantalla ajustando la resolución en el dispositivo
de destino, el ordenador local o ambos.
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Para iniciar una sesión KVM desde la ventana del Explorador del
conmutador:

1. Haga clic en un dispositivo enumerado en la pantalla Dispositivos de
destino para abrir la ventana Información general de la unidad.

2. Haga clic en el enlace Sesión KVM para abrir el Visor de vídeo en una
nueva ventana.

Tiempo de espera de la sesión

El tiempo de espera de una sesión remota puede agotarse cuando no existe
actividad en una ventana de sesión durante un tiempo especificado. El valor del
tiempo de espera de la sesión puede configurarse en la ventana Configuración
de sesión KVM del equipo. El valor del tiempo de espera especificado se
utilizará la próxima vez que se acceda a la OBWI del conmutador.

Para activar, desactivar o configurar el tiempo de espera de la sesión:

1. En el menú lateral, seleccione Vista de unidades > Equipo > Configuración
del equipo > Sesiones > General.

2. Seleccione la configuración deseada para la casilla Activar tiempo de
espera de inactividad .

3. Si es necesario, seleccione el límite de tiempo para el tiempo de espera de
inactividad.

4. Haga clic en Guardar.

4.3 Tamaño de la ventana
El comando Vista >Escala no está disponible si la ventana Visor de vídeo está en el
modo de pantalla completa ni tampoco para los usuarios no primarios de una sesión
compartida.

Cundo se utiliza por primera vez la OBWI del conmutador, cualquier pantalla
Visor de vídeo abierta se visualiza a una resolución de 1024 x 768 hasta que el
usuario cambia el valor. Cada ventana Visor de vídeo puede configurarse a una
resolución diferente.

La OBWI del conmutador ajusta automáticamente la pantalla si el tamaño de la
ventana cambia durante una sesión, siempre y cuando, la función de ajuste
automático de escala esté activado. Si la resolución del dispositivo de destino
cambia en cualquier momento durante una sesión, la pantalla se ajusta
automáticamente.
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Para cambiar la resolución de la ventana Visor de vídeo:

1. Seleccione el comando Vista > Escala.

2. Seleccione la resolución deseada.

4.4 Ajuste de la vista
Mediante los menús y los botones de tarea de la ventana Visor de vídeo, puede
hacer lo siguiente:

• Alinear los cursores del ratón.

• Actualizar la pantalla.

• Activar o desactivar el modo de pantalla completa. Cuando el modo de
pantalla completa está activado, la imagen se ajusta para adaptarse a un
tamaño del escritorio de hasta 1600 x 1200 o 1680 x 1050 (panorámica). Si
el escritorio tiene una resolución más elevada, ocurre lo siguiente:

• La imagen de pantalla completa se centra en el escritorio y las zonas
que rodean la ventana Visor de vídeo aparecen en blanco.

• El menú y la barra de herramientas están bloqueados de modo que
sean visibles en todo momento.

• Active la escala automática, completa o manual de la imagen de la sesión:

• Con la escala completa, la ventana del escritorio permanece fija y la
imagen del dispositivo se ajusta para caber en la ventana.

• Con la escala automática, el tamaño de la la ventana del escritorio se
ajusta a la resolución del dispositivo de destino que se está
visualizando.

• Con la escala manual, aparece un menú desplegable con las
resoluciones compatibles de escala de la imagen.

• Cambie la profundidad de color de la imagen de la sesión.

Para alinear los cursores del ratón:

Haga clic en el botón Alinear el cursor local en la barra de herramientas de la
ventana Visor de vídeo. El cursor local se alineará con el del dispositivo remoto.

Si los cursores se desalinean, desactive la aceleración del ratón en el dispositivo
acoplado.
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Para actualizar la pantalla, haga clic en el botón Actualizar imagen en la ventana
Visor de vídeo, o seleccione Vista > Actualizar en el menú de la ventana Visor de
vídeo. La imagen de vídeo digitalizada se regenera por completo.

Para activar el modo de pantalla completa, haga clic en el botón Maximizar o
seleccione Vista > Pantalla completa en el menú de la ventana Visor de vídeo.
La ventana del escritorio desaparece y sólo permanece visible el escritorio del
dispositivo al que se ha accedido. El tamaño de la pantalla cambia a un máximo
de 1600 x 1200 o 1680 x 1050 (panorámica). Si la resolución del escritorio es
mayor, la imagen de pantalla completa aparecerá rodeada por un fondo negro.
También aparece la barra de herramientas flotante.

Para desactivar el modo de pantalla completa, haga clic en el botón Modo de
pantalla completa de la barra de herramientas flotante para volver a la ventana
del escritorio.

Para activar la escala completa, seleccione Vista > Escala en el menú de la
ventana Visor de vídeo. El tamaño de la imagen del dispositivo se ajusta
automáticamente a la resolución del dispositivo de destino que se está
visualizando.

Para activar la escala manual, seleccione Vista > Escala en el menú de la
ventana Visor de vídeo. Elija la dimensión para cambiar el tamaño de la ventana.
Los tamaños de escalado manual disponibles varían en función del sistema.

4.5 Actualización de la imagen
Al hacer clic en el botón Actualizar imagen en el cuadro de diálogo Ajuste
manual del vídeo se regenera por completo la imagen de vídeo digitalizada.

También puede seleccionar Vista >Actualizar en elmenú de la ventana Visor de vídeo
para actualizar la imagen.

4.6 Ajustes de vídeo

Ajuste adicional de vídeo

Por lo general, las funciones de ajuste automático de la ventana Visor de vídeo
optimizan el vídeo a fin de que se consiga la mejor imagen posible. Sin
embargo, los usuarios pueden ajustar el vídeo gracias al Servicio de asistencia
técnica de Fujitsu al seleccionar el comando Herramientas - Ajuste manual del
vídeo en el menú de la ventana Visor de vídeo o al hacer clic en el botón Ajuste
manual del vídeo. Aparece el cuadro de diálogo Ajuste manual del vídeo. El
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ajuste de vídeo es una configuración que se realiza individualmente en cada
dispositivo de destino.

Los usuarios pueden también modificar el nivel de paquetes por segundo
requerido para una pantalla estática; para ello, deben observar la velocidad de
paquete ubicada en la esquina inferior izquierda del cuadro de diálogo.

Para ajustar la calidad de vídeo de la ventana manualmente:

Los siguientesajustesde vídeo deberán realizarse únicamente con ayuda delServicio
de asistencia técnica de Fujitsu.

1. Seleccione Herramientas > Ajuste manual del vídeo en el menú de la
ventana Visor de vídeo.

-o bien-

Haga clic en el botón Ajuste manual del vídeo.

Aparece el cuadro de diálogo Ajuste manual del vídeo.

Figura 4.2. Cuadro de diálogo Ajuste manual del vídeo.
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Número Descripción Número Descripción

1
Ancho de
captura de
imagen

8 Umbral de ruido de píxeles

2
Muestreo
píxeles/ajuste
preciso

9 Ajuste automático del vídeo

3
Posición
horizontal
captura imagen

10 Actualizar imagen

4
Posición vertical
captura imagen

11 Barra de ajuste

5 Contraste 12 Modelo de prueba de vídeo

6 Brillo 13 Monitor de rendimiento

7
Umbral de ruido
del bloque

14 Botón cerrar

Tabla 4.2: Descripciones para la Figura 4.2

2. Haga clic en el icono correspondiente a la característica que desee ajustar.

3. Mueva la barra deslizante de contraste y, a continuación, ajuste el valor con
precisión mediante los botones Mín (-) o Máx (+) para ajustar el parámetro
de cada icono seleccionado. Los ajustes se mostrarán inmediatamente en la
ventana Visor de vídeo.

4. Una vez realizados los ajustes, haga clic en Cerrar para salir del cuadro de
diálogo Ajuste manual del vídeo.

Ajustes de vídeo del dispositivo de destino

Los ajustes Ancho de captura de imagen, Muestreo píxeles/ajuste preciso,
Posición horizontal captura imagen, Posición vertical captura imagen afectan al
modo en que el vídeo del dispositivo de destino se captura y digitaliza. Dichos
ajustes no suelen modificarse.
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El parámetro de captura de imagen se cambia automáticamente mediante la
función de ajuste automático. Se requiere una imagen especial en el dispositivo
de destino para hacer ajustes precisos independientemente.

Ajuste de vídeo automático

En la mayoría de los casos, no le hará falta cambiar los ajustes predeterminados
de vídeo El sistema se ajustará automáticamente y usará los parámetros de
vídeo óptimos. La OBWI del conmutador funciona mejor cuando los parámetros
de vídeo están configurados de tal manera que no se transmite ningún (0)
paquete de vídeo para una pantalla estática.

Puede ajustar con facilidad los parámetros de vídeo a la configuración ideal;
para ello, haga clic en el botón Ajuste automático del vídeo en el cuadro de
diálogo Ajuste manual del vídeo.

También puede seleccionar Herramientas>Ajuste automático del vídeo en elmenú de
la ventana Visor de vídeo o hacer clic en el icono de la barra de herramientasAjuste
automático del vídeo para ajustar el vídeo automáticamente.

Modelo de prueba de vídeo

Al hacer clic en el botón Modelo de prueba de vídeo en el cuadro de diálogo
Ajuste manual del vídeo se muestra un modelo de prueba de vídeo. Haga clic en
el botón Modelo de prueba de vídeo nuevamente para volver a la imagen de
vídeo normal.

Ajustes de vídeo según el proveedor

Los ajustes de vídeo varían significativamente entre los distintos fabricantes.

4.7 Configuración del color

Ajuste de la profundidad de color

El algoritmo Dambrackas Video Compression (DVC) permite a los usuarios
ajustar el número de colores visualizables en una ventana de sesión remota.
Puede elegir entre mostrar más colores para disfrutar de una mejor fidelidad o
menos colores para reducir el volumen de datos transferidos en la red.

Las ventanas Visor de vídeo pueden visualizarse mediante Mejor color
disponible (actualizaciones más lentas), Mejor compresión (actualizaciones más
rápidas), una combinación de Mejor color y Mejor compresión o en una escala
de grises.
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Puede especificar las profundidades de color de puertos y canales
seleccionando el comando Ver color en una ventana de sesión remota. Estos
parámetros se graban individualmente por canal.

Contraste y brillo

Si la imagen de la ventana Visor de vídeo es demasiado oscura o demasiado
clara, seleccione Herramientas > Ajuste automático del vídeo o haga clic en el
botón Ajuste automático del vídeo. Este comando también está disponible en el
cuadro de diálogo Ajustes del vídeo. En la mayoría de los casos, esto corregirá
los problemas de vídeo.

Al hacer clic en Ajuste automático no se ajusta el contraste y el brillo tal y como
se desea, por lo que es preferible hacerlo manualmente. Aumente el brillo. No
aumente en más de 10 unidades antes de mover el contraste. Por normal
general, el contraste debe moverse muy poco.

4.8 Configuración del ruido

Umbrales de detección

En algunos casos, la cuenta de paquetes por segundo sigue aumentando
debido al ruido en la transmisión de vídeo, como puede verse por los pequeños
puntos que cambian en el área del cursor al moverlo. Si se cambian los valores
límites se pueden conseguir pantallas "más silenciosas" y un seguimiento de
cursor mejorado.

Puede modificar los valores Umbral de ruido y Umbral de prioridad si está
utilizando la compresión de vídeo estándar. También puede modificar los
valores Umbral de ruido del bloque y Umbral de ruido de píxeles. Puede
restaurar los valores límites predeterminados haciendo clic en Ajuste automático
del vídeo.

Umbral de ruido del bloque y Umbral de ruido de píxeles

Los valores Umbral de ruido del bloque y Umbral de ruido de píxeles establecen
los niveles de color mínimos en términos de bloques de vídeo modificados y
píxeles por mil permitidos.

• El valor Umbral de ruido del bloque define el cambio de color mínimo que se
produce en un solo bloque de vídeo. Al aumentar el valor se reduce el
ancho de banda de la red. Si se disminuye el valor, el tamaño de estos
artefactos es menor.
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• El valor Umbral de ruido de píxeles define el cambio de color mínimo en un
solo pixel. Al disminuir el valor se reduce el número de artefactos de
contraste bajo, pero se aumenta el ancho de banda de la red.

Consulte "Ajuste de la vista" en la página 58 para obtener más información sobre
cómo cambiar la profundidad de color.

4.9 Configuración del ratón

Ajuste de las opciones del ratón

Las opciones de ratón de la ventana Visor de vídeo permiten modificar el tipo de
cursor, el modo de cursor, la escala y la alineación, y efectuar un
restablecimiento. Los valores de configuración del ratón son específicos para
cada dispositivo; es decir, pueden configurarse de forma diferente para cada
dispositivo.

Si el dispositivo no admite la posibilidad de desconectar y volver a conectar el ratón (la
mayoría de losPCmodernos lo permiten), el ratón se desactivará y será necesario
volver a iniciar el dispositivo.

Tipo de cursor

La ventana Visor de vídeo ofrece cinco variantes para el cursor del ratón local.
Igualmente, puede seleccionar el cursor predeterminado o, si lo prefiere, no
seleccionar ninguno.

En el Modo de cursor simple, la visualización del cursor local (segundo) en la
ventana Visor de vídeo se desactiva y solo es visible el puntero del rato del
dispositivo de destino. Los únicos movimientos de ratón visibles son los del
cursor remoto del dispositivo de destino. Use el Modo de cursor simple cuando
no se necesite un cursor local.

590-1058-640A64



4.9 Configuración del ratón

Figura 4.3. Ventana Visor de vídeo con cursores local y remoto visualizados

Número Descripción

1 Cursor remoto

2 Cursor local

Tabla 4.3: Descripciones para la Figura 4.3

El estado del Modo del cursor de la ventana Visor de vídeo se muestra en la
barra de título e incluye la pulsación de tecla que permitirá salir del Modo de
cursor simple. Puede definir la pulsación de tecla para salir del Modo de cursor
simple en el cuadro de diálogo Opciones de sesión.

Cuando utilice un dispositivo que capture las pulsacionesde tecla antesde que lleguen
al servidor cliente, evite usar estas teclas para restaurar el puntero del ratón.

Para entrar en el Modo de cursor simple, seleccione Herramientas > Modo de
cursor simple en el menú de la ventana Visor de vídeo, o haga clic en el botón
Modo de cursor simple. El cursor local no aparece y todos los movimientos están
relacionados con el dispositivo de destino.
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Para seleccionar una tecla para salir del modo de cursor simple:

1. Seleccione Herramientas > Opciones de sesión en el menú de la ventana
Visor de vídeo.

-o bien-

Haga clic en el botón Opciones de sesión.

Aparece el cuadro de diálogo Opciones de sesión.

2. Haga clic en la ficha Ratón.

3. Seleccione la pulsación de tecla de finalización en el menú desplegable de
la zona del Modo de cursor simple.

4. Haga clic en Guardar para guardar las configuraciones.

Cuando active el Modo de cursor simple puede pulsar la tecla específica para
volver al Modo de escritorio normal.

Para salir del Modo de cursor simple, pulse la tecla indicada en la barra de título.

Para cambiar la configuración del cursor del ratón:

1. Seleccione Herramientas > Opciones de sesión en el menú de la ventana
Visor de vídeo.

-o bien-

Haga clic en el botón Opciones de sesión.

Aparece el cuadro de diálogo Opciones de sesión.

2. Haga clic en la ficha Ratón.

3. Seleccione un tipo de cursor de ratón en el panel Cursor local.

4. Haga clic en Aceptar para guardar las configuraciones.

Escala del ratón

Algunas versiones previas de Linux no son compatibles con las aceleraciones
ajustables del ratón. En el caso de instalaciones que no sean compatibles con
estas versiones anteriores, puede elegir entre tres opciones de escala de ratón
preconfiguradas o configurar su propia escala personalizada. Los parámetros
preconfigurados son Predeterminada (1:1), Alta (2:1) y Baja (1:2):

• En una escala 1:1, cada movimiento del ratón en la ventana del escritorio
envía un movimiento equivalente al dispositivo de destino.

• En una escala 2:1, el mismo movimiento del ratón envía un movimiento
equivalente al doble.
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• En una escala 1:2, el movimiento enviado equivale a la mitad.

Para configurar una escala de ratón:

1. Seleccione Herramientas > Opciones de sesión en el menú de la ventana
Visor de vídeo.

-o bien-

Haga clic en el botón Opciones de sesión.

Aparece el cuadro de diálogo Opciones de sesión.

2. Haga clic en la ficha Ratón.

3. Si desea usar una de las opciones preconfiguradas, seleccione el botón de
opción correspondiente.

-o bien-

Para configurar una escala personalizada:

a. Haga clic en el botón de opción Personalizar para activar los campos X
e Y.

b. Escriba un valor de escala en los campos X e Y. Para cada entrada del
ratón, sus movimientos se multiplican por el correspondiente factor de
escala X e Y. Los intervalos de entrada válidos son de 0,25 a 3,00.

Alineación y sincronización del ratón

Debido a que la OBWI del conmutador no puede recibir constantemente
información del ratón, a veces el ratón del conmutador pierde la sincronización
con el ratón del sistema host. Si el ratón o el teclado dejan de responder
adecuadamente, puede alinear el ratón para que el desplazamiento vuelva a ser
correcto.

La alineación hace que el cursor local se alinee con el cursor del dispositivo de
destino remoto. Reconfigurar la conexión hace que el equipo simule una
reconexion del ratón y del teclado como si los hubiera desconectado y
conectado nuevamente.

Para volver alinear los cursores del ratón, haga clic en el botón Alinear el cursor
local de la barra de herramientas de la ventana Visor de vídeo.

4.10 Medio Virtual
La función de medio virtual permite al usuario en el servidor cliente asignar una
unidad física en el equipo como unidad de medio virtual en el dispositivo de
destino. El servidor cliente puede también agregar y asignar un archivo de
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disquete o ISO como unidad de medio virtual en el dispositivo de destino. Es
posible asignar una unidad de CD y un dispositivo de almacenamiento masivo
de forma simultánea.

• Puede asignar una unidad de CD/DVD, un archivo de imagen de disco
(como una imagen de disquete o ISO) como unidad de CD/DVD-ROM
virtual.

• Puede asignar una unidad de disquete, un dispositivo de memoria USB u
otros tipos de medios como un dispositivo de almacenamiento masivo
virtual.

Para obtener más información acerca de la configuración de los parámetros de
medio virtual mediante la OBWI, consulte "Medio Virtual" en la página 35.

Requisitos

El dispositivo de destino debe ser compatible con el medio virtual y conectarse al
conmutador KVM con un cable adaptador USB20-VGA adaptador KVM s4.

El dispositivo de destino debe poder utilizar los tipos de medios compatibles con
USB2 que se asignen de forma virtual. En otras palabras, si el dispositivo de
destino no admite un dispositivo de memoria USB portátil, no podrá asignar el
servidor cliente como unidad de medio virtual en el dispositivo de destino.

El usuario (o el grupo de usuarios al que el usuario pertenece) debe contar con
el permiso necesario para establecer sesiones de medio virtual y/o sesiones
reservadas de medio virtual en el dispositivo de destino. Consulte "Cuentas de
usuario" en la página 39.

Sólo una sesión de medio virtual podrá estar activa en un dispositivo de destino
al mismo tiempo.

Consideraciones sobre el uso compartido y la preferencia

Las sesiones KVM y de medio virtual son independientes; no obstante, existen
numerosas opciones para compartir, tener preferencia o reservar sesiones. El
software DSView 3 tiene la flexibilidad necesaria para dar respuesta a todas las
necesidades del sistema.

Por ejemplo, las sesiones KVM y de medio virtual pueden vincularse entre sí. De
este modo, al desconectar una sesión KVM también se desconectará la sesión
de medio virtual asociada. Por el contrario, si las sesiones no están vinculadas,
aunque la sesión KVM se cierre, la sesión de medio virtual continuará activa.
Esto puede resultar recomendable si un usuario está realizando una tarea que
requiere mucho tiempo mediante una sesión de medio virtual (como por ejemplo
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una carga del sistema operativo), y desea establecer una sesión KVM con un
dispositivo de destino diferente para llevar a cabo otras funciones mientras se
lleva a cabo la carga del sistema operativo.

Una vez que se haya establecido una sesión de medio virtual activa sin una
sesión KVM activa asociada en un dispositivo de destino, pueden ocurrir dos
cosas: el usuario original (Usuario A) podrá volver a conectarse o bien un
usuario diferente (Usuario B) podrá conectarse a ese mismo canal. Puede
configurar una opción en el cuadro de diálogo Medio Virtual (Reservado) para
que únicamente el Usuario A pueda acceder al canal con una sesión KVM.

Si el Usuario B tiene acceso a dicha sesión (la opción Reservado no está activa),
el Usuario B podría controlar el medio utilizado en la sesión de medio virtual. Si
se usa la opción Reservado en un entorno con varios niveles, sólo el Usuario A
puede acceder al conmutador inferior y el canal KVM ubicado entre el
conmutador superior e inferior queda reservado para el Usuario A.

Cuadro de diálogo Medio Virtual

El cuadro de diálogo Medio Virtual le permite administrar la asignación y
desasignación del medio virtual. En el cuadro de diálogo se muestran todas las
unidades físicas en el servidor cliente que pueden asignarse como unidades
virtuales. También puede agregar archivos de imagen ISO y de disquete, y
asignarlos desde el cuadro de diálogo Medio Virtual.

Una vez que se haya asignado un dispositivo, en la vista Detalles del cuadro de
diálogo Medio Virtual se mostrará información acerca de la cantidad de datos
transferidos y el tiempo transcurrido desde que se asignó el dispositivo.

Puede especificar que la sesión de medio virtual está reservada. Cuando una
sesión esté reservada y la sesión KVM asociada se cierre, ningún otro usuario
podrá iniciar una sesión KVM en ese dispositivo de destino. Si la sesión no está
reservada, es posible iniciar otra sesión KVM.

También puede restablecer el cable adaptador USB2 desde el cuadro de
diálogo Medio Virtual. Mediante esta acción se restablecerá cualquier tipo de
medio USB en el dispositivo de destino. Esta función debe usarse con
precaución y solo en el caso de que el dispositivo de destino no responda.

Inicio de una sesión de medio virtual

Para iniciar una sesión de medio virtual:

Seleccione Herramientas - Medio Virtual en el menú del Visor de vídeo. El
cuadro de diálogo Medio Virtual aparece. Para reservar esta sesión, haga clic en
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Detalles y, a continuación, seleccione el cuadro de diálogo Reservado.

Figura 4.4. Cuadro de diálogo Medio Virtual del Visor de vídeo

Para asignar una unidad de medio virtual:

1. Inicie una sesión de medio virtual desde el menú del Visor de vídeo; para
ello, seleccione Herramientas > Medio Virtual.

2. Para asignar una unidad física como unidad de medio virtual:

a. En el cuadro de diálogo Medio Virtual, haga clic en la casilla de
verificación Asignado que esté situada junto a la(s) unidad(es) que
desea asignar.

b. Si desea limitar el acceso de la unidad asignada a sólo lectura, haga
clic en la casilla de verificación Sólo lectura situada junto a la unidad. Si
los valores de la sesión de medio virtual se habían configurado
previamente de modo que las unidades asignadas tengan que ser de
sólo lectura, esta casilla de verificación ya está activada y no puede
cambiarse.

Puede, si así lo desea, seleccionar la casilla de verificación
Sólo lectura si la configuración de la sesión permite acceso de
escritura y lectura, pero quiere limitar el acceso de una unidad
concreta a sólo lectura.
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3. Para agregar y asignar una imagen de disquete o ISO como unidad de
medio virtual:

a. En el cuadro de diálogo Medio Virtual, haga clic en Agregar imagen.

b. Aparecerá el cuadro de diálogo del archivo común y se mostrará el
directorio que contiene los archivos de imagen de disco (es decir
aquellos que terminan en .iso o .img). Seleccione el archivo de imagen
ISO o de disquete deseado y haga clic en Abrir.

-o bien-

Si el sistema operativo del servidor cliente es compatible con la
función "arrastrar y soltar", seleccione el archivo de imagen ISO
o de disquete deseado en el cuadro de diálogo del archivo
común y arrástrelo al cuadro de diálogo Medio Virtual.

c. El encabezado del archivo se revisa para comprobar que sea correcto.
En caso afirmativo, el cuadro de diálogo del archivo común se cierra y
el archivo de imagen seleccionado aparece en el cuadro de diálogo
Medio Virtual; para asignarlo, haga clic en la casilla de verificación
Asignado.

d. Repita los pasos a, b y c con cualquier otra imagen ISO o de disquete
que desee agregar. Puede agregar tantos archivos de imagen como
desee (hasta el límite impuesto por la memoria), pero sólo podrá tener
una unidad de CD o DVD virtual o una unidad de almacenamiento
masivo virtual asignadas de forma simultánea.

Si intenta asignar demasiadas unidades (un CD o DVD y un dispositivo de
almacenamiento masivo) o demasiadas unidades de un tipo determinado (más
de un CD o DVD, o más de un dispositivo de almacenamiento masivo), aparece
un mensaje. Si aún desea asignar una nueva unidad, debe, en primer lugar,
desasignar una de las unidades asignadas existentes y, a continuación, asignar
la nueva unidad.

Tan pronto como se asigne una unidad física o una imagen, ésta podrá usarse
en el dispositivo de destino.

Para desasignar una unidad de medio virtual:

1. En el cuadro de diálogo Medio Virtual, anule la selección de la casilla de
verificación Asignado que esté situada junto a la unidad que desea
desasignar.

2. Un mensaje le pedirá que confirme dicha acción. Confirme o cancele la
operación.
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3. Repita los pasos con todas unidades de medio virtual que desee
desasignar.

Para visualizar los detalles de la unidad de medio virtual:

En el cuadro de diálogo Medio Virtual, haga clic en Detalles. El cuadro de
diálogo se amplía para mostrar la tabla Detalles. En cada fila aparece la
siguiente información:

• Unidad de destino: Nombre utilizado para la unidad asignada, como por
ejemplo CD Virtual 1 o CD Virtual 2.

• Asignado a: Información idéntica a la información sobre la unidad que
aparece en la columna de la unidad de la vista del cliente.

• Bytes de lectura y Bytes de escritura: Cantidad de datos transferidos desde
la asignación.

• Duración: Tiempo que ha transcurrido desde que se asignó la unidad.

Para cerrar la vista Detalles, vuelva a hacer clic en Detalles.

Para reiniciar todos los dispositivos USB en el dispositivo de destino:

La función de reinicio USB reinicia todos los dispositivosUSBdel dispositivo de destino,
incluidosel ratón yel teclado. Esta función sólo debe usarse en caso de que el
dispositivo de destino no responda.

1. En el cuadro de diálogo Medio Virtual, haga clic en Detalles.

2. La vista Detalles aparece. Haga clic en Reinicio USB.

3. Aparece un mensaje de advertencia en el que se indican los posibles
efectos de este reinicio. Confirme o cancele el reinicio.

4. Para cerrar la vista Detalles, vuelva a hacer clic en Detalles.

Cierre de una sesión de medio virtual

Para cerrar el cuadro de diálogo Medio Virtual:

1. Haga clic en Salir.

2. Si tiene unidades asignadas, un mensaje le indica que éstas se
desasignarán. Confirme o cancele esta operación.

Si un usuario intenta desconectar una sesión de medio virtual o una sesión KVM
activa que cuenta con una sesión de medio virtual vinculada asociada, aparece
un mensaje de confirmación indicando que cualquier asignación de medio
virtual se perderá.
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4.11 Tarjetas inteligentes
Puede conectar un lector de tarjeta inteligente a un puerto USB disponible en el
servidor cliente y acceder a los dispositivos de destino acoplados en el sistema
del conmutador. También puede iniciar una sesión KVM para abrir el Visor de
vídeo y asignar una tarjeta inteligente.

Para todos los lectoresde tarjeta inteligente, debe usar un cable USB20-VGA
adaptador KVM s4.

El estado de la tarjeta inteligente se indica mediante el icono de tarjeta
inteligente ubicado a la derecha de la barra de herramientas del Visor de vídeo.
En la siguiente tabla se describen los iconos de estado de la tarjeta inteligente.

Tabla 4.4. Iconos de la tarjeta inteligente

Icono Descripción

No hay tarjeta inteligente en el lector de tarjeta inteligente o no se ha
acoplado un lector de tarjeta inteligente.

Hayuna tarjeta inteligente en el lector de tarjeta inteligente pero no se ha
asignado todavía.

Se ha asignado una tarjeta inteligente.

Para asignar una tarjeta inteligente:

1. Abra una sesión KVM para mostrar el menú de la ventana Visor de vídeo.

2. Introduzca una tarjeta inteligente en el lector de tarjeta inteligente acoplado
al servidor cliente.

3. Haga clic en Herramientas > Asignar tarjeta inteligente en el menú de la
ventana Visor de vídeo.

4. Si no se ha asignado ninguna tarjeta inteligente al dispositivo de destino,
aparecerá un punto junto a la opción No hay tarjeta asignada. Seleccione la
tarjeta inteligente, enumerada bajo esta opción, para asignar la tarjeta
inteligente.

Para anular la asignación de una tarjeta inteligente, cierre la sesión KVM
haciendo clic en la X en el menú de la ventana Visor de vídeo, seleccionando
Herramientas > No hay tarjeta asignada, retirando la tarjeta inteligente del lector
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de tarjeta inteligente o desconectando el lector de tarjeta inteligente del servidor
cliente.

4.12 Paso a través del teclado
Las pulsaciones de tecla que un usuario introduce cuando utiliza la ventana
Visor de vídeo pueden interpretarse de dos modos en función del modo de la
pantalla de la ventana Visor de vídeo.

• Si una ventana Visor de vídeo está en el modo de pantalla completa, todas
las pulsaciones de tecla y combinaciones de pantalla excepto Ctrl-Alt-Supr
se envían al dispositivo de destino remoto que se está visualizando.

• Si la ventana Visor de vídeo está en el modo de escritorio normal, es posible
usar el modo de paso a través del teclado para controlar si el dispositivo de
destino remoto o el ordenador local reconoce ciertas pulsaciones de tecla y
combinaciones del teclado.

El paso a través del teclado debe especificarse mediante el cuadro de diálogo
Opciones de sesión. Cuando está activado, el paso a través del teclado envía
todas las pulsaciones de tecla y combinaciones del teclado excepto Ctrl-Alt-Supr
al dispositivo de destino remoto que se está visualizando cuando la ventana
Visor de vídeo está activa. Cuando el escritorio local está activo, las pulsaciones
de tecla y combinaciones del teclado que ha introducido el usuario afectan al
ordenador local.

La combinación de teclado Ctrl-Alt-Supr solo puede enviarse a un dispositivo de destino
remotomediante el uso de unamacro.

La combinación de teclado japonésALT-Han/pulsacionesde teclasZen siempre se
envía a un dispositivo de destino remoto independientemente delmodo de pantalla o
de la configuración del paso a travésdel teclado.

Para especificar el paso a través del teclado:

1. Seleccione Herramientas - Opciones de sesión en el menú de la ventana
Visor de vídeo.

-o bien-

Haga clic en el botón Opciones de sesión.

Aparece el cuadro de diálogo Opciones de sesión.

2. Haga clic en la ficha General.
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3. Seleccione Paso de todas las pulsaciones de teclas en el modo de ventana
normal.

4. Haga clic en Aceptar para guardar la configuración.

4.13 Macros
La OBWI del conmutador viene preconfigurada con macros para las plataformas
Windows, Linux y Sun.

Para enviar una macro, seleccione Macros -<macro deseada> en el menú de la
ventana Visor de vídeo, o seleccione la macro deseada en los botones
disponibles en el menú Visor de vídeo.

4.14 Guardar la vista
Puede guardar la pantalla de un Visor de vídeo en un archivo o en el
portapapeles para luego pegarla en un procesador de textos o en otro programa.

Para capturar la ventana Visor de vídeo en un archivo:

1. Seleccione Archivo - Capturar a un archivo en el menú de la ventana Visor
de vídeo.

-o bien-

Haga clic en el botón Capturar a un archivo .

Aparece el cuadro de diálogo Guardar como.

2. Escriba un nombre para el archivo y seleccione una ubicación para
guardarlo.

3. Haga clic en Guardar para guardar la pantalla en un archivo.

Para capturar una ventana Visor de vídeo en el portapapeles, seleccione File >
Capturar al portapapeles en el menú de la ventana Visor de vídeo o haga clic en
el botónCapturar al portapapeles. Los datos de la imagen se guardan en el
portapapeles.

4.15 Cierre de una sesión
Para cerrar una sesión en la ventana Visor de vídeo:

Seleccione Archivo - Salir en la ventana Visor de vídeo.
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LDAP es un protocolo estándar independiente del vendedor que se utiliza para
acceder, consultar y actualizar un directorio usando TCP/IP. Basado en el
modelo de servicios de directorio X.500, LDAP es una estructura de directorio
global que admite potentes características de seguridad, entre las que se
incluyen la autenticación, privacidad e integridad.

Si las cuentas de usuario individuales se guardan en un servicio de directorios
compatible con LDAP, como Active Directory, el servicio de directorios puede
utilizarse para la autenticación de los usuarios. Los valores predeterminados
proporcionados para los parámetros de búsqueda y consulta de LDAP están
definidos para su uso con Active Directory.

La configuración establecida en la OBWI le permite definir los parámetros de
configuración de la autenticación. El software envía el nombre de usuario, la
contraseña y otros datos al equipo, que a su vez determina si el usuario tiene
permiso para ver o modificar los parámetros de configuración del equipo en la
OBWI.

Amenosque se indique lo contrario, se deben utilizar los valorespredeterminadosde
LDAPexcepto si se ha reconfigurado Active Directory. Lamodificación de los valores
predeterminadospuede causar erroresde comunicación del servidor de autenticación
LDAP.

5.1 Configuración de LDAP en la interfaz de usuario
En la página Información general de LDAP en la OBWI, puede configurar la
prioridad de autenticación LDAP y los parámetros que definen la información de
la conexión del servidor de LDAP.

Parámetros de información general de LDAP

Prioridad de la autenticación LDAP

En la sección Prioridad de LDAP de la OBWI, puede desactivar el LDAP o definir
la prioridad de autenticación; para ello debe elegir qué autenticación debe
producirse primero, la local o la LDAP.

Para configurar los parámetros de prioridad de la autenticación LDAP:

1. Seleccione Equipo - Configuración del equipo - Cuentas de usuario -
Cuentas LDAP - Información general.

590-1058-640A 77



5. LDAP

2. Seleccione LDAP desactivado, LDAP antes de local o LDAP después de
local para la prioridad de LDAP.

3. Haga clic en Guardar.

Servidores de LDAP

En los campos Dirección se especifican los nombre de host o las direcciones IP
de los servidores de LDAP primario y secundario. El servidor secundario de
LDAP es opcional.

Los campos Puerto especifican los números de puerto del protocolo de
datagramas de usuarios (UDP) que se comunican con los servidores de LDAP.
El valor predeterminado es 389 para LDAP no seguro y 636 para LDAP seguro
(LDAPS). El software introduce automáticamente el ID del puerto cuando se
especifica un tipo de acceso.

Los botones de opción Tipo de acceso especifican de qué modo se envía una
consulta a cada dispositivo de destino de LDAP. Al utilizar LDAP, todos los
nombres de usuario, contraseñas y otra información enviados entre un equipo y
el servidor de LDAP se mandarán como texto no cifrado y no seguro. Utilice
LDAPS para la comunicación segura y cifrada entre un equipo y el servidor de
LDAP.

Para configurar los parámetros del servidor de LDAP:

1. Seleccione Equipo - Configuración del equipo - Cuentas de usuario -
Cuentas LDAP > Información general.

2. Identifique la dirección del servidor primario y secundario, el puerto y el tipo
de acceso en los campos apropiados o los botones de opción.

3. Haga clic en Guardar.

Parámetros de búsqueda de LDAP

En la página Búsqueda de LDAP, puede configurar los parámetros utilizados
cuando se realiza la búsqueda de los usuarios del servicio de directorio de
LDAP. Utilice el campo Nombre completo de búsqueda para definir un usuario
de nivel de administrador que el equipo utiliza para iniciar sesión en el servicio
de directorio. Una vez que la autenticación del equipo haya finalizado, el servicio
de directorio le concederá acceso al directorio para ejecutar las consultas de
autenticación del usuario especificadas en la página Consulta de LDAP. Los
valores predeterminados son cn=Administrator, cn=Users,
dc=sunombrededominio y dc=com, y estos pueden modificarse. Por ejemplo,
para definir un nombre completo (DN) de administrador para test.view.com,
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escriba cn=Administrator, cn=Users, dc=test, dc=view y dc=com. Cada valor
de Nombre completo de búsqueda debe separarse con una coma. El campo
Contraseρa de bϊsqueda se utiliza para autenticar el administrador o los
usuarios especificados en el campo Nombre completo de bϊsqueda. El campo
Base de búsqueda le permite definir un punto de partida desde el cual se
iniciarán las búsquedas de LDAP. Los valores predeterminados son
dc=sunombrededominio y dc=com, y pueden modificarse. Por ejemplo, para
definir una base de búsqueda para test.com, escriba dc=test, dc=com. Cada
valor de Base de búsqueda debe separarse con una coma. En el campo
Máscara ID usuario se especifican los criterios de búsqueda para las búsquedas
de ID de usuario de los dispositivos de destino de LDAP. El formato debe seguir
la forma <name>=<%1>. El valor predeterminado es sAMAccountName=%1, que
es correcto para utilizarse con Active Directory. Este campo es necesario para
las búsquedas de LDAP.

Para configurar los parámetros de búsqueda de LDAP:

1. Seleccione Equipo - Configuración del equipo - Cuentas de usuario -
Cuentas LDAP > Búsqueda.

2. Introduzca la información apropiada en los campos Nombre completo de
búsqueda, Contraseña de búsqueda, Base de búsqueda y Máscara ID
usuario.

3. Haga clic en Guardar.

Estasopcionesno pueden cambiarse si la Prioridad de LDAP se ha configurado a
LDAPdesactivado en la pantalla Información general.

Parámetros de consulta de LDAP

En la página Consulta de LDAP, puede configurar los parámetros utilizados
cuando se efectúan las consultas de autenticación del usuario.

El equipo realiza dos tipos diferentes de consultas. El Modo de consulta (Equipo)
se utiliza para autenticar administradores y usuarios que intenten acceder al
propio equipo. El Modo de consulta (Dispositivo de destino) se utiliza para
autenticar usuarios que intenten acceder a dispositivos de destino conectados.
Además, cada tipo de consulta tiene tres modos que utilizan ciertos tipos de
información para determinar si un usuario de LDAP ha accedido o no a un
equipo o a los dispositivos de destino conectados. Consulte "Modos de consulta
del equipo y del dispositivo de destino" en la página 81 para obtener información
detallada sobre cada modo.

En la página Consulta de LDAP pueden configurarse los siguientes valores:
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• Los parámetros de Modo de consulta (Equipo) determinan si un usuario
tiene o no acceso al equipo.

• Los parámetros de Modo de consulta (Dispositivo de destino) determinan si
un usuario tiene o no acceso como usuario a los dispositivos de destino
conectados a un equipo. El usuario no tiene acceso al equipo, a menos que
le sea concedido por el Modo de consulta (Equipo).

• Los campos Contenedor de grupos, Máscara del contenedor de grupos y
Máscara de destino sólo se utilizan para los modos de consulta de Grupo y
son necesarios al realizar una consulta de equipo o de dispositivo.

• En el campo Contenedor de grupos se especifica la unidad organizativa
(ou) creada en Active Directory por el administrador como la ubicación de
los objetos de grupo.

• Los objetos de grupo son objetos de Active Directory que pueden
contener usuarios, ordenadores, contactos y otros grupos. El
Contenedor de grupos se utiliza cuando el Modo de consulta se
configura a Atributo de grupo. Se asignan miembros a cada objeto de
grupo, uno por uno, para asociarlos con un nivel de acceso específico
para objetos miembro (personas, equipos y dispositivos de destino). El
nivel de acceso asociado con un grupo se configura mediante la
introducción del valor de un atributo en el objeto de grupo.

• Por ejemplo, si se utiliza la propiedad Notas en la lista de objetos de
grupo para aplicar el atributo de control de acceso, el campo Atributo de
control de acceso en la página Consulta de LDAP debe configurarse a
info. Si la propiedad Notas se configura a Usuario administrador de
KVM, se proporcionará a los miembros de ese grupo acceso de
administración de usuarios a los equipos y a los dispositivos de destino
que también sean miembros de ese mismo grupo.

• La propiedad Notas se utiliza para aplicar el atributo de control de acceso.
El valor de la propiedad Notas, disponible en los objetos de grupo y usuario
que se muestran en los usuarios y equipos de Active Directory (ADUC), se
almacena de forma interna en el directorio, en el valor del atributo info.
ADUC es un complemento de la Consola de administración de Microsoft
para la configuración de Active Directory. Para iniciarlo, seleccione Inicio >
Programas > Herramientas administrativas > Usuarios y equipos de Active
Directory. Esta herramienta se utiliza para crear, configurar y eliminar
objetos, como por ejemplo usuarios, ordenadores y grupos. Consulte
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"Modos de consulta del equipo y del dispositivo de destino" en la página 81
para obtener más información.

• El campo Máscara del contenedor de grupos define el tipo de objeto del
Contenedor de grupos, el cual es normalmente una unidad organizativa. El
valor predeterminado es "ou=%1".

• En el campo Máscara de destino se define un filtro de búsqueda para el
dispositivo de destino. El valor predeterminado es "cn=%1".

• En el campo Atributo de control de acceso se especifica el nombre del
atributo que se utiliza cuando los modos de consulta se configuran a
Atributo de usuario y a Atributo de grupo. El valor predeterminado es info.

Para configurar los parámetros de consulta de LDAP:

1. Seleccione Equipo - Configuración del equipo - Cuentas de usuario -
Cuentas LDAP - Consulta.

2. Seleccione Básico, Atributo de usuario o Atributo de grupo para el Modo de
consulta de equipo y Modo de consulta de dispositivo de destino.

3. Introduzca la información apropiada en los campos Contenedor de grupos,
Máscara del contenedor de grupos, Máscara de destino y Atributo de control
de acceso.

4. Haga clic en Guardar.

Estasopcionesno pueden cambiarse si la Prioridad de LDAP se ha configurado a
LDAPdesactivado en la pantalla Información general.

5.2 Modos de consulta del equipo y del dispositivo
de destino
Puede utilizarse uno de los tres modos para el Modo de consulta (Equipo) y el
Modo de consulta (Dispositivo de destino):

• Básico - Se realiza una consulta al servicio del directorio sobre el nombre de
usuario y la contraseña para el usuario. Tras la correspondiente verificación,
se concede al usuario acceso como administrador al equipo, así como a
cualquier dispositivo de destino conectado para el Modo de consulta
(Equipo), o a cualquier dispositivo de destino seleccionado para el Modo de
consulta (Dispositivo de destino).

• Atributo de usuario - Se realiza una consulta al servicio del directorio sobre
el nombre de usuario, contraseña y Atributo de control de acceso para el
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usuario del equipo. El Atributo de control de acceso se lee desde el objeto
de usuario (la cuenta del usuario) en Active Directory.

Si se encuentra el valor Administrador de equipo de KVM, se concede
al usuario acceso como administrador del equipo al equipo, así como a
cualquier dispositivo de destino conectado para el Modo de consulta
(Equipo), o a cualquier dispositivo de destino seleccionado para el
Modo de consulta (Dispositivo de destino).

Si se encuentra el valor Administrador usuario de KVM, se concede al
usuario acceso como administrador usuario al equipo, así como a
cualquier dispositivo de destino conectado para el Modo de consulta
(Equipo), o a cualquier dispositivo de destino seleccionado para el
Modo de consulta (Dispositivo de destino).

Si se encuentra el valor Usuario de KVM, se concede al usuario acceso
de usuario al equipo para el Modo de consulta (Equipo), o a cualquier
dispositivo de destino seleccionado para el Modo de consulta
(Dispositivo de destino).

Si no se encuentra ninguno de los tres valores, no se concede al usuario acceso al
equipo ni a los dispositivosde destino para elModo de consulta (Equipo), ni a ningún
dispositivo de destino seleccionado para elModo de consulta (Dispositivo de destino), a
menosque el usuario cuente con privilegios de Administrador usuario o Administrador
del equipo para el equipo.

Para acceder a ADUC, seleccione Inicio - Programas - Herramientas
administrativas - Usuarios y equipos de Active Directory.

• Atributo de grupo - Se realiza una consulta al servicio de directorio sobre el
nombre de usuario, la contraseña y el grupo para un equipo y los
dispositivos de destino conectados cuando se utiliza el Modo de consulta
(Equipo), o para un dispositivo de destino seleccionado cuando se usa el
Modo de consulta (Dispositivo de destino). Si se encuentra un grupo que
contenga el usuario y el nombre del equipo, se concede al usuario acceso
al equipo y a los dispositivos de destino conectados, según el contenido del
grupo, cuando se utilice el Modo de consulta (Equipo). Si se encuentra un
grupo que contenga los ID del usuario y del dispositivo de destino, se
concede al usuario acceso al dispositivo de destino seleccionado conectado
al equipo, cuando se utilice el Modo de consulta (Dispositivo de destino).

Los grupos se pueden anidar en un máximo de 16 niveles de
profundidad. Gracias a la posibilidad de anidamiento, se pueden crear
grupos dentro de otros grupos. Por ejemplo, puede tener un grupo de
nivel superior denominado Ordenadores, en el que se incluya un
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miembro denominado I+D, que es un grupo. El grupo I+D puede incluir
un miembro denominado Doméstico, que es un grupo, y así
sucesivamente.

5.3 Configuración de Active Directory para realizar
consultas
Antes de poder utilizar cualquiera de los modos de consulta para las unidades,
primero debe realizar cambios en Active Directory, de forma que el modo de
consulta seleccionado pueda asignar el nivel de autorización correcto para el
usuario.

Para configurar consultas de grupo:

1. Inicie sesión en Windows con privilegios de administrador.

2. Abra el software de Active Directory.

3. Cree una unidad organizativa que se utilizará como contenedor de grupo.

4. Cree un objeto de ordenador en Active Directory con un nombre idéntico al
nombre del sistema de conmutación para consultar equipos (especificado
en la pantalla Información general del equipo de la OBWI) o idéntico al de
los dispositivos de destino conectados para consultar dispositivos de
destino. El nombre debe ser exactamente igual, incluidos las mayúsculas y
minúsculas.

5. Los nombres del equipo y de los dispositivos de destino utilizados para las
consultas de grupo se almacenan en el equipo. El nombre del equipo
especificado en la pantalla Información general del equipo de la OBWI y los
nombres del dispositivo de destino debe coincidir exactamente con los
nombres de objeto en Active Directory. Cada uno de los nombres de los
equipos y de los dispositivos de destino puede estar formado por cualquier
combinación de letras mayúsculas y minúsculas (a-z, A-Z), números (0-9) y
guiones (-). No se pueden usar espacios o puntos (.), ni crear un nombre
únicamente formado por números. Éstas son limitaciones de Active
Directory.

El nombre predeterminado de fábrica en versionesanteriores contiene un espacio que
debe eliminarse; para ello, debe editarse el nombre del sistema de conmutación en la
pantalla Información general del equipo de la OBWI.
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6. Cree uno o más grupos bajo la unidad organizativa del contenedor de
grupos.

7. Agregue los nombres de usuario y los objetos de equipo y de dispositivo de
destino a los grupos que se han creado en el paso 5.

8. Especifique el valor de cualquier atributo que se utilice para implementar el
atributo de control de acceso. Por ejemplo, si utiliza info como el atributo en
el campo Atributo de control de acceso y usa la propiedad Notas en el
objeto de grupo para implementar el atributo de control de acceso, el valor
del atributo Notas en Active Directory puede configurarse en uno de los tres
niveles de acceso disponibles (Usuario de KVM, Administrador usuario de
KVM o Administrador de equipo de KVM) para el objeto de grupo. Los
miembros del grupo pueden tener entonces acceso a los equipos y a los
dispositivos de destino en el nivel de acceso especificado.

Si no se encuentra ninguno de los tres valores, se concede al usuario acceso de nivel de
usuario a cualquier equipo o dispositivo de destino enumerado en un grupo con el
nombre de usuario.
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Cada conmutador puede configurarse mediante comunicación directa a

través de la interfaz del menú de consola a la que se accede a través

del puerto SETUP. Se puede acceder a todos los comandos de terminal

a través de un terminal o un ordenador que ejecute un software de

emulación de terminal.

NOTA: Lamejor opción es realizar todos los cambiosen la configuración desde la
interfaz de usuario local.

Para conectar un terminal al conmutador:

1. Mediante el adaptador RJ-45 a DB-9 (hembra) suministrado y el

cable UTP conecte un terminal o un ordenador que ejecute

software de emulación de terminal (como por ejemplo

HyperTerminal) al puerto SETUP del panel posterior del

conmutador. El terminal está configurado a 9.600 bits por

segundo (bps), 8 bits de datos, 1 bit de parada, sin paridad y sin

control de flujo.

2. Encienda primero cada uno de los dispositivos de destino y, a

continuación, el conmutador. Una vez iniciado el conmutador, el

menú de consola mostrará el siguiente mensaje: Press any key to

continue (Pulse cualquier tecla para continuar).

Opciones del menú de inicio de consola
Mientras se enciende el conmutador, puede pulsar una tecla para ver el

menú de inicio. En este menú, puede elegir una de las cuatro

opciones.

• Boot Normal

• Boot Alternate Firmware

• Reset Factory Defaults

• Full-Factory Reset

Opciones del menú de consola principal
Una vez encendido, el menú principal muestra el nombre del producto

y la versión. En este menú, puede elegir una de las cuatro opciones.

• Network configuration: Esta opción de menú le permite

configurar la configuración de red del equipo.
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• Debug messages: Esta opción del menú activa los mensajes de

estado de la consola. Puesto que esta opción puede perjudicar el

rendimiento de forma significativa, únicamente debe activar esta

opción cuando el personal de asistencia técnica de Fujitsu así lo

solicite. Cuando haya terminado la visualización de los mensajes,

pulse cualquier tecla para salir de este modo.

• Reset Appliance: Esta opción del menú le permite ejecutar un

reinicio mediante software del conmutador.

• Exit: Esta opción del menú le devolverá al mensaje "Ready". Si la

contraseña de la interfaz del menú de consola está activada, debe

salir del menú principal de la consola para que al siguiente

usuario se le pida que introduzca el nombre de usuario y la

contraseña en la pantalla de inicio de sesión.
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Apéndice B: Uso de cables serie adaptadores
KVMs4
Uso de cables serie adaptadores KVMs4

El administrador puede elegir entre contactos de Cisco o contactos del

servidor de consola ACS para cada puerto cable adaptador serie

mediante la interfaz de usuario local o la OBWI remota. ACS es la

opción predeterminada.

Para cambiar los contactos al modo Cisco:

1. Seleccione Vista de unidades - Equipo - Configuración del

equipo - Puertos - Cables adaptadores.

2. Haga clic en el (los) cable(s) adaptador(es) serie deseado(s).

3. Seleccione Configuración - Contacto.

NOTA: Si se utiliza el adaptador DB-9, seleccione los contactosdel servidor de
consola ACS.

Contactos del puerto del servidor de consola ACS

En la tabla siguiente se enumeran los contactos del puerto serie del

servidor de consola ACS para el cable adaptador serie.

Nº de
clavija Nombre de la señal Entrada/salida

1 RTS - Solicitud de envío SALIDA

2 DTR - Terminal de
datospreparado SALIDA

3 TXD - Transmisión de
datos SALIDA

4 GND - Señal de tierra N/D

5 CTS - Preparado para
enviar ENTRADA

6 RXD - Recepción de
datos ENTRADA

Tabla B.1: Contactos del puerto serie del servidor de consola ACS
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Nº de
clavija Nombre de la señal Entrada/salida

7 DCD/DSR - Conjunto
de datospreparado ENTRADA

8 N/C - No conectado N/D

Contactos del puerto Cisco

En la tabla siguiente se enumeran los contactos del puerto serie Cisco

para el cable adaptador serie.

Nº de
clavija Nombre de la señal Entrada/salida

1 CTS - Preparado para
enviar ENTRADA

2 DCD/DSR - Conjunto
de datospreparado ENTRADA

3 RXD - Recepción de
datos ENTRADA

4 GND - Señal de tierra N/D

5 N/C - No conectado N/D

6 TXD - Transmisión de
datos SALIDA

7 DTR - Terminal de
datospreparado SALIDA

8 RTS - Solicitud de envío SALIDA

Tabla B.2: Contactos del puerto serie Cisco
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Apéndice C: Cableado UTP
En este apéndice se analizan diversos aspectos de los medios de

conexión. El sistema de conmutación KVM s4 utiliza cableado UTP.

El rendimiento de sistema del conmutador depende de conexiones de

alta calidad. Un cableado de mala calidad, que esté mal instalado o

que no reciba un mantenimiento adecuado, puede perjudicar el

rendimiento del sistema del conmutador.

NOTA: Este apéndice se ha redactado para fines informativos solamente. Póngase
en contacto con técnicosautorizados y con losasesoresde cableadomáspróximos
antesde efectuar cualquier instalación.

Cableado de cobre UTP
A continuación se proporcionan las definiciones correspondientes a

los tres tipos de cableado UTP compatibles con el conmutador KVM

s4:

• El cable de alto rendimiento CAT 5 (4 pares) se compone de

conductores de par trenzado utilizados principalmente en la

transmisión de datos. El diseño trenzado de los pares proporciona

al cable cierta inmunidad ante la infiltración de interferencias no

deseadas. El cable CAT 5 se utiliza por norma general en redes

que funcionan a 10 o 100 Mbps.

• El cable CAT 5E (mejorado) cuenta con las mismas características

que CAT 5, pero su fabricación se efectúa siguiendo normas más

rigurosas.

• El cable CAT 6 se fabrica para cumplir con unas normas aún más

rigurosas que las del cable CAT 5E. CAT 6 alcanza intervalos de

frecuencia medida superiores y sus prestaciones de rendimiento

son sustancialmente mejores que las del cable CAT 5E a las

mismas frecuencias.

Normas de cableado
Existen dos normas de cableado compatibles con el cable UTP de

terminación RJ-45 de 8 conductores (4 pares): EIA/TIA 568A y B.

Estas normas se aplican a instalaciones que utilizan especificaciones

de cable CAT 5, CAT 5E y CAT 6. El sistema de conmutación KVM

s4 es compatible con todas las normas de cableado mencionadas. En la
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tabla siguiente se describen las normas correspondientes a cada

clavija.

Clavija EIA/TIA 568A EIA/TIA 568B

1 blanco/verde blanco/naranja

2 verde naranja

3 blanco/naranja blanco/verde

4 azul azul

5 blanco/azul blanco/azul

6 naranja verde

7 blanco/marrón blanco/marrón

8 marrón marrón

Tabla C.1: Normas de cableado UTP

Consejos sobre la instalación, mantenimiento y seguridad
del cableado

A continuación se proporciona una lista de consideraciones de

seguridad importantes que deben comprobarse antes de proceder con

la instalación o el mantenimiento de los cables:

• Mantenga todos los tramos UTP a una distancia máxima de 10

metros cada uno.

• Mantenga los trenzados de los pares hasta el punto de terminación

o no más de 12,7 mm sin trenzado. No retire más de 25,4 mm de

la cubierta protectora en la terminación.

• Si fuera necesario doblar el cable, hágalo de forma gradual sin

dobleces de más de 2,5 cm de radio. La parte interior del cable se

puede dañar de forma permanente si el cable se deja con dobleces

o pliegues bruscos.

• Utilice cintas de amarre para fijar los cables con cuidado,

aplicando una presión de leve a moderada. No apriete las cintas

de amarre de forma excesiva.
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• Interconecte los cables en los puntos en los que sea necesario,

mediante bloques de perforación, paneles de interconexión y

componentes de capacidad especificada. No una ni empalme

cables en ningún punto.

• Mantenga el cable UTP lo más lejos posible de cualquier posible

fuente de interferencias electromagnéticas, como por ejemplo

cables eléctricos, transformadores y aparatos de alumbrado

eléctrico. No amarre los cables a conductos eléctricos o a otros

cables pertenecientes a otras instalaciones eléctricas.

• Compruebe todos los segmentos de cable instalados con un

dispositivo de prueba de cables. Una prueba de “tonos” solamente

no es suficiente.

• Instale siempre conectores para impedir que el polvo u otras

formas de contaminación se asienten en los contactos. Los

contactos del conector deben orientarse hacia arriba sobre las

placas empotradas o hacia la izquierda/derecha/hacia abajo en las

cajas de montaje exteriores.

• Deje siempre algo de holgura adicional en los cables, y

colóquelos cuidadosamente enrollados en el techo o de forma

oculta en el lugar más cercano. Deje como mínimo 1,5 m de

distancia en el lado de salida y 4,5 m en el lado del panel de

interconexión.

• Elija entre la norma de cableado 568A o 568B antes de empezar.

Cablee todos los conectores y los paneles de interconexión

siguiendo el mismo esquema de cableado. No mezcle cableado

568A y 568B en la misma instalación.

• Respete siempre todas las medidas locales y nacionales sobre

construcción y prevención de incendios. Asegúrese de instalar un

firewall en todos los cables que penetren en el sistema de

protección. Utilice cables plenum (ignífugos) donde sea necesario.
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Apéndice D: Información sobre el contacto del
cable

NOTA: Todos los conmutadores cuentan con un enchufemodular de 8 clavijas para
los puertosde configuración/consola ymódem.

Figura D.1: Enchufe del módem

Clavija Descripción Clavija Descripción

1
Solicitud de
envío (RTS)

5 Transmisión de datos (TXD)

2

Conjunto de
datos
preparado
(DSR)

6 Señal de tierra (SG)

3
Detección de
portadora de
datos (DCD)

7 Terminal de datospreparado (DTR)

4
Recepción de
datos (RXD)

8 Preparado para enviar (CTS)

Tabla D.1: Descripciones para la Figura D.1
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Figura D.2: Enchufe de configuración/consola

Clavija Descripción Clavija Descripción

1
No conectado
(N/C)

5 Transmisión de datos (TXD)

2
No conectado
(N/C)

6 Señal de tierra (SG)

3
No conectado
(N/C)

7 No conectado (N/C)

4
Recepción de
datos (RXD)

8 No conectado (N/C)

Tabla D.2: Descripciones para la Figura D.2
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Apéndice E: Especificaciones técnicas

Puertosde servidor

Número

KVM s4-0812: 8

KVM s4-1622: 16

KVM s4-3242: 32

Tipo PS/2, USB yserie

Conectores Modular de 8 clavijas

Tiposde sincronización Horizontal y vertical separada

Resolución del vídeo de
entrada

Estándar

640 x480 a 60 Hz

800 x600 a 75 Hz

960 x700 a 75 Hz

1024 x768 a 75 Hz

1280 x1024 a 75 Hz

1600 x1200 a 60 Hz

Pantalla panorámica

800 x500 a 60 Hz

1024 x640 a 60 Hz

1280 x800 a 60 Hz

1440 x900 a 60 Hz

1680 x1050 a 60 Hz

Cableado compatible UTPde 4 pares, con una longitudmáxima de 45m

Dimensiones

Factor de forma Se puedemontar en racksde 1 U

Tabla E.1: Especificaciones técnicas
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Puertosde servidor

Dimensiones
4,3 cm x43,1 cm x23,3 cm (Altura xAnchura x
Profundidad)

Peso (sin cables)

KVM s4-0812: 3,0 kg

KVM s4-1622: 3,2 kg

KVM s4-3242: 3,4 kg

Puerto SETUP

Número 1

Tipo RS-232 serie

Conector Modular de 8 clavijas

Puerto local

Número/tipo 1 VGA/4 USB

Conexión de red

Número 2

Tipo Ethernet 10/100/1000

Conector Modular de 8 clavijas

Puerto USB del dispositivo

Número 4

Tipo USB2.0

Puerto MODEM

Número 1

Tipo RS-232 serie

Conectores Modular de 8 clavijas

Puerto PDU
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Puertosde servidor

Número 2

Tipo RS-232 serie

Conector Modular de 8 clavijas

Especificaciones de alimentación

Conectores 2

Tipo Interna

Alimentación

KVM s4-0812: 13W

KVM s4-1622: 18W

KVM s4-3242: 24W

Disipación de calor

KVM s4-0812: 45.367,40 J/h

KVM s4-1622: 47.477,7 J/h

KVM s4-3242: 49.587,63 J/h

Tensión de entrada de
CA

De 100 a 240 V de CA

Frecuencia de CA De 50 a 60 Hzcon detección automática

Corriente de entrada de
CA

1,25 A

Alimentación de entrada
de CA (máxima)

40W

Especificaciones de las condiciones atmosféricas ambientales

Temperatura
De 0 a 50 ºC en funcionamiento;

De -20 a 70 ºC en reposo
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Puertosde servidor

Humedad

En funcionamiento: De 20%a 80%de humedad
relativa (sin condensación)

En reposo: De 5%a 95%de humedad relativa,
temperatura de bulbo húmedomáxima de 38,7 ºC

Homologaciones y
marcas de normas
EMC y de seguridad

UL, FCC, cUL, ICES-003, CE, VCCI, KCC, C-Tick
yGOST

Tanto los certificadosde seguridad como los
certificadosEMC para este producto se obtienen
con alguna de las siguientesdesignaciones: CMN
(CertificationModelNumber, número demodelo
de homologación), MPN (Manufacturer’sPart
Number, número de pieza del fabricante) o la
designación demodelo de nivel de distribución. La
designación a la que se hace referencia en los
certificadose informesde seguridad y/o EMC está
impresa en la etiqueta del producto.
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Apéndice F: Emulación de teclas Sun
Determinadas teclas en un teclado Sun tipo 5 estándar se pueden

emular mediante secuencias de pulsación de teclas en un teclado USB

con puerto local. Para activar el modo de emulación de teclas

avanzadas de Sun y utilizar estas teclas, pulse y mantenga pulsado

Ctrl+Mayús+Alty, a continuación, pulse la tecla Bloq Despl. El LED
de Bloq Despl parpadeará. Use las teclas indicadas que aparecen en la

siguiente tabla del mismo modo en que usaría las teclas en un teclado

Sun. Por ejemplo: Para Stop + A, pulse y mantenga pulsado
Ctrl+Mayús+Alt y pulse Bloq Dspl y, a continuación, F1 + A.

Estas combinaciones de teclas funcionan con los cables VGA-USB20

adaptadores KVM s4. Con la excepción de F12, Windows de

Microsoft no reconoce estas combinaciones de teclas. Si se usa F12 se

efectúa una pulsación de teclas de Windows.

Al finalizar, pulse y mantenga pulsado Ctrl+Mayús+Alt y, a

continuación, pulse la tecla Bloq Despl para activar y desactivar el

modo de emulación de teclas avanzadas de Sun.

Tecla Sun Tecla para activar la emulación de teclasSun

Compose Aplicación(1)

Compose Teclado numérico

Alimentación F11

Abrir F7

Ayuda Bloq Num

Props F3

Delante F5

Stop F1

Repetir F2

Anular F4

Cortar F10

Tabla F.1: Emulación de teclas Sun
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Tecla Sun Tecla para activar la emulación de teclasSun

Copiar F6

Pegar F8

Buscar F9

Silencio Teclado numérico /

Vol + Teclado numérico +

Vol.- Teclado numérico -

Comando
(izquierdo)(2) F12

Comando
(izquierdo)(2) Win (GUI) izquierdo (1)

Comando
(derecho)(2) Win (GUI) derecho (1)

NOTASFINALES:

(1)Teclado de 104 teclasparaWindows95.

(2)La tecla Comando es la tecla SunMeta (rombo).
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Apéndice G: Ayuda y asistencia técnica
Si necesita ayuda, asistencia técnica, efectuar operaciones de

mantenimiento o simplemente desea obtener más información acerca

de los productos de Fujitsu, tiene la posibilidad de elegir entre un

amplio abanico de opciones que Fujitsu pone a su disposición. En esta

sección encontrará información sobre dónde puede acudir para obtener

más información sobre Fujitsu y sus productos, qué hacer en caso de

que sufra algún problema con el sistema y quién puede realizar las

operaciones de mantenimiento, en caso de que sea necesario.

Antes de solicitar ayuda
Antes de solicitar ayuda, asegúrese de que haya seguido los pasos que

se describen a continuación para intentar resolver el problema por su

cuenta.

• Compruebe todos los cables y asegúrese de que estén conectados.

• Compruebe los interruptores de alimentación para asegurarse de

que el sistema y todos los dispositivos estén encendidos.

• Consulte la información que aparece en la sección de resolución

de problemas de la documentación del sistema, y utilice las

herramientas de diagnóstico del sistema. La información sobre las

herramientas de diagnóstico se encuentra en la Guía de

mantenimiento y localización de problemas presente en el CD de

documentación de Fujitsu que se incluye con el sistema.

• Visite el sitio Web de asistencia técnica de Fujitsu en

http://www.ts.fujitsu.com/support/ para consultar información

técnica, trucos, consejos y controladores nuevos para los

dispositivos, así como para enviar una solicitud de información.

Si sigue los procedimientos de resolución de problemas que Fujitsu

facilita en la ayuda online y en la documentación que se incluye con

el producto de Fujitsu, podrá resolver un número muy elevado de

problemas sin tener que recurrir a ningún tipo de ayuda externa. Las

pruebas de diagnóstico que pueden realizarse también se describen en

la documentación de los sistemas Fujitsu. La mayoría de sistemas,

sistemas operativos y programas disponen de documentación en la que

es posible encontrar procedimientos de resolución de problemas y

explicaciones de los mensajes y códigos de error. Si sospecha que
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puede existir un problema de software, consulte la documentación del

sistema operativo y del programa.
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1. Panoramica sul prodotto

1.1 Caratteristiche e vantaggi
Gli switch KVM serie s4-0812/1622/3242 Fujitsu associano tecnologia digitale e
tecnologia analogica, per offrire un controllo centralizzato flessibile dei server del
centro dati, e funzioni di supporto virtuale per agevolare le operazioni e gli
interventi di attivazione e manutenzione negli uffici delle sedi distaccate, dove il
personale qualificato potrebbe non essere immediatamente disponibile. Gli
switch KVM s4 basati su IP consentono di controllare e gestire i dispositivi di
destinazione in modo flessibile e di accedere in modalità remota sicura da
qualsiasi luogo e in qualsiasi momento.

Gli switch KVM s4 mettono a disposizione dei clienti aziendali le seguenti
funzionalità e opzioni:

• significativa riduzione dell'ingombro dei cavi

• funzionalità KVM (tastiera, monitor e mouse) e configurazione per
connessioni analogiche (locali) o digitali (remote)

• funzionalità seriali totali tramite protocollo SSH (Secure Shell) e Telnet

• supporto di risoluzioni video superiori, fino a 1600 x 1200 o 1680 x 1050
(widescreen) nativa da dispositivo di destinazione tramite connessione
remota

• accesso a funzionalità di supporto virtuale tramite porte USB

• doppio percorso video indipendente della porta locale (dedicati ad ACI)

• dual stack IPv4 (DHCP) e IPv6 (DHCPv6 e configurazione automatica
stateless) per l'accesso simultaneo

• supporto di lettori di smart card compatibili con CCID

• accesso ai dispositivi di destinazione tramite porte LAN 10/100 o 1000BaseT

• porta MODEM per modem V.34, V.90 o compatibile con V.92 che consente
di accedere allo switch quando non è disponibile una connessione Ethernet

Riduzione della massa di cavi

Dato il continuo aumento della densità di server, la massa di cavi è uno dei
principali fattori che gli amministratori di rete devono tenere in considerazione.
Grazie agli innovativi cavi CO (Conversion Option) con funzionalità di supporto
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virtuale e al cablaggio che si avvale dello standard di settore UTP (Unshielded
Twisted Pair), lo switch KVM s4 consente di ridurre in misura notevole l'ingombro
dei cavi KVM nel rack. In questo modo è possibile usufruire di una densità di
server maggiore e al tempo stesso assicurare una migliore capacità di
ventilazione e di raffreddamento.

Funzionalità di commutazione KVM

Lo switch KVM s4 supporta cavi adattatore alimentati direttamente dal dispositivo
di destinazione e offrono funzionalità Keep Alive quando lo switch non è acceso.
Sono supportati i seguenti cavi adattatore: cavo adattatore KVM s4 USB20-VGA
e cavo adattatore KVM s4 seriale.

Funzionalità seriali totali

Lo switch KVM s4 supporta i cavi adattatore KVM s4 seriali che offrono
funzionalità seriali totali tramite il protocollo SSH (Secure Shell) o Telnet. È
possibile avviare una sessione SSH o un visualizzatore seriale mediante
l'interfaccia Web integrata (OBWI) per stabilire una connessione con i dispositivi
di destinazione collegati agli switch KVM s4 tramite un cavo adattatore KVMs4
seriale.

Interfacce utente locale e remota

L'interfaccia utente locale consente di stabilire una connessione diretta con la
porta locale per gestire lo switch KVM s4. Lo switch può essere gestito anche
tramite l'interfaccia OBWI remota, che è basata su browser e viene avviata
direttamente dallo switch. Tutti i dispositivi collegati allo switch KVM s4 vengono
rilevati automaticamente. Le due interfacce utente hanno un aspetto simile per
agevolare l'utilizzo da parte dell'utente.

Controllo delle funzionalità di supporto virtuale e di switch che
supportano le smart card

Lo switch KVM s4 consente di visualizzare, spostare o copiare dati memorizzati
su supporti virtuali su un qualsiasi dispositivo di destinazione o viceversa. La
gestione dei sistemi remoti risulta più efficiente grazie alle operazioni di
installazione e ripristino di sistemi operativi, ripristino e duplicazione di dischi
rigidi, aggiornamento del BIOS e backup dei dispositivi di destinazione.

Con un sistema di commutazione basato sullo switch KVM s4 è possibile
utilizzare le smart card, le piccole e pratiche schede in grado di memorizzare ed
elaborare informazioni. Smart card come le schede di tipo CAC (Common
Access Card) possono essere usate per memorizzare dati di identificazione e
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autenticazione che consentono l'accesso a computer, reti e stanze o edifici
protetti.

I supporti virtuali e i lettori di smart card possono essere collegati allo switch
direttamente tramite le porte USB presenti sullo switch, oppure possono essere
collegati a qualunque stazione di lavoro remota sulla quale è in esecuzione
l'interfaccia OBWI remota o il software di gestione Avocent® DSView® 3 e che è
connessa allo switch tramite la porta Ethernet.

Per avviare una sessione di supporto virtuale su un dispositivo di destinazione, il
dispositivo deve essere collegato allo switch tramite il cavo adattatore. Per utilizzare una
smart card, il dispositivo di destinazione deve essere collegato a uno switchmediante il
cavo adattatore compatibile con smart card.

Accesso allo switch tramite una rete TCP/IP standard

È possibile controllare e accedere allo switch in modalità remota "agentless".
Non è necessario installare software o driver speciali sui server collegati o sul
client.

Per stabilire una connessione tra client e switch è sufficiente un browser.

Per accedere allo switch e a tutti i sistemi collegati è possibile utilizzare una
connessione tramite la porta Ethernet o un modem V.34, V.90 o V.92 collegato a
un client, ossia a un qualsiasi computer dotato di una connessione di rete valida.

Plug-in del software di gestione DSView 3

Con lo switch può essere utilizzato il software DSView 3 che consente agli
amministratori IT di accedere, monitorare e controllare in modalità remota i
dispositivi di destinazione su piattaforme diverse da un'unica interfaccia utente
basata su Web. Per ulteriori informazioni consultare il bollettino tecnico sul plug-
in del software DSView 3 per switch Switch KVM s4.
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1.2 Esempio di configurazione

Figura 1.1. Esempio di configurazione di uno switch

Tabella 1.1. Descrizioni relative alla Figura 1.1

Numero Descrizione Numero Descrizione

1 Collegamento
CAT 5 7 Rete telefonica

2 Collegamento
KVM allo switch 8 Ethernet

3 Connessione IP
remota 9 Server del software DSView 3

4 Rackdi server 10 Utente con accesso analogico
(interfaccia locale)
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Numero Descrizione Numero Descrizione

5 Switch KVM s4 11
Utente con accesso digitale (computer
dotato di browser, interfaccia OBWI
remota)

6 Modem
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2. Installazione

2.1 Connettività dello switch KVM s4
Lo switch KVM s4 trasmette informazioni KVM e seriali tra operatori e dispositivi
di destinazione collegati allo switch tramite una connessione di rete basata su
Ethernet o su modem.

Per le comunicazioni tramite Ethernet lo switch KVM s4 utilizza il protocollo
TCP/IP. Per ottenere prestazioni ottimali dal sistema, utilizzare una rete
commutata 100BaseT o 1000BaseT dedicata; è possibile usare anche una
connessione Ethernet 10BaseT.

Per la comunicazione tramite un modem V.34, V.90 o V.92 lo switch KVM s4
utilizza il protocollo PPP (Point-to-Point). Le attività di commutazione KVM e
seriale possono essere eseguite usando l'interfaccia OBWI o il software DSView
 3. Per ulteriori informazioni sul software DSView 3 visitare il sito Web
http://www.avocent.com/fujitsu.

Nella Figura 2.1 è mostrato un esempio di configurazione di base dello switch; le
descrizioni sono riportate nella Tabella 2.1.
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Figura 2.1. Configurazione di base di uno switch KVM s4-3242

Tabella 2.1. Descrizioni relative alla Figura 2.1

Numero Descrizione Numero Descrizione

1
Utente con
accesso digitale 8 Cavo di alimentazione

2 Rete telefonica 9 Porte 1-32
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Numero Descrizione Numero Descrizione

3 Rete 10 CollegamentiUSB locali

4 Modem 11 Dispositivo di controllo dell'alimentazione

5
Utente con
accesso
analogico

12 Dispositivi di destinazione 1-32

6 Supporto
virtuale esterno 13 Cavi adattatore

7 KVM s4-3242
switch

Controlli preliminari

Prima di installare lo switch, controllare di avere a disposizione tutti i componenti
forniti insieme allo switch e gli altri componenti necessari all'installazione
elencati di seguito.

Componenti forniti con lo switch

• Kit delle staffe di montaggio su rack

• Guida all'installazione rapida delle staffe di montaggio su rack

• Guida all'installazione rapida KVM s4

• Guida alla sicurezza e alle dichiarazioni di conformità

• Cavi e adattatori per le porte MODEM e SETUP

• Cavo o cavi di alimentazione a corrente alternata

Componenti aggiuntivi necessari

• Un cavo adattatore per ciascun dispositivo di destinazione

• Un cavo adattatore seriale per ciascun dispositivo seriale

• Un cavo patch UTP per ciascun cavo adattatore (UTP a 4 doppini, lunghezza
massima 45 metri)

• Uno o più cavi patch UTP per il collegamento alla rete (UTP a 4 doppini,
lunghezza massima 45 metri)

• Un cavo adattatore compatibile con le funzionalità di supporto virtuale per
ciascun dispositivo di destinazione per le sessioni di supporto virtuale
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• Un cavo adattatore compatibile con smart card per ciascun dispositivo di
destinazione per il controllo tramite smart card

Configurazione della rete

Lo switch e i dispositivi di destinazione vengono identificati in modo univoco
tramite indirizzi IP. Lo switch KVM s4 offre supporto sia per il protocollo DHCP
(Dynamic Host Configuration Protocol) che per indirizzi IP statici. Accertarsi di
assegnare un indirizzo IP a ciascuno switch e di mantenere l'indirizzo statico
durante la connessione dello switch alla rete.

2.2 Montaggio dello switch KVM s4 su rack
Con ciascuno switch viene fornito un kit di montaggio su rack. È possibile sia
posizionare lo switch su un ripiano del rack che installarlo direttamente in un rack
standard EIA (Electronic Industries Alliance).

Lo switch può essere montato su rack con configurazione 1U o 0U.

Norme di sicurezza per il montaggio su rack

• Carico sul rack: il sovraccarico dei rack o una distribuzione non uniforme del
peso può provocare il cedimento del ripiano o del rack stesso, con
conseguenti danni alle apparecchiature e possibili infortuni alle persone.
Stabilizzare i rack in una postazione permanente prima dell'installazione.
Installare le apparecchiature sul rack partendo dal basso e proseguendo
verso l'alto. Non superare i limiti di carico del rack.

• Norme di alimentazione: collegare esclusivamente alla fonte di
alimentazione specificata sull'unità. Se si installano su un rack più
componenti elettrici, verificare che i limiti di alimentazione dell'insieme dei
componenti non superino le capacità del circuito. Il sovraccarico delle fonti di
alimentazione e delle prolunghe può causare incendi e infortuni dovuti a
scariche elettriche.

• Temperatura ambiente elevata: se si installano i componenti in un rack
chiuso, è possibile che la temperatura di esercizio all'interno del rack superi
la temperatura ambiente. Verificare che il limite massimo della temperatura
ambiente prescritta per l'accessorio non venga superato.

• Ventilazione insufficiente: installare le apparecchiature nel rack in modo da
garantire la circolazione dell'aria necessaria per il funzionamento sicuro
delle apparecchiature.
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• Messa a terra affidabile: dotare le apparecchiature montate su rack di messa
a terra affidabile. Prestare particolare attenzione ai collegamenti non diretti
al circuito derivato (per esempio l'uso di prese multiple).

• Il prodotto non deve essere montato con il pannello posteriore rivolto in
basso.

Per istruzioni complete sull'installazione delle staffe di montaggio su rack fare
riferimento alla Guida all'installazione rapida dello switch KVM s4.

2.3 Collegamento dei componenti hardware dello
switch
Per collegare e accendere lo switch:

Per evitare possibili problemi di video e/o tastiera durante l'utilizzo di
prodotti Fujitsu osservare le seguenti precauzioni: se l'alimentazione nell'edificio
è a corrente alternata trifase, verificare che il computer e ilmonitor siano collegati alla
stessa fase. Per risultati ottimali devono essere entrambi collegati allo stesso circuito.

AVVERTENZA: per ridurre il rischio di scariche elettriche o danni alle
apparecchiature, osservare le seguenti precauzioni:
- Non scollegare la presa conmessa a terra di alimentazione. La presa conmessa a
terra è unamisura di sicurezza estremamente utile.
- Collegare il cavo di alimentazione a una presa dotata dimessa a terra facilmente
accessibile in qualsiasimomento.
- Per scollegare il prodotto dall'alimentazione scollegare il cavo di alimentazione dalla
presa elettrica o dal prodotto.
- Per scollegare l'alimentazione dal prodotto è necessario scollegare la presa a corrente
alternata. Per eliminare completamente l'alimentazione da prodotti dotati di più di una
presa a corrente alternata è necessario scollegare tutti i cavi della linea a corrente
alternata.
- Il prodotto non contiene componenti interni che possono essere sottoposti a
manutenzione. Non aprire né rimuovere il coperchio del prodotto.

1. Collegare i cavi del monitor VGA e della tastiera e mouse USB alle
corrispondenti porte.

2. Scegliere una delle porte disponibili sullo switch. Collegare un'estremità di
un cavo UTP (a 4 doppini e con lunghezza massima di 45 m) a una delle
porte numerate e l'altra estremità a un connettore RJ-45 di un cavo
adattatore.
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3. Collegare il cavo adattatore alle porte corrispondenti sul pannello posteriore
di un dispositivo di destinazione. Ripetere la procedura per tutti i dispositivi
di destinazione da collegare.

Per il collegamento a un dispositivo di destinazione SunMicrosystem è necessario
utilizzare sulla porta locale unmonitor a sincronizzazionemultipla compatibile con
computer Sun che supporti sia VGA che la sincronizzazione su verde o composita.

4. Collegare entrambe le porte LAN a switch Ethernet indipendenti per fornire
ridondanza.

5. Accendere tutti i dispositivi di destinazione, quindi individuare il cavo di
alimentazione in dotazione con lo switch e collegarlo alla presa sul pannello
posteriore dello switch. Collegare l'altra estremità a una presa a corrente
alternata di rete adeguata. Collegare il secondo cavo di alimentazione alla
presa di alimentazione sul pannello posteriore dello switch. Collegare l'altra
estremità a una presa di rete adeguata.

Collegare gli alimentatori ridondanti a un circuito derivato diverso per garantire
caratteristiche di ridondanza aggiuntiva in caso di interruzione del servizio di una linea di
alimentazione a corrente alternata esterna.

Per collegare supporti virtuali locali o un lettore di smart card:

Collegare il supporto virtuale o il lettore di smart card a una porta USB
disponibile dello switch.

Per tutte le sessioni di supporto virtuale e per i lettori di smart card è necessario
utilizzare un cavo adattatore KVM s4 USB20-VGA.

Per informazioni sul collegamento di supporti virtuali in modalità remota fare
riferimento a "Supporto virtuale" a pagina 66. Per informazioni sul collegamento
di un lettore di smart card in modalità remota fare riferimento a "Smart card" a
pagina 71.

Per collegare un cavo adattatore seriale a un dispositivo seriale mediante un
connettore UTP:

1. Collegare il connettore UTP del cavo adattatore seriale al dispositivo seriale.

- oppure -

Collegare il cavo adattatore seriale a un adattatore da RJ-45 a 9 pin
femmina. Collegare l'adattatore alla porta seriale del dispositivo seriale.
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2. Collegare un'estremità di un cavo UTP (a 4 doppini e con lunghezza
massima di 45 m) a una delle porte numerate disponibili sul pannello
posteriore dello switch e l'altra estremità a un connettore RJ-45 del cavo
adattatore seriale.

3. Collegare un cavo di alimentazione da USB a connettore cilindrico al
connettore di alimentazione sul cavo adattatore seriale. Collegare il
connettore USB del cavo di alimentazione da USB a connettore cilindrico a
una delle porte USB disponibili sul dispositivo di destinazione seriale.

2.4 Collegamento di switch KVM s4 in serie
È possibile collegare in serie fino a due livelli di switch KVM s4 per il
collegamento di un massimo di 1024 server. In un sistema in serie ciascuna
porta per dispositivo di destinazione sullo switch principale viene collegata alla
porta ACI (Analog Console Interface) di ciascuno switch in serie, che a sua volta
viene collegato a un dispositivo tramite un cavo adattatore.
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Figura 2.2. Configurazione con switch KVM s4 collegati in serie

Numero Descrizione

1 Switch KVM s4 principale

2 Switch KVM s4 in serie

3 Porta per dispositivo di destinazione sullo switch principale

4 Porta ACI sullo switch in serie

5 Dispositivi di destinazione collegati agli switch

Tabella 2.2. Descrizioni relative alla figura 2.2
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Per collegare in serie più switch:

1. Collegare un'estremità di un cavo CAT 5 alla porta per dispositivo di
destinazione sullo switch KVM 4.

2. Collegare l'altra estremità del cavo CAT 5 alla porta ACI (icona a forma di
maglie di catena) sul pannello posteriore dello switch KVM s4 in serie.

3. Collegare i dispositivi allo switch KVM s4 in serie.

4. Ripetere la procedura per tutti gli switch KVM s4 in serie da collegare al
sistema.

Il sistema "fonderà" automaticamente i due switch e tutti i dispositivi collegati allo switch
in serie saranno visualizzati nell'elenco principale dell'interfaccia utente locale dei
dispositivi collegati allo switch.

Lo switch supporta uno switch in serie per ciascuna porta per dispositivi di destinazione
dello switch principale. Non è possibile collegare allo switch in serie un numero di switch
maggiore.

Il collegamento in serie sulla porta locale non è supportato su switch KVM s4.

2.5 Configurazione degli switch KVM s4
Dopo avere completato tutti i collegamenti fisici è necessario configurare lo
switch per l'uso effettivo nel sistema di commutazione utilizzando uno dei due
metodi a disposizione.

Per configurare lo switch utilizzando il software DSView 3:

Per istruzioni dettagliate fare riferimento alla Guida all'installazione e manuale
dell'utente di DSView 3.

Per configurare lo switch utilizzando l'interfaccia utente locale:

Per istruzioni dettagliate sull'impostazione iniziale della rete mediante
l'interfaccia utente locale fare riferimento a "Impostazioni di rete" a pagina 32.

Impostazione del server Web integrato

È possibile accedere allo switch tramite un server Web incorporato in grado di
gestire la maggior parte delle attività quotidiane sullo switch. Prima di utilizzare il
server Web per accedere allo switch è necessario specificare un Indirizzo IP
tramite la porta locale sul pannello posteriore dello switch oppure tramite
l'interfaccia utente locale.
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Connessione all'interfaccia OBWI attraverso un firewall

In installazioni di switch in cui l'accesso viene effettuato tramite l'interfaccia OBWI,
per l'accesso dall'esterno di un firewall è necessario aprire le seguenti porte.

Numero porta
TCP Funzione

22 Utilizzata per il protocollo SSH per sessioni seriali tramite un cavo
adattatore seriale

23 Utilizzata per Telnet (quando è attivato)

80 Utilizzata per il download iniziale delVisualizzatore video

443 Utilizzata dall'interfaccia di tipo browser per gestire lo switch e avviare
sessioniKVM

2068 Trasmissione di dati della sessione KVM (mouse e tastiera) o
trasmissione di dati video agli switch

Tabella 2.3. Porte TCP e funzioni per l'interfaccia OBWI dello switch

In una configurazione tipica, come quella mostrata nella Figura 2.3, il computer
dell'utente è situato all'esterno del firewall e lo switch all'interno.

Figura 2.3. Configurazione tipica del firewall con uno switch

Tabella 2.4. Descrizioni relative alla Figura 2.3
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2.6 Verifica dei collegamenti

Numero Descrizione

1 Switch KVM s4

2 Firewall

3 Computer dell'utente

4 Il firewall inoltra le richieste HTTPe il traffico KVM allo switch

5 L'utente accede all'indirizzo IP esterno del firewall

Per configurare il firewall:

Per accedere allo switch dall'esterno di un firewall è necessario configurare il
firewall in modo che inoltri le porte 80, 23 (se Telnet è attivato), 80, 443 e 2068
dall'interfaccia esterna allo switch KVM attraverso l'interfaccia interna del firewall.
Per istruzioni dettagliate sull'inoltro di porte consultare il manuale del firewall in
uso.

Per informazioni sull'avvio dell'interfaccia OBWI fare riferimento a "Interfaccia
OBWI" a pagina 22.

2.6 Verifica dei collegamenti

LED di connessione tramite la porta Ethernet sul pannello posteriore

Sul pannello posteriore degli switch KVM s4 sono presenti due LED che indicano
lo stato della connessione Ethernet LAN1 e due LED che indicano lo stato della
connessione Ethernet LAN2.

• I LED verdi si illuminato quando viene stabilita una connessione valida alla
rete e lampeggiano quando viene rilevato il passaggio di dati attraverso la
porta.

• I LED a doppio colore possono illuminarsi in verde o in giallo.

• Si illuminano in verde quando la velocità di comunicazione è 1000 M.

• Si illuminano in giallo quando la velocità di comunicazione è 100 M.

• Non si illuminano quando la velocità di comunicazione è 10 M.

LED di stato dell'alimentazione sul pannello posteriore

Sul pannello posteriore di ciascun accessorio sono presenti due LED di stato
dell'alimentazione, uno per ciascun alimentatore. I LED si illuminano in verde
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quando lo switch è acceso e funziona regolarmente.

• Il LED è spento se l'alimentatore non riceve corrente o non funziona.

• Il LED si illumina quando l'unità è pronta.

• Il LED lampeggia quando lo switch è in fase di avvio o è in corso un
aggiornamento.

• Il LED lampeggia componendo la parola "SOS" se si verifica una condizione
di errore, per esempio in caso di interruzione dell'alimentazione,
temperatura ambiente elevata o guasto della ventola. Il LED continua a
lampeggiare in questa modalità finché la condizione di errore non viene
risolta.

Lo switch impedisce che la connessione seriale al dispositivo collegato si
interrompa se l'alimentazione al modulo si interrompe. È tuttavia possibile
generare un'interruzione della connessione seriale al dispositivo collegato
premendo Interruzione seriale nel Visualizzatore sessioni seriali.

2.7 Regolazione delle impostazioni del mouse sui
dispositivi di destinazione
Per utilizzare un computer collegato allo switch per il controllo da parte di utenti
remoti, è necessario regolare la velocità del mouse per il dispositivo di
destinazione e disattivare l'accelerazione. Sulle macchine su cui è in esecuzione
Microsoft®Windows® (Windows XP, Windows Vista, Windows 2003, Windows
2008 e Windows 7), utilizzare il driver per mouse PS/2 predefinito.

Affinché il movimento del mouse locale e la visualizzazione del cursore remoto
siano sincronizzati, l'accelerazione del mouse deve essere impostata su
"nessuna" per tutti gli account utente utilizzati per l'accesso a un sistema remoto
tramite uno switch KVM. L'accelerazione del mouse deve essere impostata su
"nessuna" anche su ciascun sistema remoto. Non è possibile utilizzare cursori
speciali e anche le opzioni di visualizzazione del cursore come tracce del
puntatore, animazioni della posizione del cursore per il tasto Ctrl, effetti di
ombreggiatura e la funzione per nascondere il cursore durante la digitazione
devono essere disattivate.
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2.7 Regolazione delle impostazioni del mouse sui dispositivi di

Se non è possibile disattivare l'accelerazione delmouse dal sistema operativoWindows,
o per evitare di regolare le impostazioni di tutti i dispositivi di destinazione in uso,
utilizzare il comandoStrumenti >Modalità cursore unico della finestra Visualizzatore
video per impostare la finestra su unamodalità di "mouse invisibile". Talemodalità
consente di passaremanualmente dal puntatore delmouse del sistema di destinazione
visualizzato al puntatore delmouse del computer client e viceversa.
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3. Configurazione locale e remota

3.1 Interfacce utente
Lo switch KVM s4 mette a disposizione due interfacce gestibili tramite mouse:
un'interfaccia utente locale e un'interfaccia Web integrata (OBWI) remota. Le
opzioni di configurazione delle interfacce consentono di impostare lo switch in
base alla specifica applicazione in uso, controllare tutti i dispositivi collegati e
gestire tutte le esigenze di base di switch KVM o seriali.

L'interfaccia utente locale e l'interfaccia OBWI remota sono quasi identiche e, salvo
diversa indicazione, tutte le informazioni del presente capitolo sono valide per entrambe
le interfacce.

Entrambe le interfacce consentono di avviare due diversi tipi di sessione:

• La finestra Visualizzatore video consente di controllare in tempo reale le
funzioni di tastiera, monitor e mouse dei singoli dispositivi di destinazione
collegati allo switch. Inoltre è possibile utilizzare macro globali predefinite
per eseguire operazioni nella finestra Visualizzatore video. Per istruzioni
sull'uso del Visualizzatore video fare riferimento al capitolo 4.

• La finestra del Visualizzatore seriale consente di gestire singoli dispositivi di
destinazione utilizzando comandi o script.

Interfaccia utente locale

Lo switch è dotato di una porta locale sul pannello posteriore che consente di
collegare una tastiera, un monitor e un mouse direttamente allo switch per
utilizzare l'interfaccia utente locale.

Per visualizzare l'interfaccia utente locale o per passare dall'interfaccia utente
locale a una sessione attiva e viceversa possono essere impostate le seguenti
sequenze di tasti: Stamp, Ctrl + Ctrl, Maiusc + Maiusc e Alt + Alt.

Per avviare l'interfaccia utente locale:

1. Collegare i cavi di monitor, tastiera e mouse allo switch. Per ulteriori
informazioni fare riferimento a "Collegamento dei componenti hardware
dello switch" a pagina 11.

2. Premere una delle sequenze di tasti per avviare l'interfaccia utente locale.
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3. Se è stata attivata l'autenticazione dell'interfaccia utente locale, immettere il
nome utente e la password.

Se lo switch è stato aggiunto a un server DSView 3, l'autenticazione dell'utente verrà
eseguita tramite il server DSView 3; se lo switch non è stato aggiunto a un server
DSView 3, o se non è possibile stabilire una connessione con tale server,
l'autenticazione dell'utente verrà eseguita tramite il database utenti locale. Il nome
utente predefinito è Admin e non è richiesta alcuna password; per i nomi utente nel
database utenti locale è necessario distinguere tra letteremaiuscole eminuscole.

Interfaccia OBWI

L'interfaccia OBWI dello switch è un'interfaccia utente basata su browser. Per
informazioni specifiche sull'impostazione del sistema fare riferimento a
"Collegamento dei componenti hardware dello switch" a pagina 11. Nella
seguente tabella sono elencati i sistemi operativi e i browser supportati
dall'interfaccia OBWI. Verificare che la versione del browser in uso sia la più
recente.

Tabella 3.1. Sistemi operativi e browser supportati dall'interfaccia OBWI

Sistema operativo

Browser

Microsoft® Internet
Explorer versione
6.0 SP1 e
successive

Firefox versione 3.0 e successive

MicrosoftWindows
Server® 2003
Standard, Enterprise e
Web Edition

Sì Sì

MicrosoftWindows
Server® 2008
Standard, Enterprise e
Web Edition

Sì Sì

WindowsXP
Professional con
Service Pack3

Sì Sì
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Sistema operativo

Browser

Microsoft® Internet
Explorer versione
6.0 SP1 e
successive

Firefox versione 3.0 e successive

WindowsVista®

Business con Service
Pack1

Sì Sì

Windows7 Sì Sì

Red Hat Enterprise
Linux® 4 e 5 Standard,
Enterprise oWeb
Edition

No Sì

Sun Solaris 10 e 11 No Sì

Solaris 10 x86 No Sì

Ubuntu 8Workstation No Sì

Per accedere all'interfaccia OBWI dello switch:

1. Avviare il browser.

2. Nel campo dell'indirizzo del browser immettere l'indirizzo IP o il nome host
assegnato allo switch a cui è necessario accedere. Utilizzare il formato
https://xxx.xx.xx.xx o https://nomehost.

Se si utilizza la modalità IPv6, l'indirizzo IP deve essere racchiuso tra parentesi quadre.
Utilizzare il formato https://[<indirizzoIP>].

3. Una volta stabilita la connessione tra il browser e lo switch, immettere il
proprio nome utente e password e fare clic su Accedi per visualizzare
l'interfaccia OBWI dello switch.

Il nome utente predefinito è admin con password admin.

Per accedere all'interfaccia OBWI dello switch dall'esterno di un firewall, ripetere
la procedura descritta sopra usando l'indirizzo IP esterno del firewall.
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Utilizzo delle interfacce utente

Dopo avere eseguito l'autenticazione viene visualizzata l'interfaccia utente, che
consente di visualizzare, accedere e gestire lo switch, nonché di specificare le
impostazioni di sistema e modificare le impostazioni del profilo. Nella Figura 3.1
sono illustrate le aree della finestra dell'interfaccia utente dello switch; per le
descrizioni fare riferimento alla tabella che segue.

Figura 3.1. Finestra dell'interfaccia utente

Numero Descrizione

1

Barra opzioni in alto: consente di impostare un segnalibro per una
finestra dell'interfaccia, aggiornare le informazioni visualizzate in una
finestra dell'interfaccia, stampare una paginaWeb, uscire da una
sessioneOBWI e accedere alla guida in linea. A sinistra della barra
opzioni è visualizzato il nome dell'utente che ha eseguito la procedura di
accesso.

2

Barra di navigazione laterale: consente di selezionare e visualizzare le
informazioni di sistema nella finestra di contenuto. Nell'angolo superiore
sinistro della barra di navigazione laterale sono presenti icone che
consentono di espandere o comprimere tutti i nodi.

3 Finestra di contenuto: consente di visualizzare omodificare il sistema
OBWI dello switch.

Tabella 3.2. Descrizioni dell'interfaccia utente
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Utilizzo della barra di navigazione laterale

La barra di navigazione laterale consente di visualizzare finestre in cui è
possibile specificare impostazioni o eseguire operazioni. Facendo clic su un
collegamento che non contiene una freccia viene visualizzata la corrispondente
finestra.

Utilizzo della barra opzioni in alto

Se l'autenticazione è disattivata, nell'interfaccia utente locale sarà visualizzato solo il
pulsante Aggiorna. Se l'autenticazione è attivata, nell'interfaccia utente locale saranno
visualizzati solo i pulsanti Aggiorna e Disconnetti; nell'interfaccia OBWI remota saranno
visualizzati tutti i pulsanti.

Creazione di un segnalibro a una finestra (solo Microsoft Internet Explorer)

Nell'interfaccia utente è presente un'icona di segnalibro e un pulsante in formato
testo nella barra opzioni in alto. È possibile creare un segnalibro per una finestra
e aggiungere un collegamento a tale finestra nel menu a discesa dei preferiti. Il
collegamento consente di accedere con rapidità e in qualsiasi momento alla
finestra associata.

Se per una finestra è stato creato un segnalibro e le informazioni relative alla
finestra vengono modificate, le nuove informazioni saranno visualizzate nella
finestra associata al segnalibro la prossima volta che viene visualizzata.

Facendo clic su SEGNALIBRO o sull'icona di segnalibro dopo che la sessione
OBWI dello switch è scaduta, sarà visualizzata la finestra la finestra Accesso
utente e sarà necessario eseguire nuovamente la procedura di accesso.

Per creare un segnalibro per una finestra:

1. Nella barra opzioni in alto fare clic su SEGNALIBRO o sull'icona di
segnalibro per visualizzare la finestra di dialogo Aggiungi a preferiti.

2. È possibile immettere un nome per la finestra, nonché fare clic sul pulsante
Crea in per creare o specificare una cartella per la finestra.

3. Fare clic su OK per chiudere la finestra di dialogo.

Stampa di una finestra

In tutte le finestre dell'interfaccia OBWI dello switch è presente un'icona di stampa
nella barra opzioni in alto.
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Per stampare una finestra dell'interfaccia OBWI dello switch:

1. Nella barra opzioni in alto fare clic su STAMPA o sull'icona di stampa per
visualizzare la finestra di dialogo Stampa.

2. Specificare le opzioni per la stampa della finestra dell'interfaccia OBWI dello
switch.

3. Fare clic su Stampa per stampare la finestra dell'interfaccia OBWI dello
switch e chiudere la finestra di dialogo Stampa.

Aggiornamento di una finestra

È possibile aggiornare l'interfaccia utente dello switch in qualsiasi momento
facendo clic su AGGIORNA o sull'icona di aggiornamento nella barra opzioni in
alto.

Disconnessione

Per uscire in qualsiasi momento, fare clic sull'icona di chiusura della sessione
nella barra opzioni in alto.

3.2 Visualizzazione delle informazioni di sistema
È possibile visualizzare varie informazioni relative all'accessorio e ai dispositivi
di destinazione in più finestre diverse dell'interfaccia utente.

Tabella 3.3. Informazioni di sistema

Categoria Scegliere: Per visualizzare:

Switch
Vista unità >
Accessorio >
Panoramica

Nome e tipo di switch e strumenti per
l'accessorio

Vista unità >
Accessorio >
Proprietà >
Identità

Versione del firmware corrente di applicazione
e boot

Vista unità >
Accessorio >
Proprietà >
Posizione

Località, reparto o posizione
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Categoria Scegliere: Per visualizzare:

Vista unità >
Accessorio >
Impostazioni
accessorio >
Versioni

Versione del firmware corrente di applicazione,
boot e Video FPGA

Vista unità >
Connessioni

Elenco di dispositivi collegati

Dispositivo di
destinazione

Vista unità >
Dispositivi di
destinazione

Elenco di dispositivi di destinazione collegati
nonché le seguenti informazioni su ciascun
dispositivo: nome, tipo, stato e azione

Fare clic su uno dei dispositivi di destinazione
per visualizzare le seguenti informazioni
aggiuntive: nome, tipo, eID, opzione di sessione
disponibile e percorso di connessione

Saranno notificate le seguenti condizioni di errore, qualora si verifichino: errore
dell'alimentatore, temperatura ambiente elevata o guasto della ventola.
Nell'intestazione di ciascuna finestra saranno visualizzati un triangolo giallo con
un punto esclamativo e il nome dell'errore rilevato. La notifica sarà visualizzata o
scomparirà solo dopo che la pagina viene aggiornata. Facendo clic sulla notifica
saranno visualizzate ulteriori informazioni.

3.3 Sessioni dello switch KVM s4
La finestra Sessioni attive consente di visualizzare un elenco delle sessioni attive
e le seguenti informazioni su ciascuna sessione: dispositivo di destinazione,
proprietario, host remoto, durata e tipo.

Avvio di una sessione
Per avviare una sessione è richiesto Java 1.6.0_11 o successivo.

Per avviare una sessione:

1. Nella barra di navigazione laterale scegliere Vista unità > Dispositivi di
destinazione per visualizzare un elenco dei dispositivi disponibili.

590-1058-640A 27



3. Configurazione locale e remota

2. Fare clic sul collegamento Sessione KVM o Sessione seriale a destra del
dispositivo di destinazione di interesse per avviare la sessione.

Se il dispositivo di destinazione è già in uso e l'utente che tenta di accedervi
dispone di un livello di priorità pari o superiore a quello dell'utente corrente, il
nuovo utente avrà la possibilità di imporre la propria connessione al dispositivo.

Per commutare alla sessione attiva dall'interfaccia utente locale (solo utenti
locali):

1. Nella barra di navigazione laterale scegliere Sessione locale.

2. Selezionare la casella di controllo Riprendi sessione attiva. Verrà
visualizzata la finestra Visualizzatore video.

- oppure -

Premere Esc.

Configurazione delle sessioni

Per configurare le impostazioni generali delle sessioni:

1. Nella barra di navigazione laterale scegliere Vista unità > Accessorio >
Impostazioni accessorio > Sessioni > Generale per visualizzare la finestra
Impostazioni generali sessione accessorio.

2. Selezionare o deselezionare la casella di controllo Attiva timeout inattività.

3. Nel campo Timeout inattività immettere la durata del periodo di inattività
richiesto per la chiusura della sessione (da 1 a 90 minuti).

4. Nel campo Timeout accessi immettere la durata del periodo di inattività
richiesto prima che sia necessario eseguire nuovamente la procedura di
accesso (da 21 a 120 secondi).

5. Selezionare o deselezionare la casella di controllo Attiva timeout diritti di
priorità.

6. Nel campo Timeout diritti di priorità immettere la durata della visualizzazione
(da 1 a 120 secondi) del messaggio che informa che la sessione sta per
essere interrotta per diritti di priorità.

7. Fare clic su Salva.

Per configurare le impostazioni delle sessioni KVM:

1. Nella barra di navigazione laterale scegliere Vista unità > Accessorio >
Impostazioni accessorio > Sessioni > KVM per visualizzare la finestra
Impostazioni sessione KVM accessorio.
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2. Selezionare un livello di crittografia per i segnali della tastiera e del mouse
(SSL 128 bit, DES, 3DES o AES) e per i segnali video (SSL 128 bit, DES,
3DES, AES o Nessuno).

3. Selezionare una lingua nel menu a discesa Tastiera.

4. Fare clic su Salva.

Per configurare le impostazioni delle sessioni seriali:

1. Nella barra di navigazione laterale scegliere Vista unità > Accessorio >
Impostazioni accessorio > Impostazioni > Seriale per visualizzare la finestra
Impostazioni sessione seriale accessorio.

2. Selezionare o deselezionare la casella di controllo Accesso Telnet attivato.

3. Fare clic su Salva.

Chiusura di una sessione

Per chiudere una sessione:

1. Nella barra di navigazione laterale scegliere Sessioni attive per visualizzare
la schermata delle sessioni dell'accessorio.

2. Selezionare la casella di controllo a fianco del dispositivo o dei dispositivi di
destinazione di interesse.

3. Fare clic su Disconnetti.

Se è in corso una sessione di supporto virtuale bloccata, sarà interrotta.

Per chiudere una sessione (solo utenti locali):

1. Nella barra di navigazione laterale scegliere Sessione locale.

2. Selezionare la casella di controllo Disconnetti sessione attiva.

3.4 Strumenti per gli switch KVM s4
La finestra Panoramica unità consente di visualizzare il nome e il tipo degli
accessori e di eseguire operazioni di base sugli accessori.

Riavvio dello switch

Per riavviare lo switch:

1. Nella barra di navigazione laterale scegliere Vista unità > Accessorio >
Panoramica per visualizzare la finestra Panoramica unità.

2. Fare clic su Riavvia.
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3. Viene visualizzata una finestra di dialogo con l'avvertenza che tutte le
sessioni attive saranno interrotte. Fare clic su OK.

Se si utilizza l'interfaccia utente locale, durante il riavvio dello switch la schermata sarà
vuota; se si utilizza l'interfaccia OBWI remota, viene visualizzato unmessaggio per
informare che l'interfaccia è in attesa del completamento del riavvio dell'accessorio.

Aggiornamento del firmware dello switch

Il firmware dello switch può essere aggiornato con la versione più recente
disponibile.

Una volta che la memoria Flash è stata riprogrammata con l'aggiornamento, lo
switch esegue un ripristino soft che interrompe tutte le sessioni dei cavi
adattatore. È possibile che un dispositivo di destinazione sottoposto
all'aggiornamento del firmware del cavo adattatore non sia visualizzato o risulti
disconnesso; una volta completato l'aggiornamento Flash, il dispositivo di
destinazione sarà visualizzato normalmente.

AVVERTENZA: se durante un aggiornamento del firmware un cavo adattatore viene
scollegato o il dispositivo di destinazione viene spento e riacceso, ilmodulo diventerà
inutilizzabile e sarà necessario restituire il cavo adattatore al produttore per la
riparazione.

Per aggiornare il firmware dello switch:

1. Nella barra di navigazione laterale scegliere Vista unità > Accessorio >
Panoramica per visualizzare la finestra Panoramica unità.

2. Fare clic su Aggiorna firmware per visualizzare Aggiorna firmware
accessorio.

3. Selezionare una delle seguenti opzioni da cui caricare il file di firmware: File
System, TFTP, FTP o HTTP.

L'opzione File System è disponibile solo nell'interfaccia OBWI remota.

4. Se è stato selezionato File System, fare clic su Sfoglia per specificare la
posizione del file di aggiornamento del firmware.

- oppure -

Se è stato selezionato TFTP, immettere l'indirizzo IP del server e il nome
del file di firmware da caricare.

- oppure -
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Se è stato selezionato FTP o HTTP, immettere l'indirizzo IP del server e
il nome del file di firmware da caricare, il nome utente e la password
utente.

5. Fare clic su Aggiorna.

Salvataggio e ripristino delle configurazioni degli switch e dei
database utenti

La configurazione dello switch può essere salvata in un file (file di
configurazione) che conterrà le informazioni sull'accessorio da gestire. Anche il
database utenti locale dello switch può essere salvato. Dopo avere salvato tali
file, sarà possibile ripristinare sullo switch un file di configurazione o un file di
database utenti locale salvato in precedenza.

Per salvare una configurazione o un database utenti di un accessorio da
gestire:

1. Nella barra di navigazione laterale scegliere Vista unità > Accessorio >
Panoramica per visualizzare la finestra Panoramica unità.

2. Fare clic su Salva configurazione accessorio o Salva database utenti
accessorio per visualizzare la finestra di dialogo per il download del file.

3. Fare clic su Salva. Verrà visualizzata la finestra di dialogo Salva con nome.

4. Accedere alla posizione di interesse e immettere un nome per il file. Fare clic
su Salva.

5. Fare clic su Chiudi.

Per ripristinare una configurazione o un database utenti di un accessorio da
gestire:

1. Nella barra di navigazione laterale scegliere Vista unità > Accessorio >
Panoramica per visualizzare la finestra Panoramica unità.

2. Fare clic su Ripristina configurazione accessorio o Ripristina database utenti
accessorio per visualizzare la finestra Ripristina configurazione accessorio o
Ripristina database utenti accessorio.

3. Fare clic su Sfoglia. Accedere alla posizione di interesse e selezionare il
nome del file. Fare clic su Carica.

4. Quando viene visualizzata la schermata di completamento fare clic su
Chiudi. Riavviare l'accessorio da gestire per attivare la configurazione
ripristinata. Fare riferimento a "Strumenti per gli switch KVM s4" a pagina 29.
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3.5 Impostazioni di rete
Solo gli amministratori di switch possono eseguiremodifiche alle impostazioni della
finestra di dialogo Rete; gli altri utenti dispongono dell'accesso in sola lettura.

Per configurare le impostazioni di rete generali:

1. Nella barra di navigazione laterale scegliere Vista unità > Accessorio >
Impostazioni accessorio > Rete > Generale per visualizzare la finestra
Impostazioni generali di rete accessorio.

2. Scegliere una delle seguenti opzioni nel menu a discesa Velocità LAN:
Rilevazione automatica, Half duplex 10 Mbps, Full duplex 10 Mbps, Half
duplex 100 Mbps, Full duplex 100 Mbps o Full duplex 1 Gbps.

Se vienemodificata la modalità Ethernet è necessario riavviare.

3. Scegliere Attivo o Non attivo nel menu a discesa Risposta ping ICMP.

4. Fare clic su Salva.

Per configurare le impostazioni di rete IPv4:

1. Nella barra di navigazione laterale scegliere Vista unità > Accessorio >
Impostazioni accessorio > Rete > IPv4 per visualizzare la finestra
Impostazioni IPv4 dello switch.

2. Selezionare o deselezionare la casella di controllo Attiva IPv4 per attivare o
disattivare la modalità IPv4.

3. Immettere le informazioni di interesse nei campi Indirizzo, Subnet e
Gateway.

4. Scegliere Attivo o Non attivo nel menu a discesa DHCP.

Se viene attivato il protocollo DHCP, tutte le informazioni immesse nei campi Indirizzo,
Subnet e Gatewaysaranno ignorate.

5. Fare clic su Salva.

Per configurare le impostazioni di rete IPv6:

1. Nella barra di navigazione laterale scegliere Vista unità > Accessorio >
Impostazioni accessorio > Rete > IPv6 per visualizzare la finestra
Impostazioni IPv6 dello switch.
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2. Selezionare o deselezionare la casella di controllo Attiva configurazione con
stato IPv6 per attivare o disattivare il protocollo.

3. Immettere le informazioni di interesse nei campi Indirizzo, Gateway e
Lunghezza prefisso.

4. Scegliere Attivo o Non attivo nel menu a discesa DHCPv6.

Se viene attivato il protocollo DHCPv6, tutte le informazioni immesse nei campi
Indirizzo, Gatewaye Lunghezza prefisso saranno ignorate.

5. Fare clic su Salva.

3.6 Impostazioni DNS
È possibile assegnare il server DNS manualmente o utilizzare gli indirizzi ottenuti
tramite DHCP o DHCPv6.

Per configurare le impostazioni DNS manualmente:

1. Nella barra di navigazione laterale scegliere Vista unità > Accessorio >
Impostazioni accessorio > DNS per visualizzare la finestra Impostazioni DNS
accessorio.

2. Selezionare Manuale, DHCP (se è attivato il protocollo IPv4) o DHCPv6 (se
è attivato il protocollo IPv6).

3. Se viene selezionato Manuale, immettere i dati del server DNS nei campi
Primario, Secondario e Terziario.

4. Fare clic su Salva.

3.7 Impostazioni dell'interfaccia utente locale
Per modificare la modalità di richiamo dell'interfaccia utente locale:

1. Nella barra di navigazione laterale scegliere Vista unità > Accessorio >
Impostazioni accessorio > Porte > Interfaccia utente porta locale per
visualizzare la finestra Impostazioni interfaccia utente porta locale.

2. Nella sezione Apri interfaccia utente porta locale selezionare la casella di
controllo a fianco di uno o più metodi elencati.

3. Fare clic su OK.
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Impostazioni dell'utente della porta locale

È possibile attivare o disattivare l'autenticazione dell'interfaccia utente della porta
locale e scegliere un livello di accesso dell'utente. Se l'autenticazione
dell'interfaccia utente della porta locale è attiva, per utilizzare l'interfaccia è
necessario eseguire la procedura di accesso.

Possono inoltre essere eseguite le selezioni per la lingua della tastiera per la
porta locale, la durata della modalità di scansione, l'attivazione/disattivazione
della password per la porta di impostazione e il livello di priorità dell'utente. Il
livello di priorità degli utenti determina la possibilità di interrompere la sessione
seriale o KVM su un dispositivo di destinazione di un altro utente. Il livelli di
priorità sono compresi tra 1 e 4 (il livello 4 è il più elevato). Per esempio, un
utente con livello di priorità 4 può esercitare diritti di priorità su altri utenti di livello
4, nonché su utenti di livello 1, 2 e 3.

Per modificare il livello di priorità predefinito (solo amministratore):

1. Nella barra di navigazione laterale scegliere Vista unità > Accessorio >
Impostazioni accessorio > Porte > Interfaccia utente porta locale per
visualizzare la finestra Impostazioni interfaccia utente porta locale.

2. Selezionare o deselezionare la casella di controllo Disattiva autenticazione
utente porta locale.

3. Selezionare una delle seguenti opzioni nel menu a discesa Livello accesso
utente: Utente, Amministratore utenti o Amministratore accessorio.

4. Selezionare un numero da 1 a 4 nel menu a discesa Livello priorità utente.

5. Fare clic su Salva.

3.8 Supporto virtuale
Le opzioni disponibili nella finestra Impostazioni sessione supporto virtuale
accessorio consentono di determinare il comportamento dello switch durante
una sessione di supporto virtuale. Nella tabella 3.4.sono riepilogate le opzioni
che possono essere impostate per le sessioni di supporto virtuale. Per
informazioni sull'utilizzo di supporti virtuali in una sessione KVM fare riferimento
a "Supporto virtuale" a pagina 66.
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Impostazione Descrizione

Impostazioni sessione:
Supporto virtuale
bloccato su sessioni
KVM

L'impostazione del blocco consente di specificare se una
sessione di supporto virtuale è associata alla sessione KVM sul
dispositivo di destinazione. Se il blocco è attivo (impostazione
predefinita) e la sessione KVM viene chiusa, anche la sessione di
supporto virtuale verrà chiusa. Se il blocco è stato disattivato e la
sessione KVM viene chiusa, la sessione di supporto virtuale
rimarrà attiva.

Impostazioni sessione:
Consenti sessioni
riservate

Consente di limitare l'accesso a una connessione a un supporto
virtuale solo al nome utente corrente e di impedire ad altri utenti
di stabilire una connessione con il dispositivo di destinazione
interessato. Quando la sessione KVM associata viene chiusa, la
sessione di supporto virtuale può essere interrotta in base
all'impostazione Bloccata della finestra di dialogo Supporto
virtuale.

Mappatura unità:
Modalità accesso
supporto virtuale

Lamodalità di accesso alle unità mappate può essere impostata
su sola lettura o lettura-scrittura. Se lamodalità di accesso è di
sola lettura, non sarà possibile scrivere dati sull'unità mappata
sul server client. Se lamodalità di accesso è impostata su lettura-
scrittura, sarà possibile scrivere e leggere dati sull'unità
mappata. Se l'unità mappata è di tipo sola lettura (per esempio
un'unità CD-ROM, un'unità DVD o immagini ISO), la modalità di
accesso in lettura-scrittura sarà ignorata. L'impostazione della
modalità sola lettura può essere utile quando vienemappata
un'unità di scrittura e lettura (per esempio un dispositivo di
archiviazione dimassa oppure un supporto USB rimovibile) e si
desidera impedire all'utente di scrivere dati su tale unità.

Possono esseremappati contemporaneamente un'unità DVD e
un dispositivo di archiviazione dimassa. Un'unità CD, DVD o un
file di immagine disco ISOvengonomappati come unità
CD/DVD virtuale.

Livello crittografia
Per le sessioni di supporto virtuale è possibile configurare i livelli
di crittografia. Le opzioni disponibili sono: Nessuno (predefinito),
SSL a 128 (ARCFOUR), DES, 3DESe AES.

Tabella 3.4. Impostazioni delle sessioni di supporto virtuale
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Impostazione Descrizione

Accesso supporto
virtuale a ciascun cavo
adattatore: Attiva
supporto
virtuale/Disattiva
supporto virtuale

Nella sezione Accesso supporto virtuale a ciascun cavo
adattatore sono elencati tutti i cavi adattatore KVM s4 USB20-
VGA. L'elenco comprende informazioni dettagliate su ciascun
cavo e un'opzione per attivare o disattivare il supporto virtuale
per ciascun cavo.

Per impostare le opzioni di supporto virtuale:

1. Nella barra di navigazione laterale scegliere Vista unità > Accessorio >
Impostazioni accessorio > Sessioni > Supporto virtuale per visualizzare la
finestra Impostazioni sessione supporto virtuale accessorio.

2. Selezionare o deselezionare la casella di controllo Supporto virtuale
bloccato su sessioni KVM.

3. Selezionare o deselezionare la casella di controllo Consenti sessioni
riservate.

4. Scegliere una delle seguenti opzioni nel menu a discesa Modalità accesso
supporto virtuale: Sola lettura o Lettura-Scrittura.

5. Selezionare il livello di crittografia che sarà supportato.

6. Selezionare la casella di controllo a fianco di ciascun cavo adattatore KVM
 s4 USB20-VGA per il quale si desidera attivare il supporto virtuale e fare clic
su Attiva supporto virtuale.

- oppure -

Selezionare la casella di controllo a fianco di ciascun cavo adattatore
KVM s4 USB20-VGA per il quale si desidera disattivare il supporto
virtuale e fare clic su Disattiva supporto virtuale.

7. Fare clic su Salva.

Impostazioni di supporto virtuale locali

Gli utenti locali possono determinare il comportamento di supporti virtuali nella
finestra Sessione locale. Oltre a connettere e disconnettere una sessione di
supporto virtuale, è possibile configurare le impostazioni elencate nella tabella
che segue.

Tabella 3.5. Impostazioni locali di sessioni di supporto virtuale
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Impostazione Descrizione

CD ROM/

DVD ROM

Consente di avviare sessioni di supporto virtuale con le prime unità
CD-ROMoDVD-ROM (sola lettura) rilevate. Selezionare la casella
di controllo per stabilire una connessione del supporto virtuale CD-
ROMoDVD-ROM con un dispositivo di destinazione;
deselezionarla per terminare la connessione del supporto virtuale
CD-ROMoDVD-ROM con un dispositivo di destinazione.

Memoria dimassa

Consente di avviare sessioni di supporto virtuale con la prima unità
dimemoria dimassa rilevata. Selezionare la casella di controllo per
stabilire la connessione di un supporto virtuale di archiviazione di
massa con un dispositivo di destinazione; deselezionarla per
terminare la connessione di un supporto virtuale di archiviazione di
massa con un dispositivo di destinazione.

Riservata

Consente di limitare l'accesso a una connessione a un supporto
virtuale solo al nome utente corrente e di impedire ad altri utenti di
stabilire una connessione con il dispositivo di destinazione
interessato.

Per configurare le impostazioni di supporto virtuale locali:

1. Nella barra di navigazione laterale scegliere Sessione locale.

2. Selezionare per attivare o deselezionare per disattivare le opzioni della
sessione di supporto virtuale.

3.9 Impostazioni del modem
La finestra Impostazioni modem accessorio consente di configurare varie
impostazioni del modem, nonché di visualizzare le seguenti impostazioni del
modem: Indirizzo locale, Indirizzo remoto, Subnet mask e Gateway.

Per informazioni sul collegamento dello switch a un modem fare riferimento a
"Collegamento dei componenti hardware dello switch" a pagina 11.

Per configurare le impostazioni del modem:

1. Nella barra di navigazione laterale scegliere Vista unità > Accessorio >
Impostazioni accessorio > Porte > Modem per visualizzare la finestra
Impostazioni modem accessorio.

2. Selezionare o deselezionare la casella di controllo Sessioni modem
possono interrompere sessioni digitali per diritti di priorità.
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3. Impostare Timeout autenticazione su un valore compreso fra 30 e 300
secondi e Timeout inattività su un valore compreso fra 1 e 60 minuti.

4. Fare clic su Salva.

3.10 Modalità di scansione
In modalità di scansione lo switch esegue una scansione automatica di tutte le
porte, ossia di tutti i dispositivi di destinazione. È possibile eseguire la scansione
di più dispositivi di destinazione specificando quali dispositivi includere nella
scansione. L'ordine di scansione è determinato dalla posizione del dispositivo di
destinazione nell'elenco. Inoltre è possibile configurare il periodo di tempo che
deve trascorrere prima che la scansione passi al dispositivo di destinazione
successivo nella sequenza.

Il pulsante Scansione non è attivo se la connessione è stata stabilita tramitemodem.

Per aggiungere dispositivi di destinazione all'elenco di scansione:

1. Nella barra di navigazione laterale scegliere Vista unità > Dispositivi di
destinazione per visualizzare la finestra Dispositivi di destinazione.

2. Selezionare la casella di controllo a fianco del nome dei dispositivi di
destinazione da includere nella scansione.

3. Fare clic su Scansione.

Per configurare la durata della scansione:

1. Nella barra di navigazione laterale scegliere Vista unità > Accessorio >
Impostazioni accessorio > Porte > Interfaccia utente porta locale per
visualizzare la finestra Impostazioni interfaccia utente porta locale.

2. Nella sezione Modalità scansione immettere la durata in secondi (da 3 a
255) nel campo Durata scansione.

3. Fare clic su Salva.

3.11 Indirizzi IP di dispositivi DSView 3
Uno switch non gestito può essere contattato e registrato tramite un server
DSView 3 specificando gli indirizzi IP di un massimo di quattro server DSView 3.

Per configurare l'indirizzo IP di server DSView 3:

1. Nella barra di navigazione laterale scegliere Vista unità > Accessorio >
Impostazioni accessorio > Account utente > DSView 3 per visualizzare la
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schermata delle impostazioni di DSView 3.

2. Immettere nei campi Server 1-4 fino a quattro indirizzi IP di server del
software DSView 3 da contattare.

3. Fare clic su Salva.

3.12 Account utente

Gestione di account locali

L'interfaccia OBWI dello switch consente di impostare funzioni di protezione a
livello locale e di accesso tramite account utente definiti dagli amministratori. La
voce Account locale della barra di navigazione laterale consente agli
amministratori di aggiungere ed eliminare utenti, di definire i diritti di priorità e il
livello di accesso di ciascun utente e di modificare le password.

Livelli di accesso

Quando viene aggiunto un account utente, l'utente può essere assegnato a uno
qualsiasi dei seguenti livelli di accesso: Amministratore accessorio,
Amministratore utenti e Utenti.

Livello di accesso

Operazione Amministratore
accessorio

Amministratore
utenti Utenti

Configurazione
delle impostazioni a
livello di sistema
dell'interfaccia

Sì No No

Configurazione dei
diritti di accesso

Sì Sì No

Aggiunta, modifica
ed eliminazione di
account utente

Sì, per tutti i
livelli di accesso

Sì, solo per
utenti e
amministratori
di utenti

No

Modifica della
propria password

Sì Sì Sì

Tabella 3.6. Operazioni consentite in base al livello di accesso
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Livello di accesso

Operazione Amministratore
accessorio

Amministratore
utenti Utenti

Accesso a
dispositivi di
destinazione

Sì, a tutti i
dispositivi di
destinazione

Sì, a tutti i
dispositivi di
destinazione

Sì, se specificamente
autorizzato

Per aggiungere un nuovo account utente (solo amministratore):

1. Nella barra di navigazione laterale scegliere Vista unità > Accessorio >
Impostazioni accessorio > Account utente > Account locale per visualizzare
la finestra Account utente locali accessorio.

2. Fare clic sul pulsante Aggiungi.

3. Immettere il nome e la password del nuovo utente negli spazi disponibili.

4. Selezionare i livelli di priorità e accesso per il nuovo utente.

5. Selezionare i dispositivi di destinazione disponibili da assegnare all'account
utente e fare clic su Aggiungi.

Gli amministratori di utenti e gli amministratori di accessorio possono accedere a tutti i
dispositivi di destinazione.

6. Fare clic su Salva.

Per eliminare un account utente (solo amministratore):

1. Nella barra di navigazione laterale scegliere Vista unità > Accessorio >
Impostazioni accessorio > Account utente > Account locale per visualizzare
la finestra Account utente locali accessorio.

2. Selezionare la casella di controllo a sinistra di ciascun account da eliminare
e fare clic su Elimina.

Per modificare un account utente (solo amministratore o utente attivo):

1. Nella barra di navigazione laterale scegliere Vista unità > Accessorio >
Impostazioni accessorio > Account utente > Account locale per visualizzare
la finestra Account utente locali accessorio.

2. Selezionare il nome dell'utente da modificare per visualizzare il profilo
dell'utente.
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3. Immettere le informazioni relative all'utente nella finestra, quindi fare clic su
Salva.

3.13 Impostazioni SNMP
Il protocollo SNMP è utilizzato per la comunicazione di informazioni di gestione
tra le applicazioni di gestione della rete e lo switch. Altri manager SNMP possono
comunicare con lo switch tramite l'accesso a MIB-II e alla sezione pubblica delle
informazioni MIB dell'organizzazione. Quando viene visualizzata la finestra
SNMP, l'interfaccia OBWI recupera i parametri SNMP dall'unità.

La finestra SNMP consente di immettere informazioni di sistema e stringhe di
comunità, nonché di stabilire quali stazioni di lavoro gestiranno lo switch
AutoView e riceveranno le trap SNMP dallo switch. Se la casella di controllo
Abilita SNMP è selezionata, l'unità risponderà alle richieste SNMP tramite la
porta UDP 161.

Per configurare le impostazioni generali di SNMP:

1. Scegliere Vista unità > Accessorio > Impostazioni accessorio > Impostazioni
 SNMP per visualizzare la finestra SNMP.

2. Selezionare la casella di controllo Abilita SNMP per consentire allo switch di
rispondere alle richieste SNMP tramite la porta UDP 161.

3. Nel campo Nome immettere il nome di dominio completo del sistema e nel
campo Contatto immettere informazioni sulla persona di contatto per il nodo.

4. Immettere i nomi di comunità Lettura, Scrittura e Trap. In tali campi sono
specificate le stringhe di comunità che devono essere utilizzate in azioni
SNMP. Le stringhe Lettura e Scrittura si applicano soltanto al protocollo
SNMP sulla porta UDP 161 e fungono da password per proteggere l'accesso
allo switch. La lunghezza massima dei valori è di 64 caratteri e i campi non
possono essere vuoti.

5. Nei campi Manager consentito immettere l'indirizzo di un massimo di quattro
stazioni di lavoro che saranno autorizzate a gestire lo switch. In alternativa,
questi campi possono essere lasciati vuoti e qualsiasi stazione di lavoro
sarà in grado di gestire lo switch.

6. Fare clic su Salva.

3.14 Impostazioni degli eventi
Un evento è costituito da una notifica inviata dallo switch a una stazione di
gestione per segnalare un episodio che richiede ulteriore attenzione.

590-1058-640A 41



3. Configurazione locale e remota

Per attivare singoli eventi:

1. Scegliere Vista unità > Accessorio > Impostazioni accessorio > Verifica >
Eventi per visualizzare la finestra Eventi.

2. Per specificare gli eventi che genereranno notifiche selezionare le caselle di
controllo di interesse nell'elenco.

- oppure -

Selezionare e deselezionare la casella di controllo a fianco di Nome
evento per selezionare o deselezionare l'intero elenco.

3. Fare clic su Salva.

3.15 Impostazione di destinazioni degli eventi
È possibile configurare l'invio degli eventi di verifica a destinazioni di trap SNMP
e a server Syslog. Gli eventi attivati nella finestra Eventi vengono inviati a tutti i
server elencati nella finestra Destinazioni eventi.

1. Scegliere Vista unità > Accessorio > Impostazioni accessorio > Verifica >
Destinazioni per visualizzare la finestra Destinazioni eventi.

2. Nei campi Destinazioni trap SNMP digitare l'indirizzo di un massimo di
quattro stazioni di gestione a cui saranno inviati gli eventi, nonché di un
massimo di quattro server Syslog.

3. Fare clic su Salva.

3.16 Configurazione dei cavi adattatore
Dallo switch è possibile visualizzare un elenco dei cavi adattatore collegati
nonché le seguenti informazioni relative a ciascun cavo: eID (ID elettronico),
porta, stato, applicazione, tipo di interfaccia e velocità USB. Facendo clic su uno
dei cavi possono essere visualizzate le seguenti informazioni aggiuntive: tipo di
switch, versione di boot, versione dei componenti hardware, versione FPGA,
versione disponibile e stato di aggiornamento.

È possibile inoltre eseguire le seguenti operazioni: eliminare cavi adattatore non
in linea, aggiornare il firmware dei cavi, impostare la velocità USB e azzerare i
cavi.

Per eliminare i cavi adattatore non in linea:

1. Nella barra di navigazione laterale scegliere Vista unità > Accessorio >
Impostazioni accessorio > Porte > Cavi adattatore per visualizzare la
schermata dei cavi adattatore dell'accessorio.
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2. Fare clic su Elimina non in linea.

Per impostare la velocità USB (solo cavi adattatore KVM s4 USB20-VGA):

1. Nella barra di navigazione laterale scegliere Vista unità > Accessorio >
Impostazioni accessorio > Porte > USB20-VGA per visualizzare la schermata
USB20-VGA dell'accessorio.

2. Selezionare la casella o le caselle di controllo a fianco dei cavi da
modificare.

3. Fare clic su Imposta velocità USB 1.1 o Imposta velocità USB 2.0.

Aggiornamento dei cavi adattatore

La funzione di aggiornamento Flash dei cavi adattatore consente agli
amministratori di accessorio di aggiornare i cavi con il firmware più recente
utilizzando l'interfaccia utente dello switch o il software DSView 3.

Una volta che la memoria Flash è stata riprogrammata con l'aggiornamento, lo
switch esegue un ripristino soft che interrompe tutte le sessioni dei cavi
adattatore. È possibile che un dispositivo di destinazione interessato
dall'aggiornamento del firmware del cavo adattatore non sia visualizzato o risulti
disconnesso; una volta completato l'aggiornamento Flash, il dispositivo di
destinazione sarà visualizzato normalmente.

Se è impostato l'aggiornamento automatico dei cavi adattatore, i cavi saranno
aggiornati automaticamente quando viene aggiornato lo switch. Per aggiornare il
firmware dello switch fare riferimento a "Strumenti per gli switch KVM s4" a
pagina 29 o alla guida in linea del software DSView 3. Se durante il normale
processo di aggiornamento si verificano problemi, è possibile imporre un
aggiornamento forzato ai cavi adattatore.

Per verificare la disponibilità di file di aggiornamento del firmware accedere a
http://www.ts.fujitsu.com.

Per aggiornare il firmware dei cavi adattatore:

1. Nella barra di navigazione laterale scegliere Vista unità > Accessorio >
Impostazioni accessorio > Porte > Cavi adattatore per visualizzare la
schermata dei cavi adattatore dell'accessorio.

2. Selezionare la casella o le caselle di controllo a fianco dei cavi adattatore da
aggiornare e fare clic su Aggiorna.
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AVVERTENZA: se durante un aggiornamento del firmware un cavo adattatore viene
scollegato o il dispositivo di destinazione viene spento e riacceso, ilmodulo diventerà
inutilizzabile e sarà necessario restituire il cavo adattatore al produttore per la
riparazione.

3.17 Impostazioni dei dispositivi di alimentazione
Per modificare le impostazioni dei dispositivi di controllo dell'alimentazione sono richiesti
privilegi di amministratore.

Nella schermata Dispositivi di alimentazione accessorio sono visualizzati
l'elenco dei dispositivi di alimentazione collegati nonché le seguenti informazioni
per ciascun dispositivo di alimentazione: nome, porta, stato, versione, segnale
acustico, allarme e temperatura. Inoltre è possibile selezionare un dispositivo di
alimentazione e fare clic su Impostazioni per visualizzare le seguenti
informazioni sul dispositivo: nome, descrizione, stato, versione, prese, nome del
fornitore, modello e informazioni in ingresso.

Se un dispositivo di destinazione è collegato a una presa di un dispositivo di
controllo dell'alimentazione, il dispositivo di destinazione può essere spento,
acceso o spento e quindi riacceso.

Per accendere, spegnere o spegnere e riaccendere un dispositivo di
destinazione:

1. Nella barra di navigazione laterale scegliere Vista unità > Accessorio >
Impostazioni accessorio > Porte > Dispositivi di alimentazione per
visualizzare la finestra Dispositivi di alimentazione accessorio.

2. Fare clic sul nome dell'unità da configurare e quindi su Prese.

3. Selezionare la casella di controllo a sinistra della presa o delle prese da
configurare.

4. Fare clic su Attiva, Disattiva o Disattiva e riattiva, a seconda dell'azione da
eseguire.

Per eliminare i dispositivi di alimentazione non in linea:

1. Nella barra di navigazione laterale scegliere Vista unità > Accessorio >
Impostazioni accessorio > Porte > Dispositivi di alimentazione per
visualizzare la finestra Dispositivi di alimentazione accessorio.

2. Fare clic su Elimina non in linea.
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Per modificare i periodi di minimo attivo, disattivazione o riattivazione:

1. Nella barra di navigazione laterale scegliere Vista unità > Accessorio >
Impostazioni accessorio > Porte > Dispositivi di alimentazione per
visualizzare la finestra Dispositivi di alimentazione accessorio.

2. Fare clic sul nome dell'unità da configurare e quindi su Prese.

3. Fare clic sul nome della presa da modificare.

4. Modificare le impostazioni di interesse utilizzando le finestre a discesa e fare
clic su Salva.

Associazione di server di destinazione e prese di alimentazione

Se una o più prese di alimentazione vengono denominate con lo stesso nome di
un server di destinazione, tali prese vengono collegate o associate con il server
per agevolare le attività di controllo. La pagina Dispositivi di destinazione
dell'interfaccia OBWI consente di selezionare le azioni di controllo
dell'alimentazione per i dispositivi di destinazione a cui sono state associate una
o più prese. Nella tabella Alimentazione presa a muro della pagina di
panoramica di un dispositivo di destinazione sono mostrate le prese associate a
tale dispositivo di destinazione.

Nella seguente figura al dispositivo di destinazione denominato Server2 sono
state associate delle prese di alimentazione. Facendo clic sulla freccia del menu
a discesa nella colonna Azione vengono visualizzate le ulteriori azioni di
controllo dell'alimentazione disponibili.

Figura 3.2. Dispositivi di destinazione

Nella seguente figura della pagina Panoramica unità per Server2, nella sezione
Alimentazione presa a muro la presa 1 e la presa 9 di PDU 1 sono associate a
Server2.
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Figura 3.3. Server2 nella pagina di panoramica del dispositivo di destinazione

Raggruppamento di prese di alimentazione

È possibile assegnare lo stesso nome a più prese di alimentazione per
associarle in un unico gruppo, che sarà elencato come un unico dispositivo di
destinazione. Le azioni di controllo dell'alimentazione eseguite nella pagina
Dispositivi di destinazione vengono applicate a tutte le prese incluse nel gruppo.
Per eseguire azioni di controllo dell'alimentazione su prese specifiche di un
dispositivo di destinazione, utilizzare la pagina Panoramica unità. Nella
seguente figura il dispositivo di destinazione denominato Gruppo2 comprende le
prese di alimentazione 4 e 5 su PDU 1.

Figura 3.4. Gruppo2 nella pagine di panoramica del dispositivo di destinazione

Nomi di prese predefiniti

Nella pagina Dispositivi di alimentazione la casella di controllo "Assegna nomi
predefiniti a prese" consente di impostare l'assegnazione di nomi predefiniti alle
prese di alimentazione di ciascun dispositivo di alimentazione, come mostrato
nella figura che segue. Nella pagina dei dispositivi di destinazione vengono
elencate solo le prese di alimentazione a cui è stato assegnato un nome. Per
rimuovere i nomi predefiniti assegnati alle prese di alimentazione, deselezionare
la casella di controllo "Assegna nomi predefiniti a prese" e salvare; per
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assegnare nomi predefiniti alle prese di alimentazione senza nome, selezionare
"Assegna nomi predefiniti a prese" e salvare.

Figura 3.5. Pagina Dispositivi di alimentazione accessorio

Assegnazione del nome a una presa

Come mostrato nella seguente figura, nella pagina Impostazioni presa
dispositivo di alimentazione sono disponibile tre opzioni per l'assegnazione del
nome a una presa: Manuale, Collega a dispositivo di destinazione e Non
visualizzare come dispositivo di destinazione.

Figura 3.6. Pagina Impostazioni presa dispositivo di alimentazione

• L'opzione Manuale consente di attribuire un nome univoco a una presa. A
tutti i cavi adattatore e alle prese di alimentazione deve essere assegnato un
nome univoco: l'assegnazione manuale di un nome non univoco genera un
errore e il nome non sarà salvato.

• L'opzione Collega a dispositivo di destinazione consente di associare la
presa al nome di un altro dispositivo di destinazione (una presa o un cavo
adattatore) per controllare l'alimentazione del dispositivo di destinazione a
cui è già stato assegnato un nome. Di solito, una presa viene associata al
nome di un cavo adattatore di destinazione quando la presa fornisce
fisicamente alimentazione al server collegato a tale cavo adattatore.

• L'opzione Non visualizzare come dispositivo di destinazione consente di
lasciare vuoto il campo del nome della presa, per impedire che venga
visualizzata nella pagina Dispositivi di destinazione. Questa opzione è utile
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per le prese di riserva che si desidera rimuovere dalla pagina Dispositivi di
destinazione.

Trasferimento del controllo degli accessi

Quando il nome di una presa di alimentazione viene modificato tramite
l'associazione a un dispositivo di destinazione, alla presa viene trasferito il
controllo degli accessi già configurato per il nome di tale dispositivo. Quando
viene aggiunto un cavo adattatore, se il nome recuperato dal cavo adattatore
corrisponde al nome di un dispositivo di destinazione già esistente, al nuovo
cavo viene trasferito il controllo degli accessi di tale dispositivo di destinazione.
Quando un dispositivo di destinazione viene rinominato, tutti i cavi adattatore e le
prese del dispositivo vengono a loro volta rinominati e assumono il controllo
degli accessi precedentemente configurato per il vecchio nome del dispositivo di
destinazione.

Rinominazione di un dispositivo di destinazione

La pagina di panoramica di un dispositivo di destinazione consente di assegnare
al dispositivo un qualsiasi nome univoco. Il nome deve essere univoco per tutta
la serie di dispositivi di destinazione, compresi cavi adattore e prese di
alimentazione. Quando un dispositivo di destinazione viene rinominato, il nuovo
nome viene assegnato anche a tutte le prese associate a tale dispositivo.

Stato di priorità di dispositivi di destinazione

Nella pagina Dispositivi di destinazione un dispositivo di destinazione a cui sono
state associate prese di alimentazione controlla più dispositivi. Il valore Stato
visualizzato per un dispositivo di destinazione viene scelto come la priorità
massima di tutti i valori di stato dei dispositivi. Nella seguente tabella sono
riportati i possibili valori di stato in ordine di priorità (dalla più alta alla più bassa)
e i tipi di dispositivi di destinazione a cui può essere applicato.

Valore di stato Applicabile a: Descrizione dello stato

Cavo
adattatore

Presa di
alimentazione

In uso x N/A Una sessione è attiva

Percorso bloccato x N/A
Il percorso al dispositivo di
destinazione è in uso in un'altra
sessione

Tabella 3.7. Valori di stato dei dispositivi di destinazione
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Valore di stato Applicabile a: Descrizione dello stato

Cavo
adattatore

Presa di
alimentazione

Aggiornamento in
corso x N/A È in corso l'aggiornamento del

cavo adattatore.

Attivazione in
corso N/A x È in corso l'attivazione di una o più

prese

Disattivazione in
corso N/A x È in corso la disattivazione di una o

più prese

Non alimentato x N/A Sul cavo adattatore non è stata
rilevata alimentazione

Alimentazione
parziale N/A x Il dispositivo di destinazione

presenta prese attive e non attive

Bloccato-Non
attivo N/A x Una o più prese sono bloccate

attive

Spento N/A x Una o più prese sono spente

Bloccato-Attivo N/A x Una o più prese sono bloccate non
attive

Inattivo x N/A Non è attiva alcuna sessione; il
cavo adattatore è alimentato

Acceso N/A x Le prese sono accese

Quando a un dispositivo di destinazione sono associate tramite il nome più prese
di alimentazione e tali prese non hanno uno stato di alimentazione comune, è
possibile che l'accessorio interpreti lo stato Bloccato-Non attivo di una presa
come Non attivo e lo stato Bloccato-Attivo come Attivo. Nella seguente tabella
sono elencati i valori Stato che risultano dalla combinazione di due diversi valori
di stato delle prese.

Stato presa 1 Stato presa 2 Stato risultante

Non attivo Non attivo Non attivo

Non attivo Attivo Alimentazione parziale

Tabella 3.8. Valori di stato delle prese multipli e stato visualizzato
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Stato presa 1 Stato presa 2 Stato risultante

Attivo Attivo Acceso

Bloccato-Attivo Attivo Acceso

Bloccato-Attivo Bloccato-Attivo Bloccato-Attivo

Bloccato-Attivo Non attivo Alimentazione parziale

Bloccato-Non
attivo Attivo Alimentazione parziale

Bloccato-Non
attivo

Bloccato-Non
attivo Bloccato-Non attivo

Bloccato-Non
attivo Non attivo Spento

Bloccato-Attivo Bloccato-Non
attivo Alimentazione parziale

Pagina Sessione locale sulla porta locale

Quando al dispositivo di destinazione della sessione attiva sono associate prese
di alimentazione, nella sezione Sessioni attive della pagina Sessione locale
sono visualizzati tre controlli dell'alimentazione. Nella seguente figura sono
mostrati i controlli dell'alimentazione visualizzati per una sessione attiva sulla
porta locale per un dispositivo di destinazione denominato Server2.

Figura 3.7. Pagina Sessione locale con controlli dell'alimentazione
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4.1 Finestra Visualizzatore video
Il Visualizzatore video consente di eseguire una sessione KVM tramite
l'interfaccia OBWI sui dispositivi di destinazione collegati a uno switch. Quando
viene stabilita la connessione a un dispositivo per mezzo del Visualizzatore
video, il desktop del dispositivo di destinazione viene visualizzato in una finestra
separata in cui sono disponibili il cursore locale e i cursori dei dispositivi di
destinazione.

Per visualizzare la finestra Visualizzatore video il software dell'interfaccia OBWI
dello switch si avvale di un programma basato su Java. Il Visualizzatore video
viene scaricato e installato automaticamente dall'interfaccia OBWI dello switch la
prima volta che viene aperto.

Per avviare una sessione è richiesto Java 1.6.0_11 o successivo.

Java Runtime Environment (JRE) non viene installato dall'interfaccia OBWI dello switch.
JRE può essere scaricato gratuitamente dal sitoWeb http://www.sun.com.

Per la memorizzazione e la visualizzazione delle immagini nelle finestre Visualizzatore
video l'interfaccia OBWI dello switch sfrutta la memoria del sistema. Ciascuna finestra
aperta delVisualizzatore video richiedememoria di sistema aggiuntiva. L'impostazione
del colore a 8 bit sul server client richiede 1,4MBdimemoria per ciascuna finestra
Visualizzatore video, l'impostazione del colore a 16 bit richiede 2,4MBe il colore a 32 bit
richiede 6,8MB. Se si tenta di aprire più finestre Visualizzatore video di quante sono
consentite dalla memoria del sistema in uso (di solito quattro), verrà visualizzato un
errore dimemoria esaurita e la finestra Visualizzatore video richiesta non sarà aperta.

Se il dispositivo a cui si tenta di accedere è attualmente visualizzato da un altro
utente e il proprio livello di diritti di priorità è uguale o superiore a quello dell'altro
utente, sarà richiesto di esercitare diritti di priorità sull'altro utente. Un
amministratore di accessorio può disconnettere un utente attivo anche tramite la
pagina delle sessioni attive. Per ulteriori informazioni fare riferimento a "Sessioni
dello switch KVM s4" a pagina 27.
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Figura 4.1. Finestra Visualizzatore video (modalità finestra normale)

Tabella 4.1. Descrizioni relative alla Figura 4.1

Numero Descrizione

1

Barra del titolo: è indicato il nome del dispositivo di destinazione
visualizzato. In modalità schermo intero la barra del titolo scompare e il
nome del dispositivo di destinazione è visualizzato tra ilmenu e la barra
degli strumenti.

2
Icona Puntina da disegno: consente di bloccare ilmenu e la barra degli
strumenti in visualizzazione permanente.
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Numero Descrizione

3

Menu e barra degli strumenti: consentono di accedere amolte delle
funzionalità della finestra Visualizzatore video. Se la puntina da disegno
non è stata attivata, ilmenu e la barra degli strumenti vengono
visualizzati a richiesta; per visualizzarli posizionare il cursore sulla barra
degli strumenti. Nella barra degli strumenti possono essere visualizzati
fino a dieci comandi e/o pulsanti di gruppi dimacro. Per impostazione
predefinita sono visualizzati i pulsantiModalità cursore unico, Aggiorna,
Regolazione video automatica e Allinea cursore locale. Per ulteriori
informazioni fare riferimento a "Modifica della barra degli strumenti" a
pagina 54 e a "Macro" a pagina 73.

4
Pulsanti dimacro: sequenze da tastiera di uso frequente che possono
essere inviate al dispositivo di destinazione.

5
Pulsante Riduci a icona: consente di ridurre la finestra Visualizzatore
video a un'icona sulla barra delle attività nella parte inferiore del
computer locale.

6

Pulsante Ingrandisci: consente di attivare la modalità schermo intero
della finestra in cui la visualizzazione del desktop del dispositivo connesso
viene ingrandita fino a occupare l'intero schermo. Quando la finestra
viene ingrandita:

La barra del titolo scompare.

Il nome del dispositivo di destinazione viene visualizzato tra ilmenu e la
barra degli strumenti.

Il pulsante Ingrandisci diventa il pulsante di ripristino della finestra
normale ed è visualizzato nella barra degli strumenti. Facendo clic sul
pulsante la finestra Visualizzatore video passa alla modalità finestra
normale.

Il pulsante Chiudi viene visualizzato nella barra degli strumenti.

7

Pulsante Chiudi: consente di chiudere la finestra Visualizzatore video.

NOTA: è possibile che in determinati sistemi operativi il pulsante Chiudi
non sia visualizzato.

8
Desktop del dispositivo connesso: consente di interagire con il
dispositivo.
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Numero Descrizione

9 Riquadro: consente dimodificare le dimensioni della finestra
Visualizzatore video facendo clic e trascinando il bordo.

Modifica della barra degli strumenti

È possibile impostare il periodo di tempo che trascorre prima che la barra degli
strumenti nella finestra Visualizzatore video venga nascosta quando la
visualizzazione non è stata bloccata tramite la puntina da disegno.

Per impostare il periodo di tempo prima che la barra degli strumenti venga
nascosta:

1. Scegliere Strumenti > Opzioni sessione nel menu della finestra
Visualizzatore video.

- oppure -

Fare clic sul pulsante Opzioni sessione.

Verrà visualizzata la finestra di dialogo Opzioni sessione.

2. Scegliere la scheda Barra degli strumenti.

3. Specificare il numero di secondi che trascorreranno prima che la barra degli
strumenti venga nascosta utilizzando i pulsanti freccia.

4. Fare clic su OK per salvare le modifiche e chiudere la finestra di dialogo.

4.2 Avvio di una sessione
Quando si utilizza una connessione nonmediata da un proxy, le prestazioni video con
una connessione di rete di tipo più lento possono non essere ottimali. È possibile
migliorare le prestazioni videomodificando le impostazioni del colore, poiché certe
impostazioni (per esempio la scala di grigi) richiedono unaminore larghezza di banda di
rete rispetto ad altre (per esempio il colore ottimale). Per prestazioni video ottimali con
una connessione di rete di tipo più lento, impostare il colore su scala di
grigi/compressione ottimale oppure su colore basso/compressione alta. Per ulteriori
informazioni, fare riferimento a "Regolazione della visualizzazione" a pagina 56.

Se per una connessione a un dispositivo di destinazione viene utilizzata una risoluzione
dello schermo superiore a quella del computer locale, nella finestra Visualizzatore video
sarà visualizzata solo una parte della schermata del dispositivo di destinazione e
saranno disponibili barre di scorrimento per visualizzare il resto della schermata. Per
visualizzare l'intera schermata è necessario regolare la risoluzione del dispositivo di
destinazione, del computer locale o di entrambi.
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Per avviare una sessione KVM dalla finestra Esplora risorse dello switch:

1. Fare clic su un dispositivo nell'elenco della finestra Dispositivi di
destinazione per visualizzare la finestra di panoramica delle unità.

2. Fare clic sul collegamento Sessione KVM per aprire il Visualizzatore video in
una nuova finestra.

Periodo di attesa per le sessioni

Se non si verifica alcuna attività nella finestra di una sessione remota per un
periodo di tempo specificato, la sessione scade. Il periodo di attesa prima della
scadenza di una sessione può essere configurato nella finestra Impostazioni
sessione KVM accessorio. Il valore impostato sarà utilizzato dall'accesso
successivo all'interfaccia OBWI dello switch.

Per attivare, disattivare o configurare il periodo di attesa per le sessioni:

1. Nel menu laterale scegliere Vista unità > Accessorio > Impostazioni
accessorio > Sessioni > Generale.

2. Selezionare l'impostazione di interesse per la casella Attiva timeout inattività.

3. Se necessario, impostare il limite di tempo per l'opzione di timeout per
inattività.

4. Fare clic su Salva.

4.3 Dimensioni della finestra
Il comando Visualizza >Modifica proporzioni non è disponibile quando la finestra
Visualizzatore video è visualizzata in modalità schermo intero o in una sessione
condivisa per utenti non primari.

Quando l'interfaccia OBWI dello switch viene utilizzata per la prima volta, le
eventuali finestre Visualizzatore video aperte sono visualizzate con una
risoluzione di 1024 x 768 finché l'impostazione non viene modificata dall'utente.
Ciascuna finestra Visualizzatore video può essere impostata su una risoluzione
diversa.

Se la modifica delle dimensioni automatica è attivata, la visualizzazione viene
regolata automaticamente dall'interfaccia OBWI dello switch qualora le
dimensioni della finestra cambino durante una sessione. Se la risoluzione del
dispositivo di destinazione viene modificata mentre una sessione è attiva, la
visualizzazione viene regolata automaticamente.
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Per modificare la risoluzione della finestra Visualizzatore video:

1. Scegliere il comando Visualizza > Modifica proporzioni.

2. Selezionare la risoluzione di interesse.

4.4 Regolazione della visualizzazione
I menu e i pulsanti di comando della finestra Visualizzatore video consentono di:

• Allineare i cursori del mouse.

• Aggiornare la schermata.

• Attivare o disattivare la modalità schermo intero. Quando è attivata la
modalità schermo intero, l'immagine viene regolata per occupare il desktop
fino alla dimensione massima di 1600 x 1200 o1680 x 1050 (widescreen).
Se il desktop ha una risoluzione maggiore:

• L'immagine a schermo intero viene centrata nel desktop e le aree
attorno alla finestra Visualizzatore video sono nere.

• Il menu e la barra degli strumenti sono bloccati in visualizzazione
permanente.

• Attivare la modifica delle dimensioni automatica, completa o manuale
dell'immagine della sessione:

• In modalità di modifica completa le dimensioni della finestra del desktop
rimangono costanti e l'immagine del dispositivo viene adeguata alle
dimensioni della finestra.

• In modalità di modifica automatica la finestra del desktop viene
ridimensionata in base alla risoluzione del dispositivo di destinazione
visualizzato.

• In modalità di modifica manuale verrà visualizzato un menu a discesa
con le risoluzioni di proporzionamento dell'immagine supportate.

• Modificare l'intensità del colore dell'immagine della sessione.

Per allineare i cursori del mouse:

Fare clic sul pulsante Allinea cursore locale nella barra degli strumenti del
Visualizzatore video. Il cursore locale verrà allineato con il cursore del dispositivo
remoto.

Se i cursori perdono l'allineamento, disattivare l'opzione di accelerazione delmouse sul
dispositivo collegato.
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Per aggiornare la schermata, fare clic sul pulsante Aggiorna immagine nella
finestra Visualizzatore video o scegliere Visualizza > Aggiorna nel menu della
finestra Visualizzatore video. L'immagine video digitalizzata verrà
completamente rigenerata.

Per attivare la modalità schermo intero fare clic sul pulsante Ingrandisci oppure
scegliere Visualizza > Schermo intero nel menu della finestra Visualizzatore
video. La finestra del desktop scompare e sarà visibile solo il desktop del
dispositivo connesso. La schermata viene ridimensionata fino a un massimo di
1600 x 1200 o 1680 x 1050 (widescreen). Se il desktop ha una risoluzione
superiore, l'immagine a schermo intero sarà circondata da uno sfondo nero.
Verrà visualizzata la barra degli strumenti mobile.

Per disattivare la modalità schermo intero e tornare alla finestra del desktop, fare
clic sul pulsante Modalità schermo intero nella barra degli strumenti mobile.

Per attivare la modifica delle dimensioni completa scegliere Visualizza >
Modifica proporzioni nel menu della finestra Visualizzatore video. L'immagine del
dispositivo sarà automaticamente modificata in base alla risoluzione del
dispositivo di destinazione visualizzato.

Per attivare la modifica delle dimensioni manuale scegliere Visualizza > Modifica
proporzioni nel menu della finestra Visualizzatore video. Selezionare le nuove
dimensioni per la finestra. Le dimensioni disponibili per la modifica manuale
delle dimensioni variano a seconda del sistema in uso.

4.5 Aggiornamento dell'immagine
Il pulsante Aggiorna immagine nella finestra di dialogo Regolazione video
manuale consente di rigenerare completamente l'immagine video digitalizzata.

In alternativa, per aggiornare l'immagine è possibile scegliereVisualizza >Aggiorna nel
menu della finestra Visualizzatore video.

4.6 Impostazioni video

Altre regolazioni video

In generale, le funzioni di regolazione automatica della finestra Visualizzatore
video consentono di ottimizzare la visualizzazione; è comunque possibile
eseguire regolazioni di precisione con l'aiuto del personale dell'assistenza
tecnica Fujitsu scegliendo il comando Strumenti > Regolazione video manuale
nella menu della finestra Visualizzatore video oppure facendo clic sul pulsante
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Regolazione video manuale. Verrà visualizzata la finestra di dialogo
Regolazione video manuale che consente di regolare il video per ciascun
dispositivo specifico.

È possibile inoltre verificare il livello di pacchetti al secondo necessari per
supportare uno schermo statico osservando la velocità di trasmissione
visualizzata in basso a sinistra nella finestra di dialogo.

Per regolare manualmente la qualità video della finestra:

Le seguenti regolazioni video dovrebbero essere effettuate solo con l'aiuto del
personale dell'assistenza tecnica Fujitsu.

1. Scegliere Strumenti > Regolazione video manuale nel menu della finestra
Visualizzatore video.

- oppure -

Fare clic sul pulsante Regolazione video manuale.

Verrà visualizzata la finestra di dialogo Regolazione video manuale.

Figura 4.2. Finestra di dialogo Regolazione video manuale
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Numero Descrizione Numero Descrizione

1
Larghezza
acquisizione
immagine

8 Soglia rumore pixel

2
Regolazione fine
campionamento
pixel

9 Regolazione video automatica

3

Posizione
orizzontale
acquisizione
immagine

10 Aggiorna immagine

4
Posizione verticale
acquisizione
immagine

11 Barra di regolazione

5 Contrasto 12 Motivo di prova video

6 Luminosità 13 Monitoraggio prestazioni

7
Blocca soglia
rumore

14 Pulsante Chiudi

Tabella 4.2. Descrizioni relative alla Figura 4.2

2. Fare clic sull'icona della caratteristica da regolare.

3. Per ciascuna icona selezionata, spostare la barra di scorrimento (Contrasto
in figura), quindi fare clic sui pulsanti Min (-) o Max (+) per la regolazione di
precisione del parametro. Le regolazioni vengono visualizzate
immediatamente nella finestra Visualizzatore video.

4. Una volta completate le regolazioni, fare clic sul pulsante Chiudi per uscire
dalla finestra di dialogo Regolazione video manuale.

Impostazioni video del dispositivo di destinazione

Le regolazioni Larghezza acquisizione immagine, Regolazione fine
campionamento pixel, Posizione orizzontale acquisizione immagine e Posizione
verticale acquisizione immagine influiscono sull'acquisizione e sulla
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digitalizzazione delle immagini del dispositivo di destinazione e vengono
modificate raramente.

I parametri di acquisizione delle immagini vengono modificati automaticamente
mediante la funzione di regolazione automatica. Per eseguire regolazioni più
accurate è necessario visualizzare un'immagine speciale sul dispositivo di
destinazione.

Regolazione video automatica

Nella maggior parte dei casi non è necessario modificare le impostazioni video
predefinite poiché il sistema regola automaticamente i parametri per ottimizzare
la qualità video. L'interfaccia OBWI dello switch offre prestazioni ottimali quando i
parametri video sono impostati in modo che non venga trasmesso alcun (zero)
pacchetto video per una schermata statica.

Per impostare i parametri video sui valori ottimizzati è sufficiente fare clic sul
pulsante Regolazione video automatica nella finestra di dialogo Regolazione
video manuale.

In alternativa, per regolare automaticamente il video è possibile scegliereStrumenti >
Regolazione video automatica nelmenu della finestra Visualizzatore video oppure fare
clic sull'iconaRegolazione video automatica nella barra degli strumenti.

Motivo di prova video

Il pulsante Motivo di prova video nella finestra di dialogo Regolazione video
manuale consente di visualizzare un motivo di prova per il video. Fare
nuovamente clic sul pulsante Motivo di prova video per tornare all'immagine
video normale.

Impostazioni video a seconda del produttore

Le impostazioni video variano in modo significativo da un produttore all'altro.

4.7 Impostazioni del colore

Regolazione dell'intensità del colore

L'algoritmo Dambrackas Video Compression (DVC) consente di regolare il
numero di colori visualizzabili in una finestra di sessione remota. È possibile
visualizzare più colori per mantenere una maggiore fedeltà di immagine oppure
meno colori per ridurre il volume dei dati trasferiti sulla rete.
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Le finestre Visualizzatore video possono essere impostate su Colore ottimale
(aggiornamenti più lenti), Compressione ottimale (aggiornamenti più veloci), una
combinazione di Colore ottimale e Compressione ottimale o su Scala di grigi.

Il comando Visualizza - Colore in una finestra di sessione remota consente di
impostare l'intensità del colore per porte e canali specifici e tali impostazioni
saranno salvate singolarmente per ciascun canale.

Contrasto e luminosità

Se l'immagine del Visualizzatore video è troppo scura o troppo chiara, scegliere
Strumenti > Regolazione video automatica o fare clic sul pulsante Regolazione
video automatica. Il comando è disponibile anche nella finestra delle regolazioni
video. Nella maggior parte dei casi è sufficiente questo comando per correggere
i problemi del video.

Se l'uso ripetuto del comando o del pulsante Regolazione video automatica non
è sufficiente per regolare il contrasto e la luminosità, provare a eseguire una
regolazione manuale. Aumentare la luminosità, senza spostare la barra per più
di 10 punti prima di regolare il contrasto. Di solito è necessario muovere molto
poco la barra del contrasto.

4.8 Impostazioni dei disturbi

Soglie di rilevamento

In alcuni casi i disturbi della trasmissione video mantengono elevato il valore
pacchetti/sec, indicato dai puntini animati nell'area del cursore quando viene
spostato. La modifica dei valori delle soglie può garantire schermate meno
disturbate e migliori prestazioni del cursore.

I valori Soglia rumore e Soglia priorità possono essere modificati se si utilizza
una compressione video standard; inoltre è possibile modificare i valori Blocca
soglia rumore e Soglia rumore pixel. Per ripristinare i valori predefiniti delle
soglie è sufficiente fare clic su Regolazione video automatica.

Blocca soglia rumore e Soglia rumore pixel

I valori Blocca soglia rumore e Soglia rumore pixel stabiliscono i livelli minimi di
colore in termini di pacchetti video e pixel modificati ogni mille consentiti.

• Il valore Blocca soglia rumore consente di impostare la modifica di colore
minima in un singolo pacchetto video: mentre l'aumento del valore riduce la
larghezza di banda della rete, la diminuzione riduce le dimensioni di questo
tipo di elementi.
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• Il valore Soglia rumore pixel consente di impostare la modifica di colore
minima in un singolo pixel: la diminuzione del valore riduce il numero di
elementi a basso contrasto, ma aumenta la larghezza di banda della rete.

Per ulteriori informazioni sulla modifica dell'intensità del colore fare riferimento a
"Regolazione della visualizzazione" a pagina 56.

4.9 Impostazioni del mouse

Regolazione delle opzioni del mouse

Le opzioni del mouse della finestra Visualizzatore video influiscono sul tipo e
sulla modalità del cursore, sulle proporzioni, sull'allineamento e sull'eventuale
ripristino. Le impostazioni del mouse sono specifiche per ciascun dispositivo e
quindi possono essere diverse per ciascun dispositivo.

Se il dispositivo non supporta la funzionalità che consente di scollegare e ricollegare il
mouse (quasi tutti i PC più recenti la supportano), ilmouse verrà disattivato e sarà
necessario riavviare il dispositivo.

Tipo di cursore

Per la visualizzazione del cursore del mouse locale sono disponibili cinque
opzioni; inoltre è possibile scegliere nessun cursore o il cursore predefinito.

In modalità cursore singolo la visualizzazione del cursore locale (secondo) è
disattivata: nella finestra Visualizzatore video è visibile solo il puntatore del
mouse del dispositivo di destinazione e saranno visualizzati solo i movimenti del
cursore remoto, ossia del mouse del dispositivo di destinazione. Utilizzare la
modalità cursore singolo quando non è richiesto un cursore locale.
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Figura 4.3. Cursori locale e remoto visualizzati nella finestra Visualizzatore video

Numero Descrizione

1 Cursore remoto

2 Cursore locale

Tabella 4.3. Descrizioni relative alla Figura 4.3

La modalità attiva del cursore è visualizzata nella barra del titolo della finestra
Visualizzatore video, assieme alla sequenza di tasti che consente di uscire dalla
modalità cursore unico. La sequenza di tasti per uscire dalla modalità cursore
unico può essere impostata nella finestra di dialogo Opzioni sessione.

Si consiglia di non utilizzare tale sequenza per ripristinare il puntatore delmouse se si
utilizza un dispositivo che acquisisce le sequenze di tasti prima che raggiungano il server
client.

Per accedere alla modalità cursore unico scegliere Strumenti > Modalità cursore
unico nel menu della finestra Visualizzatore video oppure fare clic sul pulsante
Modalità cursore unico. Il cursore locale non sarà visualizzato e tutti i movimenti
si riferiscono al dispositivo di destinazione.
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Per impostare una sequenza di tasti per disattivare la modalità cursore
unico:

1. Scegliere Strumenti > Opzioni sessione nel menu della finestra
Visualizzatore video.

- oppure -

Fare clic sul pulsante Opzioni sessione.

Verrà visualizzata la finestra di dialogo Opzioni sessione.

2. Scegliere la scheda Mouse.

3. Selezionare una sequenza di tasti per uscire dalla modalità nel menu a
discesa nella sezione Modalità cursore unico.

4. Fare clic su Salva per salvare le impostazioni.

Quando la modalità cursore unico è attiva, sarà sufficiente premere la sequenza
di tasti specificata per tornare alla modalità desktop normale.

Per uscire dalla modalità cursore unico premere la sequenza di tasti indicata
nella barra del titolo.

Per modificare l'impostazione del cursore del mouse:

1. Scegliere Strumenti > Opzioni sessione nel menu della finestra
Visualizzatore video.

- oppure -

Fare clic sul pulsante Opzioni sessione.

Verrà visualizzata la finestra di dialogo Opzioni sessione.

2. Scegliere la scheda Mouse.

3. Selezionare un tipo di cursore del mouse nella sezione Cursore locale.

4. Fare clic su OK per salvare le impostazioni.

Proporzioni del mouse

Alcune versioni di Linux meno recenti non offrono supporto per l'accelerazione
regolabile del mouse. In installazioni che devono supportare tali versioni è
possibile selezionare una delle tre opzioni di proporzioni del mouse
preconfigurate o impostare proporzioni del mouse personalizzate. Le
impostazioni preconfigurate sono Predefinito (1:1), Alto (2:1) o Basso (1:2).
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• Se viene impostato il rapporto di proporzionamento 1:1, ogni movimento del
mouse nella finestra del desktop invia un movimento equivalente al
dispositivo di destinazione.

• Se è impostato il rapporto 2:1 lo stesso movimento del mouse invierà al
server un movimento del mouse doppio.

• Se è impostato il rapporto 1:2 il movimento sarà pari alla metà.

Per impostare le proporzioni del mouse:

1. Scegliere Strumenti > Opzioni sessione nel menu della finestra
Visualizzatore video.

- oppure -

Fare clic sul pulsante Opzioni sessione.

Verrà visualizzata la finestra di dialogo Opzioni sessione.

2. Scegliere la scheda Mouse.

3. Per utilizzare una delle impostazioni preconfigurate selezionare il
corrispondente pulsante di opzione.

- oppure -

Per impostare proporzioni personalizzate:

a. Selezionare il pulsante di opzione Personalizza per attivare i campi X e
 Y.

b. Digitare il valore delle proporzioni nei campi X e Y. A ogni input dal
mouse il movimento verrà moltiplicato per il relativo fattore di
proporzione X e Y. L'intervallo di valori validi è 0,25-3,00.

Allineamento e sincronizzazione del mouse

L'interfaccia OBWI dello switch non riceve continuamente informazioni dal mouse
e quindi è possibile che il mouse sullo switch perda la sincronizzazione con il
mouse sul sistema host. Se il mouse e la tastiera in uso non rispondono più
correttamente, per ripristinare il movimento corretto è sufficiente eseguire un
allineamento del mouse.

L'allineamento consente di allineare il cursore locale al cursore del dispositivo di
destinazione remoto. Il ripristino simula un nuovo collegamento di mouse e
tastiera, come se fossero stati fisicamente scollegati e ricollegati.

Per riallineare il mouse fare clic sul pulsante Allinea cursore locale nella barra
degli strumenti del Visualizzatore video.
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4.10 Supporto virtuale
Le funzioni di supporto virtuale consentono di mappare un'unità fisica del server
client come unità virtuale su un dispositivo di destinazione. È possibile anche
aggiungere e mappare un file immagine ISO o floppy del server client come unità
virtuale sul dispositivo di destinazione. Possono essere mappati
contemporaneamente un'unità CD e un dispositivo di archiviazione di massa.

• Un'unità CD/DVD o un file immagine di disco (per esempio un file immagine
ISO o floppy) vengono mappati come unità CD/DVD-ROM virtuale.

• Un'unità floppy, un dispositivo di memorizzazione USB o altri tipi di supporto
vengono mappati come dispositivo di archiviazione di massa virtuale.

Per informazioni sulla configurazione delle impostazioni di supporto virtuale
tramite l'interfaccia OBWI fare riferimento a "Supporto virtuale" a pagina 34.

Requisiti

Il dispositivo di destinazione deve supportare le funzioni di supporto virtuale ed
essere collegato allo switch KVM tramite un cavo adattatore KVM s4 USB20-
VGA.

Il dispositivo di destinazione deve essere intrinsecamente compatibile con i
supporti di tipo USB2 che vengono mappati a livello virtuale. In altre parole, se il
dispositivo di destinazione non supporta un dispositivo di memorizzazione USB
rimovibile, non è possibile mappare tale dispositivo sul server client come unità
di supporto virtuale sul dispositivo di destinazione.

L'utente, o il gruppo di utenti a cui appartiene, deve essere autorizzato a stabilire
sessioni di supporto virtuale e/o sessioni di supporto virtuale riservate sul
dispositivo di destinazione. Fare riferimento a "Account utente" a pagina 39.

Su un dispositivo di destinazione può essere attiva un'unica sessione di supporto
virtuale per volta.

Osservazioni su condivisione e interruzione per diritti di priorità

Dato che le sessioni KVM e di supporto virtuale sono indipendenti, sono
disponibili molte opzioni per condividere, riservare o interrompere per diritti di
priorità le sessioni. Il software DSView 3 offre tutta la flessibilità necessaria per
rispondere alle esigenze di sistema.

Per esempio, le sessioni KVM e le sessioni di supporto virtuale possono venire
ancorate insieme. In questa modalità l'interruzione di una sessione KVM
comporta l'interruzione della sessione di supporto virtuale associata. Se le
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sessioni non sono associate, è possibile chiudere la sessione KVM e la sessione
di supporto virtuale rimane attiva. Ciò può essere utile se un utente sta
eseguendo un'attività che richiede molto tempo utilizzando la sessione di
supporto virtuale, per esempio l'installazione di un sistema operativo, e desidera
avviare una sessione KVM con un dispositivo di destinazione diverso per
eseguire altre funzioni durante l'installazione del sistema operativo.

Quando su un dispositivo di destinazione è in corso una sessione di supporto
virtuale senza che sia associata una sessione KVM attiva, possono verificarsi
due situazioni: il canale potrà essere utilizzato dall'utente originale (Utente A) per
una nuova connessione oppure da un utente diverso (Utente B). Se viene
selezionata l'opzione di sessione riservata nella finestra di dialogo Supporto
virtuale, soltanto l'Utente A sarà in grado di accedere a tale canale tramite una
sessione KVM.

Se l'Utente B è autorizzato ad accedere a tale sessione in quanto l'opzione di
sessione riservata non è stata attivata, l'Utente B ha la capacità di controllare il
supporto utilizzato nella sessione di supporto virtuale. Se l'opzione di sessione
riservata è attiva in un ambiente di collegamenti a livelli, solo l'Utente A può
accedere allo switch di livello inferiore e il canale KVM tra lo switch superiore e
quello inferiore sarà riservato all'Utente A.

Finestra di dialogo Supporto virtuale

La finestra di dialogo Supporto virtuale consente di gestire la mappatura di
supporti virtuali. Nella finestra di dialogo sono visualizzate tutte le unità fisiche
del server client che possono essere mappate come unità virtuali. La finestra di
dialogo Supporto virtuale consente anche di aggiungere file immagine ISO e
floppy e di mapparli.

Dopo che un dispositivo è stato mappato, nella sezione Dettagli della finestra di
dialogo Supporto virtuale sono visualizzate informazioni sulle dimensioni dei dati
trasferiti e sul tempo trascorso dal momento in cui il dispositivo è stato mappato.

È possibile specificare se una sessione di supporto virtuale è riservata. Se una
sessione è riservata e la sessione KVM associata viene chiusa, gli altri utenti non
potranno avviare una sessione KVM su tale dispositivo di destinazione. Se una
sessione non è riservata, sarà possibile avviare un'altra sessione KVM.

La finestra di dialogo Supporto virtuale consente inoltre di ripristinare il cavo
adattatore USB2 per ripristinare tutti i supporti USB sul dispositivo di
destinazione. Deve essere utilizzata con attenzione e solo se il dispositivo di
destinazione non risponde.

590-1058-640A 67



4. Visualizzatore video

Apertura di una sessione di supporto virtuale

Per avviare una sessione di supporto virtuale:

Scegliere Strumenti - Supporto virtuale nel menu del Visualizzatore video per
visualizzare la finestra di dialogo Supporto virtuale. Per impostare la sessione
come riservata, fare clic su Dettagli e quindi selezionare la casella di controllo
Riservata.

Figura 4.4. Finestra di dialogo Supporto virtuale del Visualizzatore video

Per annullare la mappatura di un'unità di supporto virtuale:

1. Aprire una sessione di supporto virtuale dal menu del Visualizzatore video
Strumenti > Supporto virtuale.

2. Per mappare un'unità fisica come unità di supporto virtuale:

a. Nella finestra di dialogo Supporto virtuale selezionare la casella di
controllo Mappato a fianco dell'unità o delle unità da mappare.

b. Per impostare l'accesso in sola lettura all'unità mappata, selezionare la
casella di controllo Sola lettura a fianco all'unità. Se le impostazioni
della sessione di supporto virtuale configurate in precedenza
prevedono che tutte le unità mappate siano di sola lettura, la casella di
controllo sarà già attivata e non può essere modificata.

Selezionare la casella Sola lettura se le impostazioni della
sessione consentono l'accesso in lettura e scrittura ma si
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desidera limitare l'accesso all'unità in questione alla modalità
di sola lettura.

3. Per aggiungere e mappare un'immagine ISO o floppy come unità di supporto
virtuale:

a. Fare clic su Aggiungi immagine nella finestra di dialogo Supporto
virtuale.

b. Verrà visualizzata la finestra di dialogo dei file comuni e sarà
visualizzata la directory in cui sono salvati file immagine di disco (con
estensione iso o img). Selezionare il file immagine ISO o floppy di
interesse e fare clic su Apri.

- oppure -

Se il sistema operativo del server client supporta le funzioni di
trascinamento, selezionare il file di immagine ISO o floppy di
interesse nella finestra di dialogo dei fili comuni e trascinarlo
nella finestra di dialogo Supporto virtuale.

c. L'intestazione del file verrà controllata automaticamente per verificare
che sia corretta. Se la verifica ha esito positivo, la finestra di dialogo dei
file comuni chiusa e il file immagine selezionato sarà visualizzato nella
finestra di dialogo Supporto virtuale, dove può essere mappato
selezionando la casella di controllo Mappato.

d. Ripetere le fasi da a. a c. per ogni ulteriore immagine ISO o floppy da
aggiungere. In ciascuna sessione è possibile aggiungere un numero
indefinito di file immagine (fino al limite imposto dalla memoria), mentre
possono essere mappati una sola unità CD o DVD virtuale o un solo
dispositivo di archiviazione di massa virtuale alla volta.

Se si tenta di mappare troppe unità (un CD o DVD e un dispositivo di
archiviazione di massa) o troppe unità di un particolare tipo (più di un CD o DVD
o dispositivo di archiviazione di massa), verrà visualizzato un messaggio. Per
mappare una nuova unità, è necessario annullare la mappatura di un'unità già
mappata, quindi sarà possibile mappare la nuova unità.

Quando un'unità fisica o un'immagine è stata mappata, può essere utilizzata sul
dispositivo di destinazione.

Per annullare la mappatura di un'unità di supporto virtuale:

1. Nella finestra di dialogo Supporto virtuale deselezionare la casella di
controllo Mappato a fianco dell'unità unità di interesse.
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2. Verrà richiesto di confermare la modifica. Confermare o annullare
l'operazione di annullamento della mappatura.

3. Ripetere la procedura per ciascuna unità di supporto virtuale mappata che si
desidera annullare.

Per visualizzare i dettagli delle unità di supporto virtuale:

Nella finestra di dialogo Supporto virtuale fare clic su Dettagli. La finestra di
dialogo si espanderà e sarà visualizzata la tabella Dettagli. In ciascuna riga è
indicato:

• Unità target - Nome utilizzato per l'unità mappata, per esempio CD virtuale 1
o CD virtuale 2.

• Mappato su - Campo identico alle informazioni sull'unità visualizzate nella
colonna Unità della sezione Visualizzazione client.

• Byte lettura e Byte scrittura - Quantità di dati trasferiti dal momento della
mappatura.

• Durata - Tempo trascorso dal momento della mappatura dell'unità.

Per chiudere la vista Dettagli fare di nuovo clic su Dettagli.

Per ripristinare tutti i dispositivi USB sul dispositivo di destinazione:

La funzione di ripristino USB consente di ripristinare tutti i dispositiviUSB sul dispositivo
di destinazione, compresi tastiera emouse. Deve essere utilizzata solo se il dispositivo di
destinazione non risponde.

1. Nella finestra di dialogo Supporto virtuale fare clic su Dettagli.

2. Verrà visualizzata la vista Dettagli. Fare clic sul pulsante Ripristina USB.

3. Verrà visualizzato un messaggio di avvertenza sui possibili effetti del
ripristino. Confermare o annullare il ripristino.

4. Per chiudere la vista Dettagli fare di nuovo clic su Dettagli.

Chiusura di una sessione di supporto virtuale

Per chiudere la finestra di dialogo Supporto virtuale:

1. Fare clic su Esci.

2. Se una o più unità sono ancora mappate, verrà visualizzato un messaggio
per notificare che la mappatura di tali unità sarà annullata. Confermare o
annullare l'operazione.
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Se si tenta di disconnettere una sessione di supporto virtuale o una sessione
KVM attiva a cui è associata una sessione di supporto virtuale bloccata, un
messaggio di conferma indicherà che la mappatura di tutti i di supporti virtuali
sarà annullata.

4.11 Smart card
È possibile collegate un lettore di smart card a una porta USB disponibile sul
server client e accedere ai dispositivi di destinazione collegati sul sistema di
commutazione. È quindi possibile avviare una sessione KVM per aprire il
Visualizzatore video e mappare una smart card.

Per tutti i lettori di smart card è necessario utilizzare un cavo adattatore KVM s4 USB20-
VGA.

Lo stato della smart card è indicato dall'icona di smart card all'estrema destra
della barra degli strumenti del Visualizzatore video. Nella seguente tabella sono
descritte le icone di stato di una smart card.

Tabella 4.4. Icone delle smart card

Icona Descrizione

Nel lettore di smart card non è presente una smart card oppure il lettore
non è collegato.

Nel lettore di smart card è presente una smart cardma non è ancora stata
mappata.

Una smart card èmappata.

Per mappare una smart card:

1. Aprire una sessione KVM per visualizzare il menu della finestra
Visualizzatore video.

2. Inserire una smart card nel lettore di smart card collegato al server client in
uso.

3. Scegliere Strumenti > Mappatura smart card nel menu della finestra
Visualizzatore video.

4. Se sul dispositivo di destinazione non è mappata alcuna smart card, a fianco
dell'opzione Nessuna card mappata sarà visualizzato un puntino.
Selezionare la smart card in uso, elencata sotto l'opzione, per mapparla.
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Per annullare la mappatura di una smart card, chiudere la sessione KVM
facendo clic sulla X nel menu della finestra Visualizzatore video, scegliere
Strumenti > Nessuna card mappata, rimuovere la smart card dal lettore di smart
card o scollegare il lettore dal server client.

4.12 Accesso da tastiera
Le sequenze di tasti digitate da un utente durante l'uso della finestra
Visualizzatore video possono essere interpretate in due modi, a seconda della
modalità di schermo della finestra del visualizzatore.

• Se una finestra Visualizzatore video è in modalità schermo intero, tutte le
sequenze di tasti e le combinazioni da tastiera a eccezione di Ctrl-Alt-Canc
vengono inviate al dispositivo di destinazione remoto visualizzato.

• Se una finestra Visualizzatore video è in modalità desktop normale, è
possibile utilizzare la modalità accesso da tastiera per impostare il
riconoscimento di determinate sequenze o combinazioni di tasti sul
dispositivo di destinazione remoto o sul computer locale.

L'accesso da tastiera deve essere impostato nella finestra di dialogo Opzioni
sessione. Una volta attivato l'accesso da tastiera, quando è attiva la finestra
Visualizzatore video tutte le sequenze e le combinazioni di tasti a eccezione di
Ctrl-Alt-Canc saranno inviate al dispositivo di destinazione remoto visualizzato.
Quando è attivo il desktop locale, tutte le sequenze e le combinazioni di tasti
digitate dall'utente avranno effetto sul computer locale.

La combinazione da tastiera Ctrl-Alt-Cancpuò essere inviata a un dispositivo di
destinazione solo tramite unamacro.

La combinazione di tasti ALT-Han/Zen della tastiera giapponese viene sempre inviata a
un dispositivo di destinazione remoto, a prescindere dalla modalità dello schermo o
dall'impostazione dell'accesso da tastiera.

Per impostare l'accesso da tastiera:

1. Scegliere Strumenti > Opzioni sessione nel menu della finestra
Visualizzatore video.

- oppure -

Fare clic sul pulsante Opzioni sessione.

Verrà visualizzata la finestra di dialogo Opzioni sessione.

2. Scegliere la scheda Generale.

3. Selezionare Passthrough attivo per tutti i tasti in modalità finestra regolare.
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4. Fare clic su OK per salvare l'impostazione.

4.13 Macro
Nell'interfaccia OBWI dello switch sono disponibili macro preconfigurate per le
piattaforme Windows, Linux e Sun.

Per inviare una macro scegliere Macro - <macro di interesse> nel menu della
finestra Visualizzatore video oppure fare clic sul pulsante della macro di
interesse nel menu del Visualizzatore video.

4.14 Salvataggio della visualizzazione
È possibile salvare una visualizzazione del Visualizzatore video in un file oppure
negli Appunti per incollarla in un programma di elaborazione testi o di altro tipo.

Per acquisire la finestra Visualizzatore video in un file:

1. Scegliere File - Acquisisci in file nel menu della finestra Visualizzatore video.

- oppure -

Fare clic sul pulsante Acquisisci in file.

Verrà visualizzata la finestra di dialogo Salva con nome.

2. Immettere un nome per il file e scegliere la destinazione per il salvataggio.

3. Fare clic su Salva per salvare la visualizzazione nel file.

Per acquisire la finestra Visualizzatore video negli Appunti scegliere File >
Acquisisci in appunti nel menu della finestra Visualizzatore video oppure fare clic
sul pulsante Acquisisci in appunti. I dati dell'immagine saranno salvati negli
Appunti.

4.15 Chiusura di una sessione
Per chiudere la sessione di una finestra Visualizzatore video:

Scegliere File - Esci nella finestra Visualizzatore video.
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Il protocollo indipendente LDAP viene utilizzato per l'accesso e l'inoltro di query
alle directory e per l'aggiornamento delle directory tramite il protocollo TCP/IP. Il
protocollo LDAP si basa sul modello X.500 Directory Services ed è una struttura
di directory globale che supporta funzionalità di protezione avanzate quali
l'autenticazione, la tutela della privacy e l'integrità.

Se i singoli account utente sono memorizzati in un servizio di directory
compatibile con il protocollo LDAP, per esempio Active Directory, per
l'autenticazione degli utenti è possibile utilizzare il servizio di directory. I valori
predefiniti forniti per i parametri di query e ricerca LDAP vengono definiti per
Active Directory.

Le impostazioni nell'interfaccia OBWI consentono di configurare i parametri di
configurazione dell'autenticazione. Il nome utente, la password e altre
informazioni vengono quindi inviate automaticamente all'accessorio per
determinare se l'utente è autorizzato a visualizzare o modificare i parametri di
configurazione dell'accessorio nell'interfaccia OBWI.

Se non altrimenti specificato e se la configurazione diActive Directory non è stata
modificata, si consiglia di utilizzare i valori LDAPpredefiniti. Lamodifica dei valori
predefiniti può causare errori di comunicazione con il server di autenticazione LDAP.

5.1 Configurazione del protocollo LDAP tramite
l'interfaccia utente
La pagina di panoramica LDAP dell'interfaccia OBWI consente di configurare la
priorità dell'autenticazione LDAP e i parametri di definizione delle informazioni di
connessione al server LDAP.

Parametri della panoramica LDAP

Priorità dell'autenticazione LDAP

La sezione Priorità LDAP dell'interfaccia OBWI consente di disattivare il
protocollo LDAP e di impostare la priorità di autenticazione scegliendo se viene
eseguita prima l'autenticazione locale o l'autenticazione LDAP.
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Per configurare i parametri di priorità dell'autenticazione LDAP:

1. Scegliere Accessorio > Impostazioni accessorio > Account utente > Account
LDAP > Panoramica.

2. Impostare Priorità LDAP su LDAP non attivo, LDAP prima di locale o LDAP
dopo locale.

3. Fare clic su Salva.

Server LDAP

I campi Indirizzo consentono di specificare i nomi host o gli indirizzi IP dei server
LDAP primario e secondario; il server LDAP secondario è opzionale.

I campi Porta consentono di specificare i numeri delle porte UDP (User Datagram
Protocol) che saranno utilizzate per comunicare con i server LDAP. Il valore
predefinito è 389 per un server LDAP non protetto e 636 per un server LDAP
protetto (LDAPS). Il valore ID porta predefinito viene immesso automaticamente
quando viene specificato il tipo di accesso.

I pulsanti di opzione Tipo accesso consentono di specificare la modalità con cui
una query viene inviata a ciascun dispositivo di destinazione LDAP. Se viene
selezionato LDAP, tutti i nomi utente, le password e le altre informazioni verranno
inviati dall'accessorio al server LDAP e viceversa come testo non protetto e non
crittografato. Per garantire comunicazioni protette e crittografate tra un accessorio
e il server LDAP, selezionare il pulsante di opzione LDAPS.

Per configurare i parametri del server LDAP:

1. Scegliere Accessorio > Impostazioni accessorio > Account utente > Account
LDAP > Panoramica.

2. Identificare l'indirizzo dei server primario e secondario, la porta e il tipo di
accesso utilizzando i campi e i pulsanti di opzione opportuni.

3. Fare clic su Salva.

Parametri di ricerca LDAP

La pagina di ricerca LDAP consente di configurare i parametri utilizzati per la
ricerca di utenti del servizio di directory LDAP. Nel campo Nome distinto ricerca
viene definito un utente di livello amministratore che sarà utilizzato
dall'accessorio per accedere al servizio di directory. Dopo che l'accessorio è
stato autenticato, verrà consentito l'accesso alla directory per eseguire le query di
autenticazione utente specificate nella pagina Query LDAP. I valori predefiniti
sono cn=Administrator, cn=Users, dc=DomainName e dc=com e possono essere
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modificati. Per esempio, per definire un DN (Distinguished Name) amministratore
per test.view.com, digitare cn=Administrator, cn=Users, dc=test, dc=view e
dc=com. I valori Nome distinto ricerca devono essere separati da una virgola. Il
campo Password ricerca è utilizzato per l'autenticazione dell'amministratore o
dell'utente specificato nel campo Nome distinto ricerca. Il campo Base ricerca
consente di definire un punto di partenza per le ricerche LDAP. I valori predefiniti
sono dc=DomainName e dc=com e possono essere modificati. Per esempio, per
definire una base di ricerca per test.com, digitare dc=test, dc=com. I valori Base
ricerca devono essere separati da una virgola. Il campo Maschera ID utente
consente di specificare i criteri di ricerca per le ricerche di ID utente dei dispositivi
di destinazione LDAP. Il formato predefinito è <name>=<%1>. Il valore
predefinito è sAMAccountName=%1 ed è corretto per l'uso con Active Directory.
Questo campo è obbligatorio per le ricerche LDAP.

Per configurare i parametri di ricerca LDAP:

1. Scegliere Accessorio > Impostazioni accessorio > Account utente > Account
LDAP > Ricerca.

2. Immettere le informazioni necessarie nei campi Nome distinto ricerca,
Password ricerca, Base ricerca e Maschera ID utente.

3. Fare clic su Salva.

Tali opzioni non possono esseremodificate se nella schermata di panoramica la priorità
LDAPè stata impostata su LDAPdisattivato.

Parametri delle query LDAP

La pagina Query LDAP consente di configurare i parametri che saranno utilizzati
per eseguire query di autenticazione degli utenti.

Vengono eseguiti due diversi tipi di query: mentre la Modalità query (Accessorio)
viene utilizzata per autenticare l'accesso di amministratori e utenti all'accessorio,
la Modalità query (Dispositivo di destinazione) viene utilizzata per autenticare
l'accesso di utenti ai dispositivi di destinazione collegati. Ciascun tipo di query è
dotato inoltre di tre modalità che si avvalgono di determinati tipi di informazioni
per stabilire se un utente LDAP è autorizzato ad accedere all'accessorio o ai
dispositivi di destinazione collegati. Per ulteriori informazioni su ciascuna
modalità fare riferimento a "Modalità di query accessorio e dispositivo di
destinazione" a pagina 79.

La pagina Query LDAP consente di configurare le seguenti impostazioni:
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• I parametri della Modalità query (Accessorio) determinano se un utente è
autorizzato ad accedere all'accessorio.

• I parametri della Modalità query (Dispositivo di destinazione) consentono di
determinare se a un utente sono stati assegnati diritti di accesso ai
dispositivi di destinazione collegati a un accessorio. L'utente può accedere
all'accessorio solo se il diritto di accesso è stato attribuito tramite Modalità
query (Accessorio).

• I campi Contenitore gruppo, Maschera contenitore gruppo e Maschera
destinazione sono utilizzati esclusivamente per le modalità di query gruppo
e sono obbligatori per eseguire una query accessorio o una query
dispositivo.

• Il campo Contenitore gruppo consente di specificare l'unità organizzativa
(UO) creata in Active Directory dall'amministratore per contenere gli oggetti
gruppo.

• Gli oggetti gruppo sono oggetti Active Directory che possono
comprendere utenti, computer, contatti e altri gruppi. Il campo
Contenitore gruppo viene utilizzato quando Modalità query è impostata
su Attributo gruppo. A ciascun oggetto gruppo vengono assegnati
membri da associare con un particolare livello di accesso per oggetti
membri (persone, accessori e dispositivi di destinazione). Il livello di
accesso associato a un gruppo viene configurato impostando il valore di
un attributo nell'oggetto gruppo.

• Per esempio, se la proprietà Note nell'elenco degli oggetti gruppo viene
usata per applicare l'attributo di controllo dell'accesso, è necessario
impostare il campo Attributo controllo accesso della pagina Query LDAP
su info. Se la proprietà Note viene impostata su Amministratore utenti
KVM, i membri di tale gruppo avranno un accesso di tipo amministratore
di utenti agli accessori e ai dispositivi di destinazione che sono a loro
volta membri di quello stesso gruppo.

• La proprietà Note consente di applicare l'attributo di controllo dell'accesso. Il
valore della proprietà Note, disponibile in oggetti gruppo e utente visualizzati
in Utenti e computer di Active Directory (ADUC), è memorizzato
internamente nella directory, nel valore dell'attributo info. ADUC è un
componente di Microsoft Management Console per la configurazione di
Active Directory che può essere avviato scegliendo Start > Programmi >
Strumenti di amministrazione > Utenti e computer di Active Directory. Questo
strumento consente di creare, configurare ed eliminare oggetti come utenti,
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computer e gruppi. Per ulteriori informazioni fare riferimento a "Modalità di
query accessorio e dispositivo di destinazione" a pagina 79.

• Il campo Maschera contenitore gruppo consente di definire il tipo di oggetto
del contenitore del gruppo, che di solito è un'unità organizzativa. Il valore
predefinito è “ou=%1”.

• Il campo Maschera destinazione consente di definire un filtro di ricerca per il
dispositivo di destinazione. Il valore predefinito è “cn=%1”.

• Il campo Attributo controllo accesso consente di specificare il nome
dell'attributo utilizzato quando le modalità di query sono impostate su
Attributo utente o Attributo gruppo. Il valore predefinito è info.

Per configurare i parametri di query LDAP:

1. Scegliere Accessorio > Impostazioni accessorio > Account utente > Account
LDAP > Query.

2. Impostare Modalità query (Accessorio) e Modalità query (Dispositivo di
destinazione) su Di base, Attributo utente o Attributo gruppo.

3. Immettere le informazioni necessarie nei campi Contenitore gruppo,
Maschera contenitore gruppo, Maschera destinazione e Attributo controllo
accesso.

4. Fare clic su Salva.

Tali opzioni non possono esseremodificate se nella schermata di panoramica la priorità
LDAPè stata impostata su LDAPdisattivato.

5.2 Modalità di query accessorio e dispositivo di
destinazione
Per la Modalità query (Accessorio) e per la Modalità query (Dispositivo di
destinazione) può essere utilizzata una delle tre modalità disponibili:

• Di base - Al servizio di directory viene inviata una query nome utente e
password per l'utente. Se i valori vengono confermati, all'utente vengono
concessi diritti di accesso come amministratore di accessorio all'accessorio
e a tutti i dispositivi di destinazione collegati in Modalità query (Accessorio),
oppure a qualsiasi dispositivo di destinazione selezionato in Modalità query
(Dispositivo di destinazione).

• Attributo utente - Al servizio di directory viene inviata una query nome utente,
password e attributo controllo accesso per l'utente accessorio. L'Attributo
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controllo accesso viene letto dall'oggetto utente (l'account utente) in Active
Directory.

Se viene trovato il valore Amministratore accessorio KVM, all'utente
vengono concessi diritti di accesso come amministratore di accessorio
all'accessorio e a tutti i dispositivi di destinazione collegati in Modalità
query (Accessorio), oppure a qualsiasi dispositivo di destinazione
selezionato in Modalità query (Dispositivo di destinazione).

Se viene trovato il valore Amministratore utenti KVM, all'utente vengono
concessi diritti di accesso come amministratore di utenti all'accessorio e
a tutti i dispositivi di destinazione collegati in Modalità query
(Accessorio), oppure a qualsiasi dispositivo di destinazione selezionato
in Modalità query (Dispositivo di destinazione).

Se viene trovato il valore Utente KVM, all'utente vengono concessi diritti
di accesso come utente all'accessorio in Modalità query (Accessorio),
oppure a qualsiasi dispositivo di destinazione selezionato in Modalità
query (Dispositivo di destinazione).

Se nessuno dei tre valori viene trovato, all'utente vengono concessi diritti di accesso
all'accessorio e ai dispositivi di destinazione inModalità query (Accessorio), oppure ai
dispositivi di destinazione selezionati in Modalità query (Dispositivo di destinazione), solo
se tale utente è dotato dei privilegi di amministratore di utenti o amministratore di
accessorio per l'accessorio.

Per accedere all'ADUC scegliere Start > Programmi > Strumenti di
amministrazione > Utenti e computer di Active Directory.

• Attributo gruppo - Al servizio di directory viene inviata una query nome
utente, password e gruppo per un accessorio e per i dispositivi di
destinazione collegati in Modalità query (Accessorio), oppure per un
dispositivo di destinazione in Modalità query (Dispositivo di destinazione). In
Modalità query (Accessorio), se viene trovato un gruppo che contiene il
nome utente e il nome dell'accessorio, all'utente vengono concessi diritti di
accesso all'accessorio o ai dispositivi di destinazione collegati, a seconda
del contenuto del gruppo. Se è stata selezionata la Modalità query
(Dispositivo di destinazione) e viene individuato un gruppo che contiene gli
ID dell'utente e del dispositivo di destinazione, all'utente vengono concessi i
diritti di accesso al dispositivo di destinazione selezionato e collegato
all'accessorio.

È possibile nidificare i gruppi fino a una profondità massima di 16 livelli.
La nidificazione consente di creare gruppi all'interno di altri gruppi. Per
esempio, può esistere un gruppo di livello principale denominato
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Computer che contiene un membro denominato Ricerca e sviluppo, che
a sua volta è un gruppo; il gruppo Ricerca e sviluppo può contenere un
membro denominato Nazionale che è a sua volta un gruppo e così via.

5.3 Impostazione di Active Directory per
l'esecuzione di query
Prima di utilizzare le modalità query per le unità è necessario modificare Active
Directory in modo che la modalità query selezionata possa assegnare il livello di
autorizzazione corretto per l'utente.

Per impostare le query gruppo:

1. Accedere a Windows con diritti di amministratore.

2. Avviare il software Active Directory.

3. Creare un'unità organizzativa da utilizzare come contenitore dei gruppi.

4. In Active Directory creare un oggetto computer con nome identico al nome
del sistema di commutazione per inviare query agli accessori (specificato
nella schermata di panoramica dell'accessorio dell'interfaccia OBWI), oppure
identico ai dispositivi di destinazione collegati per inviare query ai dispositivi
di destinazione. Il nome deve corrispondere perfettamente, incluse le lettere
maiuscole e minuscole.

5. I nomi degli accessori e dei dispositivi di destinazione usati per le query
gruppo vengono memorizzati nell'accessorio. Il nome dell'accessorio
specificato nella schermata di panoramica dell'accessorio dell'interfaccia
OBWI e i nomi dei dispositivi di destinazione devono essere identici ai nomi
degli oggetti in Active Directory. I nomi di accessori e dispositivi di
destinazione possono essere formati da qualunque combinazione di lettere
maiuscole e minuscole (a-z, A-Z), numeri (0-9) e trattini (-). non è possibile
utilizzare spazi e punti (.), né creare un nome che comprenda solo cifre. Tali
limitazioni sono imposte da Active Directory.

Il nome predefinito di versioni precedenti contiene uno spazio che deve essere eliminato
modificando il nome del sistema di commutazione nella schermata di panoramica
dell'accessorio dell'interfaccia OBWI.

6. Creare uno o più gruppi nell'unità organizzativa che funge da contenitore dei
gruppi.
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7. Aggiungere i nomi utente e gli oggetti dispositivo di destinazione/accessorio
ai gruppi creati nella fase 5.

8. Specificare il valore di tutti gli attributi usati per applicare l'attributo di
controllo dell'accesso. Per esempio, se si utilizza l'attributo info nel campo
Attributo controllo accesso e la proprietà Note nell'oggetto gruppo per
applicare l'attributo di controllo dell'accesso, il valore dell'attributo Note in
Active Directory può essere impostato su uno dei tre livelli di accesso
disponibili (Utente KVM, Amministratore utenti KVM e Amministratore
accessorio KVM) per l'oggetto gruppo. I membri del gruppo saranno così in
grado di accedere agli accessori e ai dispositivi di destinazione con il livello
di accesso specificato.

Se nessuno dei tre valori viene trovato, all'utente vengono concessi diritti di accesso
come utente a tutti gli accessori o dispositivi di destinazione elencati nel gruppo con tale
nome utente.
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Ogni switch può essere configurato anche a livello di accessorio per

mezzo dell'interfaccia del menu della console, a cui è possibile

accedere tramite la porta SETUP. Tutti i comandi del terminale sono

accessibili attraverso un terminale o un computer su cui è in

esecuzione un software di emulazione terminale.

NOTE: si consiglia di eseguire tutte le impostazioni di configurazione nell'interfaccia
utente locale.

Per collegare un terminale allo switch:

1. Utilizzare l'adattatore da RJ-45 a DB-9 (femmina) e il cavo UTP

in dotazione e collegare un terminale o un computer su cui è in

esecuzione un software di emulazione terminale (per esempio

HyperTerminal) alla porta SETUP sul pannello posteriore dello

switch. Il terminale deve essere impostato su 9600 bps, 8 bit, 1 bit

di stop, nessuna parità e nessun controllo di flusso.

2. Accendere prima tutti i dispositivi di destinazione e poi lo switch.

Una volta completata l'inizializzazione dello switch, nel menu

della console sarà visualizzato il messaggio Press any key to

continue.

Opzioni del menu di avvio della console
Per visualizzare il menu di avvio, premere un tasto qualsiasi durante

l'accensione dello switch. Nel menu sono disponibili quattro opzioni.

• Boot Normal

• Boot Alternate Firmware

• Reset Factory Defaults

• Full-Factory Reset

Opzioni del menu principale della console
Dopo l'accensione nel menu principale sono visualizzati il nome e la

versione del prodotto. Nel menu sono disponibili quattro opzioni.

• Network configuration: consente di configurare l'impostazione di

rete dell'accessorio.
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• Messaggi di debug: consente di attivare i messaggi di stato della

console. Poiché questa funzione può ridurre notevolmente le

prestazioni, attivare i messaggi di debug solo su richiesta del

personale dell'assistenza tecnica Fujitsu. Dopo avere visualizzato i

messaggi, premere un tasto qualsiasi per uscire dalla modalità.

• Reset Appliance: consente di eseguire il ripristino soft dello

switch.

• Exit: consente di tornare alla finestra iniziale. Se è stata attivata la

password dell'interfaccia del menu della console, è necessario

uscire dal menu principale della console affinché venga

visualizzata la schermata di accesso con la richiesta di nome

utente e password per l'utente successivo.
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Appendice B: Utilizzo dei cavi adattatore KVM
s4 seriali
Utilizzo dei cavi adattatore KVM s4 seriali

È possibile scegliere lo schema pin di tipo console server ACS o

Cisco per ciascuna porta cavo adattatore seriale utilizzando

l'interfaccia utente locale o l'interfaccia OBWI remota; l'impostazione

predefinita è ACS.

Per impostare lo schema pin Cisco:

1. Scegliere Vista unità - Accessorio - Impostazioni accessorio -

Porte > Cavi adattatore.

2. Fare clic sul cavo o sui cavi adattatore seriali di interesse.

3. Scegliere Impostazioni > Schema pin.

NOTA: se è in uso l'adattatore DB-9, selezionare gli schemi pin console server ACS.

Schema pin della porta server console ACS

Nella tabella che segue è riportato lo schema pin della porta seriale

console server ACS per il cavo cavo adattatore seriale.

N. pin Nome segnale Ingresso/uscita

1 RTS - Request to Send OUT

2 DTR - Data Terminal
Ready OUT

3 TXD - Transmit Data OUT

4 GND - SignalGround N/A

5 CTS - Clear to Send IN

6 RXD - Receive Data IN

7 DCD/DSR - Data Set
Ready IN

8 N/C - Not Connected N/A

Tabella B.1. Schema pin della porta seriale server console ACS
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Schema pin della porta Cisco

Nella tabella che segue è riportato lo schema pin della porta seriale

Cisco per il cavo cavo adattatore seriale.

N. pin Nome segnale Ingresso/uscita

1 CTS - Clear to Send IN

2 DCD/DSR - Data Set
Ready IN

3 RXD - Receive Data IN

4 GND - SignalGround N/A

5 N/C - Not Connected N/A

6 TXD - Transmit Data OUT

7 DTR - Data Terminal
Ready OUT

8 RTS - Request to Send OUT

Tabella B.2. Schema pin della porta seriale Cisco
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Appendice C: Cavi UTP
In questa appendice vengono discussi vari aspetti dei supporti di

collegamento. Il sistema di commutazione KVM s4 utilizza il

cablaggio UTP. Le prestazioni di un sistema di commutazione

dipendono dalla buona qualità dei collegamenti. Cablaggi di scarsa

qualità oppure installazioni o interventi di manutenzione non corretti

possono infatti ridurre le prestazioni del sistema.

NOTA: i contenuti della presente appendice devono essere intesi a solo scopo
informativo. Prima di qualsiasi installazione consultare le normative locali e/o
consulenti che si occupano di cablaggi.

Cavi UTP in rame
Di seguito vengono riportate le definizioni di base dei tre tipi di cavi

UTP supportati dallo switch KVM s4:

• Il cavo CAT5 (a 4 doppini) ad alte prestazioni è composto da

conduttori a doppini intrecciati e viene utilizzato principalmente

per la trasmissione dei dati. I doppini intrecciati garantiscono una

certa schermatura delle interferenze indesiderate. I cavi CAT5

vengono utilizzati di solito per reti a 10 o 100 Mbps.

• Il cavo CAT5E (migliorato) è dotato delle stesse caratteristiche

del cavo CAT5, ma viene prodotto seguendo standard più

rigorosi.

• Il cavo CAT6 viene prodotto secondo standard ancora più rigorosi

rispetto al cavo CAT5E. Il cavo CAT6 offre una gamma di

frequenze più alte e prestazioni superiori rispetto al cavo CAT5E

alle stesse frequenze.

Standard di cablaggio
Esistono due standard di cablaggio per i cavi UTP a 8 conduttori (4

doppini) dotati di connettori RJ-45: EIA/TIA 568A e B. Tali standard

vengono applicati alle installazioni che utilizzano le specifiche di

cablaggio CAT5, CAT5E e CAT6. Il sistema di commutazione KVM

 s4 supporta entrambi questi standard di cablaggio. Nella seguente

tabella sono descritti gli standard per ciascun pin.
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Pin EIA/TIA 568A EIA/TIA 568B

1 bianco/verde bianco/arancione

2 verde arancione

3 bianco/arancione bianco/verde

4 blu blu

5 bianco/blu bianco/blu

6 arancione verde

7 bianco/marrone bianco/marrone

8 marrone marrone

Tabella C.1. Standard di cablaggio UTP

Suggerimenti per l'installazione, la manutenzione e la
sicurezza dei cavi

Di seguito viene presentato un elenco di importanti considerazioni per

la sicurezza. Se ne consiglia la lettura prima di procedere con

l'installazione o la manutenzione dei cavi.

• Mantenere la lunghezza massima di tutti i cavi UTP al di sotto di

10 metri.

• Mantenere l'intreccio dei doppini per tutta la lunghezza fino

all'estremità, oppure mantenere la lunghezza della sezione non

intrecciata al di sotto di 1,25 cm. Non rimuovere più di 2,5 cm di

rivestimento all'estremità.

• Se è necessario piegare il cavo, la curvatura deve essere graduale

con un raggio non inferiore a 2,5 cm. La formazione di curvature

strette o pieghe accidentali del cavo può danneggiare

permanentemente l'interno del cavo.

• Applicare fascette ai cavi, utilizzando una pressione leggera o

moderata. Non serrare eccessivamente le fascette.

• Se necessario, incrociare i cavi utilizzando blocchi di cablaggio,

quadri a spine e altri componenti. Non congiungere i cavi e non

creare ponti in nessun punto.
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• Mantenere il cavo CAT 5 il più lontano possibile da potenziali

fonti di interferenze elettromagnetiche, quali cavi elettrici,

trasformatori e impianti di illuminazione. Non fissare i cavi a

condotti elettrici e non disporli su impianti di illuminazione.

• Effettuare sempre un test di ciascun segmento installato

utilizzando un tester per cavi. Il solo controllo del tono non

rappresenta un test accettabile.

• Installare sempre jack per impedire alla polvere e ad altri corpi

estranei di depositarsi sui contatti. I contatti dei jack devono

essere rivolti verso l'alto se si utilizzano piastre incassate oppure a

sinistra/destra/verso il basso se si utilizzano scatole cavi.

• Lasciare sempre un lasco sufficiente per i cavi e avvolgerli in

modo ordinato nel controsoffitto oppure in anfratti vicini. Lasciare

almeno 1,5 metri dal lato della presa e 3 metri dal lato del

pannello dei collegamenti.

• Scegliere lo standard di cablaggio 568A o 568B prima di iniziare.

Collegare tutti i jack e i pannelli di collegamento in base allo

stesso schema di cablaggio. Non utilizzare schemi di cablaggio

misti 568A e 568B nella stessa installazione.

• Attenersi sempre alle normative locali e nazionali in materia di

costruzioni e prevenzione degli incendi. Installare parafiamma su

tutti i cavi che attraversano un muro tagliafuoco. Utilizzare cavi

con classificazione Plenum quando richiesto.
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Appendice D: Informazioni sullo schema pin dei
cavi

NOTA: su tutti gli switch sono presenti connettorimodulari a 8 pin per ilmodem e le
porte di console/impostazione.

Figura D.1. Connettore per modem

Pin Descrizione Pin Descrizione

1
Request to
Send (RTS)

5 Transmit Data (TXD)

2
Data Set
Ready (DSR)

6 SignalGround (SG)

3
Data Carrier
Detect (DCD)

7 Data TerminalReady (DTR)

4
Receive Data
(RXD)

8 Clear to Send (CTS)

Tabella D.1. Descrizioni relative alla Figura D.1

Figura D.2. Connettore di console/impostazione
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Pin Descrizione Pin Descrizione

1
NoConnection
(N/C)

5 Transmit Data (TXD)

2
NoConnection
(N/C)

6 SignalGround (SG)

3
NoConnection
(N/C)

7 NoConnection (N/C)

4
Receive Data
(RXD)

8 NoConnection (N/C)

Tabella D.2. Descrizioni relative alla Figura D.2
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Appendice E: Caratteristiche tecniche

Porte server

Numero

KVM s4-0812: 8

KVM s4-1622: 16

KVM s4-3242: 32

Tipo PS/2, USB, Sun e seriale

Connettori Modulari a 8 pin

Tipi di sincronizzazione Orizzontale e verticale separate

Risoluzione video in
ingresso

Standard

640 x480 a 60 Hz

800 x600 a 75 Hz

960 x700 a 75 Hz

1024 x768 a 75 Hz

1280 x1024 a 75 Hz

1600 x1200 a 60 Hz

Widescreen

800 x500 a 60 Hz

1024 x640 a 60 Hz

1280 x800 a 60 Hz

1440 x900 a 60 Hz

1680 x1050 a 60 Hz

Cavi supportati
Cavo UTPoCAT 6 a 4 doppini, lunghezzamassima
45metri

Dimensioni

Tabella E.1. Caratteristiche tecniche
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Porte server

Fattore di forma 1U installabile su rack

Dimensioni 1,72 x17,00 x9,20 (altezza x larghezza xprofondità)

Peso (senza cavi)

KVM s4-0812: 3,0 kg

KVM s4-1622: 3,2 kg

KVM s4-3242: 3,4 kg

Porta SETUP

Numero 1

Tipo Seriale RS-232

Connettore Modulare a 8 pin

Porta locale

Numero/tipo 1 VGA/4 USB

Connessione di rete

Numero 2

Tipo 10/100/1000 Ethernet

Connettore Modulare a 8 pin

Porta dispositivi USB

Numero 4

Tipo USB2.0

Porta MODEM

Numero 1

Tipo Seriale RS-232
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Porte server

Connettori Modulari a 8 pin

Porta PDU

Numero 2

Tipo Seriale RS-232

Connettore Modulare a 8 pin

Caratteristiche di alimentazione

Connettori 2

Tipo Interna

Potenza

KVM s4-0812: 13 W

KVM s4-1622: 18 W

KVM s4-3242: 24 W

Dispersione di calore

KVM s4-0812: 45,4 kJ/h

KVM s4-1622: 47,5 kJ/h

KVM s4-3242: 49,6 kJ/h

Tensione di ingresso
c.a.

100-240 V c.a.

Frequenza c.a. 50/60 Hz, rilevazione automatica

Valore nominale
corrente di ingresso
c.a.

1,25 A

C.a. di ingresso
(massima)

40W

Condizioni atmosferiche e ambientali
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Porte server

Temperatura
Operativa: da 0 a 50 °C

Immagazzinamento: da -20 a 70 °C

Umidità

Operativa: umidità relativa da 20%a 80%, senza
condensa

Immagazzinamento: umidità relativa da 5%a 95%,
temperatura di bulbo umidomassima 38,7 °C

Marchi e
certificazioni degli
standard EMC e di
sicurezza

UL, FCC, cUL, ICES-003, CE, VCCI, KCC, C-Tick,
GOST

Le certificazioniEMC e di sicurezza per questo
prodotto possono essere ottenute in conformità a una
o più delle seguenti categorie: CMN (Certification
ModelNumber, numero di certificazione delmodello),
MPN (Manufacturer'sPart Number, numero pezzo
del produttore) o certificazione delmodello a livello di
distribuzione. La categoria dichiarata nei rapporti e
nelle certificazioniEMC e/o di sicurezza è riportata
sull'etichetta applicata sul prodotto.
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Appendice F: Emulazione avanzata di tasti Sun
Determinati tasti disponibili su una tastiera Sun di tipo 5 (US)

standard possono essere emulati per mezzo di sequenze di tasti sulla

tastiera USB collegata alla porta locale. Per attivare la modalità di

emulazione avanzata dei tasti Sun e utilizzare tali tasti, tenere premuto

Ctrl+Maiusc+Alt e quindi premere Bloc Scorr. La spia Bloc Scorr
lampeggia. Usare i tasti indicati nella tabella seguente come se fossero

i tasti avanzati di una tastiera Sun. Per esempio: per Stop + A, tenere
premuto Ctrl+Maiusc+Alt e premere Bloc Scorr, quindi F1 + A.

Queste combinazioni di tasti funzionano con i cavi adattatore KVM

 s4 USB20-VGA e non vengono riconosciute da Microsoft Windows,

a eccezione di F12; il tasto F12 esegue la funzione predefinita in

Windows.

Dopo avere finito tenere premuto Ctrl+Maiusc+Alt e premere Bloc

Scorr per disattivare la modalità di emulazione avanzata dei tasti Sun.

Tasto Sun (US) Tasto per attivare emulazione di tastiera Sun

Componi Applicazione(1)

Componi tastierino numerico

Accensione F11

Apri F7

Guida BlocNum

Proprietà F3

Avanti F5

Stop F1

Ancora F2

Annulla F4

Taglia F10

Copia F6

Tabella F.1. Emulazione di tasti Sun
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Tasto Sun (US) Tasto per attivare emulazione di tastiera Sun

Incolla F8

Trova F9

Interruzione suono / (tastierino numerico)

Vol.+ + (tastierino numerico)

Vol.- - (tastierino numerico)

Command
(sinistro)(2) F12

Command
(sinistro)(2) TastoWin (GUI) sinistro(1)

Command
(destro)(2) TastoWin (GUI) destro(1)

NOTEFINALI:

(1) TastieraWindows95 a 104 tasti.

(2) Il tasto Command è il tasto SunMeta (rombo).
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Appendice G: Servizio di assistenza tecnica
Fujitsu mette a disposizione un'ampia gamma di risorse per il supporto

o l'assistenza tecnica, o per ulteriori informazioni sui prodotti Fujitsu.

La presente sezione fornisce informazioni su come ottenere ulteriori

informazioni su Fujitsu e sui prodotti Fujitsu, su cosa fare in caso di

problemi al sistema in uso e su chi contattare per l'assistenza.

Prima di rivolgersi al servizio di assistenza
Prima di rivolgersi al servizio di assistenza, eseguire i seguenti

controlli per tentare di risolvere il problema:

• Controllare tutti i cavi e verificare che siano collegati.

• Controllare gli interruttori di alimentazione per verificare che il

sistema e tutti i dispositivi siano accesi.

• Utilizzare le informazioni per la risoluzione dei problemi

contenute nella documentazione del sistema e utilizzare gli

strumenti di diagnostica in dotazione con il sistema. Le

informazioni sugli strumenti di diagnostica sono disponibili nella

guida per l'individuazione dei problemi e la manutenzione

contenuti nel CD della documentazione Fujitsu in dotazione con

il sistema.

• Visitare il sito Web di supporto Fujitsu all'indirizzo

http://www.ts.fujitsu.com/support/ per consultare le informazioni

tecniche, i suggerimenti, i consigli e verificare la disponibilità di

nuovi driver per i dispositivi, oppure inviare una richiesta di

informazioni.

Molti problemi possono essere risolti senza assistenza esterna

seguendo le procedure per la risoluzione dei problemi fornite da

Fujitsu nella guida in linea o nella documentazione allegata al

prodotto Fujitsu in uso. Nella documentazione allegata ai sistemi

Fujitsu sono descritti anche i test diagnostici che possono essere

eseguiti. Alla maggior parte dei sistemi, dei sistemi operativi e dei

programmi è allegata la documentazione che contiene la descrizione

delle procedure per la risoluzione dei problemi e le spiegazioni dei

messaggi e dei codici di errore. Se si sospetta la presenza di un

problema di software, consultare la documentazione relativa a quel

particolare sistema operativo o programma.
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1. 製品概要

1.1 特性・特長

富士通のKVM series4-0812/1622/3242スイッチでは、アナログとデジタルの技術を組み

合わせることにより、データ･センター･サーバー、およびバーチャル・メディアのフレキシ

ブルな中央集中の管理が可能となり、さらに専門のIT要員が不在の場合でも遠隔地の

ブランチ･オフィスに対する運用、起動、保守の円滑化も図ることができます。IPベース

のKVM s4スイッチの使用により、フレキシブルなターゲット・デバイス管理とセキュアな

リモート･アクセスがいつでもどこからでも実行できます。

KVM s4スイッチは、企業のお客様を対象に次の特長とオプションを提供します。

• ケーブル量を大幅に低減

• キーボード／ビデオ／マウス統合機能(KVM)、アナログ(ローカル)またはデジタル(

リモート)接続用に構成可能

• セキュア・シェル(SSH)およびTelnetによるトゥルー・シリアル機能

• ビデオ解像度のサポート強化により、ターゲットからリモートにネーティブで最

大1600 x 1200または1680 x 1050(ワイドスクリーン)対応

• USBポートを介してアクセスするバーチャル・メディア機能

• 独立したデュアル・ローカル・ポート・ビデオ・パス(ACI専用)

• 同時アクセスのためのデュアル・スタックIPv4(DHCP)およびIPv6(DHCPv6およびス

テートレス自動構成)

• CCID準拠のスマート・カード・リーダー対応

• 10/100または1000BaseT LANポートを経由してターゲット・デバイスへアクセス可

能

• イーサネット接続が利用できない場合でも、V.34、V.90、V.92対応モデムをサポート

するモデム・ポートによりスイッチへのアクセスが可能

ケーブル量の低減

サーバーの高密度化に伴い、ネットワーク管理者にとってはケーブル量が大きな考慮事

項となっています。KVM s4スイッチは、革新的なバーチャル・メディア変換オプション・

ケーブルと単一の、業界標準である非シールド・ツイスト・ペア(UTP)ケーブルを活用し

て、ラック内のKVMケーブル量を大幅に削減します。これによって、気流を大きくし、冷却

能力を増やしながら、サーバー密度をさらに高めることができます。
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KVMスイッチ機能

KVM s4スイッチは、ターゲット・デバイスから直接電力が供給されるアダプター・ケーブ

ルをサポートしているため、スイッチに電源が入っていないときも「キープ・アライブ」機能

を提供します。次のアダプター・ケーブルがサポートされています：KVM s4アダプ

ターUSB20-VGAおよびKVM s4アダプター・シリアル・ケーブル。

トゥルー・シリアル機能

KVM s4スイッチは、Secure Shell (SSH)またはTelnetを介してトゥルー・シリアル機能を提

供するKVM s4アダプター・シリアル・ケーブルに対応しています。SSHセッションを起動

するか、あるいはOBWI(On-Board Web Interface)からシリアル・ビューアを立ち上げ

て、KVM s4アダプター・シリアル・ケーブルでKVM s4スイッチに接続されているターゲッ

トに接続することができます。

ローカルおよびリモート・ユーザー・インターフェイス

ローカル・ポートに直接接続することにより、ローカル・ユーザー・インターフェイス(ローカ

ルUI)を使用してKVM s4スイッチを管理できます。リモートのOBWIを使用して、スイッチを

管理することもできます。OBWIはWebブラウザ・ベースであり、スイッチから直接起動さ

れます。また、KVM s4スイッチに接続されているすべてのデバイスが自動的に検出され

ます。最適なユーザー・エクスペリエンスが得られるように、上記の2つのユーザー・イン

ターフェイスで同じ外観が使われています。

バーチャル・メディアとスマート・カード対応スイッチの制御

KVM s4スイッチにより、あらゆるターゲット・デバイス間で、バーチャル・メディアのデー

タを表示、移動、コピーできます。オペレーティング・システムのインストール、オペレーテ

ィング・システムのリカバリ、ハード・ドライブのリカバリや複製、BIOSの更新、ターゲット・

デバイスのバックアップが可能になり、リモート・システムを効率よく管理できます。

KVM s4スイッチでは、ご使用のスイッチ・システムとスマート・カードを組み合わせて使

用することができます。スマート・カードは情報を格納および処理するポケット・サイズの

カードです。CAC(Common Access Card)などのスマート・カードは、コンピューターやネ

ットワークにアクセスしたり、セキュリティで保護された部屋やビルに入るためのIDや認

証を格納するために使用できます。

バーチャル・メディアおよびスマート・カード･リーダーは、スイッチにあるUSBポートを使

用してスイッチに直接接続できます。さらに、バーチャル・メディアおよびスマート・カー

ド・リーダーは、リモートのOBWI、Avocent® DSView® 3管理ソフトウェアのいずれかを実

行している任意のリモート・ワークステーションに接続でき、イーサネット接続を使用して

スイッチに接続されます。

590-1058-640A2



1.1 特性・特長

ターゲット・デバイスでバーチャル・メディア・セッションを開くには、はじめにアダプター・

ケーブルを使用してターゲット・デバイスをスイッチに接続する必要があります。スマート・

カードの場合、最初にスマート・カード対応のアダプター・ケーブルを使用してターゲット・デ

バイスをスイッチに接続する必要があります。

標準TCP/IPネットワークを介したスイッチへのアクセス

スイッチはエージェントレスのリモート制御およびアクセスが可能です。接続されたサー

バーまたはクライアントに特別のソフトウェアやドライバーをインストールする必要はあり

ません。

クライアントは、インターネット・ブラウザを使用してスイッチに接続します。

スイ ッ チおよび すべて の接続されているシス テ ム には、 イー サネッ ト ま た

はV.34、V.90、V.92のいずれかのモデム経由でクライアントからアクセスできます。クラ

イアントは、有効なネットワーク接続さえ確立されていればどこにでも設置できます。

DSView 3管理ソフトウェア・プラグイン

スイッチでDSView 3管理ソフトウェアを使用すると、IT管理者が単一のWebベースの

ユーザー・インターフェイスから、複数のプラットフォームにあるターゲット・デバイスへの

アクセス、監視、および制御をリモートで行うことが可能になります。詳細について

は、KVM s4スイッチ用DSView 3ソフトウェア・プラグインの技術告示を参照してください。
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1.製品概要

1.2 構成例

図1.1.スイッチ構成の例

表 1.1. 図 1.1の説明

番号 説明 番号 説明

1 CAT 5接続 7 電話回線ネットワーク

2 スイッチへ

のKVM接続
8 イーサネット

3 リモート IP接
続

9 DSView 3ソフトウェア・サーバー

4 サーバーのラ

ック
10 アナログ・ユーザー(ローカルUI)
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1.2 構成例

番号 説明 番号 説明

5 KVM s4スイッ

チ
11 デジタル･ユーザー(インターネット･ブラウザ、リモー

トOBWIを備えたコンピューター)

6 モデム
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1.製品概要
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2. インストール

2.1 KVM s4スイッチの接続性

KVM s4スイッチでは、スイッチに接続されているオペレーターとターゲット・デバイス間

で、KVM情報とシリアル情報を送信します。これは、イーサネットまたはモデム接続を使

用してネットワークを介して送られます。

KVM s4スイッチではイーサネットの通信にTCP/IPを使用します。最適なシステム・パフ

ォーマンスのためには、専用スイッチ付き100BaseTネットワークまたは1000BaseTネット

ワークを使用します。10BaseTイーサネットを使用することもできます。

KVM s4スイッチでは、V.34、V.90、V.92のモデムを介する通信にポイント・ツー・ポイント・

プロトコル(PPP)を使用します。OBWIまたはDSView 3ソフトウェアを使用して、KVMおよ

びシリアル・スイッチ・タスクを実行できます。DSView 3ソフトウェアの詳細について

は、http://www.avocent.com/fujitsuを参照してください。

図 2.1にスイッチの基本構成の例を示します。説明については、表 2.1を参照してくださ

い。
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2.インストール

図2.1. KVM s4-3242スイッチを使用した基本構成スイッチ

表 2.1. 図 2.1の説明

番号 説明 番号 説明

1 デジタル・ユーザー 8 電源コード

2 電話回線ネット

ワーク
9 ポート1～32
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2.1 KVM s4スイッチの接続性

番号 説明 番号 説明

3 ネットワーク 10 ローカルUSB接続

4 モデム 11 電源管理装置

5 アナログ・ユーザー 12 ターゲット・デバイス1～32

6 外部バーチャル・メ

ディア
13 アダプター・ケーブル

7 KVM s4-3242スイ

ッチ

はじめに

スイッチのインストールを始める前に、下記の一覧を参照し、スイッチの同梱品、さらに

正しくインストールする上で必要なアイテムがすべて揃っていることを確認してください。

スイッチの同梱品

• ラック収納ブラケット・キット

• ラック収納用金具クイック・インストール・ガイド

• KVM s4クイック・インストール・ガイド

• 安全性および法規制関連文書ガイド

• モデムとSETUPポート用ケーブルおよびアダプター

• AC電源コード

その他の必要品目

• ターゲット･デバイス1台につきアダプター・ケーブル1本

• シリアル・デバイス1台につきシリアル・アダプター1個

• アダプター・ケーブル1本につきUTPパッチ・ケーブル1本(UTP4対、最長45 m)

• ネットワーク接続用UTPパッチケーブル(UTP4対、最長45 m)

• ターゲット・デバイス1台につきバーチャル・メディア対応アダプター・ケーブル1本、

バーチャル・メディア・セッション用

• ターゲット・デバイス1台につきスマート・カード対応アダプター・ケーブル1本、ス

マート・カード制御用
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2.インストール

使用ネットワークの設定

スイッチはIPアドレスを使用して、スイッチとターゲット・デバイスを個別に識別しま

す。KVM s4スイッチは、Dynamic Host Configuration Protocol(DHCP)と静的IPアドレス

の両方をサポートしています。IPアドレスを各スイッチに予約して、スイッチがネットワー

クに接続している間、各IPアドレスは静的のままになるようにします。

2.2 KVM s4スイッチのラック収納

ラック収納用キットが各スイッチに付属しています。スイッチは、ラック型のシェルフに配

置するか、または米国電子工業会(EIA)規格のラックに直接取り付けることができます。

スイッチは、1Uまたは0U構成でラックに収納できます。

機器をラック収納する際の安全措置

• ラックへの収納について：ラックに過負荷や不均一な負荷をかけると、棚やラックの

故障の原因となり、機器および身体に対する損傷を引き起こすことがあります。設

置を始める前に、まず最終設置箇所にラックを固定させてください。コンポーネントを

ラックの底部から収納していき、上に向かって作業を続けてください。ラックの荷重

定格を超えてはいけません。

• 電源に関する注意事項：装置指定の電源以外には接続しないでください。複数の電

気コンポーネントをラックに設置する場合は、コンポーネントの総出力定格が回路容

量を超えないことを確認してください。電源および延長コードが過負荷状態となると、

火災やショックの危険性が生じます。

• 周辺温度の上昇：密閉型のラック・アッセンブリーに設置する場合、ラック収納環境

の作動温度が室温より高くなることがあります。スイッチの定格最高周辺温度を超

えないよう注意してください。

• 通気の減少：ラックに装置を設置する際には、機器の安全な動作に必要な気流の

量が損なわれないよう配慮する必要があります。

• 確実なアース処理：ラックに取り付けられた装置については、常時確実なアースを

確保してください。分岐回路に対し直接接続以外の給電接続を行う場合(例：テーブ

ルタップの使用)は、特に注意を払う必要があります。

• リア・パネルが下向きになった状態で製品を収納しないでください。

ラック収納用金具の取り付けに関する詳しい説明については、「KVM s4クイック・インスト

レーション・ガイド」を参照してください。
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2.3 スイッチ・ハードウェアの接続

2.3 スイッチ・ハードウェアの接続

スイッチを接続して電源を投入するには：

富士通製品の使用時に起こり得るビデオ／キーボード関連の問題を回避するには：建物

に3相AC電源がある場合は、コンピューターとモニターが同じ相になっていることを確認し

ます。最良の結果を得るには、両者を同一回路に接続してください。

警告：使用機器への電気ショックや損傷の危険を回避するには：

-電源コードの接地プラグを無効にしないでください。接地プラグは安全上重要な役割を

果たします。

-電源コードを常時使用できる接地処理されたコンセントに接続します。

-電源コードを電気コンセントあるいは製品から抜いて、製品の電源の接続を切ります

-本製品をオフにするには、通常、ACコンセントからコードを抜いてください。AC電源取入

口が複数ある製品の場合は、電源を完全に取り除くために、すべてのACコードの接続を

外してください。

-本製品では、製品フレーム内にユーザーが修理可能な部品はありません。製品のカ

バーを開けたり取り外したりしないでください。

1. VGAモニター、USBキーボード、およびマウスのケーブルをラベル付きの適切な

ポートに接続します。

2. スイッチの使用可能なポートを選択します。UTPケーブル(4ペア、45 m)長まで)の一

方の端を、番号が付いているポートに差し込みます。ケーブルのもう片方の端を、ア

ダプター・ケーブルのRJ-45コネクターに差し込みます。

3. アダプター・ケーブルをターゲット・デバイス背面の適切なポートに接続します。接

続するすべてのターゲット・デバイスについてこの手順を繰り返します。

SunMicrosystemsのターゲット・デバイスに接続する際は、VGAとSync onGreenの両方また

はComposite Sync(複合同期)機能を備えたSunコンピューターに対応するため、ローカル・

ポートで必ずマルチシンク・モニターを使用してください。

4. 冗長が提供されるように、LANポートを独立したイーサーネット・スチッチに接続しま

す。

5. 各ターゲット・デバイスをオンにし、次にスイッチに付属の電源コードを取り出しま

す。スイッチ背面にある電源ソケットにコードの一方の端を接続します。もう一方の

端は適切なAC壁面コンセントに接続してください。2本目の電源コードを使って、ス

イッチ背面にある2番目の電源ソケットに接続します。他方の端は適切なAC壁面コ

ンセントに接続してください。
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2.インストール

冗長電源を個別の分岐回路に差し込むと、外部AC電源が切れた場合の冗長性が高まり

ます。

ローカルのバーチャル・メディアまたはスマート･カード･リーダーを接続するには：

バーチャル・メディアまたはスマート･カード･リーダーを、スイッチの空いているUSBポー

トに接続します。

すべてのバーチャル・メディア・セッションとスマート･カード･リーダーの場合、KVM s4アダ

プターUSB20-VGAアダプター・ケーブルを使用する必要があります。

リモートによるバーチャル・メディアの接続に関する情報については、「バーチャル・メデ

ィア」(ページ60) を参照してください、。リモートによるスマート･カード･リーダーの接続に

関する情報については、「スマート･カード」(ページ65) を参照してください。

UTPコネクターを使用してシリアル・アダプター・ケーブルをシリアル・デバイスに接続す

るには次の手順を実行します。

1. シリアル・アダプター・ケーブルUTPコネクターをシリアル・デバイスに取り付けま

す。

-または-

シリアル・アダプター・ケーブルをRJ-45／9ピン(メス)変換アダプターに取り付

けます。アダプターをシリアル・デバイスのシリアル・ポートに接続します。

2. UTPケーブル(4ペア、最長45 m)の一方の端を、スイッチの背面にある番号が付い

た利用可能なポートに接続します。もう一方の端をシリアル・アダプター・ケーブル

のRJ-45コネクターに接続します。

3. USB／バレル間電源コードをシリアル・アダプター・ケーブルの電源コネクターに接

続します。USB／バレル間電源コードのUSBコネクターを、シリアル・ターゲット・デ

バイスの任意の使用可能なUSBポートに接続します。

2.4 KVM s4スイッチのカスケード接続

KVM s4スイッチを最高2レベルまでにカスケード接続して、ユーザーを最大1024台の

サーバーに接続することができます。カスケード接続システムでは、主スイッチの各ター

ゲット・ポートはカスケード接続されている各スイッチのアナログ・コンソール・インターフ

ェイス(ACI)ポートに接続します。その後で、カスケード接続されているスイッチをアダプ

ター・ケーブルを使ってデバイスに接続することができます。
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2.4 KVM s4スイッチのカスケード接続

図2.2. KVM s4スイッチのカスケード接続構成

番号 説明

1 マスターKVM s4スイッチ

2 カスケード接続されているKVM s4スイッチ

3 マスター・スイッチのターゲット・ポート

4 カスケード接続されているスイッチのACIポート

5 スイッチに接続されているターゲット・デバイス

表 2.2: 図 2.2の説明
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2.インストール

複数のスイッチをカスケード接続するには：

1. CAT 5ケーブルの一端を、KVM s4スイッチのターゲット・ポートに接続します。

2. CAT 5ケーブルのもう一方の端を、カスケード接続されているKVM s4スイッチ後面

のACIポート(チェーン・リンクのアイコン)に接続します。

3. デバイスをカスケード接続されているKVM s4スイッチに接続します。

4. システムに接続するすべてのカスケード接続のKVM s4スイッチに対して、この手順

を繰り返します。

システムが自動的に2つのスイッチを統合します。カスケード接続されているスイッチに接

続されているデバイスすべてが、グラフィカル・インターフェイス(UI)のメイン・スイッチのデ

バイス・リストに表示されます。

スイッチは、メイン・スイッチのターゲット・ポートごとに1つのカスケード接続のスイッチをサ

ポートしています。カスケードされている接続のスイッチに、それ以上のスイッチを接続す

ることはできません。

ローカル・ポートのカスケード接続は、KVM s4ではサポートされていません。

2.5 スイッチのKVM s4構成

すべての物理接続が完了したら、スイッチ・システム全体で使用するためにスイッチを構

成する必要があります。これを実行するには2つの方法があります。

DSView 3ソフトウェアを使用してスイッチを構成するには：

詳細については、「DSView 3インストーラ／ユーザー・ガイド」を参照してください。

ローカルUIを使用してスイッチを構成するには次の手順を実行します。

ローカルUIを使用して最初のネットワーク・セットアップを構成する詳細な手順について

は、「ネットワーク設定」(ページ29) を参照してください。

組み込みWebサーバーの設定

組み込みWebサーバーを使用してスイッチにアクセスして、スイッチに関する日常作業の

ほとんどを処理できます。Webサーバーを使用してスイッチにアクセスする前に、まずス

イッチの背面パネルにあるローカル・ポートまたはローカルUIを介してIPアドレスを指定し

ます。

ファイヤーウォールを使用したOBWIへの接続

アクセスにOBWIを使用するスイッチの設置では、外部にアクセスする必要がある場合

は、ファイヤーウォールで次のポートが開いている必要があります。
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2.5 スイッチのKVM s4構成

TCPポート番

号
機能

22 シリアル・アダプター・ケーブルへのシリアル・セッションのSSHに使用されま

す。

23 (Telnetが有効な場合 )Telnetに使用されます

80 ビデオ・ビューアの最初のダウンロードに使用されます

443 スイッチの管理とKVMセッションの起動を行うWebブラウザ・インターフェイスに

使用されます

2068 スイッチでのKVMセッション・データ(マウス／キーボード)の伝送またはビデオ

の伝送に使用されます

表 2.3: スイッチのOBWI用のTCPポートおよび機能

図 2.3に示すような代表的な構成においては、ユーザーのコンピューターはファイアウ

ォールの外側に位置し、スイッチはファイアウォールの内側にあります。

図2.3.体表的なスイッチのファイアウォール構成

表 2.4. 図 2.3の説明

番号 説明

1 KVM s4スイッチ
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2.インストール

番号 説明

2 ファイヤーウォール

3 ユーザーのコンピューター

4 ファイヤーウォールはHTTP要求とKVMトラフィックをスイッチへ転送します。

5 ユーザーはファイヤーウォールの外部 IPアドレスを参照します。

ファイヤーウォールを構成するには次の手順を実行します。

ファイヤーウォールの外側からスイッチにアクセスするには、ファイヤーウォールの内部

インターフェイスを介して、外部インターフェイスからKVMスイッチにポート22、23(Telnet

が有効な場合)、80、443，2068が転送されるようにファイヤーウォールを構成します。ファ

イヤーウォールの特定ポートの転送手順については、マニュアルを参照してください。

OBWIの起動の詳細については、「OBWI」(ページ20) を参照してください。

2.6 接続の確認

リア・パネルのイーサネット接続LED

KVM s4のリア・パネルには、イーサネットLAN1の接続状態を示すLEDと、イーサネッ

トLAN2の接続状態を示すLEDがそれぞれ2つあります。

• ネットワークへの有効な接続が確立されると緑のLEDが点灯し、ポートにアクティビ

ティがあるときは点滅します。

• 両色LEDは、緑または黄色に点灯します。

• 通信速度が1000Mの時には緑色に点灯します。

• 通信速度が100Mの時には黄色に点灯します。

• 通信速度が10Mの時には点灯しません。

リア・パネルの電源状態LED

各アプライアンスのリア・パネルには、電源状態LEDが2個が付いており、各電源装置に1

個ずつとなっています。スイッチに電源が入り正常に動作しているとき、LEDは緑に点灯

します。

• 電源が入っていなかったり、エラーが発生すると、LEDはオフになります。

• ユニットが準備完了になると、LEDは点灯します。

• スイッチの起動中またはアップグレード処理中は、LEDは点滅します。

590-1058-640A16



2.7 ターゲット・デバイスでのマウス設定の調整

• 電源エラー、周辺温度の上昇、ファンのエラーなどの障害が検出されたとき、LED

は「SOS」を点滅します。障害が続く限り、LEDは「SOS」を点滅し続けます。

モジュールの電源が失われた場合、スイッチは接続されているデバイスからのシリア

ル・ブレークを防止します。ただし、シリアル・セッション・ビューアのシリアル・ブレークを

押すことにより、接続されているデバイスでシリアル・ブレークを生成できます。

2.7 ターゲット・デバイスでのマウス設定の調整

スイッチに接続したコンピューターをリモート・ユーザー制御用に使用するには、ターゲッ

ト・マウスの速度の設定を行い加速をオフにする必要があります。Microsoft®

Windows®(Windows XP、Windows Vista、Windows 2003、Windows 2008、Windows 7)を

稼動しているマシンでは、デフォルトのPS/2マウス・ドライバーを使用してください。

ローカル・マウスの動きとリモート・カーソルの表示の間で同期が保たれるように、KVMス

イッチを介してリモート・システムにアクセスするすべてのユーザー・アカウントでは、マ

ウス加速度を「なし」に設定する必要があります。また、マウス加速度は、各リモート・シ

ステムで「なし」に設定する必要があります。特殊なカーソルは使用しないでください。ま

た、カーソルの表示(ポインターの軌跡、Ctrlキーでカーソルの位置表示、アニメーショ

ン、カーソルの影の有効、カーソルの非表示など)のオプションもオフにしてください。

Windowsオペレーティング・システムからマウス加速度を無効にできない場合や、すべての

ターゲット・デバイスの設定を変更したくない場合は、ビデオ・ビューア・ウィンドウにある

ツール→シングル・カーソル・モードコマンドを使用できます。このコマンドにより、ビデオ・

ビューア・ウィンドウが「透明マウス」モードになります。これにより、表示しているターゲッ

ト・システムのマウス・ポインターとクライアント・コンピューターのマウス・ポインターの制御

とを手動で切り替えることができます。
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3. ローカルおよびリモートの構成

3.1 ユーザー・インターフェイス

KVM s4スイッチには、「ポイント・アンド・クリック」インターフェイスである、ローカル・ユー

ザー・インターフェイス(ローカルUI)およびリモートOBWIが搭載されています。これらのイ

ンターフェイスで利用できる構成オプションを使用して、特定のアプリケーションに合わせ

てスイッチを調整したり、接続デバイスを制御したり、すべての基本的なKVMまたはシリ

アル・スイッチのニーズを処理したりできます。

ローカルUIとリモートOBWIはほとんど同じものです。指定がない限り、この章のすべての

情報は両方のインターフェイスに適用されます。

どちらのインターフェイスからも、2種類のセッションを起動できます。

• ビデオ・ビューア・ウインドウでは、スイッチに接続された個々のターゲット・デバイス

のキーボード、モニター、マウスの機能をリアルタイムで制御できます。また、ビデ

オ・ビューア・ウィンドウ内では、事前に定義されたグローバル・マクロを使用して操

作を実行することもできます。ビデオ・ビューアの使用方法については、第4章を参

照してください。

• シリアル・ビューア・ウィンドウでは、コマンドまたはスクリプトを使用して、個々のシ

リアル・ターゲット・デバイスを管理できます。

ローカルUI

スイッチの背面にはローカル・ポートがあります。このポートを使用してキーボード、モニ

ター、およびマウスをスイッチに直接接続して、ローカルUIを使用できます。

次の任意のキーストロークを選択して構成し、ローカルUIを開いたり、ローカルUIとアク

ティブ・セッション間を切り替えるようにできます：Print Screen、Ctrl + Ctrl、Shift + Shift、

および Alt + Alt。

ローカルUIを起動するには次の手順を実行します。

1. モニター、キーボード、マウスのケーブルをスイッチに接続します。詳細について

は、「スイッチ・ハードウェアの接続」(ページ11) を参照してください。

2. 任意の有効なキーストロークを押して、ローカルUIを起動します。

3. ローカルUI認証が有効にされている場合は、ユーザー名とパスワードを入力しま

す。
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3.ローカルおよびリモートの構成

スイッチがDSView 3サーバーに追加されている場合は、ユーザー認証のために、DSView

3サーバーにアクセスします。スイッチがDSView 3サーバーに追加されていない場合

や、DSView 3サーバーに接続できない場合は、ユーザー認証のために、スイッチのローカ

ル・ユーザー・データベースにアクセスします。デフォルトのローカル・ユーザー名はAdmin

です。パスワードはありません。ローカル・ユーザー・データベースのユーザー名は、大文

字と小文字が区別されます。

OBWI

スイッチのOBWIは、リモートのWebブラウザ・ベースのユーザー・インターフェイスです。

システム・セットアップの詳細については、「スイッチ・ハードウェアの接続」(ページ11) を

参照してください。次の表に、OBWIでサポートされているオペレーティング・システムとブ

ラウザの一覧を示します。必ず最新バージョンのWebブラウザを使用してください。

表 3.1. OBWI対応のオペレーティング・システムとブラウザ

オペレーティング・システム

ブラウザ

Microsoft®

Internet Explorer
バージョン6.0 SP1
以降

Firefoxバージョン3.0以降

Microsoft Windows
Server ® 2003
Standard、Enterpriseまた

はWebEdition

可 可

MicrosoftWindows
Server® 2008
Standard、Enterpriseまた

はWebEdition

可 可

Windows XP
Professional(Service
Pack3)

可 可

Windows Vista ®

Business(Service Pack1)
可 可

Windows7 可 可
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3.1 ユーザー・インターフェイス

オペレーティング・システム

ブラウザ

Microsoft®

Internet Explorer
バージョン6.0 SP1
以降

Firefoxバージョン3.0以降

Red Hat Enterprise
Linux® 4 お よ び5
Standard、Enterpriseまた

はWebEdition

不可 可

Sun Solaris 10および11 不可 可

Solaris 10 x86 不可 可

Ubuntu 8Workstation 不可 可

スイッチのOBWIにログインするには次の手順を実行します。

1. Webブラウザを起動します。

2. ブラウザのアドレス欄に、アクセスするスイッチに割り当てられているIPアドレスまた

はホスト名を入力します。「https://xxx.xx.xx.xx」または「https://ホスト名」の形式を

使用します。

IPv6モードを使 用してい る場合は、IP ア ドレス を角括弧 で囲む必 要があり ま

す。「https://[<ipaddress>]」の形式を使用します。

3. ブラウザがスイッチに接続されたらユーザー名とパスワードを入力し、ログインをク

リックします。スイッチのOBWIが表示されます。

デフォルトのユーザー名はadminで、パスワードもadminです。

ファイヤーウォールの外側からスイッチのOBWIにログインするには、上記の手順を繰り

返し、代わりにファイヤーウォールの外部IPアドレスを入力します。

ユーザー・インターフェイスの使用

認証後に、ユーザー・インターフェイスが表示されます。ここでは、スイッチの表示、アク

セス、管理を行ったり、システム設定の指定とプロファイル設定の変更を行うことができ

ます。図 3.1に、スイッチのユーザー・インターフェイス・ウィンドウの各領域を示します。

それらについての説明は、後続の表に示してあります。
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3.ローカルおよびリモートの構成

図3.1.ユーザー・インターフェイス・ウィンドウ

番号 説明

1

トップ・オプション・バー：トップ･オプション･バーを使用して、インターフェイス･ウィ

ンドウのブックマーク、インターフェイス･ウィンドウ表示の更新、Webページの印

刷、OBWIセッションからのログアウト、またはオンライン・ヘルプ･ページへのアク

セスを実行することができます。トップ・オプション・バーの左側には、ログイン中

のユーザーの名前が表示されます。

2

サイド・ナビゲーション・バー：サイド・ナビゲーション・バーを使用して、コンテンツ

領域に表示して編集するシステム情報を選択します。また、サイド･ナビゲーシ

ョン･バーの左上隅にはアイコンがあり、クリックすると全ノードを展開または折り

畳むことができます。

3 コンテンツ領域：コンテンツ領域を使用して、スイッチのOBWIシステムを表示し

たり、変更したりすることができます。

表 3.2: ユーザー・インターフェイスの説明

サイド・ナビゲーション・バーの使用法

サイド・ナビゲーション・バーでは、設定の変更や操作を実行するためのウィンドウを表示

できます。矢印のないリンクをクリックすると、対応するウィンドウが表示されます。
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3.1 ユーザー・インターフェイス

トップ･オプション･バーの使用方法

認証が無効になっている場合は、「更新」ボタンのみがローカルUIに表示されます。認証

が有効になっている場合は、「更新」ボタンと「ログアウト」ボタンのみがローカルUIに表示

されます。全部のボタンはリモートOBWIに表示されます。

ウィンドウのブックマーク(Microsoft Internet Explorerのみ)

ユーザー・インターフェイスには、トップ・オプション・バーにブックマーク用のアイコンとテ

キストがあります。ウィンドウをブックマークして、そのウィンドウへのリンクを「お気に入

り」のドロップダウン･メニューに追加することができます。そのリンクを選択することで、

ブックマークしたウィンドウに簡単にアクセスできるようになります。

あるウィンドウをブックマークして、そのウィンドウに関係する情報が変更した場合、この

新情報は次にこのブックマークしたウィンドウを表示した際に反映されています。

スイッチのOBWIセッションがタイム・アウトになった後にブックマーク またはブックマー

ク・アイコンをクリックした場合は、「ユーザー・ログイン」ウィンドウが開き、再ログインす

る必要があります。

ウィンドウをブックマークするには：

1. トップ・オプション・バーで、ブックマーク またはブックマーク・アイコンをクリックしま

す。「お気に入りに追加」ダイアログ・ボックスが表示されます。

2. 名前を変更したい場合は新しい名前を入力します。また、フォルダボタンをクリック

して、このウィンドウを保存するフォルダを作成または指定することもできます。

3. OK をクリックし、お気に入りに追加ダイアログ・ボックスを閉じます。

ウィンドウの印刷

スイッチのすべての「OBWI」ウィンドウには、トップ・オプション・バーに印刷用のアイコン

とテキストがあります。

スイッチの「OBWI」ウィンドウを印刷するには：

1. トップ・オプション・バーで、印刷または印刷アイコンをクリックします。印刷ダイアロ

グ・ボックスが表示されます。

2. スイッチの「OBWI」ウィンドウの印刷で使用したいオプションを指定します。

3. 印刷 をクリックして、スイッチの「OBWI」ウィンドウを印刷して、印刷ダイアログ・ボッ

クスを閉じます。

ウィンドウの更新

スイッチのユーザー・インターフェイスは、トップ・オプション・バーの更新または更新ア

イコンをクリックすることで、いつでも更新することができます。
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3.ローカルおよびリモートの構成

ログアウト

トップ･オプション･バーのログアウト･アイコンをクリックすれば、いつでもログアウトできま

す。

3.2 システム情報の表示

ユーザー・インターフェイスの複数の画面では、さまざまなアプライアンスとターゲット・

デバイスの情報を表示できます。

表 3.3. システム情報

カテゴリー
操作画面の選択順

表示内容

スイッチ
ユニットの表示 → ア

プライアンス→ 概要
スイッチ名、タイプ、アプライアンス・ツール

ユニットの表示 → ア

プライアンス → プロ

パティ → ID
アプリケーションおよびブートの現在のファイルの改訂

ユニットの表示 → ア

プライアンス → プロ

パティ → ロケーショ

ン

サイトや部門、またはロケーション

ユニットの表示 → ア

プライアンス → アプ

ライアンスの設定 →
バージョン

アプリケーション、ブート、およびビデオFPGAの現在の

ファイルの改訂

ユニットの表 示 →
接続

接続されているデバイスの一覧

ターゲット・

デバイス

ユニットの表 示 →
ターゲット・デバイス

接続されたターゲット・デバイスの一覧と、各デバイスの

名前、タイプ、状態、操作の情報

ターゲット・デバイスの1つをクリックすると、名前、タイ

プ、eID、使用可能なセッション・オプション、接続パス

の情報を表示できます
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3.3 KVM s4スイッチ・セッション

次の障害状態が発生した場合にはアラートも出されます：電源エラー、周辺温度の上

昇、ファンのエラー。感嘆符つきの三角形と障害の名前が各画面のヘッダーに表示され

ます。この通知はページを更新した後にのみ現れたり、見えなくなったりします。通知を

クリックして詳細情報を得ることができます。

3.3 KVM s4スイッチ・セッション

アクティブ・セッション画面から、アクティブなセッションの一覧と各セッションのターゲッ

ト・デバイス、所有者、リモート・ホスト、継続時間、タイプに関する情報を表示できます。

セッションの開始

セッションを起動するには、Java 1.6.0_11以降が必要です。

セッションを起動するには次の手順を実行します。

1. サイド・ナビゲーション・バーから、ユニットの表示 →ターゲット・デバイス を選択し

ます。利用可能なデバイスの一覧が表示されます。

2. ターゲット・デバイスの右にあるKVMセッションまたはシリアル・セッションリンクを

クリックして、セッションを起動します。

アクセスしようとしているターゲット・デバイスが使用中の場合、アクセスを試みている

ユーザーは、自身の優先権レベルが現在使用中のユーザーのレベルと同等またはそれ

以上であれば、プリエンプトするかどうかを問われます。

ローカルUIからアクティブなセッションに切り替えるには(ローカル・ユーザーのみ)：

1. サイド・ナビゲーション・バーから、ローカル・セッションを選択します。

2. アクティブ・セッションを再開するチェックボックスをオンにします。「ビデオ・ビュー

ア」ウィンドウが表示されます。

-または-

Escキーを押します。

セッションの構成

一般セッションを構成するには次の手順を実行します。

1. サイド・ナビゲーション・バーから、ユニットの表示 →アプライアンス → アプライア

ンスの設定→セッション→一般を選択します。アプライアンスの一般セッションの

設定画面が表示されます。

2. アイドル タイムアウトを有効にするチェックボックスをオンまたはオフにします。

3. アイドル タイムアウト・フィールドには、セッションを閉じる非アクティブ時間を入力し

ます(1分～90分)。
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3.ローカルおよびリモートの構成

4. ログイン・タイムアウト・フィールドには、再ログインを必要とする非アクティブ時間を

入力します。(21秒～120秒)

5. プリエンプト タイムアウトを有効にするチェックボックスをオンまたはオフにします。

6. プリエンプト タイムアウト・フィールドには、セッションがプリエンプトされることを知ら

せるメッセージを表示する時間を入力します(1秒～120秒)。

7. 保存をクリックします。

KVMセッションを構成するには次の手順を実行します。

1. サイド・ナビゲーション・バーから、ユニットの表示 →アプライアンス → アプライア

ンスの設定→セッション→ KVM を選択します。アプライアンスのKVMセッション設

定画面が表示されます。

2. キーボード信号およびマウス信号の暗号化レベル(128ビットSSL、DES、3DES、また

はAES)およびビデオ信号の暗号化レベル(128ビットSSL、DES、3DES、AES、または

なし)を選択します。

3. キーボード・ドロップダウン・メニューから言語を選択します。

4. 保存をクリックします。

シリアル・セッションを構成するには次の手順を実行します。

1. サイド・ナビゲーション・バーから、ユニットの表示 →アプライアンス → アプライア

ンスの設定→設定→シリアルを順に選択します。アプライアンスのシリアル・セッ

ション設定画面が表示されます。

2. Telnetアクセス有効チェックボックスをオンまたはオフにします。

3. 保存をクリックします。

セッションの終了

セッションを終了するには次の手順を実行します。

1. サイド・ナビゲーション・バーから、アクティブ・セッション を選択して、アクティブ・セ

ッション画面を表示します。

2. 目的のターゲット・デバイスの横にあるチェックボックスをオンにします(複数可)。

3. 接続解除をクリックします。

関連付けられているロック状態のバーチャル・メディア・セッションがある場合は、そのセッ

ションも接続解除されます。

セッションを終了するには(ローカル・ユーザーのみ)：

1. サイド・ナビゲーション・バーから、ローカル・セッションを選択します。
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3.4 KVM s4スイッチ・ツール

2. Dアクティブ・セッションを接続解除するチェックボックスをオンにします。

3.4 KVM s4スイッチ・ツール

ユニット概要画面では、アプライアンス名とタイプを表示できます。また、基本的なアプラ

イアンス・タスクを実行できます。

スイッチの再起動

スイッチを再起動するには：

1. サイド・ナビゲーション・バーから、ユニットの表示 →アプライアンス → 概要の順

に選択して、ユニット概要画面を開きます。

2. 再起動をクリックします。

3. ダイアログ・ボックスが表示され、すべてのアクティブ・セッションの接続が解除され

ることを警告します。OK をクリックします。

ローカルUIを使用している場合、スイッチの再起動中、画面は空白になります。リモー

トOBWIを使用している場合、アプライアンスでインターフェイスが再起動の完了を待機し

ていることを通知するメッセージが表示されます。

スイッチのファームウェアのアップグレード

スイッチを最新のファームウェアにアップデートできます。

アップグレードによりフラッシュ・メモリーが再プログラムされると、スイッチはソフト・リセ

ットを実行し、すべてのアダプター・ケーブルセッションを終了します。ターゲット・デバイ

スでアダプター・ケーブルのファームウェア・アップデートを実行中の場合に、表示されな

くなるか、または接続されていないと表示されることがあります。フラッシュ・アップデート

が完了すると、ターゲット・デバイスは正常に表示されるようになります。

警告： ファームウェアのアップデート中にアダプター・ケーブルの接続を解除したりパワー

サイクリング(一旦電源を切って入れ直す)を行ったりすると、モジュールが作動不能となり

アダプター・ケーブルに工場返送、修理の必要が生じる場合があります。

スイッチのファームウェアをアップグレードするには次の手順を実行します。

1. サイド・ナビゲーション・バーから、ユニットの表示 →アプライアンス → 概要の順

に選択して、「ユニット概要」ウィンドウを開きます。

2. ファームウェアのアップグレード をクリックして、「アプライアンス・ファームウェアの

アップグレード」を開きます。

3. ファームウェア・ファイルの読み込み元を、ファイル・システム、TFTP、FTP、HTTP

から1つ選択します。
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3.ローカルおよびリモートの構成

「ファイル・システム」オプションは、リモートOBWIでのみ使用できます。

4. 「ファイル・システム」を選択した場合、参照 を選択して、ファームウェア・アップグ

レード・ファイルの場所を指定します。

-または-

「TFTP」を選択した場合、サーバーのIPアドレスと読み込むファームウェア・ファ

イルを入力します。

-または-

「FTP」または「HTTP」を選択した場合、ユーザー名とユーザー・パスワード、お

よびサーバーのIPアドレスと読み込むファームウェア・ファイルを入力します。

5. アップグレード をクリックします。

スイッチの構成およびユーザー・データベースの保存と復元

スイッチの構成はファイルに保存できます。保存する構成ファイル内には、管理アプライ

アンスに関する情報が含まれます。また、スイッチのローカル・ユーザー・データベース

を保存できます。いずれかのファイルを保存後、以前に保存した構成ファイル、または

ローカル・ユーザー・データベース・ファイルをスイッチに復元することもできます。

管理アプライアンスの構成または管理アプライアンスのユーザー・データベースを保存

するには次の手順を実行します。

1. サイド・ナビゲーション・バーから、ユニットの表示 →アプライアンス → 概要の順

に選択して、「ユニット概要」ウィンドウを開きます。

2. アプライアンス構成の保存またはアプライアンス・ユーザー・データベースの保存

をクリックします。「ファイルのダウンロード」ダイアログ・ボックスが開きます。

3. 保存をクリックします。「名前を付けて保存」ダイアログ・ボックスが開きます。

4. 対象の場所に移動し、ファイルの名前を入力します。保存をクリックします。

5. 閉じるをクリックします。

管理アプライアンスの構成または管理アプライアンスのユーザー・データベースを復元

するには次の手順を実行します。

1. サイド・ナビゲーション・バーから、ユニットの表示 →アプライアンス → 概要の順

に選択して、「ユニット概要」ウィンドウを開きます。

2. アプライアンス構成の復元またはアプライアンス・ユーザー・データベースの復元

をクリックします。「アプライアンス構成の復元」ウィンドウまたは「アプライアンス・

ユーザー・データベースの復元」ウィンドウが表示されます。
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3.5 ネットワーク設定

3. 参照をクリックします。対象の場所に移動し、ファイル名を選択します。アップロード

をクリックします。

4. 正しく実行されたことを告げる画面が表示されたら、閉じるクリックします。管理アプ

ライアンスを再起動して、復元した構成を有効にします。「KVM s4スイッチ・ツー

ル」(ページ27) を参照してください。

3.5 ネットワーク設定

ネットワーク・ダイアログ・ボックスの設定を変更できるのは、スイッチ管理者のみです。他

のユーザーには、表示のみのアクセスが許可されています。

一般ネットワーク設定を構成するには次の手順を実行します。

1. サイド・ナビゲーション・バーから、ユニットの表示 →アプライアンス → アプライア

ンスの設定→ネットワーク →一般を順に選択します。アプライアンスの一般ネット

ワーク設定画面が表示されます。

2. 「LAN速度」ドロップダウン・メニューから、自動検出、10Mbps半二重、10Mbps全二

重、100Mbps半二重、100Mbps全二重、1 Gbps全二重 のオプションのいずれか1つ

を選択します。

イーサネット・モードを変更した場合は、再起動する必要があります。

3. 「ICMP Ping Reply」ドロップダウン・メニューから、有効または無効のいずれかを選

択します。

4. 保存をクリックします。

IPv4ネットワーク設定を構成するには次の手順を実行します。

1. サイド・ナビゲーション・バーから、ユニットの表示 →アプライアンス → アプライア

ンスの設定→ネットワーク → IPv4 を順に選択します。IPv4設定画面が表示されま

す。

2. IPv4モードの有効と無効を切り替えるには、IPv4 を有効にする チェック・ボックスを

選択または選択解除します。

3. 「アドレス」、「サブネット」、「ゲートウェイ」の各フィールドに適切な情報を入力しま

す。

4. 「DHCP」ドロップダウン・メニューから、有効または無効のいずれかを選択します。

DHCPを有効にすると、「アドレス」、「サブネット」、「ゲートウェイ」の各フィールドに入力した

情報は無視されます。

5. 保存をクリックします。
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3.ローカルおよびリモートの構成

IPv6ネットワーク設定を構成するには次の手順を実行します。

1. サイド・ナビゲーション・バーから、ユニットの表示 →アプライアンス → アプライア

ンスの設定→ ネットワーク → IPv6 を順に選択します。スイッチの「IPv6設定」画面

が表示されます。

2. 有効と無効を切り替えるには、IPv6 のステートフルな構成を有効にするチェック・ボ

ックスを選択または選択解除します。

3. 「アドレス」、「ゲートウェイ」、「プレフィックス長」の各フィールドに適切な情報を入力

します。

4. 「DHCPv6」ドロップダウン・メニューから、有効または無効のいずれかを選択しま

す。

DHCPv6を有効にすると、「アドレス」、「ゲートウェイ」、「プレフィックス長」の各フィールドに

入力した情報は無視されます。

5. 保存をクリックします。

3.6 DNS設定

手動でDNSサーバーを割り当てることも、DHCPまたはDHCPv6を使用して取得したアド

レスを使用することもできます。

DNS設定を手動で構成するには次の手順を実行します。

1. サイド・ナビゲーション・バーから、ユニットの表示 →アプライアンス → アプライア

ンスの設定→ DNS を順に選択します。アプライアンスのDNS設定画面が表示され

ます。

2. 手動、DHCP(IPv4が有効な場合)、DHCPv6(IPv6が有効な場合)のいずれかを選択

します。

3. 手動 を選択した場合は、「プライマリ」、「セカンダリ」、「ターシャリ」の各フィールド

にDNSサーバー番号を入力します。

4. 保存をクリックします。

3.7 ローカルUIの設定

ローカルUIの起動方法を変更するには次の手順を実行します。

1. サイド・ナビゲーション・バーから、ユニットの表示 →アプライアンス → アプライア

ンスの設定 → ポート → ローカル・ポートUIの設定 を順にクリックして、ローカル･

ポートUIの設定画面を開きます。
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3.8 バーチャル・メディア

2. 「ローカルポートUIの起動」ヘッダーの下で、一覧で表示されている1つまたは複数

の方法の横にあるチェックボックスをオンにします。

3. OK をクリックします。

ローカルポート ユーザーの設定

ローカル・ポートのユーザー・インターフェイス認証をオン／オフしたり、ユーザー・アクセ

ス・レベルを選択したりできます。ローカル・ポートのユーザー・インターフェイス認証をオ

ンにする場合は、インターフェイスを使用するためにログインする必要があります。

また、ローカル・ポートのキーボード言語やスキャン・モード時間を選択したり、SETUP

ポート・パスワードを有効化／無効化したり、ユーザーのプリエンプト操作レベルを選択

したりできます。ユーザーが、ターゲット・デバイスとの間で別のユーザーが実行中のシ

リアル・セッションまたはKVMセッションを中断／切断できるかどうかは、ユーザーのプリ

エンプト操作レベルによって決まります。プリエンプト操作レベルは1～4まであり、4が最

高レベルです。たとえば、プリエンプト操作レベルが4のユーザーは、他のレベル1、2、3

のユーザー、およびレベル4のユーザーを切断できます。

デフォルトのプリエンプト操作レベルを変更するには(管理者のみ)

1. サイド・ナビゲーション・バーから、ユニットの表示 →アプライアンス → アプライア

ンスの設定 → ポート → ローカル・ポートUIの設定 を順にクリックして、ローカル･

ポートUIの設定画面を開きます。

2. ローカル ポートでのユーザー認証を無効にする チェックボックスをオンまたはオフ

にします。

3. 「ユーザー・アクセス・レベル」のドロップダウン・メニューから次のオプションを1つを

選択します：ユーザー、ユーザー管理者、またはアプライアンス管理者。

4. プリエンプト操作レベルのドロップダウン・メニューから番号1～4の1つを選択しま

す。

5. 保存をクリックします。

3.8 バーチャル・メディア

バーチャル・メディア・セッションの設定画面に表示されるオプションを使用して、バーチ

ャル・メディア・セッション中のスイッチの動作を指定できます。下表は、バーチャル・メデ

ィア・セッションに対して設定できるオプションの概要です。KVMセッションでのバーチャ

ル・メディア・セッションの使用に関する詳細は、「バーチャル・メディア」(ページ60) を参

照してください。
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3.ローカルおよびリモートの構成

設定 説明

セッシ ョンの設

定：KVM セッシ

ョンとバーチャル

メディアをロック

ロック・オプションは、バーチャル・メディア・セッションがターゲット・デバイス

上のKVMセッションにロックされているかどうかを指定します。ロックが有効 (
デフォルト )である場合にKVMセッションが終了すると、バーチャル・メディ

ア・セッションも終了します。ロックが無効である場合にKVMセッションが終

了すると、バーチャル・メディア・セッションはアクティブのままになります。

セッションの設

定：予約済み

セッションを許

可

特定のユーザー名にのみバーチャル・メディア接続へのアクセスを許可し、

それ以外のユーザーがターゲット・デバイスにKVM接続を確立できないよ

うにします。KVMセッションの接続が解除されたとき、バーチャル・メディア・

ダイアログ・ボックスの「ロック状態」の設定により、バーチャル・メディア・セッ

ションの接続が解除されることがあります。

ドライブのマッピ

ング： バー チャ

ル・メディア・ ア

クセス・モード

マッピングされたドライブのアクセス・モードは、読み取り専用か読み取り／

書き込みに設定できます。アクセス・モードが読み取り専用の場合、クライ

アント・サーバー上でマッピングされたドライブにデータを書き込むことはでき

ません。アクセス・モードが読み取り／書き込みの場合は、マッピングされ

たドライブとの間でデータの読み取りと書き込みを行うことができます。マッ

ピングされるドライブが設計上読み取り専用 (CD-ROMドライブ、DVD-
ROMドライブ、 ISOイメージなど)の場合は、設定された読み取り／書き込

みアクセス・モードは無視されます。読み取り専用モードに設定すると、大

容量記憶装置や外付けUSBメディアのような読み取り／書き込み対応

ドライブをマッピングした後に誤って上書きされることを回避できます。

DVDドライブ(1台 )と大容量記憶装置 (1台 )は同時にマッピングできま

す。CDドライブ、DVDドライブ、 ISOディスク・イメージ・ファイルは、バーチャ

ルのCD／DVDドライブとしてマッピングされます。

暗号化レベル

バーチャル・メディア・セッションの暗号化レベルを設定できます。選択肢

は、なし(デフォルト )、128-bit SSL(ARCFOUR)、DES、3DES、AESで
す。

アダプター・ケー

ブルによるバー

チャルメディア

アクセス：VMを

有効にす

る／VMを無効

にする

アダプター・ケーブルによるバーチャルメディアアクセスのセクションに

は、KVM s4アダプターUSB20-VGAケーブルが一覧されます。一覧には、

各ケーブルのバーチャル・メディアを有効化／無効化するオプションを含

む、各ケーブルの詳細が含まれます。

表 3.4: バーチャル・メディア・セッションの設定
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3.8 バーチャル・メディア

バーチャル・メディア・オプションを設定するには次の手順を実行します。

1. サイド・ナビゲーション・バーから、ユニットの表示 →アプライアンス → アプライア

ンスの設定→ セッション →バーチャル・メディア を順にクリックして、アプライアン

スのバーチャル・メディア・セッション設定画面を開きます。

2. バーチャル・メディアがKVMセッションにロック チェックボックスを有効または無効に

します。

3. 予約済みセッションを許可チェックボックスを有効または無効にします。

4. ドロップダウン・メニューの「バーチャル・メディア・アクセス・モード」から、読み取り

専用または読み取り／書き込みのオプションのいずれかを選択します。

5. サポートする暗号化レベルを選択します。

6. バーチャル・メディアを有効にする各KVM s4アダプターUSB20-VGAケーブルの横

にあるチェックボックスを選択して、VM を有効にするをクリックします。

-または-

バーチャル・メディアを無効にしたいそれぞれのKVM s4アダプターUSB20-

VGAケーブルの横にあるチェックボックスを選択して、VMを無効にするをクリ

ックします。

7. 保存をクリックします。

ローカル・バーチャル・メディアの設定

ローカル・ユーザーも、ローカル・セッション画面からバーチャル・メディアの動作を指定

できます。バーチャル・メディア・セッションの接続／接続解除に加えて、次の表に示す

設定を構成できます。

表 3.5. ローカル・バーチャル・メディア・セッションの設定

設定 説明

CDROM/

DVD ROM

最初に検出されたCD-ROMドライブまたはDVD-ROM(読み取り専用 )ドライ

ブに、バーチャル・メディア・セッションを確立できます。このチェックボックスを有

効にすると、バーチャル・メディアのCD-ROMまたはDVD-ROMからターゲット・

デバイスへの接続が確立します。無効にすると、バーチャル・メディアのCD-
ROMまたはDVD-ROMからターゲット・サーバーへの接続が終了します。

大容量記憶

装置

バーチャル・メディア・セッションを最初に検出された大容量記憶装置に確

立することができます。このチェックボックスを有効にすると、バーチャル・メディ

アの大容量記憶装置からターゲット・デバイスへの接続が確立します。無効

にすると、バーチャル・メディアの大容量記憶装置からターゲット・デバイスへ

の接続が終了します。
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3.ローカルおよびリモートの構成

設定 説明

予約されて

います

特定のユーザー名にのみバーチャル・メディア接続へのアクセスを許可し、そ

れ以外のユーザーがターゲット・デバイスにKVM接続を確立できないようにし

ます。

ローカル・バーチャル・メディアの設定を構成するには：

1. サイド・ナビゲーション・バーから、ローカル・セッションを選択します。

2. バーチャル・メディア・セッションのオプションのいずれかを有効にするを選択する

か、または無効にするを選択解除します。

3.9 モデムの設定

アプライアンス モデムの設定画面から、一部のモデム設定を構成できます。また、モデ

ムのローカル・アドレス、リモート・アドレス、サブネット・マスク、ゲートウェイの設定を表

示できます。

スイッチのモデムへの接続に関する詳細は、「スイッチ・ハードウェアの接続」(ペー

ジ11) を参照してください。

モデム設定を構成するには次の手順を実行します。

1. サイド・ナビゲーション・バーから、ユニットの表示 →アプライアンス → アプライア

ンスの設定 →ポート → モデム を順にクリックして、アプライアンス モデムの設定

画面を開きます。

2. モデム セッションではデジタル セッションを切断できます チェックボックスをオンま

たはオフにします。

3. 「認証タイムアウト」で認証がタイムアウトする時間(30秒～300秒)を選び、「アイド

ル・タイムアウト」で非アクティブ・タイムアウト時間(1分～60分)を選びます。

4. 保存を選択します。

3.10 スキャン・モード

スキャン・モードでは、アプライアンスは自動的にポートごと(またはターゲット・デバイス

ごと)のスキャンを行います。複数のターゲット・デバイスをスキャンでき、この場合、スキ

ャン対象のデバイスを指定することができます。スキャンは、一覧内でターゲット・デバイ

スが表示されている順序に従って実行されます。また、スキャンが一覧の次のターゲッ

ト・デバイスに移動するまでの時間を設定できます。

モデム経由で接続している場合、「スキャン」ボタンは無効です。
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スキャン・リストにターゲット・デバイスを追加するには

1. サイド・ナビゲーション・バーから、ユニットの表示→ターゲット・デバイス の順に選

択して、ターゲット・デバイス画面を開きます。

2. スキャンするターゲット・デバイスの横にあるチェックボックスをオンにします。

3. スキャンをクリックします。

スキャン時間を構成するには次の手順を実行します。

1. サイド・ナビゲーション・バーから、ユニットの表示 →アプライアンス → アプライア

ンスの設定 → ポート → ローカル・ポートUIの設定 を順にクリックして、ローカル･

ポートUIの設定画面を開きます。

2. 「スキャン・モード」ヘッダーの下で、「スキャン時間」フィールドに時間を秒単

位(3～255)で入力します。

3. 保存をクリックします。

3.11 DSView 3デバイスのIPアドレス

DSView 3サーバーのIPアドレスを指定すると(最高4台まで)、DSView 3サーバーを使っ

て、管理されていないスイッチに接続して登録できます。

DSView 3サーバーのIPアドレスを構成するには：

1. サイド・ナビゲーション・バーから、ユニットの表示 →アプライアンス → アプライア

ンスの設定→ ユーザー・アカウント → DSView 3 を選択します。DSView 3設定画

面が表示されます。

2. 最大4台までの接続したいDSView 3ソフトウェア・サーバーのIPアドレスを1～4のフ

ィールドに入力します。

3. 保存をクリックします。

3.12 ユーザー・アカウント

ローカル･アカウントの管理

スイッチのOBWIでは、管理者が定義したユーザー・アカウントを通して、ローカル・アクテ

ィビティおよびログインがセキュアに実行されます。管理者は、サイド・ナビゲーション・

バーのローカル・アカウント を選択して、ユーザーの追加と削除、ユーザーのプリエンプ

ト操作の定義、アクセス・レベルの変更、パスワードの変更などを実行できます。

アクセス・レベル

ユーザー･アカウントが追加されるとき、ユーザーに対して割り当てられるアクセス･レベ

ルには、アプライアンス管理者、ユーザー管理者、ユーザーの3つがあります。
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アクセス・レベル

操作

アプライア

ンス管理

者

ユーザー管

理者
ユーザー

インターフェイスのシ

ステム・レベル設定

の構成

可 不可 不可

アクセス権の構成 可 可 不可

ユーザー・アカウント

の追加、変更、削

除

すべてのア

クセス・ レ

ベルで可

可 ( ユー

ザーおよび

ユーザー管

理者のみ)

不可

自 分 自 身 のパス

ワードの変更
可 可 可

ターゲット・デバイス

へのアクセス

可 (すべて

のターゲッ

ト・ デバイ

ス対象 )

可 (すべて

のターゲ ッ

ト・デバイス

対象 )

許可されていれば可

表 3.6: アクセス・レベルによって許可される操作

新規のユーザー･アカウントを追加するには(管理者のみ)

1. サイド・ナビゲーション・バーで、ユニットの表示→アプライアンス →アプライアン

スの設定 →ユーザー・アカウント → ローカル・アカウント の順にオンにして、アプ

ライアンスのローカルユーザー アカウント画面を開きます。

2. 追加ボタンをクリックします。

3. 新規ユーザーのユーザー名とパスワードを該当欄に入力します。

4. この新規ユーザーの優先権レベルとアクセス･レベルを選びます。

5. ユーザー・アカウントに割り当てる、任意の使用可能なターゲット・デバイスをオンに

して、追加をクリックします。

ユーザー管理者とアプライアンス管理者はすべてのターゲットデバイスにアクセス可能で

す。

6. 保存をクリックします。
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ユーザー･アカウントを削除するには(管理者のみ)

1. サイド・ナビゲーション・バーで、ユニットの表示→アプライアンス →アプライアン

スの設定 →ユーザー・アカウント → ローカル・アカウント の順にオンにして、アプ

ライアンスのローカルユーザー アカウント画面を開きます。

2. 削除するアカウントの左にあるチェックボックスをそれぞれクリックして、削除をクリ

ックします。

ユーザー･アカウントを編集するには(管理者またはアクティブ･ユーザーのみ)

1. サイド・ナビゲーション・バーから、ユニットの表示 →アプライアンス → アプライア

ンスの設定→ユーザー・アカウント →ローカル・アカウント を選択します。アプライ

アンスのローカルユーザー アカウント画面が表示されます。

2. 編集するユーザーの名前をクリックします。ユーザー･プロファイルが表示されま

す。

3. 画面にユーザー情報を入力し、保存をクリックします。

3.13 SNMP設定

SNMPは、ネットワーク管理アプリケーションとスイッチの間で管理情報を通信するため

に使用されるプロトコルです。 他のSNMPマネージャーは、 MIB-IIや企業MIBの公共部

分にアクセスすることによってスイッチと通信します。SNMP画面を開くと、OBWIによ

り、SNMPパラメーターがユニットから取り込まれます。

SNMP画面から、システム情報とコミュニティー・ストリングを入力できます。 また、スイッ

チを管理するステーション、さらにスイッチからSNMPトラップを受信するステーションを

指定できます。SNMPを有効にする を選択すると、ユニットはUDPポート161を介し

たSNMP要求に応答します。

一般SNMP設定を構成するには次の手順を実行します。

1. ユニットの表示→アプライアンス →アプライアンスの設定→ SNMP→ SNMP設

定を順に選択して、SNMP画面を開きます。

2. NMPを有効にする チェックボックスをクリックして有効にし、スイッチがUDPポー

ト161を介したSNMP要求に応答できるようにします。

3. 「名前」フィールドにシステムの完全修飾ドメイン名を、「連絡先」フィールドにノード

の連絡先担当者を入力します。

4. 「読み取り」、「書き込み」、「トラップ」の各コミュニティー名を入力します。これらの

名称は、SNMPアクションで使用が必須となっているコミュニティー・ストリングを指

定します。「読み取り」と「書き込み」のストリングは、UDPポート161を介したSNMPに

のみ適用され、スイッチへのアクセスを保護するパスワードとして機能します。この

590-1058-640A 37



3.ローカルおよびリモートの構成

値は、64文字以内の範囲で受け入れられます。これらのフィールドを空欄のまま残

すことはできません。

5. スイッチの管理を許可する最大4台の管理ワークステーションのアドレスを、「許可

管理マネージャー」フィールドに入力します。これらのフィールドを空欄のまま残し、

すべてのワークステーションにスイッチの管理を許可することもできます。

6. 保存をクリックします。

3.14 イベントの設定

イベントはスイッチによって管理ステーションに送信される通知で、何らかの処置が必要

である事象が発生したことを示します。

個別のイベントを有効にするには次の手順を行います。

1. ユニットの表示→ アプライアンス →アプライアンスの設定→ 監査→ イベント を

順に選択して、イベント画面を開きます。

2. 一覧の適切なチェックボックスをオンにして、通知を生成するイベントを指定します。

-または-

「イベント名」の横にあるチェックボックスをオン／オフにすると、リスト内のすべ

てをオンまたはオフにできます。

3. 保存をクリックします。

3.15 イベント送信先の設定

監査イベントを、SNMPトラップ送信先とSyslogサーバーに送信されるように構成できま

す。イベント画面で有効にされたイベントは、イベント送信先画面に一覧で表示されてい

るすべてのサーバーに送信されます。

1. ユニットの表示→ アプライアンス →アプライアンスの設定 →監査→ 送信先 を

順に選択して、イベント送信先画面を開きます。

2. 「SNMPトラップ送信先」フィールドに、このスイッチがイベントを送信する管理ワーク

ステーションのアドレスとSyslogサーバーをそれぞれ4つまで入力します。

3. 保存をクリックします。

3.16 アダプター・ケーブルの構成

スイッチから、接続されているアダプター・ケーブルの一覧や、各ケーブルの電

子ID(eID)、ポート、状態、アプリケーション、インターフェイス・タイプ、およびUSB速度の

情報を表示できます。ケーブルの1つをクリックすると、スイッチ・タイプ、ブート・バージョ
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ン、ハードウェア・バージョン、FPGAバージョン、最新バージョン、アップグレード・ステー

タスなどの追加情報が表示できます。

また、実行できるタスクには、オフライン・アダプター・ケーブルの削除、ケーブル・ファー

ムウェアのアップグレード、USB速度の設定、ケーブルのデフォルト設定の復元がありま

す。

オフラインのアダプター･ケーブルを削除するには：

1. サイド・ナビゲーション・バーから、ユニットの表示 →アプライアンス → アプライア

ンスの設定→ポート →アダプター・ケーブルを順にクリックして、アプライアンス・

アダプター・ケーブル画面を開きます。

2. オフラインの削除 をクリックします。

USB速度を設定するには(KVM s4 アダプターUSB20-VGAケーブルのみ)：

1. サイド・ナビゲーション・バーから、ユニットの表示 →アプライアンス → アプライア

ンスの設定→ ポート → USB20-VGA を順にクリックして、アプライアンスUSB20-

VGA画面を開きます。

2. 変更するケーブルの横にあるチェックボックスを選択します。

3. USB 1.1速度の設定またはUSB 2.0 速度の設定のいずれかをクリックします。

アダプター・ケーブルのアップグレード

ケーブルのフラッシュ・アップグレード機能を使用すると、アプライアンス管理者はアダプ

ター・ケーブルを利用可能な最新のファームウェアにアップデートすることができます。

このアップデートは、スイッチのユーザー・インターフェイスまたはDSView 3ソフトウェア

を使用して実行できます。

アップグレードによりフラッシュ・メモリーが再プログラムされると、スイッチはソフト・リセ

ットを実行し、すべてのアダプター・ケーブルセッションを終了します。アダプター・ケーブ

ルのファームウェアがアップデート中のターゲット・デバイスは、接続解除されたと表示さ

れる場合があります。フラッシュ・アップデートが完了すると、ターゲット・デバイスは正常

に表示されるようになります。

アダプター・ケーブルの自動アップグレードを行うようにアプライアンスが構成されている

場合は、スイッチがアップデートされると、アダプター・ケーブルも自動的にアップデート

されます。スイッチのファームウェアをアップデートするには、「KVM s4スイッチ・ツー

ル」(ページ27) 、またはDSView 3ソフトウェアのオンライン・ヘルプを参照してください。

通常のアップグレード処理中に問題が発生した場合も、必要に応じて、アダプター・ケー

ブルは強制的にアップグレードされることがあります。

ファームウェア・アップグレード・ファイルについては、http://www.ts.fujitsu.comを確認してく

ださい。
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アダプター・ケーブルのファームウェアをアップグレードするには：

1. サイド・ナビゲーション・バーから、ユニットの表示 →アプライアンス → アプライア

ンスの設定→ポート →アダプター・ケーブルを順にクリックして、アプライアンス・

アダプター・ケーブル画面を開きます。

2. アップグレードするアダプター・ケーブルの横にあるチェックボックスを選択し、アッ

プグレード をクリックします。

警告： ファームウェアのアップデート中にアダプター・ケーブルの接続を解除したりパワー

サイクリング(一旦電源を切って入れ直す)を行ったりすると、モジュールが作動不能となり

アダプター・ケーブルに工場返送、修理の必要が生じる場合があります。

3.17 電源装置の設定

電源装置の設定を変更するには、管理者の権限が必要です。

アプライアンス電源装置画面から、接続されている電源装置の一覧や、各電源装置の

名前、ポート、状態、バージョン、モデル、ブザー、アラーム、および温度の情報を表示

できます。また、電源装置を選択して、設定を選択すると、その電源装置の名前、説明、

状態、バージョン、ソケット、ベンダー名、モデル、および入力フィードの詳細を表示でき

ます。

電源管理装置のアウトレットにターゲット・デバイスが接続されている場合は、ターゲッ

ト・デバイスの電源のオン／オフ、またはオフ／オン(電源の入れ直し)を行うことができま

す。

ターゲット・デバイスの電源のオン、オフ、またはオフ／オンを行うには次の手順を実行し

ます。

1. サイド・ナビゲーション・バーから、ユニットの表示 →アプライアンス → アプライア

ンスの設定 →ポート →電源装置 を順にクリックして、アプライアンス電源装置画

面を開きます。

2. 構成するユニットの名前をクリックして、ソケット を選択します。

3. 構成するソケットの左側にあるチェックボックスを選択します(複数可)。

4. オン、オフ、または電源オフ／オンを目的に応じてクリックします。

オフラインの電源装置を削除するには次の手順を実行します。

1. サイド・ナビゲーション・バーから、ユニットの表示 →アプライアンス → アプライア

ンスの設定 →ポート →電源装置 を順にクリックして、アプライアンス電源装置画

面を開きます。

2. オフラインの削除 をクリックします。
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最小オン時間、オフ時間またはウェイク・アップ状態を変更するには次の手順を実行しま

す。

1. サイド・ナビゲーション・バーから、ユニットの表示 →アプライアンス → アプライア

ンスの設定 →ポート →電源装置 を順にクリックして、アプライアンス電源装置画

面を開きます。

2. 構成するユニットの名前をクリックして、ソケット を選択します。

3. 変更するソケットの名前をクリックします。

4. ドロップダウン・ウィンドウを使用して対象の設定を変更し、保存をクリックします。

ターゲット・サーバーと電源アウトレットの関連付け

1つ以上の電源アウトレットをターゲット・サーバーと同じ名前にして、そのアウトレットを

ターゲット・サーバーにリンクまたは関連付け、管理を容易にすることができます。OBWI

の「ターゲット デバイス」ページでは、リンクされたアウトレットを持つターゲットの電源管

理操作を選択できます。「ターゲット デバイス」ページの「壁コンセント電源」表には、ター

ゲット・デバイスにリンクされたアウトレットが表示されます。

次の図に、リンクされた電源アウトレットを持つServer2という名前のターゲット・デバイス

を示します。「操作」列のドロップダウン・メニューの矢印をクリックすると、利用可能なオ

プションの電源操作が表示されます。

図3.2. ターゲット・デバイス

次の図では、ターゲットのServer2の「ユニットの表示」ページに、「壁コンセント電源」が

表示されています。ここでは、PDU1からのアウトレット1とアウトレット9がServer2にリンク

されています。
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図3.3. ターゲットの概要-Server2

電源アウトレットのグループ化

1つのグループにリンクするために、複数の電源アウトレットに同じ名前が付けられること

があります。この場合、1つのターゲット・デバイスとして一覧に表示されます。「ターゲッ

ト・デバイス」ページで実行された電源操作は、適用可能なすべてのアウトレットに適用

されます。「ユニットの表示」ページでは、ターゲットの特定の電源アウトレットに対して電

源管理操作を実行できます。次の図に、PDU1からの電源アウトレット4と5という組み合

わせを持つ、Group2という名前のターゲットを示します。

図3.4. ターゲットの概要-Group2

デフォルトのアウトレット名

次の図に示すとおり、「電源装置」ページの「アウトレットへのデフォルト名の割り当て」チ

ェックボックスを使用して、電源アウトレットに電源デバイスのデフォルトの名前を指定す

るかどうか制御します。名前の付いた電源アウトレットのみが「ターゲット」ページに一覧

表示されます。「アウトレットへのデフォルト名の割り当て」チェックボックスをオフにして

保存すると、デフォルトで割り当てられた電源アウトレット名を削除できます。「アウトレッ

トへのデフォルト名の割り当て」チェックボックスをオンにして保存すると、名前のない電

源アウトレットにデフォルトの名前を割り当てられます。

図3.5.アプライアンス電源装置ページ

アウトレット名の割り当て

次の図に示すとおり、「電源装置アウトレットの設定」ページには、アウトレットの名前を

割り当てるための3つのオプションがあります。オプションは、「手動」割り当て、「ターゲッ

ト デバイスへのリンク」、「ターゲット デバイスとして表示しない」です。

590-1058-640A42



3.17 電源装置の設定

図3.6.電源装置アウトレット設定ページ

• 「手動」では、アウトレットに固有の名前を指定します。名前は、すべてのアダプ

ター・ケーブルおよび電源アウトレット名に対して固有である必要があります。固有

でない名前を手動で指定しようとするとエラーになり、名前は保存されません。

• 「ターゲット デバイスへのリンク」では、別のターゲット名(アウトレットまたはSIPのい

ずれか)にアウトレットをリンクして、指定されたターゲットの電源を管理します。アウ

トレットがアダプター・ケーブルのターゲット名にリンクされると、通常そのアウトレッ

トはリンクされたアダプター・ケーブルに接続されているサーバーに物理的に電源を

供給します。

• 「ターゲット デバイスとして表示しない」オプションは、アウトレットの名前を空白にし

ます。これにより、アウトレットは「ターゲット・デバイス」ページに表示されません。こ

のオプションを予備のアウトレットに使用して、予備のアウトレットを「ターゲット・デ

バイス」ページに表示されないようにできます。

アクセス制御の継承

ターゲットに電源アウトレットをリンクすることにより電源アウトレット名を変更すると、アウ

トレットはそのターゲット名に既に構成されているアクセス制御を継承します。アダプ

ター・ケーブルが追加され、そのアダプター・ケーブルから取得された名前が既存のター

ゲットの名前と一致すると、新しいアダプター・ケーブルはそのターゲットからアクセス制

御を継承します。ターゲット・デバイスの名前が変更されると、そのターゲットのすべての

アダプター・ケーブルおよびアウトレットの名前は変更され、古いターゲット名に構成され

ていたアクセス制御を継承し続けます。

ターゲット・デバイスの名前の変更

「ターゲット・デバイス」ページでは、ターゲットの名前を任意の固有ターゲット名に変更

できます。名前は、アダプター・ケーブルおよび電源アウトレットを含むすべてのターゲッ

トに対して固有である必要があります。ターゲットの名前が変更されると、そのターゲット

にリンクしているすべてのアウトレットにも、新しいターゲット名が指定されます。
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3.ローカルおよびリモートの構成

ターゲット・デバイスの優先付けされる状態

「ターゲット・デバイス」ページでは、リンクされた電源アウトレットを持つターゲットにより

複数のデバイスが制御されます。ターゲットに表示されている「状態」値は、デバイスの

すべての状態値のうちでもっとも優先度の高いものとして選択されます。次の表に、状態

値の種類を優先度順(優先度の高い順から低い順)と適用可能なターゲット・デバイス・タ

イプを示しています。

状態値 適用対象 状態の説明

アダプター・

ケーブル

電源アウ

トレット

使用中 x なし セッションがアクティブです

パスがブロ

ック状態
x なし ターゲットへのパスは別のセッションが使用中です

アップグ

レード中
x なし アダプター・ケーブルがアップグレード中です

電源オン

処理中
なし x 1つ以上のアウトレットが電源オンです

電源オフ

処理中
なし x 1つ以上のアウトレットが電源オフです

電源なし x なし アダプター･ケーブルで電源が検出されません

電源の一

部
なし x ターゲットにはオン／オフ状態のアウトレットが両方

あります

ロック解除

状態
なし x 1つ以上のアウトレットがロックされています

電源がオ

フになりま

した

なし x 1つ以上のアウトレットが電源オフです

ロック状態 なし x 1つ以上のアウトレットがロック解除されています

アイドル x なし
アクティブなセッションはありません。ケーブル・アダプ

ターには電源が投入されています

電源がオ

ンになりま

した

なし x アウトレットの電源はオンです

表 3.7: ターゲットの状態値
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3.17 電源装置の設定

ターゲット・デバイスに名前でリンクされている複数の電源アウトレットがあり、それらが

共通の電源状態にない場合、アプライアンスは「ロック解除状態」のアウトレット状態を「

オフ」と見なし、「ロック状態」のアウトレット状態を「オン」と見なす場合があります。次の

表に、2つのアウトレットの状態値が組み合わされたときに生じる状態値の一覧を示しま

す。

アウトレット1の状

態

アウトレット2の状

態
結果となる状態

オフ オフ オフ

オフ オン 電源の一部

オン オン 電源がオンになりました

ロック状態 オン 電源がオンになりました

ロック状態 ロック状態 ロック状態

ロック状態 オフ 電源の一部

ロック解除状態 オン 電源の一部

ロック解除状態 ロック解除状態 ロック解除状態

ロック解除状態 オフ 電源がオフになりました

ロック状態 ロック解除状態 電源の一部

表 3.8: 複数のアウトレットの状態値と表示される状態

ローカル・ポートの「ローカル・セッション」ページ

ローカル・ポートの「ローカル・セッション」ページでは、アクティブ・セッションのターゲット

にリンクされている電源アウトレットがある場合、3つの電源コントロールがアクティブ・セ

ッションの下に表示されます。次の図に、Server2という名前のターゲットのアクティブ・

ローカル・ポート・セッションで表示される電源コントロールを示します。
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3.ローカルおよびリモートの構成

図3.7.ローカル・セッション・ページの電源管理
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4. ビデオ・ビューア

4.1 「ビデオ・ビューア」ウィンドウ

OBWIを使用してスイッチに取り付けられているターゲット・デバイスとのKVMセッションを

操作するには、ビデオ・ビューアを使用します。ビデオ・ビューアを使用してデバイスに接

続すると、ターゲット・デバイスのデスクトップが別個のウィンドウに表示されます。この

ウィンドウには、ローカル・カーソルとターゲット・デバイスのカーソルの両方が含まれて

います。

スイッチのOBWIソフトウェアでは、Javaベースのプログラムを使用して、「ビデオ・ビュー

ア」ウィンドウを表示します。スイッチのOBWIは、初めて起動したときにビデオ・ビューア

を自動的にダウンロードして、インストールします。

セッションを起動するには、Java 1.6.0_11以降が必要です。

スイッチのOBWIは、Java RuntimeEnvironment(JRE)をインストールしません。JREは無料

でhttp://www.sun.comからダウンロードできます。

スイッチのOBWIは、システム・メモリーを使用して、「ビデオ・ビューア」ウィンドウ内にイメー

ジを保存して表示します。開かれた「ビデオ・ビューア」ウィンドウには、追加のシステム・メ

モリーがそれぞれ必要です。クライアント・サーバーで色を8ビットに設定すると、「ビデオ・

ビューア」ウィンドウあたり1.4 MBのメモリーが必要です。16ビットに設定すると2.4MB、32ビ

ットに設定すると6.8 MBのメモリーが必要です。システム・メモリーが許容する(通常4つ)以

上の「ビデオ・ビューア」ウィンドウを開こうとすると、メモリー不足エラーが発生し、要求し

た「ビデオ・ビューア」ウィンドウは開きません。

アクセスしようとしているデバイスを別のユーザーが表示中である場合、このユーザー

のプリエンプト操作レベルと同等またはそれ以上のプリエンプト操作レベルが自分に許

可されていれば、相手のユーザーをプリエンプトするよう指示するメッセージが表示され

ます。また、アプライアンス管理者も、アクティブなユーザーを「アクティブ・セッション」の

ページから接続解除することができます。詳細については、「KVM s4スイッチ・セッショ

ン」(ページ25) を参照してください。
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4.ビデオ・ビューア

図4.1. 「ビデオ・ビューア」ウィンドウ(通常のウィンドウ・モード)

表 4.1. 図 4.1の説明

番号 説明

1
タイトル・バー：表示されているターゲット・デバイスの名前を表示します。全画

面表示モードではタイトル・バーが隠され、ターゲット・デバイス名がメニューと

ツールバーの間に表示されます。

2 画鋲アイコン：メニューとツールバーをロックして、常に表示されるようにします。

3

メニューおよびツールバー：「ビデオ・ビューア」ウィンドウ機能の多くには、ここか

らアクセスできます。画鋲を使用していない場合、メニューとツールバーは表

示／非表示状態になります。ツールバー上にカーソルを移動すると、メニュー

とツールバーが表示されます。ツールバーには10個までのコマンドやマクロ・グ

ループ・ボタンを表示できます。デフォルトでは、ツールバーには、シングル・カー

ソル・モード、更新、自動ビデオ調整、ローカルカーソルを合わせるの各ボタン

が表示されます。詳細については、「ツールバーの変更」(ページ49)および「マ

クロ」(ページ67)を参照してください。

4
マクロ・ボタン：ターゲット・デバイスへの送信に通常使われるキーボード・シーケ

ンスです。
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4.1 「ビデオ・ビューア」ウィンドウ

番号 説明

5 最小化ボタン：「ビデオ・ビューア」ウィンドウの画面をローカル・コンピューターの

下部にあるタスク・バーに最小化します。

6

最大化ボタン：ウィンドウを全画面表示モードに変更します。アクセスされたデ

バイスのデスクトップが画面全体に拡大されます。ウィンドウを拡大すると以下

のことが起こります：

タイトル・バーが非表示になります。

ターゲット・デバイス名がメニューとツールバーの間に表示されます。

「最大化」ボタンが「通常のウィンドウ・モード」ボタンに変化し、ツールバー上に

表示されます。このボタンをクリックすると、「ビデオ・ビューア」ウィンドウと「通常

のウィンドウ」モードが切り替わります。

「閉じる」ボタンがツールバーに表示されます。

7
「閉じる」ボタン：「ビデオ・ビューア」ウィンドウを閉じます。

注：このボタンは、オペレーティング・システムによっては表示されません。

8
アクセスしたデバイスのデスクトップ：このウィンドウを介してデバイスと相互に通

信します。

9 フレーム：「ビデオ・ビューア」ウィンドウのサイズを変更するには、フレームをクリッ

クしてホールドします。

ツールバーの変更

表示／非表示状態(つまり、画鋲によって所定の位置にロックされていない)にあるツール

バーが「ビデオ・ビューア」ウィンドウで非表示になるまでの秒数を指定することができま

す。

ツールバーの非表示時間を指定するには次の手順を実行します。

1. 「ビデオ・ビューア」ウィンドウのメニューから、ツール →セッション・オプションの順

に選択します。

-または-

セッション・オプションボタンをクリックします。

「セッション・オプション」ダイアログ・ボックスが表示されます。

2. ツールバー タブをクリックします。
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4.ビデオ・ビューア

3. 矢印キーを使用して、ツールバーが非表示になるまでの待ち時間(秒数)を指定しま

す。

4. OKをクリックして変更を保存し、ダイアログ・ボックスを閉じます。

4.2 セッションの起動

非プロキシ接続を使用している場合、低速のネットワーク接続では最適のビデオ・パフ

ォーマンスが得られないことがあります。一部の色設定(グレースケールなど)では他の設

定(色－最適化など)ほどネットワーク帯域を使用しないため、色設定を変更するとビデオ・

パフォーマンスを改善できることがあります。低速のネットワーク接続で最適のビデオ・パ

フォーマンスを得るには、「グレースケール／圧縮－最適化」または「色－低／圧縮－高」

などの色設定を使用してください。詳細については、「表示形態の調整」(ページ51)を参照

してください。

ユーザーがローカル・コンピューターより高い画面解像度でターゲット・デバイスに接続した

場合には、ターゲット・デバイス画面の一部が「ビデオ・ビューア」ウィンドウに表示され、画

面残りの部分はスクロール・バーで参照するようになります。この場合は、ターゲット・デバ

イスまたはローカル・コンピューター(またはこの両方)の解像度を調整すれば、画面全体

が表示できるようになります。

スイッチのExplorerウィンドウからKVMセッションを起動するには次の手順を実行します。

1. ターゲット・デバイス画面で一覧表示されたデバイスをクリックし、「ユニット概要」ウ

ィンドウを開きます。

2. KVMセッションリンクをクリックし、新しいウィンドウでビデオ・ビューアを開きます。

セッションのタイムアウト

一定の時間枠内に「セッション」ウィンドウでアクティビティがなかった場合、リモート・セッ

ションはタイムアウトとなることがあります。セッションのタイムアウトの時間枠は、アプラ

イアンスの「KVMセッション設定」ウィンドウで指定します。指定したタイムアウト値は、次

にスイッチのOBWIにアクセスしたときに使用されます。

セッションのタイムアウトを有効、無効にする、またはタイムアウト値を指定するには：

1. サイド・メニューで、ユニットの表示 →アプライアンス →アプライアンスの設定→

セッション→一般の順に選択します。

2. アイドル タイムアウトを有効にするボックスの目的の設定を選びます。

3. 必要に応じて、アクティビティなしによるタイムアウトの時間枠を指定します。

4. 保存をクリックします。
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4.3 ウィンドウ・サイズ

4.3 ウィンドウ・サイズ

表示→ スケール・コマンドは、「ビデオ・ビューア」ウィンドウが全画面表示モードになって

いる場合は使用できません。また、共有セッションの非プライマリ・ユーザーは使用できま

せん。

スイッチのOBWIを初めて使用した場合、開いている「ビデオ・ビューア」ウィンドウはすべ

て、ユーザーが値を変更するまで、1024 x 768の解像度で表示されます。「ビデオ・ビ

ューア」ウィンドウは、それぞれ異なる解像度に設定できます。

自動スケールが有効になっている場合は、セッション中にウィンドウ･サイズが変わって

も、スイッチのOBWIは表示を自動調整します。ターゲット・デバイスの解像度がセッショ

ン中に変更された場合でも、表示は自動調整されます。

「ビデオ・ビューア」ウィンドウの解像度を変更するには次の手順を実行します。

1. 表示→スケールコマンドを選択します。

2. 希望の解像度を選択します。

4.4 表示形態の調整

「ビデオ・ビューア」ウィンドウ内のメニューやタスク・ボタンでは、次の機能を実行できま

す：

• マウス・カーソルの位置を合わせる。

• 画面を更新します。

• 全画面表示モードを有効／無効にする。全画面表示モードが有効の場合は、イメー

ジはデスクトップに合わせて最大1600 x 1200または1680 x 1050(ワイドスクリーン)

のサイズまで調整されます。デスクトップの解像度がより高い場合は、次の現象が

発生します。

• 全画面画像はデスクトップの中央に表示され、この外枠となる「ビデオ・ビュー

ア」ウィンドウ領域が黒く表示されます。

• メニューとツールバーはロックされ、常に表示された状態になります。

• セッション画像の自動／フル／手動スケールのサイズ調整を有効にする。

• フル・スケールでは、デスクトップ・ウィンドウは固定され、デバイスの画像はウ

ィンドウに合わせてサイズ調整されます。

• 自動スケールでは、表示中のターゲット・デバイスの解像度に合わせてデスク

トップ・ウィンドウのサイズが調整されます。
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4.ビデオ・ビューア

• 手動スケールでは、サポートされている画像スケーリング解像度がドロップダ

ウン・メニューに表示されます。

• セッション画像の色の階調を変更する。

マウス・カーソルの位置を合わせるには次の手順を実行します。

「ビデオ・ビューア」ウィンドウのツールバーで、ローカル・カーソルの位置を合わせるボタ

ンをクリックします。ローカル・カーソルの位置がリモート・デバイス上のカーソルと揃い

ます。

カーソルが調整した位置からずれた場合は、接続されているデバイスでのマウス加速度

をオフにしてください。

画面を更新するには、「ビデオ・ビューア」ウィンドウで、イメージの更新 ボタンをクリック

するか、「ビデオ・ビューア」ウィンドウのメニューから表示→更新の順に選択します。デ

ジタル化されたビデオ画像が完全に再生成されます。

全画面表示モードを有効にするには、最大化 ボタンをクリックするか、「ビデオ・ビュー

ア」ウィンドウのメニューから表示→全画面 の順に選択します。デスクトップ・ウィンドウ

は非表示の状態になり、アクセス中のデバイスのデスクトップのみが表示されます。画

面は最大1600 x 1200または1680 x 1050(ワイドスクリーン)にサイズ変更されます。モニ

ターのデスクトップ解像度がこれより高い場合は、フル・スクリーン画像が黒の背景で縁

取られます。浮動ツールバーが表示されます。

全画面表示モードを無効にするには、浮動ツールバー上の全画面表示 ボタンをクリック

して、デスクトップ・ウィンドウに戻ります。

フル･スケールを有効にするには、「ビデオ・ビューア」ウィンドウのメニューから表示 →

スケール を選択します。表示中のターゲット・デバイスの解像度に合わせて、デバイス

の画像が自動的に調整されます。

手動スケールを有効にするには、「ビデオ・ビューア」ウィンドウのメニューから表示→ ス

ケールの順に選択します。ウィンドウに適用するサイズを選択します。利用可能な手動

スケールのサイズはシステムによって異なります。

4.5 イメージの更新

手動ビデオ調整ダイアログ・ボックスのイメージの更新 ボタンをクリックすると、デジタル

化されたビデオ画像が完全に再生成されます。

またイメージは、「ビデオ・ビューア」ウィンドウのメニューから表示→更新の順に選択して

更新することもできます。
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4.6 ビデオの設定

その他のビデオ調整

通常、「ビデオ・ビューア」ウィンドウの自動調整機能を選択した場合には、調整可能な範

囲で最高のビデオ画像に最適化されます。ただし、富士通のテクニカル・サポートに問い

合わせた上で、「ビデオ・ビューア」ウィンドウ・メニューのツール →手動ビデオ調整コマ

ンドを使用するか、手動ビデオ調整 ボタンをクリックして、ユーザーが画質を微調整する

ことができます。これにより、手動ビデオ調整ダイアログ・ボックスが表示されます。ビデ

オ調整はターゲット単位の設定です。

ユーザーは、ダイアログ・ボックスの左下にあるパケット・レートを見ながら、静的画面を

サポートするために必要なパケット数／秒のレベルを確認できます。

ウィンドウのビデオ画質を手動で調整するには次の手順を実行します。

次のビデオ調整は、富士通テクニカル・サポートに連絡し、指示を受けて行ってください。

1. 「ビデオ・ビューア」ウィンドウのメニューから、ツール→手動ビデオ調整 の順に選

択します。

-または-

手動ビデオ調整ボタンをクリックします。

手動ビデオ調整ダイアログ・ボックスが表示されます。

図4.2.手動ビデオ調整ダイアログ・ボックス
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番号 説明 番号 説明

1
画像キャプチャーの

幅
8 ピクセル・ノイズしきい値

2
ピクセル・サンプリン

グ／微調整
9 自動ビデオ調整

3
画像キャプチャーの

水平位置
10 画像の更新

4
画像キャプチャーの

垂直位置
11 調整バー

5 コントラスト 12 ビデオ・テスト・パターン

6 明るさ 13 性能モニター

7
ブロック・ノイズしきい

値
14 閉じるボタン

表 4.2: 図 4.2の説明

2. 調整したい機能に対応するアイコンをクリックします。

3. まず、コントラスト・スライダー・バーを移動し、その後最小(-)または最大(+)ボタンを

クリックして、押されている各アイコンに対応するパラメーターを微調整します。調整

は即座に「ビデオ・ビューア」ウィンドウに表示されます。

4. 完了したら閉じるをクリックして、手動ビデオ調整ダイアログ・ボックスを閉じます。

ターゲット・ビデオの設定

イメージ・キャプチャーの幅、ピクセル・サンプリング／微調整、イメージ・キャプチャーの

水平位置、イメージ・キャプチャーの垂直位置の調整は、目的のビデオがどのようにキ

ャプチャーされ、デジタル化されるかに影響しますが、ほとんど変更されることはありま

せん。

イメージ・キャプチャ・パラメーターは、自動調整機能によって自動的に変更されます。

正確な調整を個別に行うためには、ターゲットに特別のイメージが必要になります。

自動ビデオ調整

大抵の場合、ビデオ設定をデフォルト設定から変更する必要はありません。システムが

自動的に調整を行い、最適なビデオ・パラメーターが適用されます。スイッチのOBWIは、
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ビデオ・パラメーターが静的画面用ビデオ・パケットの送信なし(ゼロ)に設定されていると

きに最高の性能を発揮します。

ビデオ･パラメーターは、手動ビデオ調整ダイアログ･ボックスの自動ビデオ調整ボタンか

ら、簡単に希望の設定に調整できます。

また、ビデオを自動調整することもできます。この場合は、「ビデオ・ビューア」ウィンドウの

メニューから、ツール →自動ビデオ調整 を選択するか、または自動ビデオ調整 ツール

バー・アイコンをクリックします。

ビデオ・テスト・パターン

手動ビデオ調整ダイアログ・ボックスのビデオ・テスト・パターンボタンをクリックすると、

ビデオ・テスト・パターンの表示に切り替わります。ビデオ・テスト・パターン ボタンをもう

一度クリックすると、通常のビデオ画像に切り替わります。

ベンダー特定のビデオ設定

ビデオ設定はメーカー間で大幅に変わります。

4.7 色の設定

色の解像度の調整

Dambrackas Video Compression® (DVC)アルゴリズムでは、リモート･セッション･ウィンド

ウでの表示色数を調整できます。表示色を増やすと色の忠実度がベストになり、色数を

減らすとネットワーク・データ転送量を減らすことができます。必要に応じて調整してくだ

さい。

「ビデオ・ビューア」ウィンドウは、「色－最適化」(更新レートは最も遅くなります)、「圧

縮－最適化」(最も速い更新レート)、またはこの2つの組み合わせ、または「グレース

ケール」で表示できます。

個々のポートとチャンネルの色の階調は、リモート・セッション・ウィンドウで表示 -色コマ

ンドを選択して指定できます。この設定はチャンネル別に保存されます。

コントラストと明るさ

ビデオ・ビューア・ウィンドウの画像が暗すぎたり明るすぎたりする場合は、ツール→ 自

動ビデオ調整の順に選択するか、自動ビデオ調整 ボタンをクリックします。このコマンド

はまた、自動ビデオ調整ダイアログ・ボックスでも使用できます。大概の場合、これでビ

デオの問題は修正されます。

自動調整を数回クリックしてもコントラストと明るさが希望どおりに調整されない場合は、

これらを手動で調整することで改善できる場合があります。明るさのレベルを上げてみま
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す。コントラストを変える前に、10目盛り以上増やさないでください。一般的に、コントラス

トはほんのわずかの変更ですむはずです。

4.8 ノイズの設定

検出しきい値

ビデオ通信のノイズがパケット／秒の読み取り値に影響して値が高くなることがありま

す。この場合、カーソルを動かすとカーソルの周りで小さなドットが変動するため分かり

ます。しきい値を変更すると、「より安定した」画面が得られ、カーソル・トラッキングを改

善できます。

通常のビデオ圧縮を使用している場合、ノイズのしきい値と優先順位のしきい値は変更

できます。またブロック･ノイズしきい値とピクセル･ノイズしきい値も変更できます。しきい

値をデフォルトに戻すには、自動ビデオ調整をクリックします。

ブロック・ノイズしきい値とピクセル・ノイズしきい値

ブロック・ノイズしきい値とピクセル・ノイズしきい値は、変更されたビデオ・ブロック数とピ

クセル数(1,000単位)に対する最小色レベルを許容範囲内で設定します。

• ブロック・ノイズしきい値は、単一ビデオ・ブロック内で発生する最小の色変更を設定

します。値を増やすと、ネットワークの回線容量が減少します。値を減らすと、これ

らのアーチファクトのサイズが小さくなります。

• ピクセル・ノイズしきい値は、単一ピクセル内の最小色変更を設定します。値を減ら

すと、低コントラストのアーチファクトの数が減りますが、ネットワークの回線容量が

増加します。

色の階調の変更に関する詳細は、「表示形態の調整」(ページ51) を参照してください。

4.9 マウスの設定

マウス・オプションの調整

「ビデオ・ビューア」ウィンドウのマウス・オプションでは、カーソル・タイプ、カーソル・モー

ド、マウス・スケール、位置合わせ、およびリセットを調整できます。マウスの設定は、デ

バイスで固有です。すなわち、デバイスごとに異なる設定ができます。

マウスをプラグ・アンド・リプラグする機能をデバイスでサポートしていない場合(新しいPC

のほとんどがこの機能をサポートしています)、マウスは使用不能になり、デバイスの再起

動が必要になります。
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カーソル・タイプ

「ビデオ・ビューア」ウィンドウのメニューではローカルのマウス・カーソル用に5種類の表

示オプションがあります。また、カーソル「なし」か、デフォルト設定にすることもできま

す。

「シングル・カーソル」モードでは、「ビデオ・ビューア」ウィンドウのローカル(第二)カーソ

ルの表示がオフになり、ターゲット・デバイスのマウス・ポインターだけが表示されます。

表示されるマウスの動きは、ターゲット・デバイスのリモート・カーソルのものだけになり

ます。「シングル・カーソル」モードは、ローカル・カーソルが不要な場合に使用します。

図4.3. 「ビデオ・ビューア」ウィンドウにローカルとリモートの両方のカーソルが表示された状態

番号 説明

1 リモート・カーソル

2 ローカル・カーソル

表 4.3: 図 4.3の説明

「ビデオ・ビューア」ウィンドウがどのカーソル・モードになっているかは、タイトル・バー

に、「シングル・カーソル」モードの終了に使用するキーストロークと共に表示されます。「

シングル・カーソル」モードを終了させるためのキーストロークは、「セッション・オプショ

ン」ダイアログ・ボックスで定義できます。
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クライアント・サーバーに送られる前にキーストロークをキャプチャーするデバイスを使用し

ている場合は、マウス・ポインターの復元にこれらのキーを使用することは避けてください。

「シングル・カーソル」モードを開始するには、「ビデオ・ビューア」ウィンドウのメニューか

らツール→ シングル・カーソル・モード の順に選択するか、またはシングル・カーソル・

モードボタンをクリックします。ローカル・カーソルは表示されず、すべての動きがターゲ

ット・デバイスに対応します。

既存の「シングル・カーソル」モードを終了するためのキーを選択するには：

1. 「ビデオ・ビューア」ウィンドウのメニューから、ツール →セッション・オプションの順

に選択します。

-または-

セッション・オプションボタンをクリックします。

「セッション・オプション」ダイアログ・ボックスが表示されます。

2. マウス タブをクリックします。

3. 「シングル・カーソル」モード領域内のドロップダウン・メニューから、終了用キースト

ロークを選択します。

4. 保存をクリックして、設定を保存します。

「シングル・カーソル」モードを有効にした場合、先ほど指定したキーを使用すれば、「通

常のデスクトップ」モードに戻れます。

「シングル・カーソル」モードを終了するには、タイトル・バーに表示されている終了用の

キーを押します。

マウス・カーソルの設定を変更するには次の手順を実行します。

1. 「ビデオ・ビューア」ウィンドウのメニューから、ツール →セッション・オプションの順

に選択します。

-または-

セッション・オプションボタンをクリックします。

「セッション・オプション」ダイアログ・ボックスが表示されます。

2. マウス タブをクリックします。

3. 「ローカル・カーソル」パネルでマウス・カーソル・タイプを選択します。

4. OKをクリックして設定内容を保存します。
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マウス・スケール

Linuxの以前バージョンの一部では、マウス加速度の調整がサポートされていませんで

した。これらの古いバージョンにインストールする必要がある場合は、事前設定されてい

る3種類のマウス・スケール・オプションから選ぶか、またはカスタム・スケールを設定で

きます。既定の設定にはデフォルト(1:1)、高(2:1)、または低(1:2)があり、次のようになっ

ています：

• 1:1のスケール率では、デスクトップ・ウィンドウでのマウスのすべての動きは、実際

のマウスの動きと等しい動きとしてターゲット・デバイスに送られます。

• 2:1のスケール率では、同一のマウスの動きは2倍速の動きとして送られます。

• 1：2のスケール率では、この値は2分の1になります。

マウス・スケールを設定するには：

1. 「ビデオ・ビューア」ウィンドウのメニューから、ツール →セッション・オプションの順

に選択します。

-または-

セッション・オプションボタンをクリックします。

「セッション・オプション」ダイアログ・ボックスが表示されます。

2. マウス タブをクリックします。

3. 規定の設定の1つを使用するには、該当するオプション・ボタンをオンにします。

-または-

カスタム・スケールを設定するには：

a. カスタム オプション・ボタンをクリックして、XフィールドとYフィールドを有効にし

ます。

b. スケール値をXフィールドとYフィールドに入力します。マウスの各入力に対し、

マウスの動きは、XとYの各スケール係数を乗じた動きとなります。有効な入力

範囲は、0.25～3.00です。

マウスの位置合わせと同期

スイッチのスイッチOBWIではマウスからのフィードバックを継続的に得ることはできない

ため、スイッチでのマウスの動作がホスト・システムのマウス動作と同期しなくなることが

あります。マウスやキーボードが正しく応答しなくなった場合は、マウスを調整して適切な

トラッキングが得られるようにできます。

位置合わせを調整することで、ローカル・カーソルがリモート・ターゲット・デバイスの

カーソルと揃うようになります。リセットを行うと、マウスとキーボードを一度接続解除して

接続し直したかのような効果が得られます。
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マウスの位置を再度合わせるには、「ビデオ・ビューア」ウィンドウのツールバーでローカ

ルカーソルの位置を合わせるボタンをクリックします。

4.10 バーチャル・メディア

バーチャル・メディア機能を使用すると、クライアント・サーバー上のユーザーは、そのマ

シンの物理ドライブをバーチャル・ドライブとしてターゲット・デバイス上にマッピングでき

ます。また、クライアント・サーバーはISOまたはフロッピーのイメージ・ファイルをバーチ

ャル・ドライブとしてターゲット・デバイス上に追加し、マッピングできます。同時にマッピン

グできるのは、CDドライブ1台と大容量記憶装置1台です。

• CD／DVDドライブ、ディスク・イメージ・ファイル(ISOまたはフロッピーのイメージ・フ

ァイルなど)は、バーチャルCD／DVD-ROMドライブとしてマッピングされます。

• フロッピー・ドライブ、USBメモリー・デバイス、その他のメディア・タイプは、バーチャ

ル大容量記憶装置としてマッピングされます。

OBWIを使用したバーチャル・メディアの設定の構成に関する詳細は、「バーチャル・メデ

ィア」(ページ31) を参照してください。

要件

ターゲット・デバイスは、バーチャル・メディアをサポートし、KVM s4アダプターUSB20-

VGAアダプター・ケーブルを備えたKVMスイッチに接続されている必要があります。

ターゲット・デバイスは、バーチャルにマッピングしようとしているUSB2対応メディア・タイ

プを利用可能なデバイスである必要があります。すなわち、ターゲット・デバイスがポー

タブルUSBメモリー・デバイスをサポートしていない場合は、クライアント・サーバー上の

メモリー・デバイスをバーチャル・メディア・ドライブとしてターゲット・デバイスにマッピン

グすることはできません。

ユーザー(またはユーザーが所属するユーザー・グループ)には、ターゲット・デバイスに

対するバーチャル・メディア・セッションや予約済みバーチャル・メディア・セッションを確

立するアクセス権が必要です。「ユーザー・アカウント」(ページ35) を参照してください。

ターゲット・デバイスに対してアクティブにできるバーチャル・メディア・セッションは、一度

に1つだけです。

共有およびプリエンプト操作での注意事項

KVMセッションとバーチャル・メディア・セッションは別個のものです。したがって、共有／

専用／プリエンプト・セッションには多くのオプションがあります。DSView 3ソフトウェアに

は、様々なシステム・ニーズに対応するだけの柔軟性があります。

たとえば、KVMセッションとバーチャル・メディア・セッションを同時にロックできます。この

モードでは、KVMセッションの接続が解除されると、関連付けられているバーチャル・メデ
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ィア・セッションの接続も解除されます。これらのセッションが同時にロックされていない

場合は、バーチャル・メディア・セッションをアクティブにしたまま、KVMセッションを終了

できます。この機能は、ユーザーがバーチャル・メディア・セッションを使用して時間がか

かるタスク(オペレーティング・システムのロードなど)を実行しているときに、処理の進行

中に他の機能を実行するために異なるターゲット・デバイスとKVMセッションを確立した

い場合などに役立ちます。

関連するKVMセッションなしにバーチャル・メディア・セッションがターゲット・デバイスで

いったんアクティブになった場合は、そのチャンネルにオリジナル・ユーザー(ユー

ザーA)が再接続するか、別のユーザー(ユーザーB)が接続できます。バーチャル・メデ

ィア・ダイアログ・ボックスにあるオプション(「予約済み」)を設定すると、KVMセッションで

そのチャンネルへのアクセスをユーザーAにのみ許可できます。

ユーザーBにこのKVMセッションへのアクセスを許可した(「予約済み」オプションが無効

になっている)場合は、ユーザーBがバーチャル・メディア・セッションで使用されているメ

ディアを制御できます。ティアド(階層)接続環境で「予約済み」オプションを使用すると、

ユーザーAにのみ下層スイッチへのアクセスを許可し、また上層スイッチと下層スイッチ

間のKVMチャンネルをユーザーA用に予約できます。

バーチャル・メディア・ダイアログ・ボックス

バーチャル・メディア・ダイアログ・ボックスでは、バーチャル・メディアのマッピングとアン

マッピングを管理できます。このダイアログ・ボックスには、バーチャル・ドライブとしてマ

ッピング可能なクライアント・サーバー上の物理ドライブがすべて表示されます。バーチ

ャル・メディア・ダイアログ・ボックスを使用すると、ISOやフロッピーのイメージ・ファイルを

追加した後で、それらをマッピングすることもできます。

デバイスをマッピングすると、バーチャル・メディア・ダイアログ・ボックスの詳細表示に、

転送されたデータ量と、デバイスのマッピング後に経過した時間に関する情報が表示さ

れます。

バーチャル・メディア・セッションは、予約済みとして指定できます。セッションが予約さ

れ、関連付けられているKVMセッションが終了した場合は、他のユーザーがこのターゲ

ット・デバイスへのKVMセッションを起動することはできません。セッションが予約されて

いない場合は、別のKVMセッションを起動できます。

「バーチャル・メディア」ダイアログ・ボックスからは、USB2アダプター・ケーブルをリセット

することもできます。この操作により、ターゲット・デバイス上のすべてのUSBメディアが

リセットされます。この操作はターゲット・デバイスが応答しない場合にのみ、注意して実

行してください。
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バーチャル・メディア・セッションの開始

バーチャル・メディア・セッションを起動するには次の手順を実行します。

ビデオ・ビューアのメニューから、ツール →バーチャル・メディア を選択します。バーチ

ャル・メディア・ダイアログ・ボックスが表示されます。セッションを予約済みにするには、

詳細をクリックしてから、予約済みチェックボックスをオンにします。

図4.4.ビデオ・ビューアのバーチャル・メディア・ダイアログ・ボックス

バーチャル・メディア・ドライブをマッピングするには次の手順を実行します。

1. ビデオ・ビューアのメニューから、ツール→バーチャル・メディア を選択してバーチ

ャル・メディア・セッションを開始します。

2. バーチャル・メディア・ドライブとして物理ドライブをマッピングするには次の手順を実

行します。

a. バーチャル・メディア・ダイアログ・ボックスで、マッピングするドライブの横にあ

るマッピング済みチェックボックスをクリックします。

b. マッピングするドライブを読み取り専用アクセスに制限する場合は、ドライブの

横にある読み取り専用チェックボックスをクリックします。マッピングされたすべ

てのドライブがバーチャル・メディア・セッションの設定で既に読み取り専用に

なっている場合は、このチェックボックスはすでに有効になっており、変更する

ことはできません。
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セッションの設定で読み取り／書き込みアクセスが有効になっている

ものの、特定のドライブへのアクセスを読み取り専用に制限したい場

合には、読み取り専用チェックボックスを有効にすることもできます。

3. ISOまたはフロッピー・イメージをバーチャル・メディア・ドライブとして追加してマッピ

ングするには次の手順を実行します。

a. バーチャル・メディア・ダイアログ・ボックスで、イメージの追加 をクリックしま

す。

b. 共通のファイル・ダイアログ・ボックスが表示され、ディスク・イメージ・ファイ

ル(.isoか.imgの拡張子を持つファイル)を格納しているディレクトリが表示されま

す。ISOまたはフロッピー・イメージ・ファイルを選択して、開く をクリックします。

-または-

クライアント・サーバーのオペレーティング・システムがドラッグ・アン

ド・ドロップをサポートしている場合は、ISOまたはフロッピー・イメー

ジ・ファイルを共通ファイル・ダイアログ・ボックスから選択し、それを

バーチャル・メディア・ダイアログ・ボックスにドラッグします。

c. 確認のため、ファイル・ヘッダーにチェック印がつきます。チェック印がつくと共

通ファイル・ダイアログ・ボックスが閉じ、選択したイメージ・ファイルがバーチャ

ル・メディア・ダイアログ・ボックスに表示されます。このダイアログ・ボックスの

マッピング済みチェックボックスをオンにすると、ファイルのマッピングが可能に

なります。

d. 他にもISOやフロッピー・イメージを追加したい場合は、これらの手順を繰り返し

ます。イメージ・ファイルは(メモリーの容量範囲内で)いくつでも追加できます

が、バーチャルのCD、DVDまたは大容量記憶装置は同時に1つしかマッピング

できません。

マッピングしようとしているドライブの数が多すぎたり(1台のCDまたはDVDドライブと1台

の大容量記憶装置)、特定タイプのドライブの数が多すぎる(2台以上のCDまたはDVDド

ライブか大容量記憶装置)場合は、メッセージが表示されます。新しいドライブをマッピン

グする場合は、まず現在マッピングされているドライブをアンマップしてから別のドライブ

をマッピングする必要があります。

物理ドライブかイメージのマッピングが完了すると、ターゲット・デバイスで使用できるよう

になります。

バーチャル・メディア・ドライブをアンマップするには次の手順を実行します。

1. バーチャル・メディア・ダイアログ・ボックスで、アンマップするドライブの横にあるマ

ッピング済み チェックボックスをオフにします。
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2. 確認を求めるメッセージが表示されます。アンマップを確定するか、キャンセルしま

す。

3. アンマップするバーチャル・メディア・ドライブごとに上記の手順を繰り返します。

バーチャル・メディア・ドライブの詳細を表示するには次の手順を実行します。

バーチャル・メディア・イアログ・ボックスで、詳細 をクリックします。ダイアログ・ボックス

が拡張され、「詳細」の表が表示されます。各行の情報は、次のとおりです：

• ターゲット・ドライブ －マッピングされたドライブの名前(バーチャルCD 1やバーチャ

ルCD 2など)。

• マッピング先 － 「クライアント表示」の「ドライブ」列に表示されているドライブ情報と

同じ。

• 読み取りバイト数および書き込みバイト数 － マッピングを行ってから転送された

データ量。

• 継続時間－ドライブをマッピングしてから経過した時間。

「詳細」ビューを閉じるには、詳細を再度クリックします。

ターゲット・デバイス上のすべてのUSBデバイスをリセットするには次の手順を実行しま

す。

USBリセット機能は、ターゲット・デバイス上のすべてのUSBメディア(マウスおよびキーボー

ドを含む)をリセットします。この操作を実行するのはターゲット・デバイスが応答しない場合

のみに限定してください。

1. バーチャル・メディア・イアログ・ボックスで、詳細をクリックします。

2. 「詳細」ビューが表示されます。USBのリセット をクリックします。

3. リセットした場合の影響を警告するメッセージが表示されます。リセットを確定する

か、キャンセルします。

4. 「詳細」ビューを閉じるには、詳細を再度クリックします。

バーチャル・メディア・セッションの終了

バーチャル・メディア・ダイアログ・ボックスを閉じるには次の手順を実行します。

1. 終了をクリックします。

2. マッピングしたドライブがある場合は、アンマップされる旨のメッセージが表示されま

す。操作を確定するか、キャンセルします。
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バーチャル・メディア・セッション、もしくはバーチャル・メディア・セッションが関連付けら

れてロックされたアクティブなKVMセッションをユーザーが接続解除しようとすると、バー

チャル・メディアのマッピングが失われる旨の確認メッセージが表示されます。

4.11 スマート･カード

クライアント･サーバーの利用可能なUSBポートにスマート･カード･リーダーを接続して、

スイッチ･システムに接続されているターゲット・デバイスにアクセスできます。その

後、KVMセッションを起動してビデオ・ビューアを開き、スマート・カードをマッピングできま

す。

すべてのスマート・カード・リーダーの場合、KVM s4アダプターUSB20-VGAアダプター・ケー

ブルを使用する必要があります。

スマート・カードの状態は、ビデオ・ビューアのツールバーの右端にあるスマート・カード・

アイコンに表示されます。次の表にスマート・カード・ステータス・アイコンの概要を示しま

す。

表 4.4. スマート･カードのアイコン

アイコン 説明

スマート・カードがスマート・カード・リーダーに挿入されていないか、またはスマー

ト・カード・リーダーが接続されていません。

スマート・カードはスマート・カード・リーダーに挿入されていますが、まだマッピン

グされていません。

スマート・カードはマッピングされています。

スマート・カードをマッピングするには次の手順を実行します。

1. KVMセッションを開始し、「ビデオ・ビューア」ウィンドウのメニューを表示します。

2. クライアント･サーバーに接続されているスマート･カード･リーダーにスマート･カード

を挿入します。

3. 「ビデオ・ビューア」ウィンドウのメニューで、ツール→スマート・カードのマッピング

の順にクリックします。

4. ターゲット・デバイスにマッピングされているスマート・カードがない場合は、「マッピ

ング済みのカードはありません」オプションの横にドットが表示されます。このオプシ

ョンの下の一覧からスマート・カードを選び、スマート・カードをマッピングします。
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スマート・カードをアンマップするには、「ビデオ・ビューア」ウィンドウのメニューのXをクリ

ックしてKVMセッションを終了し、ツール→マッピング済みのカードはありません の順に

選択し、スマート・カード・リーダーからスマート・カードを取り外すか、またはクライアン

ト・サーバーとスマート・カード・リーダーとの接続を解除します。

4.12 キーボード・パススルー

ユーザーが入力するキーストロークは、「ビデオ・ビューア」ウィンドウの画面表示モード

に従って2種類に解釈されます。

• ビデオ・ビューア・ウィンドウが全画面表示モードの場合、すべてのキーストロークお

よびCtrl-Alt-Delを除くキーストロークの組み合わせのすべてが、表示中のリモー

ト・ターゲット・デバイスに送られます。

• ビデオ・ビューア・ウィンドウが通常のデスクトップ・モードの場合、特定のキースト

ロークやキーの組み合わせをリモート・ターゲット・デバイスとローカル・コンピュー

ターのどちらで認識させるようにするかを、キーボード・パス・スルー・モードによって

制御できます。

これには、キーボード・パススルーを「セッション・オプション」ダイアログ・ボックスで設定

する必要があります。キーボード・パス・スルー・モードが有効になっていると、ビデオ・ビ

ューア・ウィンドウがアクティブであれば、すべてのキーストロークおよびCtrl-Alt-Delを

除くキーストロークの組み合わせのすべてが、表示中のリモート・ターゲット・デバイスに

送られます。ローカル・デスクトップがアクティブになっている場合、ユーザーが入力した

キーストロークとキーストロークの組み合わせはローカル・コンピューターに反映されま

す。

Ctrl-Alt-Deleteのキーストロークの組み合わせは、マクロを使用しなければリモート・ター

ゲット・デバイスに送ることはできません。

日本語キーボードのALT - 半角／全角キーストロークの組み合わせは、画面モードや

キーボード・パス・スルー・モードの設定に関係なく、常にリモート・ターゲット・デバイスに送

られます。

キーボード・パススルーを指定するには：

1. 「ビデオ・ビューア」ウィンドウのメニューから、ツール →セッション・オプションの順

に選択します。

-または-

セッション・オプションボタンをクリックします。

「セッション・オプション」ダイアログ・ボックスが表示されます。

2. 一般 タブをクリックします。

3. 通常ウィンドウ・モードでは全キーストロークが許可されます を選択します。
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4. OKをクリックして、設定を保存します。

4.13 マクロ

スイッチのOBWIには、Windows、Linux、およびSunのプラットフォーム用にマクロが既定

されています。

マクロを実行するには、ビデオ・ビューア・ウィンドウ・メニューからマクロ→ <目的のマク

ロ> を選択するか、またはビデオ・ビューア・メニューにあるボタンから実行するマクロを

選択します。

4.14 表示の保存

ビデオ・ビューアの表示は、ファイルに保存するか、またはクリップボードにコピーして、

ワード・プロセッサーやその他のプログラムで使用できます。

「ビデオ・ビューア」ウィンドウをファイルにキャプチャーするには：

1. 「ビデオ・ビューア」ウィンドウのメニューから、ファイル→ ファイルにキャプチャ の

順に選択します。

-または-

ファイルにキャプチャ ボタンをクリックします。

「名前をつけて保存」ダイアログ・ボックスが表示されます。

2. ファイル名を入力し、ファイルの保存先を指定します。

3. 保存ボタンをクリックし、ウィンドウの画像をファイルに保存します。

「ビデオ・ビューア」ウィンドウをクリップボードにキャプチャーするには、「ビデオ・ビュー

ア」ウィンドウのメニューからファイル→クリップボードにキャプチャ の順に選択するか、

またはクリップボードにキャプチャ ボタンをクリックします。イメージ・データがクリップ

ボードに保存されます。

4.15 セッションの終了

「ビデオ・ビューア」ウィンドウ・セッションを終了するには次の手順を実行します。

ビデオ・ビューア・ウィンドウからファイル→終了 の順に選択します。
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5. LDAP

LDAPはベンダー固有のプロトコル規格で、TCP/IPを介したディレクトリへのアクセス、ク

エリー、更新に使用されるのものです。LDAPはX.500 Directory Servicesの様式に準拠し

ており、認証、プライバシー、完全性をはじめとする強固なセキュリティ機能をサポートす

る世界規模のディレクトリ構造です。

Active Directoryのような、LDAP認証が有効化されたディレクトリ・サービスに個々の

ユーザー・アカウントが保存されている場合、ディレクトリ・サービスによりユーザー認証

を行うことができます。LDAP検索およびクエリのパラメーターに対するデフォルト値

は、Active Directoryとの併用を前提に定義されています。

OBWIで実行される設定により、認証構成のパラメーターを構成します。ソフトウェアが

ユーザー名、パスワード、その他の情報をアプライアンスに送信すると、このユーザー

がOBWI内のアプライアンスの構成パラメーターを参照・変更する権限を持っているかど

うかがアプライアンスにより判断されます。

ActiveDirectoryが再設定されている場合を除き、他に特に規定がなければLDAPのデフ

ォルト値を使用してください。デフォルト値を変更すると、LDAP認証サーバーの通信エ

ラーとなることがあります。

5.1 ユーザー・インターフェイスでのLDAPの構成

OBWIの「LDAP概要」ページで、LDAP認証の優先順位とLDAPサーバーの接続情報を定

義するパラメーターを設定することができます。

LDAPパラメーターの概要

LDAP認証の優先順位

OBWIの「LDAPの優先順位」セクションで、LDAPを無効にするか、ローカル認証とLDAP

認証のどちらを先に行うか選択して認証の優先順位を設定することができます。

LDAP認証の優先順位パラメーターを設定するには：

1. アプライアンス →アプライアンスの設定→ユーザー・アカウント → LDAPアカウン

ト →概要を順に選択します。

2. 「LDAP優先度」には、DAP無効、LDAPはローカルの前 または LDAPはローカルの

後のいずれかを選択します。

3. 保存をクリックします。
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LDAPサーバー

「アドレス」フィールドでは、プライマリおよびセカンダリLDAPサーバーのホスト名また

はIPアドレスを指定します。LDAPのセカンダリ・サーバーは任意です。

「ポート」フィールドでは、LDAPサーバーとの通信に使用するユーザー・データグラム・プ

ロトコル(UDP)ポートの番号を指定します。デフォルト値は、非セキュアのLDAPで

は389、セキュアLDAP(LDAPS)では636となっています。アクセス・タイプが指定された時

点で、デフォルトのポートIDがソフトウェアにより自動的に入力されます。

「アクセス・タイプ」オプション・ボタンでは、各LDAPターゲット・デバイスへのクエリ送信

方法を指定します。LDAPを使用している場合、アプライアンスとLDAPサーバー間で交

わされるユーザー名、パスワード、その他の情報はすべて、非セキュアのクリアテキスト

として送られます。アプライアンスとLDAPサーバー間のセキュアな暗号化通信に

はLDAPSを使用してください。

LDAPサーバーのパラメーターを設定するには：

1. アプライアンス →アプライアンスの設定→ユーザー・アカウント → LDAPアカウン

ト →概要を順に選択します。

2. プライマリおよびセカンダリのサーバー・アドレス、ポート、およびアクセス・タイプを

該当するフィールドやオプション・ボタンで確認します。

3. 保存をクリックします。

LDAP検索のパラメーター

LDAP検索ページで、LDAPディレクトリ・サービスでユーザーを検索する際に使用するパ

ラメーターを設定することができます。「検索DN」フィールドでは、ディレクトリ・サービス

にログインする際にアプライアンスが使用する管理者レベルのユーザーを定義できま

す。アプライアンスが認証されると、ディレクトリ・サービスによりディレクトリへのアクセス

が許可され、「LDAPクエリ」ページで指定されたユーザー認証クエリが実行されます。デ

フォルト値は、cn=Administrator、cn=Users、dc=yourDomainName、dc=comで、変更が

可能です。例えば、test.view.comでの管理者のDistinguished Name(DN)を定義するに

は、cn=Administrator, cn=Users, dc=test, dc=view, and dc=comを入力します。検索DNに

入力する個々の値は、カンマで区切る必要があります。「検索パスワード」フィールド

は、「検索DN」フィールドで指定した管理者あるいはユーザーの認証を行う際に使用しま

す。「検索ベース」フィールドでは、LDAP検索を開始する際の起点を定義します。変更可

能なデフォルト値は、dc=yourDomainNameおよびdc=comです。例えば、test.comでの検

索ベースを定義するには、dc=test、dc=comと入力します。 .検索ベースの各値は必ずコ

ンマで区切って入力してください。「UIDマスク」フィールドでは、LDAPターゲット・デバイ

スでのユーザーID検索のための検索基準を指定します。<name>=<%1> の形式を使用し

てください。デフォルト値はsAMAccountName=%1です。これはActive Directoryと併用す

る場合の値となっています。このフィールドはLDAP検索では必須です。
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LDAP検索パラメーターを構成するには：

1. アプライアンス →アプライアンスの設定→ユーザー・アカウント → LDAPアカウン

ト →検索を順に選択します。

2. 「検索DN」、「検索パスワード」、「検索ベース」、および「UIDマスク」の各フィールド

に適切な情報を入力します。

3. 保存をクリックします。

概要画面でLDAP優先順位がLDAP無効に設定されている場合、これらのオプションは変

更できません。

LDAPクエリ・パラメーター

「LDAPクエリ」ページでは、ユーザー認証クエリを実行する際のパラメーターを設定する

ことができます。

アプライアンスは2種の異なるクエリを実行します。クエリ・モード(アプライアンス)は、管

理者およびユーザーがアプライアンスそのものにアクセスしようとしている場合に、管理

者およびユーザーの認証に使用されます。クエリ・モード(ターゲット・デバイス)は、ユー

ザーが接続されているターゲット・デバイスにアクセスしようとしている場合に、そのユー

ザーの認証に使用されます。さらに、各クエリ・タイプには3つのモードがあります。これ

は、アプライアンスや接続されているターゲット・デバイスにアクセスする権限がLDAP

ユーザーにあるかどうかを判断する上での特定情報を得るためのものです。各モードに

関する詳細情報については、「アプライアンスおよびターゲット・デバイスのクエリ・モー

ド」(ページ73) を参照してください。

「LDAPクエリ」ページでは以下の設定ができます：

• クエリ・モード(アプライアンス)パラメーターは、ユーザーがアプライアンスへのアク

セス権を有するかどうかを判断するものです。

• クエリ・モード(ターゲット・デバイス)パラメーターは、ユーザーがアプライアンスに

接続されているターゲット・デバイスへのユーザー・アクセス権を有するかどうかを

判断するものです。ユーザーは、クエリ・モード(アプライアンス)で付与されない限

り、アプライアンスへのアクセス権は持ちません。

• 「グループ・コンテナ」、「グループ・コンテナ・マスク」、および「ターゲット・マスク」の

各フィールドは、グループ クエリ・モードでのみ使用されます。これらはアプライアン

スまたはデバイスのクエリ実行中に必要となります。

• 「グループ・コンテナ」フィールドでは、管理者がActive Directory内にグループ・オブ

ジェクト用位置として作成した組織ユニット(ou)を指定します。
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• グループ・オブジェクトとはActive Directoryオブジェクトで、ユーザー、コンピ

ューター、連絡先、他のグループなどが含まれます。「グループ・コンテナ」は、

クエリ・モードが「グループ属性」に設定されている場合に使用します。メン

バー・オブジェクト(人、アプライアンス、およびターゲット・デバイス)への特定

アクセス・レベルで提携するためのメンバーが、個々のグループ・オブジェクト

に順番に割り当てられます。あるグループと関連付けられているアクセス・レベ

ルは、グループ・オブジェクト内の属性の値を設定することで指定されていま

す。

• 例えば、グループ・オブジェクト・リスト内の「メモ」プロパティを使用してアクセ

ス制御属性を実行する場合、「LDAPクエリ」ページの「アクセス制御属性」フ

ィールドは「info」に設定されているはずです。「メモ」プロパティをKVMユーザー

管理者に設定した場合、該当グループのメンバーには、アプライアンスとター

ゲット・デバイス(このカテゴリーも、同一グループのメンバーとなっている)への

ユーザー管理者アクセスが与えられます。

• 「メモ」プロパティはアクセス制御理属性を実行するために使用されます。「メモ」プ

ロパティの値は、Active Directoryユーザーとコンピューター(ADUC)に表示されるグ

ループ／ユーザー・オブジェクト内にあり、ディレクトリ内部に「info」属性の値として

保存されています。ADUCは、Active Directory設定用のMicrosoft Management

Consoleスナップインです。起動するには、スタート →プログラム →管理ツール→

Active Directoryユーザーとコンピューター を順に選択します。このツールはユー

ザー、コンピューター、グループなどのオブジェクトを作成、設定、削除する際に使

用します。詳細については、「アプライアンスおよびターゲット・デバイスのクエリ・

モード」(ページ73) を参照してください。

• 「グループ・コンテイナ・マスク」フィールドでは「グループ・コンテイナ」のオブジェク

ト・タイプを指定します。通常、グループ・コンテイナとは組織ユニットです。デフォル

ト値は「ou=%1」です。

• 「ターゲット・マスク」フィールドではターゲット・デバイスの検索フィルタを定義しま

す。デフォルト値は「cn=%1」です。

• 「アクセス制御属性」フィールドでは、クエリ・モードが「ユーザー属性」または「グ

ループ属性」に設定されている場合に使用する属性名を指定します。デフォルト値

はinfoです。

LDAPクエリ・パラメーターを設定するには：

1. アプライアンス →アプライアンスの設定→ユーザー・アカウント → LDAPアカウン

ト →クエリ を順に選択します。

2. アプライアンス・クエリ・モードおよびターゲット・デバイス・クエリ・モードについて、

基本、ユーザー属性またはグループ属性のいずれかを選択します。
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3. 「グループ・コンテナ」、「グループ・コンテナ・マスク」、「ターゲット・マスク」および「ア

クセス制御属性」の各フィールドに適切な情報を入力します。

4. 保存をクリックします。

概要画面でLDAP優先順位がLDAP無効に設定されている場合、これらのオプションは変

更できません。

5.2 アプライアンスおよびターゲット・デバイスのクエリ・モード

クエリ・モード(アプライアンス)およびクエリ・モード(ターゲット・デバイス)には、次の3種

のモードのいずれか1つが使用されます：

• 基本 －ユーザーのユーザー名とパスワードに関するクエリがディレクトリ・サービ

スに送信されます。認証されると、ユーザーには、アプライアンスおよびクエリ・モー

ド(アプライアンス)用に接続されているターゲット・デバイスのすべて、またはクエリ・

モード(ターゲット・デバイス)用の特定ターゲット・デバイスのすべてに対する管理

者アクセスが与えられます。

• ユーザー属性－ アプライアンス・ユーザーのユーザー名、パスワード、「アクセス

制御属性」に関するクエリがディレクトリ・サービスに送信されます。アクセス制御属

性はActive Directory内のユーザー・オブジェクト(ユーザー・アカウント)から読み込

まれます。

「KVM Appliance Admin」の値が検出されると、ユーザーには、クエリ・モード(

アプライアンス)用のアプライアンスおよび接続されているターゲット・デバイス

のすべて、またはクエリ・モード(ターゲット・デバイス)用の特定ターゲット・デ

バイスのすべてに対するアプライアンス管理者アクセスが与えられます。

「KVM User Admin」の値が検出されると、ユーザーには、クエリ・モード(アプラ

イアンス)用のアプライアンスおよび接続されているターゲット・デバイス、また

はクエリ・モード(ターゲット・デバイス)用の特定ターゲット・デバイスのすべて

に対するユーザー管理者アクセスが与えられます。

「KVM User Admin」の値が検出されないと、ユーザーには、クエリ・モード(アプ

ライアンス)用のアプライアンスまたはクエリ・モード(ターゲット・デバイス)用の

特定ターゲット・デバイスに対するユーザー・アクセスが与えられます。

これらのいずれの値も検出されない場合、ユーザーが「ユーザー管理者」または「アプライ

アンス管理者」の特権を持っていない限り、クエリ・モード(アプライアンス)用のアプライア

ンスおよびターゲット・デバイス、またはクエリ・モード(ターゲット・デバイス)用の特定ターゲ

ット・デバイスに対するアクセスは与えられません。

スタート → プログラム → 管理ツール→ Active Directoryユーザーとコンピューター を

順に選択して、ADUCにアクセスします。
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• グループ属性－ ユーザー名、パスワード、グループ・クエリは、クエリ・モード(アプ

ライアンス)時はアプライアンスと接続のターゲット・デバイスに関して、クエリ・モー

ド(ターゲット・デバイス)時には特定のターゲット・デバイスに関してディレクトリ・

サービスに送信されます。クエリ・モード(アプライアンス)時の場合、該当ユーザー

とアプライアンス名を含むグループが検索されると、グループ・コンテンツの内容に

従って、アプライアンスまたは接続されているターゲット・デバイスへのユーザー・ア

クセスがユーザーに与えられます。クエリ・モード(ターゲット・デバイス)の場合、該

当ユーザーとターゲット・デバイスIDを含むグループが検索されると、アプライアン

スに接続されている特定ターゲット・デバイスへのユーザー・アクセスがユーザーに

与えられます。

グループは、最高16レベルの深さまで組み込むことができます。組み込み(ネ

スティング)によりグループを他のグループ内に作成することができます。例え

ば、「Computers」の名称の最高位レベル・グループに「R&D」の名称のメンバー

が含まれていて、このR&Dもグループであるとします。このR&Dグループに

は「Domestic」の名のメンバーが含まれており、このDomesticもまたグループ

で、さらにまた続く、といった具合です。

5.3 クエリ実行のためのActive Directoryの設定

ユニットにクエリ・モードを使用する前に、特定のクエリ・モードがユーザーに対する正し

い承認レベルを割り当てられるよう、Active Directoryに変更を加える必要があります。

グループ・クエリをセットアップするには次の手順を実行します。

1. Windowsに管理者としてログインします。

2. Active Directoryソフトウェアを起動します。

3. グループ・コンテナとして使用する組織単位を作成します。

4. アプライアンスのクエリ用のスイッチ・システム名と同一名(OBWIのアプライアンス

概要画面で指定)、またはターゲット・デバイスのクエリ用の、接続されているターゲ

ット・デバイス名と同一名のコンピューター・オブジェクトをActive Directory内に作成

します。名前は、大文字／小文字の区別も含めて完全に一致する必要がありま

す。

5. グループ・クエリ用のアプライアンス名とターゲット・デバイス名は、アプライアンス

に保存されています。OBWIのアプライアンス概要画面で指定したアプライアンス名

とターゲット・デバイス名は、Active Directory内のオブジェクト名と完全に一致する

必要があります。各アプライアンス名とターゲット・デバイス名は、大文字、小文字

を含む全アルファベット(A-Z、a-z)、数字(0-9)、ハイフン(-)を自由に混ぜて構成す
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ることができます。スペース、ピリオド(.)は使用できません。また名前を数字のみで

構成することはできません。以上がActive Directoryでの制限事項です。

以前のバージョンでは工場出荷時設定のデフォルト名にスペースが入っているた

め、OBWIのアプライアンス概要画面でスペースを削除してスイッチング・システム名を編

集し直す必要があります。

6. グループ・コンテナの組織単位の下にグループ(１つまたは複数)を作成します。

7. ユーザー名、ターゲット・デバイス／アプライアンス・オブジェクトを、手順5で作成し

たグループに加えます。

8. アクセス制御属性を実行する上で必要な各属性値を指定します。たとえば、Access

Control Attributeフィールドにinfoを属性として使用し、グループ・オブジェクトに「メ

モ」プロパティを使用してアクセス制御属性を指定する場合、Active Directory内で

の「メモ」の属性値は、グループ・オブジェクトに関してはアクセス・レベル3種(KVM

User、KVM User Admin、KVM Appliance Admin)のうちのいずれかに設定できま

す。設定が行われると、グループのメンバーは指定されたアクセス・レベルに従って

アプライアンスやターゲット・デバイスにアクセスできるようになります。

これら3つの値のいずれもが検出されない場合は、ユーザーに、当該ユーザー名を持つグ

ループ内に一覧されているアプライアンスまたはターゲット・サーバーすべてに対するユー

ザー・レベルのアクセスが与えられます。

590-1058-640A 75



5. LDAP

590-1058-640A76



付録 A: ターミナルの操作

各スイッチは、SETUPポートからアクセスされるコンソール・メニュー・

インターフェイスを介して、アプライアンス・レベルで構成できます。すべ

てのターミナル・コマンドは、ターミナル・エミュレーション・ソフトウェア

を実行しているターミナルまたはコンピューターを介してアクセスされま

す。

注：推奨方法は、ローカルUIでの構成設定です。

ターミナルをスイッチに接続するには次の手順を実行します。

1. 付属のRJ-45/DB-9(メス)変換アダプターとUTPケーブルを使用し

て、ターミナル・エミュレーション・ソフトウェア(HyperTerminalなど)

を実行しているターミナルまたはコンピューターを、スイッチの背面

パネルにあるSETUPポートに接続します。ターミナル設定の種類

は、9600bps、8ビット、1ストップ・ビット、パリティなし、フロー・コン

トロールなしです。

2. 各ターゲット・デバイスをオンにしてから、スイッチの電源をオンに

します。スイッチの起動が完了すると、コンソール・メニューに次の

メッセージが表示されます。Press any key to continue.(任意の

キーを押して続行します)

コンソール・ブート・メニュー・オプション

スイッチの電源投入中に、キーを押してブート・メニューを表示できま

す。このメニューからは、次の4つのオプションのいずれかを選択できま

す。

• Boot Normal(通常ブート)

• Boot Alternate Firmware(代替ファームウェアのブート)

• Reset Factory Defaults(出荷時デフォルトへのリセット)

• Full-Factory Reset(完全出荷時リセット)

コンソールのメイン・メニュー・オプション

電源がオンになると、メイン・メニューに製品の名前とバージョンが表示

されます。このメニューからは、次の4つのオプションのいずれかを選択

できます。

• Network configuration：このメニュー・オプションでは、アプライア

ンスのネットワーク設定を構成できます。
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• Debug messages：このメニュー・オプションでは、コンソール・ス

テータス・メッセージをオンにできます。この操作を行うと性能が大

幅に低減することがあるため、富士通テクニカル・サポートからの

指示を受けた場合にのみデバッグ・メッセージを有効化してくださ

い。メッセージの閲覧が終了したら、任意のキーを押してこのモード

を終了します。

• Reset Appliance：このメニュー・オプションでは、スイッチのソフト・

リセットを実行できます。

• Exit：このメニューを選択すると、入力待機のプロンプトに戻りま

す。コンソール・メニュー・インターフェイスのパスワードが有効に

なっている場合には、次のユーザーにユーザー名とパスワードの

ログイン画面によるメッセージが出されるように、コンソールのメイ

ン・メニューを終了する必要があります。
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KVM s4アダプター・シリアル・ケーブルの使用

各シリアル・アダプター・ケーブルのポートは、管理者がローカル・ユー

ザー・インターフェイスまたはリモートOBWIを介して、ACSコンソール・

サーバーまたはCiscoのピン配列から選択することができます。ACSが

デフォルトです。

ピン配列をCiscoモードに変更するには次の手順を実行します。

1. ユニットの表示 → アプライアンス → アプライアンスの設定 →

ポート →アダプター・ケーブルの順に選択します。

2. 希望するシリアル・アダプター・ケーブルをクリックします。

3. 設定→ピン配列の順に選択します。

注：DB-9アダプターを使用している場合は、ACSコンソール・サーバーのピン配列を選

択します。

ACSコンソール・サーバー・ポートのピン配列

次の表に、シリアル・アダプター・ケーブルのACSコンソール・サー

バー・シリアル・ポートのピン配列を一覧で示します。

ピン番

号
信号名 入力／出力

1 RTS - Request to Send(送
信要求 ) 出力

2
DTR - Data Terminal
Ready(データ・ターミナル・レ

ディー)
出力

3 TXD - Transmit Data(送信

データ) 出力

4 GND - SignalGround(信号

用接地 ) なし

5 CTS - Clear to Send(送信

可 ) 入力

表B.1: ACSコンソール・サーバー・シリアル・ポートのピン配列
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ピン番

号
信号名 入力／出力

6 RXD - Receive Data(受信

データ) 入力

7
DCD/DSR - Data Set
Ready(データ・セット・レデ

ィー)
入力

8 N/C - Not Connected(未接

続 ) なし

Ciscoポートのピン配列

次の表に、シリアル・アダプター・ケーブルのCiscoシリアル・ポートのピ

ン配列を一覧で示します。

ピン番

号
信号名 入力／出力

1 CTS - Clear to Send(送信

可 ) 入力

2
DCD/DSR - Data Set
Ready(データ・セット・レデ

ィー)
入力

3 RXD - Receive Data(受信

データ) 入力

4 GND - SignalGround(信号

用接地 ) なし

5 N/C - Not Connected(未接

続 ) なし

6 TXD - Transmit Data(送信

データ) 出力

7
DTR - Data Terminal
Ready(データ・ターミナル・レ

ディー)
出力

8 RTS - Request to Send(送
信要求 ) 出力

表B.2: Ciscoシリアル・ポートのピン配列
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付録 C: UTPケーブル

以下に、接続媒体のさまざまな特徴を説明します。KVM s4スイッチ・シ

ステムではUTPケーブルが活用されています。スイッチ・システムの性

能は、高品質の接続が得られるかどうかに依存します。品質が優れな

いケーブル、設置や保守に問題のあるケーブルは、システムの性能を

損なう結果となる場合があります。

注：この付録は情報の提供のみを目的としています。設置する前に、当地のコード当

局やケーブル関連の専門家に確認してください。

銅製UTPケーブル

KVM s4スイッチでサポートされている3種類のUTPケーブルの基本的な

定義は下記の通りです：

• CAT5(4対)高性能ケーブルはツイスト・ペア電線で構成されてお

り、主にデータ送信に使用されます。ペア線がより合わされている

ことで、このケーブルでは不要な干渉の混入からある程度免れるこ

とができます。CAT5ケーブルは通常、10～100 Mbpsの範囲で動作

するネットワークに使用されます。

• CAT5E(強化)ケーブルの特徴はCAT5と同様ですが、製造規格が

若干厳しいものになっています。

• CAT6ケーブルは、CAT5Eケーブに比べより厳しい要件に合わせて

製造されます。CAT6はより高い測定周波数範囲を持ち、同一周波

数においてはCAT5Eに比べ明らかに分かる優れた性能要件を示し

ます。

配線規格

8導線(4ペア)RJ-45終端処理済みUTPケーブルには、EIA/TIA 568Aお

よびEIA/TIA 568Bの2種類の推奨配線規格があります。これらの規格

は、CAT5、CAT5E、CAT6のケーブル仕様によるインストールに適用さ

れます。KVM s4スイッチ・システムではこれらの両方の規格がサポート

されています。次の表は、各ピンの規格を説明しています。

ピン EIA/TIA 568A EIA/TIA 568B

1 白／緑 白／オレンジ

2 緑 オレンジ

表C.1: UTP配線規格
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ピン EIA/TIA 568A EIA/TIA 568B

3 白／オレンジ 白／緑

4 青 青

5 白／青 白／青

6 オレンジ 緑

7 白／茶 白／茶

8 茶 茶

ケーブルのインストール、保守、および安全情報

次に、ケーブルの設置や保守を実行する前に目を通しておくべき重要

な安全注意事項を一覧で示します。

• 各UTPの長さは最長で9.1 m(30フィート)としてください。

• ペア線は、必ず終端箇所までツイストされた(より合わされた)状態

を保つか、またはツイストになっていない部分が1.3 cm(半インチ)

を超えないようにしてください。終端処理の際、外被を2.5 cm(1イン

チ)以上剥がさないでください。

• ケーブルを曲げる必要がある場合は、半径が2.5 cm(1インチ)より

小さくならない範囲で緩やかに行ってください。ケーブルを鋭角に

曲げたりねじったりすると、ケーブル内部に恒久的な損傷が生じる

おそれがあります。

• ケーブルは、ケーブル・タイを用いて低～中程度の圧力で束ねてま

とめてください。ケーブル・タイは締め過ぎないでください。

• ケーブルは必要に応じて、定格のパンチ・ブロック、パッチ・パネ

ル、その他のコンポーネントを用いて交差接続します。ケーブルは

絶対に繋ぎ合わせたりブリッジにしたりしないでください。

• UTPケーブルは、電線、トランス、電灯などのようなEMI源となり得

る品物からはできるだけ距離を持たせてください。ケーブルを電線

用導管に結びつけたり、電気機器上に配置したりしないでくださ

い。

• 設置部分は必ずケーブル・テスターでテストしてください。「トーニン

グ」のみではテストとして適切ではありません。
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• ジャックの設置は、接点に埃や他の汚染物質が蓄積しないような形

で行ってください。ジャックの接点は、埋め込み型のプレート上では

上向きに、表面実装型ボックスの場合は左／右／下向きにします。

• ケーブルには常に遊びをもたせ、天井部分あるいは付近の引込ん

だ箇所にはコイル状に整然と配置します。少なくとも、コンセント側

では1.5 m(5フィート)、パッチ・パネル側では4.5 m(15フィート)の

ケーブルの長さを残しておいてください。

• 作業を開始する前に、568Aと568Bのどちらの配線規格を使用する

かを決めておいてください。ジャックおよびパッチ・パネルはすべ

て、同一の配線方式で配線します。同一の設置に568Aと568Bのワ

イヤーを混在させないでください。

• 常に、地方／国の消防規則および建築条例のすべてに従ってくだ

さい。防火壁を通過するケーブルには必ず火炎止めをしてくださ

い。規定に応じてプレナム・ケーブルを使用してください。
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付録 D: ケーブルのピン配列情報

注：すべてのスイッチには、モデム・ポートとコンソール／セットアップ・ポート用にRJ45(8

ピン・モジュラー)ジャックが付いています。

図D.1:モデム・ジャック

ピン 説明 ピン 説明

1
送信要

求 (RTS：Request to
Send)

5 送信データ(TXD：Transmit Data)

2
データ・セット・レデ

ィー(DSR：Data Set
Ready)

6 信号用接地 (SG：SignalGround)

3
データ・キャリア検

出 (DCD：Data
Carrier Detect)

7
データ・ターミナル・レデ

ィー(DTR：Data TerminalReady)

4
データ受

信 (RXD：Receive
Data)

8 送信可 (CTS：Clear to Send)

表D.1:図 D.1の説明
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図D.2:コンソール／セットアップ・ジャック

ピン 説明 ピン 説明

1
未接続 (N/C：Not
Connected)

5 送信データ(TXD：Transmit Data)

2
未接続 (N/C：Not
Connected)

6 信号用接地 (SG：SignalGround)

3
未接続 (N/C：Not
Connected)

7 未接続 (N/C：Not Connected)

4
データ受

信 (RXD：Receive
Data)

8 未接続 (N/C：Not Connected)

表D.2:図 D.2の説明
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付録 E: 技術仕様

サーバー･ポー

ト

個数

KVM s4-0812： 8

KVM s4-1622： 16

KVM s4-3242： 32

タイプ PS/2、USB、シリアル

コネクター RJ45

同期タイプ セパレート・シンク

入力ビデオ解

像度

標準

640 x480@ 60Hz

800 x600@ 75Hz

960 x700@ 75Hz

1024 x768@ 75Hz

1280 x1024@ 75Hz

1600 x1200@ 60Hz

ワイドスクリーン

800 x500@ 60Hz

1024 x640@ 60Hz

1280 x800@ 60Hz

1440 x900@ 60Hz

1680 x1050@ 60Hz

推奨ケーブル 4対UTPまたはCAT6、最大長45m

寸法

表E.1:技術仕様
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サーバー･ポー

ト

フォーム・ファク

ター
1Uラックにマウント可能

寸法 1.72 x17.00 x9.20 (高さ x幅 x奥行き)

重 量 ( ケー ブ

ルを除く)

KVM s4-0812：3.0 kg(6.5 lb)

KVM s4-1622：3.2 kg(7.0 lb)

KVM s4-3242：3.4 kg(7.6 lb)

SETUPポート

個数 1

タイプ RS-232シリアル

コネクター RJ45

ローカル・ポート

個数／タイプ 1 VGA/4 USB

ネットワーク接続

個数 2

タイプ 10/100/1000イーサーネット

コネクター RJ45

USBデバイス・ポート

個数 4

タイプ USB2.0

MODEMポート

個数 1
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サーバー･ポー

ト

タイプ RS-232シリアル

コネクター RJ45

PDUポート

個数 2

タイプ RS-232シリアル

コネクター RJ45

電源仕様

コネクター 2

タイプ 内部

電力量

KVM s4-0812： 13W

KVM s4-1622：18W

KVM s4-3242：24W

熱放散

KVM s4-0812：43 BTU/時

KVM s4-1622：45 BTU/時

KVM s4-3242：47 BTU/時

AC入力範囲 100～240 VAC

AC周波数 50/60 Hz自動検知

AC入力電流

定格
1.25 A

AC 入 力 電

源 (最大 )
40W

周囲大気条件定格
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サーバー･ポー

ト

温度
摂氏0～50度 (華氏32～122度 )、作動時：

摂氏 -20～70度 (華氏 -4～158度 )、非作動時：

湿度
作動時：20%～80%相対湿度 (結露なし)

非作動時：5%～95%相対湿度、38.7℃ 最大湿球温度

安全 規 格 お

よ びEMC 規

格認証、マー

キング類

UL、FCC、cUL、 ICES-003、CE、VCCI、KCC、C-
Tick、GOST

本製品の安全性証明書およびEMC証明書は、次の1つまたは

複数の題名の下でご覧いただけます。CMN(証明書モデル番

号 )、MPN(製 造 元 部 品番 号 )、 販 売 段 階で付 く型 式 名

称。EMCおよび／または安全性の報告書および証明書で参

照されている題名は、製品に使用されているラベル上に印刷さ

れています。
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付録 F: Sunキーボードのアドバンスト・キー・エミュ

レーション

標準のタイプ5 (US) Sunキーボードのキーの一部には、キープレス・

シーケンスでローカル・ポートのUSBキーボードにエミュレートできるも

のがあります。Sunアドバンスト･キー・エミュレーション・モードを有効化

してこれらのキーを使用するには、Ctrl+Shift+Altを押したままScroll

Lockキーを押してください。Scroll Lock LEDライトが点滅します。Sun

キーボードのアドバンスト・キーを使用するのと同様に、次の表のキー
を使用します。例：Stop + A の場合には、Ctrl+Shift+Altを押したまま

Scroll Lockを押し、次に F1 + A を押します。

これらのキー・コンビネーションは、KVM s4アダプターUSB20-VGAと併

用できます。これらのキー・コンビネーションは、F12を除き、Microsoft

Windows製品では認識されません。F12は、Windowsのキー・プレスを

実行します。

終了したら、Ctrl+Shift+Altを押したままScroll Lockキーを押し、Sunアド

バンスト･キー・エミュレーション･モードをトグル操作でオフにします。

Sunキー (US) Sunキー・エミュレーションを有効化するキー

Compose Application(1)

Compose keypad

電源 F11

Open F7

Help Num Lock

Props F3

Front F5

Stop F1

Again F2

Undo F4

Cut F10

表F.1: Sunキー・エミュレーション
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Sunキー (US) Sunキー・エミュレーションを有効化するキー

Copy F6

Paste F8

Find F9

Mute keypad /

Vol.+ keypad +

Vol.- keypad -

Command(左 )(2) F12

Command(左 )(2) Win (GUI)左 (1)

Command(右 )(2) Win (GUI)右 (1)

備考：

(1)Windows95 104キー・キーボード。

(2)CommandキーはSunMeta(ダイヤモンド)キーです。
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付録 G: ヘルプおよびテクニカル・サポート

ヘルプ、サービスやテクニカル・サポート、あるいは富士通製品につい

ての詳しい情報をお探しの場合、弊社ではさまざまな情報をご用意して

おります。このセクションには、富士通および富士通製品に関する追加

情報の入手方法、お使いのシステムで問題が生じた場合の対処方法、

サービスが必要な場合の連絡先などについての情報が含まれていま

す。

電話でお問い合わせいただく前に

電話でお問い合わせいただく前に、問題をご自分で解決していただくた

めの以下の手順をすべて試したことを確認してください。

• すべてのケーブルを点検して、接続されていることを確認してくださ

い。

• 電源スイッチを点検して、システムと装置の電源がオンになってい

ることを確認してください。

• 使用システムのマニュアルに記載されているトラブルシューティン

グ情報を使用し、さらにシステムに付属の診断ツールを使用してく

ださい。診断ツールについての情報は、お使いのシステムに付属

の富士通付属文書／マニュアルCDに収録されている 問題の診断

およびサービス・ガイドをご参照ください。

• 富士通サポートのWebサイトを閲覧して技術情報、ヒント、特別情

報、新しいデバイス・ドライバーをチェックするか、情報のリクエスト

を提出してください。

http://www.ts.fujitsu.com/pc/support/

富士通がオンライン・ヘルプまたは富士通製品に付属のマニュアルで

提供するトラブルシューティングの手順に従っていただくことで、外部の

支援を求めることなくお客様が多くの問題を解決することができます。

富士通システムに付属のマニュアルにも、お客様が実行できる診断テ

ストについての説明が記載されています。システム、オペレーティング・

システム、プログラムには大抵、トラブルシューティングの手順ならび

にエラー・メッセージとエラー・コードの説明を含むマニュアルがついて

います。ソフトウェアに問題がある思われる場合は、オペレーティング・

システムまたはプログラムのマニュアルを参照してください。
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